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Preface
About OpenStax
OpenStax is part of Rice University, which is a 501(c)(3) nonprofit charitable corporation. As an educational
initiative, it's our mission to improve educational access and learning for everyone. Through our partnerships
with philanthropic organizations and our alliance with other educational resource companies, we're breaking
down the most common barriers to learning. Because we believe that everyone should and can have access to
knowledge.

About OpenStax Resources
Customization
Workplace Software and Skills is licensed under a Creative Commons Attribution 4.0 International (CC BY)
license, which means that you can distribute, remix, and build upon the content, as long as you provide
attribution to OpenStax and its content contributors.

Because our books are openly licensed, you are free to use the entire book or select only the sections that are
most relevant to the needs of your course. Feel free to remix the content by assigning your students certain
chapters and sections in your syllabus, in the order that you prefer. You can even provide a direct link in your
syllabus to the sections in the web view of your book.

Instructors also have the option of creating a customized version of their OpenStax book. Visit the Instructor
Resources section of your book page on OpenStax.org for more information.

Art attribution
In Workplace Software and Skills, most art contains attribution to its title, creator or rights holder, host
platform, and license within the caption. Because the art is openly licensed, anyone may reuse the art as long
as they provide the same attribution to its original source. Screenshots from Microsoft and Google are credited
with the figure. Please retain that attribution when reusing the images. To maximize readability and content
flow, some art does not include attribution in the text. If you reuse art from this text that does not have
attribution provided, use the following attribution: Copyright Rice University, OpenStax, under CC BY 4.0
license.

Errata
All OpenStax textbooks undergo a rigorous review process. However, like any professional-grade textbook,
errors sometimes occur. In addition, the wide range of topics, data, and technology in business software
change frequently, and portions of the textbook may become out of date. Since our books are web-based, we
can make updates periodically when deemed pedagogically necessary. If you have a correction to suggest,
submit it through the link on your book page on OpenStax.org. Subject matter experts review all errata
suggestions. OpenStax is committed to remaining transparent about all updates, so you will also find a list of
past and pending errata changes on your book page on OpenStax.org.

Format
You can access this textbook for free in web view or PDF through OpenStax.org, and for a low cost in print. The
web view is the recommended format because it is the most accessible—including being WCAG 2.0 AA
compliant—and most current. Print versions are available for individual purchase, or they may be ordered
through your campus bookstore.

About Workplace Software & Skills
Workplace Software and Skills covers applications from the Microsoft 365 (formerly Microsoft Office) suite and
Google Workspace. Coverage of both suites aligns with contemporary business use and prepares students for
workforce needs, especially introductory students who have had limited exposure to these software programs.
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By teaching their basic and advanced features, users of all levels can learn the skills necessary for success in
their jobs.

Applications covered in depth from Microsoft 365 include Word, PowerPoint, Excel, and Access, as well as
overviews of integrations with Outlook, Calendar, and Teams. Applications covered in depth from Google
Workspace include Docs, Sheets, and Slides, as well as overviews of integrations with Gmail, Calendar, and
Meet. The text also provides overviews of additional collaboration and conference applications, as well as in-
depth coverage of content management software such as WordPress.

With this selection of applications, Workplace Software and Skills provides a holistic exposure to common tools
of business practice and prepares students for additional focused training that may be required for specialized
fields. In addition to technical skill development, the text covers conceptual topics related to ethics and
security; and technology advancements, such as the Internet of Things and generative artificial intelligence.
These topics are discussed as they relate to business and everyday life, reflecting their importance to
contextualizing business computer application use within the modern business world. They emphasize
responsible use and considerations for collaboration across a virtual network.

Across each chapter, conceptual and technical skill is anchored in real-world examples and applications. This
ensures that students are prepared for entry into the workforce with a portfolio of completed examples
relevant to positions requiring these skills.

Pedagogical Foundation
Learning Objectives
Every module begins with a set of clear and concise learning objectives, which are designed to be both
measurable and closely aligned with current teaching practice. These objectives can help the instructor decide
what content to include or assign and guide student expectations of learning. After completing the module
and end-of-module exercises, students should be able to demonstrate mastery of the learning objectives.

Key Features
• Cross-chapter Scenario: Presents students with a mock business simulation that continues from Chapter

1 through Chapter 15. The scenario focuses on a multi-division business and provides a variety of work-
related tasks, such as preparing a memo or creating a slideshow for an entry-level employee, as well as
longer projects, such as a marketing report that a mid-level employee might need to create. Additional
scenarios showcase green technology, non-profit organizations, and entrepreneurship. Students will be
exposed to everyday business needs as related to the chapter topic. Integrated projects and capstones will
also pull from this simulated business scenario.

• Real-World Application: Discusses the practical applications of software and related technology in our
everyday lives, whether in or out of the workplace.

• Mac Tips: Calls out brief notes where commands or tools for macOS and Windows differ.
• Spotlight on Ethics: Highlights an ethics issue related to the concept, skill, or activity being taught in the

text. These features may discuss a real-world case, dig deeper into an ethical concept being discussed, or
present an ethical dilemma for the student to think through.

• Link to Learning: Includes a few sentences of introduction to a website with an interactive activity,
animation, or video that helps improve student understanding.

• Final Project: The last chapter includes a complex final project assignment. Students are given a dataset
and asked to create a detailed business report that uses product integrations, tools, and skills learned
across all fifteen chapters.

Section Summaries
Section summaries distill the information in each section for both students and instructors down to key,
concise points addressed in the section.

2 Preface
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Key Terms
Key terms are bold and are followed by a definition in context. Definitions of key terms are also listed in the
Glossary, which appears at the end of the chapter.

Assessments
A variety of assessments allow instructors to confirm core conceptual understanding, elicit brief explanations
that demonstrate student understanding, and offer more in-depth assignments that enable learners to dive
more deeply into a concept, tool, or topic.

• Review Questions test for conceptual apprehension of key concepts and tools.
• Practice Exercises ask students to apply the program content they have learned so that they can both

learn by repetition and extend the practice through critical thinking exercises.
• Written Questions require students to explain concepts in words, as well as asking students to explain

when a concept should be applied in the workplace, and respond to non-technical concepts, such as
ethics.

• Case Exercises ask students to come up with creative solutions to a new problem; these exercises may
draw from real-world examples or fictional scenarios.

Answers to Questions in the Book
The end-of-chapter Review Questions, Written Questions, Practice Exercises, and Case Exercises are intended
for homework assignments or classroom discussion; thus, student-facing answers or solutions are not
provided. Sample answers are provided in the Instructor Solution Manual, for instructors to share with
students at their discretion, as is standard for such resources.

About the Authors
Senior Contributing Authors

Figure 1 Senior Contributing Authors (left to right): Tammie Bolling, Angela Mitchell, Tanya Scott, Nyrobi Wheeler.

Tammie Bolling, Pellissippi State Community College

Dr. Tammie Bolling holds the rank of tenured Professor at Pellissippi State Community College. She has
obtained master’s degrees in business administration, healthcare management, and psychology, as well as
postgraduate certificates in varying information technology areas and a doctorate in Leadership. In addition to
teaching, she manages the Industry Recognized Credential and Major Field Test testing program for the
Business and Computer Technology department. Dr. Bolling’s other areas of interest include the development
of cultural competence and the internationalization of curricula in a wide range of disciplines, and is an avid
mobile technology researcher. Dr. Bolling was named a Fulbright Scholar to Ireland in 2022-2023 in Computing,
which was one of the highlights of her professional life.

Angela Mitchell, Wilmington College

Dr. Angela Mitchell is department chair and professor of business and economics at Wilmington College. She
primarily teaches finance and statistics courses, and serves in various leadership roles at the institution. Her
primary research interests are focused on nonprofit management and efficiencies and student intercultural
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development through travel opportunities. Dr. Mitchell holds a master's degree in Business Administration and
a doctorate in Operations Research. Dr. Mitchell is involved in her local community by serving on several
nonprofit boards and volunteering regularly for community events. Prior to Wilmington College, Dr. Mitchell
spent five years in product development at Procter & Gamble, spending time in the manufacturing
environment and leading trials to test new processes and product formulations. The combination of business
experience and technical background provides a unique perspective that Dr. Mitchell brings to the classroom
and to her research.

Tanya Scott, Achieving the Dream

Dr. Tanya Scott is the director of program innovation at Achieving the Dream, a national nonprofit organization
that partners with community colleges to help achieve student success. Dr. Scott's experience spans teaching,
program development, and leadership in middle school, high school, community college, and university
settings in Canada and the United States. She holds a master's degree in Education and a doctorate in
Business Administration-I/O Psychology. An active practitioner, she has extensive undergraduate and graduate
teaching experience in teacher and curriculum development, instructional strategies, and integrating
technology in the classroom, as well as business, change management, strategy, and leadership. She is also a
fervent advocate for open educational resources and open pedagogy.

Nyrobi Wheeler, Bellevue University

Nyrobi Wheeler is a full time online adjunct professor of Business, Human Resources, and Diversity, Equity and
Inclusion at Bellevue University, as well as an online instructor of Business at Jesuit Worldwide Learning in
Geneva, Switzerland. Nyrobi holds a master's degree in Business Administration in Leadership and Finance, as
well as a postgraduate certificate in Human Resources Management. Nyrobi is a self-publishing author of
several e-books and articles on career advice, as well as the co-author of several anthologies on workplace and
hair discrimination among Black Women.

Contributing Authors
Bridget Lepore, Lehman College

Janine Walton, Louisiana State University Shreveport

Timothy Burgoyne, Wilmington College

Valeree Falduto, Broward College

Reviewers
Adam Gorski, New York University

Alex Katrompas, Austin Community College

Angela Heath, Baptist Health System

Betty Fitte, Tidewater Community College

Bill Nantz, Houston Community College

Brian Pusateri, University of Scranton

Bryan Broussard, Central Louisiana Technical Community College

Caleb Williamson, Pellissippi State Community College

Carmen Montanez-Rodriguez, Allan Hancock Community College

David Collins, Bellarmine University

Deanna Bartee, Grand Canyon University
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Glenn McQueary, Houston Community College

Heather Beatty, Ashworth College

John Christie, Regis College

Julie Goff Lindsey, Linn Benton Community College

Laura Bantz, McHenry County College

Lawrence Chui, University of St. Thomas

Lisa Breaux, San Jacinto College

Mariya Breyter, New York University

Michael MacLeod, Austin Community College

Reni Abraham, Houston Community College

Saverio Iaconis, New York University

Sue McCrory, Missouri State University

Terri Lukshaitis, Ferris State University

Additional Resources
Student and Instructor Resources
We’ve compiled additional resources for both students and instructors, including an instructor’s manual, test
bank, and lecture presentation slides. Instructor resources require a verified instructor account, which you can
apply for when you log in or create your account on OpenStax.org. Take advantage of these resources to
supplement your OpenStax book.

Instructor's answer guide. Each component of the instructor’s manual is designed to provide maximum
guidance for delivering the content in an interesting and dynamic manner.

Test bank. With nearly 2,000 true/false, multiple-choice, fill-in-the-blank, and short answer questions in our
test bank, instructors can customize tests to support a variety of course objectives. The test bank is available in
Word format. Authored by Amit Shah, Frostburg State University.

PowerPoint lecture slides. The PowerPoint slides provide learning objectives, images and descriptions, and
feature focuses as a starting place for instructors to build their lectures.

Data files. Some chapters are accompanied by downloadable data files (typically in .xlsx, .docx, or .csv format)
that provide students with the data needed to perform certain assessments, exercises, or in-text examples.
Providing the data files to students reduces the amount of unnecessary typing and allows the student to jump
right into manipulating the data.

Academic Integrity
Academic integrity builds trust, understanding, equity, and genuine learning. While students may encounter
significant challenges in their courses and their lives, doing their own work and maintaining a high degree of
authenticity will result in meaningful outcomes that will extend far beyond their college career. Faculty,
administrators, resource providers, and students should work together to maintain a fair and positive
experience.

We realize that students benefit when academic integrity ground rules are established early in the course. To
that end, OpenStax has created an interactive to aid with academic integrity discussions in your course.
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Figure 2 Visit our academic integrity slider (https://www.openstax.org/r/academic-integrity-slider). Click and drag icons along the
continuum to align these practices with your institution and course policies. You may then include the graphic on your syllabus,
present it in your first course meeting, or create a handout for students. (attribution: Copyright Rice University, OpenStax, under CC
BY 4.0 license)

At OpenStax we are also developing resources supporting authentic learning experiences and assessment.
Please visit this book’s page for updates. For an in-depth review of academic integrity strategies, we highly
recommend visiting the International Center of Academic Integrity (ICAI) website at
https://academicintegrity.org/ (https://academicintegrity.org/).

Community Hubs
OpenStax partners with the Institute for the Study of Knowledge Management in Education (ISKME) to offer
Community Hubs on OER Commons—a platform for instructors to share community-created resources that
support OpenStax books, free of charge. Through our Community Hubs, instructors can upload their own
materials or download resources to use in their own courses, including additional ancillaries, teaching
material, multimedia, and relevant course content. We encourage instructors to join the hubs for the subjects
most relevant to your teaching and research as an opportunity both to enrich your courses and to engage with
other faculty. To reach the Community Hubs, visit www.oercommons.org/hubs/openstax.

Technology partners
As allies in making high-quality learning materials accessible, our technology partners offer optional low-cost
tools that are integrated with OpenStax books. To access the technology options for your text, visit your book
page on OpenStax.org.
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Figure 1.1 Today’s workspaces represent decades of advances in technology. Portable personal computers, cellular communications,

tablets, and advances in artificial intelligence have changed the way people do their jobs. (credit: modification of "Home office,

Computer, Desk" by Pexels/Pixabay, CC0)

Chapter Outline
1.1 Computing from Inception to Today
1.2 Computer Hardware and Networks
1.3 The Internet, Cloud Computing, and the Internet of Things
1.4 Safety, Security, Privacy, and the Ethical Use of Technology

Chapter Scenario
WorldCorp welcomes you to your new position within the company, a multinational corporation where the jobs
are plentiful, and the future is bright. To be successful at WorldCorp, you will need to know a little bit about the
computing past and a lot about the computing present. You’ll also need to have a sense of the computing
future, especially as it pertains to business. That’s what this chapter is about. You will also need to know how to
perform basic functions at WorldCorp using two major computer programs you’ve probably heard
of—Microsoft 365, or more commonly known as Office, and Google Workspace. The next chapter in this
textbook, Essentials of Software Applications for Business, covers the basics of these programs.

WorldCorp activities presented in other chapters will lay out specific computing tasks, such as formatting
documents, creating spreadsheets, designing online slide presentations, posting on social media, and
conducting virtual meetings. Even though the online environment changes rapidly, these are fundamental
computing skills that workers need regardless of their level of employment. As you move forward in the text,
you will learn more about WorldCorp, its structure, products, customers, and strategies.

Technology in Everyday Life and Business
1



1.1 Computing from Inception to Today

Learning Objectives
By the end of this section, you will be able to:

• Explain the evolution of computing in the workplace
• Explain the rise of computing for personal use
• Discuss the use of technology in today’s workplace
• Describe key technologies in mobile devices, digital imaging, and gaming
• Discuss recent advances in technology and related career opportunities

Today’s workplace looks very different from the workplace of even a decade ago. Much has changed in the
field of computer science and computing in general, reshaping the use of technology at both individual and
professional levels. From the early uses of massive, room-size computers to perform large, complex
calculations to today’s much smaller, more advanced computers—even one so small it can fit in the palm of
your hand like the Raspberry Pi 4 shown in Figure 1.2—computing has secured a solid foothold in our everyday
lives.

Figure 1.2 The Raspberry Pi 4 contains the basic components and power of a computer. It can power a robot, smart products, and
basic PCs. At 3.4 inches by 2.2 inches and only .6 inches high, it fits in the palm of your hand. (credit: “Raspberry pi” by kritsadaj/
Pixabay, CC0)

Workers today need to know how to use computers to perform basic (and advanced) tasks that employers
need. Those tasks could be preparing documents, creating spreadsheets for financial calculations, designing
slide presentations for meetings, constructing databases, and even navigating social media and virtual
meeting spaces that help companies communicate internally and externally. This text explores the basic
software applications that perform these tasks, mostly through Microsoft Office and Google Workspace.

But, first, this chapter looks at the evolution of computing to provide some context and appreciation for the
field itself and to show its importance not just for today’s workplace, but also to give you a sense of where
computing is heading.

Computing in the Workplace
The rise of computers for work came out of a need to manage a massive quantity of numbers. The early
computers essentially were developed to be “data crunchers.” Their origins date back to the 1800s in France.
Joseph Marie Jacquard, a textile merchant, developed a machine to automatically weave designs in fabric using
a punch card system, as you can see in Figure 1.3. This punch card system laid the foundation for more
advances in number calculations, including those developed by Herman Hollerith for the 1880 U.S. census.

8 1 • Technology in Everyday Life and Business
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Hollerith went on to improve the initial punch card system and eventually founded IBM, one of the first major
computing companies.

Figure 1.3 (a) Jacquard’s loom, which performed calculations using a punch card system, was an early development in computing, as
was (b) Herman Hollerith’s punch-card tabulating machine, for which he was awarded a patent in 1889. (c) Each hole in a punch card
equals a piece of data (called a “bit” today) that the machines read. (credit a: modification of work “Jacquard.loom.cards” by George
H. Williams/Wikimedia Commons, Public Domain; credit b: modification of work “Holerith395782Figures1-6” by Herman Hollerith/
Wikimedia Commons, Public Domain; credit c: modification of work “2punchCards” by José Antonio González Nieto/Wikimedia
Commons, CC BY 3.0)

The first computer (in the modern sense of the term) was the Z1, designed and built in the late 1930s by
Konrad Zuse of Germany. This machine was motor-driven, programmable, and weighed over 2,000 pounds,
about 400 times the average laptop today. The Z1 contained many of the internal components still used in
today’s computers, paving the way for other inventors to evolve the technology.

Bill Hewlett and David Packard, two Stanford University engineering students, began working out of a garage
in California, initially developing equipment for engineers and major companies. They founded their company,
Hewlett Packard (HP), in 1939, but it wasn’t until a few decades later that it would become a titan in the
computer manufacturing industry.

Meanwhile, the 1940s and 1950s saw major advances in computing technology. Most notable was the 1943
invention of the ENIAC (Electronic Numerical Integrator and Calculator). This massive unit, built by two
professors at the University of Pennsylvania, is considered the forerunner of today’s digital computers because
it was the first machine to run calculations electronically. Other innovations included solving equations
simultaneously and the invention of the transistor, which allowed for much smaller computers to be built.

The development of computer language is another major milestone in computing history. By using words
rather than symbols, computer coding became easier to learn and write, especially for those in the business
world who did not have mathematics or engineering degrees. It is thanks, in large part, to mathematician and
U.S. Navy Admiral Grace Hopper (Figure 1.4). Hopper’s PhD in mathematics from Yale, along with her naval
career working on technology to aid the war effort during World War II, positioned her to make some
remarkable contributions, and in a male-dominated field.
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Figure 1.4 Grace Hopper, shown here in 1960 with a UNIVAC computer, earned her PhD in mathematics and went on to an illustrious
career in computer science. (credit: “Grace Hopper and UNIVAC” by Public.Resource.Org/Flickr, CC BY 2.0)

SPOTLIGHT ON ETHICS

Grace Hopper: A Pioneer in Computer Science

Historically, science, technology, engineering, and mathematics (known as the STEM fields) were seldom
viewed as appropriate fields for females, and the same was true for careers in the military. Although
women today make up half of the U.S. workforce, less than 30 percent of employees in STEM fields are
women. As a reflection of this gender bias, in 1950, fewer than 5 percent of doctoral degrees awarded in
chemistry, math, and physics were granted to females, and even today, that number has only risen to just
under 20 percent.

Grace Hopper was a pioneer in the computer science field and in the military as a woman working in STEM.
She was also a member of the first group of women to be granted a PhD in mathematics from Yale
University. Hopper’s work in computer science had a profound impact on the future of computer
programming, especially through her creation of an English-language-based programming language,
which eventually became COBOL (still in use today).

There are many organizations centered on narrowing the gender gap in STEM fields. One of these is the
American Association of University Women (AAUW). Founded in 1881, it has been tirelessly focused on
investing in education, especially in STEM fields, and on promoting these fields to females through tech
camps and other initiatives.

Computers entered the workplace in the 1950s. Their use at that time was for scientific and engineering
applications, mostly as calculating machines to facilitate data analysis. In 1964, the Programma 101, an Italian
desktop-sized programmable calculator, was the first commercially viable workplace computer to hit the
market. It was heavy and expensive—its $3,200 price tag in 1964 dollars was the equivalent of nearly $30,000
today. As a result, only large corporations and research institutions had the space and resources to use the
computers that were commercially available. This remained the status quo into the 1970s, when the
development of the microcomputer changed the face of the industry. The first personal computer, the
Kenbak-1, came on the market in 1971. Microcomputer is the technical name for the personal computers that
operated with a single processing unit and were much smaller than the machines used in corporations or
industrial institutions. Intel’s 1970 invention of the microchip (a group of small circuits that work together to
make a computer operational) was quickly followed by the floppy disk (which allowed for data to be stored and
moved easily), developed by IBM engineers, and ethernet connection capability, developed by Xerox. Ethernet
connects computers and devices such as printers through hard cables. With advances in technology, the
market for computers expanded rapidly in the 1970s. That’s when Paul Allen and Bill Gates founded Microsoft
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to focus on developing software and an operating system for the new computers. It is also when Steve Jobs
and Steve Wozniak founded Apple, creating the Apple I computer with a single circuit board.

Xerox’s revolutionary Alto computer, shown in Figure 1.5, introduced in 1973, included a screen resembling
those we use today, plus a mouse and keyboard. The screen included, for the first time, elements such as
folders, buttons, and icons controllable through the mouse. The Alto not only had the ability to act as a
calculator but also could print documents and send electronic mail, anticipating the email we know today.

Figure 1.5 Xerox’s Alto computer has a similar look to today’s computers, even including the mouse. (credit: “Xerox Alto Computer)
by Joho345/Wikimedia Commons, Public Domain)

Early personal computers like the Programma and the Alto set the stage for the rapid expansion of computing
in the workplace. By 1980, there were several microcomputers on the market that made computing more
accessible to small businesses and even individuals. Computing capabilities had expanded to include color
graphics, spreadsheets, and word processing programs. The market competition between Microsoft, HP, IBM,
Apple, and others shaped the industry and our society. In fact, in 1983, Time magazine’s cover recognized the
computer as “Machine of the Year,” replacing its traditional “Man of the Year.” These early computers have
evolved into today’s laptops, cell phones, tablets, and wearables.

These innovations in computing technology have had a profound impact on the workplace. Figure 1.6 shows
just how different today’s “workplace” has become. From the automation of manual processes, to the ways we
store and analyze information, to how and where we communicate with colleagues and customers—all have
changed dramatically. Resulting improvements include improved efficiency and productivity, reduction of
errors, improved database management and analytics, advanced communication capabilities, telecommuting,
enhanced graphics and marketing, the need for new organizational structures and departments (such as
information technology, or IT, departments), and the development of technology privacy policies and legal
regulations. Computing machines, along with the emergence and subsequent explosion of the internet, have
forever transformed both our work and our personal lives.
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Figure 1.6 Computing technology has transformed the modern workspace. People no longer have to be “in the office.” (credit: “left”:
modification of work by Cory Zanker; credit “center”: modification of work by “@Saigon”/Flickr; credit “right”: modification of work by
Daniel Lobo)

Computing for Personal Use
By the 1970s, new workplace technology filtered into homes in the form of entertainment devices. With
technological improvements and more accessible prices, the value of a computer in the home—to help
manage everything from household finances to children’s homework assignments—was becoming evident.
The advertisement for the Apple II computer shown in Figure 1.7 shows what this early technology looked like.

Figure 1.7 This December 1977 advertisement for the Apple II computer touts its uses around the home, such as organizing
finances, storing recipes, and gaming. (credit: modification of “Apple II advertisement Dec 1977 page 2” by Apple Computer
Inc./Wikimedia Commons, Public Domain)
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In the early 1980s, personal computers were made available to the average consumer through retailers such
as Sears and Radio Shack. In 1981, IBM introduced a personal computer—first known by the code name
“Acorn” and subsequently renamed the IBM PC—that included the Microsoft operating system and Office
software, as well as an Intel microchip. Soon to follow was Apple’s Macintosh computer, launched in January
1984, running Apple’s own operating system and officially establishing Apple as competitors to Microsoft and
the PC. Many of these new designs were streamlined and user-friendly for the whole family. Moreover, the
price point made them more attainable for the consumer, though still expensive for that time.

Initially, home computers were focused on gaming and entertainment. Figure 1.8 shows what that primitive
technology looked like in the 1980s. Classic games such as chess and solitaire were translated into the
computer environment, a trend that quickly caught on even with rudimentary graphics and text-based games.
These games allowed the user to experience the computer’s capabilities in settings far beyond the workplace
and established the personal computer as a technology to support not only work, but pleasure and
entertainment, too.

Figure 1.8 (a) The Apple II and (b) the Commodore PET offered video games that popularized the use of computers at home. (credit
a: modification of “Living Computers – Apple” by Michael Dunn/Wikimedia Commons, CC BY 2.0; credit b: modification of
“Commodore PET Exhibit at American Museum of Science and Energy Oak Ridge Tennessee” by Frank Hoffman/Wikimedia
Commons, Public Domain)

With developments such as disk storage and programming capabilities, the market for personal computers
continued to grow. Manufacturing costs decreased with innovations in the industry and as many producers
shifted manufacturing overseas. Although computers evolved into home workstations with capabilities beyond
gaming, the home computing trend was slow to catch on. Many potential home users simply did not see the
value in owning a personal computer; in the late 1980s, fewer than 20 percent of households owned one. This
changed in the late 1990s and early 2000s, when the home computer industry exploded with the expansion of
the internet, improved interfaces that were less technically challenging for the average user, and customizable
products and features such as color schemes. Increasingly, home workstations became the place to maintain
family finances, store recipes, and write school research reports. Email, followed quickly by instant messaging,
offered a new way to connect and communicate. Then came a way to connect to the internet without wires,
using high-frequency radio signals.

Since 2000, the warp speed of innovation has brought to market lightweight laptops that can be easily carried
from workplace to workplace. The computing power of the computers that first took astronauts to the moon
was similar to that of a couple of today’s gaming consoles. Many modern home computing devices are laptops
less than one inch thick, equipped with high-speed connectivity, high-quality graphics, and touchscreen
capabilities. Computing power today has increased nearly 1 trillion percent since the 1960s.
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Technology Today
The rapid trajectory of innovations in computing has forever changed today’s workplace, where computing
power is at our fingertips. It is difficult to imagine any industry that doesn’t depend on computing technology
as an integral part of its business. Some of the more basic technologies that are present in businesses may
include:

• direct deposit of paychecks
• key card building access
• shared company computer drives for document storage
• paperless documentation systems for recordkeeping
• high-speed printers/copiers
• automated inventory systems

Industries that are traditionally considered nontechnical have also embraced improvements that depend on
computing technology—for example, farmers can control irrigation and monitor field conditions. Computing
technologies have also enabled individuals to embark on entrepreneurial ventures that once only seemed like
a dream and have launched some of them into marketplace leadership. From manufacturing to health care to
the service sector, we can see the impact of computing and how technological innovations continue to shape
the future of many industries.

For example, consider the auto industry, where advances in technology continue to pave the way for changes
in how we drive, safety improvements, and new ways to purchase vehicles. Recent innovations include the
introduction of self-driving vehicles (see Google’s self-driving car, Waymo in Figure 1.9) and of vehicle-to-vehicle
communication—cross-communication that allows cars to wirelessly share information such as speed, spatial
proximity to other cars or objects, and traffic status, with the potential to reduce vehicle crashes and
congestion on roadways. Technology has also created a space for nontraditional car dealers, such as Carvana,
that offer an online purchase experience and home delivery. The use of technology in the auto industry can be
seen at all stages of the business cycle.

Figure 1.9 Google’s Waymo, a self-driving car, can navigate roads, maintain safe speeds, and see obstacles in time to apply the
brakes. (credit: “Google Self-Driving Car” by R Boed/Flickr, CC BY 2.0)

Computing technology has also brought substantial changes to the health-care industry. Most medical
practices and hospitals utilize electronic medical records. These records and the ability to share them across
providers have increased the efficiency and accuracy of record management and have also increased the
transparency of information provided to patients and their families and care providers. Performance of
surgical procedures has been advanced through the use of visualization technology and robotics. Figure 1.10a
shows a robotic arm used in surgery.

More recently, telehealth and virtual health-care options have grown. Figure 1.10b shows a virtual telehealth
appointment. These options have reduced many barriers (including some financial barriers and transportation
issues) for those seeking care for a variety of needs, including mental health issues, child illness, or support for
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the elderly. This virtual option has not only added convenience, but has also improved communication
between patient and provider, increased speed of care, and allowed patients to take a better informed and
more active role in addressing their own health-care needs. And, of course, the use of virtual technology for
health-care needs was a lifesaver during the COVID-19 pandemic, when in-person appointments were too
risky.

Figure 1.10 (a) Robotic surgery and telehealth services are two health-care industry-changing technologies. (credit a: modification of
“Laproscopic Surgery Robot” by GPA Photo Archive/Flickr, CC BY 2.0; credit b: modification of “People on a Video Call” by Anna Shvets/
Pexels, CC BY 2.0)

With today’s available technologies, organizations and individuals alike are continuing to rethink the traditional
business model. Many organizations have come to see the value of giving employees the freedom afforded by
working from home, and even many industries that had resisted telecommuting learned to incorporate it as a
necessary response to the COVID-19 pandemic. Some companies have found that organizational efficiencies
can be realized in terms of cost savings, improved employee satisfaction, and enhanced productivity. Other
businesses, such as smaller retailers, have shifted more resources to e-commerce. Banks have found
innovative ways to connect with their customers using technology rather than through in-person transactions.
Still others, such as restaurants, have used technology to deliver their products to consumers in new ways. In
Figure 1.11, customers can order directly through the internet à la Uber Eats or even have their food delivered
by robot.

Figure 1.11 (a) Uber Eats is a popular food delivery service that is becoming more widely available because of technological
advances. (b) Autonomous delivery robots are becoming a more common sight on campuses. (credit a: modification of “Uber Eats
bicycle” by Yuya Tamai/Flickr, CC BY 2.0; credit b: modification of “Starship food delivery robot” by bikesharedude/Flickr, Public
Domain)
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REAL-WORLD APPLICATION

Technology and Food Trucks

Food trucks have been growing in popularity in the early decades of the twenty-first century. In fact, the
food truck industry has grown at a faster rate than traditional restaurants. The availability of technology has
helped foster this growth, especially in two areas: point-of-sale (POS) systems and social media marketing.
It used to be that food trucks could accept only cash because the registers that could take credit cards did
not work on the road. A POS system does even more than exchange money. A food truck can use a POS
product—for example, a product called Square—to track inventory and sales, and can even use social media
to post messages and to make sales.

Our interactions with computing, both at home and in the workplace, rely on interfaces and communications
like those you will likely use in this course. Tools for documenting information, analyzing and exporting data,
and communicating with others form the foundation of business computer applications.

Mobile Devices, Digital Imaging, and Gaming
It might be hard to imagine a world without access to information at our fingertips—or, for that matter, a
world without Xbox or PlayStation. Today, many households no longer have a traditional landline phone,
instead relying on mobile devices. It is estimated that less than 10 percent of homes in the United States have
a traditional landline phone. Think about how advances in digital imaging technology over the past half
century have forever changed the way we capture and preserve life’s notable moments—our days are now
routinely filled with screens and images. The rise of the computing industry has brought along changes in
companion industries that have impacted most of our lives in one way or another.

In this section, you will learn about the origins of the mobile phone industry and its evolution into today’s
diverse handheld computing devices. The rise of the computing industry also led to a new industry, gaming.
You will look at how the gaming industry not only changed the face of family entertainment but also created
additional industries and shaped cultures across the world. Finally, you will explore the digital imaging
industry, the impact on other fields, and recent technological developments in imaging.

Mobile Devices
The concept of a mobile phone has been around a lot longer than you might imagine—since the early 1900s,
in fact. In 1908, a patent was issued for a wireless telephone in Kentucky, but the idea was considered so far-
fetched that its inventors were accused of fraud. (The case was later dropped, and the invention was never
produced.) Not long after, during World War I, Germany was testing radio-based wireless telephones
(essentially two-way radios) on trains traveling from Berlin. By 1940, this technology had improved, and
handheld receivers were widely available and used in World War II, prompting the private sector to use this
emerging technology (Figure 1.12a).

Bell Laboratories, founded in the late nineteenth century by Alexander Graham Bell, was a key player in
bringing mobile phones to the public. In 1946, Bell Labs developed a system to offer a mobile phone service in
cars. Because of the limited number of channels available, the system quickly reached capacity, and was
mostly used by taxi drivers and emergency vehicles localized in urban areas. From the 1950s to the 1980s, the
technology continued to develop, built mostly around radio frequencies.

The first cellular technology using automated cellular networks, called 1G or first generation, was introduced
in Tokyo in 1979. It was deployed to other countries soon after and, in 1981, reached North America, where it
was known as the Advanced Mobile Phone System (AMPS). This led to the launch of the first truly mobile cell
phone, Motorola’s DynaTAC, in 1983 (Figure 1.12b). With a price point of just under $4,000, the unit was not
designed for the everyday consumer. Motorola believed the phone’s customers would include realtors and

16 1 • Technology in Everyday Life and Business

Access for free at openstax.org



large-company executives who could afford the purchase price as well as the $50-per-month plan to use the
device. But they underestimated the appeal of the cell phone. Sales far exceeded projections, and the concept
of the cell phone quickly replaced the unwieldy mobile car phones of the past.

The overwhelming demand, along with advances in digital technology, prompted the migration of the old
AMPS networks to a digital format, an effort that began in 1990 and was completed in the early 2000s. The
popularity of the cell phone also prompted competition between European and American networks. 2G cellular
networks emerged, providing basic short message service (SMS) text messaging capabilities. The first text
message was sent in 1993 in Finland. The 2G network had better security than 1G and was also much faster.
These changes in network capabilities influenced the development of phone technologies.

Although smartphones are seen as a rather new technology, the first smartphone was actually introduced by
IBM in 1993. The Simon Personal Communicator (Figure 1.12c) looked very different from modern
smartphones. Its features included a calendar, address book, and email service. The phone even had a
touchscreen. The price point, around $1,000, was high at the time, equivalent to about $2,000 in today’s
dollars. The device was well received in the United States, where consumers viewed it primarily as a digital
personal assistant that just happened to have phone capabilities. Though popular with business executives,
the Simon stayed on the market for less than a year and sold only around 50,000 units, but it did pave the way
for the smartphones of today. Other notable phone introductions soon to follow were the first flip phone (the
Motorola StarTAC in 1997) and the first BlackBerry device in 1999.

Figure 1.12 (a) This two-way wireless communication device was used during World War II to communicate critical information
among troops. (b) Motorola’s DynaTAC was the first mobile phone to use cellular technologies rather than radio frequencies.
DynaTAC was marketed toward wealthy business professionals at a price point of nearly $4,000. (c) The first smartphone, a personal
assistant device, was a precursor to today’s cell phones. (credit a: modification of “Bärbar radio” by Flygvapenmuseum, CC BY; credit
b: modification of “MF013: Figure 2.8” by Rosenfeld Media/Flickr, CC BY 2.0; credit c: modification of “Simon FIRST Smart Phone” by
Mike Mozart/Flickr, CC BY 2.0)

As the technology rapidly advanced, 3G and then 4G networks soon followed. This allowed faster speeds as
well as streaming services—4G networks were nearly 10 times faster than their 3G counterparts. With this
expanded network accessibility, phones rapidly came to be seen less as a luxury and more as a need.

Apple’s introduction of the iPhone in 2008 had a major impact on the market. With this introduction came the
iPhone operating system (iOS), exclusive to Apple. An operating system is one of the most important
components of a computing device. It runs the interactions between the device’s hardware and software
components (more on these later in the chapter). The second most popular operating system to emerge
during this time was the Android operating system, first developed in 2005 and later acquired by Google.
These two operating systems, each of which has advantages and disadvantages, are engaged in an ongoing
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battle for market share. At the end of 2022, the Android operating system had a majority share of the market
worldwide (nearly 72 percent). Today, nearly 90 percent of Americans own a cell phone; of those, nearly 60
percent are smartphones.

LINK TO LEARNING

It seems that people are either iPhone users or Android device users, with an unwillingness to shift
platforms. Although the two operating systems that run iPhones and Android devices (such as Samsung’s
Galaxy phones), respectively, have similar performance capabilities, they vary dramatically in terms of the
user experience. The proprietary software working behind the scenes also limits the apps, or programs,
that are compatible with each device. Read this article on the differences between Android and iOS
(https://openstax.org/r/78AndroidiOS) to learn more. Which operating system do you prefer? Why?

The adoption of mobile phone technology has had a large economic impact in the United States and
worldwide, giving rise to new products (cell phone cases, pop sockets, wireless earbuds, screen protectors)
that did not exist before mobile phones hit the market. Other industries such as clothing and handbags have
also been impacted: It’s now commonplace for a jacket to have a specific phone pocket, and many handbags
and backpacks have slots designed to accommodate most cell phones. The creation of mobile phone apps has
developed into an entirely new industry that has created many jobs worldwide. And beyond these tangible
effects of the cell phone boom, there have been some significant changes in how we operate in our business
and professional lives. About 40 percent of all business transactions are conducted on a mobile phone device.
Companies rely on mobile technology to conduct essential correspondence with their employees and their
customers.

Gains in efficiency and collaboration across geographic boundaries are now easier than ever. Consumer
product companies use mobile devices to advertise in new ways and to expand their market reach. We may
use the technology to stay in contact with out-of-town family members, to connect to our bank or our health-
care provider, and to make everyday purchases. Many children growing up today have never had a home
landline phone ring or not even heard a dial tone. The dial tone is a sound that indicates that a landline is
active. It can be difficult to imagine a world before cell phones, even though it was not all that long ago they
first emerged on the market.

LINK TO LEARNING

Listen to this video on vintage telephone network sounds (https://openstax.org/r/78Telephone) to hear
what a dial tone sounds like, as well as sounds from telephone technology through the ages.

Digital Image, Video, and Audio Capture Devices
Image, video, and audio capture are another area of technological growth that many people now use daily.
Photography was invented in the mid-1800s, and it took a century and a half for digital imagery to emerge, in
1957. Using binary digits, Richard Kirsch was able to convert a photograph of his son into a digital image
using the only programmable computer available in the United States at the time. The photograph was
scanned electronically in small squares of the image, now called pixels, and reconfigured using white and
black, as Figure 1.13 shows. The binary data for the image could then be stored on the computer. This
development, along with the invention of the microchip, laid the foundation for future work in digital imaging.

18 1 • Technology in Everyday Life and Business

Access for free at openstax.org

https://openstax.org/r/78AndroidiOS
https://openstax.org/r/78AndroidiOS
https://openstax.org/r/78Telephone


Figure 1.13 Kirsch took a photo of his son Walden and was able to capture the image digitally using binary digits. Part (a) shows the
digital scan of Walden Kirsch from (b), the original photo. (credit a: modification of “NBSFirstScanImage” by Russell A. Kirsch/
Wikimedia Commons, Public Domain; credit b: modification of “Walden Kirsch” by Russell A. Kirsch/ Portland Art Museum, Public
Domain)

The scientific community, government, and the military soon took notice of the advantages of using the digital
approach to capturing images. Beginning in the 1960s, NASA used the technology to transmit images back
from space through television receivers. Tech companies created new storage methods, such as saving images
to tape. RCA built the photo-dielectric tape camera for NASA, which was able to store about 120 images on
tape—a huge improvement over the long processing times needed for previous digital images.

This technology continued to grow over the decades, and soon combined with mobile phone technology. In
1997, the first image was taken using a camera phone. Cell phone manufacturers quickly launched new phone
models that included cameras, and most of today’s devices include a digital camera. The 2004 emergence of
Flickr, a popular photo-sharing site, as well as the launch of Facebook that same year, provided new ways for
people to share and connect via digital photographs.

The digital camera revolution transformed how we conduct business and stay in touch with family and friends.
The use of webcams and videoconferencing technology has enabled many to conduct business across
geographic boundaries and to telecommute from home to their job. This has changed the face of the
traditional office environment for all industries and parts of the marketplace, such as government agencies,
corporations, small businesses, and service organizations. And in many ways, digital cameras have changed
our everyday lives. The use of digital cameras has revolutionized many medical procedures and how we
interact with our health-care providers. Digital cameras have enabled us to see space beyond the earth and
moon. Consumer products can be test marketed and brought into consumers lives’ virtually. Parents have the
capability to monitor their babies sleeping in cribs. Doorbell cameras have increased our sense of security in
our homes. The cameras we have at our fingertips today have far surpassed the imaginations of the early
inventors of this technology.

REAL-WORLD APPLICATION

Virtual Reality and Marketing

Virtual reality (VR) refers to a simulated environment that is computer-generated. Through the use of
devices such as a helmet or glasses, the user sees a simulated world and is able to move about it visually.
Instead of simply viewing the scene from an outsider’s point of view, the user is immersed in the actual
scene. Companies such as Nike, Wendy’s, McDonald’s, and Gucci have used VR to creatively demonstrate
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new products to consumers and to allow consumers to interact with a new product concept. Even small
businesses have capitalized on the technology, which enables them to bring ideas in front of consumers
quickly without the expense of creating an actual prototype of the product. This concept has application
across a wide range of industries, from restaurants to real estate to consumer products.

Games and Gaming Devices
Computerized games for entertainment existed long before today’s gaming consoles. When computers were
starting to gain a foothold in the American household, their primary use was for entertainment. The initial
concept of computerized games was centered on taking existing, often traditional games, such as checkers
and chess, and moving those to the computerized platform.

The first video game was developed by an American physicist. William Higinbotham developed the game
Tennis for Two in 1958 using an analog computer with an oscilloscope display. This simple invention laid the
groundwork for one of the most profitable industries in the world. It is estimated that over 60 percent of U.S.
households today have members who regularly play video games. Technology progressed to the first gaming
console, 1967’s Brown Box, and then to 1972’s Atari, with its popular game, Pong. In 1978, Space Invaders hit
the arcade market—a game venue marketed heavily to bowling alleys and retail locations. The arcade craze
became a huge commercial success for the game makers as well as the businesses that purchased the games
(Figure 1.14). Motivated by getting to the top of the scoring list, players were readily putting their quarters into
the machines. Over the next decade, nearly two dozen companies developed arcade games, including the well-
known game Pac-Man, which was introduced to the U.S. market in 1981.

Figure 1.14 The arcade of the 1980s changed how teenagers spent their time and their money. (credit: “the Luna City Arcade” by
Blake Patterson/Flickr, CC BY 2.0)

The decades that followed saw the leap from Intellivision to the Nintendo Entertainment System (NES) and
Nintendo’s handheld Game Boy device. At the end of the 1980s, Sega emerged as a major competitor to
Nintendo. Their gaming system had better graphics and new creative energy, bringing on what would become
some of the most popular games of our time, like Sonic the Hedgehog. As new game concepts emerged,
controversy over violence in games and other questionable content prompted a government response and the
creation of an industry rating system for games.

SPOTLIGHT ON ETHICS

Video Games and Violence

Early video games were based on traditional board games such as chess and checkers. But over time, with
increases in graphic capabilities and new companies coming into the market purely as game developers,
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new game concepts were developed. At times, these new game concepts contained what some considered
to be inappropriate language and situations. The American Psychological Association even considers the
playing of violent video games as a risk factor for aggression. The violence in video games prompted a
congressional hearing on the matter in 1993. The hearing focused on three controversial games: Doom,
Night Trap, and Mortal Kombat, the first video game to include realistic depictions of violence. Despite this,
the game was allowed to be sold, but a new rating board emerged from the hearings called the
Entertainment Software Ratings Board (ESRB). It is a voluntary, self-regulated entity run by the
Entertainment Software Association, which rates games according to their level of violence and
recommends appropriate age levels for users. Some stores will not sell video games without an ESRB
rating.

As the trajectory of advances in games and consoles continues, today it seems that a new and improved
system hits the market every year. Many people also have games downloaded on their phones. And the
concept of e-sports has reached colleges and universities, both as an academic program and as an NCAA-
recognized collegiate sport. The future of video games seems to be moving in the direction of artificial
intelligence (AI) and virtual reality simulations, with both Apple and Google making company acquisitions in
that arena.

REAL-WORLD APPLICATION

E-sports in Colleges and Universities

The term e-sports refers to a sports competition using video games. Like professional football, baseball,
and other sports, e-sports events have a large following, including both spectators at the actual events and
others who join to watch the action virtually. E-sports became a large player in the gaming industry around
2010 and has since exploded worldwide to such an extent that colleges and universities are taking notice.
The impact on the academic environment can be seen in three key areas: academic programs such as game
developing, student groups focused on gaming, and collegiate sports. Some institutions are even offering
scholarships for e-sports similar to traditional athletic scholarships.

Mobile technology, digital imaging, and gaming capabilities today are inherently intertwined. Often, all three
coexist on a single device. As just one example, consider how we use Google Photos on our phones to share
family memories. Extending this capability, in a video game app on a mobile phone, a user can create a
character using their photo and then have this virtual character interact with other players across the world. In
the business world, many of us now use Zoom or other videoconferencing tools to connect with colleagues
remotely. Outside of work, users of gaming consoles can chat with other players through their phones or
through the console. Many games today are designed from the start to be played on multiple platforms.
Microsoft is even offering mobile phone plans for customers. Each technology has changed our lives, but
together their impact has been remarkable.

Advances in Technology
Technology is advancing faster than what was previously believed to be possible. In just a short period of time,
we have gone from having no computers to today where nearly 90 percent of people in the United States have
some access to a computing device. What’s also impressive is that 90 percent of data in the world today was
generated in just the last two years. Today’s 5G technology is 100 times faster than 4G, and the rate of
adoption of new technologies has diminished from years to mere months in some cases. As you can see in
Figure 1.15, older technologies such as refrigerators and landlines took decades to reach widespread adoption
with a majority of Americans buying them, while today’s smartphones and tablets achieve broad adoption as
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soon as they enter the market.

Figure 1.15 (a) Historically, the rate of adoption for new technologies has taken decades. (b) Now, new products to the market reach
more than a 50 percent adoption rate in just a few years. (credit a and b: modification of work by Our World in Data, CC BY 4.0)

Computers today typically double their capabilities in less than two years. With this in mind, we can expect
computing capabilities to continue to increase at a similar rate. The rate of change is increasing exponentially
because companies are building on existing technologies. Researchers can take what has worked well to
rapidly refine and enhance technologies for innovations and improvements. Additionally, resources from
across the world—both financial resources and human capital—are being pumped into supporting these
technological advances. To put the popularity of computer technology into perspective, consider how long it
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takes to get fifty million users for a product. Radio took thirty-eight years after its invention to become that
popular, while the hit game Angry Birds needed only about thirty-eight days to reach that milestone. Figure
1.16 shows some common products and how long each of them took to reach the same milestone.

Figure 1.16 Products are being adopted at a faster rate than ever before. The advent of social media has exponentially increased the
spread of some of these later innovations. (data source: Interactive Schools, https://blog.interactiveschools.com/blog/50-million-
users-how-long-does-it-take-tech-to-reach-this-milestone)

AR/VR Simulations
Using digital objects in a real-life picture or scene is called augmented reality (AR). For example, think about
the overlays or filters you can put on photos in some social media apps. A mostly simulated, 3-D environment
in which the user can move about visually and interact is called virtual reality (VR). Both technologies have
applications in many industries. For example, if you want to try a new style of glasses, you could use AR to see
what those glasses might look like on your face. You might use a VR simulation to offer your insight on a yet-
to-be-developed product concept. Other applications could be in manufacturing, real estate, medicine, and
education.

One recent example of the use of VR was seen when the NBA had to cancel games because of the COVID
pandemic. To keep fans engaged, the league offered VR passes that enabled ticket holders to attend past
games in a VR environment and nearly be courtside for the action. The only equipment they needed was the
app and a VR headset. (VR headsets are widely available for purchase, typically for under $200.) This was a
unique use of the technology to keep the audience’s attention during a difficult time.

Robotics and Automation
Robotics should be distinguished from automation, which refers to using computers or machines to do tasks
that could be completed by a person. Automation can be quite technical, using computerized technology, or it
can be a mechanical process using machines. For example, processing retail transactions, which was once
handled by people using pen and paper, is now well automated through the use of a computer.

On the other hand, robotics is centered on robotic machines, which are now used in nearly every industry.
These machines can automate some tasks that were previously performed by humans, but they can also be
programmed to perform tasks that no human could perform. Consider some medical procedures that can now
be carried out using robotic machines but that simply were not possible in the past, such as certain procedures
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on the brain. The use of robots in the workplace can reduce errors, increase safety, enhance productivity, and
reduce time spent on routine tasks for employees.

Robotics has been a part of the manufacturing environment for some time. But today we see increasingly
unique applications of robotics in the workplace. For example, the University of California is testing a robotic
pharmacist, which will perform many of the functions of a traditional pharmacist, such as choosing the correct
prescription and dosage. Robots are also being used to keep areas clean and sanitized; in some cases, robots
can be used to clean up spills that might otherwise be hazardous to humans. Giant Food Stores is piloting a
program that uses robot assistants throughout the store to monitor for spills and potential hazards in the
aisle. Drones (a kind of robot) are used in some military applications, and the use of drones is being tested for
package delivery. Finally, robots can be used to find and rescue victims in disaster situations where it might be
too dangerous to send in typical emergency personnel.

Nanotechnology
Another advancement in technology is nanotechnology, which entails changing individual molecules to
produce different properties or attributes. It can be applied to a wide variety of fields, including engineering
and chemistry, as well as to medicine and consumer products. The U.S. National Nanotechnology Initiative was
launched in 2000 to manage research and development in the field, and the first academic program centered
on nanotechnology emerged by 2004. At that time, the technology was being heavily tested with consumer
products. Nanotechnology has been used to make golf balls go straighter, make car bumpers more dent
resistant, and give cosmetics and lotions deep skin-penetrating properties. With nanotechnology, drug
delivery to patients can be better targeted and controlled. Filters made using nanotechnology have been used
to filter drinking water sources in countries such as India. In agriculture, nanotechnology has improved yields
with the use of soil analysis and targeted fertilizer applications. Nanotechnology can also be used to better
combat air and water pollution through increased filtration efforts. Research into nanotechnology possibilities
continues to expand.

Wearables
A wearable is a device that uses computing technology to collect and receive data via the internet. You may
already be using a wearable technology device—for example, a smartwatch. Using similar technology to a
smartwatch, Motiv has developed a ring that can track fitness goals and sleep cycles. As Figure 1.17 shows, you
would never know it was a smart ring from its outward appearance. Other wearables include heart rate
monitors and a medical alert device. These devices can be worn, incorporated into apparel, or even embedded
into the skin. The military is even considering using embedded wearables to keep track of troops. Some
cutting-edge wearables are centered in the medical industry; for example, a wearable has been developed that
can detect early signs of breast cancer.

Figure 1.17 The fitness tracking ring is a new take on the fitness tracker. It can track activity and sleep cycles and send the
information to your smartphone. (credit: “Left hand with Oura smart ring on finger, right hand shows phone with the Oura app´s
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energy and activity statistics” by Marco Verch/Flickr, CC BY 2.0)

Some professional athletes use wearables to improve performance and track incidences of concussions.
Wearables for children are becoming more popular for location tracking. The possibilities are endless. It is
estimated that there are nearly a billion wearable devices active globally, over 50 percent of which are
smartwatches. And about a quarter of wearable users wear the device while sleeping. Revenues in the industry
are nearly $10 billion in the United States. Wearables are now also being used for ticketing purposes at
concerts and amusement parks.

LINK TO LEARNING

You may have a smartwatch or use a fitness tracker when working out. These are commonplace wearables
in today’s society. But where is the industry headed? Wearables have been identified as an area of growth in
the economy. Many tech companies are focusing on innovative ways to incorporate internet-connected
devices in different settings, as illustrated in this article on the wearable tech of the future
(https://openstax.org/r/78WearTech) in Time. You may be surprised to discover just how futuristic they are
becoming.

Smart Spaces
An internet-connected space—office, home, car, or building that incorporates technologies that can be
controlled from the internet—is called a smart space. In homes, we see products centered on convenience,
security, and comfort. The goal is to improve your life without interfering and creating a nuisance. For
example, you can have a thermostat that enables you to control the temperature in your home from your
phone, even when you are not at home. You can have a device that switches on the lights or the TV when you
verbally ask it to do so, or home security lights that come on for your safety as you approach the front door.
With products such as Google Home Smart, shown in Figure 1.18—a virtual assistant that is connected to the
internet—all members of the family can control many devices. If you have your devices synced to one another,
you can even have Google Home tell you your calendar appointments for the day or set reminders and alarms.

Figure 1.18 Devices such as Google Home Smart are creating "smart" spaces that are able to be managed from remote locations,
such as the workplace. (credit: “Home Automation22” by mikemacmarketing/Wikimedia Commons, CC BY 2.0)

Similar technologies can be employed in the workplace. Smart offices/buildings can be equipped with many of
the same technologies—a good strategy for managing utility costs and adding convenience for employees.
Smart offices can make employees more productive by giving them more time to focus on creative and

1.1 • Computing from Inception to Today 25

https://openstax.org/r/78WearTech
https://openstax.org/r/78WearTech


strategic tasks as opposed to more routine and mundane responsibilities such as sending invoices or even
turning on the office lights. Job satisfaction can be increased by giving employees more control over their
workspaces.

A unique application of the technology is its use in schools, which is being piloted in Texas with a partnership
between two private companies and Microsoft. They are equipping schools with a variety of connected devices
centered on security and communication in an emergency. These devices can communicate internally during
an emergency, such as a fire, and can also communicate externally with first responders and police.

There are some challenges in the smart space industry. Many concerns arise about the invasive nature of
some of the connected devices, including concerns about recording personal information, governmental
monitoring of the information, and the usage/security of the data collected. Another challenge is educating
consumers on how to use the equipment and its capabilities. Finally, the price point is high for some of these
devices because many are still rather new to the market.

AI and Machine Learning
Using computers, robots, and machines to mimic the human brain is called artificial intelligence (AI). From
problem solving to perception to learning, the goal is to reduce errors and minimize human biases and
emotions in the process. In machine learning, a subset of AI, an AI device learns on its own, gathering data
and using that data to continuously refine and “learn” about the system and its usage. Speech and image
recognition are two examples of AI. Another example is a robot vacuum cleaner, where the AI system uses a
computer and the data it collects to know where to clean in the home. Figure 1.19 shows the popular Roomba
vacuum. Still another example is seen when websites show recommended products for you based on your
prior searches. The device learns your likes and dislikes based on your clicks and other related data.

Figure 1.19 AI in the home can take over inconvenient or repetitive tasks such as cleaning. (credit: “iRobot Roomba 870” by Kārlis
Dambrāns/Flickr, CC BY 2.0)

In a more large-scale use of AI, for quite some time airlines have made use of autopilot features, including
robotics, image recognition, and GPS, to fly and navigate an aircraft. In the retail industry, the use of AI is
expected to grow about 30 percent by 2028, a strong increase, to include applications centered on
personalizing the customer experience as well as managing distribution and inventories. Today, AI technology
has evolved to create stories in the style of famous writers or even write detailed research papers when
prompted.

Workplace and Career Implications
Technology in the workplace has made processes faster and more reliable, increased collaboration, made it
possible to work from anywhere, and, overall, changed the typical office culture. The adoption of new
technologies in the workplace has some distinct career implications for individuals, while organizations need
to figure out the best mix of humans and technology to allow the business to thrive.

The idea that technology eliminates jobs is a myth: Technology introduced into the workplace is intended to
help employees do their jobs better, not to replace jobs. But this does mean that employees may need to shift
from more traditional tasks to tasks that are more technology-driven. For example, an employee in the human
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resources field may have spent hours sifting through résumés for contact information to schedule interviews.
With technology, this process can be automated, freeing up time for the employee to focus on more
meaningful tasks such as interviewing candidates and decision making. In a manufacturing environment,
technology can enable employees to focus on process improvements and problem solving rather than working
with repetitive tasks on a production line.

These changes affect our future educational and training needs. Some jobs that require a lower skill base have
been replaced with technology. Additional training may be necessary in areas such as troubleshooting
technology in the workplace. The shift for employees today is toward capitalizing on brain power, reserving
human capital for the complex, multifaceted tasks that technological advances cannot tackle. Therefore,
training and education in critical thinking, communication, problem solving, and teamwork skills are a
necessity. These skills are of value at all levels within an organization. Jobs in the technological fields are
expected to grow; however, an emphasis will be placed on the essential skills of communication, fostering
cross-functional collaborations, and creative problem solving that cannot be replicated by technology.

REAL-WORLD APPLICATION

Changing Careers

Facing a career change (whether voluntary or not) can be a scary proposition, especially if you have been in
your current position for some time. With changes in technology, many people will face decisions regarding
their career direction, either needing to change focus within their current industry or, in some cases,
pivoting to an entirely different industry. Here are some tips to consider when you are facing a career
change:

• Identify areas where you can further develop your technological skills.
• Use your network to find out about job opportunities.
• Take a certification course for a particular computer program or a class on enhancing your public

speaking skills.
• Reach out to your network, either social media or sites such as LinkedIn, to make people aware that

you are interested in a new opportunity.

It is important to take the time to find the right opportunity and then to take small steps to get where you
want to be. Think about your long-term goal. Do your research by interviewing those in the industry you
want to be in or utilize a job coach/mentor to assist in your journey. Would you consider a career change?
Why or why not? If so, what strategies will you use to make the transition easier?

Importance of Lifelong Learning
To protect your job security in the workplace of the future, you will want to demonstrate to your employer that
you are committed to lifelong learning. With the rapid acceleration of technological change, some employers
today are actively seeking employees with a lifelong learning mind-set. Lifelong learning requires continuous
self-improvement and education—the motivation to be a continual student. It often occurs outside a
traditional educational system and includes both informal channels and formal ones such as corporate
training programs. Employee development is a core part of many human resources departments within
organizations. Mandatory training or education may be required for your position, or voluntary opportunities
may be offered to employees. Taking the initiative to learn and adopt new workplace technologies can be both
professionally and personally fulfilling.

There are some strategies you can use to help further a lifelong learning mind-set. First, understand your
personal interests and set some goals that align with them. Lifelong learning does not always have to
incorporate building skills or knowledge applicable to the workplace. It might be centered on something you
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enjoy in your personal life. For example, suppose you really enjoy genealogy and local history. Perhaps you
decide you want to learn more about the history of your hometown. For local history, you might visit the local
historical society or find internet resources about the history of your hometown. Then, you can determine how
you might incorporate this desire for learning into your life. Will you do something related to your personal
learning goals once a week? Will you share your new knowledge with coworkers, friends, or family? Or maybe
you can find a way to utilize the new information in the workplace or the community.

There are many ways to incorporate a lifelong learning mind-set into your life. Regardless of your approach,
the lifelong learning mind-set can be advantageous from both a personal and a professional standpoint.

1.2 Computer Hardware and Networks

Learning Objectives
By the end of this section, you will be able to:

• Explain the components that make up a computer
• Describe how computers process and store data
• Discuss what networks are and how they function
• Understand how to maintain and clean computer components

You do not need to know how to build a computer from scratch to effectively use a mobile device or other
computing technology. However, a basic understanding of how computers operate can help you troubleshoot
problems, and with some knowledge of computer terminology, you will be a more informed consumer when
you are making technology purchases. Although there are technological and programming differences
between computers, tablets, gaming consoles, and mobile devices, all are built around the same basic
technology. This technology has evolved through innovations in the field to offer users enhanced features,
reduced costs, and increased operating speeds.

This section will cover some basic aspects of computing. These concepts will give you a broader understanding
of the technology you are using beyond simply operating the computer or tablet for personal or work tasks.

What Is a Computer?
Although today’s computers look and behave differently from early efforts, they include the same core
features. A computer is simply a programmable machine that can execute predefined lists of instructions and
respond to new instructions. A very large computers called a mainframe is capable of great processing speed
and data storage. Mainframe computers today typically function as servers. Servers are powerful computers
that act as a central hub of the technology needs for the organization. Servers support data storage, sharing of
computer programs, and hosting websites. Another name for a computer program (language) or set of
programs with the end goal of converting data into processes and actions is software. Software, such as
Microsoft Word, allows the user to interface with the computer. Accessories such as a keyboard, mouse,
printer, and monitor are called hardware. These input and output devices allow us to communicate with the
computer and to extract information from it.

There are many different types of computer systems, including workstations, microcomputers, and
supercomputers. A workstation is a powerful single-user computer that is similar to a personal computer but
more powerful. They are typically used to manage business operations such as invoicing customers, managing
online sales, or ordering inventory for the company. A minicomputer is similar in power to mainframe
computers but, as the name implies, is much smaller in size and can be used in midsize organizations that
need more power than what a typical personal computer might provide. A supercomputer is extremely
powerful and has the fastest processor available. These computers can be used to process highly complex
scientific data at fast speeds.

Computers are hard to get away from—they’re in all kinds of everyday devices. Appliances, cars, watches, and
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even the heating and cooling systems in our homes incorporate computer technology that enables us to send
and receive information from these devices. Today’s smartphones are essentially minicomputers.

How Computers Work
Most computers consist of a few basic elements. The motherboard is the hardware that runs communications
for the computer system (Figure 1.20a). It sits within the system unit, which is the container that houses most
of the computer’s electronic components. The central processing unit (CPU) contains a single chip called a
microprocessor (the “brains” of a computer system). A microprocessor (Figure 1.20b) consists of a control and
what is known as an arithmetic-logic unit, which performs math and logical operations within the computer
system.

Figure 1.20 Two essential components of a computer’s inner workings are (a) the motherboard and (b) the CPU’s microprocessor.
(credit a: modification of “Green Motherboard” by Pixabay/Pexels, CC0; credit b: modification of “Intel Core 2 Duo E6750” by Nao
Iizuka/Flickr, CC BY 2.0)

Personal Computers and Devices
Numerous types of computers and devices are available for business or personal use today. A personal
computer (PC) is a microcomputer that is suitable for individual use, including a desktop computer, laptop,
tablet, smartphone, and wearable device such as a smartwatch. Desktop computers are personal workstations
that you set up at a fixed location, such as a desk. They are typically equipped with a tower (where components
such as the motherboard are housed), a monitor, and other peripheral accessories, such as a keyboard,
mouse, and printer. Laptops are portable and lightweight—small enough to fit into most briefcases. The
computer and monitor are combined, and peripheral accessories are optional. Tablets, such as the Kindle, are
smaller than laptops and have less functionality but are still very powerful, with many features that support
everyday personal use. They are even more portable than laptops, and their touch screens, which don’t require
a mouse, are their distinguishing feature.

Operating Systems
As stated earlier, a computer’s operating system is software that is essential to all functionality and use of the
computer. It controls the computer’s activities, from memory to processes, and ensures that hardware and
software components can “speak” to each other. It provides the interface necessary for humans to
communicate with the computer and all its components. Here is where the big players enter the computing
scene: Microsoft Windows, Apple macOS, and Google’s Android OS, to name a few. You will typically interact
with Windows and Apple macOS on a laptop or tablet. The programs that we discuss in this text, such as
Google Sheets and Microsoft Word, use their respective operating system. The Android and iOS operating
systems are used for mobile devices. You are likely to see these operating systems in use daily, both in the
workplace and in your personal life.

Information Processing, Storage, and Memory
Businesses take great care in procuring computers that can handle the work that needs to get done. Before
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selecting computers, they’ll investigate some basic functions that have to do with how fast the devices process
information and how well they store data. The information processing cycle is the sequence of events
involved in processing information—input, processing, storage, and output:

• Input consists of entering the data and information into the computer system.
• Processing involves a series of operations performed by the computer to organize, interpret, or otherwise

make use of the information input into the computer.
• Output entails viewing this processed information in a way that makes sense to the user, either through

the monitor or as a printout.
• Finally, storage is the process of saving information into the computer for future use.

There are two types of storage, primary storage and secondary storage. Primary storage refers to temporary
files that are available only when the computer is on. Primary storage is also known as short-term memory, or
random access memory (RAM). This type of memory is not meant to save information for future use but
allows the computer to operate and process information quickly as it is being used. Secondary storage is
considered permanent storage on a computer system or removable device, such as the old floppy disks. You
may also be familiar with another type of memory—cache. The computer’s cache holds data that can be
retrieved quickly, often including downloads from websites or other information that can be used to load
websites faster. The cache operates in the background to help the computer operate more quickly.

A hard disk is considered secondary storage where users can save files and retrieve data and programs. There
are two types of hard disks, internal and external. An internal disk drive is housed within the computer unit,
and users update and produce copies of all files they need. Figure 1.21 shows a few types of external disk
drive. These are portable, allowing the user to save information outside of the computer unit for use
elsewhere.

Before an operating system loads and is ready to use, the computer needs hardwired instructions, called read-
only memory (ROM). Businesses should be sure to procure computers with sufficient RAM and to make sure
that data storage solutions are in place to handle their needs. The amount of RAM impacts the speed at which
programs run. Computers with less RAM are slower and can hinder work productivity in the workplace. Often
businesses will begin with less RAM and eventually upgrade to higher levels as their business and needs
expand.

Figure 1.21 Different types of storage devices used over the years include (a) floppy disks, which are no longer used, (b) CD-ROM
disks, and (c) flash drives. (credit a: modification of “Floppy Disk Data” by OpenClipart-Vectors/Pixabay, CC0; credit b: modification of
“Dvd Cd-Rom Compact Disk” by OpenClipart-Vectors/Pixabay, CC0; credit c: modification of “Usb Disk Disc” by Clker-Free-Vector-
Images/Pixabay, CC0)

Networks
Talk about networks is common in the workplace. You will hear that the network “has gone down” or “is
running slow.” What does this mean? What is a network, anyway? A network is a connection of two or more
computer systems, as well as devices, by either a cable or a wireless connection. Networks may be simple or
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complex, self-contained within a small area like your home or dispersed over a large geographic area.

These different types of networks are called personal area networks (PANs), local area networks (LANs), and
wide area networks (WANs). Personal area networks typically connect personal computers and devices within a
small area. Local area networks (LANs) are primarily used by colleges and universities as a way of linking
computers and sharing printers and other resources. Wide area networks (WANs) allow access to regional
service providers and span distances greater than 100 miles. The internet is a wide area network.

Network Hardware
In order to function properly, networks depend on a router. These devices perform two functions: they direct
the data traffic, so to speak, from one network to another, and they allow multiple computers to use the same
internet connection. Routers can vary in shape and size and also by performance. Switches coordinate direct
flow of data between components. Gateways are devices that allow one local area network to be linked to
other LANs or larger networks. The purpose of a hub is to send a received message to all connected devices
rather than just the intended ones.

Network Servers
A client is a device that requests and uses resources available from other devices on the same network. For
example, if you use a computer at your local library or a computer located on your campus, you are using a
client device. In the workplace, the computers that employees have at their workstations are often connected
through the network and are clients to that network. A server connects devices and allows for resource
sharing across the network. Servers may have different functions. Examples are application servers,
communication servers, database servers, file servers, print servers, and web servers.

Network adapter cards connect computers and devices to a network, enabling the sharing of hardware,
software, and data across the network. The network adapter card connects the system unit to the network via
a network cable. These cards used to be purchased separately in the early days of personal computers, but
most computers today come with integrated cards embedded in their motherboard. The devices sending and
receiving data are identified by transmission control protocol/internet protocol (TCP/IP), which organizes
the information into small packets for transmission through the network and across the internet. One of the
most widely used internet protocols, used for web traffic, is hypertext transfer protocol (HTTP). HTTPS is a
more secure protocol than HTTP, for users and website owners alike, because users’ information is protected
with a “pass” safety inspector embedded within the protocol. Before exchanging confidential information, such
as credit card information, online, users should always verify if the website begins with https. And even with
this safer and more secure connection, you should always be cautious when sharing information.

Secure File Transfer Protocol (SFTP) is a secure version of file transfer protocol; it provides a secure connection
for transferring files. User datagram protocol (UDP) is a communication protocol that works across the
internet for time-sensitive transmissions such as video playback. Its main goal is to speed up communication
by establishing connection before data is transferred. Another security protocol that uses encryption to help
ensure privacy of information and communications across the internet is secure sockets layer (SSL).
Cybersecurity is a major concern of computer users, both personally and professionally. As encryption
technology has progressed, there have been several iterations of SSL protocols. Today, the encryption is
referred to as TLS (transport layer security), but the intent is the same—providing protection of data that is
shared via the internet.

SPOTLIGHT ON ETHICS

Secure Information Transfers

One of the most common types of cybercrimes is identity theft, which occurs when a hacker steals an
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individual’s identity for economic gain. The increase of hackers, individuals who gain unauthorized access to
computer systems in an attempt to steal someone’s information, has become a major issue and has led to
the development of such software programs as Norton Antivirus and LifeLock to protect consumers’
identities.

Another major safety concern when using computers is the existence of malware and viruses—software
that can damage or slow down a computer system by opening an insecure portal into your computer.
Malware can also damage files and allow hackers access to files and information stored on your computer.
Depending on how these programs are written, they may only damage the computer that initiated the
virus/malware, or the malware may flow throughout networks by attaching itself to other files that are
exchanged across the network.

Users should be very careful when opening files sent to them in email or when clicking links to unfamiliar
websites. Phishing scams are very common. These are attempts by hackers to gain access to your personal
information, such as the credentials you may use to access financial and other sensitive accounts. Phishing
most often occurs through email that appears to come from a reputable source, or via social media. It is
always best to avoid logging into accounts through links sent in email, clicking on links that are not secure
or recognizable, or opening files unless you know who the sender is and what is being sent.

1.3 The Internet, Cloud Computing, and the Internet of Things

Learning Objectives
By the end of this section, you will be able to:

• Explain how the internet has evolved and how it functions in today’s world
• Describe how to conduct an effective internet search
• Conduct business research on the internet
• Explain the use of cloud computing for business
• Define the Internet of Things

The internet has dramatically transformed how we access and manage information, both at home and in the
business world. For many people, it’s almost impossible to go about your day without needing access to the
internet. It’s in your home—from smart doorbells to TVs, thermostats, and personal assistants. It’s on your
wrist, in your car, and, of course, on your phone. It’s big business and it is integral to just about every business
out there.

Established businesses have taken advantage of the ability to reach new customers by selling their products
online, while would-be entrepreneurs use the internet to open online storefronts. The internet also enables us
to conduct both personal and professional transactions more efficiently—from accessing important health-
care documents to filing our tax returns, transferring money between bank accounts, and making payments to
individuals online. Many of us practically run our lives through our phones.

LINK TO LEARNING

Read this article on the invention of the internet (https://openstax.org/r/78InternetInv) to learn more. When
was the internet first developed and for what purpose? How did it evolve into the internet we use today?

The Internet: From Inception to Today
The internet as we know it today originated in the 1960s with the idea of using a traditional telephone
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switching circuit to wirelessly connect computers in a network. The telephone system would allow these
computers to communicate with one another, exchange data, and run shared programs. Researchers and
engineers from both the public and the private sector came together to form the Advanced Research Projects
Agency (ARPA) to investigate ways the U.S. military could improve communications, with the goal of protecting
the country from unexpected enemy attacks.

In 1969, a new digital packet switching technology was introduced to enable two computers to communicate
with each other, replacing the telephone circuit technology. Packet switching happens when computers break
down data or information into smaller groups (packets) and transmit several of those packets over the
network. When the packets reach the destination computer, they are put back together in their original form.
The communication occurred through the traditional phone line system but was transformed into digital data
during transmission. The packet technology did not require a dedicated telephone line to network the
computers together. This was the origin of the ARPA Network, or ARPANET, and is the same technology used
today for the internet. The networked computers were also able to send simple messages to one another,
setting the stage for email as we know it today. Figure 1.22 shows an early iteration of the ARPA network.

Figure 1.22 In the 1970s, ARPA’s network consisted of a series of nodes (connectors) and lines that stretched across the continental
United States. (credit: modification of “Arpanet 1974” by Yngvar/Wikimedia Commons, Public Domain)

In less than five years, the network expanded to include thirty different organizations and institutions across
the world, and by 1975, ARPA determined that it needed to establish standards for consistency. These rules
helped ensure that the interconnected network, or internet, was secure and efficient. The transmission control
protocol/internet protocol (TCP/IP) was established to standardize the computer language used between the
computers in the network. With these rules, a unique internet protocol address (IP address) allowed users to
determine the geographic location of any computer on the network. The IP address was also used to direct the
transmitted information to the appropriate destination. Because the IP address is a series of numbers and
decimal points that can be hard to remember, the domain name system (DNS) was developed in 1983 to
convert IP addresses into simple names. The DNS thus became the phone book for the internet, enabling
users to send a message using their name, the symbol @, and the location of the computer as identified by its
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domain name. With the DNS, the foundation of the World Wide Web (WWW) was put into place. The term
internet simply refers to the interconnected computers, a network that now extends across the world. The
WWW is the content that has been collected over the internet and is available online. By 1981, the network had
grown to over 200 hosts. The first domain name was registered in 1985 to a computer manufacturer.

By the mid-1980s, scientists and researchers across the world were working on computer networking
technology. With the success of the ARPANET, the ARPA group was charged with working on other, more
cutting-edge projects. The ARPANET-connected organizations were predominantly government entities or
educational research centers; the system was not available for commercial or personal use. Consequently, the
project was moved to the U.S. Department of Defense, where the network continued to expand through
various branches, including NASA and the National Science Foundation (NSF). In 1985, the NSF created the
structure for a supercomputing center to connect colleges and universities, research centers, and regional
networks. By the end of the 1980s, this network had grown to over 30,000 hosts. As a result, ARPANET was
decommissioned in 1990.

In 1989, the first dial-up internet service provider (ISP) was established, allowing commercial access to the
internet. The term dial-up internet emerged to describe how users would use existing telephone technology to
“dial up” internet access through a specific provider. Because the internet was established primarily for military
use, access to the technology was highly restricted, limited to specific uses such as research. By 1992,
Congress had allowed the NSF to grant some access to the network for uses beyond education and research.
Then, in 1995, all restrictions on noncommercial uses of the internet were lifted.

In these early days, a good deal of computer knowledge was needed in order to use the network, so the
internet was not yet part of mainstream life. But that was about to change. In 1990, hypertext transfer
protocol (HTTP), hypertext markup language (HTML), and the uniform resource locator (URL) were developed
to give the average person access to the web of information. This really was the birth of the World Wide Web.
HTML provides the structure on which web pages are based; it is a series of commands that describe attributes
such as the font size and background colors of the displayed page. The uniform resource locator (URL) is an
address—similar to a postal address—that directs the user to a unique location or page on the World Wide
Web. These two developments, along with the milestones shown in Figure 1.23 made the web less technically
complex and easier for the average person to navigate.

People soon began to see the ease with which web pages could be created. In 1993, the first user-friendly web
browser, Mosaic, came on the scene. A web browser provides the interface that you can use to search for the
information stored on the WWW. Marc Andreessen, a student at the University of Illinois, developed it. One key
feature of Mosaic was the ability to include images as well as text on a web page. Other features included
buttons to select for navigating the page, the ability to include video clips, and hyperlinks. A hyperlink is a link
that can take the user from one web page to another just by clicking the highlighted link. Initially available as a
free download, Mosaic quickly caught on and evolved as more users came on board. Prior to Mosaic, fewer
than 200 web pages were available, but in just a few short years by the late 1990s, that number grew to more
than 100,000. After graduating, Andreessen formed Netscape Communications and would eventually launch
Netscape Navigator, which would grow to over 10 million users globally in just two years. Microsoft was quick
to respond with its browser, Internet Explorer, which was bundled with the Windows operating system.
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Figure 1.23 Major milestones in the creation of the internet came in layers.

LINK TO LEARNING

HTML is used to create web pages. The information is contained behind the scenes and is used to format
text and the layout of the page. Read this article about HTML and the process used (https://openstax.org/r/
78HTMLProcess) to learn more. Watch this video on how HTML is used to build websites
(https://openstax.org/r/78HTMLBuild) to learn more.

By 1998, some big tech names established themselves as internet-based businesses—Hotmail, Amazon,
Google, eBay, and Yahoo!, to name a few. The rise of the internet led to what became known as the dot-com
bubble, a period when investors poured money into many internet-based ventures that promised high returns.
Of course, many of these ventures failed, and their investors lost a good deal of capital. But, despite this, new
ideas continued to emerge, and the internet continued to grow. Here are a few internet ventures that came
out of the dot-com bubble and are still around today:

• Wikipedia—2001
• Facebook—2004
• YouTube—2005
• Twitter (now X)—2006
• Hulu—2007

SPOTLIGHT ON ETHICS

Inequities in Internet Access

Having access to the internet is almost essential to fully participate in society today. In some instances,
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without the internet, even routine tasks can seem impossible. For example, some companies can be
contacted only via the internet, so you may need internet access to even apply for a job. Because of the
global nature of the internet, it might be assumed that everyone has access in some way. But even in the
United States, there are large disparities in access to reliable internet connections. In today’s electronic
world, this is furthering the gap between economic, racial, and ethnic groups; age groups; and
socioeconomic groups. It is estimated that on average, nearly 15 percent of households in the United States
with school-age children lack access to the internet. But in rural or low-income areas, this percentage could
be much higher.

Governments are introducing initiatives to make the internet more accessible to all, often through
partnerships with technology firms. For example, in a partnership with Google, the city of Austin, Texas, has
been able to provide free internet services for nearly 2,000 lower-income residents. As early as 2006, India
established internet access in its rural communities through the use of kiosks. These are just a couple of
examples of the efforts worldwide to make the internet more accessible for all.

Using the Internet
Using the internet today is much simpler than it was even as recently as five years ago. It simply entails going
to the web browser of our choice and clicking the mouse to launch it. Common browsers in use today include
Google Chrome, Apple Safari, Microsoft Edge, and Firefox. The browser, once opened, will take you to where
you want to go online. You can go directly to a web page by typing its URL in the navigation bar at the top of
the browser. However, many browsers have a default search engine that will automatically launch when you
open the browser and will allow you to search the internet for content you want to locate or research. Chrome,
for example, will automatically navigate to the Google search engine when you open the Chrome program.
Most browsers include a bookmark feature, and it may be helpful to bookmark/favorite pages that you visit
frequently or want to remember for quick access later. With Chrome, you will see a star on the right-hand side
of the URL to select to bookmark/favorite the page. Figure 1.24 shows these buttons.

Figure 1.24 To use a browser, type the website URL address into the navigation bar. Here, we’ve typed www.google.com to get to
Google’s famous search page. You can also bookmark/favorite websites that you frequent for quick access by selecting the star
button. (Google Search is a trademark of Google LLC.)
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Conducting Effective Searches
Conducting searches on the internet is straightforward, but there are some techniques that will make your
searches more effective. Because of the vast amount of information available on the internet, incorporating
some simple changes to your search strategies can make a huge difference. You might, for example, want to
narrow the number of results that you get from a search to those that are most relevant. When you begin to
type in a search term, most engines will display a list of suggested searches. This list of suggestions will give
you similar, related searches using the terms that you have begun to type into the search bar. This is often
helpful as you try to narrow your search to obtain the desired results, as Figure 1.25 shows.

Figure 1.25 When you begin typing into a search engine, not just Google’s, most will offer suggested searches based on what you
typed, as you can see in the list under the “flower arrangements” entry. (Google Search is a trademark of Google LLC.)

As you conduct your search, it is often helpful to keep a list of search terms that you have successfully used. It
is easy to forget that you have already used a particular phrase or word, so a simple list will make it easier to
avoid replicating something you have already searched.

For example, suppose your boss at WorldCorp has asked you to search for a local nonprofit organization
centered on children to support this year during the holidays. You might choose to search using the word or
phrase children, kids, not for profit, nonprofit, or children in need, as just a few examples.

Search engines also offer the capability to search with an image or with voice instead of text. Once you have
entered a search term or phrase, you have some additional options. For example, you can restrict the search
to a certain date range or a certain location, or you can change the search to focus only on shopping related to
your search term. See Figure 1.26. Keep in mind that once you reach a website, you will often find a search bar
within the website itself. This will enable you to search within that specific website instead of conducting a
search of the entire internet. A little trick for searching on a page is to use the control (Ctrl) key and the F key at
the same time (Ctrl+F). When you press these two keys at the same time, a search window will appear that
allows you to search on that specific web page.
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MAC TIP

To search within a web page on a Mac, type Command+F.

Figure 1.26 Using the advanced search features, you can restrict your search to a location or date range. You can also search using
voice or search with an image. (Google Search is a trademark of Google LLC.)

To conduct an internet search, it is best to use specific and unique terms whenever possible. For example,
when searching for contact information for a nonprofit organization in your hometown, rather than simply
using the term “food bank,” you should use the actual name of the food bank you are searching. Or, if you are
unsure of the name of the organization, you might limit the search by combining “food bank” with the name of
your town or city. You can add a phrase as well. Being more specific in your searches will lead to more refined
results.

In defining your search, avoid using common words such as “a” and “the,” as well as punctuation marks. Also
note that most search engines are not case sensitive, so proper capitalization is unimportant. Finally, to get the
most results, it may be helpful to focus on the base or root word. For example, instead of searching on
“running gear for women,” you might get more results by using “run gear women,” leaving the search open to
words such as “runner” in addition to “running.”

Your internet searches can be further refined by adding “+” or “–” in front of a word to either add to the search
term or exclude something from the term. If, for example, you are searching for theaters but do not want
movie theaters, you can type “theater–movie” to get search results that do not include movie theaters. This
same approach can be used with “+” to add more terms to your searches. (Note: Some search engines may use
NOT or AND instead of the mathematical sign.)

To search for an exact phrase or string of words, enclose the phrase in quotation marks. For example, if you
are looking for information about historic theaters, you can search by typing “historic theaters” and then
perhaps add a location (city or state) at the end, also in quotation marks, so your search would be “historic
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theaters” “Atlanta.”

Use the tilde (~) to search for synonyms for the word you type. For example, searching “~coat” might return
search results including jackets and sweatshirts. The asterisk (*) can be used to search partial words. This can
be very helpful if you want to search for a specific person or location but are not sure of the correct spelling or
the complete term. If you are researching nonprofit organizations and want to capture information that might
just say “nonprofits” instead of the complete phrase, you can search using “nonprofit*.” Finally, the “|” or OR
operator can search on two terms at the same time, giving you results for either of the two terms. Searching
“black shoes for sale” | “brown shoes for sale” will return results that satisfy both search phrases. These
operators can be combined in various ways to make your searches much more directed. Be careful not to be
too restrictive, however, as you might filter out some relevant results. Table 1.1 summarizes the key internet
search operators.

Operator Description

+ , AND Include a word in the search

–, NOT Exclude a word from the search

“ ” Search for the exact words contained between the quotation marks

* Search partial words

~ Search for synonyms

|, OR Search two words at the same time

Table 1.1 Internet Search Operators Using these operators can make your search more effective.

Conducting Business Research
Conducting business research via the internet enables you to access information quickly at little or no cost.
The internet gives you access to a large body of data from a variety of sources across the world. There are both
free and fee-based services available on the internet to gather data. In addition, you can access many
academic, peer-reviewed research using specialized databases. The first step is to narrow your search by
determining what information you need and making a list of the data needed. As you work through your
search, be sure to record relevant search terms, the website URL, and other pertinent information for you to
access later if needed. A good strategy might be to keep a notepad by the computer or keep an electronic
record in Microsoft Word or Google Docs.

Some common sources of information for business research can be readily accessed:

• Google Scholar is a search engine for peer-reviewed academic research. Here, you will find journal articles
(often full-text .pdf files) for nearly all disciplines. This source can be handy if you are looking for targeted
information based on a specific academic discipline.

• Microsoft has a similar search engine called Microsoft Academic.
• Science.gov is a website that provides access to data from nearly twenty U.S. federal agencies.
• Census.gov is an excellent source of demographic information.
• If you are searching for financial information for companies, Yahoo! Finance or Google Finance is a great

place to start.
• More detailed information about specific industries and sectors is available at CSImarket.com.
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When conducting research on the internet, there always will be some question of the credibility of the
information you find. Because virtually anyone can create a website or post information on the internet, you
should read with a critical eye. There is a wealth of quality information available, but it is just as easy to
stumble upon unreliable data. Wikipedia is a commonly searched source for information. Wikipedia is an
online encyclopedia built organically by users (it isn’t owned by a person or organization). It was founded in
2001 as a nonprofit organization with the goal of giving free access to information for everyone. Wikipedia is
the fifth most visited site on the internet. Users submit content to pages and check one another for accuracy.
They are given guidelines to follow for fact checking and editorial changes. In most cases, however, using
Wikipedia as the primary source for research is frowned upon because of the lack of authentic reliability checks
for the information.

With any research, it is good practice to use triangulation: To verify the credibility of a piece of research, you
should find at least three sources that are in agreement. By using multiple sources, you are minimizing the risk
of uncertainty of the information found. It is also good practice to follow additional guidelines when evaluating
the credibility of information found on the internet. By looking a little deeper into the research, you may
uncover some hidden biases or questionable conclusions that were not readily apparent.

• Who is the author and what is their affiliation?
• Who paid for the research?
• What is the date of the information?
• Has the website been updated recently, and do the hyperlinks work?
• Are any clear biases or opinions expressed?
• Is there a way to contact the author or request more information?

By taking the time to dive a little deeper into the information retrieved, you can better ensure the data is
credible and suitable for your needs.

Globalization
The internet has broken down many geographic barriers. Business transactions can easily happen from points
across the globe, products can be ordered and efficiently shipped to destinations thousands of miles away,
and individuals can readily access information related to current events in other countries. The global nature
of the internet has opened up the world, but there is little consistency between countries in their management
of this technology. There are distinct differences from country to country in the laws and regulations
governing internet use. For example, Facebook and Google are banned in some countries, such as Iran and
North Korea, because these sites are seen as contradictory to local traditions and customs. In China, the
government plays a major role in monitoring what citizens can access and view on the internet. There are
nearly 100 regulations specifically centered on the internet and its use in China.

Internet regulations across the world generally fall into one of four categories:

• Encouragement of self-regulation and voluntary use of filters for illegal material
• Punitive actions for making material available online that is unsuitable for children
• Required blocking of government-selected materials
• Prohibition on public access to the internet

Many countries have enacted some type of legislation, policy, or governmental oversight with the goal of
managing internet content. This governmental involvement began as early as 1996 and continues to be
amended today. As you enter the workplace, you should be aware of the specific legislation that might impact
the industry that you are working in. This could include protecting user information through specific privacy
controls to managing content on a social media site for appropriateness. You do not have to be a legal expert,
but having a general awareness of governmental involvement in the information shared over the internet is
important.
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Communication, Collaboration, and Social Media
Through the internet and the software programs available today, we can stay connected to colleagues and
family across great distances. Email, the Google Workspace of programs, Microsoft 365, and social media sites
have all had a significant impact on business and personal productivity. Email first became a reality with the
ARPANET. Today, we have many options when it comes to our email service. Gmail from Google and Outlook
by Microsoft led the email market. These programs are directly integrated into their other products to aid in
communication and collaboration between users. The enhanced capabilities of email programs today allow
easy sharing of photos, documents, video, and large files. Just the ability to connect to colleagues who are
outside of your general geographic area on a regular basis greatly improves productivity and connectivity.

We also now have several options for videoconferencing. Many people use these tools outside the workplace
to spend time with out-of-town family and friends. The traditional telephone conference call where several
people sit around a conference table while another colleague calls in on a speaker phone is a rare sight in
today’s office. Now, we can gather around a virtual table and use a videoconferencing program to conduct an
important business meeting (Figure 1.27). We can use the same program to have a virtual meal with a family
member who lives miles away. Some of the leading videoconferencing tools today include Zoom, Microsoft
Teams, Skype, WebEx, and Google Meet. All have basically the same functionality, with features such as
recording the meeting and providing a transcript of the discussion. These features have been valuable as part
of a widespread shift to remote working conditions for many companies. The shift to greater use of remote
working environments occurs for various reasons, ranging from global issues such as a public health
emergency to more localized reasons like increasing employee satisfaction by assisting in work/life balance.

Figure 1.27 Videoconferencing tools such as Zoom make telecommuting easier than ever before. Forbes credited Zoom’s quick rise
in use to its ease in navigation. (credit: modification of “VFRÖ - Zoom Meeting 3/2020” by Radiofabrik/Flickr, CC BY 2.0)

Another tool people use to connect and collaborate with others is social media. Social media is digital
technology that allows users (individuals and organizations) to share information about themselves such as
posts, photos, or videos. More than 40 percent of the global population use social media. Social media sites
had their origin in connecting friends and families. However, as the number of users increased, businesses
started to see the value in connecting with their customers via these social media sites. Many businesses have
a distinct presence on social media as active users, not simply advertising through the site. Today, about 70
percent of businesses have a social media presence. The line between personal and business has blurred
significantly. Very few people use social media solely for connecting and sharing with friends and family. Most
will interact with businesses such as retail outlets and even banks on their social media sites. Many people
follow a specific brand or company that they like. Personal and business social media sites are intertwined and
connected across sites.

This phenomenon has shifted how businesses manage relationships with their customers. Many banks, for
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example, have a social media site where they share financial tips and banking products/promotions available
to their customers. Consumer products companies can use the sites to get feedback on product attributes or
advertising strategies. Small businesses can use social media sites to offer promotions to bring more foot
traffic into the store—whether online or brick-and-mortar.

The leading social media sites vary by age to some extent, with older generations leaning more toward
Facebook and LinkedIn while younger people tend to gravitate to platforms such as TikTok, Instagram,
Snapchat, and X (Twitter). Other popular social media sites include Pinterest and Reddit.

Privacy is a concern when dealing with any interaction on the internet, but especially with social media sites,
where individuals often share personal information and pictures that could open them up to cyberattacks. You
should regularly check and update the privacy settings on the social media sites you use. You might consider
changing your password routinely to prevent hackers from accessing your information. Never share personal
information through the site or through messages within the site. You should be wary of friend/follower
requests from people who are unknown to you or your other connections. Avoid being controversial or posting
overly personal content. Employers now are checking applicants’ social media profiles and, in some cases,
monitoring employees’ activity.

Finally, as a user, it is easy to get pulled into clicking on advertisements that either show up in the margins or
in the social media feed. Clicking leaves a virtual footprint of your activity that both legitimate advertisers and
spammers can use to target advertisements and compel you to visit their sites. Often, you can limit your
exposure through the site privacy settings, but the risk of exposure of personal information probably cannot
be totally mitigated unless you avoid using social media sites altogether.

Personally identifiable information (PII) may include items that directly reveal your identity, such as your
address or Social Security number. But other identifiable information can also be gathered, such as race,
gender, or religion. You should be cautious when sharing information on the internet via social media and
other websites. Useful precautions include regularly changing your passwords, not using the same passwords
for multiple sites, providing limited personal information on social media sites or putting privacy settings at a
high level, and, finally, being cautious about clicking links or advertisements from unknown sources.

Libraries and Media
The internet has changed the way that libraries operate and store/share information. Many libraries still house
extensive collections of books, reference materials, magazines, and the like. In fact, you may be surprised to
learn that reading print books still outpaces reading electronic books. Some college students have reaped the
benefits of e-books by purchasing their textbooks in (often cheaper) electronic formats. Unlike a traditional
print copy of the same material, these textbooks are interactive, enabling the publisher to include updated
information and links to relevant extra materials that cannot be included in the print edition. With the
availability of the internet and today’s technology, students can also rent electronic textbooks, which can save
a good deal of money over time. Currently, electronic textbooks hold about 30 percent of the total market.

Many libraries now have online services that allow users to place a hold on materials. When the item becomes
available, the patron is notified via text or email. Libraries are also moving some of their resources to a digital
format. For example, some of the historical archives housed in libraries have been cataloged digitally to
provide broader access. Libraries will still have a good supply of DVDs or books on CD for patrons to check out,
but many resources can now be accessed electronically by using your library card.

Many states have library systems that allow patrons in one city to utilize materials owned by another library in
a different city. With apps such as OneDrive and Hoopla, users can gain access to thousands of digital
materials, including books and media. These apps are typically compatible with the leading e-reader apps,
such as Kindle, Kobo, and Libby. Also, libraries have become a central access point and technology hub for
those lacking these resources at home, as Figure 1.28 shows. Nearly 96 percent of all rural public libraries offer
free access to the internet for their cardholders. In all these ways, the digital revolution has altered the way
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libraries think about the services they provide.

Figure 1.28 Many libraries today have computer workstations where users can access the internet and conduct research. (credit:
modification of “Vancouver Public Central Library” by GoToVan/Flickr, CC BY 2.0)

Libraries can be a source of research that might otherwise be unavailable to you. For example, the popular
genealogy site Ancestry.com has agreements with libraries to provide some of its exclusive material free of
charge to users of the site’s library edition. Libraries also provide free access to other databases that are
centered on business research, including LexisNexis, BizMiner, Business Source Complete, and IbisWorld.
These databases provide a wealth of information that is not readily obtained with a simple internet search.

Web Applications
A web application is a software program that is not installed directly onto the user’s computer. Instead, the
program and data associated with it are stored on the internet, and the application is accessed through a
browser or app rather than through an installed program on the computer. In the past, users had to purchase
a license key to install programs directly onto their computer. This takes up memory and storage space on the
computer and presents limitations on updates to the program. The user would generally have to purchase the
program on a regular basis to get the most updated version or purchase an upgrade. Web-based applications
give users access to the most up-to-date version of the software while sometimes freeing up essential storage
on the networks and allowing seamless collaboration between users in real time. Companies pay monthly or
annual subscription fees for these programs, often based on the number of user licenses they want to
purchase. Throughout this text, you will become familiar with the Google Workspace of products and Microsoft
365, so that you can develop basic computing skills for the work world.

E-commerce
Electronic commerce, or e-commerce, refers to conducting business transactions online—buying and selling
goods or services in an online environment rather than in a traditional brick-and-mortar storefront. The first e-
commerce transaction was in 1994, but it is helpful to think of e-commerce as a modern-day version of the
catalog sales (Sears, JCPenney, Montgomery Ward) of times past, except that the ordering is done over a
computer rather than over a telephone or by filling out a form and mailing it through the post office.

E-commerce transactions can occur between all customers in the marketing mix. In a business-to-business
transaction, one business might purchase office supplies from another business. In a business-to-customer
transaction, an individual purchases a product from a retailer online and has it delivered to their home.
Consumer-to-consumer purchases can also be made through e-commerce—for example, when an individual
purchases a product directly from another individual through a resale website.

E-commerce does not necessarily involve shipping the purchased items; for instance, you may purchase and
download an electronic product, such as an e-book or music. E-commerce simply means that the purchase
transaction occurs online rather than in person. Today, virtually all products or services can be purchased
online. Some entrepreneurs have started exclusively online businesses with virtual storefronts and no physical
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inventory. Today, e-commerce makes up about 15 percent of all retail sales across the world, with over twenty
million e-commerce sites worldwide, representing nearly $4 trillion in sales. E-commerce jobs are expected to
reach nearly 500,000 by the end of the 2020s; it is predicted that by 2040, 95 percent of purchases will be
through e-commerce.

REAL-WORLD APPLICATION

A New Kind of Entrepreneurship

Crowdfunding is a concept wherein many people contribute to fund a particular product launch or cause.
Kickstarter is one such online platform where entrepreneurs can post their business idea and ask for
contributions to make it happen. Some products have raised millions of dollars to fund their ideas.
Pebbletime Smartwatch and the Coolertime Cooler garnered $20 million, $13.3 million respectively from
Kickstarter donations.

The Cloud and Cloud Computing
Technological advances have made working remotely, or telecommuting, a possibility for many employees. In
fact, one recent survey estimated that nearly 90 percent of U.S. employees would like to work remotely. Today,
there are almost five million workers in the United States (nearly 40 percent of the U.S. workforce) who
telecommute. Since 2015, the number of businesses that have allowed telecommuting has increased over 40
percent. Even for those who do not telecommute full time, access to the internet and such technologies as
cloud computing in the workplace enable many employees to work from home at least once per month, with
nearly 50 percent doing so once a week.

With cloud computing many of the resources that were traditionally stored on individual computers, including
software programs, data management and storage systems, and networking tools, are moved to internet
servers. This technological advance was prompted by the need to store large amounts of information and data
and to enable collaboration by individuals across the world. The resources and their associated data are stored
in a data center that is managed by a cloud service provider (CSP). The benefits of cloud computing are that it
can handle larger amounts of data than any physical storage device can, and it also allows users to access their
data from any computer, no matter the location, and from any device, as Figure 1.29 illustrates.
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Figure 1.29 Cloud computing enables you to store much more data than can be kept on any physical computing device. (credit:
“Cloud-Computing” by Learntek/Flickr, Public Domain)

The cloud is the term used to describe servers that are located at different locations and that are accessed via
the internet. These servers are housed in data centers to provide storage and computer processing
operations. The term cloud was first used in 1996 by a researcher at Compaq, and the first cloud computing
service was Amazon Web Services (AWS), which launched in 2002 as a public cloud system. The cloud offers
some distinct cost advantages to businesses. Companies can save money by not having to constantly upgrade
individual users’ storage capacity, and they can lower their IT costs because the subscription fee for use of the
cloud service includes many troubleshooting and technical assistance functions. When we use the cloud for
storage, we no longer need to store and maintain CDs with backups of the system or flash drives to transport
documents from one computer to another. Cloud computing increases the speed of computing and gives all
users real-time access to information stored in the cloud. Use of the cloud allows greater security for
information storage as well as speedy distribution of new software and software upgrades. Finally, the cloud
offers flexibility that enables businesses to operate more efficiently.

The security of information stored in the cloud can be of concern, but due diligence by individual users and the
company can mitigate these risks. Here are some basic steps for ensuring the security of information:

1. Select a CSP that encrypts its data. Computers use the process of encryption to rewrite readable
information into a code that can be deciphered only by using the key to the code, similar to solving a word
puzzle that uses a secret code (see Figure 1.30). Encryption is an important step in ensuring the security of
the information transmitted and stored in the cloud.

Figure 1.30 Each key has the code to the secret (encrypted) information, allowing messages to be sent safely.

2. Back up information regularly. Most CSPs will include this with the services they provide.
3. Use strong passwords and change the passwords regularly. Some businesses will set up a system that

requires a password change at set time intervals.
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4. Use two-factor authentication. This means that to access the system, you will need two pieces of
identification, typically your username and password as well as one additional means of identification,
such as an email to verify your identity, a code sent to your cell phone, or an answer to a personal
question.

5. Make sure your system is protected by antivirus/antimalware software. These programs prevent
unauthorized attempts to gain access to the system.

6. Avoid using public Wi-Fi access points to conduct critical business or personal transactions. Using public
Wi-Fi exposes users to the potential for personal information to be compromised.

Cloud Computing in Business
Some companies set up a cloud-based intranet—a private network for internal company use. Unlike the
internet, it is not available to the public and typically requires authorized users to enter a username and
password. Many companies also require employees to make use of a virtual private network (VPN) to gain
access to the company’s intranet when they are off-site.

LINK TO LEARNING

The use of virtual private networks enables businesses to control who gains access to their computer
network. Using cloud services can offer some of the same security advantages for business. Read this
article on VPN and cloud computing (https://openstax.org/r/78VPNCloud) to learn how the two are related
and some differences between the two.

Many businesses today use cloud computing to manage their information technology needs. Through the
cloud, businesses can more efficiently analyze, manage, and store data. They are able to deliver software to
their employees on demand and make updates to programs more rapidly. Finally, cloud computing enables
seamless collaboration between business units that may be located miles apart.

Three types of clouds are involved in cloud computing:

1. The public cloud is managed by a CSP. All of their services are delivered via the internet, and they charge
for their service. The resources are owned and maintained by the CSP. Microsoft Azure and IBM Cloud
Services are examples of public cloud service providers.

2. A private cloud is used within a single business or organization. Its resources, which are owned by the
business and maintained within the organization, are stored on a private network, or the company can
pay a third party to host the private cloud. With a private cloud, there are often restrictions on who can
use it and what permissions are given to the users. Businesses that use sensitive information, such as
financial institutions or health-care providers, prefer private clouds because they offer more security than
a public cloud system.

3. The final type of cloud system is a hybrid cloud—a blend of public and private. Some resources are utilized
through a public cloud and others are secured through a private cloud.

Cloud Computing for Personal Use
You are probably using the cloud already in your professional or personal life, even if you are unaware that you
are doing so. For example, cloud computing is used behind the scenes for Google and Microsoft programs, so
if you are using Gmail or Outlook, you are using the cloud. Likewise, if you use Google Photos to store family
memories, you are using the cloud. And if your family members play video games, stream movies, or listen to
music on the internet, they are more than likely using the cloud. The cloud is working behind the scenes with
much of the work we do both personally and professionally. This is a natural outgrowth of advances in internet
capabilities and computing power to enable us to manage information more efficiently, conveniently, and cost-
effectively.
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Internet of Things (IoT): Integration and Collaboration
The Internet of Things (IoT) refers to the extension of internet connectivity beyond computers, to enable the
transfer of information between machines and other objects, people, and animals by connecting them to the
internet in some way. With the IoT, the physical connects to the virtual. Today, many consumers seek out
products that connect to the internet, and some simple adjustments enable many nontechnical, inanimate
objects, from light bulbs to dishwashers, to be part of the IoT.

As businesses see the value of the additional data that is gathered through IoT, many companies are
marketing these technologies to consumers to make their lives easier and to save money. Having a reminder
to put the laundry in the dryer or having the house thermostat adjust automatically based on outside
temperature is more than a novelty—these features can save time and money, allowing consumers to feel
more secure, better equipped to handle life’s demands, and able to focus more on their pleasures in life.
Businesses, too, can realize distinct improvements using real-time data and analytics, performance tracking,
inventory/cost controls, and the automation of simple tasks. These capabilities can also allow businesses to
adapt to challenging times.

REAL-WORLD APPLICATION

Pivoting during the Pandemic

COVID-19 drastically affected in-person business and services, many of whose owners found themselves
struggling just to keep their businesses afloat. Some businesses chose to start offering their products or
services online while some began or greatly enhanced their delivery operations. Others decided to close
their business in the short term. Some businesses, such as Spotify and Netflix, put more resources into
creating original content (podcasts, movies, series shows) rather than relying primarily on the sale of ads as
a major revenue stream. Small restaurants offered delivery services and meal subscription services to keep
their business thriving even during the pandemic. And larger corporations found that remote work allowed
their employees to stay healthy while still meeting the needs of the business.

1.4 Safety, Security, Privacy, and the Ethical Use of Technology

Learning Objectives
By the end of this section, you will be able to:

• Describe the importance of practicing responsible computer safety and security
• Identify common computer security issues
• List measures to prevent computer security breaches
• Describe the importance of privacy in a digital world

At WorldCorp, you’ve realized how the evolution of computing has led to your present-day status as a new
employee. You’re getting the hang of how computers are put together, how they have changed the business
landscape, and how you need to understand their basic components to thrive in your industry. Another part of
that understanding is learning how to safely navigate the computer world, both in the company’s internal
systems and in external systems on the internet and the World Wide Web.

The Importance of Computer Safety and Security
The protection of computer systems and information that prevents unauthorized use is referred to as
computer security. Computer ethics are guidelines for the morally acceptable use of computers in society.
Any criminal offense that involves a computer and a network is referred to as cybercrime. One of the most
common types of cybercrimes is identity theft, which occurs when an unauthorized user steals an individual’s
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personal information, such as a Social Security number or credit card information for economic gain. An
increase in the number of hackers—individuals who gain unauthorized access to computer systems in an
attempt to steal someone’s information—has prompted the development of software programs designed to
protect consumers’ identities, such as LifeLock.

There are strategies you can employ that will keep your computer, and the information you have saved on it,
safe and secure from theft and hacking. These include:

• using security suites that can protect user privacy and security while on the internet
• using a firewall, which is a barrier between a network that is secured and one that is not secured, to

provide additional security
• setting up password-protected network access
• avoiding logging in to accounts on an open network (one that is not password protected)
• using encryption to make it impossible for unauthorized individuals to gain access

Data and Identity Theft
In addition to hackers who target individual users, corporate espionage (also known as industrial, economic,
or corporate spying) is conducted for commercial or financial gain by targeting businesses, government
agencies, energy companies, and even schools. Corporate espionage can take the form of unethical or illegal
acquisition of intellectual property (such as customer data, pricing, or research and development information)
or trade secrets through theft, bribery, or blackmail. Examples of corporate espionage include:

• trespassing on a competitor’s property and/or gaining unauthorized access to files
• wiretapping—the secret interception of electronic communications
• domain hacking, which occurs when another entity steals the original party’s domain name
• phishing to lure competitors’ employees to open emails, thereby exposing information

Attempts to get users to interact with an email or website that appears to be legitimate but is actually fake is
called phishing. Phishing lures users to provide their personal information and login credentials through
these hoax sites and emails. This is usually through the use of spoofing. Spoofing is communication (usually
an email) that on the surface looks to be legitimate from a trusted source. These emails have become much
more sophisticated and are designed to look more and more like real correspondence from a company or even
a government agency such as the IRS. Something that has grown increasingly common is ransomware,
malicious software that encrypts computer data, rendering it useless and inaccessible, and forcing the owner
to pay a ransom to regain access. Software that is designed with the purpose of damaging a user’s computer
system once it has access to that system is called malware.

Password Management and Biometrics
For all of these threats to online security, there are protective steps you can take. A set of principles and best
practices for storing and managing passwords in a manner that is likely to prevent unauthorized access is
called password management. You may password protect your computer, as well as various accounts you
may access through your computer and the internet. Having a strong password will ensure that hackers
cannot figure out your password easily. Many organizations today use multifactor authentication to provide an
additional layer of security. For example, when accessing your bank account on your phone or your laptop, you
may be asked to enter a specific code that is sent via email or text. This now provides two layers of
security—first, entering the correct password, then correctly entering the code that was sent to you.
Multifactor authentication can also be used by businesses when accessing the company software or computer
network.
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REAL-WORLD APPLICATION

Please Pass the Password

Some tips for creating a strong password include:

• Avoid using a real name (either your own or the company’s) as your password.
• Use a combination of letters and numbers with at least eight characters.
• Do not use a complete word such as “password.”
• Do not reuse passwords.
• Use a combination of uppercase and lowercase letters.
• Incorporate special symbols instead of letters or numbers (such as an exclamation point or dollar sign

instead of a numeral).

In addition to passwords, you can also use biometrics to protect your computer and information. Unique
physical markers of an individual that can be used to restrict access to only those who match these physical
characteristics, such as retinal scans and fingerprints, are called biometrics. Biometrics are much harder to
hack as they cannot be guessed or stolen.

Internet and Web Privacy
The internet is pervasive and omnipresent. It is part of all you do in business and in your everyday life. How
people conduct themselves online, what they share, and what they visit—all this information is captured and
saved in various places, from internet providers’ servers to browser companies such as Google to different
social media sites. This information is captured and saved even if deleted from your computer or account. It is
important to consider how to represent yourself and what to share to maintain your privacy.

Cookies
After you have searched for a product on the internet, do you notice that you suddenly start receiving
advertisements for that product, or that a store website now displays that product on its front page? For that,
you can thank cookies. Small data files that are deposited on user hard disks from websites you visit are called
cookies. They keep track of your browsing and search history, collecting information about your potential
interests to tailor advertisements and product placement on websites. These cookies can be either blocked or
accepted, depending on a company’s privacy policy. The potential risk of cookies is that they can store
information about the user, user preferences, and user browsing habits. That said, they can also save time by
storing users’ login information and browsing preferences, allowing internet pages to load faster than if you
had loaded them the first time. Regardless of convenience, it is a good idea to clear cookies from time to time
and to restrict cookies on certain sites depending on your own preferences.

Browsing History
Your browsing history includes all websites you may have visited, as well as any actions you may have taken on
those websites. It is typically saved locally on your computer within the browser application, as well as with the
company that provides the browser. Your internet or data provider may also keep track of your browsing
history. While this information is handy to have for future reference, consider clearing your browsing history
from your personal computer on a regular basis. Be aware that your employer may also collect this
information; while using a work computer, you should avoid visiting websites that do not support your work
function. Both Google analytics and your company can theoretically store browsing data for a long time, even
after you delete it.

Temporary Files
As the name implies, temporary files are created by a program to allow it to complete a task or tasks. These
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files are handy to have in case of a sudden shutdown, as they may help to recover a file that might otherwise
be lost. Many temporary files are automatically deleted once the task is complete or the file is saved
permanently. But others may stick around; these files are saved in your temp folder. On a Windows computer,
you can access your temp folder by typing %temp% in the Windows search bar at the bottom left of your
screen.

MAC TIP

On a Mac, open the Finder and select Go ≫ Go to Folder. In the search bar, type ~/Library/Caches/ and then
click Go to run the command. A window will open with a list of all the generated temp files saved on your
Mac. You can easily select and delete these files.

Posting on Social Media
According to Pew Research, “seven-in-ten Americans use social media to connect with one another, engage
with news content, share information and entertain themselves.” Some of the most popular platforms today
are TikTok, Facebook, YouTube, Instagram, and WhatsApp. Figure 1.31 shows the sites adults in the United
States use most. The United States and China have the most social media users of all countries worldwide.
Social media has exploded in popularity and is used widely for both personal and business purposes.
Businesses and individuals must be mindful of what they post on social media. Even the most private accounts
can have data breaches, allowing others to save and/or share private content. It is important to consider what
you post, as well as any potential unintended consequences that might arise from social media use. You must
also be aware of spoof accounts that present as a reputable person, when in fact they are attempting to con or
mislead an individual. Similarly, AI and bots may interact with users, posing as real people when in fact they
are nothing more than a computer algorithm.

Figure 1.31 YouTube, Facebook, and Instagram were the top three social media sites among U.S. adults in 2021 for both personal
and professional use. (data source: PEW Research Center, https://www.pewresearch.org/internet/2021/04/07/social-media-use-
in-2021/)

Ultimately, you should be sure to present a positive self-image on the internet, particularly on networking
social media platforms such as LinkedIn. When considering how you want to represent yourself online, answer
these questions: (1) Is this information accurate? (2) Will this post be potentially detrimental to my schooling
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and/or career? (3) Is the information hurtful or detrimental to someone else?

Ensuring Privacy
Privacy involves practices related to the collection and use of data about an individual. Many companies will
have privacy policies when you sign up as a customer or purveyor of their content. It is important to read
these policies to ensure you are not inadvertently providing permission to use your data and information in a
way that you do not actually approve of. In addition, many companies will disclose they sell your information
to other companies seeking similar customers. It is important to decline these permissions to avoid circulation
of your contact information.

Minimal Data Collection from Customers
Collecting data from customers allows organizations to determine their needs and identify niche markets.
Companies must ensure they are collecting the most minimal amount of data necessary from their customers
to achieve these goals. Collecting too much data places both the company and the customer at risk. The
company is responsible for ensuring that information is used responsibly and within the parameters of its
privacy agreement; any data breach puts the company at risk of liability. Similarly, customers have the right to
know how their information is used by the company and may request compensation if it is used
inappropriately. Therefore, companies must ensure that they collect only the most minimal amount of data
required to meet their business needs.

Data Security
Data security involves protecting digital information (data) from being accessed or used by parties who should
not have access, or for purposes it should not be used for. Just as individuals must ensure they protect their
information from hackers and malicious intent, companies are responsible for ensuring they use the most up-
to-date data security measures to protect both customer information and proprietary company information
and data.

Companies must ensure both internal and external security. Internally, a company should establish policies
and protocols to ensure employees are abiding by data security measures. A company should also limit
employee access to certain information. Keeping technologies up to date, with the most current security
software, is also important. Depending on the size of the company, it may be worthwhile to establish a
cybersecurity branch that employs qualified professionals dedicated to data security.

There are a number of strategies a company can use to keep data secure. Encrypting the data will render
information unreadable to unauthorized users. Without the access key, encrypted information presents as
nothing more than a meaningless string of characters. Companies, like individuals, can also take steps to
delete files, software, and data that is no longer of use. And they can take it a step further by practicing data
erasure, wherein the information is not only deleted but overwritten as well. In another approach, data
masking, personally identifiable information is removed from the data, allowing the company to make
decisions about its customers without associating the data with an individual’s personal information. By taking
these steps, companies ensure they can recover from a data breach quickly, reinforcing their data resiliency.
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Chapter Review
Key Terms
Android operating system Google software operating system used to run non-iPhone mobile phones such

as Samsung’s Galaxy
artificial intelligence (AI) use of computers, robots, and machines to behave “intelligently,” engaging in

autonomous decision making and behaviors
augmented reality (AR) use of digital objects or elements in a real-life picture or scene
automation use of computers or machines to do tasks that could be completed by a person
binary digits sequences of the numbers 0 and 1 used in computer programming
biometrics authentication that uses a person’s physical characteristics as a form of digital security
cache type of storage in a computer that operates in the background, holding data that can be quickly

retrieved
central processing unit (CPU) unit that contains the microprocessor, or “brains” of a computer system
client device that requests and uses resources from other devices on the network
cloud servers housed in data centers to facilitate remote storage and computer operations
cloud computing delivering computer resources such as programs and data storage through the internet

rather than storing resources directly on a computer
computer programmable machine that can execute predetermined lists of instructions and respond to new

instructions
computer security protection of computer systems and information that prevents unauthorized use
cookies small data files that are deposited on user hard disks and internet sites visited
cybercrime criminal offense that involves a computer and a network
data erasure process by which information is not only deleted but overwritten as well
data masking process by which personally identifiable information is removed from data, allowing a

company to make decisions without violating customer privacy
data resiliency ability to recover quickly from a data breach
domain name system (DNS) phone book for the internet, enabling a user to send a message using their

name, the symbol @, and the location of the computer as identified by its domain name
e-commerce conducting business transactions online
encryption process of taking information transmitted through the internet and converting it into an

unrecognizable code to prevent unauthorized access
ethernet protocols used to connect computers in a local area network or LAN
external disk drive hard disk for information storage such as USBs, CDs, DVDs, and flash memory cards
firewall barrier between a network that is secured and one that is not secured
hackers individuals who gain unauthorized access to a computer system to steal someone’s information
hard disk secondary storage areas where users can save files and retrieve data and programs
hardware computer accessories such as keyboard, mouse, printer, and computer monitor
HTTPS communication protocol that is more secure than HTTP
hub device that sends and receives messages to and from all network connections
hyperlink link on a page or document that, when clicked, navigates the user to that location; a connection

between two web pages or documents
hypertext transfer protocol (HTTP) rules that allow users to access information on the internet and protect

confidential data such as credit card numbers
information processing cycle sequence of events involved in processing information
internal disk drive storage space within the computer that updates and produces copies of files
Internet of Things (IoT) extension of internet connectivity beyond computers, enabling the transfer of

information between machines and other objects, people, and animals by connecting them to the internet
in some way
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internet protocol address (IP address) unique combination of characters used to identify the location of a
host computer

internet service provider (ISP) company that provides individuals or organizations with access to the
internet

intranet private network for internal company use; can be combined with cloud technology
iPhone operating system (iOS) Apple’s software operating system, used to run iPhones, iPads, and other

mobile devices
machine learning use of software applications to make computations and decisions that can inform

predictions without human intervention
mainframe computer that is capable of great processing speed and data storage for large organizations
malware software designed to damage the victim’s computer system once it gains access to it
microchip small microprocessor unit used for programming and computer memory storage
microcomputer personal computer that was much smaller than earlier computers and operated with

microprocessors
microprocessor consists of a control and an arithmetic-logic unit, which performs math and logical

operations within a computer system
minicomputer computer that is similar in power to a mainframe computer, but much smaller in size; used in

mid-size organizations
motherboard controls communications for an entire computer system
nanotechnology technology that focuses on changing individual molecules to produce different properties

or attributes
network connection of two or more computer systems or devices, either by a cable or through a wireless

connection
operating system connection between a device’s hardware and its software
packet switching technology that enabled the development of the internet; computer files are broken up

into segments, which are transmitted over the network and reordered into a single file at their destination
password management set of principles and best practices for storing and managing passwords to prevent

unauthorized access to the computer
personal computer (PC) microcomputer suitable for individual use
phishing attempts to get users to interact with an email or website that appears to be legitimate but is fake
random access memory (RAM) computer’s primary, short-term memory
ransomware malicious software that encrypts computer data, rendering it useless and inaccessible, forcing

the owner to exchange something of value to regain access
read-only memory (ROM) memory not meant for storage but to process information as the computer is

being used
robotics use of robotic machines to perform tasks that no human could perform
router device that directs data traffic and allows for multiple devices to run on a network
secure sockets layer (SSL) security protocol that uses encryption to help ensure privacy of information and

communications across the internet
server connects devices and allows for resource sharing across networks
short message service (SMS) technology for sending text messages through mobile phones
smart space physical space that incorporates technologies that can be controlled through the internet
social media digital technology that allows users (individuals and organizations) to share information about

themselves such as posts, photos, and videos
software computer program or set of programs with the end goal of converting data into processes or

actions
spoofing correspondence such as email that appears legitimate but instead is used to obtain your personal

information
supercomputer extremely powerful computer that has the fastest processors available
transmission control protocol/internet protocol (TCP/IP) communication standard that allows data to be
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sent and received over a network, most notably the internet
triangulation research technique whereby information is verified and validated through multiple sources
virtual reality (VR) simulated environment in which users can interact as if they were physically present
wearable device that uses computing technology to collect and receive data via the internet
web browser a program used to find content stored on the WWW
workstation powerful single-user computer, similar to a personal computer but with more powerful

microprocessors
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Summary
1.1 Computing from Inception to Today

• Early computers were used predominantly by engineers and scientists to handle large amounts of data.
Key companies in the evolution of computing include IBM, Hewlett Packard, Xerox, Apple, and Microsoft.

• With the invention of the microprocessor, computers became available to the average consumer.
• Computing technology has increased efficiencies, decreased errors, opened new opportunities, and

enhanced business–customer relationships.
• Key technologies in computing include mobile devices, digital imaging, and machine learning.
• Advances in technology are applicable to nearly every industry. The rapid pace of technological change

has distinct career implications.

1.2 Computer Hardware and Networks
• Hardware components that make up a computer are the motherboard, CPU, microprocessor, and memory,

as well as the keyboard, mouse, and other peripheral devices.
• Computers process and store data through the information processing cycle.
• Networks are connections of two or more computer systems, such as LANs and WANs. Routers, switches,

and firewalls are basic components of networks.

1.3 The Internet, Cloud Computing, and the Internet of Things
• The internet was initially rooted in government and military applications.
• Advances in technology such as HTML, URL, and DNS made the internet more accessible to the average

user.
• Programs such as Zoom, Google Docs, and X (Twitter) foster new types of interactions between businesses

and their customers.
• Through sites such as eBay and Amazon, e-commerce has become an efficient way to purchase products

and services, not just from companies but also from individuals.
• Cloud computing refers to storing IT resources on a virtual server rather than on the actual computers

where the resources are used.
• The use of cloud computing in the workplace has increased productivity and saved money for many

businesses.
• Cloud computing enables individuals to access a wide variety of resources such as media files, documents,

and photos without the need for computers with massive storage capacities.
• The Internet of Things (IoT) connects the physical to the virtual; with simple changes to product designs,

many products can be connected to the internet.

1.4 Safety, Security, Privacy, and the Ethical Use of Technology
• Computer safety and security are paramount considerations for a company’s effective operations.
• Privacy in the digital world has become a major focus of corporate efforts to maintain the trust of

employees, the public, and stakeholders.
• Common security issues include data and identity theft, cybercrime, phishing, and hacking.
• Measures that prevent computer security breaches include encryption, firewalls, password management,

data erasure, and data masking.

Review Questions
1. What nineteenth-century invention laid the foundation for future developments in computing?

a. Jacquard’s loom
b. Apple’s Macintosh computer
c. Programma 101
d. TRS-80
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2. What is the main operating system for iPhone mobile devices?
a. Android
b. Google
c. iOS
d. SMS

3. What are direct deposit, high-speed printers/copiers, and automated inventory systems all examples of?
a. outdated technology
b. future developments in technology
c. early-stage developments in technology
d. advances in technology

4. What is VR?
a. a mostly live, real environment with some digital elements embedded
b. a computerized game for trying out a new product
c. a robot that can perform mundane tasks
d. a mostly simulated environment that allows the user to interact in the space

5. The autopilot features on an airplane are an example of ________.
a. VR
b. AI
c. AR
d. machine learning

6. ________ is referred to as "the brains of the computer system."
a. Printer
b. Mainframe
c. Microprocessor
d. Router

7. ________ allows the computer to operate and process information quickly.
a. ROM
b. RAM
c. HTTP
d. WAN

8. What is a network adapter card that organizes information into small packets for movement in the
network or over the internet?
a. TCP (transmission control protocol)
b. HTTP (hypertext transfer protocol)
c. UDP (user datagram protocol)
d. STP (standard transfer protocol)

9. Microsoft 365 is an example of ________.
a. HTTP
b. LAN
c. a Web application
d. an e-commerce site

10. ________ is the language used behind the scenes for website formatting.
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a. HTTP
b. HTML
c. URL
d. IP address

11. What is Wikipedia?
a. an internet service provider
b. a web browser on mobile phones
c. a domain name
d. a free source of information

12. ________ is the protocol used to connect computers together in a LAN.
a. HTML
b. Ethernet
c. IP address
d. Web application

13. Which operator is used to search partial words on the internet?
a. *
b. |
c. +
d. –

14. ________ refers to a private network meant for internal company use.
a. Cloud
b. Cloud computing
c. Internet
d. Intranet

15. Cloud computing was first introduced in what year?
a. 1982
b. 2002
c. 1996
d. 2016

16. ________ is a set of principles and best practices designed to prevent unauthorized access to a system.
a. Two-factor authentication
b. Biometrics
c. Data masking
d. Password management

17. Corporate espionage refers to ________.
a. trespassing on a competitor’s property
b. wiretapping a competitor’s office
c. domain hacking
d. all of the above

18. Cookies are defined as ________.
a. the practice of protecting digital information from unauthorized access, corruption, or theft
b. small data files from websites that are deposited on a user’s hard disk
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c. a list of web pages a user visits, stored on a computer’s browser
d. ads that entice users to click on them

19. ________ encrypts information on your computer, making it inaccessible until you give the hacker
something valuable.
a. Phishing
b. Data masking
c. Spoofing
d. Ransomware

Practice Exercises
20. Conduct research to show how mobile, imaging, and gaming devices have contributed to the U.S.

economy and the global economy.

21. Using some of the internet search strategies discussed earlier in the chapter, choose an industry and
research some leading technologies in that industry.

22. Think about the concept of lifelong learning. Using the strategies outlined in the chapter, discuss how
lifelong learning can be incorporated into your life.

23. A computer’s memory capacity and speed have an impact on its price. Perform a Google search to
compare the prices of at least three laptops and three desktop computers with various speeds and
memory capacities. Which is more expensive, and why? What factor has the greatest impact on the price
of the computers?

24. Go to United States Census Bureau Data (https://openstax.org/r/78CensusData). Select the Explore Data
section. Find your county and identify a variable of interest to you, such as education or poverty. List some
key findings you discovered about your county from the data on the site.

25. You want to find out about music festivals happening this summer close to your home. First, follow your
typical procedure for conducting an internet search. Then, conduct another internet search for the same
information, this time using some of the techniques discussed in the chapter. What differences do you
notice in the results?

26. Conduct an internet search for a topic that interests you. Then, navigate to a website devoted to that
topic. Using the strategies discussed in this chapter, evaluate the credibility of the information contained
on the site.

27. View your social media account (or someone else’s, if you don’t have one). From the perspective of an
outsider, what do you see? Is everything that is viewable acceptable? Would you want your employer to
view this social media account?

28. Discuss how you would protect your personal computer, including access restriction and prevention of
data loss.

Written Questions
29. Discuss how today’s technology has improved the workplace.

30. How was computing in the workplace instrumental in the development of computing for personal use?

31. How are mobile devices, imaging, and gaming interconnected?

32. Discuss the key differences between AR and VR.

33. What are some advantages to using VR in business?
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34. What are some advantages of using smart spaces in business today?

35. What is the information processing cycle and why is it important?

36. Why is it important to understand the basic components of a computer?

37. Which network would you likely have in your home? At your place of business?

38. What capabilities must a device have to be called a computer?

39. If you were setting up a computer network in your small business, what security measures would you take
to guard against cybercrime and security breaches?

40. Explain some criteria you should use in evaluating the credibility of sources for business research.

41. Outline some tips for conducting effective online searches.

42. Discuss some of the key advances with the internet that have increased business productivity.

43. Discuss some advantages and disadvantages of using cloud computing for business and for personal use.

44. Discuss some of the advantages of using the Internet of Things in business and for personal use.

45. Describe some ways that companies can protect their systems from cybercrime.

46. Define ransomware, malware, and phishing.

47. What are cookies? How are cookies used in business?

Case Exercises
48. Suppose you want to set up a computer network for a small business you are launching. The business will

provide bookkeeping services for other businesses. You will maintain an office for yourself and one other
employee. Your employees will also sometimes work remotely, either at their homes or at the clients’
locations. Do some research on the process of setting up a computer network for a small business. What
types of equipment might you need? What types of security precautions should you take to protect your
clients’ financial information?

49. You are working with a local entrepreneur who wants to open an organic food store in your town and is
asking you for help in finding relevant demographic information to help determine appropriate pricing for
some of their products.

A. What internet sources might be appropriate for this research?
B. Where would you begin your search?
C. How would you determine the key competitors for the business?
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Figure 2.1 Software applications are what allow us to interact with our computer’s hardware. It is essential to learn how to use

programs like calendars, word processors, and email clients to communicate with others and create documents in the workplace.

(credit: "wocintech (microsoft) - 241" by WOCinTech Chat/Flickr, CC BY 2.0)

Chapter Outline
2.1 Software Basics
2.2 Files and Folders
2.3 Communication and Calendar Applications
2.4 Essentials of Microsoft 365
2.5 Essentials of Google Workspace
2.6 Collaboration

Chapter Scenario
WorldCorp is a multinational conglomerate that produces and works in consumer goods, health care, and
technology. Its functional service areas include research and development, strategy, operations, production
and distribution, human resources, information technology and equipment, marketing and sales, finance and
accounting, and customer service.

The corporation has a strong commitment to social responsibility and environmental protection. Employees
are encouraged to participate in company-wide and individual charity initiatives, with paid time off to
participate in each once a month.

With employees located across the globe, WorldCorp understands a successful workplace is supported by a
commitment to equity, diversity, and inclusion (EDI). It has a strong ethics policy that is enforced throughout
the company hierarchy, with senior leaders and management expected to serve as models in all actions and
interactions.

You have just been hired as a management trainee at the company and will be exposed to all functional areas.
In this chapter, you have just been hired and are tasked with learning the basics of the software programs
WorldCorp uses to run its operations, most notably Microsoft 365—or more commonly known as its longtime
former name, Microsoft Office—and Google Workspace.

Essentials of Software Applications for Business
2



2.1 Software Basics

Learning Objectives
By the end of this section, you will be able to:

• Explain what software is and what it does
• Describe each of the main software types used in business
• Understand how to install and maintain software

You learned about the history of computers and basic hardware in the Technology in Everyday Life and
Business chapter. While hardware is the backbone of a computer, and knowledge of it and what can go wrong
with it helps you to keep vital devices working properly, software is the lifeblood that gets work done
personally and in the business world.

This chapter examines the basics of software programs. It also covers the terminology and functions common
to most programs. Refer to this chapter as you work through the rest of the material in the textbook,
especially when you encounter more advanced concepts.

One final note: Before beginning this chapter, be sure you know how to use your mouse to click and hover.
Clicking (sometimes called pressing or selecting) the left side of the mouse tells it you want to activate a
command directly on the screen. It is the most direct use of the mouse. Clicking the right side (called “right-
clicking”) of the mouse will reveal a little screen with a menu of options. Don’t worry about those yet. And,
finally, hovering over portions of the screen such as icons will give you a short descriptor of that tool or menu.
When you hover, you do not click the mouse at all but rather direct it over the tool icon.

MAC TIP

You will need to hold the Control (Ctrl) key when clicking the mouse to reveal the menu of options, and then
hold Command when clicking the mouse to activate a command directly on screen.

What Is Software?
When using a computer, we often hear the terms programs, software, and applications. Sometimes these
terms are used interchangeably. However, there are some distinctions. Programs are the instructions that tell
the computer how to operate and run specific tasks. Whereas software consists of the step-by-step
instructions that tell a computer how to operate with its hardware. Software is essentially a collection of
interlinked programs. More specifically, the instructions enable the program to perform specific actions such
as printing, saving, or formatting text. These step-by-step instructions are written in computer language or
code. Different types of programs include the Microsoft Office suite, educational software, and antivirus
software.

There are two major categories of software: system-related software and application software. System
software is related to the functioning of the computer. Examples include the computer’s operating system and
the software needed to run items such as printers, the keyboard, and antivirus software. Applications are
programs that are task-oriented, including those we will cover in this text such as word processing programs
and presentation software. Internet browsers are also considered application programs. They are used to
search for content on the internet.

There are several facets of programs that are consistent regardless of the type of program. The programs use
computer programming to add the functionality for the software or application. For example, there is a
specific computer programming language (or code) that is used to simply print a document. This language is
the foundation for making the program work. The basic elements of programs are shown in Figure 2.2. They
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are:

• The graphical user interface (GUI) is the portion of a program that allows the user to interact with it.
Commands in Office are organized in groupings called tabs, while in Google Workspace, these groupings
are called menus.

• A menu bar, or ribbon, typically at the top of the screen, contains an array of general commands that the
user can choose, such as changing the font, printing the file, or adding elements such as pictures or
shapes. In Office, this is referred to as the ribbon.

• A toolbar, typically located below the menu bar, contains icons or graphical representations for commonly
used commands such as Copy or Save that are more specific than those contained in the menu bar.

• A dialog box provides information or requests inputs. These boxes typically appear after a user action,
such as clicking a button or selecting a menu option. For example, see Figure 2.2, which shows more
options for changing the font color or size.

• The status bar is located at the bottom of the program window. Its main function is to show the status of
the program, such as the number of pages.

Figure 2.2 The common format for software includes a series of menus or toolbars at the top of the screen that are specific to the
functionality of the program. (Used with permission from Microsoft)
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Common Applications in Business
Task-oriented applications include word processing, spreadsheet, presentation, and database management
programs. Figure 2.3 shows the icons for the popular applications in Google Workspace.

Specialized applications include programs used only for certain disciplines or occupations, such as
QuickBooks, which is used for accounting. Mobile applications such as E-reader applications are programs
designed primarily for smartphones and tablets.

A word processing application creates text-based documents such as memos, letters, and reports. Just about
every organization uses word processing software, especially businesses, colleges, and universities. Microsoft
Word is the most widely used word processing application, along with Google Docs and Open Office Writer.

A spreadsheet application organizes, analyzes, and uses numeric data. These applications are common in
just about every profession today for compiling data in a table and creating visual displays (graphs and charts)
of the information. Sales data from WorldCorp can be analyzed using the tools in a spreadsheet application.
The most widely used spreadsheet applications are Microsoft Excel and Google Sheets.

A presentation application combines graphics and text to create attractive slideshows. These applications are
used by students in colleges and universities as well as in the business world. The most common presentation
applications are Microsoft PowerPoint and Google Slides. Employees at WorldCorp can use presentation
applications to prepare sales summaries to present to key executives at the company.

A database application is designed to organize and store large amounts of data. The information in a
database program often includes both text and numeric information. Microsoft Access is a database
application that can be used to compile and filter a large dataset. WorldCorp can use Access to store customer
data in one file that includes information such as the customer address, historical purchase information, key
contacts, and other related information.

Figure 2.3 Google Workspace includes applications for emailing, managing files, and creating spreadsheets. These are the common
icons you will see most as you start to learn this suite. (Google Workspace is a trademark of Google LLC.)

Specialized applications include programs that are used only in certain disciplines or occupations, such as a
design application used in the engineering profession. Another example would be tax software programs that
accounting professionals use to prepare taxes for their clients. Desktop publishing enables users to mix text
and graphics to create page designs and layouts for brochures, newsletters, and textbooks. Popular types of
desktop publishing software include Adobe InDesign and Microsoft Publisher.

Finally, businesses might also use social media applications. Social media applications are used to create
virtual networks or communities through which users connect and share information, messages, and/or
content such as images and videos. These applications are accessed either through the internet or by
downloading the application to your device. These applications are geared to connecting with others in a
variety of different scenarios. For example, LinkedIn is a professional networking application that can help you
connect with others in your career field. Social media applications will be covered in detail in Content
Management Systems and Social Media in Business.

One of the first social media platforms was Myspace, which was used to connect individuals with family and
friends, as well as for networking. Then came Facebook (which became more popular than Myspace),
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Instagram, LinkedIn, TikTok, and Twitter (now X). At WorldCorp, you would most likely use LinkedIn, which is a
site tailored to the business world. Companies and workers share news, their résumés, and network through
it. Social media also allows virtual collaboration, which plays a role in work life, as individuals can use Zoom or
Microsoft Teams for business meetings, a feature that became crucial during the COVID pandemic. Many
organizations also use social media for marketing purposes.

In addition to interacting with others, social media users can watch movies and play games on many different
types of devices, including tablets, computers, and even cell phones through social media sites. The chapter
Content Management Systems and Social Media in Business covers this topic in more depth.

Installing and Maintaining Software
Installing software is an automated process for the most part. Although there are some differences based on
both the software and the operating systems (Windows or macOS), software installation follows a basic
process. Acquisition of the software often begins with visiting the software website and purchasing the
software download. Not all software requires a purchase. Some programs are freely available. Also, not all
programs are directly downloaded onto your computer. With today’s cloud-based technologies, some software
exists in the cloud and instead you are downloading an app on your device to get access to the software.

Once you have identified the software you would like to install, generally you will find a link (or button) on the
website that says Download. By clicking on the download, you agree to allow the software components to be
added to your computer’s hard drive. Also, although not as common today, software programs can be installed
via a CD-ROM. If you have a CD-ROM to install the software, often the installation process will begin once the
CD is inserted in the CD drive. You will be prompted with similar dialog windows whether installing from a
download or a CD-ROM.

Keep in mind that you need to do your research and use caution when choosing software from the internet to
download. There are fake sites that exist for downloading software that could harm your computer.
Additionally, sometimes there are options to download other software or additional features to install. These
are generally not necessary and could again be potentially harmful to your computer. Take the time to make
sure you are downloading software from trusted sites.

The installation begins with downloading a folder that contains the necessary files to install the software
program on your computer. Two key files in the folder are the README file and the actual install file, which will
have a .exe extension (the execute file). It is a good idea to read the README file. This file is a text file that
contains the steps needed to install the program. It will also contain the system requirements information to
determine if your computer is suitable for the program. The programs differ based on the computer space
needed to store the software files and the version of the operating system needed for the software to function.
The download prompter screens will often indicate the amount of space required for the installation.

Installation starts when you click on the .exe file. You will be prompted with a series of approvals at the
beginning of the installation. These approvals could include the consent to make changes (add files) to your
computer, closing all other open programs, and usage of the software. Some software programs will have
options to customize the installation based on the elements you want installed or where you want to place the
installation files. You may be prompted with a dialog box asking you the type of installation, which could
include options such as basic installation or customized. Often, the software developers will recommend the
basic installation for most applications. Unless you have a reason not to complete the installation as
recommended, there is usually no reason to choose a customized installation.

MAC TIP

.exe files are only for Windows computers and cannot be installed on macOS operating systems. The Mac
operating system uses .dmg files.
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Maintenance of software is simple. Developers of the programs will regularly check the programs for issues. At
times, there may be a need to update the software. You might already be familiar with the concept with your
cell phone. These updates improve security and functionality of the programs when issues arise. Installation of
the updates can be set to be automatic, or you can manually and regularly check for updates of the software
programs. Many programs will notify users when the program is opened if an update is available. Updating
the software is a necessary part of keeping the program functional.

Troubleshooting issues in a program is another key component of being a software user. Most software has a
Help function or menu available to assist the user with questions about the program. The items in the Help
function are generally centered on issues of using the program itself. Items could include how to perform a
certain task such as printing or other related items. If your issue is not solved with this type of assistance, most
programs have a way to connect with the software company for more assistance through registering the
software. This could be in the form of sending an email, contacting customer service by phone, or through a
chat function in the program. Most problems with the functionality of a program can be resolved through one
of these methods.

2.2 Files and Folders

Learning Objectives
By the end of this section, you will be able to:

• Describe the purpose and use of files and folders
• Identify different file formats and their common uses
• Apply best practices in file and folder organization, including saving
• Understand the differences between Google Drive, SharePoint, and OneDrive

Being organized is a key skill in the business world. Disorganized workspaces, whether real or virtual, can lead
to a host of negative outcomes: lost productivity, wasted money and resources, and a poor worker reputation.
A study by professional staffing company Express Employment Professionals revealed that approximately six
hours per week can be lost to poor organizational skills, and that employees earning $50,000 a year can cost
their employers upward of $10,000 annually in lost time. You don’t want to be one of those employees. So,
here, we will learn how to organize your computer software files. This is a basic, key skill.

Right now, as a student, you need a way to organize the items from your classes such as the syllabus,
homework papers, and class notes. Some students choose to use a physical binder to organize all the material
needed for a class. You may have one binder to hold the information for all your courses, or multiple binders,
one for each course. Just as you would organize class material in a binder, a computer needs a way to organize
the information stored in the hard drive. Through computer coding and programming, the computer uses a
system of files and folders to organize the information and run its programs correctly.

Most people will never use many of the files and folders stored on the hard drive. For example, you probably
will not access the information in the Windows folder or the Program Files folder. Those files that are needed
for operating the computer are generally not necessary for the average computer user to access. You will use
files and folders for specific software programs for information you have created. Understanding how to
navigate the files and folders on the computer is crucial.

Using and Organizing Folders and Files
A file is a collection of data, such as a document or a program. Files are stored within a folder, which can
contain subfolders as well as individual files. Files contain information, unlike folders, which are used to
organize the files. For example, you might organize the photos on your phone into folders labeled by year or
by type of photo (family, friends, events). In addition to those folders of photos, your phone contains other
folders, each named based on its contents.
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In this course, you will work frequently with four types of files:

• Document files are used in word processing applications to save documents such as school assignments,
communications, and lists. Microsoft Word and Google Docs are two of the programs businesses use
most. WorldCorp would use document files for company memos to employees or to write up contracts
with new vendors.

• Spreadsheet files are produced by spreadsheet applications, such as Microsoft Excel and Google Sheets.
This type of file is often used to analyze data and for numerical recordkeeping and calculations.
Spreadsheet files could be particularly useful for WorldCorp when summarizing sales data for the last
quarter or to create charts to show sales trends in different regions.

• Database files are created by database management applications. Many companies have high-level,
specialized databases that store information about customers or specific products they sell. In this course,
you will learn about Microsoft Access.

• Presentation files consist of pages that may be used as slides or handouts. Google Slides and Microsoft
PowerPoint are popular presentation applications.

What Is a Folder?
A folder is a defined area of a computer or drive that stores subfolders and files (Figure 2.4). Organizing files
into folders and subfolders makes it easier to locate a specific file and to keep files organized for the long
term. Folders and subfolders are a hierarchical way of organizing your files.

Figure 2.4 A computer stores files in the same way you might store files in a filing cabinet (although maybe a little neater). (credit:
“document file, folders, carton, paper” by PPD/Pixnio, CC0)

Using and Organizing Files
As you create and use files, you will develop a system of organization that works for your needs. In some
cases, the entity that you work for will have a system that is used for all employees. The goal is to gather files
in such a way that facilitates finding and using those files. You could organize files by type (all Word documents
in one folder), by date, or even by project. Your system will depend on how you interact with your computer
and how you plan to use the files you create or download. There is no one standard way to organize files, but
here are a few tips to get you started:
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• Decide on an organizational system that works for you.
• Use descriptive folder names and be consistent with naming.
• Make use of subfolders within the main folder.
• When files are created, place them in the appropriate folder.
• Regularly delete or archive files or folders that you no longer need.

Opening a File
To open an existing file, locate the file wherever it is saved. It may be saved on your computer hard drive, in
the cloud, or on an external drive such as a flash drive. The easiest method for locating an existing file is by
using the File Explorer folder (see Figure 2.5).

MAC TIP

Folders can be found in the Finder or the Documents tab.

To access File Explorer, either double-click the manila folder icon on the desktop or access File Explorer
through the Windows menu. You can also search for a specific file name using the search bar at the bottom of
the screen or the search bar at the upper-right side of File Explorer. As you can see, there are several ways to
find the file you are looking for.

Figure 2.5 File Explorer shows the folders on your hard drive and the devices that are connected to your computer. The Search This
PC search bar finds specific files on your local hard drive. (Used with permission from Microsoft)

Once you have located your file, you can either right-click or double-click on the file to open it.

Creating a File
To create a file, you will likely begin in the application program itself. For example, to create a new presentation
file, open PowerPoint or Slides. Or you can create a new file directly from the desktop: Simply right-click on the
desktop screen itself, select New, and choose the file type you want, as Figure 2.6 shows.

MAC TIP

For Mac users, the procedure to create a file is the same, except you would use Finder.

The new file will be created when the application program opens. Once a new file opens, you can add text,
images, and other items to your file as needed.
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Figure 2.6 The various application programs are listed for you to select when creating a new file. (Used with permission from
Microsoft)

Saving a File
Saving files might seem like a mundane task, but it is one of the most basic skills to master in computer work.
In general, there are three broad categories of saving files: Save, Save As, and AutoSave. Save and Save As
both give you the option to choose the file type and the name of the file. You would use Save if you are saving
a file for the first time and also, as you go along if you are saving the file to your computer, rather than to the
cloud. You can use Save As to save an existing file under a different name. This can be useful if you are keeping
track of different versions or revisions of the same file. You would also use Save As to save the file in a different
location on your computer. Finally, AutoSave does just what it implies—saves continuously as you make
changes to the file. This is a nice feature in both Microsoft and Google applications, making it easier to retain
changes in a file without having to constantly remember to save the file you are working with.

Moving and Deleting a File
From time to time, you will need to move and delete files as part of good computer housekeeping practices. To
delete a file, right-click on the file you want to delete and choose Delete. Once deletion is confirmed, select OK.
You can select multiple files by using either the Shift or Ctrl keys. Use Shift to select files that are listed
together. You would click the first file and then hold Shift and click the last file in the list you want to move or
delete. To select files that are not listed together, use the Ctrl key. Click on the first file, and then, to select
additional files, hold the Ctrl key and then click on each file name.

MAC TIP

You can delete the file, which will move it to the trash bin, or you can simply drag the file to the trash bin. To
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completely delete the file, you must empty the trash bin.

To move a file, you can use one of two methods. You can click and drag the file to the new location. This is
particularly useful if you have saved a file on the desktop and now want to move that file to a designated
folder. Alternatively, you can Cut the file from its current location (see the Home tab) and then Paste the file to
the new folder or location. This can be tricky if you do not immediately paste the file in another spot. Use
caution when totally deleting files.

Recovering a File
After you have deleted a file, you may still be able to recover it. This is not always possible, but in some cases,
you can recover files that have been deleted or, at least, locate a previous version that may be saved on your
computer. First, check the Recycle Bin. Generally, you will find it on the desktop. Open the Recycle Bin by
double-clicking on the Recycle Bin icon on the computer desktop. When you see the file that you deleted and
now want to retrieve, select it by double-clicking on the file name. Then, choose Restore from the dialog box.
You can also right-click on the file name and choose Restore from there. Another strategy is to simply search
for the file on your computer in File Explorer. In the search bar, type in the name of the file (even a partial
name will work). You may be able to locate the file or a version of the file through the search tool.

MAC TIP

A file that is in the Trash can be restored. If the file has been removed from the Trash, and you use Time
Machine, Apple’s backup program, you can recover an earlier version of the file even after it has been
removed from the Trash.

Windows systems have another option for retrieving deleted files, which involves restoring files from the file
history. This is in the Systems and Security area of your computer’s Control Panel. The easiest way to access
this tool is to type File History in the search bar by the Start menu (see Figure 2.7). If you have File History
enabled on your computer, you can choose Restore your files with File History to search for the file you have
deleted.
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Figure 2.7 File History can also be accessed through your computer’s Control Panel. (Used with permission from Microsoft)

As a final option, there are apps that you can download to help you search and recover deleted files. Several
apps that serve this purpose are free and can be helpful when searching for a deleted file.

Compressing and Extracting Files
Sometimes you’ll be working with a file that is too big to send as an email attachment. In that case, you can
shrink the file down. It’s analogous to letting the air out of a raft so you can store it in a tight spot and then
reinflating it later for use. The process of reducing the size of one or more files by removing unnecessary data
is called file compression. Compression also allows larger files to be sent faster and more efficiently. Large
files usually contain lots of dense graphics or video clips or photos. With compression, no content in the file is
lost; the file is simply compressed in size by the computer to make it more manageable. These compressed
files are often referred to as zipped files. But be aware that in some instances, email recipients may not be set
up to receive zipped files. This is a setting that is managed by their information technology (IT) administrator.
In this case, you may have to send the uncompressed file or share the file with the recipient in another way.

How to Compress and Extract Files
Locate the file or files that need to be zipped. Press and hold or right-click the file to select it, click Send To, and
then select the compressed folder. Locate the zipped file that needs to have files extracted from it. You can
extract a single file, open it, and then drag it from the extracted folder to a new location. Or, to extract all
contents of the zipped folder, you can press and hold or right-click the folder and select Extract All.

MAC TIP

To compress a file on a Mac, select the file you want to compress and then hold Control and click on the
mouse and choose Compress.

2.2 • Files and Folders 71



File Types
Information in computers is stored in a system of files. Each file will have a unique file name followed by an
extension, using the file name.extension format. The file format depends on the usage of the file, the
program in which the file was created, and/or the size of the file. The computer will store the data in a
particular file format, which is the way the data is encoded, depending on the type of data and the application
the computer will use to read it. There are many different file formats. You may be familiar with some of them,
such as .doc or .txt. The .txt file format is a general format for a text file that can be recognized by almost any
word processing application. The text contained in a .txt file does not contain any formatting such as
underlines, special spacing, and other related items.

There are many other file types within the computer filing system that you will probably never see. These file
types are necessary instructions created to make the computer function. Those operating file types are beyond
the scope of this text and are not essential for you to understand how to use a computer and the software
programs on your computer effectively.

Table 2.1 lists some common software program file extensions that you may already be familiar with. You can
choose the file type in the Save dialog box so that you do not have to type the file extension as part of the file
name. Generally, the application you are using will have the file extension already chosen in the Save dialog
box as a default. In general, an “x” is added to the end of a file extension for newer versions of the application.
For example, when documents are created in Word in versions 2007 or newer, the file will have the .docx
extension rather than .doc only.

Application File Extensions

Microsoft Word .doc, .docx

Google Docs .gdoc, .gdocx

Microsoft Excel .xls, .xlsm, .xlsx

Google Sheets .gsheet

Microsoft PowerPoint .ppt, .pptx

Google Slides .gslides

Table 2.1 Types Computer application files are
saved with the file name and an extension that
identifies the type of file it is.

Rich Text Format (RTF)
Microsoft developed Rich Text Format (RTF), or .rtf, files in 1987 to enable other Microsoft applications to
read Word output more easily. Today, the .rtf format can be used to make your .docx file more compatible so
that other software can use the information in the file more readily. For example, information from a Word
document that is saved as an .rtf file type can be fed into a database program. Text in .rtf appears fairly
“plain”—that is, with minimal formatting. .rtf files have stayed more or less the same as when they were first
released, but Word .docx files are frequently updated. To put it another way, an .rtf is less sophisticated than a
.docx file and may not support all the features of a newer .docx. To save a file as an .rtf, go to the File tab, click
on Export, hover over Rich Text Format, and then click Save As.
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MAC TIP

To open .rtf files on a Mac:

1. In the TextEdit app on your Mac, choose TextEdit > Settings, and then click Open and Save.
2. Select Display RTF files as RTF code instead of formatted text.
3. Open the .rtf file.

Portable Document Format (PDF)
In the business setting, you will see many documents in Portable Document Format (PDF), or .pdf. Unlike
.docx format, the .pdf format is designed as a publishing platform, so .pdf documents are not easily editable.
This is an advantage because it means that everyone who opens the .pdf document will see the same format,
alignment of objects, font style and size, images, tables, graphs, and so on. The appearance of the document
will not change across any computer, phone, tablet, or other device. The Word file format, by contrast, is
designed to be fully editable, so if you use Word 2019 or Word 365 (part of Microsoft 365), for example, to
open a .docx created in Word 2013 or Word 2016, you may see unintended and unwelcome changes, such as a
shifted object.

Countless companies and other institutions typically release their annual reports and other public documents
in .pdf format. WorldCorp publishes its annual report using the .pdf format. Local townships, public schools,
and community agencies also are likely to distribute their newsletters and other information as .pdf
documents. Further, many job seekers produce a .pdf version of their résumé, as Figure 2.8 shows, to prevent
style or alignment changes when the prospective employer opens the file.

Figure 2.8 Saving as a .pdf file can preserve formatting and spacing in documents such as résumés and newsletters when they are
shared with others and opened in other programs. (Used with permission from Microsoft)

Web Page/Hypertext Markup Language (HTML)
Many professionals have their own web page, featuring their professional experience, skills, contact
information, and samples of work or testimonials. The content of such a website can be created in Word. For
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more than a decade, Word has doubled as a What You See Is What You Get (WYSIWYG) HTML editor—a web
page design application that lets users make their own web pages without needing to know hypertext markup
language (HTML). HTML is one of the major programming languages that web designers use to make
websites. Essentially, Word lets you write the content of your web page as if you were writing any document in
Word; you can add images, objects, and graphs, then Save As an .html file. However, there are better ways to
create content for websites rather than using Word. We will discuss more about this later in the book.

Today, many people use packaged services such as WordPress or Squarespace to create their own websites.
You may still find some people who prefer to use Word to create their website or at least to design the initial
content and layout of the site. Also, note that just creating a website doesn’t make it available on the web. The
website will need to be published, a domain name purchased (e.g., www.yourwebsite.com), and it hosted
through a paid service such as GoDaddy.

Graphics
Graphics file formats are for pictures and moving images. In general, graphics can mean any program that
allows a computer to display these types of images. But for our purposes here, it means a file format. Without
going into detail that is beyond the scope of this text, these graphics file formats organize their information in
different ways. You just need to be able to recognize what they are in the workplace.

• JPEG, which stands for Joint Photographic Experts Group, is the most common of the formats. Its benefit is
that the files can be quickly uploaded to any platform, even if the images are large. However, if the files are
compressed and decompressed multiple times when sending, the images can lose quality.

• PNG files (.png) are higher quality than JPEGs. PNG stands for portable network graphics. This file type is
best for images with sophisticated backgrounds, making them denser and therefore needing more
storage space on the hard drive, and more time to load on your computer.

• GIF (.gif) stands for graphics interchange format. It is a file format that works well for graphics with few
colors.

• PDF stands for portable document format. It is a common file format that works best for online
documents that you don’t want altered. They print well, too. A PDF (.pdf) file format is not only used for
text, but for images such as photos, as well as audio and video. Adobe Photoshop, InDesign, Word, and
Docs are some of the applications that allow you to create PDFs.

• SVG (Scalable Vector Graphics) file formats support digital illustrations made up of geometric shapes. SVG
(.svg) file formats retain the highest quality even when resized, but they are not applicable to social media
platforms.

• MP4 (Moving Picture Experts Group) is a multimedia format that stores internet videos. MP4 (.mp4) files
can contain audio and subtitles. They take up a manageable amount of computer storage space and you
can easily upload them on a social media channel or a website.

Best Practices in Using and Organizing Folders and Files
Remember that Word allows users to save documents in different file formats and in multiple versions within a
single format, designated by changing the file name—for example, from “version1” to “version2.” Word also
lets you choose between different file formats depending on how you want to use the file. You may also want
to publish your document on the web, using a file format that allows it to be read correctly by web browsers.

REAL-WORLD APPLICATION

Tips for Organizing and Maintaining Files

Imagine you have been asked by your professor to resubmit a homework assignment that you originally
turned in at the beginning of the semester. The professor cannot find your submitted assignment, so you
currently have received zero credit in the gradebook. Having a well-organized system for keeping track of
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your school notes and assignments will help you quickly find this assignment.

This scenario can also be applied to the workplace. Suppose you need to quickly locate a document for a
customer or a coworker. A good organizational system makes this task much easier. Here are some tips for
effective file management:

• After creating and naming a file, place it in the appropriate folder based on your organization system. If
you want quick access to a file, you can store it on the desktop. But if you store too many files on the
desktop, it can be hard to locate a specific file. It is generally preferable to store files within folders and
to reserve the desktop for icons to access particular apps. Ultimately, this is a matter of personal
preference.

• Group files by category. For example, your categories might be Business Plans, Résumé Services,
Memos, Letters, and Meeting Notes.

• Create subfolders for all files and give them descriptive names. For example, you might want to label a
subfolder Business Plan – Client 2 – June 2023.

• Use effective file name conventions for folders. Specific, informative file names like Resumes – 2022
and Employee Files – A–M will save you the time of having to search within a folder with a more generic
name.

It is important to keep your files current. In many cases, you may have files that you no longer use or that have
been updated. In that case, delete the previous versions of the file. Unless you need to refer to a previous
version of a document or think you might need the information in the future, generally there is no need to
keep older files that you no longer use. You can save multiple versions of a file and rename them in such a way
that they identify the version of the original file referencing the version or even the date of the version of the
file.

To make this process effective, be consistent in naming versions of files. Always use the same approach. For
example, you could have the file name with the version number and the date (nameV2Mar212023). What is
more important is having a consistent approach that is used by everyone who uses the files.

If you are hesitant to delete the files entirely, consider backing them up to an external drive such as a flash
drive or a cloud-based storage option. This will free up space on your computer’s hard drive, while still
reassuring you that your files are secure. As a best practice, regularly back up all your files/folders on your
computer, not just the items you are no longer using.

Create a folder organization system that works for your needs. For example, you might want to create folders
by software program, by date, or by client. Establishing an organization system for your folders will save you
time when searching for specific files. Consider writing out the system on paper first to get an idea of what it
will look like. Just the process of writing out how your folders will be organized may give you additional ideas
on how to structure your system. For example, if you have a few larger folders organized by client, you may
want to have several subfolders within each of them that house specific files for that client by software
program or usage.

Suppose WorldCorp asks you to keep track of correspondence with four of its clients. You can create four main
folders (Clients 1–4) and then, within each of those folders, subfolders labeled Invoices, Email Correspondence,
and Work Tasks. It is often easier to have the folders and the files within those folders sorted alphabetically so
that you can easily find information.

It is better to use full names and words rather than abbreviations in your folder names. This makes using the
search function more effective in locating the folders you need. This is especially important if files are shared
and may need to be accessed in your absence. Most computers have the capability to mark or flag certain
folders or files for quick access so that you can readily find them. Generally, this capability is found in the File
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Explorer feature in your computer, which looks like a manila folder and is located on your desktop. You could
also place those files or folders that you use daily on the desktop for quick access to them when you need
them. Finally, organize your files as you create them rather than saving that task for later. When you create a
new file in a software program, determine the folder where the file will be placed, and save the information
there.

Google Drive, SharePoint, and OneDrive
Both Microsoft and Google have applications to help you manage, organize, and share your computer files.
Drive is the online, cloud-based file storage system in Google. Drive is free and allows you to store, organize,
manage, and create files online through the Google platform. Drive also has the capabilities to sync with
multiple devices and has convenient sharing tools to share files and images with others. You will get your Drive
when you create a Google account. There are limits to the storage capacity on Drive, but you can pay for more
storage if needed.

Microsoft’s versions of Drive are OneDrive and SharePoint. Like Drive, both are cloud-based systems. However,
each serves a different purpose. OneDrive is most similar to Drive in its intended use. It is a storage system for
files in the cloud, which enables you to access files on a variety of platforms and to share documents with
others. You can also store and manage documents through SharePoint, but it has many more capabilities,
designed for business and team communication. SharePoint helps build a shared library of resources to be
used company-wide, such as links to employee documents or forms common to the organization. You can also
use it to distribute comments or announcements company-wide and to create content and web pages to
share. Within a company, you may have both OneDrive and SharePoint. For personal use, when you create a
Microsoft account, you will be given a OneDrive account. SharePoint is more of an enterprise system for
company teams.

2.3 Communication and Calendar Applications

Learning Objectives
By the end of this section, you will be able to:

• Identify common communication applications for email and messaging
• Apply best practices to crafting an email
• Describe features and uses of calendar applications

Effective communication is a key component of any organization. Today’s technologies enable us to
communicate nearly seamlessly across thousands of miles, so that organizations can operate more efficiently
and respond quickly to their customers’ changing needs.

Communication technologies fall into three broad categories: email, instant chat/messaging, and
videoconferencing programs. Some companies might also conduct communication by placing calls over the
internet. Email is electronic mail. It is like writing a letter and delivering it via the internet rather than through
the postal service. Instant chat/messaging is designed for brief, typed messages that are delivered in real time
as if you were chatting with someone face-to-face. Finally, videoconferencing programs use video to mimic a
face-to-face meeting where you can see and hear the other participants, but in a virtual environment (rather
than in the same physical location).

There are advantages and disadvantages to each type of communication technology. Email is not ideal for
conveying emotion clearly. Instant chat/messaging, though quick, as its name implies, may not preserve the
entire conversation for later reference. (This may depend on the messaging service used.) Many email and
instant messaging applications include a video chatting/meeting option as well.

With video communication programs, engagement from participants could be limited, especially if participants
keep their video cameras turned off or if there are a large number of participants. It may be difficult to
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interject to speak in such a setting. But video communication software has made it possible to hold
departmental meetings where all members do not have to be gathered in the same location. This technology
has transformed communication on a large scale as well, especially on the world stage, as Figure 2.9 shows.

Figure 2.9 Technical Cooperation Members of the COP26 Climate Change Conference hold a virtual meeting in 2021 in Glasgow,
Scotland, enabling stakeholders from 200 countries to come together whether in person or over the internet. (credit: “IAEA Staff
Behind the Scenes at COP26” by IAEA Imagebank/Flickr, CC BY 2.0)

Communication in the Digitized Office
Effective communication is essential for enhancing organizational performance. Communication is needed
from upper management to effectively convey the strategic goals of the organization. Communication among
colleagues is needed to ensure that work tasks are being completed in a timely manner. And, finally, external
communication of an organization to key stakeholders such as customers or vendors is necessary to increase
the customer base or garner additional funding if needed. External communication is essential when
marketing your company. WorldCorp can use external communication via a variety of ways (such as a website
and emails to potential customers) to raise awareness about a new product line they are offering. With
technology today, business can be conducted without the individuals being in the same physical space. It is
likely that you will encounter a digitized office environment in your career.

Challenges of Digitized Collaboration
Some challenges of collaboration via technology include:

• Building trust
• Scheduling
• Addressing communication issues
• Overcoming cultural differences

Regular video calls with teams can be an effective way to build trust in an organization. In a digitized business
environment, scheduling will need to account for time zone differences and this can be facilitated with the
technologies today. Figure 2.10 shows one map of the world time zones that most video conferencing
programs will automatically account for when scheduling meetings in multiple countries and continents.
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Figure 2.10 An understanding of time zones is important in running video meetings in multinational corporations. (credit: “Standard
World Time Zones map (as of August 2015)” by UnaitxuGV/Wikimedia Commons, Public Domain)

Communications issues such as language barriers can be addressed using translation capabilities within some
applications. This can allow businesses to recognize cultural differences that may exist within their
organization or customer base. Organizations that operate remotely should consider offering training to help
overcome some of these cultural differences so that they do not become barriers to effective teamwork. The
training could include cultural awareness training or even language classes to assist employees working across
borders.

Essentials of Business Communication
Communication in the workplace is an essential part of the day-to-day functions for any employee. Keep in
mind that communication conducted using company equipment (even if private) can be recorded and is the
property of the company that can be accessed at any time. So keep this in mind when you are communicating
while at work. This includes chats, instant messages, emails, video calls, and computer files.

Although the exact content of the communication will vary, there are some best practices to follow to make the
communication more effective. First, one of the most important aspects of communicating is to know your
audience. The way you communicate with your coworker could be completely different than how you would
communicate with a senior level manager in the company. The communication style, needs, and method can
vary widely based on the audience. Next, you need to understand your communication objectives: Is the intent
to inform or persuade? What are you hoping to achieve with the communication? Knowing the answer to these
questions can help you format the content of your communication and clearly articulate the message.

Determining the audience and the purpose of the communication leads to creating the content of the
communication. First, consider the level of formality needed in the message. Communicating lunch plans with
your coworkers is a different level of formality than communicating quarterly sales results with a manager. You
might also consider the timing of communication in your thought process. Sending critical information via
email at 5:15 p.m. on a Friday afternoon may not be the best timing for the message to go out. Some
applications might give you the ability to schedule delivery of emails at a more appropriate time. Timing is
especially important when communicating across time zones. Be sure to spell-check your content and read it
out loud for professionalism when appropriate. This is also applicable to all attachments to the
communications that you might send.
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Communication Applications
WorldCorp uses email, instant messaging, and video applications because it has several employees who work
remotely. Technologies of this kind are called communication applications, or software that facilitates
communication between individuals or groups.

Email has become its primary means to communicate. Instant messaging also plays a role in the company as a
fast way to communicate with coworkers who might not be located in the same office space as you are. Finally,
video communication applications work well when not everyone can be in the same place to meet face-to-face.
Within each communication type, there are several applications available, and many are integrated into one
program. Most of the software for the communication type will have similar functionality. For example, many
email applications offer similar tools and capabilities for communicating.

Email
Email is a digital means to send messages, ranging from a short memo to a longer narrative, which can be
sent to a single recipient or to thousands (or more). You’ve most likely used or at least heard of popular email
programs such as Outlook, Gmail, Apple Mail, and Yahoo! mail. Emails can also include attachments, such as
Word or Excel documents.

Regardless of which email program you use, all emails have certain common elements. The main components
of an email include: To, Cc, Bcc, subject, body of the email, and attachments, as shown in Figure 2.11. The To
field is where you enter the address of the primary intended recipient(s). You can include multiple recipients
for the email; their email addresses will be separated either by a “,” or a “;” depending on which program you
are using. All carbon copy (Cc) recipients will get the identical email and all recipients will know all that have
received the email, but they are merely “copied” on the message to be informed of it. There is no action
required by Cc’d recipients. A blind carbon copy (Bcc) means that the recipients in the To and Cc fields will not
know the Bcc individual has received the email. This function serves to inform someone else confidentially and
usually means there is a crucial need for it. It’s not a function to use lightly or liberally.
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Figure 2.11 When composing a professional email, format the email in a similar manner to a business letter. (Used with permission
from Microsoft)

The subject line of the email is a brief description of the content or purpose of the email. The body of the email
is composed in the large space. Composing an email in an email application is similar to using word processing
software such as Google Docs.

The final component of most emails is attachments. Not all emails have to include attachments, but you may
want to include an attachment such as a document to review or an image you want to share. To attach a file to
an email, you will usually find a tool or icon that looks like a paper clip. Attachments are just as they
sound—additional information that is saved in a computer file outside of the actual email, such as
spreadsheets, pictures, and PDFs. These digital files can then be saved by the recipient on their computer for
future use.

When responding to an email you have received, you have several options. You can choose Reply, Reply All, or
Forward, as Figure 2.12 shows. Reply will allow you to compose a response, which will go to the sender of the
email only. When you choose Reply All, everyone who received the original email from the sender will also get
your reply. Use caution when choosing Reply All. Make sure you are comfortable with all on the email
distribution list reading your response.
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Figure 2.12 When responding to an email, be careful to choose the appropriate option. As an example, you may not want to choose
Reply All when responding to an email that was sent to all employees. (Used with permission from Microsoft)

For example, the human resources (HR) director at WorldCorp has just sent a company-wide email about the
upcoming holiday schedule. If you had a question about the schedule and chose Reply All, everyone in the
company would get your email with the question. You really intended only to ask the question of the HR
director, so you should have used Reply.

Finally, Forward allows you to forward the original email to someone else. You might choose this option if you
want to get some input on a topic before responding. Sales personnel at WorldCorp might use the Forward
option to send accounts payable receipts for products they have purchased.

Generally, email is not the best communication channel for long discussions that require input from multiple
people, because you will get multiple replies that clog your email inbox (more on that later). In general, a
business email should take a formal tone. Like a business letter, it should be clear and concise. Emails should
include a descriptive subject line that conveys the topic of the message. In fact, some email programs have a
security feature that will flag any message without a subject line and will ask you to write one before clicking
Send.

Professional business emails should start with a greeting or salutation—something like Dear Mr. Jones, Mr.
Jones, or simply Jim, depending on the level of formality you desire.

The body of the email should be brief and concise. Anything longer than a few paragraphs should be put into
an attachment file instead. Pay attention to spelling and grammar as you are constructing the email. Finally,
end with a closing and your signature. The closing may be a sentence such as “Thank you for your time” or “I
look forward to hearing your thoughts.” Some email programs have a built-in feature that allows you to
include a preformatted signature on all emails, perhaps including your name, company, position, and contact
information.

Common Email Applications
There are many email applications on the market. Your company will have chosen one, but that doesn’t mean
you can’t have your own email addresses to use at home. Just be sure to keep those email accounts separate.
It is not a good idea to use company email for personal matters because you have no privacy and it is the
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company’s property first and foremost. Because this text covers Microsoft and Google products, you will learn
these email applications, Outlook and Gmail, respectively.

MAC TIP

Visit this Apple mail support page (https://openstax.org/r/78AppleMail) for information about Apple Mail.

Microsoft Outlook

Outlook is part of the Microsoft suite of applications. It contains many of the same features that you might find
in Word or Excel. You can format the email text as you are composing the email. Figure 2.13 shows you the
email composition screen in the application. You will notice there are common features in Outlook that you will
find in most email applications. You have options to reply to the message, include attachments, and add
signatures to your emails. Another handy feature in Outlook is setting a priority for your email. This allows you
to give an email that needs immediate attention a high priority label. It can alert the recipient that the email is
a “High Priority” email and needs to be addressed quickly.

Other features that you will see in Outlook and many other email applications are identifying emails as spam
or junk. You can mark an email as junk and emails from that sender will no longer appear in your inbox. They
will instead be immediately sent to the spam or junk folders. When you no longer need an email, you can
choose to delete it. When you delete an email, it goes to the Trash folder. You can still access it in the Trash
folder for some time based on the settings of Outlook to delete the content of the Trash folder. Finally, you
have the ability to add folders to help keep your emails organized. Just as you would for folders on your
computer, you can use an organization system that works for your needs. For example, a sales agent at
WorldCorp might set up an email folder for each of its customers.

Figure 2.13 If you set the priority to High, recipients can quickly see emails that need immediate attention. (Used with permission
from Microsoft)

Gmail

Gmail (see Figure 2.14) is part of the Google suite of applications. You may have experience already using
Gmail as many schools will assign Gmail email addresses to their students for use while they are enrolled. In
Gmail, you have some ability to format text, but not to the extent that you have with Outlook. The basic setup
of the email composition is similar. The functionality of Gmail is similar to that of most email programs. You
can add attachments, organize emails into folders, and identify emails as junk or spam.
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Figure 2.14 Gmail places the Send button at the bottom of the email composition screen. (Gmail is a trademark of Google LLC.)

LINK TO LEARNING

Email was invented in 1971 by Ray Tomlinson, a computer engineer who worked for Bolt Beranek and
Newman in Massachusetts. Tomlinson developed a system that could send messages between computers
using the @ symbol. The first organization to use email was the Department of Defense. Read this article on
the history of email (https://openstax.org/r/78HistoryEmail) to learn more about how email has evolved
since 1971.

• How has email changed the way organizations function?
• How has email changed the way individuals stay connected?

Instant Chat/Messaging (IM) Applications
Instant chat/messaging applications offer users a quick way to send messages in real time, meaning the back
and forth is directly on the screen rather than in an email you have to open first to read. Often, these
applications are more text based and do not offer some of the same formatting features that you might find in
email programs. Many do offer the ability to send files through the instant messaging application. However,
the size of the file may be limited. Usually, communicating through instant messaging is less formal than
communication in email. Also, you would not expect to format a message in instant messaging applications
like a business email. You might also find that users will abbreviate words more when using instant messaging
applications. This is like texting via your cell phone.

Some companies offer internal programs for instant messaging. Others use commercially available tools to
facilitate communication in the workplace. For example, if you had a quick question to your manager about
the format needed for a presentation you are preparing, using an instant messaging application might be a
good tool. You could send the message to your manager in a short, concise question and the manager would
receive the message directly. Think about instant messaging like having a face-to-face conversation with your
manager, but just electronically—an online chat. Instant chat/messaging applications give users the ability to
send to multiple people or to create a “chat room.” Most programs also have an indication if a user is online.
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This will allow you to know whether your message will be viewed when you send it.

Using instant chat/messaging in the workplace can facilitate real-time communication between employees
who are not in the same physical location. This can foster team building and foster trust among the
employees. It can also reduce the number of emails an employee receives on a daily basis. Instant messaging
can be a secure form of communication that can be archived by the information technology department.
However, overuse of instant messaging can provide a distraction in the workplace. With instant messaging, we
often do not place the same attention to proofreading and making sure we are conveying the message we
intend. You might inadvertently send a message in error or with incorrect information. Because of the
immediate nature of instant messages, take care to make sure the message is correct before sending.

Also, instant chat/messaging is not appropriate for critical discussions such as hiring decisions, strategic
company decisions, or contract discussions. Instant messaging should be viewed as a means to facilitate quick
conversations, not as a replacement for company meetings and other such discussions. Instant messaging,
although similar in ways to a face-to-face conversation, cannot take the place of those human interactions.
Emotions and body language are not conveyed through messages. Here are the major instant message
programs.

Microsoft Teams

Microsoft Teams is a useful tool in business for instant messaging. It is included in the Microsoft suite of
programs. Teams also offers video chat capability as well as file sharing. Many organizations today use Teams
to conduct team meetings. Teams provides much more than just a chat function. You can take calls, schedule
meetings through the calendar function, and much more in the Teams environment. Figure 2.15 shows what
the Teams interface looks like with the chat function selected.
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Figure 2.15 The Teams window will display your picture in the upper-right corner with a green check mark to show you are available.
(Used with permission from Microsoft)

Slack

Another instant messaging platform, Slack, is a free program with some extra features available for a fee. For
example, with the free version, users are limited to view and access only the most recent 10,000 instant
messages. This will work for many uses but may be limiting if you try to use the free version for workplace
communications, where you may need to recall a conversation that goes back further. Slack is similar in many
ways to Teams (see Figure 2.16). It was designed specifically for use in the workplace. Slack allows users to add
emojis to messages and to create workspaces for team collaboration. Files can be shared via Slack as they are
in Teams. Private and public messages can be exchanged through Slack. Slack integrates well with other
programs such as the Google suite of products, including Google Calendar.
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Figure 2.16 Notice that Slack uses the term “channels” to refer to different chats. (Copyright 2023 Slack Technologies, LLC.)

Calendar Applications
There are several applications that can help you keep organized. One such category of applications is
calendars. Suites such as Microsoft and Google include calendar applications. One key feature of calendar
applications is the ability to have both your personal and business schedules in one place that can be accessed
from virtually anywhere. You can integrate the apps with your phone so that you no longer have to carry a
separate day planner or schedule book with you. With the sophistication of the calendar apps today, you can
enter appointment information into one place and it can be updated across many different programs and even
shared to other people.

Calendar Features and Functions
With the availability of various technologies today, many people have moved their calendar to an online
format, rather than a more traditional paper planner. Many prefer the convenience of storing their work and
personal appointments in a single place. These calendar apps allow users to bring together multiple calendars
as well as scheduling meetings and blocking out time when you might be unavailable. Many calendar
applications will permit users to determine which items are visible to others or to share your calendar with
coworkers and family. You can also use calendar software to allow your customers to set up meetings with you
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during your available time. If you want to keep your personal appointments hidden from your coworkers, you
can easily set this up in the program. The settings in the application also allow users to permit others to add
appointments to their calendars.

Calendar applications can also be useful for managing work tasks for project management and setting
reminders for key activities. Calendar items can be color coded and/or flagged based on their importance of
due date. Calendars are used frequently in organizations to make scheduling easier when including multiple
people for a meeting. Using a calendar application can also increase productivity because you can manage
your time more efficiently. Many of the calendar apps also integrate well with cell phones so that you can
receive notifications of upcoming appointments if you are not at your computer. You may also find when
scheduling family or personal appointments such as dentist appointments, those appointments can be directly
added to your calendar by the doctor’s office. While some may still prefer the traditional paper planner for
keeping their schedule, the convenience of calendar applications has prompted many businesses to adopt
them for use in their organization.

SPOTLIGHT ON ETHICS

Adjusting Privacy Settings in Your Electronic Calendar

While electronic calendars are incredibly useful and convenient, we must also recognize that these
calendars may be viewed by others, especially if we are using our employer’s software. Google Calendar
and Outlook/Calendar can be viewed by others easily, requiring us to use privacy options such as adjusting
viewing permissions for different individuals. You may want to prevent some people from viewing your
calendar entirely, provide only limited information (such as availability) to others, and allow full access to
your calendar to some. You can also control what information you can make available on a calendar
appointment. For instance, you can make an appointment private and not viewable by anyone; this slot will
show up as private with no further details. This is helpful for keeping private appointments or sensitive
appointments.

Calendar Integration and Syncing
Syncing calendars stored in other applications is an essential component of getting the best use of a calendar
application. You could have a calendar on your phone for personal appointments and reminders, a calendar
for your work tasks on your work computer, and then perhaps another calendar to keep track of your
extended family birthdays. Through calendar integration, these calendars can be synced into one place. This
often involves simple changes to the settings in the software to link all the calendars together. In fact, when
you first install a calendar application on your device, you might be prompted to integrate existing calendars
during the setup process.

Common Calendar Applications
Figure 2.17 shows the calendar feature in Microsoft Outlook. The calendar function and email are integrated in
the program. You cannot delete the calendar application, but you can choose not to use it. There are no preset
events in the calendar application. You can set the program to give you notifications of meetings and tasks
when you are in the email program. The Outlook Calendar also has a meeting scheduler to assist with
scheduling meetings and can even be used to determine if specific meeting spaces are available in the
organization. Outlook Calendar has a useful feature to set up recurring meetings that happen at some
frequency. For example, if your company has a set meeting each week for sales force updates, you can set this
up in Outlook once and it will be added to all attendees’ calendars for the time frame you desire.
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Figure 2.17 To switch back to Outlook Mail, just choose the envelope in the lower-left corner of the screen. (Used with permission
from Microsoft)

If you already have a Google account, you have access to Google Calendar. Google Calendar is easy to use and
integrates well with a wide variety of platforms. With Google Calendar, you create multiple calendars to
manage different events. You can then manage the settings for each of the calendars independently. All the
created calendars are integrated into an overall calendar interface. You can use color coding to differentiate
the different calendars when viewing in the main calendar view, as Figure 2.18 shows. You access Google
Calendar by logging in to your Google account.

Figure 2.18 To create a new calendar appointment, choose Create. All calendars displayed in the main calendar view are listed in the
lower left of the screen. (Google Calendar is a trademark of Google LLC.)
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2.4 Essentials of Microsoft 365

Learning Objectives
By the end of this section, you will be able to:

• Know how to access Microsoft applications
• Describe the key functions within Microsoft’s standard menus
• Create, save, and open a document

Both personal and business productivity have increased as the result of technological advances. Computer
technology has facilitated communication, information sharing, and data analytics. Although there have been
several software programs developed over the years in these areas, two main leaders have emerged:
Microsoft and Google are most common in organizations today and are suitable for a variety of purposes.
Google and Microsoft have dominated the market for productivity software programs because they have
adapted to the changing needs of businesses. Their success continues because of their forward-thinking and
response to market needs.

Overview of Microsoft 365
Microsoft launched Microsoft Office in 1990. This suite of applications included three main programs: Word,
Excel, and PowerPoint. These programs are bundled as a package to give the user the full range of productivity
tools to meet a wide variety of needs. Office applications offer the flexibility to appeal to various preferences
with the many ways to perform tasks within the software.

Office applications are compatible across a wide variety of platforms, including mobile devices and Apple/Mac
operating systems. The applications also integrate well with other software. You may be aware of older
versions of Office, such as Office 2016 or 2019, but the latest product, Microsoft 365, moves beyond these
static versions, instead offering a subscription that updates automatically. With the introduction of Microsoft
365, the programs use a cloud-based technology that can be accessed anywhere. Microsoft 365 also enhanced
the collaborative features of the programs.

Accessing and Maintaining Microsoft Products
When you register for a Microsoft 365 account, you are given access to OneDrive, which is its product that
provides online storage in the cloud. This offers many advantages. When you save a file to your OneDrive, you
will be able to access it from any computer as long as you have an internet connection. There are different
versions of Microsoft 365 available for purchase, but most software today uses this subscription-based model
for a fee. The software programs are installed on your devices as “apps,” but can also be accessed through the
web-based versions with some limitations to functionality. Updates to the programs are provided regularly by
Microsoft and should be performed when prompted. Sometimes the information technology department (IT)
will take care of these software maintenance issues with your company or school equipment. There are
student editions of most versions of Microsoft 365 that can be purchased at a reduced cost or even for free.
The student editions might also have some limitations to the functionality of the programs.

Applications
The Microsoft 365 suite includes software for many of the most common computer needs in today’s
workplace, as well as for personal use, including word processing, spreadsheets, presentations, database
management, an email and calendar interface, and a collaboration tool. Table 2.2 provides an overview of the
applications within the suite. Other chapters in this text will cover these programs in detail. What comes next
in this chapter is a breakdown of commands that are common to all the Microsoft 365 applications, so you can
get a basic understanding of how to navigate.
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Application Type Description

Word
Word
processing

Create documents such as reports, memos, agendas, résumés, flyers, and
mailings.

Excel Spreadsheet
Create data-based sheets and workbooks for gathering data, performing
functions, and analysis.

PowerPoint Presentations
Create slide presentations for use in workplace meetings or client
showcases.

Access Database Create and maintain databases of information.

Outlook Email Manage email communications and calendars.

Teams
Collaboration
tool

Set up workspaces for collaboration, such as a team might use on a specific
project.

Table 2.2 Microsoft 365 Applications

Overview: Ribbons, Tabs, and Commands Menu
Since its initial release, Microsoft’s suite of office products has been a driver of change, introducing new
features in each subsequent version. Since the 2007 version, the apps have used the ribbon—an interactive
bar of commands at the top of the application—as their user interface. With the ribbon, all the functions are
clearly organized and user-friendly.

The ribbon is organized into tabs, each of which houses a collection of thematically grouped commands. The
default tabs are File, Home, Insert, Design, Layout, References, Mailings, Review, View, and Help. As you hover
your mouse over the ribbon, you will notice many small icons (pictures) that have a command over them. A
command directs the program to complete a process, such as Save. When you select the Save icon, the
command will start.

As you can see in Figure 2.19, the commands in the ribbon are organized into a command group of similar or
related buttons, which appear together on the ribbon tabs.
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Figure 2.19 The Home tab contains the command groups Font, Paragraph, and Styles, which are used for formatting text. (Used with
permission from Microsoft)

Each tab generates a different ribbon with the appropriate commands and command groups. This section
introduces the most used tabs. You will learn more details about them and practice using them in each specific
application as the book goes on. Figure 2.20 shows the tabs available in Word and Excel, and Figure 2.21 shows
the tabs available in PowerPoint and Access.

Figure 2.20 The main menu bars for (a) Word and (b) Excel share common tabs (File, Home, Insert, Help, for instance), but also
contain tabs that are in character with their main functions (such as References in Word and Formulas in Excel). (Used with
permission from Microsoft)
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Figure 2.21 The main menu bars for (a) PowerPoint and (b) Access also share common tabs with one another and with Word and
Excel (File, Home, Insert, Help, for instance). They also contain tabs that are in character with their main functions (such as
Animations in PowerPoint and Database Tools in Access). (Used with permission from Microsoft)

File Tab
If you open a Microsoft product without opening any specific file, you will see the welcome screen, which
provides a Backstage view. The Backstage view is located in an application for managing most tasks related
to the documents. In Backstage view, you can open, close, rename, print, and control the settings for the
application. There will be many commonalities within the Office programs for the tabs. When you have opened
a file in an application such as Word or Excel, the Backstage view gives you information about that file you are
working with. As you can see in Figure 2.22, the file properties are shown on the right pane of the Backstage
view, which displays critical metrics about your document, such as its size, number of pages, number of words,
file name, last saved time, and when it was printed. Backstage view also includes important commands such as
file protection, inspecting the document, and managing the document, which will be discussed later in this
chapter.
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Figure 2.22 Backstage view shows file properties, which are the statistics and technical details of your file. (Used with permission
from Microsoft)

MAC TIP

The Backstage view is not included in the Mac Version of Office, but you can get the properties of a file by
going to the File tab and choosing Properties.

Creating a New File
As you open an Office application, you will be introduced to the welcome screen, which shows your recent files
on the left and your options on the right. See Figure 2.23. Because you are in Word, you can choose Blank
document to start a new document, or you can select a template from the default template list. A template is
a document with many fields already filled and formatted, ready for the user to work on.
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Figure 2.23 The welcome screen gives you three choices: start from scratch with a new file, create a file from a template, or open a
recent file you have already saved. (Used with permission from Microsoft)

MAC TIP

The Mac version does not have the same welcome screen. To create a new file, go to the File tab and choose
New Document or New Document from Template.

To create a new document without using a template, simply select Blank document. A new document will be
opened with a blank screen for you to create your file. This new document will be opened in a new window.
You can then add the content to the document and save the document if desired. More about document
creation will be covered in later chapters in the book.

Saving a File
The Save command is located at the upper-left corner of the window. Using the Save command saves your
document in its same location, with its same file name. It is a way of making sure your work does not get lost
in case your computer crashes or the application closes suddenly. A good best practice is to save your
document occasionally, by either pressing on the Save icon or using Ctrl+S. You can also set up automatic
saving at specified time intervals.

The Save As command, located on the File tab, allows you to not only save the file with a different name but
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also to change its location and its type. When you save the file to a new type (for instance, Save As PDF), the
file opens in the new file format. The previous file type remains open. When you click on the Save As
command, a dialog box will appear, asking you to select the location where you want to save the new version
and what you want to name it.

Large companies like WorldCorp will typically give their employees a schema or convention to follow when
naming files so that the company will have a unified system that all employees can easily identify and
understand. This also allows people within the organization to be able to keep track of different information
about the file, such as its version and the project or department it is associated with. For example, if the name
of your market trends report is “market_report_v1.docx,” the next version could be “market_report_v2.docx.”
This gives you a version history of the file, which enables you to keep track of older and newer versions. Figure
2.24 shows the current folder and the name of the file you want to change.

Figure 2.24 When you Save As, you can change the file name, the file format, or both. (Used with permission from Microsoft)

Save As can also be helpful in other situations. For example, you may want to save your file in a different
format so that it can be opened by a different application. You would also use the Save As command to save
the file in a different folder, with a different name for categorization purposes. The default Word file format is
.docx, but you could also save it as a .pdf or .rtf.

Microsoft also offers the option to save to a different location—for example, your local computer, a shared
private location (such as a company drive), or the cloud OneDrive. This allows you to save your work easily
even if the device you are working on does not have saving capacity, and also gives you the ability to share
your work with others. (You will learn more about collaboration later.) To share a file with others, first save your
presentation to OneDrive. Choose File, then Share, and then Share with People.

Opening an Existing File
With the desktop version of Microsoft 365, your recent file list will be readily available in Backstage view. If the
file you want does not appear in your recent file list, click on File and then Open. Locate the file, select it, and
click Open. If you want a file to always appear in your recent file list, you can “pin” it: Go back to File, and the
file that is now open will have a pushpin icon next to its name. Click on the pushpin, and the file will be pinned.

To access a file in Microsoft 365 online, you must set up an account with Microsoft if you do not already have
one. Then, you can go to the program you are working in and you will find your recent file list. OneDrive also
gives you access to files not listed in your recent file list. Locate the file you want and click Open. Your
document should appear.
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Printing a File
To print a file, choose the File tab. In the list of options on the left, you will see Print. When you click on Print,
you will be shown a preview of your document along with print options. See Figure 2.25. The print options
include a variety of settings, such as number of copies, printer selection, and paper size. You can also print on
both sides of the paper or select only certain sheets to print. When you have chosen the desired settings,
choose Print on the upper-left side of the screen.

Figure 2.25 You can also choose to have your document stapled if that option is available on your printer. (Used with permission
from Microsoft)

MAC TIP

Print screen on a Mac displays the options that are included with the user’s installed printer.

Options
The Options command at the bottom of the File tab contains a multitude of choices that control the way your
workspace appears, determine the way the text is corrected, and allow changes to many aspects of the
program. A summary of the options available is shown in Table 2.3.
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General Provides options that affect the user interface

Display Changes how the content is shown on the screen and when it is printed

Proofing Sets the way spelling and grammar are checked

Save Sets up AutoSave to save a copy of your work at scheduled intervals

Language Chooses the language in which menus and controls appear

Accessibility Checks your documents for accessibility to people with visual or other challenges

Advanced Sets how words are edited, replaced, or cut and pasted

Customize Ribbon Allows users to choose which commands are shown on the ribbon

Quick Access
Toolbar

Allows users to choose what is displayed on the Quick Access Toolbar above the
ribbon

Add-ins Manages the available Office add-ins

Trust Center Sets security settings, most of which should remain as set

Table 2.3 Summary of the Options Dialog Box The Options command appears in all Office applications and provides helpful
settings.

The Options command, present in all Office applications, opens an Options dialog box, as shown in Figure
2.26. Before you start working, it’s advisable to click on each of the Options items to see what each covers.

An Options item that is critical to your work is a Save option called AutoRecover. Just ask yourself, “Has my
computer ever frozen in the middle of a sentence?” This happens to everyone, but AutoRecover can prevent a
catastrophe by allowing you to set the program to automatically save your work every two minutes, five
minutes, or whatever interval you choose.

Another helpful option is proofing, which allows Microsoft to check your spelling as you type.

You will find some options that you may never need to change. In the future, however, you will be glad to know
where to locate these hidden settings.
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Figure 2.26 The Options command, present in all Office applications, opens an Options dialog box with many available options or
settings that can be changed. (Used with permission from Microsoft)

Customize Ribbon and the Quick Access Toolbar are useful features. Because you are likely to use both
functions on a regular basis, you want their commands to always be visible. This is most easily done by
customizing the ribbon or the Quick Access Toolbar.

There are probably some other commands that you wish you had immediate access to but did not know this
was possible. For example, did you know that you can add an email command to either the ribbon or the Quick
Access Toolbar? Suppose you want to email someone and add a presentation to your email as an attachment.
If you add Email to your ribbon or Quick Access Toolbar, you can just click on the Email command, which will
open your regular email program with access to your address book and add an attachment of the presentation
to the email. No more need to open the email program independently, then search for the file on your
computer, and finally attach it.
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As another example, suppose you work with a lot of graphics. There are numerous commands associated with
drawing and inserting graphics that are generally hidden. You may not even be aware that these functions
exist, but when you change the scope to All Commands and look through the choices, you will find many
commands that can save you a lot of time if you set them up for immediate access.

There are two ways to customize the Quick Access Toolbar. First, from the Options dialog box, select the Quick
Access Toolbar, shown in Figure 2.27.

Figure 2.27 To customize the Quick Access Toolbar, add commands from the selections on the left to the list on the right. (Used with
permission from Microsoft)

For example, to add a Quick Print option, scroll down to Quick Print in the list of commands on the left.
Highlight Quick Print, click the Add button, and Quick Print will appear on the Quick Access Toolbar, as seen in
Figure 2.28, which shows the result of customizing the Quick Access Toolbar.
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Figure 2.28 Items added to the Quick Access Toolbar will appear at the top of the screen when you open the program. (Used with
permission from Microsoft)

The second way to customize is to right-click on the Quick Access Toolbar, which opens a context menu.
Choose Quick Print from the menu items, as shown in Figure 2.29. The Quick Print option should appear on
the Quick Access Toolbar.
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Figure 2.29 Using the context menu, you can easily add the Quick Print option to the Quick Access Toolbar. (Used with permission
from Microsoft)

MAC TIP

The Quick Access Toolbar is found on the Preferences tab on the app main page.

Customizing the ribbon is a similar process. Start at the Customize the ribbon command from Options in
Backstage view. To add a command to the ribbon, you first have to create a new group, as follows:

1. Choose the tab on the right where you want to add the new command. (For the purposes of this
demonstration, choose the Draw group, making sure there is a check mark next to the Draw box.)

2. Click on New Group, which will be listed when you click on the plus sign next to Draw.
3. In the box at the top left, select Commands Not in the ribbon (see Figure 2.30).
4. Scroll down to Borders and Shading and click Add.
5. Then, select another command, Brightness, and click Add.

When you return to the application, you will see your New Group with the options selected. Using this method,
you can select any command from the left and add it to the ribbon commands on the right. This works for all
the Office programs.
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Figure 2.30 Customizing the ribbon can facilitate your productivity by including items you use frequently for quicker access. (Used
with permission from Microsoft)

LINK TO LEARNING

Microsoft products offer hundreds of keyboard shortcuts (such as holding down the Ctrl button and S at the
same time saves a document) that can help you work more quickly and efficiently. The Microsoft support
page on keyboard shortcuts in Word (https://openstax.org/r/78KeyShortWord) provides a long list of these
shortcuts, categorized by activity type.

Home Tab
The Home tab is where you begin to create your document, spreadsheet, or presentation. The ribbon for the
Home tab in Word is shown in Figure 2.31. You can view the ribbon as command central for the application: It
is a collection of commands and command groups that govern the basics of the program you are working
with. Each group of commands is separated by a thin vertical line (see arrow in Figure 2.31).
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Figure 2.31 The Home tab contains items such as formatting the font size and determining the line spacing. (Used with permission
from Microsoft)

First is the Clipboard group, which contains the commands for all the cut-and-paste functions. As in all the
Office applications, an arrow next to or below a label means that there are other possible choices for that
function. Notice that the Paste command has an arrow below it. Clicking on the arrow gives you several Paste
options; if you hover over them, you will see helpful descriptions and previews.

The Font command group is similar across applications. You can choose Bold, Italic, Underline, Strikethrough,
and Highlight. You can also regulate character spacing and add a superscript or subscript. Primarily, however,
you will change the font face, color, and size.

Sticking with Word to get an idea of how the Home tab operates, the Paragraph command group contains the
commands for indentation and for aligning text to the right or to the left, centered, or justified. You can create
columns, change the direction of the text by rotating 90, 180, or 270 degrees, or stack the letters on top of one
another. The Paragraph command group also contains the commands for creating bulleted and numbered
lists and for adding SmartArt graphics to text. Notice that there is an arrow associated with most of these
commands, indicating that each one offers still more choices for formatting a paragraph.

Table 2.4 lists common keyboard shortcuts. To use each action, press the Ctrl button, and while holding it
down, press the next key. You may find these shortcuts useful so that you do not have to take your hands from
the keyboard to use the mouse. It might be helpful to bookmark this table for future reference as you work
through the rest of the book.

Action Keyboard
Shortcut

Action Keyboard
Shortcut

Action Keyboard
Shortcut

Copy Ctrl+C Italic Ctrl+I Help F1

Cut Ctrl+X Center Ctrl+E Open a file Ctrl+O

Paste Ctrl+V Justify Ctrl+J
Create a new
file

Ctrl+N

Undo Ctrl+Z Underline Ctrl+U Save a file Ctrl+S

Redo Ctrl+Y Align left Ctrl+L Print a file Ctrl+P

Bold Ctrl+B Find Ctrl+F Close a file Ctrl+W

Table 2.4 Common Keyboard Shortcuts in Office
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MAC TIP

On a Mac, Control is replaced with Command.

Format Painter
Format Painter, represented with a paintbrush icon, is a shortcut tool that is available in Word, Excel, and
PowerPoint. This tool lets you copy the formatting of a section of text, a cell, or whatever you choose to
another place on a document, spreadsheet, or slide, respectively. It is especially useful when you need to
reformat large amounts of text.

First, select the text that has been formatted in the way you want. Then, click on Format Painter, and the cursor
will turn into a little paintbrush, as Figure 2.32 shows. Brush over the text you want to change, let go of the
mouse, and the text will now be formatted in the desired style.

Note that if you want to use Format Painter again, you will have to repeat the steps outlined above. To format
a lot of text, double-click on the Format Painter icon, and it will last until you click on it one more time.

Figure 2.32 Format Painter is a handy tool to brush, so to speak, over text and format it as you like. (Used with permission from
Microsoft)

Insert Tab
The Insert tab allows you to insert a variety of items into your file, including visual images such as pictures or
diagrams, tables, links, and equations or special symbols. The Insert tab will differ a bit by program. Figure
2.33 shows what the Insert tab looks like for Word, Excel, and PowerPoint. For example, in Word and
PowerPoint, you have options to insert SmartArt. Excel has many options to insert charts and graphs. More
details about the specific insert options will appear in the chapters to follow on each of the programs.
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Figure 2.33 (a) Insert tab for Word, (b) Excel, and (c) PowerPoint. Different tabs appear for each program depending on the
program’s purpose. (Used with permission from Microsoft)

Design Tab
The Design tab is found on the ribbon in Word and in PowerPoint. See Figure 2.34. The tab includes options to
customize the look of the document or presentation. There are preset themes that you can use to enhance the
document or slide, or you can create your own theme. The options on the Design tab are covered in more
depth in Creating and Working in Documents and Preparing Presentations.

Figure 2.34 (a) The Design tab in Word allows you to choose preset themes for formatting text or you can create your own design
choices. (b) PowerPoint’s Design tab functions similarly. (Used with permission from Microsoft)

Layout and Page Layout Tabs
The Layout tab (Word) and Page Layout (Excel) tabs control items such as spacing and margins in your file. You
can use the options on the tabs to insert page breaks, change the orientation, and define the print area. In
Page Layout in Excel, you can also apply a theme to your spreadsheet to enhance the visual appeal. This is
similar to what you would find on the Design tab for Word and PowerPoint. Figure 2.35 shows the tabs for
Word and Excel. The chapters on Word and Excel will cover these tabs in depth.
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Figure 2.35 (a) The Layout tab in Word and (b) Page Layout tab in Excel allow you to set up your document or spreadsheet for easier
reading and visual appeal. (Used with permission from Microsoft)

Review Tab
The Review tab is found in three Office programs (Access does not have a Review tab). In Word, the Review tab
is useful to check spelling, track changes within a document, and compare previous versions of documents to
each other. The Review tab in Excel also contains a spell-check feature, but also allows you to add comments
and to protect the worksheet from editing by others. Finally, the Review tab options in PowerPoint are very
similar to those in Excel. The Review tab is a great place to reference to make sure your file is ready to share
with others and to collaborate by adding comments. Figure 2.36 shows the Review tabs for Excel, Word, and
PowerPoint.

Figure 2.36 The Review tab in (a) Word, (b) Excel, and (c) PowerPoint all share common functions, such as creating and managing
comments from multiple users. (Used with permission from Microsoft)

View Tab
The View tab is also seen in Office applications, except Access. It can customize what you see on the screen.
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You can change the options to show you what the file will look like when printed by choosing the Print Layout
view. You can use the options to zoom in to make the screen larger. Finally, there are options to view files open
in the same program side by side or to switch between the open windows when working with multiple files at
a time. Notice the slight differences in options between the three applications in Figure 2.37.

Figure 2.37 The (a) View tab in Word, (b) Excel, and (c) PowerPoint sets how your document, spreadsheet, or presentation will appear
on-screen. (Used with permission from Microsoft)

Help Tab
The Help tab looks the same in all the Office applications. The Help tab gives you options to seek help on an
issue with the application you are working with. Through the tab, you can use the Help search by clicking on
the question mark or you can contact support directly. The Show Training is a good place to start if you have
not used the program at all before. It gives you a collection of help tutorials to walk you through many of the
more common features used in the program. When you select any of the options on the Help tab, a window
will open at the right to assist you further (see Figure 2.38).
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Figure 2.38 When you select the general help search with the question mark, you can type the topic or question you need help with
into the search bar. (Used with permission from Microsoft)

Other Tabs
Based on the application you are using, there are different tabs that are included in the ribbon specific to that
program. These tabs offer options that relate to the functionality of the program. For example, in Word, you
have a Mailings tab that can send a document to a large database of individuals. In PowerPoint, you have the
Slide Show tab that contains options for developing your presentation. Table 2.5 gives you the default tabs for
each program. Remember, using the Customized Ribbon option, you can change which tabs you have
displayed in the programs.

Word Home, Insert, Layout, References, Mailings, Review, View, and Help

Excel Home, Insert, Page Layout, Formulas, Data, Review, View, and Help

PowerPoint Home, Insert, Design, Transitions, Animations, Slide Show, Review, View, and Help

Access Home, Create, External Data, Database Tools, Help, Table Fields, and Table

Table 2.5 Default Tabs by Office Program Each program has a ribbon of default tabs.
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2.5 Essentials of Google Workspace

Learning Objectives
By the end of this section, you will be able to:

• Access Google Workspace’s applications
• Describe the key functions within Google’s standard menus
• Create, open, and save a document

The Google group of programs, called Google Workspace, includes applications similar to those of Microsoft
Office. But a key difference between Google and Microsoft programs is that Google is a cloud-based platform
only. That means the programs are accessed through the cloud and not installed on your computer or device.
Google first launched its platform in 2006 as Google Apps for your Domain. The collection of applications has
been rebranded by Google, first as Google Suite and then as Google Workspace, as it is called today. Many of
the programs in Google Workspace are free, but there are some additional programs and features that are
available to businesses for a fee. You can also pay to have additional cloud storage through Google. Many
schools and colleges use an educational version of Google called Google Classroom.

In your role at WorldCorp, you work closely with a team of six colleagues in the marketing department. The
team leader has decided that for internal teamwork, you will use the Google suite of products because of their
advanced capabilities for collaborating with others. Also, the user-friendly nature of Google products makes
them appropriate for working with others in your small marketing team.

Overview of Google Workspace
Google Workspace consists of several applications that are useful in the workplace. You may be most familiar
with its communication and scheduling tools (Gmail and Google Calendar, discussed in Communication and
Calendar Applications). Google also offers a suite of applications similar to those in Office, including software
for word processing (Google Docs), spreadsheets (Google Sheets), and presentations (Google Slides).

One distinctive feature of Google’s Docs, Sheets, and Slides applications is that your work is automatically
saved to the cloud. This automatic save function helps prevent accidental file loss. Google also maintains a
history of all versions of the file, so if you need to restore to an earlier version or check on the history of an edit
formatting change, you can view that information in the Version history, which will be covered later in this
section.

Although each application has specific purposes and performs different tasks, some features are shared
across the entire Google suite of products. These include essential functions like opening and saving a file,
formatting fonts and spacing, inserting objects like a visual image, and accessing help to learn new skills
within the software.

Accessing and Maintaining Google Products
To access Google’s products, you must first create an account with Google and acquire the free email program
Gmail. You get to that through google.com. Once you have set up a Gmail account, you will have access to all
the Google apps.

Since the software resides online rather than downloaded onto your device, maintenance is automated:
Google regularly provides updates as new features and improvements are introduced. Whenever updates are
rolled out, you will typically receive a notice along with a summary and walk-through of changes. It is a best
practice to take the time to view these explanations, as they will allow you to take advantage of new features
as they are released.
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Applications
Once you have a Gmail account set up, you can access Google’s applications by opening the Google Chrome
browser or any other browser by going to google.com and signing into your account. In the upper-right
corner, you will see nine dots arranged in a 3 × 3 array, as shown in Figure 2.39. Clicking on the dots opens a
menu of all the Google apps.

Figure 2.39 Click on the dots in the upper-right corner to open the menu of apps. (Gmail is a trademark of Google LLC.)

You will see two sections of offerings. In the first, shown in Figure 2.40a, you can access your Google account
settings and can use common tools such as the Google search engine for internet searches, Maps for locating
places and navigating trips, Play for accessing apps for your mobile device, Meet for online meetings, Drive for
storing your files, Gmail for email, and Calendar for scheduling.

The second section includes the offerings that are the focus of this course. You will see various applications,
including Docs and Sheets. If you wanted to work on a presentation, you would select the Google Slides
option, as shown in Figure 2.40b.
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Figure 2.40 (a) Gmail includes many apps. (b) Slides, which is similar to PowerPoint, is one of them. (Gmail is a trademark of Google
LLC.)

Like most application suites, Google continually expands and changes its offerings. Older applications may be
phased out over time, while the most popular applications undergo regular updates. Table 2.6 provides a
summary of Google offerings. In this course, we will focus mostly on Google Docs, Sheets, and Slides.

Application Type Description

Docs
Word
processing

Create documents such as reports, memos, and agendas

Sheets Spreadsheet Create data-based spreadsheets for storing and analyzing data

Slides Presentations
Create slide presentations such as for a workplace meeting or client
showcase

Gmail Email Send and receive emails

Calendar Calendar Schedule individual events and collaborative meetings

Search
Internet
search

Search the internet based on search terms

Table 2.6 Common Google Applications The Google Workspace includes applications for all the tools you need in the workplace
from communicating with colleagues to creating documents and presentations.
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Application Type Description

Maps
Maps and
navigation

Provide navigation directions based on location or address

Play
Application
store

List apps on android devices that are available for download

Meet
Online
meetings

Video Conference with others

Drive File storage Store files; similar to OneDrive; the cloud-based storage for files in Google

Contacts
Contact
information

Organize and store contact information such as email addresses and
phone numbers for people

Classroom
Educational
interface

Create a classroom interface to share files, turn in assignments, and have
class discussions virtually

Table 2.6 Common Google Applications The Google Workspace includes applications for all the tools you need in the workplace
from communicating with colleagues to creating documents and presentations.

Menu Overview
As you’ve learned, all the applications in the Google Workspace share some general features and functions,
which are found in the menus. Although there are slight differences between the apps, they all contain these
essential menus: File, Edit, View, Insert, Format, Tools, Add-ons or Extensions, and Help, as Figure 2.41 shows.
These menus are similar to the tabs in Office, but in Google they are called menus.

Figure 2.41 The main menu bars for (a) Docs, (b) Sheets, and (c) Slides are similar—from File to Help. (Google Workspace is a
trademark of Google LLC.)

Not only are there similarities between the various Google applications, but many of the menu options are
also similar to those you learned about in Essentials of Microsoft Office). As you progress through the course,
you will learn and practice most of the specific features within each menu. Here, our focus is on the essential
shared functions.
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File Menu
The File menu is used to open files in Drive, to create new files, and to print materials. In addition, the Make
Available Offline option lets you work on files when you do not have internet access. (See Figure 2.42.)

Figure 2.42 The File menu is mainly used for opening and saving documents. (Google Docs is a trademark of Google LLC.)

The File menu also has tools for saving and exporting files in different formats. Docs and Sheets are
compatible with their Microsoft counterparts, so users have the option of either working on a Word or Excel
file in Docs or converting the file into a Google file. This appears in the menu as the Save as Google Docs
command. Google files can be opened and edited in only a browser window, from your Drive.

Recall that Google automatically saves your work for you in the cloud. If you want to save files locally or to
other locations, you will need to use the Download command, which enables you to export the current version
of the document onto your own computer as a Word document, Excel spreadsheet, PDF, or some other file
format.

LINK TO LEARNING

If you own a smartphone, you likely already use the cloud to capture your text messages and other
activities performed on your cell phone. The cloud has become increasingly important in the business
world, and it is helpful to understand how it works. To learn more, watch this video on what the cloud is and
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how it pervades our lives (https://openstax.org/r/78WhatIsCloud) from Scientific American.

The Download command brings up the menu shown in Figure 2.43. Using Slides as an example, one of the
download options enables you to download your presentation as a PowerPoint file.

Figure 2.43 Download your presentation to one of seven other formats, including a PowerPoint file. (Google Slides is a trademark of
Google LLC.)

The File menu also allows you to explore your document settings. You can use the Email command to send the
file to one or more collaborators. The Document Details option contains the file’s statistics and technical data.
The Page Setup command can modify paper size or format; as in Word, you can make your document’s
orientation either portrait (vertical) or landscape (horizontal).

The two most critical tools in the File menu are Version history and Share. Version history is a feature unique
to Docs. Every time you make a change in a file, Google autosaves your document, keeping many versions of
the file. Version history allows you to revert to a previous version of a file or simply to look back at previous
versions for reference.

The Share command enables a document’s owner to invite others to work on it. It is used to tag or add
collaborators who can read, comment, develop, or edit the file.

If you want to create a copy of an existing file, you can use the Save a Copy command. As Figure 2.44 shows,
this command allows you to make a copy of your Doc and save the document under another name. You can
save it to the Drive, which uses the cloud, as discussed. Or you can save the file to your hard drive, but your
files are safer in the cloud, and using cloud storage allows you to free up storage on your local device.
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Figure 2.44 Creating a copy of an existing file by using the Save a Copy command. (Google Docs is a trademark of Google LLC.)

Opening an Existing File
To open an existing presentation in Slides, first, go to Drive (called My Drive on your computer). You will see
your recently saved presentations listed across the top. Even if you are working offline, you will still have
access to your files. If you do not see your presentation file, click on Recent under My Drive in the left pane, or
scroll down.

Figure 2.45 shows a typical Drive page. Your most recent presentations will be shown across the top, and
below you will find all the files you created using one of the Google apps. Click on your presentation to open it.
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Figure 2.45 This is a typical Drive page showing recent presentations and other recent work. (Google Drive is a trademark of Google
LLC.)

Creating a New File
In the File menu, selecting New opens a menu, as shown in Figure 2.46. You can select a new Presentation
From template, new Document, new Spreadsheet, new Form, or new Drawing.

Figure 2.46 Select New Presentation, New Document, New Spreadsheet, New Form, or New Drawing. (Google Drive is a trademark of
Google LLC.)

After you have chosen the file type you want to create, a blank file of that type will appear on the screen. The
document will open with a default name based on the program. For example, a new Doc will have the default
name of “Untitled Document” and this will be listed at the top of the screen (see Figure 2.47). To change this
name to something more meaningful, double-click on the current title at the top of the screen. This will
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highlight the words “Untitled Document” so that you can delete that and rename the file. You can also access
the Rename command in the File menu. The process is the same for Sheets and Slides.

Figure 2.47 You can also rename the file you just created by using the Rename command in the File menu. (Google Docs is a
trademark of Google LLC.)

Google also has a wide variety of templates to choose from. You can create a new file using a template in a
similar manner to how you use templates in Office. Templates can be a great place to start if you are designing
a specialized document or file such as an invoice or a budget worksheet. They can also be useful when doing
more creative work such as designing flyers. The templates can provide a starting point for you and you can
customize to meet your needs. To access the templates in Google for each of the programs, use the expanded
menu to the side of the program name when you choose New (see Figure 2.48).

Figure 2.48 When creating a new file in Google, you can either create a file from scratch or start with a template. (Google Drive is a
trademark of Google LLC.)

Printing a File
The Print command in Google is found in the File menu. There are also two shortcuts to printing a file: Ctrl+P
or the printer icon on the toolbar. When you select print, a window will open with similar settings that you
might see in Office (Figure 2.49). You can manage the various settings related to printing such as the number
of copies, orientation, and paper size. Like with Office, you will also be able to see a preview of the file you are
printing.
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Figure 2.49 When you have changed the appropriate settings, click Next to print the file. (Google Docs is a trademark of Google LLC.)

Edit Menu
The Edit menu contains the expected choices: Undo, Redo, Cut, Copy, Paste, Delete, Duplicate, Select All, and
Find and Replace. Clicking on Find and Replace brings up the window shown in Figure 2.50. You type in a word
from your file. For each occurrence, you confirm whether you want to replace it with another word. Although
most misspelled words will be caught by the spell-check function, if, for example, you have misspelled a title or
name throughout the file, using Find and Replace is an efficient way to make sure you catch all the errors.
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Figure 2.50 You can use Find and Replace to find specific text in a file and replace it with other text. (Google Sheets is a trademark of
Google LLC.)

The Edit menu for each of the apps looks similar. Figure 2.51 shows the Edit menu.

Figure 2.51 The Edit menu will look the same in Docs, Sheets, and Slides. (Google Docs is a trademark of Google LLC.)

View Menu
The View menu controls the way your document or file appears on your screen, allows you to show certain
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components to others, and lets you set three different modes in Docs: Editing, Suggesting, and Viewing. The
default mode is Editing, which allows the user to edit the document directly. The Suggesting mode is similar to
Track Changes in Word, as shown in Figure 2.52. In this mode, the changes you type into the document
become suggestions rather than actual edits. You can then either accept each change by clicking on the check
mark or reject it by choosing the X. You can also add comments to the edits, which is especially useful when
you are collaborating with others on a document.

Figure 2.52 Notice that when you are in Suggesting mode, changes are not saved until you first either accept or reject the edits, as
represented by the check mark or X in the comment box. (Google Docs is a trademark of Google LLC.)

In Sheets, you can use the View menu to display the gridlines or not, or to display a ruler at the top. In Slides,
you use the View menu to view the slideshow, zoom in if needed, or show the speaker notes for the
presentation. Figure 2.53 shows the different View menus for each application.
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Figure 2.53 The View menus for (a) Docs, (b) Sheets, and (c) Slides will become more familiar to you as you navigate the programs.
(Google Docs, Google Sheets, and Google Slides are trademarks of Google LLC.)

Insert Menu
The Insert menu is used to insert a variety of items into a file. The different apps may offer different items that
are best suited to the purposes and uses of that app (see Figure 2.54). In Docs, the Insert menu includes items
such as inserting images, footnotes, headers, and page numbers. Sheets insert options include inserting
columns/rows, charts, and formulas. Finally, Slides includes options for inserting tables, drawings, text boxes,
and WordArt. Other chapters will cover the Insert menu in more detail.
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Figure 2.54 The Insert menu in (a) Docs, (b) Sheets, and (c) Slides differ slightly from one another depending on the function of each
program. (Google Docs, Google Sheets, and Google Slides are trademarks of Google LLC.)

Format Menu
The Format menu enables you to alter the visual appearance of most elements within your document,
spreadsheet, or slide. Most frequently, you will be formatting text, paragraph setting, spacing, and layout in
Docs. In Sheets, you will be formatting the information in the cells and adding conditional formatting based on
specific rules. For Slides, the Format menu is much like that of Docs. To see the differences between the
Format menus, see Figure 2.55.
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Figure 2.55 The Format menu in (a) Docs, (b) Sheets, and (c) Slides. While the options in Docs and Slides focus on formatting text,
Sheets’s options allow you to format numerical information in the cells. (Google Docs, Google Sheets, and Google Slides are
trademarks of Google LLC.)

Tools Menu
The Tools menu is where you’ll find the tools you need to help ensure the quality of your document, sheet, or
slide. Let’s examine some of the Docs offerings, shown in Figure 2.56. “Spelling and grammar” allows you to
check for misspelled words, to ensure phrasing and sentences are grammatically correct, and to create a
personal dictionary to which you can add frequently used names or words that are not in a standard
dictionary. There are also tools for quickly checking editorial matters, such as counting the number of words in
your document or seeing a list of linked objects. Notice how the menu also includes keyboard shortcuts. The
Tools menu also offers the option of typing by voice recognition, and it includes accessibility settings such as
the ability to use a screen reader to read the text on a page aloud and a magnifier to see content at a very
large scale. The Tools menu among the three Google apps is very similar.
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Figure 2.56 The Tools menu contains some of the most useful features of the Google Workspace. (Google Workspace is a trademark
of Google LLC.)

The Tools menu is also where you can set standard preferences for your Google app. The General options
allow for automatically capitalizing initial words, automatically applying certain quotation mark styles, and
having spell-check running in the background, among other functions. In the Substitutions section, you can
set certain manually entered items to be automatically formatted, such as fractions. See Figure 2.57.
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Figure 2.57 The list in (a) shows the general preferences; (b) shows the substitutions. (Google Workspace is a trademark of Google
LLC.)

Add-ons or Extensions Menu
The Add-ons menu is where you will find accessory programs that can be used for additional features
compatible with Google. For example, in Docs, if you need to work on a document with lots of mathematical
formulas and equations, you can install an add-on like MathType, which has offerings that go beyond Docs’s
equation feature. Or you might install Box, a cloud-based, file sharing, and storage app, to share files with
colleagues or clients.

Help Menu
The Help menu is self-explanatory: It contains the body of available knowledge concerning each Google
application, as well as all the fine print of the terms of use for the consumer or business. You can search for
content related to your question and you can access training materials in the Help menu (see Figure 2.58).
Conveniently, Docs also offers the user a dialog box with a list of all the keyboard shortcuts. The Help menu in
each of the Google apps is similar to the one shown for Docs.
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Figure 2.58 Using keyboard shortcuts can be a time-saver. (Google Docs is a trademark of Google LLC.)

Other Menus
Some Google products have menus specific to the application. For example, Sheets contains a Data menu to
help format and organize data. Slides has both a Slides tab, with a variety of options specific to the
presentation page, and an Arrange menu for organizing the various slides within a presentation. You will learn
how to use these specific menu features as you practice using the software later in the course.

2.6 Collaboration

Learning Objectives
By the end of this section, you will be able to:

• Discuss the benefits and challenges of collaborating with technology
• Describe professional behavior in collaborative meetings
• Outline how to attend and host a meeting
• Share and collaborate on documents via editing and commenting

Businesses in nearly all industries have benefited from advances in technology that have presented the need
for collaboration among workers who are not located in the same geographic area, maybe not even on the
same continent. Collaboration is essential in today’s business environment and occurs at all levels within an
organization. For example, the marketing department uses collaboration to make sure that company products
are meeting customer needs. This could include working with product developers in the company to convey
key customer preferences. It could also mean working with the accounting and finance departments to make
sure that the products have the correct price point and that profit margins are being met for the company’s
strategic goals.

Collaboration and teamwork are often used to mean the same thing, but there is a key difference. Both terms
are centered on a group of people working toward a shared goal. With teamwork, however, the group will have
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a defined leader, whereas with collaboration, there is no leader, and the group is more self-managed.
Collaboration and teamwork have become a core part of most business structures. In fact, being a “team
player” and being comfortable working with others have become key metrics in job performance evaluations.
Also, hiring managers seek out these skills in potential candidates. Effective collaboration takes practice. It
requires trust, information sharing, listening, an ability to accept feedback, and strong leadership to work well.

Collaboration in the Digitized Workplace
Reasons for collaboration are numerous. Collaboration provides innovative solutions to problems through the
sharing of ideas and ways to solve the issue at hand. But some results of collaboration can be more concrete.
For example, through shared resources, cost savings can be realized. Goals can be attained sometimes at a
faster pace with collaboration. Collaboration can contribute to enhanced job satisfaction as well as develop
employees’ skills.

Collaboration does not just happen spontaneously in organizations. Management will need to make an effort
to develop the structure and establish the culture of collaboration within the organization. This could mean
that management will set up teams or develop other such strategies to encourage the practice of
collaboration.

Collaborative Meetings
Meetings are necessary in nearly all types of organizations. Business meetings may be more discussion-based
or more centered on making specific decisions. Meetings are used to make decisions, exchange information,
announce changes, convey organizational goals, solve a specific problem, meet with stakeholders outside the
organization, or celebrate successes. Historically, meetings have occurred face-to-face, either in a traditional
conference room setup or in an individual’s office. But today’s technology enables us to conduct meetings
virtually, and this is where collaborative software programs come in handy.

Videoconferencing allows users to have a face-to-face meeting without being in the same room or even the
same part of the world. Videoconferencing tools include Google Meet, Zoom, and FaceTime. You can do
videoconferencing on a laptop, desktop, phone, or iPad. Meet, as shown in Figure 2.59 is part of the
Workspace. If you have a Google account, you have access to Meet.

Figure 2.59 Today’s technology enables us to meet with coworkers from across the world in a virtual meeting room. Depending on
meeting rules and norms, participants have the option of participating without having to turn on their cameras. (credit: “7.12.2020 -
Reunião GT – Retomada” by Ministério Público de Pernambuco/Flickr, CC BY 2.0)
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Zoom has recently become a leader in videoconferencing. Zoom offers both individual and corporate-level
subscriptions. The program has also been used for educational purposes in many schools and colleges.

Skype is a Microsoft product that has been around since 2003. However, it is not as popular as it once was, and
Microsoft Teams has taken over much of the functionality that Skype has to offer.

Finally, FaceTime is a video calling interface. FaceTime is an Apple product and is used for personal
communication rather than for conducting meetings in a business environment. To use videoconferencing to
its full capability, be sure your computer has either an internal camera or a webcam.

Professional Meeting Etiquette
Meeting etiquette for a videoconference should be given the same attention as preparing for an in-person
meeting. Although expectations may vary by organizational culture and the context of the meeting, there are
some general expectations to keep in mind. First and foremost, be sure to check your technology to make sure
you can access the link and that your internet connection is stable. Make sure you are familiar with the
software that is being used and know how to use some of the features within the program. Some key items to
understand prior to the meeting are:

• How to mute/unmute yourself
• How to turn your camera on/off
• How to participate in the group chat during the meeting if applicable
• How to enter comments
• How to use screen sharing options
• How to share files
• How to use emojis (if available and appropriate) during the meeting

During the meeting, unless you are the speaker, be sure to mute yourself. Also, be sure to be in a quiet place
without distractions such as pets and children. Consider what might be on the wall behind you. Some
programs offer the ability to customize the background that other participants see behind you.

Be on time for the meeting just as you would be expected to do for a face-to-face meeting. And finally, dress
appropriately for being on camera. In business meetings where you are an active participant, you should have
your camera on. If instead, it is a large group presentation, it might be appropriate to turn off the camera. It is
a good idea to check with the meeting organizer ahead of time to understand the expectations. For best
practices in videoconferencing:

• Make passwords mandatory for all participants to prevent uninvited guests from attending.
• Check meeting links to ensure they are accurate and are sent to the appropriate participants.
• Review security settings on participants’ computers to prevent identity theft.

SPOTLIGHT ON ETHICS

Ethical Considerations for Recording

Use of videoconferencing has grown exponentially due to its convenience and fairly straightforward
technology. It is quite easy to use, and most conferencing programs come with useful features and tools to
augment the experience. One of these conveniences is the ability to record. Recording meetings can be
incredibly useful; we can capture what was said for later reference or we can share the recording with those
unable to attend. That said, there are considerations to keep in mind when using the record feature. For
instance, some videoconferencing tools may record silently, with no indicator that the conversation is being
recorded. In most business settings, however, we want to avoid recording without the express approval of
all parties. Some applications will request participants accept the recording; failure to accept the recording
will usually take you out of the session. In addition, different states have different rules about recording
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audio, video, or both. It would be wise to inform yourself of your state’s laws, as well as the company policy
for recording meetings and conversations.

Collaborative Work
One of the biggest differences between Word and Docs is Google’s capacity for sharing. Workspace was first in
the market for use in offices based on sharing and collaboration. Its biggest advantage is that it allows many
people to work on the same document at the same time, with all participants having the document open at
once and seamlessly writing and editing different parts of it. Microsoft 365 incorporates some of these
capabilities now, but Google has secured a strong market share since its introduction in 2006. Because both
Microsoft 365 and Workspace are widely used, it’s necessary to learn to use and collaborate in both systems,
especially in the file sharing and editing functions.

File Sharing and Transferring
The most popular types of file sharing software are Drive, Microsoft SharePoint and OneDrive, and Dropbox.
When sharing and transferring files, you need to have a system. Develop a system that is simple and easy to
understand. This might mean that you limit the number of folders or develop a file/folder naming system that
is used for all content in the shared drive. You might consider grouping files together by software program or
by business function. For example, you could have a folder that contains all relevant marketing PowerPoint
presentations or a folder in the drive for Marketing, for Accounting, for Management, and so on.

Consider creating a manual or at least a list of expectations and rules associated with the shared information.
This could include the file naming process, where to store specific file types, and how to obtain permission to
add files or folders. When a new person joins the team, make sure they get training on using the shared drive
space. Finally, you should also control access to certain files and/or folders in the shared drive. Not everyone
will need access to all documents in the drive. These permissions can be easily managed based on the shared
software platform you are using.

Collaborative Writing and Editing
Because Workspace is web-based, all documents are in the cloud, making it easy to collaborate with
coworkers. Multiple users can have the same file open at the same time and can make changes together. As
one example, this functionality is useful in a small business accounting system that generates many invoices.
Sales associates in different locations can update their sales amounts online, all using the same workbook.
This type of collaboration was not possible in Office until Microsoft released its online version of Office. Office
365 (now called Microsoft 365) was the first version that allowed collaboration and sharing similar to that in
Workspace. The Excel 2016 and 2019 desktop versions now permit collaboration and sharing in real time on
files that are saved to OneDrive.

Sharing a Document
In Google, you can choose to send your file to individuals by simply typing in their emails, as shown in Figure
2.60a. There are various restrictions and modifications you can add to your sharing invite. By clicking the drop-
down menu next to the person’s name, you can choose to make this person a Viewer, Commenter, or Editor.
This is the most basic level of adjusting the sharing settings by person. You can also select the gear icon at the
upper right of the sharing window and uncheck the options you don’t want, as shown in Figure 2.60b. The first
choice allows for collaborators to edit and share the Google file; keep it checked if you want them to be able to
edit, or unchecked if you don’t want the recipients to edit. If you want recipients to just read, uncheck the first
option and keep the second option. But if you don’t want readers to be able to edit, print, download, or copy
the file, you should uncheck both options.
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Figure 2.60 (a) To share a file, simply type in the recipient's email address to send the invitation. (b) Clicking the gear icon will allow
you to manage what collaborators can do with the file. (Google Docs is a trademark of Google LLC.)

You can send people a link to the file without adding them as collaborators. There are more sharing
restrictions and options available in the Get Link box, as shown in Figure 2.61a. You can set your link sharing
up as a public link or a restricted link. The public link can be configured further, as you can see in Figure 2.61b.
Readers will be able to just view, comment, or edit. Or, you could choose Restricted, in which only certain
people can open the link. Whichever you choose—public link or sharing to groups or individuals—any changes
done by collaborators will be recorded, as mentioned earlier in the Version history feature from Docs. Adding
people as collaborators by sharing the file with them means that they get an email notification, and the file is
added to their “Shared with me” section of their Drive. This means that those collaborators have a Drive
account, whether through Gmail or through Workspace. When you send someone a link only, it’s not added to
their “Shared with me” and may be accessed by someone without a Google account, or without logging in to
their Google account if they have access to the link to the file.
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Figure 2.61 (a) You can set up a public link for people to access a file, whether they have a Google account or not. (b) You can also
place some restrictions on access to the file. (Google Docs is a trademark of Google LLC.)

Accessing a Saved Document with Drive
Your options for sharing and viewing files will depend on how you save files in Drive. Drive is the main location
from which you will create and save your Docs. However, Drive can also act as simple data storage, where you
can keep your Word documents, pictures, PDFs, and many other types of files. Word documents are
compatible with Docs to some extent; you can even open a Word document directly from Drive and edit it in
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your browser. However, you may notice some differences between your original Word file and the way it opens
in Docs. For example, some formatting may not seamlessly transfer to the Docs version of your file. Be aware
that you may need to make adjustments to clean up any incompatibilities. (Some other file types, like PDFs,
may need a separate application to edit.)

There are two ways to access files on your Drive. One is directly through your browser: Simply log in to your
Google account and navigate to the Drive app or go to drive.google.com and log in from there. This method
requires only an internet connection and an internet browser. When you select a .gdoc file, it will open directly
in your browser and you edit it from there. If you select a different type of file, you may want to edit it in-
browser or download it to your computer to use with another application.

The other way to access files is to sync your Drive with your computer. If you install Drive on your computer as
a network drive, you can access your files from your Windows File Explorer or macOS Finder window, as you
would your pictures or other documents. You can create folders or rename files all from File Explorer or Finder.
The advantage of this method is that you can open non-Google files, such as Word documents or PDFs, in their
native applications. That is, if you open a .docx file from FileStream, it will open in Word, instead of opening the
Google-compatible version in your browser. However, if you open a Docs file from FileStream, it will
automatically prompt your computer to open your internet browser and open the file there, as .gdoc files do
not have a native computer application.

The advantage of the in-browser method of accessing files on Drive is that it offers the user different options
for sharing and viewing files. In Figure 2.62, you can see on the right the available options: My Drive, Shared
with me, Recent, Starred, and Trash. My Drive contains your personal files: ones that you either created
yourself, uploaded from your computer, or copied to your Drive from people who shared files with you. Shared
with me contains shared files sent to you for collaboration. Recent contains the most recently opened or
edited files. “Starred” is a special category that contains only files that you have deliberately added to it by
selecting the “Add to Starred” command. These may be important files that you want to see later or files that
have high-priority issues needing to be solved. Trash, like the Windows Recycle Bin, is simply a place where you
send files to be deleted. Below these categories, you will see the amount of space you have left in Drive.

There are added benefits of using Drive. The most obvious one is that you can access your files from anywhere
in the world, with any device. A second advantage is the online drive’s interactive sharing ability: You can send
your file to anyone, either an individual or a select group. Finding and opening a file is as easy as signing into
your Google account, going to Drive, and locating your file.
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Figure 2.62 Drive is the storage space that customers get on Google’s servers. As you pay fees, your storage capacity is increased.
(Google Drive is a trademark of Google LLC.)

The one potential drawback of Drive is its reliance on internet access. All files are accessed and saved through
the internet.
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Chapter Review
Key Terms
AutoSave a function that saves continuously as you make changes to a file
Backstage view welcome screen and the File tab, where you can open or save a document, create a new

document, or configure settings for the application
blind carbon copy (Bcc) recipient in email; the recipient will receive the same email as recipients in the Cc

and To fields but will not be known to those recipients
carbon copy (Cc) recipient in email; the recipient who is Cc’d on the email will receive the same email as the

recipient in the To field, but the Cc recipient will be known to all other recipients
command process the user selects; located on the toolbar, on the ribbon, or in a menu
command group group of related commands that are placed together in one area of the ribbon
communication applications software that facilitates communication between individuals or groups
database applications software that organizes and manages large amounts of data, which could be textual

or numeric
dialog box window that appears within a software program prompting the user to choose or enter

information for a task
Download command in Google Docs that lets the user Save As their .gdocx file by exporting the file in

another file extension
email mail sent and received electronically
file electronic system used to store data and programs
file compression process of reducing the size of one or more files by removing unnecessary data
file format way data is encoded based on the application that the computer will use to read the file
folder defined area of a computer that stores files and subfolders
graphical user interface (GUI) portion of an application that allows the user to interact with the program
instant chat/messaging chat application that allows messages to be sent and received in real time
menu bar screen display of software commands that can be arranged in tabs and often at the top of the

screen; also called a ribbon
Portable Document Format (PDF) file format designed for publishing documents; maintains the same text

and object alignment when read in different software versions of .pdf readers
presentation application software used to create slides that combines text and visuals to be shared in a

presentation
ribbon area at the top of the application window where all commands are housed; organized into tabs
Rich Text Format (RTF) older text file format that is plainer and less sophisticated than .docx
Save way of saving a document that resaves the file with its existing name
Save a Copy command that creates a duplicate version of an existing file
Save As way of saving a document that enables you to rename the file or save it in another format
Share command that enables a document’s owner to invite others to work on it
spreadsheet application software that is used to work with data, especially numerical data
status bar feature that shows the computer’s progress in loading a website and is often found at the bottom

of the software screen
tabs sections of the ribbon that refer to related processes, organized by labels
template preformatted file, designed to save the user time in document formatting
toolbar bar of icons that are used in the program to perform functions; often found below the menus in the

program
Version history Google Drive feature that allows users to access past versions of the same document,

created using AutoSave
videoconferencing allows you to communicate with individuals over the internet using sound and video
word processing application software that is used to create text-based documents such as memos, letters,
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and reports
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Summary
2.1 Software Basics

• Software is the lifeblood of a computer system that gets work done personally and in the business world.
• Word processing applications are used to create text-based documents such as memos, letters, and

reports.
• Spreadsheet applications are used to work with data, especially numerical data.
• Presentation applications are used to create slides that combine text and visuals to be shared in a

presentation.
• Specialized applications include programs that are used only in certain disciplines or occupations.
• Installing and maintaining software is an important skill to have in today’s business world and beyond.

2.2 Files and Folders
• Some best practices for organizing and cleaning your files include never storing files on your desktop,

removing files from the download folder, and using descriptive folder names.
• The different types of files include document, worksheet, presentation, and graphics files.
• Files can be managed, shared, organized, and stored in the cloud using the applications provided by

Google or Microsoft.

2.3 Communication and Calendar Applications
• Communication in organizations today is facilitated with technology.
• Many applications include features to facilitate communication across time zones and borders.
• Email applications such as Outlook and Gmail make it possible to communicate and to send files via the

internet.
• Instant chat/messaging platforms such as Microsoft Teams and Slack have been used to create virtual

workspaces for teams in organizations.
• Productivity in teams can be enhanced by using calendar applications to manage team meetings and

project tasks.

2.4 Essentials of Microsoft 365
• Applications in the Office suite have generally the same layout.
• The options to customize files are arranged on the ribbon by tabs based on the usage.
• The Save, Save As, Open, and Print options are common among all applications.
• By using the settings options in the applications, you can customize the view and the ribbon to meet your

needs.

2.5 Essentials of Google Workspace
• Apps in Workspace include Docs, Sheets, and Slides. These apps are similar in many ways to their

Microsoft counterparts.
• Google has some of the same functionality that you will find in Microsoft, but items may use different

terminology.
• A unique feature of creating files in Google is that the files are automatically saved in your Drive in the

cloud.
• Commands and settings in Google are arranged in menus, with the more frequently used commands

appearing as icons on the toolbar.

2.6 Collaboration
• Collaboration and teamwork are essential aspects of today’s workplace. Both can be fostered through

technology. Sharing platforms such as OneDrive and Drive make it possible to collaborate and track
teamwork across a wide variety of applications.
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• Today’s companies expect workers to treat videoconferencing with the same level of professionalism as in-
office meetings.

• Companies use popular software programs such as Zoom and Microsoft Teams to run videoconferences.
• You can share and collaborate on documents through editing and commenting functions.

Review Questions
1. Which program is focused on numerical information?

a. LinkedIn
b. Google Slides
c. Microsoft Excel
d. Adobe InDesign

2. ________ is software used primarily for developing slides.
a. A word processing application
b. A spreadsheet application
c. A presentation application
d. Adobe InDesign

3. ________ show(s) the computer’s progress in loading a website.
a. Menus
b. The status bar
c. The toolbar
d. A dialog box

4. What are the advantages of saving your file as a PDF?
a. The document will have a higher resolution.
b. The document will be editable and ready for sharing.
c. The document will not easily alter its font or change the position of objects across any device that

opens the file.
d. The document will not be able to be viewed by a web browser.

5. ________ is a programming language used for designing websites.
a. PDF
b. HTML
c. JPEG
d. RTF

6. If you want to save your file in a different format or in a different location, you would choose the ________
command.
a. Restore
b. New
c. Save
d. Save As

7. The file extension .xls is associated with which software program?
a. Google Sheets
b. Adobe InDesign
c. Microsoft Excel
d. Microsoft Word
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8. Slack is a(n) ________ application.
a. calendar
b. email
c. meeting scheduler
d. instant messaging

9. ________ is used to send a copy of an email to a recipient without others on the email being able to see that
recipient's address.
a. Bcc
b. To
c. Attachment
d. RTF

10. When multiple calendars are centralized in a single calendar, this is called ________.
a. calendar creation
b. calendar color coding
c. calendar attachment
d. calendar integration

11. What type of Word file lets you start with a preformatted new document?
a. PDF
b. Open
c. themes
d. templates

12. Where would you find the AutoRecover command?
a. on the Home tab
b. on the Review tab
c. on the Slides tab
d. in the Options dialog box

13. Which tab contains the command group for paragraphs?
a. the Home tab
b. the Review tab
c. the Transitions tab
d. the Insert tab

14. Name three items that are found in the Options dialog box.
a. Save, Save As, Text
b. Save As, Font, Insert
c. Save, Proofing, Customize the Quick Access Toolbar
d. Insert, Proofing, Customize the Ribbon

15. What is the method of saving in Docs that lets you save a document to your own computer in a different
format?
a. Download
b. Save a Copy
c. Save As
d. Export
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16. Where will you find the settings to automatically capitalize words at the beginning of sentences?
a. Backstage view, Options
b. Home tab, Styles command group
c. in the Paragraph command group
d. Backstage view, Info

17. ________ is an example of a feature that is automatic in Google but not in Office products.
a. File sharing capability
b. File storage
c. Find and Replace
d. AutoSave

18. Which videoconferencing application is used more for social interactions rather than business meetings?
a. Skype
b. Google Meet
c. Zoom
d. FaceTime

19. What is one potential drawback of Drive?
a. It lacks the ability to share links with others.
b. It is a cloud storage platform.
c. It is incompatible with Microsoft products.
d. The organization of files is not predetermined.

Practice Exercises
20. Provide an image of a user interface (UI) and label the menu, toolbar, and dialog box.

21. Describe an application you use regularly. Have you ever needed to upgrade the program? How did the
upgrade change the application?

22. Choose a file that you are comfortable deleting that is saved on your computer. Open that file and create a
backup of that file by saving it in another location with a different name. Then, delete the original file. Go
to the Recycle Bin and choose the file you just deleted and choose Restore. What did you notice about the
Restore process and the restored file?

23. Using your classes this semester, create a folder organization system for your electronic class files using
the best practices covered in this section. Explain how you can use this framework for future semesters.

24. Using either Outlook or Gmail, create a business email following up on a recent interview you had for a
job opportunity. Apply the best practices discussed in this section.

25. Establish a Google account if you do not already have one. Access the Google Calendar function and
create a calendar for one of your classes. Enter a few assignments as calendar appointments into the class
calendar.

26. Go into the Backstage view of Word and customize the Quick Access Toolbar to include cut, paste, and
another command of your choice. Remove the Redo command from the Quick Access Toolbar.

27. Go to the Backstage view in PowerPoint. Examine the options for additional ribbon tabs you can add.
Choose two to add to the ribbon that you think might be helpful when creating a presentation in
PowerPoint.

28. Go to the appropriate menu in Docs. Find the MathType add-on and install it. Use the add-on to create a
couple of mathematical equations in a blank document.
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29. Create a new Slides file using a template. Go to the appropriate menu in Google, choose a presentation
template that appeals to you, and create a new Slides file from that template. Examine the menus that are
available in Slides and the tools found in those menus.

30. Create a meeting in Meet and invite participants. Create a document that will be shared with the
participants for collaboration. Use comments as appropriate in the collaboration document.

Written Questions
31. Why is the user interface important?

32. Why is software important?

33. You have been asked to prepare a presentation to introduce yourself to the other participants in the
management trainee program. Which program(s) could you use and why?

34. Describe the different types of Microsoft files that are commonly used and how each one can be used
both by a user and by a business.

35. What is the difference between a file and a folder?

36. Why would you compress a file?

37. Examine your own files and folders. How do you typically name your files and folders? Does your system
work for you? How might you improve your file/folder structure and protocol?

38. Describe an instance where you needed to work or learn remotely. What tools did you use? How did the
experience differ from an in-person meeting? What were the challenges? What were the benefits?

39. Why is email still so widely used in businesses today?

40. Discuss the benefits and challenges of communicating electronically in a global business world.

41. What is the purpose of being able to see document properties in Backstage view?

42. How does a command group differ from a ribbon tab?

43. What is the advantage of using AutoRecover?

44. What are the Workspace apps, and how do they compare with those in Office?

45. Explain the difference between Download and Save a Copy in Docs.

46. Why would you choose to create a new file using a template instead of starting with a blank document?

47. Why do we use videoconferencing?

48. Discuss how you see collaboration and teamwork in organizations. What are the challenges? What are the
benefits? What are the differences?

Case Exercises
49. Imagine you are working for a realtor in your hometown. You are asked to organize the files on the

realtor’s computer to make it easier for them to keep up with the properties they are selling and their
clients who are looking for homes. The realtor also deals with several rental properties. Design a folder
structure that is logical and that will be easy for your boss to manage when new clients or new properties
are added.

50. Aquent is a staffing agency for marketing professionals (Aquent: Global Work Solutions Company
(https://openstax.org/r/78Aquent)). As a result of the pandemic and their business needs, they have
converted to a permanently remote workforce. They have kept some office space for meetings and other
needs that necessitate meeting in person. What communication tools could they use to facilitate a remote
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work policy? What are some challenges they might face?

51. Go back through Essentials of Microsoft Office and find a command that you would like to add to your
ribbon. Then, follow the directions in the chapter to do so. Once you have added your command to your
ribbon, answer the following questions: Why did you choose to add what you did? Which ribbon did you
add it to? Why there?

52. Discuss the value of specific Office applications (Word, Excel, PowerPoint, etc.) in a business context, giving
examples of why Office has become so dominant.

53. Read this article about conducting a hybrid meeting (https://openstax.org/r/78HybridMeeting) in the
workplace. Describe at least three key takeaways from the article that will help you plan a meeting where
some participants attend in person and others participate virtually. What are some challenges posed by
setting up such a meeting?

2 • Chapter Review 141

https://openstax.org/r/78HybridMeeting


142 2 • Chapter Review

Access for free at openstax.org



Figure 3.1 Many people use word processing software for a variety of purposes, such as writing a paper for an assignment, or

creating a report for a manager. Companies often use both Microsoft Word and Google Docs in the workplace. (credit: modification

of "WOCinTechChat" by wocintech (microsoft) - 175/Flickr, CC BY 2.0)

Chapter Outline
3.1 Navigating Microsoft Word
3.2 Formatting Document Layout in Microsoft Word
3.3 Formatting Document Content in Microsoft Word
3.4 Collaborative Editing and Reviewing in Microsoft Word
3.5 Document Design
3.6 Navigating Google Docs
3.7 Formatting Layout and Content in Google Docs
3.8 Collaborative Editing and Reviewing in Google Docs
3.9 Versions and Version History

Chapter Scenario
You have been tasked with writing a market trends report on the manufacturing division of WorldCorp’s
consumer goods company, which produces products such as televisions and computer monitors. A market
trends report summarizes the current status of an industry, details the major competitors and their market
share, and provides some information on where the industry is moving. You are the main document editor, but
you need to get information from other WorldCorp employees in different departments, such as the
manufacturing and the accounting departments, as well as from international business statistics databases.
Creating this report will require a considerable amount of collaboration and sharing of information, as well as
layout and design skills, to make the final report look good. The process of creating this market trends report
will require a thorough, working knowledge of the program you are using to generate it.

Microsoft Word and Google Docs are two of the more popular document preparation and editing software
programs. Both programs have a distinct look and feel, as well as their own advantages. Word is full of
powerful tools that can be used across different fields, from education to accounting. In contrast, Docs, a free
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application, has more user-friendly and collaborative features. Offices around the world use both tools for
different purposes. First, you will learn about Word, and then Docs, building on the basics from the chapter on
the Essentials of Software Applications for Business.

3.1 Navigating Microsoft Word

Learning Objectives
By the end of this section, you will be able to:

• Identify the most commonly used tabs in Microsoft Word
• Use the Navigation pane

Microsoft Word is a sophisticated word processing application. It completely transformed the document-
creation process, replacing typewriters and existing word processing programs, such as WordPerfect and
WordStar, with a user-friendly digital interface and hundreds of options for formatting. The comprehensive
features allow users to easily adjust fonts and page layouts, insert graphics, track revisions, communicate
collaboratively via comments, check spelling, search for text, and much more.

Let’s get started on our market trends report. As you learned in the chapter on Essentials of Software
Applications for Business, you should first open a new, blank document in Word. Using the default settings,
type the following into the document:

Industry and Market Analysis

The laptop industry is growing at a rather slow rate with sales expected to grow around 1% annually.
Sales in the industry currently are over $20 billion. A large part of sales comes from consumer
demand. There are several key players in the laptop industry. The largest companies in the industry in
terms of consumer laptop ownership in the United States (market share) are HP, Dell, Apple, Acer, and
Lenovo. Individuals can purchase a laptop at various price points based on the features, speed, and
storage capabilities of the laptop. These companies also compete in the tablet industry and some
consumers might make the decision to choose a tablet over a laptop. There are also laptops that are
considered “convertible,” meaning that they can be more like a tablet or a laptop with the screen
feature that allows full rotation.

You will use this text to build the framework for the market trends report as you move through the sections in
this chapter and in subsequent chapters.

Tabs
Word comes with a set of default tabs (or menus), which are the interface for most of the functions and
features you will use. Those tabs are File, Home, Insert, Draw, Design, Layout, References, Mailings, Review,
View, and Help.

MAC TIP

These same tabs are on the Mac Menu Bar, but the menu bar varies when you are in Word. There is no File
tab on Word’s toolbar in Mac. The default tabs you see depend on the settings you have selected. They
usually are Home, Insert, Draw, Design, Layout, References, Mailings, Review, View, and Tell Me. You can
access Word preferences and settings via the taskbar at the top of the screen.

Many of the features that are common among the tabs in Office were covered in the Essentials of Software
Applications for Business chapter. In this chapter, you will learn more about how the tabs work in Word.

You can customize your menu bar by adding or hiding tabs, and by modifying the tools that appear on each
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tab. There are hundreds of commands you can choose from; the Word interface is highly customizable.
Customization of the tabs was covered in the chapter on Essentials of Software Applications for Business. The
next sections introduce some of the most important default tabs and their overall function, as well as the
most-used commands, as Figure 3.2 shows.

Figure 3.2 Notice there are several tabs, such as Home and Insert, that are common to all Office programs, as covered in Chapter 2.
(Used with permission from Microsoft)

Home Tab
The Home tab is where you will spend most of your time, as it contains the formatting of fonts, alignment,
headings, numbering, and lists, as well as the Find commands. It is also the default tab that displays when you
open your document. We will go over the Home tab commands in detail in Formatting Document Layout in
Microsoft Word.

Insert Tab
The Insert tab is useful for adding certain material into your document. The Insert tab also allows the user to
include elements such as headers and footers, page numbers, page breaks, and bookmarks. We will review
using these features in more detail in the chapter on Document Preparation.

Knowing how to use the Insert tab is particularly important for designing business documents, such as your
WorldCorp market trends report. Your report will contain many pages and sections, as well as a table of
contents and page numbers. It will also likely contain charts, graphs, and images, all of which need to be
inserted into the document. For example, you could insert a chart of the top-selling TV screens (by using the
Charts drop-down menu), then add a callout or label explaining the chart (by using the Shapes drop-down
menu).

Layout Tab
The Layout tab is where you will configure your page setup. It includes commands for adjusting margins and
the paper size, as well as options for shaping the text on the page with columns. The Paragraph command
group is for adjusting the alignment of lists, body text, and objects such as pictures in your document. This tab
also gives the user options for adding page breaks and line numbers.

Review Tab
If you are working with a team on your documents, you’ll likely use the Review tab. This tab has a commenting
function that allows users to add comments to a file, and to respond to each other’s comments, as also
discussed in the Essentials of Software Applications for Business chapter. As Figure 3.3 shows, the Review tab
contains the Track Changes feature, which is helpful when many people are taking turns reviewing and
contributing to a document. When Track Changes is turned on, edits to the document appear underlined and
in colored text. Each user’s edits will be colored differently to easily distinguish input from multiple people. This
is particularly helpful when documents go through several revisions and are reviewed by many people. The
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market trends report for WorldCorp is a team effort, requiring several people to contribute to the final
product. You can expect that as the document is created and revised, comments will be used to help reach the
final version of the report.

The Track Changes process might feel familiar to you, as it is designed to mimic the act of marking up a paper
document with a pen. You might have had someone work on your résumé or mark up a homework
assignment of yours, using a red pen to make suggestions and revisions on the document itself. In a Word
document, comments and Track Changes serve the same purpose as using a red pen on a paper document.
This process will be covered in more detail later in the chapter.

The Review tab also has many commands that allow commenting and suggesting changes in documents that
are used and edited by multiple people. Figure 3.3 shows two comments that users made by choosing the New
Comment function. As people work on the document, they can read and respond to those comments, or
remove them by clicking on them and selecting Delete in the Comments menu. There are also options in the
Show Markup button found in the Tracking command group to display (or not display) formatting changes
such as boldfacing or underlining.
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Figure 3.3 The Review tab in Word is helpful when multiple people are working on a document. It allows them to add comments and
track revisions. The second comment is the lower one and is the reply to the one above it. (Used with permission from Microsoft)

Also on the Review tab, the Proofing command group contains helpful tools that you will use often when
writing and editing a document. You can check your spelling and grammar, look up words in a dictionary or
thesaurus, and keep track of your word count.

You will learn more about the Review tab and its features in Formatting Document Layout in Microsoft Word.

View Tab
The View tab is useful for changing how you see your document. For instance, it gives you the option of
looking at your document one or two pages at time. You can also activate the zoom option from here, as well
as add rulers and gridlines, which are helpful when placing objects, such as a table or picture, in the report you
may be writing. You can also access the Navigation pane in the View tab. You may also use the read, print, or
web viewing modes when typing, which give you different ways of seeing your document, as Figure 3.4 shows.
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Figure 3.4 The View tab allows users to view documents in a variety of ways. The multiple pages selection, shown here, lets you see
several pages at once. (Used with permission from Microsoft)

Navigation Pane
The Navigation pane serves various purposes. The Navigation pane is accessed directly by checking the box
on the View tab in the Show command group. You can also get the Navigation pane by selecting Find from the
Home tab. With either of these options, a pane will open on the left side of the screen. There are three tabs in
the Navigation pane: Headings, Pages, and Results. The first tab, Headings, is the first thing you will see when
you open the Navigation pane. This tab shows the outline of your document, but only if you have placed
headings for each section and subsection (which you will learn more about in the section on Formatting
Document Content in Microsoft Word). The Pages tab shows a thumbnail representation of the pages of the
document. The Results tab is used for searching for a particular word, phrase, or number throughout the
document, as Figure 3.5 shows. You can always activate the Find function with the Ctrl+F keyboard shortcut.

MAC TIP

To activate the Find function on a Mac, press Command+F.
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Figure 3.5 The Navigation pane is a sidebar that helps you move quickly from one section of your document to another, or locate a
specific term or phrase through its search feature. (Used with permission from Microsoft)

REAL-WORLD APPLICATION

What Is a Document?

You will likely work in creating, editing, and consuming documents throughout your personal life and
professional career. But what exactly is a document? Generally, a document is any type of file that contains
information or transferred thoughts/ideas. While historically these documents were transferred to some
type of paper or physical presentation on a chalkboard or displayed with an overhead projector, nowadays
these are largely found in electronic format. However, when we are referring to a document with respect to
Word, we are referring to a very specific type of file. This document file will contain primarily text and
images that have been formatted and processed electronically. Hence, Word is a word processor, a type of
program that contains a number of different text formatting capabilities for producing primarily text-based
files and documents. This is an important distinction, as you can create any number of different text-based
files in several different programs.

There will be times when you may not have access to Word or another word processing program. Many
computers, and even some portable devices, will come with a preinstalled basic text processing as part of
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their operating system. Notepad is one example. While you will not be able to format the text (not even
bold, italic, or underline), you can capture basic text information and save it as a basic text file (.txt) to your
computer. This can be useful for jotting down quick notes—hence the name Notepad. Then, later, when you
have access to Word, you can copy and paste the text from Notepad into Word, where you can format it and
incorporate it into other documents if needed.

3.2 Formatting Document Layout in Microsoft Word

Learning Objectives
By the end of this section, you will be able to:

• Format page setup and margins
• Create different types of sections and modify section formatting

At WorldCorp, each major division represents a product line. All these divisions have their own functional
departments, such as finance, marketing, manufacturing, research and development (R&D), and logistics. To
write your report on market trends, you will need to get information on the products from these different
departments. For example, the marketing department might provide sales data for a particular product, while
the finance department can provide the profit made for each product sold. Practically speaking, this means
creating a document that is readable and easy to use for everyone.

Setting the page layout for your document in Microsoft Word allows you to present material in a way that
maximizes ease of use. Page layout includes setting margins and page size, choosing the page orientation,
introducing features like columns, and breaking up a document into sections so that different parts can have
different formats applied. These functions can be accessed using the tools on the Layout tab (see Figure 3.6).

Figure 3.6 The Layout tab has clearly defined drop-down menus and buttons for its page layout tools. (Used with permission from
Microsoft)

Page Setup
The Layout tab contains commands and tools for adjusting the overall page setup of your document, located
within the Page Setup command group. Page setup typically includes adjusting the paper size, margins, and
orientation, as well as adding features like section breaks and columns. There are accepted standards for
document formatting, but these can vary by target audience and by industry. For business reports, such as
your market trends report, a 12-point font for body text (Calibri, Times New Roman, and Cambria are some
popular fonts), and one-inch margins on all sides (top, bottom, left, right) are typically standard. Most reports
also have sections and section headings to help break up and organize the content. The line spacing in the
reports can vary, but the most common spacing will be either single-spacing, 1.5-spacing, or double-spacing.

Each of these elements has an important role to play in presenting the document to its audience (e.g.,
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business professionals), as well as an impact on readability. Some fonts are easier to read than others, or are
more appropriate for a specific genre of document. You may use a style guide (a manual for consistent styling
and editorial treatment) like the Chicago Manual of Style or the Modern Language Association (MLA) style for
published corporate reports, but many businesses do not strictly follow a manual of style for internal reports.
For reports like your market trends report, it is usually left up to the employee or the supervisor to determine
the best formatting and style for the report. For reports that will be distributed externally, such as at a
conference, you should ask colleagues in charge of these events if they have formatting and style
requirements for documents. It is important to keep the intended audience in mind when setting up the
document.

REAL-WORLD APPLICATION

Style Guides

Different industries will establish certain expectations around the types of documents that are typical of
their field, as well as how these documents are formatted and presented. For instance, newspapers will use
a certain type of font and use only certain types of formatting options. They will also define the paper size,
margins, and how the content is laid out on the page. If you review a handful of different printed
newspapers, you will find that each has a very specific style and that no two really look alike, although we
recognize that they are newspapers because they share a subset of agreed-upon standards (such as page
size). So too, will you find that your industry has a specific style, and in your studies, you will be asked to
adopt different writing and formatting standards. These are known as style guides, or style manuals.
Common ones you may encounter while in college are the APA (American Psychological Association) and
MLA (Modern Language Association) style manuals; however, others exist, including ones used in specific
industries, such as the CSE (Council of Science Editors) style used in biology and other sciences. These
guides will define how documents should be formatted in their entirety, from font type to the general
layout of pages, including margin width and line spacing. It is important to know that these styles are
updated regularly. You will want to stay abreast of these updates. To make this easier, most major style
guides, such as APA and Chicago, have websites that provide information about updates. To ensure that
you stay informed, some of these websites offer subscriptions for information about updates.

While Word does not come preset with these formatting requirements, you can create your own style sets,
which you will learn more about in later chapters. What’s more, there are many online resources that can
help guide you in these formatting requirements. For instance, the reference or citation page tends to be a
sticky spot for many students. There are several citation styles in the citation tool in Word. There are also
many free online services that can help you create your reference list by inputting relevant information into
guiding categories. They then generate your reference list for you. A word of caution: You should also
review and verify if the produced content does align with the formatting requirements of that style. Styles
do change and are updated, and these services do not always remain current.

Margins
All pages in a document have a margin, a blank area from the edge of each side of the page to the content.
Margins make a page more readable, and in printed documents, allow space for bindings, notes, and so on.
You may encounter projects that need different margins on different pages, or unconventional margins—that
is, custom margins.

To adjust the margins of a page, go to the Layout tab. Select the Margins icon, and a drop-down menu will
appear. The default margin is Normal (1 inch on all sides), but this can be adjusted via the prepopulated
options, such as for different layouts with narrower margins. If you want to set your own margins, choose the
Custom Margins option at the bottom of the drop-down menu. In the dialog box shown in Figure 3.7, notice
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how you can adjust the margins to be various measurements.

Figure 3.7 The Margins tab in the Page Setup dialog box lets you (a) choose from predetermined selections, or (b) create your own
specifications through the custom margin dialog box. (Used with permission from Microsoft)

Orientation
Page orientation refers to whether the page is vertical or horizontal. The default in Word is the vertical layout,
called portrait orientation. This layout works best for everyday text documents, such as business reports and
correspondence. The horizontal layout is known as landscape orientation, and works best for documents with
tables and graphs that otherwise would not fit well on a vertical page. Using the Orientation command in the
Page Setup command group, you can alter the orientation of your entire document, or also limit the changes
to certain pages or sections. Figure 3.8 shows the two layout options.

Figure 3.8 Inserting sections in your document allows you to change the page orientation between sections. (Used with permission
from Microsoft)
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Line Spacing
The space between lines of text as you move through the document is referred to as line spacing. You might
be familiar with double-spacing, which is often required when creating documents for a class assignment.
However, the default in Word is single-spacing. To change the line spacing, access the Line and Paragraph tool
from the Paragraph command group on the Home tab (Figure 3.9). To change the spacing of text that has
already been typed, select the text and change the line spacing to the desired spacing. You can also set the
spacing before typing anything in the document.

The line spacing can vary throughout the document. It does not have to be consistent. You can, at any point,
change the line spacing by selecting the text you want to apply the different spacing to, and then selecting the
spacing from the Line Spacing tool on the Home tab. But keep in mind the professionalism of the document
you are preparing. It is not advisable to vary the line spacing throughout the document, as that can impact the
readability of the report. It can also look as if you did not take care to ensure consistency in formatting when
preparing the report. However, if you have a few sentences that need to stand out for some reason—such as a
table caption, or a block quote—having these elements set with a different line spacing might be appropriate.

Figure 3.9 (a) You can change the line spacing of a document by using the tool in the Paragraph command group. (b) There are
additional options for indentation and line spacing by selecting Line Spacing Options. (Used with permission from Microsoft)

Through the Line Spacing Options tool, you can change the spacing before and after lines of text, the spacing
before and after paragraphs, and the indentation of lines of text.

Page Size
Understanding page size is particularly important when working at a global corporation like WorldCorp.
Different countries use different standard page sizes, and it is helpful to know how documents might vary
across various company locations. For example, the United States uses standard letter size (8.5 inches wide by
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11 inches long), whereas Europe and East Asia typically use A4 size (8.25 inches wide by 11.75 inches long).

Similar to margin selection, when you select the Size command, there is a drop-down list of default pages
sizes, as Figure 3.10 shows. You can select from these options or choose to create a custom page size. Note
that the size selections include materials other than standard pages, such as envelopes.

Figure 3.10 You can select from a variety of predetermined page sizes for your document, or create a custom paper size if desired,
such as for a poster or invitation. This figure shows the entire drop-down list as two panels. (Used with permission from Microsoft)

Columns
You may be familiar with the column format in print media such as newspapers and magazines, where the text
on a page is separated into multiple, vertical columns. Sometimes columns are desired in specific types of
Word documents, such as newsletters or brochures. They can also be useful if you have a long list of short
terms and want to optimize page space by utilizing columns instead of having a large expanse of white space.

Word has many options for creating columns. To do this, you can select a section of text, go to the Columns
drop-down menu, and select from common column layouts. Menu options include columns of equal size, or
options where there is one narrower column on the side of a wider column. If you want to customize a column
to be of a specific width, or you want more than three columns in one page, choose More Columns. In Figure
3.11, you can see the options. The dialog box shows a preview of how the document will look. A line between
the columns is possible, as seen in the dialog box.
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Figure 3.11 (a) More Columns opens a window where you can (b) customize their width and spacing. Columns are common in certain
types of documents, such as newsletters and brochures. (Used with permission from Microsoft)

Working with Section Breaks
Sections in Word are especially useful for long documents. A section allows the user to partition part of the
document, such as front matter, body text, and back matter, and apply different styles and formatting to each
section, while still maintaining all the text in one document. Sections are also important when creating a table
of contents and assigning page numbers in a large report. These concepts will be covered in more detail in the
chapter on Document Preparation.

The division of a document into front matter, body text, and back matter is more common in longer
documents, such as extensive reports, booklets, and manuals. Front matter typically includes the title page,
the table of contents, and prefaces or forewords. The body contains the main text of the document. The back
matter may include appendixes, an index, a glossary, or references.

Regardless of how you partition a document, having sections allows you to apply different styles to each
separately, including page numbering, page orientation, and formatting. Consider an example where your
document has a title page and a table of contents, and the main text begins on the third page. You don’t want
a page number to appear on the title page, but you would like the main content to start on page 1. You can
achieve this with a section break.

First, go to the Insert tab, select Page Number, and add page numbers to your document. The market trends
report is expected to be quite lengthy. Including page numbers in the WorldCorp market trends report will be
essential to help readers navigate through the document to the areas that are of interest to their needs.

To insert a section break, go to the Layout tab, click on the Breaks drop-down menu, and select the Next Page
section break, as Figure 3.12a shows. This will start a new section on the next page. Then, choose where you
want your page number to appear. As Figure 3.12b shows, it will be on the bottom right. Then, right-click on
the page number in that new section and choose “Start at 1” from the dialog box that appears. You can use
this feature to apply different page numbering styles, such as using Roman numerals in front matter.
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Figure 3.12 Section breaks (a) allow you to have different page formats for different areas of the document. Panel (b) shows that the
number will be at the bottom of the page. (Used with permission from Microsoft)

Another advantage to having different sections in a document is that you can accommodate different graphics
well. This can be helpful when working with graphics that are best suited for landscape orientation, for
example. As with the page numbering, you can change the orientation for a specific section. Figure 3.13 shows
successive pages of a document with different orientations.

156 3 • Creating and Working in Documents

Access for free at openstax.org



Figure 3.13 Inserting sections in your document allows you to change the page orientation between sections. (Used with permission
from Microsoft)

3.3 Formatting Document Content in Microsoft Word

Learning Objectives
By the end of this section, you will be able to:

• Format font types, sizes, and styles
• Modify paragraph styles in a document
• Use headings for reader and internal organization
• Adjust settings for how text and graphics flow together

You want your WorldCorp market trends report to look professional. To achieve this, you need to consider how
the content should be formatted for its intended audience. Formatting applied to content includes line
spacing, font type and size, alignment, and the use of organizational features like headers. Many employees in
the organization, including those in upper management, will view the report, so you need the report to show
your professionalism and skills in your role in the marketing department.

Formatting Font
There are many ways to change your text formatting in Microsoft Word. The most basic ways of adjusting your
text are through the font, font size, and font style (bold, italic, or underlined).

The default Word font is currently Calibri. (Formerly, it was Times New Roman, and could change again.) Fonts
are described as either serif or sans serif (Figure 3.14). A serif font is one that has short lines on the ends of
the parts of each letter, whereas a sans serif (“without” serif) font doesn’t have those embellishments on the
characters. Serif fonts are usually considered easier to read when there is a large amount of text being
presented, and sans serif fonts are often considered to have a more contemporary look. For accessibility,
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simple fonts such as Arial are a better choice to accommodate all readers. Fonts that are curvy or more artistic
in nature are difficult to read and decipher, particularly for people with vision-related impairment. However,
curvy and artistic fonts may be used to attract attention and add flair to promotional materials, such as
brochures.

Figure 3.14 The top three fonts are common serif fonts, while the three on the bottom are sans serif. Note the differences in the
lines on the ends of the letter strokes. (Used with permission from Microsoft)

You can select fonts using the drop-down menu within the Font options on the Home tab. There are many
fonts in Word, most of which are not appropriate for business reports because they are too ornate or
decorative. You should think carefully about the type of font you want to use and what it will convey to its
readers. You want to stay professional and avoid “fun” fonts like Comic Sans and Papyrus. Font choice also
affects the readability of your document. Script-like or blocky fonts can be difficult to read, especially with long
documents. Additionally, some fonts are more appropriate for headings or logos instead of the body of a
report or document.

MAC TIP

Mac offers some fonts that are not included in the Microsoft OS version, and, by default, is missing some
that can be added by downloading and loading the fonts into the application.

To adjust the font size, go to the Font Size drop-down menu, directly to the right of the Font menu on the
Home tab. There are other ways to adjust the font in a selection in a document, but this is the most direct way
to make the changes. The default font size is 12-point, but you may want to make your font larger or smaller.
Most documents use fonts in sizes 10- to 12-point. For your market trends report, you will probably want an
11- or 12-point font for your main body text, and a larger size for your report title and section headings. You
should ensure your font size is easily readable, especially if you plan to provide printed copies of your
document.

You can apply additional styles to your font, such as bold, italic, or underline, using tools in the Font command
group (Figure 3.15). There are also options for special text applications, such as adding superscripted text (text
that is raised above the line) and subscripted text (text that appears below the line), and changing font color.
Additionally, you can easily change the capitalization style through the Aa drop-down menu. This allows you to
set a selection of text in all capitals, all lowercase, or to capitalize each word, such as is common in headers or
titles.
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Figure 3.15 (a) The Font command group lets you select your font and font size, apply special treatment like bold or italic, and set
case. Selecting the arrow (a) opens the dialog box (b) where you can apply multiple formats at once. (Used with permission from
Microsoft)

Formatting Paragraphs
Paragraph formatting entails customizing the way the text appears on the page and how it flows from one
paragraph to the next. Specifically, this includes line spacing, tab indentations, and alignment justification of
text.

As you learned in Formatting Document Layout in Microsoft Word, line spacing determines how much space
there is between the lines of text within a document. There are different advantages to single-spacing versus
double-spacing. Most business documents, such as emails and printed letters, use single-spacing. This means
that each line of text comes right after the other, with very little space between them. However, double-spacing
may be used in working documents, and can be useful when there are multiple collaborators and you are
using Track Changes. This allows for better visibility for the changes or edits, and makes it easier to see the
revisions in progress. Double-spacing means that there is a complete line of space between lines. In addition
to single-and double-spacing, users can use 1.5-spacing, or set custom spacing between lines within a
paragraph (Figure 3.16).

You can also specify spacing between paragraphs, which is different from the line spacing within a paragraph.
For example, you might want your paragraphs single-spaced, but want a visual break between paragraphs.

3.3 • Formatting Document Content in Microsoft Word 159



Figure 3.16 The Paragraph command group offers a variety of line spacing options in (a) a drop-down menu or (b) in more detail in a
dialog box. (Used with permission from Microsoft)

Paragraph separation is typically indicated in one of two ways: by indenting the first line of the paragraph with
a tab indentation as Figure 3.17a shows, or by adding a space between paragraphs, as you can see in Figure
3.17b. In the latter case, the paragraph is usually not indented, as the space serves the same purpose as the
indentation (i.e., to indicate a new paragraph). Most documents, including those used in business, have small
0.5” indentations at the start of each new paragraph as the default setting. If indentations are too small, they
are difficult to distinguish, and large indentations can look awkward and confuse readers.
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Figure 3.17 Paragraphs can be indicated by (a) a first-line indentation or (b) by spaces between paragraphs. The latter works well in
documents where page count is not an issue as it could make for a longer document. (Used with permission from Microsoft)

Paragraphs can also be formatted with different alignment, or justification, styles (Figure 3.18). In documents,
the most common alignments for the body of the text are left-justified or fully justified. Left-justified means
that the text all lines up in a straight line along the left margin, but where text ends on the right margin varies.
Fully justified text lines up in a straight line along both the left and right margins. This produces a clean and
professional look and is often used in publishing or print materials. However, full justification can also lead to
awkward gaps within lines of text if the material contains a lot of long words or specialized content.
Determining which alignment is appropriate for a document depends on the audience. For example, if you
submit your WorldCorp market trends report for publication in an industry journal, it should be fully justified.
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Figure 3.18 Most documents set the main text with either (a) left alignment or (b) full justification. (Used with permission from
Microsoft)

Other alignment options include centering text and right alignment. Centering is often used to give special
treatment to a particular element of content. Right justification is often used in financial data, where, for
example, numbers align best if they align on the right.

Headings
A heading helps readers understand the organization of a document by breaking it into meaningful chunks.
Different heading levels can be used to create a hierarchy of content that also helps users best understand the
material. In Word, headings can be set using styles that give them additional functionality, such as quickly
displaying an outline of your document and providing the ability to link to or between sections. You can also
generate a table of contents using headings.

As an example, let’s select three section titles from your market trends report. Let’s say that the major sections
of your report are as follows:

• Introduction/Executive Summary
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• Industry and Market Analysis
• Competition
• SWOT (strength, weaknesses, opportunities, threats)
• Recommendations/Key Findings
• Summary

Open a blank Word document and type in the first three headings from the list above. For each header, select
the text, go to the Styles command group, and select Heading 1 (H1). H1 represents the top-level heading,
which you might want to use for a title or a high-level section title. As you can see, the font size and the color
changes automatically because you are selecting from the preset heading styles in Word. Repeat this
formatting for your next two headings. If you open the Navigation pane, you will now see that your three H1
headings appear in outline format (Figure 3.19).

Figure 3.19 (a) Headings serve as organizational signposts for a reader, collecting passages into sections and providing a hierarchy.
(b) Headings can also help you navigate documents. (Used with permission from Microsoft)

Heading hierarchies use the design of the heading to indicate levels of sections. The heading levels are usually
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referred to by numbers (such as Heading 1) and sometimes the shorthand H1, H2, H3 is used. Word’s default
heading styles are designed to have a logical and intuitive hierarchy, which typically includes font size, and
sometimes font style. In general, color should not be used to indicate levels in a hierarchy since this is neither
logical (i.e., it is not clear why one color would be higher or lower than another) nor accessible (some colors
are not readily conveyed to users who may be visually impaired or have other accessibility needs).

Adjusting Graphic and Text Layouts
If you are using graphics in your document, you will need to determine how the graphics and text should
interact in the layout. When you insert a figure into a text document, the figure can be positioned in several
ways in relation to the text using the text wrapping menu, as Figure 3.20 shows. Text wrapping refers to how
the text is placed around an image or figure you place in the document. Text wrapping is accessed through the
Layout tab in the Arrange command group. Your wrapping style may depend on the size of the graphic, as well
as its purpose. If it is an important figure being discussed in the text and/or if it has a caption, you may want to
clearly separate it from the text with the “Top and bottom” option, allowing the text to flow above and below
the image, but not to either side of it. If the image functions more as a design element, such as a logo or
photo to add interest, you might have the text wrap around it.

Figure 3.20 The wrapping style of how an image and text interact should be based on the purpose of the image. (Used with
permission from Microsoft)

For example, let’s assume you want to add an image of one of WorldCorp’s products to the market trends
report. As you may recall, WorldCorp sells products such as computer accessories, laptops, and TVs. When
discussing trends in the laptop industry, you may want to include a picture of a laptop from a top-selling brand
in the industry, such as HP. To insert the image into the report, place your cursor in the area of the report
where you want the image. Then, copy and paste the image into the market trends report. Then, from the
Layout tab, select the Wrap Text tool and select the appropriate text wrapping style to present a professional
look for the inserted picture. The Wrap Text tool can also be accessed by right-clicking on the inserted image or
figure, as shown in Figure 3.21.
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Figure 3.21 The default when inserting a picture is to have the picture inserted where the cursor is located “In line with text.” (Used
with permission from Microsoft)

Notice that you can change the wrapping style using the tool that appears in the upper-right corner of the
image when you paste it in the document (Figure 3.22).

Figure 3.22 You can choose to have the picture inserted with text wrapping blocked around the picture using “Square.” (Inserting the
picture “In front of text” does not present a professional appearance as it hides some of the text.) (Used with permission from
Microsoft)
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3.4 Collaborative Editing and Reviewing in Microsoft Word

Learning Objectives
By the end of this section, you will be able to:

• Use the tools in the Review tab
• Use the Editor tool

To put together the market trends report, you will need to gather information from several departments. This
information will likely include past sales data, information about current major vendors and customers, an
evaluation of the major competitors, and other related content. To ensure the accuracy and integrity of the
content, you want to have each department review the data specific to their sector. You also want to have the
report reviewed by a peer colleague and your supervisor to ensure it is correct and of the quality expected.
Word offers collaborative tools in the Review tab that make it easy to solicit, see, and implement feedback from
other stakeholders.

Review Tab
The Review tab is vital for teamwork between collaborators of documents. Many documents are created in
collaboration across functional departments, and each contributor to the document needs to record their
changes and suggestions so others can review them. The Review tab also has several proofreading tools you
might need for editing a document, such as a thesaurus.

Proofing Tools
As a student, you have probably been instructed to spell-check your work before handing it in. Word offers
spell-check by simply selecting Spelling and Grammar on the Review tab. This tool will automatically check
your spelling and grammar according to the dictionary and other language parameters in Word (which you
can adjust from the default settings if desired). A dialog box will appear, and Word will give the option to
accept or reject each of its corrections. It should be noted that spell-check will not always check when a word is
misused.

For example, if you have typed “four” instead of “for”, spell-check will not indicate a misspelled word. The
document creator will still need to proofread the document and not rely entirely on the Spelling and Grammar
check tool.

Word gives its users many options for customizing their dictionary and language preferences. For example,
you may frequently use the abbreviation “e.g.,” in your business documents, which means “exempli gratia,” or
“for example.” If you don’t add this abbreviation to your Word dictionary, it may be labeled as a spelling
mistake. “Id est” is another Latin term you might see, which means “that is to say.” After you add these words
to your dictionary, Word will stop flagging them as an error (Figure 3.23).

Figure 3.23 Adding regularly used new words to your dictionary will save you time when spell-checking a document. (Used with
permission from Microsoft)
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Another language customization feature is setting the proofing language. Word comes with dictionaries for
several languages, as well as a variety of English dialects, including British, Canadian, Australian, Caribbean,
Singaporean, New Zealander, and American English. After you set your preferred dialect, Word will check your
spelling and grammar according to that dialect. For example, if you choose American English as your preferred
dialect, the Spelling and Grammar tool will mark the word “favour” as an error and suggest the American
spelling “favor.”

Comments
Comments are used for calling attention to any content in your document that you want to solicit input on or
note for yourself. You can also use comments to flag spelling or usage queries, provide instructions to others
reviewing your document, remind yourself to address something later like adding a graphic or fact-checking a
statement, or ask questions about the content. To add a comment, select the segment of text in question, and
then select New Comment from the Review tab, as shown in Figure 3.24. You can then type within the
comment and click the arrow when you’re done to make sure the comment sticks.

Figure 3.24 Comments can be used to communicate collaboratively within a document, or to add notes to yourself. (Used with
permission from Microsoft)

When working in a document with comments, you can reply to any comment to add additional information or
start a dialogue about a specific item. Once comments are addressed and are no longer needed in the
document, you can either delete or resolve them, as Figure 3.25 shows. Deleting a comment removes it
completely from the document, whereas resolving a comment retains the comment in a history stored digitally
with the document.
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Figure 3.25 Comments can be either deleted or resolved when they are no longer needed. (Used with permission from Microsoft)

In a collaborative business document like your market trends report, you may find that another collaborator
added content that was not ideal. The next collaborator or editor in the process could flag this content with a
comment and send the document back to be revised. When the collaborator is done making the changes, you
or they can resolve the issue.

Tracking Changes
The shared effort of writing a document across departments and functions is achieved through the Track
Changes tool on the Review tab. Once turned on, this tool literally tracks the changes a user makes to a
document, using a different color to highlight each user’s edits. Once the document is saved and passed along
to the next collaborator, that next user can clearly see what has changed from the original document. This
makes collaborating on a document asynchronously—that is, not at the same time—easy to do.

Sometimes, you might work in a document that goes back-and-forth between you and one or two colleagues,
and you review each other’s changes and resolve comments at each pass. In other cases, all feedback may be
collected and processed by one person. In the latter situation, after all collaborators have added their inputs to
the document, a final author decides what changes are going to be kept for the final draft. This person might
be a project manager or higher-level editor, depending on the workflow and organization of your company’s
editing process. This type of editing cycle—sending documents to various stakeholders for revisions and/or
input—is common in many industries. An editing cycle may repeat multiple times before the document is
finalized. Using Track Changes and comments allows for many iterations of the editing cycle, all while
maintaining clear version history and control.

The Tracking command group offers options for which changes or markups are shown. You can toggle
between No Markup and All Markup to see tracked and clean versions of a document (Figure 3.26). The Show
Markup selections allow you to turn off Formatting revisions so you can focus more easily on content changes.
There is also an option to turn on/off feedback from specific reviewers. These possibilities are helpful when
you have a document with a lot of markup and want to focus on one area of input in particular.
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Figure 3.26 (a) Users can adjust how much markup they see, as well as (b) what types or markups are shown and which reviewers’
feedback is displayed. (Used with permission from Microsoft)

Collaborators, or a final author, have the option to accept or reject each change that has been tracked. While
reviewing changes, you can hover over any individual edit to see who made the edit and when, as shown in
Figure 3.27. The Changes command group on the Review tab has the option of accepting or rejecting the
various tracked edits as they are reviewed. You can also select to accept all changes in the document without
reviewing them individually.

Figure 3.27 (a) Track Changes tells you who made a revision, and at what time, and (b) lets you accept or reject each suggested edit.
(Used with permission from Microsoft)
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REAL-WORLD APPLICATION

Résumé Peer Evaluation

A résumé is a summary of your work experience that you use when applying for a job. You might not have a
résumé at this point, but you will probably need to create one in the near future. One option is to start with
a template that you find online or in Word or Google Docs and create one on your own. However, you might
consider starting at the career services office at your college. The career counselors in that department can
help you craft a professional résumé for your job search. You will first be asked to develop a list of your
previous jobs and the responsibilities that you had while working in those positions. Then, the career
counselor will ask about what type of job you are looking for now and your career goals in general. All of
these aspects will be reflected in the résumé you develop. The next step will be to create a first draft of your
résumé. The counselor will likely give you some tips and maybe even a couple of examples to reference
when creating your résumé. You can expect that your résumé will go through several edits and evaluations
before you have a final product.

Both Word and Docs have the tools you need to get feedback on your résumé drafts from the career
services department. You can share the file with others and have them insert comments or make revisions
to your résumé. Through the tools in the programs, you are able to see revisions made, who made the
revisions, and respond to comments. The collaboration tools in Word and Docs make it easy to get feedback
so that you can create a polished résumé to help you secure the perfect job.

Protect
If you do not want certain collaborators to change a document, you may configure your document so that
future readers of a document can change only certain components. In the Protect command group on the
Review tab, select Restrict Editing. This will offer two types of restrictions that you can set, as Figure 3.28
shows. The first, Formatting restrictions, lets you specify which elements of a document can be edited (see
Figure 3.29). For example, you might allow editing only to the main text and not allow it to headers or tables.
The second option, Editing restrictions, limits the level of editing others can do—from none, to commenting
only, to only tracked revisions. Those restrictions can be further customized to allow different restrictions for
different users.

Figure 3.28 Document protections can be added by restricting editing to certain components of a document, or to limited levels of
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editing. (Used with permission from Microsoft)

Figure 3.29 (a) Formatting restrictions can get quite detailed; however, they’re important to set to keep your document’s style from
becoming inconsistent. (b) Editing restrictions for other users can range from allowing others to work freely, to work in Track
Changes, or to “read only” and not make any changes. (Used with permission from Microsoft)

MAC TIP

Protect menu options on a Mac also include password protections, document review protections, and
privacy. There is also a menu button for Always Open Read-Only.

Editor Tool
The Editor tool in Word adds another level of document support with a more comprehensive editorial review.
Essentially, it is like a virtual editor, which goes beyond simple spelling and grammar checking. The Editor tool
is on the Home tab and can also be found on the Review tab. Simply click on the icon, and it will review your
document and provide a report and score. You can set the Editor to review for formal writing, professional
writing, or casual writing.

The Editor tool will check for spelling and grammar errors, as well as potential improvements, providing an
explanation of the issue and a suggested revision (Figure 3.30). In addition to spelling and grammar, it will
check for clarity, conciseness, formality, punctuation conventions, inclusiveness, vocabulary, conciseness,
clichés, and many more. In fact, the Editor tool checks for over 150 different issues with readability in
documents. For each item, it will give a rationale and suggested improvement that you can accept or reject.
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Figure 3.30 Editor will provide explanations and suggested revisions for errors of spelling, grammar, clarity, inclusivity, conciseness,
and more. (Used with permission from Microsoft)

3.5 Document Design

Learning Objectives
By the end of this section, you will be able to:

• Apply themes and styles to a document
• Use the Page Background command group

When creating your WorldCorp market trends report, you may choose to use custom formatting or existing
formatting to add styles to your document. You can achieve this via the options on the Design tab, by using
existing templates in Microsoft Word, or through combining those options to customize a template. Some
companies may have existing templates with logos, fonts, or colors that are part of the company brand. The
Design tab offers many options for quickly changing the graphical formatting of your document, applying
styles across the entire document so you do not have to manually make each change. You can change the
color scheme, fonts, and paragraphs, either manually or using the themes and styles in Word.

You may also opt to use a template. Templates are predesigned documents for a variety of purposes, including
reports, résumés, flyers, invitations, posters, and more. The advantage of a template is that it already has a
design applied. However, you need to ensure the template you select is appropriate for your audience and
purpose, and that your content will fit well in the template.
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Using Styles and Themes
Your supervisor has suggested that you apply a theme to the WorldCorp market trends report. A theme is a
cohesive set of fonts, font sizes, and colors that can be applied to your whole document. However, before you
apply a theme to your document, you must “code” your document’s style. Styles are preset formatting for font
type and size, line spacing, and other formats that are used to change the appearance of text in a document.
Generally, you choose the style for the document before beginning to input the text. By choosing the style, you
are coding the document so that Word knows how to format various sections. These codes tell Word which
parts of the text are body text, titles, subtitles, and so on. Without these style codes, the theme won’t know
how to apply itself to your document.

Styles Pane
Before you can implement styles, you first must label, or code, all the styles in your document. This means
selecting parts of the text and using the Styles pane on the Home tab to identify them. For example, all body
text must be selected and the Normal style applied; all headings must be labeled as Heading 1, Heading 2, and
so on. Once all your text has a style applied, then you will be able to use the themes and styles to full capacity.

You can change the default fonts and font styles in the Styles pane, as Figure 3.31 shows. For example, if the
default Normal font is Times New Roman, you may want to change it to Calibri. Then, when you select a
segment of text and choose the Normal style, it will make the font Calibri, not Times New Roman. In effect, you
are telling the program what you consider as “Normal” text font in this instance.

Figure 3.31 The Styles pane allows you to assign each part of a document a functional style, which can then coordinate with Word’s
existing themes. Hovering over each style choice will reveal the changes to the text block in which you have placed your cursor. (Used
with permission from Microsoft)

This is the manual way of applying styles. But the real power in using styles is to simply use them as identifiers
for your text so that themes can “read” and style the text properly. For example, it wouldn’t matter if you chose
Calibri as your Normal font style; if you select the “Madison” theme, for instance, the new Normal font will
automatically change to Arial, because that is what comes with the theme. Different themes have different
Normal font settings. To see what font a theme uses, you will need to select the theme and see the fonts it
uses. Now, let’s explore how to apply a theme and why it works so well with styles.

Applying Themes
Let’s revisit the different headings of the market trends report we worked on in Formatting Document Content
in Microsoft Word. Go to the Design tab and select the drop-down menu called Themes. You’ll see that there
are over a dozen default themes built into the software (Figure 3.32). As an exercise, choose the “Ion” theme
for your document. Selecting “Ion” changes all the available styles in your document. If you want to further
change the theme, you can change the color scheme using the Colors menu on the Design tab. There are
many different color palettes to choose from. Word offers these preset palettes because designers have
determined that the colors work together well to give documents a cohesive, professional appearance.
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Figure 3.32 Word offers a variety of themes, each with its own set of fonts, colors, and styles. (Used with permission from Microsoft)

You can change the colors and fonts associated with the selected theme by choosing the menus on the Design
tab. Choose the Green color group and Arial font and apply it to the report.

When you change the color and font, all headings and titles of the section will change in one step. There is no
need to select each heading one by one because you already coded your document with the correct styles
before you applied the theme, so the theme knows which text is which type of heading, and so forth. In the
template, the current font of the Normal text is Corbel. By selecting the Fonts drop-down menu, you can
change all of the Normal text and/or Headings font. Go to the bottom of the drop-down Fonts menu and select
Customize Fonts. A new dialog box will appear with all the fonts installed in Office, as seen in Figure 3.33.
Choose a new font and select Save and the headings will be changed.
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Figure 3.33 You can modify the fonts in components of a theme, such as headings, and they will change from (a) the default font
associated with that theme to (b) the customized font you select to apply. (Used with permission from Microsoft)

Page Background Command Group
The Page Background command group on the Design tab allows users to apply a page border, page colors,
and watermarks. A watermark is a lightly colored image, logo, or text that exists in the background of the
document. Like changing the page background color, adding a watermark will apply to the whole document.
Some companies choose to use watermarks to indicate the status of a document (e.g., “Draft”) or to imprint
their company name on each page of the document. To insert a watermark, select the Watermark icon and
choose Custom Watermark, as you can see in Figure 3.34.
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As an example, let’s add a watermark to the market trends report to indicate that it is a private, internal
document. Type “Confidential” into the Custom Watermark dialog box and have it run diagonally across the
page. There are a few options to alter the text’s appearance on the page. For instance, if you want to change
the text to be less visible, choose Semitransparent. You can even use an image, like a company logo, as a
watermark.

Figure 3.34 You can insert customized watermarks such as company logos using the Custom Watermark option. (Used with
permission from Microsoft)
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Figure 3.35 Watermarks are used to display letters or images on the page background. (Used with permission from Microsoft)

3.6 Navigating Google Docs

Learning Objectives
By the end of this section, you will be able to:

• Describe the major features of Google Docs
• Understand how to create a Google Doc in Google Drive

WorldCorp uses both Microsoft Office and Google Docs to conduct its daily business activities. These activities
are with both internal and external groups. For example, you might be sharing confidential sales data with the
internal marketing department at WorldCorp, but also share a version of the same information with less data
to external vendors. Both programs offer advantages: Microsoft has decades of being the industry standard in
word processing, spreadsheets, and presentation software, while Google offers a user-friendly design and
collaborative features.

In this section, you will revisit your market trends report, using Docs instead of Microsoft Word to create it. You
will see how Docs is different from Word and how to use it to your advantage.

Menus
What tabs are to Word, menus are to Docs. In Word, the tools we use to prepare documents are arranged in
tabs and then in command groups within those tabs. In Docs, the tools are arranged in menus instead of tabs.
There are some similarities between the names of the menus and tabs: For example, you have the Insert tab in
Word and the Insert menu in Docs. Docs also has a nice, user-friendly feature in which the tools that are used
more frequently, such as some of the alignment tools and the font tools, are on a toolbar under the menu.
This toolbar is called the action bar, and it is a static menu bar; it doesn’t change, like Word’s ribbon. This
keeps those tools handy so that it is faster and easier for the user to change items in the document. Many of
the tools on the action bar are similar to what you will find on the Home tab in Word. The menus in Google
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were covered in more detail in the Essentials of Software Applications for Business chapter, which discussed
the essentials of the Google programs.

Edit Menu
This menu is similar to the Edit menu in Word. Looking at Figure 3.36, you can see that this menu has
commands such as Select All, Undo, Redo, and Find and Replace. As in Word, the keyboard shortcut Ctrl+Z will
undo the last action you took, while Ctrl+Y is the opposite: It redoes what you have undone with Ctrl+Z.

MAC TIP

On a Mac, these commands are Command+Z and Command+Y, respectively. Any time a Ctrl+ function is
used on a Windows computer, the corresponding function key on a Mac will be the Command key.

Paste without formatting is a useful tool for copying and pasting text only, without any of the source
formatting (such as font, font size, or color). This is particularly helpful when copying and pasting from an
email or website.

Figure 3.36 The Edit menu has the standard copy, cut, and paste commands. (Google Docs is a trademark of Google LLC.)

View Menu
The View menu contains tools for looking at your document in different ways. It lets you see the file in three
different modes: editing, suggesting, and reading. It also gives the user options for things to toggle on and off,
such as the ruler and section breaks. The document outline found in the View menu (Show outline) is similar to
the Navigation pane outline view in Word (Figure 3.37). Showing the equation toolbar will let you add math
notation. Show section breaks allows the user to see where their document sections begin and end. Lastly, the
Full screen view is a view of the document that increases the window size to fit your whole screen (you won’t
see the Windows Start menu or your toolbar), and the window borders are seamless.
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Figure 3.37 The View menu gives the user different options for how to view the document. (Google Docs is a trademark of Google
LLC.)

Insert Menu
The Insert menu has many tools and features that are available in Word, yet in Word, these commands are
distributed throughout different tabs. Inserting images, graphs, or tables works the same way in Docs as in
Word, but inserting drawings is unique to Docs. With Docs, you can choose to insert a drawing and either
make a drawing on the spot, or insert a drawing that is already saved in Google Drive.

From the Insert menu, you can also add conventional document features such as footnotes, headers, page
breaks, bookmarks, and special characters (Figure 3.38). There is also a way to insert math equations using the
Equation command. You will find some differences between the programs and how they deal with such
features.
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Figure 3.38 The Insert menu’s central function is to add objects and document features to the document. (Google Docs is a
trademark of Google LLC.)

Format Menu
The Format menu shown in Figure 3.39 is the source for formatting text, paragraphs, indents, line spacing,
columns, and lists. The page’s headers and footers, numbers, and horizontal or vertical canvas are also
formatted here. As with Word, the user needs to select the text area that they want to change, and then select
the tool needed to modify it. Additionally, tables that were inserted using the tools in the Insert menu can be
further stylized to a professional look using the formatting tools available here, such as adjusting cell shading,
cell borders, and font.
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Figure 3.39 The Format menu contains all the tools for modifying the text or whole document. (Google Docs is a trademark of
Google LLC.)

Tools Menu
The Tools menu has some interesting features that Word doesn’t have, such as the Explore command. The
Explore command is a unique feature in the Google suite of programs that uses machine learning to offer
suggestions and predict what information you might need as you are creating files. For example, the Explore
command lets you search the web for the citations you have but need to complete, or references that you
don’t have and want to find. It can also suggest other Docs and Sheets that you own or are shared on that may
be referenced or connected to your current document. The Explore command can also suggest images that
might be connected to what you are currently working on. These images can be from your files or from images
on the web. Both citations and references will be formatted in the manual of style of your choice—APA or MLA,
for instance. The tools for checking spelling and grammar and word count function in a similar way to Word.
You will learn more about the Explore command in Collaborative Editing and Reviewing in Google Docs.

Docs also contains a tool for tracking changes, similar to Word’s Track Changes. This tool, available through a
drop-down menu in the top right of the document window, allows the user to choose between Editing (normal
editing of your own document), Suggesting (tracking your changes), and Viewing (view-only), as shown in
Figure 3.40.
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Figure 3.40 Track changes, or Suggesting, is accessed not from a menu, but from a drop-down menu on the right side of the
document screen. (Google Docs is a trademark of Google LLC.)

Through the Tools menu (Figure 3.41), you can choose Review suggested edits, which allows you to view the
suggested edits one by one and choose whether you’d like to accept or reject them. The Tools menu also
contains the Preferences window, which offers some of the general settings for your documents, such as
whether to use Smart Quotes and autocapitalization. (In Word, the Preferences are contained in the File menu,
which is covered in the chapter on Essentials of Software Applications for Business.

Figure 3.41 The Tools menu contains some tools for proofreading and collaborating in groups. (Google Docs is a trademark of
Google LLC.)

Creating a Doc
We are going to begin by creating our market trends report, starting with industry analysis information. The
most direct way to create a new Doc is to log in to your Google Drive. Once you are in the Drive, you can create
a new Doc by selecting the New plus sign, as discussed in the chapter on Essentials of Software Applications
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for Business. Then, choose Google Docs from the list. This will automatically open a new window with a blank
document. You could also hover over the arrow to the right of the Google Docs icon and choose Blank
document or From a template to create the new file. As an alternative, once in your Drive, you can create a
new document by selecting the Google Apps icon, as Figure 3.42 shows. This will open a drop-down menu, and
you will choose which app to access, in this case that would be Docs for the Google word processor
application. A new tab will appear in your browser with the Docs. Here, you can choose to open from recent
documents or create a new document either by a template or an entirely new file (by choosing blank).

If you select the first icon, Blank, Docs will open a blank canvas, similar to how Word opens its blank
documents. You can also create a new document using a template. There are many kinds of default templates
in Docs’s Template Gallery, including résumés, letters, project proposals, work notes, brochures, newsletters,
legal agreements, and several educational document templates (like essays, reports, class notes, and lesson
plans).

Figure 3.42 (a) Choose + New to create a new file type in your Google Drive. (b) Notice you can also use this menu to create a new
folder or upload a file that is already created. (Google Docs is a trademark of Google LLC.)

3.7 Formatting Layout and Content in Google Docs

Learning Objectives
By the end of this section, you will be able to:

• Modify document formatting
• Create different types of sections
• Modify the page setup
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Your market trends report is coming along in Google Docs. In this section, you’ll learn how to format it and
modify the page setup, similar to the way we modified the document in Microsoft Word. We are starting with
the same information that we used in the previous sections, and instead now learning how to format the
document using the tools in Docs. This will give you firsthand experience with the differences and similarities
between the two programs. You will also learn that Docs, like Word, has the ability to include section breaks,
and each section can have different formatting if needed.

Document Formatting
There are different key formatting options that you can do at the start of each document, such as set the
paper size, normal text font, line spacing, inserting columns (if desired), and more. You can also select the title
text of the headings and insert sections. The indent options and margins are important, too. You can certainly
change these items at any point in the document creation process, but by thinking through some of the
formatting at the beginning, you can make using additional tools, such as inserting a table of contents, a bit
easier. Determining some formatting choices at the beginning can help with collaboration and readability as
you work toward a final document.

Formatting Fonts and Modifying Styles
To modify the font in any way after you have typed in the document, you first must select the text you want to
format, then either use the commands in the window menus or with icons and tools in the action bar. As
Figure 3.43 shows, you can select a word and then use the action bar to change the font type, make another
word bold, and make another word larger. You can also select a word and use the Format menu to change it.

Figure 3.43 Font formatting can be done through (a) the action bar or (b) through the Format menu. (Google Docs is a trademark of
Google LLC.)

The drop-down pane lists these items for selection:
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Styles also have a similar function in Docs as they do in Word. The styles code your document so that it is
easier to apply formatting throughout. Docs comes with a set of default styles, like Normal text, Title, and
Subtitle, but these can be customized using the Options choice at the bottom of the style combo box. Applying
a style is critical for applying custom fonts and colors to a document. It is also essential when creating an
outline or table of contents for your document.

In Figure 3.44, you can see how to change the style from Normal text to Heading 2. First, you select the text,
then go to the action bar to select the style type.

Figure 3.44 The drop-down Styles menu gives the user a preview of what the different available styles look like. (Google Docs is a
trademark of Google LLC.)

As you can see in Figure 3.45, the text style has changed. The heading text was also added to the document
outline on the left. This is an important feature of styles in Docs. As you continue to apply styles within a
hierarchy, the outline in the document pane will reflect that hierarchy. For example, you can see that “Industry
and Market Analysis” is now listed on the outline as a heading. This can be particularly useful when managing
long documents, which Document Preparation covers.

3.7 • Formatting Layout and Content in Google Docs 185



Figure 3.45 Formatting text as a heading means it gets automatically outlined in the document pane. (Google Docs is a trademark of
Google LLC.)

Formatting Spacing, Indentation, Columns, and Lists
Changing the line spacing in a Doc is quite simple. You can easily change a whole paragraph’s line spacing
without having to select the whole paragraph: Just put your cursor anywhere in the paragraph and go to the
Format menu and hover over Line spacing. Then, choose the spacing you want (Figure 3.46).
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Figure 3.46 The line spacing formatting options give the user more options than the standard paragraph line spacing. (Google Docs
is a trademark of Google LLC.)

Notice that you have the option to add a space before a paragraph or remove a space after a paragraph. When
you are constructing a long document, it might help the readability in long blocks of text to add some extra
space in between the paragraphs. This tool will allow you to add that line space either before or after.

Docs also makes aligning and indenting text simple. As with modifying the line spacing, you can place your
cursor anywhere on a single paragraph and adjust the alignment for the whole paragraph. You can either
choose an indent from the action bar, or go to the Format menu, then hover over Align & indent, then choose
how you want to align the paragraph. If you want to align many paragraphs, just select them all together with
the mouse, and then follow the same steps.

To indent a body of text, the first line of the selection is indented to the right five spaces, which is the
convention for indenting the first line of a paragraph. To do this indentation, press the Tab key on your
keyboard. But if you want to move the entire paragraph to the right, click anywhere in the paragraph and go to
the Format menu, then hover over Align & indent, and lastly, select Increase indent (Figure 3.47). Increase or
Decrease indent can also be used to create tiers within lists, like bullets and numbers. This creates a hierarchy
of bullets or numbers in your list (Figure 3.48).
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Figure 3.47 You can choose indenting from the Format menu to indent selected text. (Google Docs is a trademark of Google LLC.)
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Figure 3.48 Only the selected text is indented over to the right. The rest of the text remains left-aligned. (Google Docs is a trademark
of Google LLC.)

Docs also makes it easy to create and format columns with a single click. To quickly change the text to be set in
two or three columns, as in a newsletter or email advertisement, just put your cursor anywhere on the text, go
to the Format menu, hover over Columns, then choose the number of columns you desire (Figure 3.49). You
can do this in the Format menu as well. You do not have to do anything like selecting the whole section or
document because the column formatting will apply to the section or paragraph you are in. If you want to
apply it to multiple paragraphs, you will need to manually select those paragraphs.

For the WorldCorp market trends report, let’s try two columns for the two paragraphs in the Industry and
Market Analysis section. This might make sense if we want to add a chart or a table of data below the text.

Begin by selecting the body text that you want to format. Then, go to the Format menu using the steps
outlined above and place the paragraphs into two columns. It should now look like Figure 3.50.
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Figure 3.49 Formatting text into columns adds more space below the text for additional items in the document, such as images or
charts. (Google Docs is a trademark of Google LLC.)

Figure 3.50 The columns present a professional look with the alignment of the text. (Google Docs is a trademark of Google LLC.)

Lastly, let’s review the Bullets & numbering tool. This tool has many useful applications, in business and in
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personal documentation. It is used to create lists in your document. To show how useful lists can be, see the
unformatted chunks of text in Figure 3.51. The text is unorganized and hard to read.

Figure 3.51 Lists are used for visual appeal as well as organizational purposes. (Google Docs is a trademark of Google LLC.)

To make this text into a bulleted or numbered list, select all of it, go to Format, hover over Bullets &
numbering, then hover over Numbered list or Bulleted list, and choose one. Figure 3.52 shows what the
content would look like if you had chosen bullets. Alternatively, for new text that has yet to be typed, you can
use the action bar and choose your list type first, then type the text desired.

3.7 • Formatting Layout and Content in Google Docs 191



Figure 3.52 Bulleting text is preferable in professional documents when you have lists of items that you want to call out without
numbering them, which could convey a hierarchy or steps. (Google Docs is a trademark of Google LLC.)

Working with Section Breaks
Adding sections to your document is important for formatting headings and creating the table of contents. To
add sections in a Doc, place the cursor where you want the section to begin, then go to the Insert menu and
look for the Break command group. Select Section break (Continuous) if you want the break to stay on the
same page, or Section break (next page) to start a new section on a new page, such as starting a new chapter.

Let’s practice using the continuous section command with our market trends report. Recall from earlier in this
chapter, the major sections of a market trends report are as follows:

• Introduction/Executive Summary
• Industry and Market Analysis
• Competition
• SWOT (strength, weaknesses, opportunities, threats)
• Recommendations/Key Findings
• Summary

Add the remaining headings into the Doc and be sure to format the headings as you did previously using
Heading 2. Add the headings in the order in which you see them here. You do not have to worry about the
alignment at this point, as we are just working on getting the sections defined. As Figure 3.53 shows, if you
insert a section before each heading, you can visualize the headings on the left document outline pane. As you
insert a continuous section break, Docs automatically moves your text further down, about two lines, as you
can see with the heading “Competition.” You can now change the format of each separate heading, as each is
its own section. Continuous section breaks are useful when you want to rapidly change one section’s format,
and not have to manually select the entire section’s paragraphs. Sections can also be used to have different
headers and footers, page numbers, and margins than the rest of the document. They can also be helpful to
break up the monotony of reading a long document.
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Figure 3.53 Section breaks are added using the Insert menu. (Google Docs is a trademark of Google LLC.)

If you want to view the section breaks as Figure 3.54 shows, go to the View menu, and select Show non-
printing characters. The document will display a light blue dotted line where the section break is. Deleting a
section is now easy because you can easily see the line; simply place the cursor at the left of the line and press
the Delete key on the keyboard. (Note that section breaks must be deleted using the Delete key from the left in
Docs; you cannot put your cursor to the right of the section break and use the Backspace key to remove it.)
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Figure 3.54 From the View menu, choose Show non-printing characters to show the blue dotted lines where section breaks have
been placed. (Google Docs is a trademark of Google LLC.)

Page Setup
As in Word, the Page Setup commands are for selecting the paper size and orientation (horizontally or
vertically). In Docs, it is all done from the File menu; Page Setup is near the bottom of the File menu. In Figure
3.55, you can see the options in the dialog box. The first combo box is for choosing whether to apply page
setup to the whole document, or just a section. You can also adjust the paper size; there is a combo box with
popular paper sizes like letter and legal. Additionally, you can change the margins to create custom margins.
You can also adjust the margins manually on the top of the window, using the mouse to move the margin
markers on the ruler (Figure 3.56). Many of the page setup tools in Docs are straightforward and minimalistic.
Google programs are intentionally designed to be user-friendly, and this is just one example of how easy it can
be to make changes to your document.
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Figure 3.55 Margins are set in the Page setup dialog box. (a) These are the margins if you choose an Executive size document. (b)
These are the margin sizes for the common Letter type document. (Google Docs is a trademark of Google LLC.)

Figure 3.56 You can also set margins by using the arrows in the ruler. (Google Docs is a trademark of Google LLC.)

LINK TO LEARNING

Docs also has numerous keyboard shortcuts that can help you perform tasks faster. These shortcuts are for
font formatting, line spacing, indent formatting, making lists, applying styles, moving and resizing objects,
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and adding citations or comments. Docs can also be manipulated through the Alt commands, to move
around in the window menus. These Google Docs keyboard shortcuts (https://openstax.org/r/
78DocsShortcuts) can be found at Google’s support page.

3.8 Collaborative Editing and Reviewing in Google Docs

Learning Objectives
By the end of this section, you will be able to:

• Use the Tools menu and collaboration functionality

Google Docs has many desirable features, but one of its biggest strengths as a word processing software
program is its ability to facilitate collaboration among multiple users. People like to use Docs for the ease of
sharing documents, tagging contacts, and inserting internet-enabled comments because these features make
working together easy. Microsoft Office has these capabilities as well, but because Google is free to use, many
people and small businesses prefer it. Nevertheless, many businesses use both because some features
function better in one product, and other features function better in the other. Google’s collaboration features
have been part of the apps from their inception. These features allow real-time edits to be seen by other users.
In the early drafts of the market trends report, you will use Docs for collaboration, because many in your
department are more familiar with the collaborative features in Docs.

In this section, you will take your market trends report and learn how to work on it with other employees at
WorldCorp, getting them to insert and verify data that you need to complete your task.

REAL-WORLD APPLICATION

Recognizing Collaborators

The collaborative power of applications today is unparalleled. Internet capabilities have spurred new ways
of working together and applications have incorporated these capabilities to provide collaborative features
across a range of suites, including the two discussed in this textbook, Microsoft Office and Google
Workspace. You can leverage not only the embedding capabilities across these suites, but you can also then
create and modify these files and documents across individuals and teams.

While ease in this collaboration is well-established, less obvious is how to credit collaborators who are
contributing to these files. Internet-enabled collaboration makes recognizing collaborators easier because
user histories and versions can be tracked. Depending on the purpose of the document, you may or may
not be listing its authors and contributors. It is important to follow your company’s established protocol
when identifying and recognizing collaborators formally; regardless, one should always at a minimum
recognize contributions informally. This may come in an email when presenting the file or verbally during a
presentation.

Tools Menu and Collaborating
The Tools menu options include spelling and grammar, citations, the Explore command, tools for reviewing
changes in Suggesting mode, and the dictionary. The Docs Tools menu contains some of the same tools that
are found on the Review tab in Word. These are tools and commands to make your document professional and
polished, as well as enable collaboration. These tools make collaboration between cowriters and coeditors
possible, as everyone can review the suggestions and comments, tag others in the comments, and add
citations and references.
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Spelling and Grammar
Before sending or sharing any document in the workplace, you want to make sure it is as error-free as
possible. You can do that by accessing the features of the Spelling and grammar command in the Tools menu.
The dialog box shown in Figure 3.57 has the same functionality and overall feel as Word, and it operates in the
same way, too, resolving each incident one-by-one.

Figure 3.57 The spelling and grammar checking tool in Docs is similar to Word’s. Always check that the suggestion is correct before
accepting it. (Google Docs is a trademark of Google LLC.)

As in Word, Docs offers users the option to add words to a Personal dictionary, so that they are not flagged as
errors by the spell-checker tool. To access the Personal dictionary, go to the Tools tab and hover your cursor
over the Spelling and grammar command. In the drop-down menu that appears, select Personal dictionary.
You can manually add words to it from there.

Citations and Explore
Citations are what give credit to sources. Sources should receive credit for contributing to your report, but
citations are also vital to avoid plagiarism. Citations appear in many different kinds of documents, from
educational papers to business plans. As you learned in Navigating Google Docs, Google’s Explore command is
an automated feature that is used in conjunction with citations. Word has a similar command called Smart
Lookup, but it only allows you to search the internet, not get autogenerated citations.

Assume that you have a list of web pages that you used as the bibliography for your WorldCorp market trends
report. Without automation, you would need to manually type in the website title, address, and date for each
source you are citing, whether it is in a simple list at the bottom of the report, or as a footnote, or even in a
separate document. With automation—that is, the Explore command—this task could become much less time-
consuming.

As you are writing the report, you can cite the source, and have Docs do the formatting of the reference. You
can cite the source either as a footnote or in the body of the text itself. Citing with footnotes is made easy with
Docs. Just select a sentence or word and go to the Explore icon at the bottom of the page (Figure 3.58).
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Figure 3.58 The Explore button is a gateway to formatting references. (Google Docs is a trademark of Google LLC.)

A sidebar will appear, where you can once again search for the source in a Google Search (Figure 3.59). When
you have found the referenced site again, just use the Google Search feature of citation formatting.

Figure 3.59 The right side of the figure shows the references for the highlighted information. (Google Docs is a trademark of Google
LLC.)

Then, click on Cite as footnote on the Google Search Explore sidebar (Figure 3.60).
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Figure 3.60 If you have a document that needs multiple sources formatted, the cite as footnote will be a handy tool. (Google Docs is
a trademark of Google LLC.)

The Explore tool automatically adds the citation on a footnote, using the citing format of the manual of style of
your choice (Figure 3.61).
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Figure 3.61 Using the Explore tool lets you add citations rapidly. (Google Docs is a trademark of Google LLC.)

Suggesting Mode
When you share the market trends report with your colleagues for their input, you need to make sure that
everyone’s individual edits are captured in a clear way, similar to Track Changes in Word. The way to do this is
through Suggesting mode, as the chapter on Essentials of Software Applications for Business introduced. To
turn on Suggesting mode, go to the top right of the Docs window and look for the drop-down menu that says
Editing. As you click on it, select Suggesting, as Figure 3.62 shows. In this mode, every time you add text, it will
be surrounded with a bracket. If you delete something, the text will get a strikethrough. All of these changes
will be accompanied by a comment box that shows a check or a cross. To accept the change, choose the check;
to reject, choose the cross.

The key to making sure your colleagues can make these suggested changes in the first place is to make sure
they know to turn on Suggesting mode when they begin working on the document. You can either inform your
colleagues about this manually or share the document with them in Comment-only mode by selecting
Commenter when you share the document with them.
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Figure 3.62 (a) Google’s version of Track Changes is called Suggesting mode. (b) When you make an edit to the document, you can
also add comments to other users about the edit. (Google Docs is a trademark of Google LLC.)

Reviewing Suggested Edits
You may want to create a document outlining the processes and workflow of the changes to your document,
particularly if there are multiple people working on it. You may want your report to be edited in a certain order,
perhaps with differing levels of access to the document. Or, you might want several people to work on it at the
same time. In the end, because you are the person in charge of producing the report, you will likely want to
review the overall result, after all changes have been added by others, so that you can accept or reject all of the
changes. This is where you will use the Tools menu’s Review suggested edits command. If the document is

3.8 • Collaborative Editing and Reviewing in Google Docs 201



filled with suggestions, it might be hard to read, so this feature is highly recommended, as it simplifies the
process of reviewing.

As Figure 3.63 shows, the drop-down box will display the options of Preview Accept All or Preview Reject All.
This is like the Track Changes feature combo box that says All Markup and No Markup. If you Preview Accept
All, you can see the document as if all the suggested edits were accepted. This will also make the document
easier to read. If you are satisfied with the changes, then you can just select Accept All. In contrast, the Preview
Reject All shows the original document before this version, without the current version’s changes, and it
doesn’t show brackets or strikethroughs as well. This way, you can control whether the document is
progressing properly or communicate with some collaborators if there is an issue with their additions or edits.
Although this function is available, it is not advisable to simply accept or reject all suggested edits in the
document. You should plan to review each suggested edit throughout the document and make the
determination about the edits one by one. You can review the suggested edits individually by using the up and
down arrows in the Review suggested edits tool in the Tools menu.

202 3 • Creating and Working in Documents

Access for free at openstax.org



Figure 3.63 As you work in Suggesting mode, your changes are tracked and recorded. The font color changes for additions and
strikethrough is used to show deletions. (Google Docs is a trademark of Google LLC.)
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3.9 Versions and Version History

Learning Objectives
By the end of this section, you will be able to:

• Access and use versioning features in Google Docs
• Access and use versioning features in Microsoft Word

This section delves into a feature of Microsoft Word and Google Docs called versioning. Versioning refers to
the technology where programs store multiple iterations of files until they are approved and saved. Essentially,
several edited versions of the file are maintained on an online server, as well as the original document.
Versioning technology can give you some peace of mind that your original document is saved somewhere, and
that any changes will need to be accepted (approved) before the final document is saved.

There are many user-friendly options in Docs’s versioning, as you can clearly see all of the changes created
within each version, as well as the time stamps for when each version was made. With this versioning
technology, your team can edit a document simultaneously, and everyone will see the changes happening and
what changes were made before you started working with the document. You will also see when other
collaborators add or edit the text. This sharing of the views of the document adds accountability to the work
on the final version of the document. It can be used to enhance communication about the rationale for
suggestions when comments are used. In Word, there are fewer options for accessing and using version
history features, but they do exist if you keep your documents stored on Microsoft’s cloud service, OneDrive,
or on a SharePoint server.

When you are creating the market trends report, you will be sending the draft to key personnel in various
departments to contribute to the report. Using these collaboration features will help as the document moves
through each stage toward a final, accurate report.

Versioning in Docs
With versioning, you no longer have to worry about losing your files if your laptop battery dies. You do not
have to be concerned if your program suddenly shuts down before you had a chance to save that last
paragraph you typed. Docs has a feature that, as long as you are connected to the internet, autosaves every
change you make to the file. There is no Save or Save As command because Docs is constantly saving in
Google Drive, which creates version histories. This version history can be accessed by going to the File menu,
then hovering over Version history, then selecting See version history. A sidebar will spring up to the right, as
shown in Figure 3.64, listing many versions of the file, each with a time stamp and the name of the person or
people using it at the time it was saved. With this Docs feature, it is not necessary to save multiple drafts of the
same document. An alternative way to access the version history is by clicking on the title bar that says, Last
edit was . . ..
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Figure 3.64 You can see the last edit of the document from version history. You can also access version history by clicking above the
action bar. Version history is a Docs’s feature that lets you see all your little changes in a document writing process. (Google Docs is a
trademark of Google LLC.)

To quickly see new changes in a file, Docs has a See New Changes alert. It appears where the date normally
appears, next to the Help menu. If you select that, you’ll be able to see the recent changes from other
editors—specifically, you will see all the changes that you haven’t seen since the last time you opened the file.
This functionality is useful for quickly and easily seeing changes from collaborators without having to access
the version history.

REAL-WORLD APPLICATION

Is Transparency Always the Right Choice?

Suggesting mode in Docs and Track Changes in Word serve the same purpose: Both help teams collaborate
and share documents. These functions also help teams maintain accountability on the document’s
grammar, usage, style, guidelines, and subject matter inaccuracies or faults. Google automatically logs the
chain of events of the addition or editing of text by time and collaborator, tracking who made each change
and when they did it. Between the Suggesting mode tool and Docs’s version history, the person in charge of
the document or team can monitor the progression of the document and increase the efficiency and speed
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of its completion.

When sharing documents between a client and a vendor, there could be concerns about access to all the
information in the document or the version history. Similarly, a supervisor might not want an employee to
see the comments and edits in a document summarizing their job performance and proposed salary
increase until they are ready to present it to the employee. That information might be important for the
human resources department to keep but does not need to be shared with the employee. So, although
Suggesting mode and Track Changes can assist with transparency and accountability, it can also be
problematic if information is shared to the wrong audience or before the document is ready to be shared
with others.

Now think about different circumstances in your life in which tracking changes and version history could be
helpful, harmful, or both. How would you store your different versions?

Browsing Versions
In Docs, all these versions of the same file are organized by date, with the newest on top (Figure 3.65). The top
version in the history is the most current and is open by default. You can check the date of the current version
on the title bar, right beside the name of the file. You can check the name of the collaborator who made the
edits by their name on the bottom of the time stamp, but also by the color of the circle next to the name, as
each collaborator will have a different color circle. If multiple people worked on the file, their usernames will
be listed below the time stamp, along with their color circle on the side.

The changes on the versions themselves are shown in highlighted font, similar to the Track Changes feature in
Word. But unlike Track Changes, each editor’s changes will not be identified with a different color. Just the
changes overall will be highlighted. If you want to find out who made the changes, hover the mouse above the
text you want to query, and the name of the collaborator will appear. If you don’t want to look at this highlight,
as it may be distracting, go to the bottom of the sidebar and uncheck Show changes.
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Figure 3.65 You can check the date of the current version and the collaborator who made the edits. The changes are highlighted and
show who made them. (Google Docs is a trademark of Google LLC.)

Figure 3.66 If you want to find out who made the changes, make sure Show changes option is checked so you can hover the mouse
above the text you want to query. (Google Docs is a trademark of Google LLC.)
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Naming Versions
In Docs, the versions do not have a name; they simply just show a time stamp. If you like a certain version and
want to keep it for future reference, or if you want to save it because it shows the progress of the file, select
that particular version and give it a specific name so that it’s easy to find. Select the three dots next to the time
stamp and a context menu will appear, from which you can choose to Name this version, as shown in Figure
3.67. As you finish typing the name, the time stamp will still appear, yet above it will be the name of that
version. This will keep track of the important changes in a collaboration.

Figure 3.67 (a) Naming the version can be useful, as there are many steps and processes in completing a business report. (b) Here,
the business report happens to be on marketing what are known as “the four Ps:” product, price, place, and promotion. You may
learn about these in the workplace. (Google Docs is a trademark of Google LLC.)

To name the current version, go to the File menu, then Version history, then Name current version. Next, type
the name of this version in the dialog box and click Save.

After you finish your document, you might have named some of the versions, and you might just want to see
only the named versions on the Version History sidebar. You can toggle the unidentified versions on and off,
on the top of the sidebar with the option Only show named versions, as you can see in Figure 3.68.
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Figure 3.68 The named versions might be the most important or relevant ones. (Google Docs is a trademark of Google LLC.)

Making a Copy of a Version
To make a copy of a version, you will also use the context menu for the specific version. The menu has the
option to make a copy, in which you can make a new separate file from this document. (It is like Save As in
Word, in which you can save a version with a different file name.) If you use the Name this version command,
you will not create a separate file; it will still be the same document. However, it may be better in some
situations to have separate files with descriptive names to them, as you would with different saved Word
versions of a document. Many companies have file naming conventions to help them keep track of versions,
such as “project#_document_name, ver#”, followed by the initials of the collaborators who made the changes
(e.g., “WC05_Market_Trends_Report_ver1_AC”).

Having copies of the same file, but as different versions, is an option if you want to download these versions to
your business’s computer desktop or hard drive, instead of keeping them online. Having a different version
can also be useful if you want to send this version to a client or any third party. When a copy is made of any
version of a document, it is saved as a new Doc, without the version history attached to it. The comments and
suggestions are also not copied.

You might find that at some point, you would like to preserve some content from an older version, but not the
whole document. In this case, you can go to the older version and look for the information that you want to
keep, then right-click to show the context menu, and select Copy. Then, go to the newest version and place the
cursor where you want the recovered paragraphs to be, and right-click to the context menu Paste. This will
keep your newest version, while adding the older paragraphs.

In addition to saving a copy by the context menu of the three dots, there are other commands available in the
list of versions. Right on top of the window of each version there are two different commands you can choose
from, zoom in and print, as shown in Figure 3.69. Some people like to have hard copies of versions of
documents for archiving purposes.

Figure 3.69 When browsing versions, you can always print a version you want save. (Google Docs is a trademark of Google LLC.)
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Restoring Versions
There may be instances when you want to revert to a previous version of the document. This is called version
restore. This could occur for a variety of reasons. For example, you might realize some key information that is
now needed was in a previous iteration of the document. Your team could also agree that a previous version
might be preferred after additional edits are made. This feature of versioning in Docs can offer you some
assurance that even if a document has gone through several stages, the previous work on the document is not
lost and can be accessed through Restore.

On the main window, where the versions are being read, there is a notification on the top right corner
displaying the number of edits of that particular session, as Figure 3.70 shows. Next to the number of edits are
two arrows; these are toggles for viewing the session changes. The first change of the May 6, 6:19pm session
was to change the date of the marketing report.

You can also restore a version without having it on the main window display by selecting the three dots beside
the version and selecting Restore this version. The newer version will not be the current version anymore, as
the older version now supersedes it.

Figure 3.70 (a) Google keeps track of the number of edits in the document, as you can see on the top right. (b) You can use the
arrows to move through the edits to determine if you want to keep the changes. (Google Docs is a trademark of Google LLC.)

If, after reviewing each change, you decide that one of the older versions is better than the current one, you
can select the large Restore this version button at the top of the window (Figure 3.71).

210 3 • Creating and Working in Documents

Access for free at openstax.org



Figure 3.71 Google gives you the option also to restore the document to a previous version. (Google Docs is a trademark of Google
LLC.)

Keep in mind that the number of versions displayed on the sidebar does not show all the versions available. If
you go to the sidebar, you’ll see that the time stamps are typically a certain length of time apart, as you can see
in Figure 3.72. That means that there are hidden versions from when the editing was taking place. Each
version has many changes that were happening seconds or minutes apart. You can access these micro
changes in each session by clicking on the triangle on the left of the version.
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Figure 3.72 (a) The versions are both time and date stamped. (b) You can restore to a particular version, make a copy of the version,
or rename the version. (Google Docs is a trademark of Google LLC.)

To quickly see new changes in a file, Docs has a See New Changes alert. It appears where the date normally
appears, next to the Help menu. If you select that, you’ll be able to see the recent changes from other
editors—specifically, you will see all the changes that you haven’t seen since the last time you opened the file.
This functionality is useful for quickly and easily seeing changes from collaborators without having to access
the version history.

Versioning in Microsoft Word
Microsoft Office has many options for accessing version histories but can be done only if the file is stored in
OneDrive or SharePoint Figure 3.73.
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Figure 3.73 The version history in Microsoft Word desktop is activated if the document is located in OneDrive. (Used with permission
from Microsoft)

If you have a desktop version of Word, you have to sign in to your Microsoft account. You will be able to access
the last 25 versions of your file on OneDrive (that is, if your file is stored on OneDrive), as you can see in Figure
3.74.
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Figure 3.74 When you choose Version History from Info, you will see a pane open on the right side of the document with the
versions that are saved. (Used with permission from Microsoft)

You can access your version histories in Word by going to the File tab and selecting History. If you have a
Microsoft 365 Word subscription, you can access the version history by going to the File tab, then Info,
followed by Version History. There you can see the versions available and browse through them. You can also
choose to restore a previous version, as Figure 3.75 shows. Moreover, if you have SharePoint Server or
SharePoint365, the possibilities of versioning are much more powerful, allowing as many as 500 versions to be
retained, as you can track a version’s history, view multiple earlier iterations, determine who can edit or write
on the files, control the number of versions stored, and more.
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Figure 3.75 (a) Microsoft 365 also has Version History that is also accessed through the File tab. (b) Select a version from the pane on
the right to see that version of the document. (Used with permission from Microsoft)

LINK TO LEARNING

SharePoint is more pliable than Google Drive, but it is not free. Unless your company is paying for a
corporate license, you would need to pay a fee per month per user for the standard version (Plan 1), and
you would need to have the desktop Microsoft 365. The current plans are priced between $5 and $23 per
month. Visit the Microsoft page comparing SharePoint plan options (https://openstax.org/r/78SharePtPlans)
for more information.
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If you want the Microsoft 365 applications integrated with SharePoint, you should choose Office 365 E3.
This article gives you an idea of the additional capabilities SharePoint has (https://openstax.org/r/
78SharePtVersion) and how users can benefit from versioning.
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Chapter Review
Key Terms
action bar toolbar, located beneath the menus, that contains the more frequently used tools in Docs
alignment justification of text on the left, right, or both when formatting a document
comments digital margin notes that collaborators can create, reply to, resolve, or delete
Editor virtual editing tool that reviews several aspects of your document’s writing, and can be set for

different styles
Explore command unique feature in the Google suite of programs that uses machine learning to offer

suggestions and predict what information you might need as you are creating files
heading key term or phrase that describes the content in a section of the document; can be used to generate

the table of contents
landscape horizontal orientation of a page so that it is wider than it is tall
line spacing spacing between lines of text in a document
margin edges of the document page that are left blank
Navigation pane Word feature that lets users view documents as thumbnail pages or outlines, or to search

for specific text within a document
portrait vertical orientation of a page so that it is taller than it is wide
proofreading process of checking a document for spelling and grammar mistakes
sans serif type of font that does not have short lines at the end of each part of a letter; considered easier to

read in large blocks of text
section partition of a document used to apply different formatting to different sections of text
serif type of font that has short lines or embellishments on the ends of the parts of each letter
style tool in Microsoft Office that is used in conjunction with the Themes tool; it lets the user customize a

theme’s color, font, and font size
Suggesting mode Google Docs’s version of the Track Changes tool in Word; it records the changes made by

collaborators on a document
text wrapping feature in Word that allows the user to insert an image or object, and have the text wrap

around it in the way that the user decides
Theme tool that lets the user change the color scheme of an entire document
Track Changes feature in Word that records what changes different users make to a document, allowing a

group of people to collaborate in writing and editing the same document
version restore feature in cloud server services like Google Drive and OneDrive that allows the user to

restore previous versions of their document
versioning technology where programs store multiple iterations of files until they are approved and saved
watermark text or image that is placed on the background of pages
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Summary
3.1 Navigating Microsoft Word

• Word’s functions and features are located in customizable tabs at the top of the user interface. The most
frequently used tabs include Home (to set document styles), Insert (to insert graphics or other elements),
Layout (to adjust margins and page settings), Review (to use comments and track change), and View (to
adjust how you see a document).

• The Navigation pane is a sidebar that allows the users to view the document in various ways. It gives the
option to see an outline of the document, see thumbnails of the pages, and lets users find and replace
text.

3.2 Formatting Document Layout in Microsoft Word
• Document formatting includes page setup configurations, such as paper size, page margins, orientation,

and the use of columns or sections.
• Section breaks allow different formatting to be applied to different sections of a document.

3.3 Formatting Document Content in Microsoft Word
• Options for formatting font types, sizes, and styles are on the Home tab. Using appropriate document

formatting helps make business documents more readable.
• The Layout tab is used for modifying paragraph styles in a document.
• Headings are a good tool for organizing your document, can be viewed in the Navigation pane, and can be

used to make a table of contents.
• When arranging objects such as images, graphs, charts, or tables around your text, use text wrapping

settings that optimize the purpose of the graphic.

3.4 Collaborative Editing and Reviewing in Microsoft Word
• The Review tab includes proofing tools like spelling and grammar check, commenting, Track Changes, and

document protection.
• The Editor tool conducts deep grammar and style checks on your document.

3.5 Document Design
• Themes are color and design schemes that autoformat document styles. The user can modify the theme

to their liking by modifying the styles.
• You can use the Page Background command group tools to make large changes to your whole document,

such as changing the background of your page and applying a watermark. These are options are found on
the Design tab.

3.6 Navigating Google Docs
• Docs has a menu protocol similar to other word processing applications, including File, Edit, View, Insert,

Format, and Tools menus. The commands in each menu have similarities to the ones in Word, but Docs
also offers unique features and abilities, such as the Explore command. Docs also features the action bar,
which contains some of the more frequently used tools in Docs.

• In order to create a new Doc, you must log in to your account and access Drive.

3.7 Formatting Layout and Content in Google Docs
• All document formatting in Docs is done by using the action bar or the Format menu. The functionality of

the formatting tools is similar to Word, although where the formatting tools are located can be a bit
different.

• Docs offers section breaks that enable the user to differentiate the formatting from one part of the
document to the next.
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• Page setup is located in the File menu and is part of document formatting, too. The configuration options
are minimalistic in nature, which makes Docs very user-friendly.

3.8 Collaborative Editing and Reviewing in Google Docs
• The Tools menu in Docs contains many of the same functions and features as the Tools menu in Word. The

Suggesting mode in Docs allows for users to work on one document simultaneously.

3.9 Versions and Version History
• Both Docs and Word have versioning capabilities that can save and restore previous versions of your

document. Docs frequently autosaves your document, capturing minute-by-minute changes. These
versions can be accessed, named, copied, and restored, which gives the user much flexibility when it
comes to keeping track of different versions.

• Word versioning only occurs if you keep your document stored on one of its cloud services like OneDrive
or SharePoint. It contains many of the same features as Docs versioning.

Review Questions
1. Which tab in the ribbon is the default tab that displays when you open a document file?

a. the Insert tab
b. the View tab
c. the Layout tab
d. the Home tab

2. What is one function of the Navigation pane?
a. It helps the user locate web pages.
b. It helps the user access help files.
c. It helps the user find a specific word or phrase in their document.
d. It helps the user find synonyms.

3. What is the purpose of the Page Setup command group?
a. It is used to set page margins and the page size.
b. It is used to wrap text and align text.
c. It is used to insert object and pictures.
d. It is used to insert WordArt or a signature line.

4. Where is the command for putting a section break located?
a. on the Layout tab, in the Breaks drop-down menu
b. on the Insert tab, in the Page Break drop-down menu
c. on the Insert tab, in the Text Box drop-down menu
d. on the Layout tab, in the Column drop-down menu

5. What is the difference between indenting a paragraph and aligning it?
a. aligning a paragraph will center or position it left or right, whereas increasing the indent will add

space in that selection
b. increasing the indent will center and indent left or right, whereas aligning will add a tab space in that

selection
c. aligning a paragraph can increase the indent when you place it in the center or left or right
d. indenting a paragraph can increase the alignment when you place it in the center or left or right

6. What is the default text wrapping when inserting a picture or an object?
a. behind the text, at the point where the cursor is located
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b. in front of the text, at the point where the cursor is located
c. in line with the text, at the point where the cursor is located
d. square around the text

7. What can Track Changes do?
a. see who made what changes to a document
b. add comments to changes made
c. search for changes to specific words
d. use Smart Lookup to select text in a document

8. Where are the two places the Editor tool is located?
a. on the Insert tab and on the View tab
b. on the Review tab and on the References tab
c. on the Home tab and on the Review tab
d. on the Home tab and on the Design tab

9. A ________ is a cohesive set of fonts, colors, and line spacing that can be applied to an entire document.
a. style
b. watermark
c. theme
d. template

10. What is the main use of a watermark?
a. to add a text or an image behind the body text of all pages
b. to insert an image on top of the header on all papers
c. to apply different font formatting throughout the document
d. to delete the page background on every page

11. Word count is found in which menu in Docs?
a. Edit
b. File
c. Tools
d. Format

12. What do you need to do first before creating a new Doc?
a. Create a template.
b. Click the New plus sign.
c. Go to the File menu.
d. Log in to Drive.

13. How does the user apply a new font to an entire paragraph in Docs?
a. Select all of the text, then either go to the Format menu or to the action bar to select a font type from

the combo box.
b. Place your cursor anywhere in the paragraph and choose the new font from the action bar.
c. Navigate to the Format menu and select a new font.
d. Select the entire paragraph and choose the font type from the Edit menu.

14. Where is the option to view section breaks in a Doc?
a. on the action bar
b. in the View menu
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c. in the Tools menu
d. in the Format menu

15. Page setup is found in the ________ menu.
a. Edit
b. File
c. Tools
d. Format

16. What is the main purpose of Suggesting mode?
a. to request comments from your coworkers
b. to collect feedback on your products
c. to gather voice messages in a chat like interface
d. to keep track of added and edited text by different collaborators

17. What are the two ways to access version history in Docs?
a. Go to the File menu, or click on the date link right beside the title bar.
b. Go to the action bar and click on the Style combo box or click on the title bar.
c. Go to the Explore icon on the bottom or click on insert equation on the View menu.
d. Go to the Edit menu and click on Select All, or use Ctrl+A.

18. What is the purpose of naming versions?
a. to have a record of the important changes in the progression of the document
b. to download the file’s versions in order to have a hard copy on your computer
c. to email each version to collaborators
d. to have track changes recorded so that the team knows about the changes

Practice Exercises
19. Go to Papers and reports (https://openstax.org/r/78PprRprtTemp) at Office.com. Choose a report template

to download for Word by scrolling through the thumbnails. (Note: Do not choose a “premium” report.
These require a subscription to access.) Select a report that is more than one page. Open the report
template in Word and change the view of the report on the screen using some of the options on the View
tab. What are some advantages/disadvantages of each of the view options?

20. Go to Papers and reports (https://openstax.org/r/78PprRprtTemp) at Office.com and search for a “Student
Paper” template for Word by typing into the search bar. Open the report template in Word and click on the
Navigation pane. Examine the result. How could the Navigation pane be useful if you were using this
template to prepare a document report for a class?

21. Find an online article that interests you. Copy the information into a new Word document. Save the
document using a relevant file name. Change the orientation of the document between portrait and
landscape. Adjust the margins and line spacing as needed to give the document a professional
appearance.

22. Go to the website of a magazine of your choosing and copy the text from an article. Select the entire
article, including the article’s images. (You can remove any advertisement images after you paste
everything into Word.) Paste it all into a Word document. All the images will be pasted along with the text;
they will appear in separate lines. Now, follow the steps you learned in this section to position and align
the images in a way that looks pleasing and professional.

23. Write out the step-by-step procedure for protecting a document that you will share with other
collaborators, whom you do not want changing the document formatting.
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24. Find an article online and copy and paste the information into a Word document. Access the Editor tool
and examine the suggested edits. Go through the edits and determine which suggestions you want to
keep.

25. Find a recent sports news article online. Copy and paste the text into a new Word document. Choose a
style and theme. Make some adjustments to the color scheme of your selected theme.

26. Copy and paste the text of an email into a Word document and format the email to appear as a WorldCorp
memo. Add a watermark to indicate the memo is a confidential draft.

27. Using the two approaches outlined in this section, create a new Docs file for the market trends report.
Which approach do you think you will use more often and why?

28. Create a new Doc using a template of your choice. Go to the appropriate menu and place a drawing in the
template.

29. Your supervisor has asked you to complete a two-page newsletter in Docs. The canvas will be landscape.
The first page will have single-spaced paragraphs in four columns, and the second page will have one
column with paragraphs that have two indent spaces from the left. That hollow area will be occupied with
an image. How would you accomplish this, given what you have learned in Formatting Layout and Content
in Google Docs?

30. Find an article on the internet that is at least three pages long. Copy the entire article and past it into a
new Doc. Use the skills from this section to reformat the text to a new font type. Insert section breaks as
appropriate. Make section headings bold.

31. Your supervisor has assigned you to write a set of company guidelines for making reports. You need to
include a section on how to collaborate on documents in Docs. List below the essential items to include in
this instructional guide for employees.

32. Find a news story online from a news outlet of your choice such as NBC, CNN, etc. Then, select one of
today’s top stories. Copy the material into a new Doc. Make some formatting changes to the document
such as changing the font style or line spacing as you learned in a previous section. Then, examine the
version history. Use the version history to look at the changes you made.

33. Select a topic and search for it on Wikipedia. Copy the material into a Word document and save the
document in SharePoint or OneDrive. Make some changes to the document such as line spacing,
formatting fonts, or adding lists. Close the document and reopen the document. Make additional changes.
Using the skills learned in this section, examine the version history. Access the previous version and
restore the current document to the previous version.

Written Questions
34. Describe how the Navigation pane can be used when working with a long document.

35. Where are the two places where you can find the margin commands? Explain the steps for each one.

36. Why is readability important for business documents?

37. Discuss some accessibility options that you should consider when creating a document.

38. Explain the difference between serif and sans serif fonts. Provide an example font of each.

39. Why are headings useful?

40. What does the Editor tool do that extends beyond a typical spell-check?

41. Why might you use both comments and Track Changes in a document?

42. What is a theme, and why would you use one?
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43. Explain what the action bar is and how it can help you when creating a document in Docs.

44. Explain the process for creating a new Doc.

45. How do you modify document section formatting in Docs?

46. Why would you insert different sections in a report?

47. Describe how the Explore command might be useful when writing a research paper for a class. Provide an
example.

48. Why would looking at version history be helpful in developing the final version of documents? Explain,
giving at least five reasons.

Case Exercises
49. You have been assigned a semester-long research project covering a topic of your choosing. This topic

must be something that directly impacts your college experience. For example, you might choose to
research how students purchase books for classes, or student opinions of campus dining facilities. To get
started, search for an appropriate business template and create a proposal for your research. Use the
template as a guide to lay out the plan for the research project. Keep in mind that you will need to
construct a report at the end of the project that includes the following sections: introduction, research
question/problem, literature review (background information on the topic), methods used to collect data,
results of the research, key recommendations, and conclusion.

50. The next step to completing your research project is building the framework for the full document. Start
by adjusting the margins of your report template so that the left and right margins are 1” and the top and
bottom are 1.25”. Insert the following headings: Introduction, Research Problem/Question, Literature
Review, Methods, Results, Recommendations, Conclusion. Now, add section breaks between each
heading. Be sure to save the document so that you can build from here.

51. Set up your document to track changes, and start to insert comments for yourself on what information
you will include in each part of the research report. Also be sure that you have formatted the document to
be double-spaced, as is typical line spacing for reports.

52. Apply a theme to the research report document you have started. Change the chosen theme’s colors. At
this point, you will notice changes in fonts for the most part as the rest of the document has not been
added.
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Figure 4.1 Learning how to properly format a document can make your documents look more polished and professional. (credit:

"wocubtech (microsoft) - 114" by WOCinTech Chat/Flickr, CC BY 2.0)

Chapter Outline
4.1 Microsoft Word: Advanced Formatting Features
4.2 Working with Graphics and Text Tools in Microsoft Word
4.3 Managing Long Documents in Microsoft Word
4.4 Google Docs: Enhanced Formatting Features
4.5 Working with Graphics and Text Tools in Google Docs
4.6 Managing Long Documents in Google Docs

Chapter Scenario
Your supervisor has read the first pages of the WorldCorp market trends report, which you have written with
the collaboration of your coworkers. Your supervisor adds some edits and comments, and is ready for you to
finalize it. This means inserting final art, updating charts and graphs, adding navigational tools such as
bookmarks and headings, tidying up the organization and appearance of the document using lists, and
formatting the bibliography.

Using the advanced formatting tools in Microsoft Word and Google Docs means understanding these
programs and their features in more detail. These tools enable the user to go beyond writing and formatting a
basic text document, and will lead to the production of documents and reports that look and feel professional.

Document Preparation
4



4.1 Microsoft Word: Advanced Formatting Features

Learning Objectives
By the end of this section, you will be able to:

• Use advanced configuration tools in Word
• Insert and format page numbers in a document
• Insert and format headers and footers in a document
• Insert and format a list

Your supervisor at WorldCorp has asked you to revisit the market trends report that you started in the Creating
and Working in Documents chapter. The report needs to have multiple sections that may need different types
of formatting based on the content in the section. You may need to update the headers and page numbers, as
well as add numbered or bulleted lists to summarize main points. You will also need to insert graphics and
charts to enhance the report.

This chapter covers how to take the market trends report to the next level by learning to insert visuals and
formatting items, such as a table of contents, as you would expect to see in a professional report. First, you will
work on the Industry and Market Analysis section from the previous chapter. Then, you will build content for
the other important sections.

To get started, revisit the market trends report you created in the Creating and Working in Documents chapter.
Using the skills from that chapter, format the headings for the document as shown below, using a theme you
find professionally appealing. Use the following section headings for the document:

• Introduction/Executive Summary
• Industry and Market Analysis
• Competition
• SWOT
• Recommendations/Key Findings
• Summary

You created the Industry and Market Analysis section in the last chapter. You can use that document as the
starting point. See Figure 4.2. The chosen theme is “Berlin,” with the colors changed to Blue II, but you can
choose a different theme for your document if you prefer.
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Figure 4.2 The first draft of the report has its major headings, under which you can add body text. (Used with permission from
Microsoft)

Advanced Configuration
As you learned in the chapter Essentials of Software Applications for Business, the File tab contains the
configuration options for Word. As the market trends report evolves, you will be collaborating with others to
produce the final report. You want to make sure the document options are set so that you can keep track of
the contributors to the document. Recall that you can enter Word’s settings by choosing Options from the very
bottom of the File menu. The Word Options dialog box shown in Figure 4.3 shows eleven different sets of
settings tabs, from General to Trust Center. It is helpful to learn about these settings because the settings in
Options allow you to adjust the editing options, save options, and sharing options for the program. The
options can be adjusted to your personal preferences as you work through the document on your own and
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collaborate with others.

Figure 4.3 The Word Options dialog box offers many different choices for configuring your settings. (Used with permission from
Microsoft)

MAC TIP

To view the same General options in Word, click the Word tab and choose the Preference tab. That is where
you will find many of the options discussed here.

First, the General tab lists information about the user. This will auto-populate based on the software
registration and computer settings. You can change the document’s username, which means that all of your
comments and tracked changes will have your name associated with them. You also have the option of turning
on “Real-time collaboration,” in which your changes to the document will be broadcast to the document’s
collaborators. (This feature is similar to Google Docs’s concurrent editing notification of documents.) This is
available to users who are working on a shared file through Microsoft 365. The document must have already
been shared with the collaborators, and they need to have been given permission to edit the document.

The second tab is Display. This tab includes options for adjusting how the text is seen on-screen. One of the
more important options is the ability to turn the formatting marks on and off because it enables you to see if
you have line breaks or extra spaces, as well as formatting settings in your text. Hidden characters that direct
how text is displayed but that don’t show when the document prints are called formatting marks. They have
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their roots in the paper-and-pencil editing process in which editors used standard markings or symbols to
indicate different things. For example, the ¶ is used to represent a hard return (i.e., a new line). These
formatting marks might be similar to the editing and revision marks that you may have seen when getting a
graded paper back in an English class.

The third tab, Proofing, contains powerful tools for reviewing document edits. From this tab, you can turn
various autocorrections on or off. Word provides the user with several convenient autocorrections, such as
correcting for two capital letters at the beginning of a sentence, capitalizing a sentence that starts with a
noncapitalized word, and correcting commonly misspelled words. You can also access the number of custom
dictionaries that you have saved. A custom dictionary is essentially a collection of defined words that you
provide to Microsoft. When you are typing in Word and use a word that is not in the default dictionary, you can
choose to have the word added to the dictionary in the program. For example, when you type “WorldCorp” in
Word, it will be identified as spelled incorrectly (see Figure 4.4). If you right-click on the misspelled word, Word
gives you suggestions or you can choose to have the term added to the dictionary. This will create a custom
dictionary by default that can be added to each time you choose to Add to Dictionary.

The key benefit to making a custom dictionary is that you can populate it with appropriate words and
terminology for documents that you work with frequently. This way, they will not come up as a spelling
mistake or a term used incorrectly when using spell check. A word of caution: When you add words to the
dictionary, they are added in exactly as you spell them, even if you accidentally misspell them. You should
make sure when you are adding words to the dictionary that they are indeed spelled correctly.

To look at the custom dictionaries that are currently saved, click on Custom Dictionaries. You can also review
and edit the word list in the dictionaries. This can be useful when you are writing different types of documents.
For example, in legal documents, you might use one custom dictionary, and in economics research
documents, you might use another.

Figure 4.4 Adding words to the custom dictionary can be helpful if you use noncommon words or acronyms regularly. (Used with
permission from Microsoft)

Another important tab is the Advanced tab. This one is the most versatile of the tabs, as it contains options for
formatting, autocorrect, cut and paste, sizing of images, document viewing and display, and printing. These
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settings are considered more advanced because they go beyond basic settings. You might find some helpful
settings in Advanced that you did not know you could change that could improve your efficiency with the
program. The additional settings are separated into several major groupings:

• Editing
• Cut, Copy, Paste
• Link Handling
• Pen
• Image Size and Quality
• Chart
• Show Document Content
• Display
• Print
• When Printing This Document
• Save
• Preserve Fidelity
• General
• Layout Options
• Compatibility Options

As you can see, the list of settings is quite extensive. Spend a little time browsing through all the items that
you can change or add to Word documents. You might also enable some commands or settings to see how
they work for you as you construct the market trends report.

There are instances in which you might want easy access to some frequently used tools. You can add those to
the Quick Access Toolbar, as the chapter on Essentials of Software Applications for Business discussed. By
default, the Quick Access Toolbar is located in the upper left of the Word window above the ribbon, and it has
three default commands: Save, Undo, and Redo. By customizing the Quick Access Toolbar, you could easily
access heavily used commands, such as Word Count or Insert Comment.

The last tab to discuss is the Trust Center (Figure 4.5).
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Figure 4.5 The Trust Center shows privacy settings that you can customize in Word. (Used with permission from Microsoft)

As you select that tab, you’ll see a button that says Trust Center Settings; select that next. Then, you’ll see the
many tabs of the Trust Center. Under Privacy Options, you will find Document Inspector. If you select
Document Inspector, you will be prompted with a list of items the inspector will scan for. Make sure the
Document Properties and Personal Information option is selected. Click Inspect and the tool will scan the
document for hidden information in the file such as your personal information or comments that are linked to
your name. After scanning, a results window will appear often with a warning that all of your personal
information will be removed if you continue with this process, as shown in Figure 4.6. Sometimes, for example,
you may need to send the document to a third party, and you don’t want to send all the versioning of the track
changes or comments.
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Figure 4.6 Word has many configurable settings that can help the user customize the program and make creating and editing
documents as easy as possible. Selecting Document Inspector allows you to remove your personal information from a file. (Used
with permission from Microsoft)

Page Numbers
Most professional documents need page numbers. You will likely see page numbers on business plans,
marketing plans, strategic plans, or any kind of business report. The process of adding page numbers to your
document so that they automatically update as you build the document is called page numbering. Recall from
the Creating and Working in Documents chapter that to insert a page number, you go to the Insert tab, and
then find the Page Number drop-down menu. You can choose to place the page number in four different
places: top, bottom, margins, or current position. Normally, business reports have the page numbers at the
bottom of the page, and you can choose to have your page numbers on the left, center, or right. You can also
format the page number field with various fonts and styles, as you can see in Figure 4.7.

Let’s add page numbers to the market trends report. To begin, go to the Insert tab and then go to the Header
& Footer command group. Choose the drop-down arrow at Page Number and choose Bottom of Page. For this
example, choose Accent Bar 2, which adds the page number on the bottom right of the page with some nice
formatting. Notice when you add page numbers, you get a Header & Footer tab that allows you to make
additional changes to the page numbers if desired.
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Figure 4.7 The Accent Bar 2 page numbering style automatically chooses a font and style for your page numbers. (Used with
permission from Microsoft)

You can tailor your page numbers to your differing document sections. You can choose to start your
numbering in a different place than the beginning of the document, as seen on the Header & Footer tab
options. For example, if you have a cover page, you generally do not include a page number on that page. It is
also possible to only number the pages in one particular section. You may choose the number format (Roman,
alphabetic, or Arabic numerals). You could choose to have the pages numbered per section rather than
numbering the document in its entirety starting from one. This is rare, however. You will most likely see a
business document numbered from the beginning and continuing on in each section rather than starting over.

Headers and Footers
Have you ever opened a book and seen the title at the top of every page? This area of the page is called the
header, in which you can put essential information about the document, such as the name, chapter name,
author, and page numbers. The header will appear on every page of your file by default, but you can change
this if desired, as will be discussed later in this section. If you glance at the bottom of a page, you may see the
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text “Page x,”; this is part of the area of the page called the footer. Many documents simply use the footer for
page numbers, but you may also add your contact information, the document file name, or the contact
information and logo of your company.

For the WorldCorp market trends report, we want a header that indicates the title of the report, along with the
year. To insert a header, go to the Insert tab and look for the Header icon drop-down menu. As with page
numbers, headers come in a few different formats. Choose the Banded format, as Figure 4.8 shows.

Figure 4.8 Just like the page numbers, the headers can be plain text, or formatted with designs. (Used with permission from
Microsoft)

To insert the desired header information, simply click on the header itself to add the header text. From here,
there are additional options to edit the header using the commands in the Header & Footer command group,
as shown in Figure 4.9. The Document Info and the Quick Parts commands on the Insert tab can also help you
add your document information or company information.

Figure 4.9 When you insert a header, the Header & Footer tab appears, where you can make further adjustments as desired. (Used
with permission from Microsoft)

In Figure 4.11, you can see all that data available to the header. Select Company Address, for example; note
that the information contained in these fields is in the document properties as covered in Essentials of
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Software Applications for Business. If these fields have not been filled out in document properties, the tool will
simply insert “Company Address” into the header. You will have to enter the required information there.

The header is fully viewable by default, but sometimes you may want to hide it when writing the document,
rather than seeing the white space dedicated to the header. To toggle off the header, go to the View tab, and
select either Read Mode, Web Layout, Outline, or Draft. The only view mode in which the header can be seen is
Print Layout.

Some business reports do not have a header on all pages or have different headers on odd versus even pages;
this is called an alternating header. For example, you might want to include the report title on the even pages
and the section title on the odd pages. To accomplish this effect in your document, just click on Different Odd
& Even Pages. This way, one page will not have the header, and one page will.

Figure 4.10 You can type directly into the header area, just as you would in the main page area. (Used with permission from
Microsoft)
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Figure 4.11 You can set up the document to include useful, company-specific properties that can quickly be added to the header.
(Used with permission from Microsoft)

The steps to insert a footer are exactly the same as inserting a header: Select the drop-down menu Footer. The
header, footer, and page numbers should have similar designs so that your document has a cohesive feel.

Lists
As you are crafting documents, you may find that some information is better suited to a list, rather than a
paragraph of text. You learned about lists in the chapter on Creating and Working in Documents, but here you
will go into more depth. Lists are useful for summarizing a long topic. The market trends report will certainly
include lists, such as a list of competitors, major markets, and major product lines. Pulling information into a
list can bring it to the reader’s attention and help the flow of the document by preventing it from getting
bogged down in page after page of paragraphs. You can choose to put text into a list after typing into the
document or you can select your list type before beginning to compose the text.

There are four types of lists in Word: bulleted, numbered, lettered, and multilevel. A multilevel list has two or
more different levels, and often combines different types of lists, such as numbers and letters, or bullets and
Roman numerals. Different types of lists are appropriate for different purposes. For example, numbered lists
are useful for indicating a sequence or order, while bulleted lists can be good for summarizing. Any type of
list—numbered, lettered, or bulleted—can be made into a multilevel list.

Numbered and Lettered Lists
To create a numbered or lettered list from text already in the document, select the lines of text you want to
create a list from and choose the Numbering drop-drown menu from the Home tab. In Figure 4.12, you can
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see the list format we chose: a number with a period after it. You can further customize your list by choosing a
different starting number or letter, or by continuing your list from a previous page or list. This can be useful if,
for example, you start a numbered list on one page, have a paragraph or two of text, then want to continue
with the same numbering sequence. Select the entire list, go to the Numbering drop-drown menu, and select
Set Numbering Value.

Figure 4.12 (a) Both numbered lists and lettered lists are available in the same drop-down menu. (b) You can choose to start your list
at any number, or continue from a previous list. (Used with permission from Microsoft)

You can also change the indentation in the list. Select the entire list and go to the Layout tab. In the Paragraph
command group, you will see fields for typing in custom indents. In the Left box, type in your desired indent
amount; 0.5 inches is a standard amount.

Bulleted Lists
Creating a bulleted list is a similar process. But unlike a numbered list, a bulleted list does not create a
hierarchy. Instead of selecting the Numbering drop-down list, choose the Bullet drop-down list, and select the
type of bullet you want to use for your list, as shown in Figure 4.13. You can either create your bulleted list
from regular body text, or you can convert an existing numbered or lettered list to a bulleted list. To change
from numbered to bulleted format, just reselect the list and go back to the Bullet drop-down menu and select
the new format.
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Figure 4.13 Different bullet designs may indicate different things. A checkmark list, for example, might be useful for a to-do list.
(Used with permission from Microsoft)

Multilevel Lists
Suppose you need to make an outline of the market trends report using the headings for the sections of the
report. Because the report is so long and detailed, it is too complex for a simple numbered or bulleted list; you
will need to use a multilevel list. A multilevel list will help indicate different levels of importance and hierarchies
within the report. Type the list of headings below into a blank document to start the outline for the market
trends report.

Introduction/Executive Summary

Industry and Market Analysis

Industry Type

Industry Category

Industry Characteristics

Trends

Stability

Market Segmentation

Total Available Market

Target Market

Market Segments

Competition

Direct Competitors

Uniqueness

SWOT

Strengths

Weaknesses
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Opportunities

Threats

Recommendations/Key Findings

Key Findings

Next Steps

Summary

As they are listed now, there is no indication of what headings go with other headings. It is just a list of words
and phrases.

To make this list of headings a multilevel list, first select the whole list with your cursor. Then, choose the
Multilevel List drop-down menu from the Paragraph command group on the Home tab. Choose the Current
List from the menu. But as you can see in Figure 4.14, you have other options for formatting your multilevel
list. You can also define a new list style if you do not want to use any of the available options by choosing
Define New List Style. Your list should now be numbered chronologically. You won’t see any changes right
away, but when you add indents, the different levels in the list will appear.

Figure 4.14 (a) Some of the multilevel list formats include text and symbols. (b) The multilevel lists will appear to be a typical, one-
level numbered list until you indent the subheadings. (Used with permission from Microsoft)

You add the indents with the Tab key on your keyboard. You can also add indentations using the Increase
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Indent tool on the Home tab in the Paragraph command group. Place your cursor at the start of a sentence in
the list and press the Tab key or click the Increase Indent button, as shown in Figure 4.15. You can see that
once you add the indent, the type of list changes. There are numbers at the top level, lowercase letters at the
middle level, and Roman numerals at the third level. You can change the format of your multilevel list by
selecting your list and going back to the Multilevel List drop-down menu. This process can be done with
lettered or bulleted lists, too.

Figure 4.15 More levels can be added to any level of the list by increasing the indent. (Used with permission from Microsoft)

As a final activity for this section, let’s add these new subheadings to the market trends report (because it is
easier to insert them at the beginning rather than going back later when creating a table of contents). Insert
the additional headings not in your current draft into the market trends report. Format the headings as
Heading 3 and Heading 4, as you learned in Creating and Working in Documents, based on the outline just
created. For example, Industry and Market Analysis is Heading 2, Industry Type would be Heading 3, and
Industry Category would be Heading 4. This will help as we build out the rest of the document toward a final
draft (Figure 4.16).
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Figure 4.16 Notice the various levels of headings have a slightly different font color and style. (Used with permission from Microsoft)

LINK TO LEARNING

As you continue to become familiar with Word and grow more comfortable with its different tools and
buttons, you will want to hone your own lifelong learning skills. This textbook covers a great deal of all that
is available in Word; however, programs are always changing and being upgraded. Microsoft offers
excellent support and tutorials about its various products, and these support pages are invaluable in
keeping current with not only Word, but all Microsoft products. Visit Microsoft’s support page on the
Advanced tab (https://openstax.org/r/78SupportAdvan) to learn more and become familiar with Microsoft
support pages.
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4.2 Working with Graphics and Text Tools in Microsoft Word

Learning Objectives
By the end of this section, you will be able to:

• Insert and modify a table
• Use tools in the Illustrations command group to enhance documents’ visual appeal
• Use the Text command group to enhance and format documents
• Use the Symbols command group to insert special characters and equations

The WorldCorp market trends report will include more than just text. It will incorporate graphics and images to
visually convey the information in the report. Some of these graphics are needed to show the relationship
between product lines and distribution centers. Other graphics are used to visually summarize information. In
this section, you will learn about the tools for creating engaging, professional graphics within Word.

Tables
Tables are a critical feature of many business documents. They are typically the most popular way of
presenting results and/or data. They are particularly useful for presenting simple data with only one or two
variables. You can easily glance at a table to see, for example, how many sales were made in a given month by
a given group of salespeople. In other words, tables are a good way of presenting a limited amount of
information in an easy-to-read format. Keep in mind that they are not best suited for complex data or
information sets with multiple variables, as the tables can quickly become overloaded with information and
hard to read.

You need to create a table to summarize WorldCorp sales information for the market trends report. The
following columns will be needed: Product, Quantity, Price, Revenue. This information will be arranged in four
rows to represent the four different product lines. (Remember that rows are represented horizontally from left
to right, and columns vertically from top to bottom.) To insert a table, go to the Table drop-down menu on the
Insert tab and select the number of rows and columns you want for the table by hovering over the squares
(see Figure 4.17). For this example, you need four columns and five rows (the products plus the column
heading row). You can add more rows or columns after the table is created if needed.

Figure 4.17 The Table tool provides an easy-to-use visual guide for creating tables. (Used with permission from Microsoft)
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When you insert the table, the ribbon changes, giving you two additional tabs for changing the formatting and
layout of the table. In Figure 4.18 you can see two new tabs: Table Design and Layout tab. These tabs open
automatically when a table is inserted into the document. You can modify the table as a whole by selecting one
of the Table Styles in the new Design tab. Select the whole table, then Table Styles, and then choose style; we
have chosen one with alternating white and blue rows. You can now add the desired text to the table with the
new table style.

Figure 4.18 With the built-in styles, you can customize the table for a more visually appealing look. (Used with permission from
Microsoft)

To add new rows or columns to your table, go to the other new tab, Layout. There are options for adding rows
and columns above and below, or to the right and left, of the one you currently have your cursor on. This
makes it easy to expand your table as you add more information. Select the area in the table you want to
expand such as the column or row. Then, choose the applicable tool from the Layout menu. In this example,
we chose Insert Below and Insert Right. In Figure 4.19, you can see an added row to the bottom of the table,
and a new column named YoY Same Month. (“YoY” stands for “Year over Year.”)

Figure 4.19 The Layout tab tools are used to make physical adjustments to the table, such as inserting or deleting rows or columns.
(Used with permission from Microsoft)

Illustrations Command Group
The Illustrations command group is for inserting images, shapes, SmartArt, or charts. For the market trends
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report, you will be inserting some graphs and charts that show the size of the market and other related
information. You might also want to include images of new developments in the industry or current products
on the market from competitors. The Creating and Working in Documents chapter covered the arrangement
and aligning of objects. This section will cover how to insert different types of objects.

Inserting Pictures
When inserting a picture into your document, you can choose to get a picture from the internet, from stock
images in Office, or from a picture saved on your computer. (Always make sure you are not violating copyright
or using pictures from proprietary sites without giving proper credit to the image creator or site.) In a business
report, you might want to include images of your products or your office building. These photos will probably
already be saved on your computer or be available on your shared company hard drive. To add a picture from
a file saved on your computer, go to the Insert tab, choose Pictures, then select This Device from the drop-
down menu (Figure 4.20). From the dialog box, choose the picture file you want to insert. The picture will be
inserted at the location of your cursor.

You may also choose to insert some stock images available through Office. Stock images are photos or other
images that are already licensed for general use through whatever platform you are using. There are stock
image repositories, such as Getty; Office has its own repository of stock images, which you can access by
selecting Stock Images from the Pictures drop-down menu. These images are searchable and include photos,
icons, and cartoons.

Figure 4.20 (a) Word makes it easy for you to insert images from a variety of locations into their document. (b) The Office stock
images give you different options for more generic images or cartoons. (Used with permission from Microsoft)

Word also gives you the option of inserting a picture directly from the internet. If you choose Online Pictures, a
dialog box will open, with Microsoft Bing’s image search available, as Figure 4.21 shows. This might be a nice
option if you want to include a picture of a competitor’s product in the market trends report.
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Figure 4.21 Bing’s image search tool helps you look for images by categorizing them by topic. (Used with permission from Microsoft)

Let’s find images of laptops for the WorldCorp market trends report. Let’s include one stock image and one
online picture. For now, insert the images in a blank document just for practice. Later, you can insert the
images into the market trends report if you desire. Open a blank document and go to the Insert tab.

Choose Picture and then choose Stock Images. Choose the Icons tab and, in the search bar, type “laptop”
(Figure 4.22). This will narrow our search to icons, or simple black-and-white illustrations, rather than
photographs. This type of image might be useful in a report because it is clear and simple. Notice that when
an icon is inserted into the document, a new tab, Graphics Format, appears on the ribbon. The Graphics
Format tab will appear when you insert something like an icon or a cartoon into your document. This tab gives
you the tools to make adjustments to the icon that you inserted.
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Figure 4.22 (a) Word gives you different categories to help you narrow down your search. (b) The Graphics Format tab offers tools
for applying different styles, effects, and other features to your image. (Used with permission from Microsoft)

Now, let’s find a picture of a laptop from the internet. Choose Online Pictures and type “laptop” in the search
bar. This will initiate a Bing web search for that key term. Notice that you can also search by license; here, we
have chosen to search for images under the Creative Commons license only. To select an image, click on the
picture and choose Insert (Figure 4.23).
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Figure 4.23 Bing is the search engine used for images because it is also a Microsoft product. (Used with permission from Microsoft)

In this case, because you are inserting an actual full-color image, such as a photograph, the tab added to the
ribbon is the Picture Format tab, not the Graphics Format tab. As with the Graphics Format tab, this tab gives
you the tools to make adjustments to the picture and its placement in the document, as Figure 4.24 shows.
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Figure 4.24 When images are used from the web, be sure to recognize copyrights and give credit for images when appropriate.
Although this image is a stock photo with an unknown author, other photos you may use will show the author's name and the
photo's license in the copyright line that Bing automatically generates. (Used with permission from Microsoft)

Shapes
The Shapes drop-down menu is a useful command if you are designing an ad, flyer, newsletter, or other
graphic-heavy document. Shapes are graphical symbols, like arrows, rectangles, circles, and lines, that can be
formatted in different ways. These can be useful in business documents because they can help call attention to
certain topics or data without being as eye-catching as a photograph. For example, you might want to insert
an arrow shape in the market trends report to draw attention to a specific item in a graph or chart. Or you
might want to use a circle to outline a key part of a table. However, keep in mind the professionalism and visual
appeal of the document you are preparing. Shapes might not be appropriate in all situations.

In Figure 4.25, you can see the wide range of shapes that you can add to your document. Let’s add an arrow to
a table that we might use in the market trends report to highlight an important number in the table. This table
contains television sales data for WorldCorp. We will revisit some of this data as we move through the
spreadsheet chapters.

We want to point out the highest quantity sold in the table. To insert an arrow, go to the Insert tab,
Illustrations command group, and select Shapes. Select the arrow you want to insert. In this example, the
single line arrow (third over from the left) is selected, as shown in the figure. When you select the shape, you
will get a black “+” as the cursor. Use that plus sign to insert the shape and to size the shape as you choose.
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Figure 4.25 There are many shapes for adding emphasis and visual appeal to your documents. (Used with permission from
Microsoft)

After you select and insert a shape, the Shape Format tab is added to the ribbon, as shown in Figure 4.26. You
can change the color of the shape, add visual effects, align the object, use a word wrap, and change the
position of the item.

Figure 4.26 The Shape Format tab is used to change the color, size, and other features of the shape. (Used with permission from
Microsoft)

SmartArt
SmartArt is a tool in Word that lets the user design organizational charts or flowcharts. It is also part of the

4.2 • Working with Graphics and Text Tools in Microsoft Word 249



Illustrations command group. It is similar to Shapes, but has the shapes prearranged in useful graphic
formats, such as flowcharts. In Figure 4.27, you can see the different organizational graphs and charts
available. This section covers three important types of SmartArt: Lists, Process Charts, and Hierarchy Charts.

Figure 4.27 There are various business charts that you can design in SmartArt. (Used with permission from Microsoft)

SmartArt Lists

Microsoft Word: Advanced Formatting Features covered basic numbered and bulleted lists. But there are other,
more visually complex options in SmartArt that an employee might have to use when creating documents that
contain deeper levels of content than, say, a memo or introductory letter to a customer. SmartArt can also be
used to outline an organizational structure to show reporting relationships between employees and
managers.

To insert a SmartArt list, select the SmartArt icon from the Insert tab and click on the List menu to see all the
options for Lists. Figure 4.28 shows a Horizontal Bullet List, which we can use to list the strengths and
weaknesses of WorldCorp in the market trends report. Click OK to insert the SmartArt. As you insert it, the
SmartArt Design tab is added to the ribbon, which has options for modifying the SmartArt. Figure 4.29 shows
what a Horizontal Bullet List SmartArt looks like.

250 4 • Document Preparation

Access for free at openstax.org



Figure 4.28 SmartArt also includes helpful hints on how to use each type of list best. (Used with permission from Microsoft)

Figure 4.29 Using the text boxes, you can enter the relevant information into the SmartArt graphic. (Used with permission from
Microsoft)

Process Charts

Another type of SmartArt is a process chart. This is one of the types of charts that Word offers to enhance
documents and is commonly used in business. A process chart is a way of graphically representing a multistep
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process. Most business processes or workflows can be diagrammed; think about the many steps needed to
publish a book or deliver a parcel. These process charts visually organize the steps or major components in a
process so that everyone involved can understand what their role is in the workflow. Workers involved in the
process may use process charts to check project status or determine which worker or department to consult to
move a task along. For your market trends report, you might want to use a process chart to show the
sequence of departments that the report will need to move through for approval.

Complex engineering, such as in manufacturing plants, has numerous processes happening at the same time,
with each set of processes being dependent on another set. The charts offered in the Process option can help
encapsulate the different types of workflows in a company.

In Figure 4.30, you can see a flowchart that needs to be filled. As with the Horizontal Bullet List, the boxes are
empty when the SmartArt is initially inserted. To add text, simply click on the text brackets and enter the
desired information. Notice there is a line that connects each box to the next one in a down than up pattern,
indicating the flow sequence.

Figure 4.30 This type of SmartArt is called a Vertical Bending Process chart. It can be used to show many different steps in a linear
workflow, without taking up too much space on the page. (Used with permission from Microsoft)

LINK TO LEARNING

Check out this tutorial to learn about creating flowcharts (https://openstax.org/r/78CrtFlowchart) in detail.
This site provides basic terminology and a step-by-step walk-through on how to create a simple flowchart
using the Shapes commands and a more complicated flowchart using the SmartArt commands.

Now let’s add a process chart to the market trends report. Open a blank document and go to the Insert tab,
SmartArt, and click Process. Choose the first option, Basic Process, and click OK (Figure 4.31). You can also
change the colors using the tools on the SmartArt Design tab using the change colors palette on the tab
(Figure 4.32).
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Figure 4.31 Becoming familiar with a Basic Process chart will lay the foundation for progressing to more complex charts in SmartArt
that you might need later in the workplace. (Used with permission from Microsoft)

Figure 4.32 The default color scheme is blue and white when the process chart is inserted, but there are many color options to make
the process chart look more professional and visually appealing. (Used with permission from Microsoft)

Hierarchy Charts

Another chart often used in corporate settings is the hierarchy chart. These charts typically show the chain of
command at a business; in other words, who supervises whom. In a large corporation like WorldCorp, there
may be hundreds of hierarchy charts. Every manufacturing center may have dozens, one for each functional
department. You could consult these hierarchy charts in a company organizational manual, or online, on the
company’s intranet. In Figure 4.33, you can see the inserted hierarchy chart of WorldCorp’s marketing
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department.

Figure 4.33 You can see the chart formatting and design options on the ribbon on this hierarchy chart. (Used with permission from
Microsoft)

REAL-WORLD APPLICATION

Understanding Types of Organizational Charts

Many companies will include an organizational chart (“org chart” for short) within their internal
documentation provided to employees. These serve as important documents that visualize the structure of
the company, as well as the chain of command within its service units. Hierarchy charts can help you
construct an organizational chart quickly. Before you begin, you will want to identify the type of
organizational structure your company has adopted.

Hierarchical organizations will have a clear and linear chain of command, usually organized by product or
function, with power primarily held at the top. These are mechanistic, or bureaucratic, organizations. They
tend to be formal, with a narrow span of control within each unit. Organic structures are more fluid and
flexible. Matrix organizations are a great way to try out a more organic organizational structure, while still
maintaining some aspects of a mechanistic structure. In a matrix, employees may report to more than one
reporting line and therefore power (and responsibility) is distributed. Dotted lines in such a chart would
show informal or secondary relationships. So, before embarking on creating an organizational chart for an
organization, first understand its structure to select the most appropriate chart type.

Charts
Charts are another type of visual representation available in Word. While tables present just data, and
SmartArt figures show relationships, charts can show both. Word charts include many types of charts that are
likely familiar to you, such as bar charts, line graphs, and pie charts. Charts can use data from another source,
such as a Microsoft Excel spreadsheet, to create the visual representation.
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You can create charts in Word using the tool in the Illustrations command group. You will use some of the data
from the sales data in Figure 4.25 and Figure 4.26 to create a bar chart of the quantity sold for each product.
When you finish inputting the data, you will see the chart in your document (Figure 4.35). First, select the Chart
command in the Illustrations command group, and choose the type of chart that you want to design. Let’s
choose a bar chart, also known as a Clustered Column chart (Figure 4.34). As you select OK, Word will
immediately open an Excel window so that you can enter the data. When you finish inputting the data, you will
see the chart in your document. As with the other types of graphical representations that we’ve covered, once
you click on the chart, a new tab will appear in the ribbon. Click on the chart and you can further format the
chart using the Chart Format tab that appears. You can also edit the data in the chart or table using the Edit
Data tool on the Chart Format tab, as shown in Figure 4.36. You can choose to edit the data in Word. If you
choose this option, an Excel window will open in Word with the data used to build the chart. If you would like
to save the data as an Excel file, choose Edit Data in Excel. This will open the Excel application. Here, you can
edit the data, but also save the information as an Excel file.

Figure 4.34 Within each chart type, there are many further options for customization. (Used with permission from Microsoft)
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Figure 4.35 As you create a chart, Word will create a new Excel file embedded in the document. You can choose to open the data in
Excel using the Edit data tool. (Used with permission from Microsoft)

Figure 4.36 You can change the design and type of chart using the Chart Format tab. (Used with permission from Microsoft)

It is worth noting that when you are looking to design a chart, typically you can use Excel as a starting point for
creating your chart. This is often a much easier approach than starting your chart in Word; this process is
covered in Working with Spreadsheets. After creating the chart in Excel, you would then copy and paste the
chart from Excel into Word or import the file into Word.
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Text Command Group
Like the Illustrations command group, the Text command group is located on the Insert tab. It houses the Text
Box, Quick Parts, WordArt, Drop Cap, Signature Line, Date & Time, and Object commands. These commands
are all related in their functionality, as they are tools to insert autogenerated text or specially designed text.

Text Box
You may have seen a text box, either in a Word document, on a website, or in a print article. It is simply a self-
contained square with some text inside. Figure 4.37 shows text box options. The text box is often used in
highly graphical documents, such as an email ad, but you may also add a text box for inserting a meaningful
phrase, idea, or data that you want to stand out from the rest of your document. The advantage of a text box is
that you can format the rest of the text in your document to wrap around it in different ways, which you will
learn about later in this chapter. In essence, it treats a box of text as if it were an image.

Figure 4.37 Text boxes such as this Banded Sidebar can help make your report more visually appealing and easy to read. (Used with
permission from Microsoft)

Quick Parts
The Quick Parts command in the Text command group was also part of the Header & Footer tab that you get
when you insert a header or footer. This is an alternative path to quickly add information to the document.
Through this menu, you can add a number of items to your document. The first option, AutoText, will
automatically add either the author’s initials or name to the header of the document. Another option under
Quick Parts is to add additional information such as the company mailing address (as shown in Figure 4.38).
The Fields option adds fields for a more specialized feature of Word called Mail Merge, which will be covered in
the Advanced Document Preparation chapter. This information will only be added if this information was
added to the document properties, as you learned in Essentials of Software Applications for Business.
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Figure 4.38 Key company information, such as address, email, and phone number, can also be added through the Quick Parts tool.
(Used with permission from Microsoft)

WordArt
WordArt is a type of stylized font available in Word. WordArt can be used to add colors, shadows, or borders to
text. In can also be used to change the text to be vertical or even diagonal. While it is appropriate to use in
graphic-heavy formats, such as front pages of business reports, newsletters, or brochures, it is not appropriate
for more text-heavy or professional documents, such as business correspondences, the inside of a business
report, a résumé, or a cover letter. That said, using WordArt in your document can be a fun way to experiment
and add color and creativity to it. WordArt could also be used to start the creation process for a logo, although
many businesses will use a graphic design company to create corporate logos.

Let’s practice with the company name, WorldCorp, to get an idea of what WordArt can do for plain text. To
insert WordArt, select the WordArt icon from the Text command group Figure 4.39. Choose a style, and a box
with “Your text here” will appear on the page, as shown in Figure 4.40. The ribbon will change to add a Shape
Format tab, where you can change the color, the font effects, and the position of the WordArt object. Replace
the text in the box with “WorldCorp” and choose a design that incorporates blue as the color because this is
the company’s primary color. Changes are made using the options in the WordArt Styles command group. You
may place the WordArt object behind or in front of other objects, or align it in a certain position within the
document, as you would with an image.
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Figure 4.39 Whatever you type in the WordArt box will initially be center aligned. You can change text alignment by going to the
Paragraph command group under the Home tab. (Used with permission from Microsoft)

Figure 4.40 (a) When you insert WordArt, you will get another tab on the ribbon to further customize the text. (b) You can send the
WordArt forward or backward using the Arrange command group. (Used with permission from Microsoft)

Drop Cap, Signature Line, Date & Time
The formatting options in the Text command group can be seen in books, reports, and other kinds of stylized
texts. For instance, you have probably seen a drop cap in a novel or journal article: It’s when the first letter of
the first sentence is large or in a stylish font, and the rest of the text is wrapped around it. To achieve this
effect, select the first letter and choose the Drop Cap drop-down menu from the Text command group (Figure
4.41). Once there, you will see options for font style and placement. You can choose Drop Cap Options to
change the font type and size. Generally, drop cap is not used in professional documents such as the market
trends report. We are just using it here for illustrative purposes. As you can see from the figure, the large letter
T is a bit distracting in the report.
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Figure 4.41 (a) You can choose from among a few different drop cap styles. (b) The drop cap design is a decorative style that you
might have seen at the start of a novel or magazine editorial. (Used with permission from Microsoft)

You have probably seen a signature line in many emails and letters in Word. The signature line is an
autogenerated graphical object that has your name, job title, and email address, as Figure 4.42 shows.

Figure 4.42 The signature line on (b) is what you will see once you fill the dialog box in (a). (Used with permission from Microsoft)

The Date & Time command is an autogenerated time stamp of the date or/and time format of your choosing,
as Figure 4.43 shows. You might want to include the date and time stamp to your market trends report as it
moves through the development process. This can help you keep track of the edits that are made in the
document at various stages of writing or through the different departments at WorldCorp that will contribute
to the report. You could include this information as a header or footer in your document. Note that if you use
the Date & Time command, it will update to the current date and time, even if you did not make any changes
to the document.
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Figure 4.43 You can choose among different date and time formats, depending on the style of your company and what kind of
information you want captured. (Used with permission from Microsoft)

Inserting an Object
The final item in the Text command group is Object. An object is anything that is inserted into the document
rather than simply typing text. An object can be a wide variety of things, including graphics (WordArt), images,
charts and graphs from Excel, links to a web page, files from a program such as Adobe Reader, among others.
When you insert an object, Word will create a link to the object and you will be directed to this object when you
click on it; it will open in a separate window. This action might be helpful if you want to direct someone to a
file, such as an Excel spreadsheet, without having to actually include all the information in the Word document.

You can also insert an object that links to an outside source, such as a web page. The Object tool can also take
text from another file and place that in the current document. This can help you save some time, instead of
copying and pasting information from one document to the next. You might consider using this feature for the
market trends report because you will have different departments working on different sections of the report.

To insert an object, go to the Object tool in the Text command group on the Insert tab. There are two options
in the tool: Object and Text from File, as shown in Figure 4.44. When Object is chosen, a dialog box appears, in
which you can select all sorts of file formats if you were to Create New, or Create from File. Create New means
that you will create the file within the Word document in the chosen format such as Excel or Adobe. You could
also choose to have the link to the object as an icon in your document rather than the first page of the inserted
object being displayed. Create from File means that you can use an existing file to insert into the document.
The Integrating Applications chapter covers inserting objects in more depth, as it includes the integration of
Office programs.
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Figure 4.44 (a) You can insert an object or use text from another file in your document. (b) When you choose Object, you can create a
new object or use an existing file. (Used with permission from Microsoft)

Symbols Command Group
The Symbols command group is also part of the Insert tab. A symbol is a special character not found on most
keyboards, and includes characters such as currency symbols, en dashes and em dashes, arrows, Greek letters
(often used in economic or financial math), and many other characters. Figure 4.45 shows some of the
character choices available in Word.
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Figure 4.45 You can use the Subset combo box to look for the category you are looking for, to help narrow down your choices. (Used
with permission from Microsoft)

The Equation command is for inserting mathematical equations into the document. The drop-down arrow by
the Equation tool allows you to see some built-in equations from common calculations, as Figure 4.46 shows.

Figure 4.46 Several built-in equations are available in the Equation tool. (Used with permission from Microsoft)

You can also choose to insert a new equation if none of the built-in options meet your needs. When you insert
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the equation (either new or built-in), a new tab appears on the ribbon called Equation. Here, you can choose
the math notation of your choice and build your own equations. This is especially useful for economic and
finance research, engineering reports, or any other kind of quantitative discipline or science. You can even
draw the equation that you want to insert, and Word will recognize the numbers and symbols. Select Ink
Equation from the Equation drop-down menu. This allows you to use the mouse or your finger to draw the
equation symbols if your touch screen or pad allows this (Figure 4.47).

Figure 4.47 (a) The Equation tool can be helpful in making your documents look professional when you need to incorporate
mathematical equations. (b) Word has the ability to read your drawings and recognize the symbols. (Used with permission from
Microsoft)

4.3 Managing Long Documents in Microsoft Word

Learning Objectives
By the end of this section, you will be able to:

• Use the tools in the Pages command group
• Utilize Format Painter to apply formatting in a long document
• Use some of the tools on the References tab
• Create bookmarks for document navigation

Long documents underscore the importance of good navigation tools. Imagine working through a 200-page
report, only to have to scroll endlessly through chapter headings to find what you are looking for. This is why
tools like cross-references, bookmarks, tables of contents, and tables of figures are so important. They allow
you to quickly access different parts of your document, as does the document outline, available in the
Navigation pane.
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In a business setting, these navigation tools are especially important. Think about your market trends report
for WorldCorp. The high-level executives reading your report will need to be able to quickly glance at the table
of contents and read a few pages of the report, without having to scroll or flip through many pages of text. In
fact, they likely don’t need to read the whole report; they will read the executive summary and skip around the
report to graphs that interest them. (The executive summary is a short overview at the beginning of the report
that highlights the main points of a long report.)

This section discusses the different command groups and tools that make long documents more user-friendly.

The Pages Command Group
The Pages command group is on the Insert tab, and it contains three commands. The most used one is Page
Break; this command allows the user to finish writing on the current page and start writing on a new page.
(You can also access many of these same tools on the Layout tab in the Page Setup command group.) Adding a
page break can be particularly useful at the end of a chapter or section. To insert a page break, place the
cursor where the break will be (the start of the new page), and select the Page Break option. You may also just
use the keyboard shortcut Ctrl+Enter to place a page break. If you turn on the ability to view hidden
characters, you can see exactly where the page break is on your page (see Figure 4.48). You can also view it
easily in the Print layout option on the View tab. Here, we can add a page beak at the end of each major
section of the market trends report.

Figure 4.48 Page breaks make the subsequent text start on the next page. Here, it was placed at the end of the Introduction/
Executive Summary, so that the Industry and Market Analysis section started on a new page. (Used with permission from Microsoft)

There is another command, Blank Page, which is not as commonly used as Page Break, but can be impactful in
long documents such as reports and textbooks. These intentionally blank pages are added to provide a sense
of closure or finality before a new chapter or section begins; they make a bigger impact than just a page break
because they leave a full page empty. This convention is more often used in the publishing world when
needing to, say, start a new chapter on a right-hand page.
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To insert a blank page, go through the same steps as inserting a page break: Put the cursor where you want
the blank page to be, and select the Blank Page icon.

The last command to discuss in the Pages group is Cover Page. Adding a cover page, or title page, is a
common practice for long documents. It is an informative page that contains basic information about the
report, such as the title, authors, publishing date, and the department or/and division. Some companies or
organizations follow specific guidelines about title pages; formally written reports that follow the Chicago
Manual of Style, for instance, do not include any graphics, and the components must follow a set alignment
and format. Yet many business reports do not strictly follow any set manual of style, or may simply follow their
company’s brand guidelines. It is appropriate in many business settings to use graphics, such as a logo or
photograph, on a title page, as in Figure 4.49.

Insert a title page to your market trends report. To insert a title page, select the drop-down menu of the Cover
Page command, and choose a design. Word offers many different options for layouts, fonts, colors, and styles.
Just update the text and add an image, if applicable.

Figure 4.49 Word comes with some built-in styles and layouts for cover pages, some of which include spaces for graphics. (Used with
permission from Microsoft)

Format Painter
Another tool in Word that helps manage long documents is the Format Painter. Format Painter is a command
on the Home tab. It is used to copy formatting from another document or section of the same document. This
can be useful when you have formatting in one section of the document that you want to copy over to another
section, saving you the time and effort of having to format the new document or section again manually.

To use the Format Painter, select the area of the document from which you want to copy the formatting, then
choose the Format Painter command. If you single-click the Format Painter, it will only allow it to be used once.
To use it multiple times, double-click the Format Painter. It can then be used until you click the Format Painter
icon again or press the Esc key. The mouse pointer will change to a little brush, then with the brush, you select
all the areas you want to apply the formatting to. Word will automatically mirror and apply the new formatting.
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If the document has a lot of chapters, if the document outline is multilevel, or if there is a lot of different
elements in the previous document, then the Format Painter will not work perfectly. You might need to fix
some pages or areas of the newer document. For example, when you have bullets, the Format Painter will not
copy over the bullets, but instead will only copy the formatting of the text.

Format Painter is a useful tool for when you want a whole document to have the same formatting, particularly
if that document contains copied and pasted text from multiple sources or collaborators. In Figure 4.50, we
selected a phrase from the first paragraph, then chose Format Painter and used the brush to select the entire
target paragraph. As you can see, the selected text now has matching formatting to the header.

Figure 4.50 The Format Painter is useful for applying multiple types of formatting to a single chunk of text. (Used with permission
from Microsoft)

References Tab
The References tab is for working with citations and the front/back matter of books. This is an important tab
for anyone who is creating a document with many sources, such as a journal article or economic report. It is
also helpful when dealing with long documents that include many sections such as the market trends report.
Managing a table of contents, a citation list, or a bibliography manually can be unwieldy, and, fortunately,
Word provides lots of tools to help users keep these organized and looking professional.

Let’s review the different command groups on this tab. The first command group is the Table of Contents
group. This contains tools for helping the user insert or modify a table of contents. The Footnotes command
group is for managing and inserting footnotes and endnotes. The Research command group has two useful
tools. The Search tool can be used to find information, definitions, and images online. The Researcher tool
allows you to search for sources for information contained in the document. You can then insert the citation or
link to the source using the tool. You simply click on the Research tool and type the search term or phrase into
the navigation window. The Citations & Bibliography command group is for inserting, formatting, and
managing your references. The Captions command group is for when you are working with figures and tables
and want to add captions to later create a summary of the figures in your document. The Index command
group is for building an index, like what you would find at the end of a textbook. The Table of Authorities is a
command group that lawyers use when they need to cite cases and statutes. This next section walks through
some of the commands you might find most helpful in this tab.

Table of Contents
If your document is formatted properly, Word will automatically generate a table of contents for you. You can
select from a few different styles, which is useful for ensuring that your table of contents matches the look and
feel of the rest of your document. Let’s examine the requirements for a table of contents and what you need to
have in your document to create a good one.
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Headings for Tables of Contents

In the Creating and Working in Documents chapter, we discussed how to insert headings and why these are
important for navigating long documents. We also mentioned how to access your document outline in the
Navigation Pane. Recall that as you insert different levels of headings (H1, H2, H3, etc.), the Navigation Pane
will read the document automatically and display them for you in the form of a document outline. This is
particularly useful for long documents, as you can see the outline of the entire document without having to
scroll all the way through hundreds of pages of text.

The reason these headings are relevant to generating a table of contents is that the table of contents uses the
headings in the same way as the document outline. When you set up your H1s, H2s, and H3s, Word will
automatically use those to generate a multilevel table of contents.

Section Breaks for Tables of Contents

In the chapter on Creating and Working in Documents, we also briefly reviewed how to insert section breaks
and why they are important. Recall that there are two types of section breaks: continuous section breaks and
page breaks. Continuous section breaks are used when you want a new section but want to remain on the
same page. They can also be used if you want to have different margins on two different areas of the same
page, or to add columns for one section of the text. Page breaks, however, begin a new section on the next
page. These do everything the continuous section break does, but simply adds a new page. These are useful
for when you want to start a new chapter, for example.

Both types of section breaks are important for generating your table of contents. When you create a table of
contents in Word, the program automatically generates page numbers based on the page numbers in your
sections. You may have continuous page numbering throughout your document, and so in this case, the table
of contents will not be concerned with your sections. However, if there is different page numbering in different
sections, the table of contents will reflect this.

Inserting a Table of Contents

You need to have added your headings and sections for the table of contents to work. In the market trends
report, we formatted the headings for each major section and the subsections in those sections. Recall the
headings were formatted using the Style command group on the Home tab. To insert a table of contents using
the headings we have defined, go to the first page of the first section. For the report, we want to include the
table of contents after the cover page. So we will go to the Introduction/Executive Summary heading. Leave a
blank line before the section heading by pressing Enter to move the first section downward as least one line,
as shown in Figure 4.51. This will determine the placement of the table of contents. It should appear before
the actual report starts, so before the first section of the document. Now, go to the References tab, choose the
drop-down menu called Table of Contents, and choose any of the preset formats. Choose Automatic Table 2 for
the market trends report; it will look like Figure 4.52. Conveniently, the table of contents has clickable
hyperlinks by default, meaning that you can press Ctrl on the keyboard while clicking the mouse on any part of
the table of contents and it will take you to that part of the document.
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Figure 4.51 Creating a hyperlinked table of contents in Word allows the reader to click right to each section, directly from the table of
contents. (Used with permission from Microsoft)
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Figure 4.52 The table of contents is arranged using the headings we defined when composing the document. (Used with permission
from Microsoft)

Note that any time you update your document, and add or delete any headings, you will also need to update
your table of contents. You can do this simply by putting your cursor anywhere on the table of contents and
selecting the Update Table button. This will automatically update your headings and page numbers.

Footnotes and Endnotes
A footnote is a way to add notes to a document, and/or a way to cite a reference. A footnote appears at the
bottom of the page where the reference occurs. When you add a footnote, a small superscript number or
symbol will appear above your text, and then the footnote will automatically be added to the bottom of the
page. This is an easy way to add a reference to a source or other general notes. For example, the author may
want to add a related thought or comment about the text and have it appear at the bottom of the page in the
form of a footnote, so that the reader can quickly and easily read it.

An endnote is similar to a footnote, except that the note appears on a page at the end of the document.
Endnotes are typically part of the back matter. They are useful for when you want to have all of your references
and comments in one place. However, having them at the end of the document makes it harder for the reader
to read them in the moment.

To insert a footnote or endnote, place your cursor at the end of a sentence, and choose the Insert Footnote or
Insert Endnote command on the References tab. Word will automatically take you to the bottom of the page
(for a footnote) or the end of the document (for an endnote) and add a short line to indicate where the
footnote/endnote space will be.

For the market trends report, we need to add a footnote to provide the reference for the information about
laptop sales in the industry. We will place the cursor at the end of the sentence (at the end of the word “billion”)
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as the place where the footnote notation will be inserted (Figure 4.53). The actual footnote will be inserted at
the bottom of the page as a blank footnote. You can then insert the appropriate citation for the footnote. In
this case, the website for the reference was copied and pasted into the footnote (Figure 4.54). To format the
text in the footnote, click on it twice, and the whole line will be selected, then right-click on it and select Style.
You can change the font type if you click on Modify. You can further change the footnote type, as there are
many standard layouts of how to present a footnote, as Figure 4.55 shows. Enter the citation/text for the
footnote.

Figure 4.53 The superscript “1” indicates that there is a footnote at the bottom of the page. (Used with permission from Microsoft)
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Figure 4.54 Footnotes will be numbered in the body of the document and numbered at the bottom of the page where the footnote
is inserted. Include the citation for the reference in the footnote. (Used with permission from Microsoft)
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Figure 4.55 The style of the footnote font can be formatted using a wide variety of built-in styles. (Used with permission from
Microsoft)

An endnote will look exactly the same as a footnote. The only difference is that it is at the end of the document
instead of at the bottom of the page. For the market trends report, we could use endnotes to identify the
departments that contributed the specific information in the sections or to add additional context to a
statement in the report.

For both footnotes and endnotes, you have the option of changing the numbering system. Word will
automatically use numbers (for footnotes) or Roman numerals (for endnotes), but you can change this.
Double-click to select the endnote or footnote, then right-click it to activate the context menu, and select Note
Options where you can change the numbering format. If you want to change the font or layout, select Style
from the context menu.

Table of Figures
A table of figures is similar to a table of contents, except that instead of listing your document’s headings and
section breaks, it lists the captioned figures, such as tables and images. This is useful in documents with a lot
of statistical analyses, for instance, in which readers will need to easily and quickly find specific graphs or
charts. It can also be useful in documents like business reports, where you might want to have a list of the
different data tables. Like a table of contents, there are a few requirements that must be met before the table
of figures can be generated.

Captions

For Word to automatically generate your table of figures, you need to insert captions for each of them. Let’s
first insert a summary chart of data using the skills learned earlier in the chapter into the market trends
report. To “caption” a figure, select the entire figure, then choose Insert Caption (see Figure 4.56). In the dialog
box that appears (see Figure 4.57), the caption is automatically generated to be “Figure 1,” but you can rename
it to whatever you like. There are also options where you can choose the placement of the caption. Do the
same for all the figures in your document. Once all your figures are captioned, then you can insert your table
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of figures.

Figure 4.56 You must use the Insert Caption tool to make sure all of your captions will appear in the table of figures. (Used with
permission from Microsoft)
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Figure 4.57 (a) You can use the default text for captions or type in your own information. (b) The caption is placed below the table in
this example, and is formatted according to the Style formatting used for the rest of the document. (Used with permission from
Microsoft)

Inserting a Table of Figures

As with inserting a table of contents, first go to the top of your document where you will want your table of
figures to appear. Typically, a table of figures is placed right below the table of contents. Now that we have
labeled our table with a caption, we can create a table of figures to see how it works. As seen in Figure 4.58,
insert a page break, and choose the Insert a Table of Figures command from the References tab. Word will
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automatically “read” the existing captions, and a table of figures will be generated.

To make your document neat and organized, add the title Table of Figures on top, and insert another page
break to separate the Table of Figures page from the beginning of the document.

Figure 4.58 You can change some formatting options when you choose Insert Table of Figures. (Used with permission from
Microsoft)

Figure 4.59 The table of figures should look similar to a table of contents, but without the multilevel tiers. (Used with permission
from Microsoft)
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Linked Bookmarks
Another helpful tool for navigating long documents is the bookmark. You can add bookmark links throughout
your document for better navigation. Place the cursor where you want the bookmark to link up to—a section
header, for example, or the beginning of an important paragraph—and go to the Insert tab and click
Bookmark. In the dialog box, type a name for your bookmark Figure 4.60. In this case, we chose to bookmark
the start of the body text. Now, select a word that will link up to the bookmark, right-click on it, and select
Hyperlink from the context menu. The same hyperlink dialog box will appear, but this time select Place in This
Document. Click on the bookmark you just made, and then click OK; the link will be set Figure 4.61. Conversely,
if you want to remove a bookmark from Word, click the Bookmark command in the Insert menu, locate it, and
then select Delete.

Figure 4.60 When creating Bookmarks, make sure to choose a descriptor word that has meaning to the content you are designating.
(Used with permission from Microsoft)
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Figure 4.61 The bookmark is now set. Linking a section of text to a bookmark eases navigation through a long document. (Used with
permission from Microsoft)

Another reason to use bookmarks is to help digital readers of your document navigate back to important
sections of the document while they read. For example, you can add a link at the end of each chapter that says,
“Go to Table of Contents.” To do this, first place a bookmark in front of the table of contents as Figure 4.62
shows. To locate the roster of bookmarks, click the Bookmark command on the Insert tab, and then click Go to.
If you want to relocate the bookmark, place the cursor where you want the bookmark to be relocated to, then
open the Bookmark dialog box, click the original bookmark’s name, and then click Add. This will update the
new location.
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Figure 4.62 When you create the bookmark at the table of contents, you will be able to see it in your roster of bookmarks. (Used with
permission from Microsoft)

Next, move to the area of the document where you want to link the table of contents. Go to the Insert tab and
select Link. From the Insert Link window, choose the bookmark you just created. In the text box that appears,
write the text you want readers to see (“Go to Table of Contents”), then choose Place in this Document as
shown in Figure 4.63 and Figure 4.64. Choose the placement in the document and click OK.
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Figure 4.63 Remember to name your hyperlink something that will be helpful to the reader. (Used with permission from Microsoft)
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Figure 4.64 Readers can simply click on the inserted hyperlink to go straight to the table of contents. (Used with permission from
Microsoft)

SPOTLIGHT ON ETHICS

Academic Integrity

When you are creating documents, especially long documents that might include research or data that has
been created by others, it is essential that you give proper credit. You might have encountered citing
sources when completing a research report for a class. We have an ethical obligation to cite sources to
acknowledge the work of researchers and their findings from the studies. If proper citation is not given to
material that is not your own, this is called plagiarism. Plagiarism is part of a broader category called
“academic integrity.” Academic integrity goes beyond giving credit for work that is not your own, but it also
covers issues such as cheating on a test or paying to have someone create a research report for you.

This is not to say that we cannot use information from others to support our thoughts or to help us develop
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a new understanding of the material. Instead, it means we have to acknowledge that the information came
from another source and we are using their research in our work. From the researcher’s standpoint, a
measure of the quality of the research is the number of times the work is cited by others. This is similar to a
product online having a large number of five-star reviews. The more the research is cited by others, the
higher the credibility of the information.

4.4 Google Docs: Enhanced Formatting Features

Learning Objectives
By the end of this section, you will be able to:

• Insert and format page numbers
• Insert and modify a header/footer
• Insert and format a list

The market trends report has been composed thus far in Microsoft Word. However, it could have just as easily
been composed in Google Docs. Docs has many of the same features that we see in Word. Some people prefer
working in Docs as it can be more user-friendly than Word, particularly its features involving collaborating with
others.

Many of Docs’s advanced formatting features are similar to those in Word. Just like in Word, you can insert and
format page numbers, headers, footers, and multilevel lists. Some customizable features that are present in
Word may not be present in Docs, but some users might prefer fewer choices, as it facilitates a more user-
friendly program. Here, we will revisit many of the tools we covered earlier and apply them to the market
trends report in Docs. We will start with an earlier draft of the report where we began the chapter (Figure 4.2).

MAC TIP

Mac computers come with Safari as the default internet browser. While Docs works just fine in Safari, it
functions better in Google Chrome. Chrome is also a Google product and, as such, comes with integrations
that work seamlessly with Docs, such as browser extensions and notifications, as well as supports Chrome-
only features, like voice typing.

Page Numbers
The tool for placing page numbers into a Google document has fewer customizable formatting options than
the tool in Word. There are only two page number styles: top right or bottom right. These are both available in
the Insert menu. Let’s start with the market trends draft and add page numbers (Figure 4.65). If you select
More options, a few more customization options appear. You can choose to have your page numbers start
counting from the second page of your document, which could be useful if your first page is a cover page or a
table of contents. You can also start your page numbering at a certain number (i.e., other than the number 1),
as shown in Figure 4.66. The page number is always placed in the header or footer.
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Figure 4.65 Although the default page number doesn’t seem to allow the user to insert the number on the left or in the center, you
can align it later using the alignment tools in the action bar. (Google Docs is a trademark of Google LLC.)

Figure 4.66 You can choose to have the page numbering continue from a previous section, which can be useful when creating long
documents with multiple sections. (Google Docs is a trademark of Google LLC.)

One convenient feature of Docs is its ability to easily add a page count to your page number. First, you insert
your page number, then manually type the word “of” after it (Figure 4.67). Then, go to the Insert menu, click
Page numbers, and select Page count (Figure 4.68). This will add a field that gives the total number of pages in
the document. Now, your page count should appear as “# of #” (e.g., “1 of 5”) (Figure 4.69).
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Figure 4.67 Use the Insert menu to insert page numbers. (Google Docs is a trademark of Google LLC.)

Figure 4.68 The Page count feature allows the reader to see how many total pages there are in the document or that section.
(Google Docs is a trademark of Google LLC.)

Figure 4.69 Adding a page count to your footer helps the reader know how far they’ve read. (Google Docs is a trademark of Google
LLC.)
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Headers and Footers
You can add headers and footers to your document in Docs. The Headers & footers command is also located in
the Insert menu. Once you have added your header or footer, you can choose to further configure it by
choosing Options, the blue command that is located on the header or footer itself. This Options button opens
to a drop-down menu with a few choices. If you select Header format or Footer format, you will see a dialog
box with the option of applying certain header/footer settings to a section of the entire document, as seen in
Figure 4.70. You can also control the height of each header/footer in inches, as well as choose to not have the
header or footer appear on the first page. This latter choice is useful in documents for which you have a cover
page. Simply tick the box Different first page. When you are finished configuring the headers/footers, select
Apply.

You can edit and format the text contained in the header/footer as you would text in any other part of the
document: by manually changing the font type; applying bold, italic, or underlined format; adding an image;
or choosing a different alignment.

Figure 4.70 Once the header or footer is inserted, you can use the formatting tools on the action bar, such as centering the header,
just like with page numbers. (Google Docs is a trademark of Google LLC.)

You can also add a horizontal line that visually separates your header or footer from the rest of the text. This
can add a neat and professional look to your document. Just put the cursor where you want the line, go to the
Insert menu, and choose Horizontal line, as shown in Figure 4.71.
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Figure 4.71 Insert the horizontal line via the Insert menu, just as you did for the header or footer itself. (Google Docs is a trademark
of Google LLC.)

Figure 4.72 The horizontal line creates a nice separation between the document and the header. (Google Docs is a trademark of
Google LLC.)

Once you have made all your adjustments in the header/footer, just place your cursor anywhere in the body of
the document to exit from the header/footer editing mode, or, alternatively, press the Esc (escape) key on the
keyboard.

Remember that using the View menu, you can change the preview of the header/footer. Make sure that you
are viewing the document with Print layout checked so that you can view your headers and footers. If you
choose to work without the Print layout option checked, you won’t see the headers/footers.

Lists
The chapter Creating and Working in Documents briefly discussed how to insert a bulleted or numbered list in
Docs. In this section, we will use the document outline we used earlier in this chapter to create a multilevel list
in Docs.

To access numbered, lettered, or bulleted lists, go to the Format menu and choose the Bullets & numbering
option. This will open a drop-down menu, where you can see your choices for customization. You can also
access lists (numbered and bulleted) from the action bar (Figure 4.73).
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Figure 4.73 There are two ways to insert a list into your Doc: through the Format menu, or via the action bar. (Google Docs is a
trademark of Google LLC.)

Because adding lists to your document is generally done for organization and visual purposes, you want to
make sure they are easy to read and showcase the most important information. For all list types, you can
increase or decrease the space between the lines. This can help with readability. To do this, select the whole list
and go to the Line and Paragraph spacing command and choose a wider or narrower space, as shown in
Figure 4.74. You can also change the color of the text, which could be useful for helping your list stand out
from the rest of your document. Select the text you want to format and use the action bar command for Text
color.
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Figure 4.74 In Docs, all types of lists can be formatted just like normal text. (Google Docs is a trademark of Google LLC.)

Numbered and Lettered Lists
To create a multilevel list, choose the style of list you want, then use the Tab key to indent your lines. We want
to create an outline of the headings and subheadings for our marketing trends report. This will give
collaborators an idea of the format for the report, as well as allow us to use the outline to allocate sections to
certain people or departments to fill in the content. For example, Figure 4.74 shows a straightforward
Numbered list from the Insert menu, but Figure 4.75 shows one with multiple levels. You can create these list
levels by using the Tab key, which will increase the indent on the line, creating a sublevel. If you want a further
sublevel, press the Tab key twice, making it a subcategory of the category. You can also do this by using the
Increase indent command in the action bar.
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Figure 4.75 Multilevel lists are helpful for showing hierarchies and how categories are structured. (Google Docs is a trademark of
Google LLC.)

Bulleted Lists
Unlike numbered and lettered lists, bulleted lists do not have an obvious sequence. Docs offers different types
of bullets to indicate the multilevel layers, which you can customize (Figure 4.76).

The process for creating a multilevel bulleted list is the same as for numbered and lettered lists: To create
another sublevel below your current level, press Enter to go to the next level, then press Tab or use the
Increase indent command to add it. In Figure 4.77, you can see the result of the new multilevel list using
bullets instead of numbers. The best practice is to use bulleted lists only if they are no longer than half a page;
after that, a numbered list is more effective. You can change the bullet type by clicking in the bulleted list,
going to the Format menu, then choosing List options from the Bullets & numbering tool (Figure 4.78).
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Figure 4.76 Several choices are available for multilevel bulleted lists. (Google Docs is a trademark of Google LLC.)

Figure 4.77 Rather than using a numerical order, the bullets change for each level when you use the Tab key. (Google Docs is a
trademark of Google LLC.)
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Figure 4.78 Docs offers a lot of customizability for its bulleted lists. (Google Docs is a trademark of Google LLC.)

Checklists
A checklist is a useful type of list option in Docs that has several everyday applications. You may use them to
make a printed to-do list, such as a list of tasks or errands to carry with you when you are away from a
computer. Or you may want to add a checklist to a guidelines document for other people to be able to print
out and reference, or use digitally. For example, it could also be useful for the multiple rounds of editing that
will be needed for the market trends report. As the document progresses through the various departments for
editing and revision, each department could tick a box when their round is complete, indicating that the
document has been approved by the various departments.

A checklist is inserted the same way as any other type of list, except that it is technically listed as a subtype of a
bulleted list in Docs. That is, you follow the same process as adding a bulleted list, but then just make sure to
choose the option that shows the checklist. As you can see in Figure 4.79, the to-do checklist is complete.
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Figure 4.79 A checklist can be printed and used with pen and paper, or the boxes can be checked digitally. (Google Docs is a
trademark of Google LLC.)

4.5 Working with Graphics and Text Tools in Google Docs

Learning Objectives
By the end of this section, you will be able to:

• Insert special characters and equations
• Insert and modify an image
• Use the Google Drawings tool
• Insert and modify a table

Google Docs has many of the same graphic-insertion tools as Microsoft Word, and often functions in a similar
way. You can add tables, images, and WordArt, just like in Word. But Google also offers an embedded app
called Google Drawings that lets the user have a little more freedom with designing charts and shapes. It is
also seamlessly connected to Google Photos and Google Drive. This section will delve into these tools in more
depth.

Inserting Special Characters and Equations
Docs has a way for the user to insert special, nonstandard characters and symbols directly into the text. In
Docs, this function is accessible from the Insert menu. However, Google has some interesting functionality that
Word doesn’t have, such as drawing symbols, a higher degree of searchability, and automatic replacement.

Special Characters and Symbols
From the Insert menu you can see Special characters, as shown in Figure 4.80. You can insert any of the
characters you see on the first screen, just by selecting one in Figure 4.81. But you may need a character that
doesn’t appear here. One way to find a character is to look by category. Choose the Symbol combo box on the
left and select another category. Options are Punctuation, Numbers, other languages, and many other groups,
as you can see in Figure 4.82. These are top-level collections of character types and include lots of special
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characters that are more than just symbols.

When you change the top-level collection to be, for instance, Emojis, the special character selections will
change, as shown in Figure 4.83.

Figure 4.80 Special characters are inserted from the Insert menu. (Google Docs is a trademark of Google LLC.)
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Figure 4.81 The special characters dialog box offers a number of different choices, as well as the option to draw a symbol or search
by keyword. (Google Docs is a trademark of Google LLC.)
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Figure 4.82 When selected, the Symbol combo box opens up a long list of different categories. Each category has a different set of
characters and symbols. (Google Docs is a trademark of Google LLC.)
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Figure 4.83 Here, the category selected from the combo box was Emoji. You can see that only emojis are shown in the main window.
(Google Docs is a trademark of Google LLC.)

If you do not have time to look through the categories for a character, you can draw the character and Docs
will search for one that looks similar to your drawing. If your character cannot be located through the drawing
tool, you can type a description in the query box.

If you have symbols or special characters that you use frequently, then you could add these symbols to the
Automatic substitution roster. This roster allows you to quickly and easily add in a symbol or special
character without having to access the Special Characters menu. For example, whenever you type the word
“pi,” Docs will substitute the pi symbol for the word.

The Automatic substitution tool is in the Tools menu, under Preferences. In the dialog box that appears, select
the Substitutions tab and add in your custom substitution, as Figure 4.84 shows.
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Figure 4.84 Adding symbols to the Automatic substitution tool can make it easier to insert frequently used special characters.
(Google Docs is a trademark of Google LLC.)

Equations
If you want to insert math notation or equations, go to the Insert menu and navigate to the Equation
command, as shown in Figure 4.85. As you do, the Equation toolbar will appear directly below the main toolbar.
From there, you can access the different groups of mathematical operations, brackets, Greek letters, and other
math notation. This toolbar allows you to write custom math equations.

Figure 4.85 Use the Insert menu (a) to access the Equation toolbar. This toolbar (b) has an easy-to-use interface for inserting
mathematical notation, such as Greek letters. (Google Docs is a trademark of Google LLC.)
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LINK TO LEARNING

To access all possible symbols for a given font, you might need to get the Unicode value. Every symbol has
its own unique numerical identifier, called the Unicode value. Visit this Unicode Lookup website
(https://openstax.org/r/78UnicodeLookup) to see different Unicode values.

Inserting an Image
Docs has a few more interactive options than Word when it comes to inserting images. Because Docs is a
Google product and you are typically online when you are using it, there are some integrations with other
Google services, like Photos and Drive, that make inserting your own images easy. First, go to the Insert menu,
and select Image. As seen in Figure 4.86, you have a number of different options: You can choose to get the
image from your computer, do a Google Image search, insert a photo from your Drive or your Photos account,
type in a web address where the image is located, or insert an image from the camera on your laptop/tablet/
smartphone. This huge array of options allows for a lot of personalization. Keep in mind copyright protections
for images that you might find on the internet. Be sure to cite properly when using images that are
copyrighted.

Figure 4.86 Docs features many different, integrated ways of inserting images into your Doc. (Google Docs is a trademark of Google
LLC.)

Let’s revisit the market trends report and insert an image of a world map that you can use to show where
WorldCorp’s major markets are located. First, place the cursor where you would like the image inserted. You
will insert the image at the end of the Industry and Market Analysis section, so you will want to place your
cursor at the beginning of the next blank line. Go to the Insert menu and choose Search the web, as shown in
Figure 4.87. Select the image you like and click Insert (Figure 4.88).
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Figure 4.87 When you select Search the web, a navigation pane will open on the right side of the screen. Use descriptive search
terms to get a narrower result for what you need. (Google Docs is a trademark of Google LLC.)

4.5 • Working with Graphics and Text Tools in Google Docs 299



Figure 4.88 The image will be inserted at the location of your cursor in the document. (Google Docs is a trademark of Google LLC.)

If you want to edit the image, simply select it with your cursor; Docs gives the user many ways and options for
modification. You will first notice that when you have the image selected, a small toolbar will appear below the
image. From here, you have options for text wrapping, sizing, and rotating, as Figure 4.89 presents. If you
want even more configuration options, choose Image Options from the action bar, and a sidebar will appear.
From here, you can modify all the above options with more detail, such as specific margin sizes. The action bar
now displays, on the right side, tools for accessing image borders, cropping the image, and replacing the
image.
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Figure 4.89 Select Image options from the action bar when the image is selected for additional formatting options. (Google Docs is a
trademark of Google LLC.)

Using the Google Drawing Tool
Google’s Drawing tool is an interactive tool that allows the user to create custom shapes and insert preset
shapes. Drawings is its own application that can be accessed either by going to Google Drawings
(https://openstax.org/r/78GoogleDraw) or through applications such as Docs. You can create drawings and
save them to your Drive. Creating custom shapes or drawings can be particularly useful if you want to insert a
specific shape or combination of shapes that isn’t available in the roster of preset shapes. The Drawing app
also gives the user the option to insert standard preset shapes or WordArt.

Creating and Modifying Custom Drawings
To create a new drawing, go to the Insert menu and select Drawing. Docs will open a dialog box to another
app called Drawings, as shown in Figure 4.90. Through the interface, you can add straight lines, curved lines,
WordArt, freehand drawings, and more. This can be a particularly useful tool if you are working on a computer
with a trackpad or touch screen. You can also change the color and thickness of the lines in your drawing.
When you are finished with the drawing, just select Save and Close, and your drawing will appear in your Doc
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where your cursor is. You can change the position of the object by aligning it using the action bar align tools,
or you can resize it by using the mouse over the edges of the object (Figure 4.91).

Figure 4.90 Drawings gives you many options for formatting text and adding shapes to visually enhance your document. (Google
Docs is a trademark of Google LLC.)

Figure 4.91 Once you insert the drawing into your document, you have further options for placement and sizing. (Google Docs is a
trademark of Google LLC.)

If you want to insert an existing drawing, you need to have uploaded it first to Drive, as Figure 4.92 shows. To
do this, go to the Insert menu, choose Drawing, then From Drive. You will then have to locate the item in your
Drive and choose whether you want to Link to source or Insert unlinked. Link to source means that you are
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creating a live link from your original Drawing in your Drive, so that your drawing will be automatically
updated if you change the original drawing. Insert unlinked means that you are inserting a static copy of your
drawing into your current Doc.

Figure 4.92 You can link the drawing to the original file, then it will update if you change the Drawings file. (Google Docs is a
trademark of Google LLC.)

Inserting Shapes
When you are creating new drawings, you might instead want to use the preset shapes. Drawings has
numerous arrows, circles, squares, callouts, equations, and more, which you can select and add via the
Drawing app, as shown in Figure 4.93. While on the canvas, these can be resized and modified in numerous
ways.

Drawings also has other commands, such as adding lines and text boxes, the fill paint bucket, line width
controls, and font color and type modifications (plus all the standard font formatting commands)—all
accessible from the Drawing app toolbar, as shown in Figure 4.94. For the market trends report, your
supervisor has asked that you create a graphic to show the flow of the report from department to department.
The report will originate with the marketing department, then move to the finance department, and finally to
the operations department. We can use Drawings to construct such a process flowchart. It is worth noting that
in Docs, you need to construct your process flowchart manually, piece by piece, whereas in Word, you can use
the preset SmartArt charts and shapes to create one. This means that creating graphics such as flowcharts and
organizational charts is a bit more labor-intensive in Docs than it is in Word. You will learn more about this in
the section on Inserting Charts.

To create your process flowchart, you first need to insert three rectangular shapes, one for each step in the
process (i.e., each of the departments). Then, you will need two arrows and three text boxes. To speed up the
process, you can copy the shape you inserted and then paste it in the Drawings window. This works for lines
and text boxes as well. Let’s change the fill color to a darker blue so that it is in line with the WorldCorp brand.
From the tool menu, select Shape (to insert the rectangles) and Line (to insert the arrows). As you are lining up
the images, Drawings will give you red guidelines to show when the images are in line with each other.
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Figure 4.93 Docs gives you many different shapes options to work with (a), which can come in handy when creating your own
custom flowcharts (b). (Google Docs is a trademark of Google LLC.)
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Figure 4.94 You can make the fill color disappear by using the Transparent option. (Google Docs is a trademark of Google LLC.)

Inserting WordArt
Google’s WordArt feature is similar to the one in Word: It is a way to add stylized text to your document. In
Google, this feature is available through the Drawing app. When you are in the Drawing app, go to the Actions
drop-down menu and select WordArt. A small box will appear, in which you type your text. If you want to
change the color, font type, transparency, borders, and other elements, you can do so using the Drawings
toolbar commands. Press Enter to finish (see Figure 4.95).
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Figure 4.95 In Docs, WordArt is part of the Drawings app. You can apply all the same formatting as you would to a shape or custom
drawing. (Google Docs is a trademark of Google LLC.)

Inserting Charts
Drawings has many shapes and connectors so that you can build your organizational charts or flowcharts from
scratch. Unlike Word, which comes with the SmartArt options for preset flowcharts, organizational charts, and
more, Docs requires that you make your own charts. This can, however, lead to more customization and
personalization of the shapes and types of charts you can make in Docs. You can see in Figure 4.96 how to
create an organizational chart from scratch by adding boxes, filling them with a light blue color, and
connecting them with lines. This is just like the simple process flowchart we made in the section on Inserting
Shapes, except the boxes are arranged a little differently.
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Figure 4.96 There are ways to make hierarchy charts in Drawings using both shapes and lines to connect the levels. (Google Docs is a
trademark of Google LLC.)

Tables
Inserting and modifying tables in Docs is similar to the same process in Word. To add a table, go to the Insert
menu, navigate to Table, and hover your cursor over the number of rows and columns you want, as shown in
Figure 4.97.
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Figure 4.97 The maximum number of columns and rows in a table is 20 x 20. (Google Docs is a trademark of Google LLC.)

From this menu, the maximum width and length of a table is 20 x 20 cells, but you can add more columns and
rows later by using the Insert column left/right or Insert row above/below tools, as shown in Figure 4.98. This
menu is accessed by right-clicking when your cursor is anywhere in the table. You may also merge cells by
selecting the cells and right-clicking to show the context menu and choosing Merge cells. This functionality is
useful when you want to merge cells in the top row to create a header row, for example. If you want to delete a
row or column, simply select it and right-click to Delete column or Delete row. The same process works for
deleting the whole table: Select it, right-click, and choose Delete table.
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Figure 4.98 Right-clicking anywhere within the table gives you many options for adjusting your table. The menu makes it easy to
add, delete, or alter existing rows and columns. (Google Docs is a trademark of Google LLC.)

As for applying formatting changes within the table, you can select the cells to format and use the action bar
to change the borders and the background color, as shown in Figure 4.99.
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Figure 4.99 Using the Background color tool allows you to fill certain table cells with a specific color. (Google Docs is a trademark of
Google LLC.)

You can change the size of the table by selecting it and right-clicking on it to show the context menu, and
selecting Table properties. The Table properties dialog box (see Figure 4.100) is where you can change the
dimensions of the rows and columns (by setting a set width or height in inches), table alignment within the
page, cell text alignment, cell padding, and more.

Outside of this dialog box, you can make some changes manually. For instance, you may change an individual
column or row height or width by dragging the borders of cells; the mouse pointer will change shape to a two-
arrow cursor. You can also make all rows and/or columns the same size by selecting the whole table and right-
clicking it, then selecting Distribute rows or Distribute columns.
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Figure 4.100 Docs offers limited options for table formatting. (Google Docs is a trademark of Google LLC.)

4.6 Managing Long Documents in Google Docs

Learning Objectives
By the end of this section, you will be able to:

• Utilize Paint format to apply formatting in a long document
• Insert and modify a table of contents
• Use linked bookmarks and hyperlinks

Google Docs has tools that can help users construct and navigate through long documents. The market trends
report will have multiple sections containing information that is best presented in varied ways. There are three
tools in Docs that this section will cover that are especially helpful: Paint format, Table of contents, and
Hyperlinks.

Paint Format
The Paint format command in Docs is the equivalent of the Format Painter in Microsoft Word. You use it in the
same way: selecting a format you want to copy from the original source, choosing the Paint format icon from
the action bar (it looks like a small paint roller), and using the cursor to apply it on the target text.

In Docs, you can even copy and apply the same original source format multiple times. Once you make your
selection, you are able to apply it many times in different areas of the document. To do this, you need to
double-click the Paint format icon, after which it will stay locked, as shown in Figure 4.101. (Word’s Format
Painter behaves the same way.) After you are done formatting all the text you need, you can unlock it by
clicking once on the icon again; then, the mouse pointer will return to normal.
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It is not advised to use the Paint format tool to apply a style to an entire document with multiple different
features, such as tables and multilevel lists. The Paint format tool may not apply the style in exactly the way
you want with these kinds of special formatting. Additionally, note that in Docs, you can use the Paint format
tool with one open document only.

Figure 4.101 (a) First, select the text with the formatting you want to copy, then click on the Paint format tool. (b) Use the tool to
highlight all the text to apply the new formatting to. As you can see, the body text now has the same format as the header text.
(Google Docs is a trademark of Google LLC.)

Table of Contents
As in Word, a table of contents in Docs requires that you have your headings properly styled, your section
breaks in place, and page numbers.
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Headings for Tables of Contents
What Word calls Styles is called Paragraph Styles in Docs. We previously touched on the importance of these
styles in Docs in the Creating and Working in Documents chapter when we discussed the use of the View menu
to activate or hide the document outline. Moreover, we carefully went over headings and their significance for
the document when we described the font formatting, and how it can be accelerated with the use of styles.
Here, we will discuss how the use of styles helps you manage long documents by helping to structure your
table of contents.

Docs will automatically read your styles and headings and autogenerate the table of contents from that. For
instance, you may have an H1 (Heading 1) for a chapter title, and H2 and H3 headings for subsections. You can
see Google’s default heading styles in Figure 4.102. We can add the table of contents to our WorldCorp market
trends report because we have already formatted the various sections of the report with headings.

Figure 4.102 Docs comes with a few default styles, but you can customize them all to suit your needs. (Google Docs is a trademark of
Google LLC.)

All of these styles can be modified using the Options menu. You can modify any of the heading styles, or even
the Normal style. If you like these styles and will use them frequently, select Save as my default styles. These
will be the default styles for every new document you create.

Changing your styles can be useful when working with long documents. Say that you want to change the font
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type of all the document’s Normal style text. The first thing to do is to change a particular paragraph by
selecting it, and then changing its font type to your desired font. While the text is still selected, go to Styles and
hover over Normal text. Then, click Update ‘Normal text’ to match, as Figure 4.103 shows. That will change all
the document’s Normal paragraphs to have the new font type. Labeling the text Normal every time gives the
user the power to automatize the font formatting.

Figure 4.103 Updating your styles can make automating font changes throughout a long document simpler. (Google Docs is a
trademark of Google LLC.)

Once you have labeled your headings and styled your document properly, the headings will appear in the
document outline. This is a good place to check that your headings are correct before you create a table of
contents. You can preview all the headings and should be able to quickly catch if something is styled
incorrectly. If you see a mistake, simply select that heading and Docs will take you there. From there, you can
select the incorrectly styled text and make it the correct heading style.

Inserting Section Breaks for Tables of Contents
We stressed the importance of section breaks in the chapter Creating and Working in Documents. Section
breaks are necessary when creating a table of contents if you want to have different page numbering in
different sections. If your page numbering is continuous throughout the entire document, you would not need
section breaks to create a table of contents. You only need the section titles to be formatted as a Heading
Style. However, if you want the page numbering to restart with each section of the document, you would need
to also include a break at the end of each section.

Once you have applied correct formatting to all of your headings and placed your section breaks, inserting
your table of contents is easy. Go to the Insert menu and choose Table of contents. There are two types: one
with page numbers and one with blue links and no page numbers. The option with page numbers is a good
choice for either print or digital publishing. If you plan on printing out your report, you want your readers to
be able to use the table of contents effectively and be able to flip to the correct page. Digital readers can still
click on the page number and be taken there automatically. The option with only blue links and no page
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numbers is a good choice if your document will only be used by digital readers.

Let’s now add the table of contents to the WorldCorp report in Docs. First, go to Insert, then go to the bottom
of the menu and choose Table of contents (see Figure 4.104). Select a type, and the table of contents will be
inserted at the location of your cursor (Figure 4.105).

Figure 4.104 Docs shows the two different options for tables of contents in the Insert drop-down menu. (Google Docs is a trademark
of Google LLC.)
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Figure 4.105 The table of contents is automatically generated if you have established the section headings with the appropriate
formatting from the Styles menu. (Google Docs is a trademark of Google LLC.)

Normally, business report writers add the table of contents when they are finished with the report. But in
Docs, it is easy to add the table of contents at the beginning and update it as you go along. For example, each
collaborator might add new headings to the document as they write or revise, which you would want to see
reflected in the table of contents. Once their work is complete, you would simply select the refresh button
(“Update table of contents”) or right-click to “Update table of contents,” to update the table of contents (Figure
4.106). This will tell Docs to recheck the document, and reread for new, modified, or deleted headings. The
table of contents will automatically update with the new document structure.

If you want to change the table of content’s appearance, just select it, and then use the action bar to apply
formatting changes as you would to normal text. You can change the font type, change the size of the font, or
choose to bold or italicize the font.
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Figure 4.106 The table of contents can be updated as collaborators contribute to the document. But they will need to make sure they
format section headings appropriately. (Google Docs is a trademark of Google LLC.)

Hyperlinks, Bookmarks, and Links to Other Files
Hyperlinks can be input in various ways in Docs. As in Word, these help with citations and navigation in long
documents. First, you need to select the text you want to make into a link, then you can choose to use the
menus or the right-click context menu to create the link. You can see both methods in Figure 4.107. They both
lead to a dialog box that asks for the web address, which you input, and then click Apply.
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Figure 4.107 You can make a link (a) using the menu method or (b) right-click method. (Google Docs is a trademark of Google LLC.)

If you want to add a link to another part of the same document, you can create a link to a specific heading. Use
the Headings and bookmarks option that comes up in the Link dialog box. Select the text that will be the link,
then right-click to Link, and you will see all the titles that the user styled to be headings, as Figure 4.108
displays. You will choose the part of the document that you want to link to.

You may also link to a certain part of the document that is not a heading. This requires first creating a
bookmark. For example, suppose you want to reference a table or figure in your document. You must first add
a bookmark next to the table or figure, then you can link to that bookmark. To add the bookmark, place your
cursor next to the table or figure you want to link to, then go to the Insert menu and click Bookmark (Figure
4.109). Then, when you want to link to that bookmark later on in the document, you do the same steps you did
for creating a link to a heading: Select the text you want to turn into a link and right-click to Link. The dialog
box will show the Headings and the bookmarks option. You can choose the pertaining bookmark, as Figure
4.110 shows. (To undo the bookmark you just made, click on it to select it, and then click Remove.)

For linking to another document, you need to already have the document in Google Drive. Go to Drive’s file
options to make a public shareable link. The linked document will not be accessible to someone unless they
have access to the document, meaning that the document has been shared with them. Copy this link address.
Next, open the document where the link will be placed, and select the text to be linked, then right-click to Link.
In the dialog box, paste the public shareable address of the other document, and click Apply. Or, skip the
pasting method, and select one that has been shared already in the link dialog box, as in Figure 4.111.
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Figure 4.108 Having your headings already styled can be helpful when creating links and bookmarks to them. (Google Docs is a
trademark of Google LLC.)

Figure 4.109 Right-clicking allows you to link directly to the selected text. (Google Docs is a trademark of Google LLC.)
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Figure 4.110 Creating bookmarks can help digital readers of your document navigate to different parts of the document without
having to scroll through many pages. (Google Docs is a trademark of Google LLC.)

Figure 4.111 Linking isn’t only for within documents but to other documents as well. In this case, the business letter has already
been shared. (Google Docs is a trademark of Google LLC.)
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Chapter Review
Key Terms
Automatic substitution feature in Docs that allows the user to type a word and have it automatically

replaced with a predetermined symbol or special character
bookmark tool that lets the user connect different parts of the document using links
checklist type of bulleted list that adds a checkbox to the beginning of each line
drop cap when the first letter of the first sentence in a paragraph is in a large, stylized font
endnote note or citation at the end of the document
footer bottom part of the page within the bottom margin, which you can see and configure in Print Layout

viewing mode
footnote note or citation at the bottom of the page
Format Painter tool in Word that lets you copy the formatting of one area of a document to another area of

the same or other file
formatting marks symbols Word uses to tell the user where a space, line, or the like are in the document;

these are usually hidden unless the user chooses to see them
header top part of the page within the top margin, which you can see and configure in Print Layout viewing

mode
hierarchy chart type of chart that visualizes the chain of command or supervision at an organization
multilevel list type of list that has hierarchical levels with different bullet styles for each level
page numbering ability of Word to number your pages in documents; they can be in the header or in the

footer
Paragraph Styles Google formatting tool similar to Word’s Styles; used to create headings and apply

document-wide formatting so that you can generate a table of contents (and document outline)
process chart way to represent a multistep process in a document; it shows the steps in the process, the

order in which to do them, and the dependencies for an outcome
reference method of giving credit to the texts and other sources you used to furnish your document with

information or data
SmartArt tool in Word that lets you design organizational charts or flowcharts
symbol special character not found on the keyboard such as currency symbols or Greek letters
table of figures list of graphs, tables, or images that are in the document
title page cover page of a document
Trust Center part of Word’s configurable options, which lets you personalize your privacy settings
WordArt tool in Word that lets you create artistic text
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Summary
4.1 Microsoft Word: Advanced Formatting Features

• Word includes some advanced configuration settings, such as the Word Options dialog box. This dialog
box is full of different categories of settings, including General settings, Display settings, Proofing
customizations, and the Advanced tab, which lets you configure a vast array of settings of different
categories.

• Page numbers in Word are easy to add and highly configurable. They have preformatted graphical
designs, styles, and numbering systems.

• Headers and footers can be inserted into Word documents using the tools on the Insert tab. As with page
numbers, headers and footers can be customized to meet your needs.

• Types of lists include numbered, lettered, or bulleted. Each type of list has multilevel capabilities.

4.2 Working with Graphics and Text Tools in Microsoft Word
• Tables can be inserted into the document to summarize information into rows and columns. The tables

can be customized with a wide variety of styles, colors, and fonts.
• You may insert images, shapes, SmartArt, charts, and screen captures into Word using the tools in the

Illustrations command group. SmartArt is a tool that lets you design different types of organizational
charts, such as process and hierarchy charts.

• The Text command group contains commands that let you insert autogenerated fields into your
document, like Quick Parts, Signature Line, and Date & Time. It also has text-designing tools like Drop Cap,
WordArt, and Text Box.

• Word also has a large collection of symbols and equations that can be inserted in the document.

4.3 Managing Long Documents in Microsoft Word
• The Pages command group has the Page Break, Blank Page, and Cover Page commands. These tools are

used for adding and managing pages in your document.
• The Format Painter is a useful tool that lets users copy the exact formatting from one section of text and

apply it to another place in the document.
• The References tab contains many useful tools for navigating long documents. From this tab, you can

generate a table of contents, a table of figures, and add footnotes and endnotes.
• Adding bookmarks helps readers easily navigate within a long document.

4.4 Google Docs: Enhanced Formatting Features
• Docs gives the user a few ways to customize page numbers in the document.
• Headers and footers can be added to the Doc and formatted using the tools in the action bar.
• Making multilevel lists in Docs is similar to the same process in Word. But Docs also has checklists, which

are unique to Docs and are a form of bulleted list.

4.5 Working with Graphics and Text Tools in Google Docs
• Docs interactive character map allows you to search for symbols and special characters using text,

Unicode references, or by drawing it.
• With the Drawings tool, the user can easily create a custom shape and insert it into their Doc.
• Drawings has some SmartArt capabilities, but they are not as robust as Word’s.
• Tables are formed in almost exactly the same way as in Word: by having a drop-down menu with an

interactive row and column designer.

4.6 Managing Long Documents in Google Docs
• The Paint format command in Docs is the same as Format Painter in Word. It can copy text formatting to

apply it to another area of the document.
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• Section breaks and headings are important for producing tables of contents automatically.
• Hyperlinks and bookmarks can be used the same way in Docs as in Word; they help the user navigate the

document.

Review Questions
1. How do you add a level to a multilevel list?

a. Go to the Insert tab and choose bulleted list.
b. Use the Tab key or use the Increase Indent tool.
c. Highlight the text and choose multilevel lists from the Layout tab.
d. Insert a numbered list from the Home tab and press Enter after each line.

2. In the Word Options dialog box, where can you add paragraph marks?
a. the General tab
b. the Proofing tab
c. the Advanced tab
d. the Display tab

3. Where would you go to remove your personal information when sending a file to someone else?
a. the General tab in Options
b. the Accessibility tab
c. The Trust Center tab in Options
d. the Display tab

4. How would you quickly insert a special character to indicate something is copyrighted ( © )?
a. using SmartArt
b. using symbols
c. changing the font
d. inserting a header

5. What is the main purpose of SmartArt?
a. to create flow and process charts
b. to create a column chart of data
c. to add visual interest to text with shading and shadows
d. to add a screenshot to a Word file

6. Where would you go to insert a signature line?
a. the Symbols command group
b. the Tables command group
c. the Text command group
d. the Illustrations command group

7. How can Format Painter be used in long documents?
a. to add section breaks to the document
b. to set up the headings for the table of contents
c. to quickly copy formats from one section of a document to other sections
d. to add bookmarks, hyperlinks, and captions

8. What do you need to do before you can insert a table of contents?
a. Add page breaks, section breaks, and cross-references.
b. Add section breaks and headings.
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c. Add headings, page breaks, and page numbers.
d. Add bookmarks, hyperlinks, and captions.

9. What is the function of the Caption tool?
a. It inserts autogenerated text to footnotes.
b. It labels all figures, which then can be used to build a table of figures.
c. It labels headings, which can then be used to build a table of contents.
d. It inserts a reference for the image or table.

10. What are the two ways to create sublevels in a multilevel list?
a. the Tab key and the Increase indent command in the action bar
b. the Enter key and the Increase indent command in the action bar
c. the Alt key and the Decrease indent command in the action bar
d. the Ctrl key and the Decrease indent command in the action bar

11. Where do you find headers in Docs?
a. on the Insert menu
b. on the action bar
c. on the Tools menu
d. on the Edit menu

12. What are the two default page number styles in Docs?
a. bottom left and top right
b. bottom left and top left
c. bottom center and top center
d. bottom right and top right

13. What is one way to insert a drawing from Google Drawings into a Doc
a. You can upload the drawing directly from your desktop.
b. You can drag-and-drop a drawing from your desktop.
c. You can upload or link to an existing file in Drive.
d. You can create a new one from a vector-graphics tool within Docs.

14. How would you insert the copyright symbol ( © ) into a Doc?
a. Go to the Insert menu and choose Special characters.
b. Find the copyright symbol online and copy and paste it into the document.
c. Insert it as a drawing.
d. Go the Insert menu and chose Image.

15. Which menu do you need to access to add a table of contents to a Doc?
a. the Insert menu
b. the Format menu
c. the Tools menu
d. the action bar

16. How do you link to a table in another part of a Doc?
a. Use the Link tool on the Insert menu and copy the link.
b. Create a bookmark to the table and copy the link.
c. Choose the Link Objects option from the Insert menu.
d. Add a heading to the table, and then link to the heading.

324 4 • Chapter Review

Access for free at openstax.org



Practice Exercises
17. Find and read a business article or report of at least 4,000 words. As you are reading it, make a detailed

multilevel outline of the contents. The outline should be at least one full page long. Apply headers and
page numbers. Use single-space and a 12-point font.

18. Using the skills learned in this section, customize the Quick Access Toolbar to include the following
commands: New document, Print, Copy, and Paste. Describe the steps you took to accomplish this.

19. Using SmartArt, create a detailed flowchart of the processes involved in a typical household task, such as
making a sandwich or doing laundry. Choose an appropriate graphic to show the flow of the task to be
completed.

20. Using the tools in the Text command group, compose an offer letter for a job opportunity. The letter
should include today’s date, a signature line, and company information. You can create a company name
and address or use an actual company and its information.

21. Go to Papers and reports (https://openstax.org/r/78PprRprtTemp) at Office.com and download a report
template. Using the template, insert both a footnote and an endnote into the document. Add some text to
each and modify the text using the skills learned in this section.

22. Go to Papers and reports (https://openstax.org/r/78PprRprtTemp) at Office.com and download a report
template that has section headings already formatted. Using the template, insert a table of contents into
the document.

23. Go to Papers and reports (https://openstax.org/r/78PprRprtTemp) at Office.com and download a report
template that has a table of contents already formatted. Using the template, insert a bookmark several
pages into the document that will take you back to the table of contents in the report.

24. Create a multilevel to-do list for your weekly tasks. You can decide the level of detail needed in the list and
you can combine both home activities, recreational items, and school-related work in the list. Add and
center the page numbers, and add a relevant header.

25. Find a report template from the template gallery in Docs. Use the template to insert page numbers (or
change the location if the template already contains page numbers) and insert a multilevel outline into the
report.

26. Search the internet and find a picture of an organizational chart for a company. Using that as a guide,
create the chart in a new Doc using the techniques covered in this section.

27. Create a table using the list of weekly tasks you created a checklist for in Google Docs: Enhanced
Formatting Features. Use the tools and skills you learned in this section to create an easy-to-read table
that outlines at least two different categories of tasks (e.g., Work Tasks, Recreational Tasks). Your table
should have at least one merged cell and at least two different fill colors.

28. Using a longer business article with headings, add section breaks as appropriate. Format the headings to
use in the table of contents. Add page numbers with the finished section breaks. Then, on the first page,
insert a table of contents.

Written Questions
29. What are a few advantages of adding headers to a document?

30. Describe the process of adding page numbers to a document. What things should you consider as you are
adding page numbers?

31. How can you format a table without manually changing the borders and colors?
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32. How would you insert a special character into a document? Also, if you use this special character
frequently, what might make the process faster in the future?

33. What is the difference between a table of figures and a table of contents?

34. Why would you use a page break or insert a blank page in a business report?

35. Explain how the Format Painter can be used in long documents.

36. How can you change the position of the page numbers in Docs?

37. Why is a checklist useful?

38. How does Google’s automatic substitution feature work, and how do you use it?

39. How does Docs’s process for inserting an image offer more options for personalization than Word?

40. Why would you change the Normal font type in a document? Why would this be helpful when working
with a large document?

41. What are some of the advantages of using section breaks in a table of contents?

Case Exercises
42. Cleveland-Cliffs is the largest steel producer in the United States. Their management team released their

brand guidelines manual.

The Cleveland-Cliffs Brand Identity Standards manual (https://openstax.org/r/78CCBrandManual) includes
guidelines for their logo, letterhead, allowed font types, and so on. They also have more guidelines for
specific documents like brochures (p. 27), posters (p. 29), flyers (p. 32), print ads (p. 34), and more. We will
revisit these Brand Identity Standards throughout the chapter, and use our applied skills and knowledge to
create a newsletter. See page 30 of the Brand Identity Standards for Cleveland-Cliffs’s guidelines for
creating a newsletter.

A. Start with a blank document. With what you have learned from Creating and Working in Documents,
insert two columns. (We will show you how to insert the sidebar text boxes later in this chapter.)

B. Insert headers with WorldCorp’s information.
C. Insert page numbers in the header using a professional style that incorporates some color. WorldCorp

uses blue in their logos and marketing materials, so consider a blue color when styling and formatting
the page numbers.

43. Let’s continue building our newsletter using the Cleveland-Cliffs Brand Identity Standards manual
(https://openstax.org/r/78CCBrandManual).

A. Design a SmartArt hierarchy chart. You can assume that the screen panel division is headed by a
divisional manager, who supervises the sales, finance, human resources, purchasing, manufacturing,
and R&D departments.

B. Create a table containing information on different TV technologies (use this CNET article on the best
TVs (https://openstax.org/r/78BestTVs) as a reference) and explain the differences. Design the
complexity and formatting of the table by yourself.

C. Insert a banded text box to one side. This side text box will take the place of the “Inside This Issue” and
“Did you know?” text boxes in the sample in the Brand Identity Guidelines. You can use your new
banded text box for adding quotes and highlights to your newsletter. For now, do not include a table of
contents (we will add that when we learn more about tables of contents in Managing Long Documents
in Microsoft Word).

44. Let’s continue building our newsletter using the Cleveland-Cliffs Brand Identity Standards manual
(https://openstax.org/r/78CCBrandManual). Take the newsletter that you started on in Word and upload it
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to Drive. Open it in Docs.
A. Insert headings into the newsletter. You can choose to make different areas of the document H1, H2,

or H3. Use the Paint format tool to apply the headings, instead of applying the styles manually.
B. Insert bookmarks next to important images in the newsletter. Add at least one link to one of these

bookmarks somewhere in the newsletter.
C. Lastly, insert a table of contents at the top of the newsletter.
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Figure 5.1 Advanced word processing features allow you to create complex documents such as invoices, custom envelopes, business

cards, and much more. (credit: modification of “Please pay this amount” by miguelb/Flickr, CC BY 2.0)

Chapter Outline
5.1 Creating Different Document Types in Microsoft Word
5.2 Mail Merge in Microsoft Word
5.3 Creating Forms in Microsoft Word
5.4 Creating Different Document Types in Google Docs
5.5 Creating Forms in Google Docs
5.6 Advanced Collaboration in Google Docs

Chapter Scenario
Microsoft Word includes some specialized features that can be used in a variety of ways, for both business and
personal use. These features are designed to save you time. For your WorldCorp market trends report, you can
use these features to gather information from employees in different departments, communicate with
vendors and customers, and even create forms to be used for human resources purposes.

The chapters on Creating and Working in Documents and Document Preparation focused on the basic
functions of constructing effective documents in Microsoft Word and Google Docs. In this chapter, you will
learn enhanced capabilities in Word and Docs that go beyond simply creating a document. You will also spend
some time reviewing additional types of documents you might encounter in business, such as invoices and
cover letters.

Advanced Document Preparation
5



5.1 Creating Different Document Types in Microsoft Word

Learning Objectives
By the end of this section, you will be able to:

• Create a template
• Create a business memo
• Create a letterhead and an envelope
• Create a business card
• Create a brochure and a flyer
• Create an invoice
• Create a business plan
• Create a résumé and a cover letter

Having different document types ready to go can be useful, in both everyday life and your professional life.
When it comes to something like applying to jobs or schools—a task that requires writing a similar document,
multiple times—you don’t want to waste time by starting from scratch for each application. You can do this by
using a template, which we learned about in Creating and Working in Documents. This section will show you
how to create your own template for a few different document types, including memos, letters, envelopes,
business cards, brochures, flyers, and invoices.

Templates
In Creating and Working in Documents, we defined what templates are and where to find them in Microsoft
Word. There are also a number of templates available on the internet. Word has web search capability so that
you can look for additional templates on templates.office.com, as you can see in Figure 5.2. On the Office
template website, there are thousands of templates that can help entrepreneurs and small businesses start
making their business more systematic. You can find Word templates for email advertisements, calendars,
brochures, memos, business cards, invoices, business plans, warehouse receipts, and more. Once you
download the template, you can populate it with data and further modify its appearance.

Figure 5.2 You can search for templates using the desktop version of Word, or you can go to your web browser and download the
templates. (Used with permission from Microsoft)

Using prebuilt templates can be incredibly useful, but sometimes you might use a custom document type
often enough that you want to save it as your own template. To do this, go to the File tab and use the Save As
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command to save the document with the .dotx extension. That will save the document as a template. This
means that every time you open this .dotx file, a new file will be created, with all your formatting already in
place. Once you make your edits to the new document, use the Save As command again to save the template
file (.dotx) as a standard Word document file (.docx), making sure to choose the .docx extension to keep the
changes. This will ensure that your edits are saved to a new document not to the template file. The .docx files
are standard Word documents used for editing and sharing, while .dotx files are Word templates used for
creating new documents with a consistent format and style. These same steps need to be followed when
building a template for any kind of file, whether it is a memo, envelope, brochure, flyer, or invoice.

LINK TO LEARNING

While Word comes with many fantastic templates installed, there are many more available online that are
free and can be used with Word. A Google search will garner thousands of available templates. You will
likely come across Canva (https://openstax.org/r/78Canva) in your search. Canva does provide access to
some free templates; however, these files must be edited in that service and are saved and downloaded in
file types that are not necessarily fully compatible in Word. When searching for templates, be sure to verify
they are indeed compatible with Word and come from a verified and trusted source.

Business Memos
Word has templates for memos and newsletters. These are similar forms of communication in that they both
inform a large group of new changes or trends in a company and may call for action. Yet there are some
differences. Memos are used internally, while newsletters are for external audiences. Memos also usually have
a standardized format. Newsletters have more freedom of form and may incorporate a lot of graphics. Like
brochures and flyers, both have been digitized in the form of emails.

Despite the widespread use of email, printed business memos are still commonly used to communicate
important information within a company. Memos typically follow a specific format, which formal company
email transmittals may also do today. One common structure is to include an opening thesis statement, the
main issue, and a closing statement. The opening is an introduction, and it may recall some relevant past
activities, or current activity. The main issue should include the changes that are being announced to the
company. The closing is a reminder of the current project general objectives. It may also include a
complimentary closing, such as, “Thank you for your kind attention,” or something similar. Last comes the
signature, which is the sender’s name, job title, and email address.

Like an email, a memo should always include fields for To (the employees), From (typically management), and
CC, which stands for “carbon copy.” In the 1980s, before personal computers, letters were typewritten, and a
piece of carbon paper was inserted between two sheets to make a copy of the letter. The copy created by the
carbon paper was the “carbon copy,” or “CC.” CC’ing others is a process still used in emails today, although of
course there is no physical hard copy involved.

Memos should also include fields for the Date and a Subject. You can see a memo template that was
downloaded from Microsoft’s template page (https://openstax.org/r/78MicTemplate) in Figure 5.3.
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Figure 5.3 Today’s emails have copied the classic style of a business memo. (Used with permission from Microsoft)

Newsletters can follow a similar format but consider that your audience will be different. You may want to use
different language, incorporate graphics, or include more details. Newsletters may not only communicate
information and updates to an external audience but are often used as advertising. Microsoft’s newsletter
templates are a good place to get started if you are not sure how to format your newsletter.

LINK TO LEARNING

Newsletters are the most popular email advertisement form. Read this step-by-step guide to writing a
newsletter (https://openstax.org/r/78WrtNewsletter) at Readz.com. You can find advice on newsletter
creation, the audience, the types of newsletter formats, idea prompts, and more.

Letterhead and Envelopes
A letterhead is a type of heading that contains company contact information and a logo. It can be used in
many scenarios, both personal and professional. Figure 5.4 shows an example of a professional letterhead for
a business. The logo and company contact information will go at the top right of the document. The
information in the template is generic so that you can customize the template with your specific company
information.
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Figure 5.4 Using the letterhead templates can make creating a brand/image for your company easier by providing prebuilt designs.
(Used with permission from Microsoft)

Business letterheads are also used in conjunction with company envelopes. You may have preprinted company
envelopes with the company logo on them. If not, you can create one using templates. When corresponding
by mail, it is much more professional to have a printed envelope with the recipient’s information, rather than
have handwritten details. While we will cover creating envelopes for larger mailings in the next section, here
we are focused on printing one or two envelopes.

Word has templates and other customizable capabilities to create printed, custom envelopes. You just need to
fill in your address with your name in the left corner, and fill the recipient’s data in the middle. To print the
envelope, you will need to load the envelope in the correct orientation in the printer. Then, you will go to the
File tab and select Print. Printers can vary by brand, so consult the owner’s manual for your printer or search
online for the proper way to print an envelope.

Using the Envelopes command is another solution, and it allows for more customization. You first need to
make sure that your address is saved into Word’s settings. This is done through the Options command, located
on the File tab. Selecting the Options command will open a window, and inside that window you will see a tab
called Advanced. This is where you can set your address, as Figure 5.5 shows.
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Figure 5.5 The Advanced tab of the Word Options window is where you can make sure your address is saved. (Used with permission
from Microsoft)

MAC TIP

From the Tools menu, click on Envelopes. You can make formatting changes here. Also, in the Tools menu,
there is an option for Labels, which has a similar functionality for preparing mailing labels.

Next, go to the Mailings tab and select Envelopes. In Figure 5.6, you can see the dialog box that will appear.
The blank address is the recipient’s address, and on the bottom is your autogenerated mailing address. If you
want to change the envelope size, choose Options, and you will see a combo box with the standard sizes
(Figure 5.7). When you finish typing the recipient’s address, click on Add to document.
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Figure 5.6 The Envelopes and Labels dialog box shows you a simple preview of what your customized envelope will look like. (Used
with permission from Microsoft)

Figure 5.7 The Envelope Options dialog box allows you to customize the placement of addresses, as well as set custom printer
settings. (Used with permission from Microsoft)

As Figure 5.8 shows, the envelope is inserted as the first page of the document, and along it, there is a section
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break. If you want to repeat the styling and envelope size again, it would be a good idea to create the envelope
in a new blank document, and then save it as a .dotx.

Figure 5.8 This is what the Envelope command will ultimately generate. (Used with permission from Microsoft)

Business Cards
A business card is a small, typically wallet-sized card that contains your contact and company information. It is
usually given to clients or potential clients when you meet them, so that they have your contact information
easily available. Business cards may be provided to you by your company, or, if you are self-employed, you may
make them yourself. They usually contain basic contact information, like your name, your position (title) with
the company, your phone number, and your email address, in addition to some eye-catching design elements,
like a logo or image. Business cards are usually printed on thick, sturdy paper called cardstock. Many
companies will order business cards for their employees using approved company designs and layout; at
WorldCorp, the marketing department is responsible for providing business cards to employees. However, if
you are a small business owner or freelancer, you might have a need to create your own business card.

You can easily design a business card in Word and send it out for printing at a business card printing shop,
where you will likely have a few different cardstock options (lighter or heavier weight, glossy or matte finish).
You could also purchase the cardstock and print the business cards on your own. This paper is generally
perforated and some major paper companies that produce this type of paper have templates for their
products in Word. Some of these printing companies may want your design in .pdf format. As we discussed in
Creating and Working in Documents, having a document in .pdf format means that the design elements will
not change at all, no matter who opens the file. If you send the printing company a design in .docx format,
some elements might move when they open the file depending on which program they are using to open and
print the file.

In Figure 5.9, you can see most of a business card template that we downloaded from Microsoft. The page has
ten business cards per page. Simply fill out the information in the fields provided. Once you fill in one area of
the first card, it will auto-populate the same area in all the remaining cards.
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Figure 5.9 Using a business card template can make designing your cards easy. (Used with permission from Microsoft)

Brochures and Flyers
Both large and small businesses use advertisements to display what the company offers and detail the
specifications of the offer. Brochures and flyers are a printed form of advertisement. Although many
advertisements are found on the internet these days, printed ads are still popular. Flyers tend to be graphic-
oriented, contain minimal text, and often advertise an event or temporary promotion. Brochures can be an
introduction for a company or specific product and may be used for a longer duration than a flyer.

As with many documents discussed so far, the best way to create a brochure or flyer is to download a template
from Microsoft, and then fill in the information. Because brochures and flyers can be image-heavy and can
have complicated layouts, using a template is the fastest and easiest way to create them. With a template, you
can establish a base layout, and then easily change the images and the color scheme.

In Figure 5.10 and Figure 5.11, notice the default design of a brochure from Microsoft’s template page
(https://openstax.org/r/78MicTemplate) called Business Brochure. The brochure is two pages, as it is designed
for double-sided printing. The brochure is also set in a three-column layout that is meant to be a trifold design.
The layout is there, and all you need to do is change images, the color scheme (if desired), and the text.

At WorldCorp, the marketing department plans a holiday toy drive each year. Your boss has asked you to
create a brochure with the details for the drive to be distributed to all employees. You can use this template to
create the brochure for the event. We will walk through the steps to create this brochure in the following
sections.
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Figure 5.10 This template is a trifold design. When folded, the panel on the right is the cover and the panel in the middle is the last
page. (Used with permission from Microsoft)

Figure 5.11 Designing the brochure from an existing template saves time. (Used with permission from Microsoft)

To change the two images, right-click on one of them and select Change Picture, as shown in Figure 5.12, then
browse to the folder where the image is and select Insert.
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MAC TIP

On a Mac, the command is Control+right-click.

If the new image is too wide, use the command Crop from the Picture Tools Format tab. To change the color
scheme for the whole brochure, go to the Design tab and click on the Color drop-down menu, as in Figure
5.13. Changing the colors this way will change the color palette for the whole brochure. Finally, to change the
actual text, put your cursor on any of the panels of the brochure and change it manually. In this example, you
changed the pictures and the text on the first page of the brochure to include details of the toy drive at
WorldCorp.

Figure 5.12 The pictures can be customized to your needs either from stock photos, photos on your computer, or photos you find
online. (Used with permission from Microsoft)
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Figure 5.13 The color scheme can be changed using the Design tab. (Used with permission from Microsoft)

To create a flyer, choose a flyer template from Microsoft’s templates, and follow the same steps as for creating
a brochure. As you can see in Figure 5.14, flyer templates are just one, single page, meant to be printed single-
sided on one sheet of paper.
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Figure 5.14 A flyer is similar to a brochure, but it is printed on one single-sided page. (Used with permission from Microsoft)

Invoices
An invoice is an important document. It is essentially a bill given to a customer for a product or service
provided by a company. You may encounter invoices either as a recipient or the sender. If you are the one
purchasing a good or service, you will receive an invoice. The invoice tells you how much you need to pay. If
you are the one selling the goods or services, you will need to create the invoice yourself, then send it to the
company or person making the purchase. In both cases, an invoice should always explain what was provided,
sold, and what is owed.

There are many kinds of invoices for many kinds of businesses, but all invoices should have a date, invoice
number, description of the goods sold or services performed, the quantity, the price per item, the total, and
the payment due date. The Microsoft 365 collection of templates has many designs and types of invoices by
industry. Using a template to design your invoice can be helpful because invoices often include complex table
formatting that can be difficult to design. The invoices can vary based on whether you are providing a service,
such as maintenance (for which you might charge an hourly rate), or providing an actual product, like
WorldCorp’s laptops and TVs (for which you might charge a per-price fee or flat rate).

You can create an invoice by following the same steps outlined above for brochures and flyers: by creating a
new document and selecting an invoice template. Just as you would with the other document types, click in the
text boxes to make the necessary adjustments to the information in the invoice. Figure 5.15 shows some of the
different invoice templates available.
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Figure 5.15 Invoices can be customized to include the company logo and include custom fields, such as sales tax or discounts. (Used
with permission from Microsoft)

Business Plans
A business plan is a document that describes a company’s plan for growth and profitability. Business plans
may have different uses and applications depending on the type of business and stage of growth that the
business is experiencing. For instance, some start-up business plans are used to seek funding for a venture.
They may describe a detailed short-term plan for the company’s first few months of activity, then a broader
long-term plan for future growth. There are also business plans for established companies, such as capacity-
building business plans. These types of plans are used to explain why a company needs funding to buy a new
capital asset, such as a manufacturing plant, or to refurbish an existing one. The business plan templates you
will find in the Microsoft Office database will give you a head start on designing and formatting your business
plan, but keep in mind that these templates will not give any advice on what to include or what kind of
language to use in your business plan. For that, you can get some examples of an already-made business plan
online. Figure 5.16 shows an example of the first couple of pages of a business plan template in Word.
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Figure 5.16 The purpose of a business plan is to discuss the road map for opening or expanding a business. (Used with permission
from Microsoft)

Résumés and Cover Letters
As you start your career and begin your job search, you will want to present yourself as a serious candidate,
ready to take on challenges. One way to put yourself on the right track toward professionalism is by having a
résumé. A résumé displays your work experience, academic degrees, and overall skills. Some résumé experts
say that you should limit your résumé to one or two pages, but depending on the position, you may want to
describe your studies and experience in more detail.

Like business cards, résumés can be simple or more imaginative. While a visual, graphics-heavy résumé may
be eye-catching, a plain text document may be more practical. When you apply for a position, you will often be
directed to an area of the company’s website where you are prompted to upload your résumé to their system.
Then, using computer software, they scan the document for critical information such as keywords, years of
experience, and skills, and then filter the résumés that meet the desired job requirements. These computer
programs do not read drawings and designs well, so a creative or graphics-heavy résumé may not be
interpreted well by this technology.

If you need to print your résumé, it is appropriate to add your personal letterhead to the top of the document.
While letterheads are often used to present company information, as we learned earlier in the chapter, you can
also create a personal letterhead. This type of letterhead is essentially a professional branding of your
personal data, displaying your name, position (if applicable), mailing address, email address, and telephone
number. It might have a simple graphic design, like a solid color bar, or a more intricate design or logo. Using a
consistent letterhead across all your communications will add a look of professionalism and could help
increase your job prospects. That consistency confirms to the potential employer your ability to see “the bigger
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picture” and your ability to visualize the tied-together documents.

Another way to use your personal letterhead is on a cover letter. Cover letters always have a distinct purpose:
to present you as a person, and your skills and relevant experience, in a brief manner. Writing a letter on your
own personal letterhead shows professionalism, as well as gives the recipient an opportunity to write back or
respond. Like a business memo, there is a specific way to structure a cover letter. It should always include the
date, your letterhead, the recipient’s address, salutation, complimentary closing, and signature. The body of
the cover letter should address these aspects in different paragraphs, usually in this order:

• The introduction: discussion of the job position that is being offered, and your interest in applying.
• The second paragraph: your work history summary. You need to be brief and cover the main points of

your career. Also include the relevant skills you possess for the job. If you are applying for a management
position, include your management responsibilities in past jobs, for example.

• The third paragraph: description of how you fit the job offered. You might also want to add your overall
career objectives here, and explain how this job furthers these.

• The conclusion: a closing paragraph that includes your willingness to be right for the job, and your
motivation for applying to this company.

Normally, cover letters are one page, and at most, two pages. You may adjust the mentioned format by adding
new paragraphs to add more detail on your work experience and skills.

The templates covered in this section can help you develop your personal letterhead and cover letter. There
are several options for résumé and cover letter templates in Word. Figure 5.17 shows a sample cover letter,
and Figure 5.18 shows just a few of the options available through Microsoft. As with the other templates,
simply replace the generic text in the template with your specific information.
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Figure 5.17 A cover letter is a complement to your résumé and specifically outlines how you are a good fit for the position to which
you are applying. (Used with permission from Microsoft)
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Figure 5.18 Choose a résumé template that not only matches your personality, but also coincides with the type of job you are
applying for. (Used with permission from Microsoft)

REAL-WORLD APPLICATION

Creating Brand “You”

As you grow in your own profession, you might want to consider developing your own brand. This will
include how you present yourself on social media, as well as all media and supporting documents you
might use to advertise yourself and your “product”—you. Corporations often use brand guidelines to
ensure consistency across all brand items, such as business cards, letterhead, envelopes, and logos. Here
are logo guidelines from Mitsubishi Motors (https://openstax.org/r/78MitsubLogo) for example. These
guidelines give specific details on how to use, and not use, the company logo in different circumstances.

When developing your own personal brand, consider using the following steps:

1. First, investigate personal brands. Canva offers a guide to personal branding (https://openstax.org/r/
78CanvaPersBrnd) that can help. Seek out individuals who do this well. What elements are they using
and why is their strategy effective?

2. Next, design your business card. You might also want to consider developing your own logo; however,
there are many free, online resources available that can help you with this. Once you have a business
card, design your other stationery.

3. Finally, develop a memo and invoice design from scratch. These will be important as your personal
business grows, and you have regular business communication and contracts to support your business.

5.2 Mail Merge in Microsoft Word

Learning Objectives
By the end of this section, you will be able to:

• Understand the purpose and function of mail merge
• Set up a main document for mail merge
• Set up a source document for mail merge
• Complete a mail merge

As companies grow, they may need to scale up their production methods. This can be a complicated process.
An increase in size usually means an increase in revenue, but this comes at the cost of an increase in units
produced or services rendered. As a result, companies need to find ways to make their everyday business
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process more efficient and automated.

One form of automation is the streamlining of communication with customers. With an increase in volume, the
sales team needs to handle hundreds or thousands of clients every day. This can be made easier through the
use of form letters, which are a kind of template for communication. In form letters, the content of the letter is
the same for all recipients, but certain information may be personalized or customized. The mail merge tool in
Word is one way to create these autogenerated letters. Although there are third-party companies that offer
these large mailing type services, the mail merge features in Word are free and simple to learn.

What Is Mail Merge?
Many businesses stay in touch with their clients and customers using some form of communication. Some of
these communications may be printed ads; some may be email newsletters. These communications are
sometimes personalized with the name of the recipient. How do businesses automate this personalized
process? One way to do this is by using mail merge. Mail merge is a tool in Word that lets the user write a
form letter or advertisement, while leaving some areas of the document blank. These blanks are fields that can
be programmed to contain personalized information: the recipient’s given name, phone number, address, or
any other type of customized field.

The mail merge tool makes sending letters or emails to hundreds or thousands of people relatively easy. The
process typically begins with the composition of the communication that you want to send to the recipients;
this is referred to as the main document. The main document will have blank spaces, or fields, where
personalized information will go. Then, you need to create your source document, a separate document that
has all the required information that will go into the blank customizable fields, such as postal addresses or
email addresses. The source document can be a document that already exists, such as a list in Microsoft Excel
or Access (we will talk about these programs later in the text). Or, you can create a new list of names and
addresses. A business may already have this document in Excel or Access, as some businesses keep a running
contact list. Finally, information in the source document and the information in the main document are
combined to create the merged document. This merged document will show the personalized customer
information in the designated blank fields on the main document, then multiply this form by the number of
recipients. For example, if the form letter is one page and you have fifty clients, Word will create a merged
document of fifty letters that can be printed.

Let’s walk through an example of how to use the mail merge tool to send out a set of personalized letters to
customers. You will learn how to build a main document, your source document, insert merged fields, and
merge to finalize your letter.

The Main Document
The first step of the mail merge is to compose your main document. The main document could be an existing
document, a template (.dotx) document, or a brand-new document. In this example, let’s use a business letter
template as the main document. You can type it up yourself based on the example in Figure 5.19, or use the
text provided in the downloadable Mail Merge document (https://openstax.org/r/78DataFileMM). This letter
will be sent to WorldCorp customers, informing them of the upcoming holiday hours for the warehouses so
that they can plan for delayed shipments.

Figure 5.19 shows a form letter to inform the customers of the holiday closures. The template used is called
Business Letter (simple design) to create the letter. We also added a simple WorldCorp logo at the top of the
letter. We have highlighted in green where we want the mail merge tool to create the personalized fields.
These are not the actual fields, yet; this highlighting is simply to help us mark those locations for when we do
add them. In this letter, we will insert the customer’s address and the greeting line with their name. You can
certainly use more fields than these. But for this example, keep it simple so you can learn the process.
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Figure 5.19 Templates can be used to create the main document for mail merge. (Used with permission from Microsoft)

The Source Document
The source document needs to be a listing created in Excel or Access. But this walk-through will build a new list
rather than using an existing list. You will build the new list with just a few customers so you can see how mail
merge works. But remember, mail merge can be used with many customers and is virtually limitless. The
capacity of the mail merge is limited by the capacity of your computer.

The source document is built with the intended recipients. To begin, go to the Mailings tab, Select Recipients,
and choose Type a New List from the menu (Figure 5.20).

MAC TIP

Under the Mailings tab, click on Select Recipients, and choose Create a New List.

Notice there are two other choices: Use an Existing List and Choose from Outlook Contacts. When you have
finished entering in the information for the customers, click OK.

Figure 5.20 Although you can create a new recipient list, if you have a long list, it is better to work from an existing file. (Used with
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permission from Microsoft)

When you choose to create a new list, a dialog box will open so that you can build your list of recipients. Here,
you type in the relevant information for the mail merge, as shown in Figure 5.21. By choosing Customize
Columns at the bottom of the dialog box, you can add or remove the fields that you are not using. Make sure
you add all the information you think you will need for your custom fields. When you do the final mail merge,
you will only be able to choose from the defined information you provided in the source document. For this
example, we need the customer name and address.

Figure 5.21 You can customize the fields used in the list. (Used with permission from Microsoft)

When you finish selecting the fields needed for the mail merge, you will be prompted to save the list as a new
file for use as the source document in the mail merge (see Figure 5.22). The default location for the file is in a
folder called “My Data Sources” (Figure 5.23). You might consider a descriptive name to tell you that this file
contains data used in a mail merge.
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Figure 5.22 When you finish entering the information, click OK to save the file. (Used with permission from Microsoft)

Figure 5.23 The list will be saved as a file with a special extension so that Word knows the list is the source document for mail merge.
(Used with permission from Microsoft)

Merge Fields
Now that you have created the main document, and created and saved the source document, you now need to
insert the merge fields into the main document. First, insert the blank fields on the letter so that Word can
automatically fill them with personalized information: First name, Last name, Address, City, State, and Zip. In
Figure 5.24, you can see the icons in the Write & Insert Fields command group on the Mailings tab. These give
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us some common merge fields: Address Block, Greeting Line, and Insert Merge Field. For this example, use
Insert Merge Field. When you select the option, you will notice that the fields available in the drop-down list
are the fields from your source document. Therefore, make sure the fields in your document are descriptive
and as separated as you would like them to be, for example, if you are sending a mailing out to voters,
consider whether you should include all the members of the household in one mailer, or if you should address
them separately (in which case, you should list each of their names individually).

To insert the field, put your cursor where you want the field inserted into the letter. For our example, we want
“Address_Line_1” to replace our highlighted green street address placeholder (see Figure 5.25). Simply click on
the field from the list and it will be inserted at the cursor location. Repeat this process for the other fields.
Notice the fields are denoted by “« »”. This notation tells Word to get the relevant information from the source
document to put into that line in the document.

Figure 5.24 The fields in your source document are in the Insert Merge Field drop-down menu. (Used with permission from
Microsoft)

Figure 5.25 Be sure to remove the green highlighting in the document as we just used this to show where we wanted to insert the
merge fields. (Used with permission from Microsoft)

Now that we have our source document with all of the customer information saved, and we have inserted the
custom fields into the main document, we can complete the mail merge process. First, you should always
preview the document to make sure it looks as it is supposed to. Go to the Mailings tab and select Preview
Results, as shown in Figure 5.26a. This allows you to see all of the letters with the actual, personalized
information in place, as in Figure 5.26b. All the merge fields you designated in the main document will be
substituted by the actual information. You can use the left and right arrows at the top-right area of the ribbon

5.2 • Mail Merge in Microsoft Word 351



to toggle between recipients.

Figure 5.26 (a) Before you complete the merge, preview the results so that everything looks as it should. (b) Notice the fields have
been replaced with the first name in our recipient list. (Used with permission from Microsoft)

If everything looks okay, then you can complete the mail merge. Go to the last icon on the Mailings tab, Finish
& Merge. The drop-down menu gives you options to edit, print, or send emails with the merged documents. In
this case, we are going to mail the letters to the customers, so we will choose Print documents from the list. If
there were any issues when you previewed the letters, you could select Edit Individual Documents to make the
necessary changes. When you choose to print, you are given the option to select which ones you want to print.
We will choose “All” for our example. The Print dialog box will open with the default printer displayed. You can
choose to send the letters directly to the printer now by selecting OK, or you can choose to print the file to a
.pdf file so that it will be saved. This .pdf file will have four pages, one for each of the four recipients in the
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source document list.

What you have just walked through is a mail merge from scratch. There is also a “Step-by-Step Mail Merge
Wizard” that guides you through the same steps. You can use mail merge for a wide variety of applications,
such as creating name tags for an event; making labels for mailing packages/letters; creating envelopes,
business cards, or postcards; or sending emails to a large group. Even though the tool is called mail merge, its
capabilities go beyond simply creating a mailing.

LINK TO LEARNING

Visit Microsoft’s detailed support page on doing a mail merge (https://openstax.org/r/78MicMailMerge) to
learn more.

Further support can be found on Redtail Technology’s sample mail merge templates (https://openstax.org/
r/78RTMailMerge) page, which has some examples of downloadable form letters.

5.3 Creating Forms in Microsoft Word

Learning Objectives
By the end of this section, you will be able to:

• Understand the Developer tab and its usage
• Use the tools in the Controls command group
• Create a fillable form in Microsoft Word

This section reviews how to build a fillable form in Word. Fillable forms can be very useful in businesses. These
forms can be emailed to recipients as attachments and the recipients can fill in required information into the
form quite easily. The fillable form creates fields that can be filled in by typing directly into the Word document.
You can also insert checkbox fields, drop-down menus, and long text fields into the form. Fillable forms have
many applications in business, such as gathering information on new hires that you might later want to put
into a database, or obtaining company information from vendors for billing purposes. The primary purpose of
the fillable form is to facilitate electronic completion while keeping the integrity and formatting of the
document. Individuals can only input information into the fields you have identified. The rest of the document
is locked from editing or deleting.

Figure 5.28 shows a simple example of how a fillable form can be a useful tool. If you wanted to gather
information on a new vendor, for example, you could create a simple document, email it to the vendor, and
have the vendor send the completed document back to us. However, as Figure 5.27 shows, if you just create
the form as a typical, printable Word document, it is difficult for the vendor to input their information. They
would need to edit the form itself in order to fill it out, which is not ideal. With a fillable form, the vendor
simply inserts their information into the provided fields and the rest of the document is protected from
editing. The fillable form can also be enhanced with decorative features, such as the company logo.
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Figure 5.27 As information is entered into the form, the underline is replaced with the text. (Used with permission from Microsoft)

Figure 5.28 A fillable form gives a more professional appearance and can be customized with the company logo or letterhead. (Used
with permission from Microsoft)

Developer Tab
To create surveys in Word, you need to enable the Developer tab. This is typically not one of the default tabs
in Word, so you need to manually add it. Go to the Options command on the File tab, then on the Customize
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Ribbon tab, then enable the Developer tab.

MAC TIP

To add the Developer toolbar on a Mac, you will need to go to Word, then select Preferences, then go to
Ribbon & Toolbar. In the Search box, type “Developer.” Select the Developer tab from Suggestions. In the
dialog box under the ribbon header, select the box that says Show Developer Tab.

The Developer tab serves several purposes, as Figure 5.29 shows. In addition to containing the tools needed to
design fillable forms, it also contains the tools to create computer programs (macros) in Word, to protect and
restrict access to your document, and other advanced tasks.

The majority of the features on the Developer tab are for more advanced uses of Word and are outside the
scope of this text. This section focuses on the Controls and Protect command groups, which contain the tools
we need to create and secure our fillable form.

Figure 5.29 Making a form in Word uses these control commands. (Used with permission from Microsoft)

Controls Command Group
The Controls command group includes several different icons to represent the fields you can use in your form.
Figure 5.30 identifies the icons you will be using to create the form. The remaining icons in the command
group are used for building sophisticated templates in Word. The controls we are using in this example are
called content control fields. These fields give people a space to type in, add a date or image, or choose their
response from a list. In other words, they are interactive fields that can be specially programmed to receive
input from recipients. The content control fields create a user interface that seeks input from the respondent.

Figure 5.30 The controls you see with the “X” are not used when creating fillable forms. (Used with permission from Microsoft)

The top-level commands are for inserting text or images into your form. The inputted answer will use either
rich text or plain text. Rich text allows the user to use bold, italic, and underlined font, different font types, and
so forth, whereas plain text does not allow these types of font formatting. This distinction is important if you
plan to print the form and want the text to appear with specific formatting. In general, the plain text response
will suffice, as most respondents will not need to add formatting to their answers. The Insert Picture command
(the landscape icon) is for letting the respondent add an image to their answer; this command may be used to
ask the user to upload their profile picture, for instance.

The middle-level commands are for asking multiple-choice-type questions and for setting the date. The first
(leftmost) in this row is the checkbox. This handy option reduces the amount of information that needs to be
typed into the form. For example, the form could have a list of all departments at the company, and the
respondent could simply check the box of the department that they work in, rather than type in the response

5.3 • Creating Forms in Microsoft Word 355



manually. You could also have multiple-select questions that ask the survey taker to “check all boxes that
apply.”

The combo box and the drop-down list also ask the respondent to select from a set of preset choices. The main
difference between the two is that the combo box lets the individual type a message after their selected
answer, whereas the drop-down list forces them to choose between the options. The last (rightmost) command
is the Date Picker, which allows the individual to select a date when they are completing the form. The
respondent can choose any date with the Date Picker, such as their birthday or their date of hire.

The Design Mode tool is used to customize the prompts that appear as the survey taker fills out the form. You
can use this to customize the prompt to the respondent; this can be more helpful to the survey taker than the
generic default text (e.g., “Click or tap to enter text”).

The last item you may use in the command group is the Properties tool. This tool allows you to modify the lists
associated with the combo box and the drop-down list. It becomes active once you have added a combo box or
drop-down list to your form.

Creating a Form
Before adding the fields, you should first develop the plan of the form. One way to do this is to type out the
information or questions that you will ask into a blank document. Creating the form using a table is one option
for presenting a professional appearance; this format helps keep everything organized and neatly aligned. The
table should have two columns, and as many rows as you will have questions. Using only two columns allows
you to put the questions in one column and the answer fields in the other. The column on the left will have
your questions, and the column on the right will have the fields for the respondent’s answers. You should
change the table borders (in Table Properties) so that they are transparent, making it so that the respondent
cannot see them. This way, the questions and answers remain aligned, but they will not appear to be in a table
format to those viewing the form. Alternatively, you could choose to not use a table to create your form. In this
case, the questions and answer fields would need to each be manually aligned.

For this example, let’s use a table to create a fillable form. In your role at WorldCorp, you have been asked to
collect information from all department office managers regarding their need for preprinted company office
supplies. Your department (marketing) is responsible for all office supplies that include the WorldCorp logo. A
large order is placed each quarter for items such as letterhead paper, envelopes, notepads and pens with the
logo, and business cards. To help facilitate the process, your supervisor has asked you to create a fillable form
that can be emailed to each department’s office manager to gather information on items that will need to be
ordered.

Creating Questions and Control Fields
To begin, start with a blank document and insert a two-column table. Type all your questions in the left
column: information on the department, whether they need items ordered, and the quantity and type of items
are needed. Figure 5.31 shows how the information will be gathered from the various departments. Because
this is just the draft form, we have noted in parentheses the type of control that will be used for that question.
You can go back and remove that information after you have inserted the fields. Notice that the table lines are
still visible in this initial draft version. To remove the lines from the table, use the Borders tool in the Paragraph
command group on the Home tab.
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Figure 5.31 Your form should have a tidy and professional appearance. This could mean removing the lines around the table and
inserting the company logo. (Used with permission from Microsoft)

Then, insert the control fields—where the respondent will put their answers—in the right column. First, insert
the Date Picker control field, as Figure 5.32 shows. Notice the text says, “Click or tap to enter a date.” This is not
very descriptive. You can change this in Design Mode to be more descriptive. Design Mode lets you change the
preset instruction text. To turn on Design Mode, simply click it in the Controls command group. You are now
able to change the default text to be more specific such as “Enter Today’s Date” (Figure 5.33).

Figure 5.32 The default text inserted with the control fields is not very descriptive, so you may want to replace it with your own, more
detailed text. (Used with permission from Microsoft)
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Figure 5.33 Your custom text should be descriptive enough so that the user knows exactly what they need to put in the field. (Used
with permission from Microsoft)

Continue with the remaining questions and enter the field and specific prompter text for each question. Figure
5.34 shows how the form should look at this point. Now, go back to each question and examine the properties
to determine if changes need to be made. Notice that a bulleted list and the insert signature tool were used in
the right column. (You learned these skills in the Creating and Working in Documents and Document
Preparation chapters.) Note that the notes in parentheses were also removed.
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Figure 5.34 Changes to the line spacing in the table now make the form more visually appealing. (Used with permission from
Microsoft)

Now that you have the form constructed and the control fields inserted, you can customize each control field if
necessary. To do that, you need to select the control field, and then choose the Properties command. A dialog
box will appear for that control, as shown in Figure 5.35 for the first field, “Today’s Date.” Here, you can change
the format of the date to be entered. There are only a few options for the text boxes. You can change the font
and the fill color. You can also choose to have the control locked so that it cannot be deleted. For this example,
use the default settings.
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Figure 5.35 By checking the “Content control cannot be deleted” box, you can protect the field. (Used with permission from
Microsoft)

For the multiple-choice questions, the drop-down lists, and the combo boxes, the setting up takes a little bit
longer. You need to manually add the choices to the list for each question type. In your form, you need to write
out the departments so that the office manager can choose the appropriate department. To do this, go to the
Properties for the drop-down list (see Figure 5.36). At the bottom of the dialog box, locate the drop-down list
properties. Here is where you will add the various departments. By default, the only option is Choose an Item.
We need to remove this item and add the departments. Click on Choose an Item and select Remove from the
options on the right. Now, choose Add to add each department.

Notice that the Display Name and Value Name are the same. There is really no need to change this, but you
can change it if you want the respondent-facing choice to look different from what is actually logged as their
response. For example, you could have the Display Name (i.e., what the respondent sees in the drop-down list)
to say Accounting, but the actual Value that is displayed when they choose Accounting is “Acct.”

Continue in this same manner to add all the departments as shown. If desired, you can change the order of
the options in the list by choosing Move Up or Move Down (Figure 5.36). For a more professional look, consider
placing the items in alphabetical order.
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Figure 5.36 With a drop-down list, use Properties to define each of the categories in the list. Generally, the display name and the
value should be the same. (Used with permission from Microsoft)

Finally, you need to format the checkbox field. As with the other control fields, you can change the font and
style (see Figure 5.37). But with the checkbox, you can also change what type of symbol is used in the box. For
example, you can choose a heart instead of an X for the form. To do this, choose Change next to Checked
Symbol. Choose what type of symbol you want for the checked box (see Figure 5.38).
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Figure 5.37 The default symbol for the checked box is an X. (Used with permission from Microsoft)

Figure 5.38 Choose Symbols from the drop-down menu in the Font field to find the heart. (Used with permission from Microsoft)

You could adjust the properties of each control field as you enter them into the document. However, it is often
easier to add the fields first and then go back and make the needed customizations to each field with the
Properties tool.

When you have finished formatting all the control fields, make sure you have saved the document. You can
now turn off Design Mode by clicking the tool in the command group. Now is also a good time to add some
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visual elements to the form, such as the company logo or other elements to make the form more visually
appealing. You should also remove the borders around the table. Figure 5.39 shows what the finished product
might look like.

Figure 5.39 Notice that when the drop-down list is selected, the various departments show up. (Used with permission from
Microsoft)

Protecting the Form
When you are finished with the form, you need to protect the file before sending it to the various office
managers. This will ensure that they cannot edit the questions and controls—that they can only provide
responses. The way to protect the document is similar to the process described in the Creating and Working in
Documents chapter. To protect the document, select the Restrict Editing command from the Developer tab and
a sidebar will appear. You can also access the Restrict Editing command from the Review tab. This sidebar will
give you options for preventing editing from happening on the file, as shown in Figure 5.40.

When you send the file to others, be sure to send the file as an attachment to the email rather than sharing
the document link. If you have saved this file in your OneDrive and share the document as a link, your original
file will be changed. You should instruct them to save the file under a different name and to send the file back
as an attachment.
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Figure 5.40 Before sending the survey form, you need to prevent clients from editing the document. (Used with permission from
Microsoft)

LINK TO LEARNING

There are a lot of detailed privacy considerations when conducting surveys. A considerable number of laws
are in place to protect consumers when participating in corporate surveys. Visit the Information and Privacy
Commissioner of Ontario’s Best Practices for Protecting Individual Privacy in Conducting Survey Research
(https://openstax.org/r/78IPCOPrivacy) site to learn more.

5.4 Creating Different Document Types in Google Docs

Learning Objectives
By the end of this section, you will be able to:

• Create and share a template
• Create a business memo
• Create a letter and associated letter for mailing
• Create a business card
• Create a brochure and a flyer
• Create an invoice

Like Microsoft, Google has ready-made templates for many types of documents. This section will walk through
how to make different types of documents using these templates, as well as how to upload other templates
and create documents from scratch. In contrast to Word, Google gives users the power to share their
documents with the public or internally, simply by uploading them to Google Drive and granting permissions
to download them. Using a simple URL, anyone can find and use publicly available, user-generated templates.

Google also has its own default Template Gallery, which contains a few different types of templates for
workplace documents such as project proposals, meeting notes, newsletters, and contracts. However, the
document types we will cover in this section—that is, many of the same ones we covered in Creating Different
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Document Types in Microsoft Word—do not have existing templates in the Google default Template Gallery.
We will walk through how to approach creating these documents using a few different methods.

Templates
All the documents covered in this section can be saved as your own template. If you want to publish a
template so that everyone can use it (i.e., to all Google users worldwide), you may do so. When you are
finished formatting your document, you can go to Google’s template gallery (https://openstax.org/r/
78GoogTemplate) and select Submit a template at the top. Note that not all Google accounts can submit
templates. This feature is available only with the paid Business and Education programs in Google.

After you submit a template, Google will ask you to browse for the file in your Google Drive, then you can enter
a description so that people who search for a certain kind of document (for example, an invoice, memo,
business card, or cover letter) will be able to find it. Next, select the category the document fits in, and the
language of the written text. Finally, click on Submit template to finish the process.

Another way to publish a template is to share it with others in a shared location so that your collaborators or
coworkers can access it. (The chapter Creating and Working in Documents covered how to share documents
with others.) Then, you can send the template to your coworkers by email, by sharing the link. The only caveat
with sharing templates is that shared templates should not be directly edited because this would alter the
template itself. You can set this shared template to “View only” if you are concerned about this happening.
Otherwise, explain to the collaborators that when accessing the document, they should not edit it. Instead,
they should use the Make a copy command.

If you would like to access a Google template (not the user-generated templates) in Docs, go to File, New, and
choose From template gallery. This will give you the listing of the templates available. Notice they are
categorized by usage (business, education, and so on).

Business Memos
We reviewed the business memo’s goals and overall form in Creating Different Document Types in Microsoft
Word. These basic understandings remain true when you are creating a memo in Docs. The only difference
between Docs and Word is how you access the template to create one.

There is no default business memo template in Docs. Google’s Template Gallery has plenty of templates,
including ones for cover letters and project proposals. This means that you have to search the internet for one,
upload one from Microsoft, or create it from scratch.

One way to find a user-generated business memo template is to go to Google’s search engine and type “memo
template site https://docs.google.com” into the search bar (see Figure 5.41). This will search for all public
templates with the description “memo template.” However, this will get you a wide range of templates, so you
should evaluate them carefully to find a memo format that you like and that looks professional.
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Figure 5.41 There are a lot of user-generated templates available on docs.google.com. (Google Docs is a trademark of Google LLC.)

You could also use a template from Microsoft and convert it to a Google Doc. We chose to use a template from
Microsoft’s productivity template page (https://openstax.org/r/MicTempMemo) here. Use the same template
we used in Creating Different Document Types in Microsoft Word Figure 5.42. Save it as a .docx file, then
upload it to Google Drive. While you have the uploaded template open in the Docs window, choose Make a
copy, to keep the original file as a template. Then, you can fill in the required memo fields with your own
information.
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Figure 5.42 Uploading and editing a template from Microsoft is easy. (Used with permission from Microsoft)

Letterhead, Letters, and Envelopes
The process and requirements for making a letterhead are the same in Docs as they are in Word. You fill it out
with the same components—name, address, other contact information—which are placed in the same location
on your documents (at the top). You can use a letterhead for any kind of business or personal correspondence,
but this example will use a cover letter. Although Docs does not have a specific template called Cover Letter in
its default Template Gallery, it does have a few that are simply called Letter.

First, start at the welcome screen, which is the first screen you see when you navigate to docs.google.com.
Select Template Gallery at the top right. If you are using a business account, you will see a tab with your
business name at the top left, and a tab that says General. If your company has its own templates, you will see
them in the first tab. But look at Google’s default templates first and choose General. Scroll down until you see
templates for Letters. Some of the templates would work as a letterhead template (Figure 5.43). Select the
template you like, and Google will automatically open a new document for you. Simply replace the template
text with your information on the letterhead (name, address, phone, email address), then add today’s date, the
recipient’s name and address, and the body text, as Figure 5.44 shows.
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Figure 5.43 Access the Template Gallery when you create a new Doc in the upper-right corner. (Google Docs is a trademark of Google
LLC.)

Figure 5.44 Google’s letter template has some classic formatting and tasteful colors. (Google Docs is a trademark of Google LLC.)

To print and mail the letter, take the professional step of having a custom-printed envelope. To create and
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modify an envelope in Docs, you have two options: get a user-generated template or template from Microsoft,
or install an add-on. Unfortunately, there are no default envelope templates in the Template Gallery, so you
have to get creative.

To use the first option, you must do a manual search in your browser’s search bar. (This is the same process we
used to find a business memo template.) Type in “envelope template site docs.google.com,” and you will see a
number of user-generated envelope templates. You can select one of these and add the information of the
addressor and the addressee. These templates could be modified.

The other option involves installing an add-on. There are several recommended add-ons from Docs’ users in
forums. An add-on is an addition to the base software program. Add-ons can be very specialized, such as
specific add-ons for graphic design, or they can be more general, such as the one we can use to make printed
envelopes. To search for an add-on, go to the search bar at the top right side of the screen, as shown in Figure
5.45. Here, you can search for a mail merge add-on, which will give you the tools to print envelopes. A tip is to
find an add-on that many users have downloaded and installed, so you know that it is effective. You can also
filter the results to show which will work with specific programs and by price. There are many free add-ons for
general usage. The more specialized add-ons might require you to pay a fee. You can see the add-on’s name,
rating, and number of users at the bottom of each result listed. To access the add-on, click on it in the
Extensions menu (see Figure 5.46).

Figure 5.45 Add-ons can increase the functionality of Docs for more specialized tasks. You can install an add-on to print envelopes
and other mailing options using mail merge. (Google Workspace is a trademark of Google LLC.)
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Figure 5.46 The new add-on will be in the Extensions menu. Click on add-on to access its tools and features. (Google Docs is a
trademark of Google LLC.)

LINK TO LEARNING

There are many add-ons that increase the capabilities of Docs. As you have read throughout this book,
Word typically offers more features than Docs. Yet, if you install many specialized add-ons, this gap
becomes smaller. Read this article on popular add-ons for Docs (https://openstax.org/r/78DocsAddOns) to
learn more.

Business Cards
As with other document types discussed so far, Google does not have a default template for business cards.
You have a few choices on how to move forward: upload a Microsoft template to your Drive, find a user-
generated template, or install an add-on.

To use a Microsoft template, go to Microsoft's template page (https://openstax.org/r/78MicTemplate5) and
choose the same business card template you used in Creating Different Document Types in Microsoft Word.
You will be making some changes to it in Docs. You can use a letter-size paper to print the cards, but
remember that business cards should be on cardstock, and may need to be professionally printed.

You can also look for a user-generated template on docs.google.com. As with the other template types, type
“business card template site https://docs.google.com” into your browser’s search bar or search engine to look.
Once you find a template, you can add your information and company logo as usual. You may also change the
design of the template by adding shapes and lines from Google Drawings (see the chapter on Document
Preparation.)

Brochures and Flyers
Docs has some default templates for brochures and flyers. But the brochures are not formatted in the
traditional trifold way. In fact, the brochure templates are very similar to the flyer templates in Google.
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Figure 5.47 shows a two-page brochure template. Note that it is a trifold format, like we saw in Creating
Different Document Types in Microsoft Word. To create a trifold brochure, you can use a Word template and
open it in Docs. You might have to adjust some of the spacing when using a Word template in Docs, but it
gives you a good framework to start designing your brochure.

Figure 5.47 Brochures in Docs look a little different than traditional brochures. Using a Word template can get you started on a
trifold brochure, but you might have to make some adjustments to the formatting and borders. (Google Docs is a trademark of
Google LLC.)

SPOTLIGHT ON ETHICS

Image Usage and Restrictions

The internet has put any number of resources at our fingertips. As we create documents, we may want to
include images or graphics to augment the visual appeal of the document or to highlight certain
information. Of course, many of us do not have the skill to create these on our own. Here, the internet can
be very useful—you can conduct an image search on just about any topic and find relevant images, and
then copy and paste, or save and insert, these images. But, first, you need to determine whether the
creator has given permission to do so; otherwise, you are taking a work that isn’t yours and using it in a way
that the creator didn’t intend.

Most images you find will have an associated license or require attribution, as they are created by someone
else, usually for someone else. Normally, a large company like WorldCorp would have a paid subscription to
a site such as AP Newsroom (https://openstax.org/r/78APStockImages) for a repository of licensed stock
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images.

However, you can also find many open-source images that are available freely and without cost. Wikimedia
Commons (https://openstax.org/r/78WikimediaComm) is one popular open-source image repository. But,
even here, you must carefully read the different licenses associated with the image in question. While some
images on Wikimedia Commons may be public domain—that is, without any copyright restrictions at
all—others may have varying types of Creative Commons (https://openstax.org/r/78CreatCommons)
licenses, which may come with restrictions on usage and attribution.

The most permissive type of Creative Commons license is a CC BY license. According to Creative Commons
“This license allows reusers to distribute, remix, adapt, and build upon the material in any medium or
format, so long as attribution is given to the creator. The license allows for commercial use.”

The least permissive type of license is a CC BY-NC-ND. First, the creator must be given attribution. Second, it
allows for use and distribution in any format but can’t be altered and can’t be used for commercial
purposes.

There are varying degrees of Creative Commons licenses between these two types.

Invoices
As with the other document types, there is no default template in the Template Gallery for invoices. Luckily, we
can still search through the huge number of user-generated templates by searching for “invoice template site
https://docs.google.com.” This internet search will return all public templates that people have added to their
own Google Drives. After you find the invoice template of your choice, you can save it by going to the File
menu, and selecting the Make a copy command, as Figure 5.48 shows.
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Figure 5.48 When you find a desirable Docs template from a user, you can get it by clicking on Make a copy. (Google Docs is a
trademark of Google LLC.)

Again, you can always import a Microsoft template and modify it in Google. For example, try using the same
template you chose in Creating Different Document Types in Microsoft Word. As you start to work on the
invoice, you can update it with company-specific information and logos. To save it as your own template, go to
the File menu, and select Make a copy. Then, go to your Drive and rename it to “invoice template” or
something similar.

As with any other template, you may want to restrict editing permissions so the template itself cannot be
changed, as the chapter on Creating Different Document Types in Microsoft Word explains. By setting the
permissions to “View only,” every time you open the template for a new invoice, you would have to use the
Make a copy command in order to create an editable version. Then, from your new editable version, you may
proceed to change the data and save it under a different name.

5.5 Creating Forms in Google Docs

Learning Objectives
By the end of this section, you will be able to:

• Create a fillable form using a template
• Create a fillable form from scratch
• Distribute the form and view responses

Google released Google Forms in 2008 as a feature of Google Sheets. It became a stand-alone product in 2016
and became its own program, which enabled Google to add more features to it. Forms helps you create an
online form that tabulates responses and analyzes information gathered from the form. This is the main
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advantage of using Forms over creating a fillable form in Word. Forms not only collects the responses, but can
also summarize the responses for you. You just need to plan the questionnaire, write and design the
questions, and email the form link to respondents. It has an easy-to-use interface, like other Google products,
and includes additional features to help you sort through and understand the form responses. Because you
are collecting the responses electronically through the Forms app rather than having the responses saved in a
document file, you have many more options for how to view and summarize your responses. In the Forms app,
you have options to view individual responses, download the responses to Sheets, and view graphs that
summarize all of the responses collected.

In the marketing department at WorldCorp, there are many uses for Forms. Forms might be more useful to
the marketing department at WorldCorp because it is much easier to create a form and collect information in
Google as compared with creating the form in Word. The process to create a form in Google is much more
direct and Forms also summarizes the information collected right in the application. As the Google programs
are web-based, we will use the web browser to construct the questionnaire, and the clients will receive an
email with a link. After respondents answer the questions, Forms can automatically create graphs to
summarize the responses, which you can import into other documents or programs if needed.

Form Templates
Creating a Form is like creating any other Google file. Begin in your Google Drive, select the New drop-down
menu, and find Google Forms, as seen in Figure 5.49. From here, you have the choice of creating a survey from
a Blank form or From a template. For this walk-through, we will choose From a template, but we will review
how to create one from scratch in Creating a New Form. The advantage to using a template is that you can
choose a form that is already similar to the one you might have in mind. Using a template from the Template
Gallery (Figure 5.50) will help save you time, as all you will need to do is modify the questions and answers,
and then add some new questions as needed.

Some of the templates in the Template Gallery are designed with specific purposes in mind: event invitations,
contact information requests, order forms, work requests, and customer feedback surveys. As Figure 5.51
shows, most templates just have a few questions, and are meant to be modified and added to.

Figure 5.49 To begin creating a form in Google, you can either start from scratch (blank form or quiz) or use a template. (Google
Drive is a trademark of Google LLC.)
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Figure 5.50 When creating a form from a template, choose a category that is close to what you want to create. (Google Forms is a
trademark of Google LLC.)
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Figure 5.51 Most form templates have only a few sample questions to get you started. (Google Forms is a trademark of Google LLC.)

Creating a New Form
If you want to create a form from scratch, select Blank form from the drop-down menu. The form will start with
a blank document that says “Untitled form.” As in Docs, rename this file by clicking on the title bar to type the
new name of the form. All new forms also have a blank space for a description, just below the form’s title. The
respondent will see the description, so it needs to be informative to them, as Figure 5.52 shows. It is important
to name the form; otherwise, you are not going to be able to find it easily in your Drive later.

Now, you can begin typing the questionnaire. Use the first sample item in the blank form—a multiple-choice
item—or choose a different type of question using the drop-down menu on the right. There are eleven types of
questions, as Figure 5.53 shows. Table 5.1 explains each type of question and what it is used for.
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Figure 5.52 Add your first question to the form by choosing the type of question from the menu. Be sure to customize the form with
a title and short description. (Google Forms is a trademark of Google LLC.)

Figure 5.53 Forms has similar question types compared with Word’s form controls. (Google Forms is a trademark of Google LLC.)
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Type Description

Short
Answer

These are open questions (the answer can be anything). Similar to the “plain text” controls in
Word.

Paragraph
These are open questions. Similar to the “plain text” controls, but you can answer with a lot
of text and paragraphs. There is no Rich Text Format control in Forms.

Multiple
Choice

The multiple choice question is like the “combo box” in Word. You can include an “Other”
option. The “Other” option can be typed.

Checkboxes
The checkboxes are the same as in Word controls, but in Forms, you can have an “Other”
open answer as well.

Drop-down
The drop-down is like the “drop-down list” control in Word. The survey taker has to choose
one option. There is no “Other” option.

File Upload The survey taker can upload a document or a picture file (or any other file extension).

Linear
Scale

It is a scaling question that can be configured to start from “0” and end at “10.”

Multiple-
Choice Grid

This is a kind of multiple choice, which the survey taker has to choose one per row or
column. There are many rows/columns.
Can be used for Likert scales.

Tick Box
Grid

This is a kind of checkbox, which the survey taker has to choose one per row or column.
There are many rows/columns. Can be used for Likert scales.

Date This makes the user choose a date, like the “date picker” control.

Time This makes the user choose a time. It can be 24h or AM/PM format.

Table 5.1 Types of Form Questions Choose the question type that will give you the information you need. You have eleven question
types to choose from.

You should learn the various question types, as there are many interesting options for how to set up your
form. There is a sidebar that lets you add a new question, as well as several additional commands, as seen in
Figure 5.54. The additional commands on that sidebar are importing a list, adding a text description (similar to
the Design Mode instructive text in Word), and inserting an image or video for the question. Lastly, there is a
command for making different section breaks; this can be used as a way to divide up the form, which can be
useful if the form is chunked into different topics or if it is several pages long. For example, the demographic
questions could all be in one section, and the TV viewing questions could be in another.
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Figure 5.54 The sidebar lets you add new questions or import older ones from previous forms. (Google Forms is a trademark of
Google LLC.)

There are two toolbars in Forms. The top toolbar is used for themes. The bottom toolbar (Figure 5.55) gives the
writer more question-level configuration options. It contains the Duplicate question command, the Delete
command (the trash icon), and the Required toggle. If you select the Duplicate icon, Forms will repeat the
previous question, so that all you need to do is edit the question instead of writing it again from scratch. The
Delete command is for removing the question from the list. The Required toggle allows the form creator to
make the question mandatory; in other words, the respondent must provide an answer for this question
before sending their final responses. In the form, the mandatory question will be followed by a red “*” to
indicate that the question is required. The last item is the three-dots menu drop-down menu that contains a
few more question-level settings, like letting you add a description to the question, manage the list of
questions, and change the order of the questions.

Figure 5.55 The bottom toolbar has tools too, like toggling a requirement of the question. (Google Forms is a trademark of Google
LLC.)

Importing Questions
Importing questions means adding questions from another form or form template to your current form. You
can do this by choosing the Import button on the sidebar (as seen in Figure 5.56). This will take you to the
gallery of form templates (Forms) or your archive of saved forms (Recent) that you have created. Select any
one of these, and you will be taken to that form, where you will see the questions on a sidebar, as Figure 5.57
shows. In this example, we selected the Customer Feedback Form Template. Select the questions you want to
import by ticking the checkboxes. When you are finished making your selections, select Import questions from
the bottom of the sidebar. If you want to add questions from multiple forms, you will have to do the same
steps over again for each form.
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Figure 5.56 You make creating a form easier by importing questions from templates or from previous forms you have created. You
can select Recent to access the files in your Drive to search for the form you want to use for importing questions. (Google Forms is a
trademark of Google LLC.)

Figure 5.57 You can choose to import all the questions in a form into the current form. (Google Forms is a trademark of Google LLC.)

If you want to import questions from a form that you wrote in Word, the easiest route is to create a new
question using the type you need, then copy and paste the text from the other file. This is the most direct
approach. Forms will not automatically recognize the type of question you want (such as drop-down list or
checkbox), but if you create the question first, then you can paste the specific text into that question. There are
add-ons that you can download to help facilitate importing questions from other file types, but using a copy/
paste method can be a simple, easy way to get the information from one file into Forms because it involves
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fewer steps and is often less complicated than using an add-on.

Let’s use the fillable form that we created in Word and copy the information from a couple of the questions
into Forms using this approach. First, create a blank form in Docs and open the fillable form you created in
Word. Recall that the first line on the office supply order form is “Date.” In the blank form, you can set the first
question to use the date question format type. We can then copy and paste the text from the Word fillable
form into the question we just created. This approach is not necessarily importing the questions from the
Word fillable form, but it provides a simple way to get the information from one file type into Forms.

Customizing the Form Settings and Theme
Although you cannot change the font or text formatting within the form questions, you can change the form
theme, which applies some formatting changes globally throughout the form. In the top toolbar in Forms, you
will find commands for document formatting and applying themes, as Figure 5.58 shows.

The first command, the painter’s palette icon, is for changing the overall survey form theme. When you select
this, a sidebar, Theme options, will appear, with theme and background color configurations (see Figure 5.59).
From here, you can choose an image for the header, such as a custom design or a company logo, as well as
change the color scheme of the document or change the font type of the whole document. There are only four
font types available.

The second command, the eye icon, is for previewing, and it displays the survey how the survey taker would
see it. This can be a handy tool for previewing the form before it is sent to the survey takers.

The third command, the gear icon, is the Form Settings. When you access the Form Settings, you will see three
tabs. The General tab gives you configurations for the survey takers, such as letting you collect the emails of
survey takers, sending the survey takers an email receipt, limiting the takers to only do one survey response,
and other configurations, as shown in Figure 5.60. In the Presentation tab, you can change some of the
appearance options for your survey, such as the confirmation message, the order of questions (e.g., shuffled
or in the same order each time), and other options. The third tab is Quizzes, which contains configuration
settings for survey types and is used more commonly in the education industry.

Figure 5.58 The top toolbar is for previewing the form or for settings. (Google Forms is a trademark of Google LLC.)
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Figure 5.59 The colors can be adjusted to reflect your company’s brand. (Google Forms is a trademark of Google LLC.)
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Figure 5.60 You can add your company’s logo on the theme options. (Google Forms is a trademark of Google LLC.)

Now, go back to your Office Supply Order Form. Build out the rest of the questions from the form that we
created in Word. We can use some of the tools now to customize the theme to make it more visually appealing
and professional in appearance. Figure 5.61 shows an example of some customizations that you might choose
to include in the form.
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Figure 5.61 Notice the asterisk following the questions that are required. (Google Forms is a trademark of Google LLC.)

Distributing the Form
The last command of the top toolbar is the Send button, which lets you start the actual surveying process.
After you press Send, you’ll have four options of how to distribute the survey: you can type your clients’ email
addresses and send it to them directly; get a public link, which you can paste into an email; embed the survey
into a website; or post the survey to a social media account (Figure 5.62).

If you choose to send it by email, you will need to copy and paste or manually type in all of the recipients’ email
addresses. You’ll be able to write the body and subject of the message, but there are limitations to the length
and style of the message. You cannot do any text formatting or add graphics in this interface like you would if
you constructed the email in your email program and included the form link. Note that the recipients will not
see the other recipients’ email addresses in the list. Also, there is no way to use the email addresses in your
Google Contacts or other contact list. This approach is best for a small number of recipients. If you expect to
send the form to a large number of people, it is better to use your email program to send the form with the
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link.

The second option is to send the form via a public link. You can copy this link and paste it anywhere. For
example, you can save it for later use, and send it to clients after a business activity has passed (e.g., after a
successful purchase). You could also paste it into an email and send it to your recipients that way.

The third option is embedding, which will give you the .html code so that you can insert the form link on the
company website. When you choose this option, the HTML code will be displayed. You can then copy that code
and use it to embed the form on a website. This option can be used when you want the responders to go to
your company’s website to answer the questions.

Figure 5.62 There are four ways to share the survey to the clients. Choose the link option to send the form through your email
program. The form can also be embedded into a website using the html option. (Google Forms is a trademark of Google LLC.)

Lastly, you can send the form via social media. Forms has Facebook and Twitter (now X) icons on the right side
of the Send form dialog box. Selecting one of these will allow you to embed the form directly onto your social
media page or feed for others to access.

Viewing Responses
Once you send the survey, you may want to wait a few days for individuals to respond. You can consult the
response statistics by going to your form and looking at the top of the form screen. By default, you are viewing
the Questions tab, as seen in Figure 5.63.

Figure 5.63 Even before the survey is complete, you can check the response statistics. (Google Forms is a trademark of Google LLC.)

If you choose the Responses tab, you’ll be taken to the responses report page, as shown in Figure 5.64. At the
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top of the Responses report, there is a Google Sheets icon command; if you choose this, all the report output
will be exported to your Sheets app, and from there you can download the file as an Excel file or CSV. Forms
provides some basic visualizations for the response. If you want more in-depth analysis, you might use other
programs more suited for statistical analysis.

When you want to close the form to new responses, you can toggle the Accepting responses lever on the right
side of Responses tab. This means that no one can submit any more responses to your form.

Figure 5.64 When you are finished accepting responses, you can get the results in Sheets. (Google Forms is a trademark of Google
LLC.)

LINK TO LEARNING

Forms is not just used to create surveys. Read this article on creative ways to use Google Forms in the
workplace (https://openstax.org/r/78GoogFormWork) to learn more. Forms can also be used in your
personal life. Read this article on some very unique uses of Forms (https://openstax.org/r/
78GoogFormPers) to learn more.
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5.6 Advanced Collaboration in Google Docs

Learning Objectives
By the end of this section, you will be able to:

• Use advanced sharing settings in Google Docs
• Use advanced editing level and access settings in Google Docs
• Use advanced settings to view comments and suggested edits

The WorldCorp market trends report needs to advance fast, and the best way to do that is by multiuser
collaboration. By using Google’s cloud service, Google Drive, you can have multiple users work on their portion
of the report simultaneously. As you work in the document, you may see these collaborators typing all at the
same time, as they have their own cursor with their username. This kind of online, synchronous collaboration
will speed up the review and revision process.

Advanced Sharing Settings
The chapter on Creating and Working in Documents discussed basic sharing capabilities of Google Docs. But
understanding the more advanced settings in Docs can maximize your work in the app and help you get the
most out of collaborating in it.

Docs allows up to one hundred persons working on the document at the same time. This can be useful when
many people need to view a file at once, such as real-time meeting notes or a report being discussed on a
conference call. But keep in mind that some of the same limitations exist in Docs as they do in Word Online:
having many people working and editing the document at the same time can cause problems. When several
individuals are working on the same file at the same time, you might see text shifting around, people making
changes in areas you just changed, or conflicting information added by different collaborators.

Fortunately, you can see how many people are accessing the document, and who they are, as seen in Figure
5.65. You can communicate with them using the Google chat software called Google Meet, as Figure 5.66
shows. Collaborators can also chat directly in the document by adding comments as they make edits and
revisions. You can also see where your document collaborators are typing by choosing their icon in the title
bar. Docs will jump down to where their cursor is in the document. The collaborator’s cursor uses another
color, and it moves as the collaborator types.

You can check who has access to this document (at all times, not just when they are online and active) when
you click the Share button at the top right of the document. This will reveal a dialog box displaying all the
people who have been granted permission to view, edit, or comment on the document, as you can see in
Figure 5.67. As you are collaborating on documents with colleagues at WorldCorp, it is helpful to be able to
restrict editing to certain individuals, while receiving comments from others. With Docs, you have the ability to
see where changes are made and by whom.
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Figure 5.65 When sharing the document, you can determine how they can or cannot change the file. (Google Docs is a trademark of
Google LLC.)

Figure 5.66 Docs allows for a lot of interactivity and communication. (Google Docs is a trademark of Google LLC.)
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Figure 5.67 Changes are highlighted with the name of the editor who made the change. (Google Docs is a trademark of Google LLC.)

Sharing Without Adding Collaborators
There may be times when you want certain people to have access to a Doc, but they do not have a Google
account. Or, you may not want to add them as a formal collaborator to the document, but rather just give
them access to review the document instead of making edits. Luckily, there are ways to do this in Google.

To share the document with people who do not have a Google account, you should generate a shareable link,
and choose Anyone with the link. This is accessed through the Share option in the upper-right corner of the
screen. You can then choose the access level (Viewer, Commenter, or Editor), generate the shareable link, and
copy it into an email or elsewhere for everyone to access, as shown in Figure 5.68. These contributors with no
Google account will be able to open and edit the document with an Anonymous user name.

You may also want to share your document with a third party, without adding them to your group of
collaborators. This can be done using the command Email this file found in the File menu, as Figure 5.69
shows. This command sends the file as a .docx or .pdf to their email.
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Figure 5.68 Non-Google account editors can enter and contribute using an anonymous username. (Google Docs is a trademark of
Google LLC.)

Figure 5.69 The Email in this file command allows you to share your document with a third party without adding them to the list of
contributors. (Google Docs is a trademark of Google LLC.)

You may also convert the document into an embedded document so that it is published on a web page. The
command Publish to the web, located in the File menu, will open a dialog box (Figure 5.70). Here, you have
two options: either to provide a Link to the file or create the .html code to embed the information directly on
the web page. Using either method will make the information available to anyone on the internet, so use
caution when choosing to publish information from a Google file to the web. Check the box Automatically
republish when changes are made if you want the embedded object on the web page to be updated when you
change the document. If you do not choose this option, you will need to update the embedding when changes
to the document are made. Then, click on Start publishing and the .html code will be generated, as shown in
Figure 5.71. Copy and paste these codes onto your web page.

The other option of Publish to the web is to get a public link, as shown in Figure 5.72, which can be shared via
social media or in an email. This public link is different from the Anyone with the link shareable links, because
the public link is searchable in search engines.
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Figure 5.70 Publishing to the web makes the document available on the internet and is searchable on the web. (Google Docs is a
trademark of Google LLC.)
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Figure 5.71 Be sure to check the box to automatically update the information published if changes are made in the source
document. (Google Docs is a trademark of Google LLC.)

Figure 5.72 The public link can be shared now either through email or your website. (Google Docs is a trademark of Google LLC.)
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Advanced Editing Access Settings
The chapter on Creating and Working in Documents discussed the different levels of access you can grant your
collaborators. Granting someone Editing access to your Doc means that they can make any changes they want
to the document. They do not have to track changes, or work in Suggesting mode, if they do not want to. This
is the most open of all sharing settings.

One way to give someone editing access to a Doc is via a shareable link. The user that opens a shareable link
can be restricted in different ways. You can set up the settings to restrict the opener of the file by selecting
Anyone on the internet with this link can edit. As we’ve learned, non-Google users can access shareable links
that have the designation of either Anyone with the link or Public link (Figure 5.68). The other option,
Restricted, allows sharing and collaborating, but with some limitations. If you check this option, the editor,
commenter, or viewer combo box disappears, as seen in Figure 5.73. This means that the link will only open for
people who are listed as collaborators. Figure 5.74 summarizes the kinds of restrictions on shareable links.

Figure 5.73 With the restricted link, only people who were shared at in the past can see the document. (Google Docs is a trademark
of Google LLC.)

Figure 5.74 These are the kinds of shareable links available.

For all types of shareable links, there are the three standard types of readers of the document, as seen in
Figure 5.75. Again, there is also a Share with people settings options at the top-right corner of the Share dialog
box. If you uncheck Editors can change permissions and share, it will prevent editors from changing access
and adding new people. This allows editor recipients to edit, comment, or read, but doesn’t allow them to
share the document. The other option, if unchecked, is directed at commenters and viewers, as they cannot
download, copy, or print the document.
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Figure 5.75 These are the kinds of collaborators available.

Advanced Settings for Viewing Comments and Suggested Edits
Once you are ready to view comments in a Doc, navigate to the top-right area of your document and click on
the Comment history icon (shown in callout 1 in Figure 5.76). Then, click on the bell icon to view and
customize notification settings (shown in callout 2). As shown in Figure 5.77, if you choose Only yours, the
email notifications of changes on the document will be sent to you only if you are being mentioned by an @
operator, or if someone edits some passage you wrote. If you choose None, you will not be notified by email,
even if the changes and comments (and mentions) are related to your written passages.

Figure 5.76 You can view the comments made on a document by choosing the comments tool. (Google Docs is a trademark of
Google LLC.)

Figure 5.77 Adjust the notifications for the document so you will know when comments or changes are made. (Google Docs is a
trademark of Google LLC.)

Once you have chosen your notification settings, return to the Comment history icon. In Figure 5.78, you can
see the sidebar that appears when you click on the icon, showing the comment history. You can view all
comments together in this sidebar. Without the sidebar, you would have to scroll down the screen slowly, to
see all the comments on the document. (The sidebar is similar to the Review pane in Word.) If you want to filter
the comments on the sidebar, you can click on the Comments drop-down command, and filter by For you,
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Open, and Resolved (Figure 5.79).

Filtering by For you gives you all comments that are directed to you directly with the @ symbol. Filtering by
Open gives you all comments that are marked as open, regardless of who the comments are directed toward.
And, finally, filtering by Resolved shows all the comments that have been marked resolved and are no longer
active comments to address.

Figure 5.78 The comment history sidebar shows all of the comments made in a document, and includes information like usernames,
timestamps, and comment status. (Google Docs is a trademark of Google LLC.)
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Figure 5.79 You can easily see all comments on a long document all together using the comment history. (Google Docs is a
trademark of Google LLC.)
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Chapter Review
Key Terms
add-on third-party application that can be added to Google, which extends the basic functionality of a

program with features that are not already included
Anyone with the link accessibility limit in Docs’s shareable links, in which the Doc can be accessed by

anybody with the link, even if they do not have a Google account
business plan document that describes a company’s plan for growth and profitability
cardstock sturdy kind of paper material, typically used for business cards
Comment history feature in Docs that places all comments on a sidebar for easy viewing
content control fields placeholders for the type of questions that the respondent will use to respond
Design Mode tool that lets the form composer type a description of the question that instructs the survey

taker how to answer
Developer tab tab that is used for forms, macros, and managing add-ons or templates; it is not one of

Word’s default tabs
form document type that has blanks for the recipient to add their information
invoice bill that indicates what goods or services one party has sold to another; it usually displays the

quantity, price per unit, and total
letterhead contact information and name of a person that is placed on top of letters
mail merge tool in Word that lets you auto-populate certain field types, such as name and address
main document document that will have merge fields added to it; it will be auto-populated with the

information from the source document when mail merged
merge fields blank fields that get auto-populated with the information imported from the source document
merged document completed mail merged document, with all information auto-populated
Publish to the web most public way to share a Doc; publishes the document so that it is searchable by

internet search engines
Restricted accessibility limit in Docs’s shareable links, which only allows users who have already been shared

on the document to access it
résumé document that displays a job seeker’s work experience and academic degrees, along with their skill

set
source document spreadsheet or other document that serves as the source file for the information that will

go in the merge fields in your main document
Submit a template feature in Docs that lets the user submit a saved template for use in the public Template

Gallery
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Summary
5.1 Creating Different Document Types in Microsoft Word

• Being able to create different types of documents in Word is an important skill. You can either use a
template or create them from scratch.

• Although many people use email, printed business memos are still common, and the way they are
composed is important to know.

• It is also important to know how to create and format documents on letterhead and printed envelopes.
Letterheads display your name and contact information, while printed envelopes help add a look of
professionalism to your communication.

• Business cards can be designed in Word and printed by yourself, or by a printing company using cardstock
paper. They display your contact information.

• Brochures and flyers are forms of print advertising that can also be used digitally.
• Invoices always contain what you or your company is billing a client for. Microsoft has a large number of

templates you can create an invoice from.
• A business plan usually has a standard layout, which a template can help you with. But it can be helpful to

look at samples of business plans online so you can understand what kind of language to use in the plan.
• When looking for a job, it is important to have a polished résumé and cover letter. The professional look

and feel of your documents can go a long way in helping you start your career.

5.2 Mail Merge in Microsoft Word
• Mail merge is a tool in Word that can personalize dozens or hundreds of form letters. It allows the user to

designate merge fields for any type of customized client data, such as names, addresses, or other details.
• To do a mail merge, you first need to create your main document, or the document that contains the letter

or information going to your recipients. You can temporarily designate where the custom fields will be by
highlighting them.

• Next, you need to create or access a source document. A source document is the place where you have all
of your recipients’ information. The information you include here will go into the custom fields in the main
document.

• You complete a mail merge by combining the main document and the source document. The resulting
item will be the merged document. Word will create one letter for each recipient you designated in a
single document.

5.3 Creating Forms in Microsoft Word
• The Developer tab is part of Word’s set of command groups, but it does not appear by default, and needs

to be manually activated. It is used for making forms, macros, handling add-ons/templates, and other
advanced processes.

• Fillable forms are built using the tools in the Controls command group of the Developer tab. This
command group contains options for content control fields, which are used for creating different types of
questions for forms. The respondent uses the content control fields to answer the questions in the form.

• Creating a fillable form in Word is a multistep process. You should first create your questions, then choose
the question types, add in the content control fields, then finally edit the properties for each question.

5.4 Creating Different Document Types in Google Docs
• Docs lets you create and publish your own templates. It does not have as many templates as Word in its

default Template Gallery, but it does allow users to search through user-generated templates on the
internet.

• There are no default templates in the Template Gallery for business memos, envelopes, business cards,
flyers, brochures, or invoices, but these can all be made from scratch in Google Docs.
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5.5 Creating Forms in Google Docs
• Forms is part of the Google workspace of software programs that allows the writer to send a form

electronically, and automatically tabulates their answers. Google provides some templates that users can
base their forms on.

• Forms also allows for creating forms from scratch. Users can choose from a wide array of question types,
add multimedia questions, and apply different themes.

• The results from responses collected through a form can easily be downloaded into Sheets for data
analysis.

5.6 Advanced Collaboration in Google Docs
• You can share a document using an email or a shareable link. There are three types of shareable links:

public links, anyone with the link, and restricted.
• Docs allows many users to edit and type in a document concurrently. This can be done with layers of

permissions, from editor, to commenter, to reader.
• Comment history collects all comments into a sidebar. This can save time for the user because this way,

they do not have to scroll through the entire document.

Review Questions
1. What are the key components of a business memo?

a. the business logo, the memo sign, the heading, the body text
b. the letterhead, the addressor’s address, the addressee’s address, the body text
c. the business logo, the name, the job position, the contact details
d. the cover, the back cover, the inside flap, the inside center

2. Why might you want to design your own letterhead?
a. It shows professionalism.
b. It demonstrates mastery of a complicated skill.
c. It helps define your career.
d. It keeps your information private.

3. Which document is given to a customer for a product or service provided by a company?
a. Cardstock
b. Letterhead
c. Memo
d. Invoice

4. What is the overall purpose of a business plan?
a. A business plan is optional with today’s technology.
b. A business plan is a document that describes a company’s plan for growth and profitability.
c. A business plan should include details about company invoices.
d. A business plan should summarize a company’s interest and motivation for applying for funding.

5. What is the source document in mail merge?
a. the file where the field information is located
b. the list of fields you will be using in the mail merge
c. the Word document where the fields are located
d. the file where the fields are inserted

6. Merge fields in a document are identified using what denotation?
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a. Parentheses ()
b. Double brackets [[ ]]
c. Double angle brackets << >>
d. All caps

7. What is the objective of Design Mode?
a. to customize the preset text labels of each form control
b. to add images to the fillable form
c. to change the preset logo of your company
d. to format the appearance of the form questions

8. Which tab is used for creating forms in the Windows version of Word?
a. Design
b. References
c. Developer
d. Layout

9. What Word tool is used as a placeholder for the types of questions you will have in the form?
a. Design Mode
b. comment
c. merge field
d. content control field

10. ________ are used to enhance Google Docs’s functionality to do more specialized tasks.
a. Templates
b. Extensions
c. Add-ons
d. Forms

11. How do you navigate to the templates in Docs?
a. Go to the File menu, then New.
b. Go to the Insert menu, then Drawing.
c. Go to the Extensions menu, then Add-ons.
d. Go to the View menu, then Mode.

12. What is one quick way to create business cards in Docs?
a. Use a business card template from the Template Gallery.
b. Create a new document from scratch.
c. Go to the Tools menu.
d. Use a Microsoft template.

13. What is one advantage to using a template to create a new form?
a. The template already has a few questions to get you started.
b. The template has all the built-in questions you need.
c. Templates have preset themes that cannot be changed.
d. The template you choose comes with responses.

14. What is the first thing you should do when creating a form from scratch?
a. Find a template to start.
b. Rename the form.
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c. Add your first question.
d. Customize the theme.

15. What does embedding the form on a website do?
a. displays the form directly on the home page of the website so that respondents can enter in their

answers
b. ensures that you reach the greatest number of respondents to fill out your form
c. gives you the .html code so that you are able to insert the form link on the company website
d. links the company website in the title of the form

16. How do you check to see who has access and what kind of access to a Google file?
a. Select the comment button at the top-right corner of your document.
b. Go to the View menu.
c. Examine the file’s version history.
d. Choose the Share button.

17. How do you open the comment history sidebar?
a. Select the comment button at the top-right corner of your document.
b. Go to Google Drive and right-click your document to see its version history.
c. Navigate to your document’s File menu and then toggle Suggesting mode.
d. Go to the Insert menu and then choose the Comment command.

18. What does the command Publish to the web do?
a. creates a link for you to email to respondents through the internet
b. allows you to link or embed the document as a web page
c. publishes the document information to social media sites
d. sends the file to Google Docs templates online

Practice Exercises
19. Design an invoice for the sales of screen panels using a Microsoft template. The client wants 25 LEDs with

64” screens, 99 LCDs with 55” screens, and 15 QLEDs with 75” screens. Use the following information:
Client: Doe’s Electronics
Client Address: 123 Doe Street, Doe City, Virginia, 12345
Use today’s date to date the invoice. Search for the unit price of these TVs on the internet.

20. At this point in your life, you might have a résumé of your own. Let’s look at it critically and revise it.
Choose a template as described in the chapter, then copy and paste your information into the résumé you
are updating for yourself.

21. Write a business memo for your department at WorldCorp using one of the Microsoft memo templates.
The memo should announce to WorldCorp employees that there is a new set of company brand
guidelines, and that all employees at WorldCorp need to upgrade their logos and design in their
letterheads, envelopes, and business cards.

22. Use mail merge to create envelopes using the names/addresses we used in the example in the chapter.
Use a fictional WorldCorp address found on the main document as the return address.

23. WorldCorp is sending a letter to its clients thanking them for their participation in a survey. Write the
“thank you form letter” for the main document from scratch, or use one of the templates from Redtail
Technology (https://openstax.org/r/78RTMailMerge). Adjust the merge fields as needed to include the
company name. Add five company names, street addresses, city, state, and zip code by creating a new list
as outlined in the chapter. These five names and addresses can be made up, or you can use the data in the
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downloadable List Names worksheet (https://openstax.org/r/78ListNamesWkst). Perform the mail merge
of the “thank you form letter,” and use the Edit Individual Documents command for the final mail merge.

24. Design a new form for your WorldCorp coworkers. You are holding training sessions on the new company-
wide computer system, and you need to know when your coworkers can come. Attendance is mandatory,
but the coworkers can choose their own time slot and date. Make a form with the necessary information
(name, position, department, time, date).

25. Create a form that could be used when contacting a new business client for cell phone/tablets for
employees. You will want to gather enough information about their needs to provide them an accurate
quote for monthly costs. Information that you will collect could be decision maker’s contact information,
number of employees, estimated usage of phones/data, how many phones/tablets might be needed, and
other related information. Be creative in selecting the correct question type for the correct form controls.

26. Go to the Extensions menu in Docs. Find a free add-on for business cards. Install the add-on and create
business cards using your own information.

27. Find an invoice template from the Google user-generated templates and create a generic invoice. Find an
image, as a symbol or simple design, to add to the invoice.

28. Use Forms to create a party invitation from scratch. You want to collect names and see how many people
plan on attending a party you are hosting. You might consider what type of party you are planning (e.g., a
graduation party) and other relevant information in order to generate appropriate questions. Consider
adding questions about food allergies or preferences when creating the invitation.

29. Find a template for a customer feedback survey. Modify the template with a different theme and font
style. Change a couple of the questions to different question types and reorder the questions.

30. Write a sample business memo to your WorldCorp coworkers, describing the upcoming market trends
report. Create the memo in Docs. Using the Publish to web option, publish the document to the web using
the two methods: link and embed.

31. Create a Doc detailing a plan for completing an assignment for one of your classes. You could create the
plan based on when the assignment is due and include items such as the date on which you will begin
work on it, what you will need to complete the task, and other related items. Share the Doc with a friend
using the skills in the section. Change the permissions so that the friend can add comments and edit the
Doc.

Written Questions
32. How could templates help your professional presence as a business consultant? Explain.

33. What is the objective and general form of a business card? Explain.

34. What are the similarities and differences between a brochure and a flyer?

35. What are some advantages of using mail merge?

36. Describe the process of inserting fields into the main document.

37. Describe the various content control fields used in creating fillable forms.

38. Explain the purpose of the combo box control.

39. Describe the process of submitting a template to Google. Why do you think Google allows only certain
users to publish templates for others to use?

40. How do you use a Word template in Docs?

41. What are the advantages of Forms over the .dotx surveys you can produce in Word?
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42. What is the objective of a public link?

43. What are the main differences between a Public link and an Anyone with the link shareable links?

44. How is Editing access different from Commenting access in a Doc?

45. Explain a potential concern you might have using a public link for collaboration on document.

Case Exercises
46. Campaignmonitor.com is a company that helps entrepreneurs set up a user-friendly email advertisement

campaign. It has lengthy guidelines on how to design a professional email ad (https://openstax.org/r/
78EmailAd) and lots of infographics and screen captures of excellent examples.
A. Now that you are more knowledgeable on email ads, design your own brief “flyer”-type email. Go to

Microsoft’s template (https://openstax.org/r/78MicTemplate) page and type "flyer" into the search bar
to find a flyer template that you like. Try to implement the lessons from campaignmonitor.com when
you design your own.

B. The flyer can be about a product or organization you are familiar with, such as a school group or the
brand of cell phone you use. Include a description of the product or organization and the overall
features that are appealing.

47. Use the form that you just completed for the Practice Exercise about new customer leads. Using the skills
you learned in Mail Merge in Microsoft Word, create a mail merge to send this form via email to the five
recipients we used in that section. You will need to create fictional email addresses. You can use the
format first initial + last name@company.com for this exercise. Include yourself (use your real email
address) so that you can see how mail merge for emails works. (Note: When you complete the mail merge,
you will get undeliverable email error messages because you used fictional email addresses.)

48. You have been hired to your “dream job.” How could you use the Google Survey feature in your chosen
profession?
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Figure 6.1 Working on a slide presentation can be done individually or collaboratively, depending on the tools you are using. (credit:

modification of “A group of people having a meeting” by Darlene Alderson/Pexels, Public Domain)

Chapter Outline
6.1 Presentation and Design Essentials
6.2 Designing a Presentation in Microsoft PowerPoint
6.3 Formatting Microsoft PowerPoint Slides: Layout and Design Principles
6.4 Adding Visuals and Features to Microsoft PowerPoint Slides
6.5 Designing a Presentation in Google Slides
6.6 Creating Google Slides: Layout and Text
6.7 Adding Visuals and Features to Google Slides

Chapter Scenario
The ability to communicate your vision and ideas effectively will be critical to your growth and success at
WorldCorp. As a new hire, the company’s human resources department will ask you to make a presentation
introducing yourself to other employees. This assignment has two purposes. First, it allows the company to get
to know you better. Second, it trains you in the two most popular presentation software programs: Microsoft
PowerPoint and Google Slides. (There are other presentation software programs available, such as Prezi,
Keynote, or Canva, but PowerPoint and Slides are used more often.) This chapter explores the basics of these
two programs.

PowerPoint launched in 1990 and has grown in complexity with each new iteration of Microsoft Office. It’s hard
to imagine, but many of the features that users rely on in PowerPoint today were available when it was first
released on Windows 3.1. Examples include importing pictures to make them editable, adding transitions
between slides in slideshows, incorporating sound and video into slides, and adding/changing fonts
throughout the presentation. Over the years, the options have expanded. Image and sound quality have
become a premium in today’s world. PowerPoint has been able to keep up with the ability to process high-
definition images and sound. It now includes a design editor that helps users hone their graphic design skills.
While PowerPoint provides tools for designing visually appealing presentations, it is not a dedicated graphic
design program like Adobe Photoshop or Illustrator.

Preparing Presentations
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Slides, which debuted in 2006, offers many features similar to those of other presentation programs. Like
other Google products, Slides relies on an internet connection. It integrates well with Google Docs and Google
Sheets and offers advanced collaboration tools. Slides has continued to advance and adapt to multiple screen
types and user needs.

Your first WorldCorp presentation is already scheduled: You will need to present My Life in a Snapshot. This
presentation is slated to last for five minutes in front of your entire 25-person marketing team. It is designed
as a formal introduction in which all new team members participate.

6.1 Presentation and Design Essentials

Learning Objectives
By the end of this section, you will be able to:

• Understand why and when presentations are used in business
• Understand the importance of knowing your audience and defining your presentation goals
• Describe two essential qualities of good digital presentation design
• Create an appropriate plan for a presentation

Whether we are in front of an audience or in an online meeting, today’s workers should know how to create
digital presentations to help communicate their ideas to diverse and different types of audiences. Our starting
point is learning how to create a digital presentation, or slideshow. Each slide can contain text, pictures, videos,
bullet item lists, WordArt—just about anything.

WorldCorp uses presentations for sales, training, internal communication programs, and external
communication within its ever-growing community. This is accomplished by using the power of words and
imagery to engage audiences. Always keep in mind that the person who delivers a presentation is front and
center to their audience. Microsoft PowerPoint and Google Slides are tools to help facilitate the presentation
for the presenter—not a distraction that takes away from the presentation. This chapter will help you
understand both elements (the person and the program) as you construct your first presentation at WorldCorp
called My Life in a Snapshot.

Why and When Presentations Are Used in Business
WorldCorp is a large, expansive corporation with a vast community of stakeholders. Business presentations in
numerous operational settings share information with internal stakeholders such as employees, managers,
and executives. They also are used to communicate with external stakeholders, such as customers, vendors,
shareholders, and the local community. The marketing team and public relations (PR) professionals are
typically the ones responsible for communicating messages to external stakeholders. But whatever your title
within an organization, you may be expected to know how to build and give presentations.

For example, an employee in the human resources (HR) department may be expected to design and present
on topics, such as business ethics or sexual harassment training, that are mandatory for all employees. These
presentations could be used multiple times to help educate the entire team by using multiple presenters. Or a
presentation may show something fun, such as the end-of-the-year awards celebration. A presentation can
have any number of purposes, uses, and audiences. Your first presentation as a member of the marketing
team will help you make a strong first impression with your coworkers.

Presentations typically fall into one of several categories: to educate or train, to sell an idea, or simply to
convey information to others. The size of your audience doesn’t matter—even a one-on-one meeting may still
necessitate the creation of a presentation. The location doesn’t matter, either. Technology has provided ever-
growing opportunities for communicating effectively and efficiently. Often, a Zoom call, sharing a laptop
screen, or screen casting to a TV may be the perfect option to conduct a presentation.
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Keep in mind that a business presentation could be the audience’s first introduction to the topic. Audience
members will expect the presentation to give them some information they can use to start their decision-
making process.

As a new hire at WorldCorp, you need to craft a presentation to introduce yourself to the leadership in the
marketing department as part of your training program. The My Life in a Snapshot, presentation poses a
typical workplace presentation challenge: You have a limited amount of time to effectively express a complex
topic. My Life in a Snapshot may feel like it takes longer than five minutes to fully explain. How can decades of
information be condensed into such a narrow window of time? To achieve this, considering your audience’s
requests and their needs becomes front and center.

Understanding Your Audience and Purpose
When you are conducting a presentation, your purpose should not be what you want to do; instead, it is what
you want your audience to do as a result of listening to what you expressed. Your audience will consist of
twenty-five WorldCorp employees. Ask yourself: What am I trying to convey? What is the best way to convey it
to my audience? How will my presentation affect them? These are the questions you need to ask when
developing a sense of purpose in a presentation.

You should also know how long your presentation should be. The recommended length will vary depending on
the purpose and content of the presentation. In many cases, the length of your presentation is predefined. In
that case, it will be up to you to maximize your use of limited time to cover everything you need to address.
Planning, crafting, and practicing your presentation are all critical in ensuring the audience gets the most out
of the available time.

Essentials of Good Digital Presentation Design
By following the best practices and helpful tips outlined here, you will be better able to craft effective digital
presentations. Two important concepts to keep in mind are consistency and coherence. Consistency refers to
the presentation having a uniform look and feel. You can achieve this by having a unified color scheme or a
defined layout for each slide in the presentation. Coherence—how all the elements work together to
communicate the intended purpose of the presentation—includes the slides and the presenters themselves.
The purpose or key message of the presentation should be the focal point when creating a presentation.
Keeping the purpose at the forefront will help with both consistency and coherence. Consistency and
coherence work hand in hand when creating an effective presentation. These two concepts will be explained in
more detail in the following sections.

Consistency as an Essential Design Quality
WorldCorp has developed a corporate-wide PowerPoint design template that makes it easy for team members
to maintain consistent brand messaging. Most companies will have established templates and style guides for
creating presentations. Consistency is the quality of always behaving or performing in a similar way, or of
something always appearing or occurring in a similar way. Font styles, background color themes, and
company logos are built into the brand to maintain consistent messaging. WorldCorp’s corporate color is blue,
as we saw in the previous chapters on creating document files. To be consistent with WorldCorp’s brand
image, we want the presentation template to follow that same color scheme. All the slides in the template will
have a similar layout that includes the slide title and some visual elements with the blue WorldCorp branding.
A consistently designed presentation would not use a different color scheme and layout for each slide. This
would appear chaotic and unprofessional. Likewise, you would expect a consistently designed presentation to
use similar font types and size on each slide. Figure 6.2 shows an example.
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Figure 6.2 Presentations designed with consistency in mind align with the company’s corporate brand, such as using the company
logo and color scheme. (Used with permission from Microsoft)

Coherence as an Essential Design Quality
In addition to slides needing to be consistent in design, the presentation must also be coherent. Each slide
should have a logical reason for being a part of the entire slideshow and should connect to the overall purpose
of the presentation. Good digital presentation design will enhance both the presenter and whom they
represent. As you advance in creating digital presentations at WorldCorp, design will become part of your own
messaging and branding of ideas. In designing a digital presentation, coherency refers to the smooth and
logical flow of the slideshow while connecting to the overall message you want to convey. A coherent
presentation includes elements and text that are connected to each other logically. For example, if a
WorldCorp employee is presenting a quarterly sales recap for their team, a coherent presentation will be
centered on sales data, include visuals and text related to sales goals, and maintain an overall professional and
businesslike appearance.

The presenter should also be dressed in business attire, to match the goals of the presentation. See Figure 6.3
for a sample agenda slide for a coherent sales presentation.
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Figure 6.3 A coherent presentation will have a unified message that is focused on the purpose of the presentation. (Used with
permission from Microsoft)

Create a Plan Before Getting Started
To create an effective presentation, you will need to become a storyteller. Start by thinking about how you
want the presentation to unfold. As with dividing an essay into paragraphs, you will need to find an easy way
to separate out the distinct topics in your presentation while also building a cohesive storyline that connects
them. When you choose the ideas that you want to emphasize and the order in which you want to present
them, you are building a plan. This plan will help much like developing an outline for a paper.

Before you begin designing the storyboard for My Life in a Snapshot, you will want to sketch out (either
digitally or by hand) a general plan for the content of each topic. A plan can allow you to organize the content
of your presentation in a visual and logical manner. It breaks down the presentation into individual slides and
shows the flow and progression of information. This can help ensure that the presentation is clear and easy to
follow and that all the important points are covered.

LINK TO LEARNING

One of the tools that can aid the process of developing stories with imagery is a storyboard. A storyboard
divides the elements of a story into impactful moments, each with its own setting, characters, and storyline.
Writers, directors, cartoonists—all sorts of creators use—storyboards.

Crafting a workplace presentation shares many of these storytelling best practices. Watch this video to view
an example of storyboard creation and storytelling (https://openstax.org/r/78Strybd) to see how
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storyboarding can aid in presentation design.

For this project, your outline will cover five topics. Each topic should be unique, with each section of your
presentation clearly distinguished from the next. Let’s revisit the example of the quarterly sales goals
presentation that we discussed in this chapter's section on Coherence as an Essential Design Quality. The
presenter wants the presentation to be informative about WorldCorp’s sales performance last quarter, as well
as help set the stage for next quarter’s goals. One way to approach this is to remind the audience of the sales
goals first. Then, present the sales results from this quarter. Next, talk about how the results connect to the
overall company goals for the quarter or year. And then, finally, discuss how this quarter’s performance can be
used to set goals for the next quarter.

This linear method can be easily sketched out using the bulleted list tool in Microsoft Word or Google Docs
that you learned about in previous chapters. You can then use this outline to create the slides for the
presentation. Figure 6.4 shows an example of a presentation plan using a bulleted list.

You could create a similar outline for your My Life in a Snapshot presentation to help you plan out the slides
and flow of the presentation.

Figure 6.4 A good starting point for a presentation is to put together an outline of the key information you want to share. Each top-
level bullet point could be its own slide. (Used with permission from Microsoft)

Once you have your presentation planned out, you will need to revisit its length and whether your plan can be
achieved within the amount of time that you have. Rather than rewriting the entire presentation, you can look
at your presentation in terms of topics, and see which topics can be lengthened or shortened. For example, if
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you think your presentation will take twenty minutes but you have only ten minutes, start by considering
whether you’ve devoted too much time to the introduction. You could also consider which details, examples, or
other potentially extraneous information to remove to shorten other sections. Remember, you don’t need to
cut an entire topic out of your presentation if you can shorten it instead. With time and practice, you will learn
how to make fine adjustments to the different topics in your presentation.

6.2 Designing a Presentation in Microsoft PowerPoint

Learning Objectives
By the end of this section, you will be able to:

• Create a new slideshow from a blank presentation
• Create a presentation from a theme or template
• Understand the functions of the Home tab
• Understand the functions of the Design tab
• Understand the functions of the View tab

At WorldCorp, Microsoft PowerPoint presentations are used company-wide for a variety of purposes, such as
presenting quarterly sales data or providing training for new sales personnel. As part of the Microsoft 365
suite, PowerPoint has characteristics similar to those of other programs such as Microsoft Word and Microsoft
Excel. PowerPoint is divided into various tabs, which appear across a ribbon that helps you organize your
actions.

In general, creating a storyboard or outline of a presentation, as outlined in the previous section, is a great
starting point, and this is the approach we will use to build My Life in a Snapshot. To get started, this section
provides an overview of the PowerPoint program, with a review of several tabs within the ribbon that you will
use to develop your first slideshow from scratch. As we start using the primary elements of PowerPoint, you
will begin to develop an understanding of how the program works with examples to provide context.

The vast capabilities of PowerPoint enable WorldCorp employees to present complex ideas, facts, and figures
in the form of easily digestible visuals. Allowing users to create visual representations of information on the
blank canvas slides can allow viewers to interpret, engage with, and expound on what they’re seeing.

Let’s begin by using the blank canvas approach to crafting a presentation.

Getting Started
Open PowerPoint and choose a blank presentation (the first option). You should see a screen that looks like
Figure 6.5, with an arrow highlighting the desired choice. If you want to open an existing presentation, select
Open from the left sidebar and search for the file. Another option is to start with a PowerPoint template—a
predesigned set of slides that you can use as a starting point for creating a new PowerPoint presentation.
Templates include a defined layout and color scheme, and they often include sample text and images that you
can replace with your own content. Using templates is a way to save time and ensure consistency in the design
of your presentation. Like many organizations, WorldCorp has a preset template that is often used for external
communications, such as presentations for clients. However, for the My Life in a Snapshot presentation, you
are not restricted to using the template, as this is an internal presentation and is more informal.

In this example, you will start with a blank presentation. After opening this blank document (by double-clicking
on Blank Presentation), you should save it to your computer or to the cloud using a file name that is
identifiable to the content of the presentation. As seen in Figure 6.5, select the Blank Presentation option on
the Home screen indicated by the arrow.
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Figure 6.5 Choosing Blank Presentation in PowerPoint means you will start your presentation from scratch. (Used with permission
from Microsoft)

In a blank presentation, the initial slide PowerPoint provides is blank except for two placeholders: one for the
title and one for the subtitle. When you choose a blank presentation, none of the design elements are defined
in advance. The Title Slide layout that is provided by PowerPoint can quickly be altered. Most presentations
should have a title. Additionally, the program opens to the Home tab found within the ribbon, as seen in Figure
6.6. Now, the blank canvas is ready for you to craft My Life in a Snapshot for your team at WorldCorp.

Figure 6.6 After selecting Blank Presentation, PowerPoint provides loose guidance on where to place a title and subtitle. You can
delete these boxes if desired. (Used with permission from Microsoft)

Creating a Presentation with Themes and Templates
Many companies tend to already have a theme developed for use with company presentations. A
presentation’s theme refers to the overall design and layout of the slides, including elements such as color
scheme, font choices, and graphic elements. Themes are useful because they give you an easy way to create a
consistent presentation by using preset fonts and color schemes. If you had chosen a theme instead of a blank
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presentation, the initial slide would show the same elements, but with the design features of the theme
applied. A theme can also include predesigned slide layouts, which can be used to create a cohesive and
consistent look throughout the presentation.

Within the New tab, as seen in Figure 6.7, selecting a theme allows the designer to set the tone and style of the
presentation, which can help to engage the audience and convey the message more effectively. Themes can
be either built-in or custom-made, depending on the software you are using. PowerPoint offers numerous
themes that you can apply and search for in the search window.

Figure 6.7 PowerPoint shows thumbnails of the different themes, allowing the user to get an idea of the style and color palette of
each one before selecting the one they want. (Used with permission from Microsoft)

Another option that users have is to select a template instead of just a theme. Unlike a theme, a template is a
blueprint of a group of slides that can help meet the topic of a presentation. Templates can contain layouts,
fonts, colors, and background styles much like a theme. Much like a résumé template in Word, for instance, a
template in PowerPoint prompts the user, suggesting sections and topics to include. As an example, a classic
conference presentation might have a specific cadence and style. Slides will be arranged to meet the needs of
a conference with suggested slides and topics to include. Theme and template options are worth considering
and searching for, especially if a theme matches the overall type of presentation you plan to create.

There are benefits to creating a PowerPoint presentation from a theme. First, this approach provides
consistency. The program will offer multiple slides with various concepts, all using the same color pattern,
style, and texture. A theme allows users to focus on the presentation message without distraction from
differing designs, although it does not necessarily guarantee that they will understand the message.
Additionally, starting with a theme ensures that all the slides in the presentation will have a professional
aesthetic design and layout, making it look polished. Aesthetics is the study of how things look and how we
perceive and respond to them. It can also refer to the overall look and feel of something—for example, the
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aesthetics of a website or a building.

PowerPoint themes often include a multitude of predesigned slide layouts, which can save time and effort in
creating your presentation. You can click into the various text boxes or image boxes to provide the required
content, copying the desired layouts that work best for you and deleting those that don’t.

REAL-WORLD APPLICATION

Marketing Toolkits

Most companies now offer their internal stakeholders Marketing Toolkits to use. Marketing Toolkits provide
users with the logos, color schemes, outlines, photo depositories, and ideas on what the company is
looking for when designing marketing materials. Digital presentation information is almost always included
in the toolkit.

With advances in cell phone technology and social media’s growing presence in our lives, companies can
now maximize their marketing reach by enlisting their entire workforce into marketing. By providing
accessible content for creators and guidelines, any employee can now be a part of promoting their
employer.

Not all employees will embrace a Marketing Toolkit. It is only as effective as leadership and the culture of
the company allow. See if any companies you know have a Marketing Toolkit online. Does the company
toolkit offer guidelines for PowerPoint presentations? Presentations to external stakeholders can be a
valuable marketing opportunity.

The themes that PowerPoint provides can be customized to reinforce your company’s image and message by
matching the company’s branding and style. The visual design and layout of themes can be chosen to convey
the message or tone of the presentation in a more effective way, which can make it more engaging for the
audience. These themes can also be easily modified to include different colors, fonts, and graphics, allowing
you to personalize the presentation while still maintaining a consistent design.

Home Tab
Themes are helpful, but to learn PowerPoint more deeply, you will also need to learn how to create a
presentation from scratch. Start by getting to know the Home tab. The tools found on the Home tab are used
to create the general structure of the slideshow, as seen in Figure 6.8. As an introduction to this group of tools,
we will review five key commands, which are circled in the figure: New Slide, Layout tab, the tools in the Font
command group, the tools in the Paragraph command group, and Design Ideas.

Figure 6.8 The Home tab houses five foundational commands in PowerPoint: New Slide, Layout, Font, Paragraph, and Design Ideas.
(Used with permission from Microsoft)
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Using the outline laid out in Figure 6.9, you can create a slideshow from a blank document to present to the
team. From here, you can see how a well-planned presentation of ideas can be created in the form of a
PowerPoint slideshow.

Figure 6.9 A storyboard works well to help plan out your presentation before you start designing the slides.

New Slide
Following the outline in Figure 6.9, the presentation requires five distinct groups of information arranged in
numerical order with subtopics. In PowerPoint, you will want to add five slides, each of which will represent
one of these groups. To do this, go to the New Slide command group and, with your mouse, select the green
button on New Slide four times. (Reminder: PowerPoint provides the first slide by default.) Note that you can
change the layout at any time after creating a slide. For this exercise, any layout will do to get started. The
default layout provided is fine.

Once complete, there should be five slides listed in the thumbnail pane on the left side of the screen. (Figure
6.10 shows the first two of five.) You can then use the thumbnail feature to click in and out of individual slides
as we develop and edit content that meets the storyboard criteria.

Figure 6.10 Your presentation screen should show five slides going down the left side. (The figure shows the first two.) (Used with
permission from Microsoft)
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Now that you have created five new slides, you can edit and format them. It’s a good idea to use the same
steps to edit and format each. For example, you might create a step called “adding text,” ensuring that every
slide that needs text will receive text. The first slide, which is similar to a cover page for the presentation,
requires a standard title and subtitle, and these are provided by default.

Layout
The next command in the Home tab (see Figure 6.8) is Layout tab. When you open the drop-down menu in
Layout, you will see that PowerPoint offers nine basic layout options, which are designed to provide variety,
balance, and consistency to each presentation design. (One of the options is “blank.” This layout gives you a
blank, white canvas to build from, enabling you to design an infinite number of layouts.) For your WorldCorp
presentation example, use the default layout Title Slide for the first slide. A title slide is a slide layout that
provides space for a title and a subtitle. (Note that you are not using a template here.)

To add your content, click into each text box provided (it says “Click to add title” and “Click to add subtitle”).
Start by typing “My Life in a Snapshot” in the first text box. In the second text box, type your name, followed by
your title at WorldCorp and your geographic location, as seen in Figure 6.11.

Figure 6.11 Slide number one is a title slide, with two lines for you to fill out. (Used with permission from Microsoft)

Next, in the thumbnail panel, select each slide and change the layout for the rest of the slides. Depending on
the content of your presentation, it can be helpful to have different layouts on different slides. This
presentation will use three different layouts to accommodate different types of information. Follow along by
selecting each slide from the thumbnails, then selecting the Home tab, followed by selecting the layout option
from the ribbon. You can choose to have information on the slide presented in a different way by changing the
slide layout. For example, you could have two groupings of text side by side, as is shown in Figure 6.12, or have
the content on the slide grouped all in one area. Make sure to change the layout setting so it accurately
reflects the recommendations found in Figure 6.12.
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Figure 6.12 (a) The Title Slide layout has large text to display the title of your presentation. (b) One layout option is to have a title for
the slide with one grouping of text under related to the title. (c) Yet another layout option is to put two groupings of text on the slide
displayed side by side. (Used with permission from Microsoft)

Font
Font choice plays a big role in PowerPoint presentations. Each letter, number, or symbol on a slide can be
adjusted to a specific design. Using these options allows you to make your text more visually appealing. The
process for selecting or changing a font is similar to the way you change a font’s details in Word. In
PowerPoint, however, you will often have much less text to manipulate than in a Word file, and the text is
usually much larger so an audience can easily view the information from a distance.

When you change font characteristics, be sure to choose what will best meet the audience’s needs. There are a
few easy rules of thumb to follow when you create text for a presentation to a large audience. One of them is
what’s known as the seven-seven rule—that each slide should have no more than seven lines of text and each
line of text should have no more than seven words. This will help prevent you from relying on punctuation or
sentence structure to convey your message. When it’s necessary to communicate via paragraphs of text, Word
may be a better tool to distribute those types of communication either as handouts along with the
presentation or in lieu of the presentation altogether. But, remember, this is only a rule of thumb. It is
acceptable to deviate by a few words or lines based on the message and content of the presentation. The point
is to keep the slides clear and simple and not to distract from the presenters themselves. Best practices can be
a great help in keeping the audience front and center in your mind and staying focused on the purpose of
your presentation.

Fill in the required text as displayed in Figure 6.13. As with changing the layouts, click on each thumbnail,
select the required text box, change the font to meet your needs (including the type and color of the font), and
adjust the font size as needed. Type the required information (this will be your chance to start explaining who
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you are to your team), and then make sure to review your work for any errors. Take your time. Word choice can
be a challenging task. Make sure that every slide is accounted for. Then, you’re ready to move on to the next
step of designing My Life in a Snapshot.

Figure 6.13 It can be helpful to choose a font style and size at the planning stage, even before your slides are final. Filling in the
information in slides (a) through (e) will help you better visualize the presentation content from the audience’s perspective. (Used
with permission from Microsoft)

A variety of presentation styles are available, so be sure to take note of the things you like and dislike in the
presentations you attend as you develop your own style preferences. Consider the contrast between the text
and the background. How easy is it to read the text while listening to a presenter? Does the text work both
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compressed on a laptop screen (as in a Zoom call) and displayed on a 176-inch projector screen designed for a
room full of people? You will notice that the font size and choice are large and easy to read in this project.
Later, as you explore the many available options, you are likely to find that the text font needs to match the
theme of the presentation.

Next, consider the text. Is this the appropriate content to display? As an example, in Figure 6.14, you can
compare the options for our closing slide choice. Is the use of a graphic image of a question mark the best
option, or would a written question, as in the center image, be more effective? In some cases, a combination
of pictures and text may work best. There is no perfect answer—PowerPoint gives you many options. But at
some point, you will need to make decisions. No matter how creative the formatting of the text, a combination
of content may be a better option when deciding what layout and kinds of content to use.

Figure 6.14 Different types of content on a slide—picture only, text only, or a combination of text and picture—can convey different
messages to your audience. (Used with permission from Microsoft)

Paragraph
Both the font and the paragraph options have functionality only when a text box has been selected. As with
the paragraph options, Office offers a helpful array of choices for line spacing, adding bullets, numbering,
aligning text, and adding or removing columns. If the default bullet points or line spacing options provided in
the text box layouts are incorrect or missing, this can be a place to add or change the required element. You
can make changes within a text box either by selecting the entire text box or by selecting only the location you
want to change.

Design Ideas/Designer
The latest option group Microsoft has built into the newest PowerPoint versions is the Design Ideas tab (also
called the Designer tab in different versions of PowerPoint). (Refer again to Figure 6.8.) This is an on/off button
that provides advanced slide layouts and “smart” options when turned on. The Design Ideas feature increases
the options available to you as the content creator of My Life in a Snapshot—or any presentation you may be
called on to create.

Select the first slide in your presentation, which is typically the title slide, and type in the title of the
presentation. As the title is added, you can see how quickly a few words can shape an entire slide. Turn on the
Design Ideas option in the Home tab. You will notice several options to the right of the screen. These options
are often unique to the words and layout you provide. In this step, select an option that fits your personality,
and the transformation will occur. An example is provided in the comparison Figure 6.15 from an employee
who started not too long ago in WorldCorp’s South Asian Marketing division. The image on the left was the
general text the WorldCorp team member typed into the default Title Slide layout. The image on the right is
the option they chose that best matched their personality, which was created and offered by the designer in
PowerPoint. Keep in mind that the Design Ideas option is available for only one slide at a time.

Because the Design Ideas option was turned on, it reviewed the text within the text boxes and considered
several complete design options that could apply. Starting with a very limited bit of information, the Design
Ideas option could add multimedia content (3D models, pictures, background themes); alter the text
alignment, color, size, and formatting; change the layout; and create an entire theme representing the
keywords on the page. It could even add simple animations, such as a snowflake background with snowflakes
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gently falling. Having these action components is like having an entire production team on call to quickly
merge your ideas with existing collaborative content to make exquisite slides.

Figure 6.15 The Design Ideas feature can create themes and layout combinations based on your specific presentation. (Used with
permission from Microsoft)

Design Tab
Instead of using the Design Ideas feature, you may want to design your PowerPoint yourself. The wide range
of design options in PowerPoint allows you to change the overall look and feel of your presentation, quickly
and easily. By using the built-in templates, color schemes, and slide layouts, you can transform the roughed-
out text that you added earlier to polished, professional-looking presentation slides without spending much
time and effort on design. (You will learn more about this process in the chapter on Giving Presentations).
Rather than using the Design Ideas feature, which only formats a single slide at a time, the Design tab
provides a collection of tools for altering color schemes and layout designs for all of the slides at once. For
example, you could change your entire color palette with just a few clicks of the mouse, applying the design to
all the slides according to their predefined layout. Additionally, the option to change the slide layout makes it
easy to organize the information in a way that is easy for the audience to follow and understand.

In summary, the Design tab in PowerPoint will help to make the process of creating a presentation faster,
easier, and more professional-looking, by allowing you to communicate your message in the best possible way
for your audience. Building new content for presentations is like building anything else: To do a professional
job, you need professional tools, and you need to know how to use them.
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Now it’s time to select the design and variation recommended in Figure 6.16. The first command group on the
Design tab focuses on themes. Each theme is unique and modifiable. We have a particular theme we want you
to use for the remainder of your slides. Hold down the Control key on your keyboard (Ctrl). With your mouse,
select slides 2, 3, 4, and 5 from the thumbnails. Go to the top of the screen and choose the theme circled in
Figure 6.16. The theme will be applied to only the slides you selected. Your uniquely designed title slide will
remain. Remember to save your work. You will quickly notice how themes and variations can elevate your
design.

Figure 6.16 Selecting the Design tab and changing the theme and variation of the slides that were selected (slides 2–5) allows the
title slide to be different but brings consistency to the remaining slides. (Used with permission from Microsoft)

For more ideas, you can turn to the Design Ideas pane at the right of the slide area, as shown in Figure 6.16.
(Note that in this figure, the Design Ideas option is called Designer.) For even more ideas, click on See More
Design Ideas at the bottom of the pane. This can be accomplished by selecting a particular slide. On the ribbon
on the Design tab, the Designer/Design Ideas option will illuminate on the far-right side. Click on the icon and
then scroll down, and you can click again on See More Design Ideas. If you have Microsoft 365, your app will be
updated as designers add new themes.

The next command group on the Design tab is titled Variants. Variants are essentially modifications you can
make within a single theme. These provide a way to add a different overall look. This group initially displays
four different color schemes to use with your theme. It lets you change the color combinations, font, or
background, or add special effects. For every theme you choose, you can alter the color scheme and font
combination (title and regular text). Make sure in your slideshow for My Life in a Snapshot that you have
selected both the theme and the corresponding variation of the theme.

Figure 6.17 displays other variant settings that you can customize, including fonts, effects, and background
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styles. These options can be accessed in the Design tab, within the Variants ribbon, using the down arrow
option. Colors, Fonts, Effects, and Background Styles all become options with a multitude of choices.

Figure 6.17 These are the options offered in the Variants command group. Think of them as “variations on a theme,” or a deeper
level of control over your design. (Used with permission from Microsoft)

Selecting the arrow to the right for Colors extends a drop-down list that displays many preset color scheme
possibilities, plus a Customize Colors option that allows you to change all of the colors in a scheme. The Font
variant lets you pick different fonts for title text and body text. The Effects variant, or Artistic Effects, applies a
graphic effect or filter to your slides, such as making them look like a sketch or a painting. Effects can be
applied to a single slide or to all slides within the presentation.

The last command group on the Design tab is Customize, which gives options to change the slide size and
format the background appearance. You won’t need to use this option for your first presentation, but it is a
helpful tool to learn for your future presentations. The slide size command offers two principal choices of
aspect ratio, which is the relationship of the slide’s width to its height: standard (compatible with older screen
sizes), with an aspect ratio of 4:3, and widescreen (for today’s HD environment), with an aspect ratio of 16:9
(Figure 6.18).

Figure 6.18 Changing the aspect ratio will apply to your whole presentation. (Used with permission from Microsoft)

Also found in the Customize group of commands is the Format Background command. Click on it and you will
see the menu as shown in Figure 6.19. This command lets you change the background of a slide by changing
the fill to a solid color, gradient fill, pattern fill, and so on. Select fill and then hover over each of the circles to
see the available color and background options.
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Figure 6.19 This customized background makes use of a gradient fill. (Used with permission from Microsoft)

Format Background contains all the options for changing the background: Solid fill, Gradient fill, Picture or
texture fill, and Pattern fill. Each option has its own set of elements to adjust. Solid fill is just that—choose a
solid color for your background. Gradient fill lets you choose the way the color is spread across the slide, the
intensity or transparency of the color, and the shape the background effect follows as it moves across the slide.
Finally, you can fill the background with a pattern or a photo.

There are many ways to customize a theme to meet your specific needs. Different color combinations, fonts,
effects, and background styles are all elements you can use to customize your presentation. Even small
changes may be transformative.

View Tab
The next tab to review is the View tab. To have a basic understanding of PowerPoint, you will need to know the
general purpose of several view options. Within the View ribbon, there are seven command groups. The first
three are circled in Figure 6.20, starting with Presentation Views.
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Figure 6.20 PowerPoint has many different options for viewing your presentation, from both viewer and behind-the-scenes
perspectives. You can zoom in on areas, enlarge the screen entirely, view the elements in different colors, and arrange the windows
so you can click through them more easily. (Used with permission from Microsoft)

When creating slides, you will typically work with the Normal View, the default view that PowerPoint opens
within a new presentation (Figure 6.21). The large window shows the current slide, and the other slides are
shown as thumbnails down the left side of the window. The large window gives you plenty of room to focus on
developing content and layout for each slide while you can also jump in and out of each slide through the
thumbnails.

Outline View shows a list of the slides on the left, highlighting the text rather than the actual slides as pictures.
In Outline View, you can scroll through the text of each slide rather than having to jump in and out of
individual slides. This can be a great aid when reviewing or organizing text, as seen in Figure 6.22. (You may
have noticed that we changed our title slide to match the theme of the rest of the slides. Now the presentation
has a more consistent design.)

Figure 6.21 In Normal view, you can see thumbnails of your presentation. (Used with permission from Microsoft)
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Figure 6.22 In contrast, Outline View only shows an outline of the text on the slide. (Used with permission from Microsoft)

Slide Sorter is an option that lays out slides in order, allowing you to move them around with a drag-and-drop
of the mouse. This view is useful when you want to add or delete a slide or change their order.

For example, suppose a team member creates a photo album to introduce themselves, with each slide
consisting of a single photo. If they select thirty photos, creating an album with thirty slides, Slide Sorter View
can help them edit the album by adding or deleting a photo and by arranging the photos in the desired order.
In My Life in a Snapshot, with only five slides to edit, this view would be overkill. But with a larger presentation
with many more slides, a Slide Sorter View can be a helpful option.

Notes view (or Notes Page) displays a single slide with the notes below the text or image. These notes are
typically designed for the speaker. They may be reminders, citations, or any various notes that the presenter
wants to have at their fingertips. This can be handy when a user wants to add or edit a large amount of text. If,
for example, they have a lot of text on a slide but are not sure yet which words might be best to highlight for
the audience, this area of notes can provide a collection place for content.

The Reading View displays slides one at a time, as they would appear in a slideshow. Utilizing the View option
allows you to take any one of the five slides and adjust the size of text boxes and change alignments—all while
seeing most of the screen.

The Master Views option group may be a bit advanced for this introductory review, but we will provide a brief
example. Within this group, the Slide Master is simply a template of the slide, breaking apart the individual
components of the slide layout. This is a time-saving method for creating professional and consistent
presentations. You can start with one of the PowerPoint themes or a blank slide, add or change the colors, add
borders, change the font, and change or create a layout of your own. You can insert text boxes and object
placeholders. When you do this on a master slide, you create a template that unifies the slides in a slideshow.
When you have completed a slide that you want to keep as a master slide, select File, Save As, choose a
location, and, in file type, choose PowerPoint Template. This is now a Master Slide template that you can use
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repeatedly.

Handouts Master and Notes Master are specialized viewing modes for specific tasks. The Handouts Master
options allow developers to create a template for the PowerPoint printed handout for audience members.
Slides can be arranged; titles, dates, and notes can be laid out. Within the Notes Master option group, the view
of the slides and printable notes can be arranged as you desire.

6.3 Formatting Microsoft PowerPoint Slides: Layout and Design
Principles

Learning Objectives
By the end of this section, you will be able to:

• Format the layout of each slide
• Understand best practices in design principles

It’s time to transform the five slides from My Life in a Snapshot by manipulating the layout and adding options.
Formatting the layout of each slide in Microsoft PowerPoint is the process of adding, subtracting, and/or
adjusting the arrangement of elements such as text, images, and shapes on a slide. You may want to format
the layout of a slide in PowerPoint to make it more visually appealing and effective for your audience.
PowerPoint includes many options for altering the layout of the slide. The slide layout can be changed by using
the tool on the Home tab in the Slides command group. From the Home tab, select Layout tab from the Slides
command group. Here, you will see a listing and image of the layout options.

We have used three types of layouts in My Life in a Snapshot. Here are some commonly used slide layouts:

• Title Slide: This layout includes a title and subtitle and is typically used for the first slide of a presentation.
• Title and Content: This layout includes a title, subtitle, and one or two content boxes that you can use for

text or media. This layout is typically used to give an overview of the presentation and the main topics to
be covered.

• Comparison: This layout includes two content boxes, which can be used to present different types of
information, such as text and images, or to compare and contrast two pieces of information.

• Section Header: This layout is used to create a slide that can be used as a header for a section of a
presentation. It typically includes a title and subtitle, with a distinctive design.

• Content with Caption: This layout includes a content box and a caption box, which can be used to present
a single image or other media and provide additional information about it.

These common PowerPoint slide layouts can help you create a clear and effective presentation structure. You
can add, remove, or customize placeholders as you need, as well as use combinations of these layouts to
create a unique, personalized presentation. PowerPoint also offers a variety of built-in slide layouts that you
can use to create different types of slides.

Formatting Layout
When you design your slide layouts, arranging text boxes and other objects becomes key in making sure they
are positioned in an effective manner. In this section, we will review the Alignment Guides option within the
View tab and discuss the numerous built-in layout designs that PowerPoint can offer.

Alignment Guides
As stated previously, getting things to look exactly how you want them to appear next to each other is crucial
to maximizing the design power of PowerPoint. But it can be difficult to align objects with other objects on a
single slide, or objects with text, using only your mouse. Under the View tab, you will find a helpful alignment
tool that you can access by checking the Guides box. When this box is checked, there will be two dashed lines
on the presentation slide, one centered vertically and the other centered horizontally.
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When you hover your mouse over one of these lines while holding down the Ctrl key, the cursor turns into a
double line with arrows. Drag the line to where you want one guideline to be and let go of the mouse. When
you do this, another line is created.

MAC TIP

Hold down the Option key, not the Ctrl key, to turn your cursor into a double line with arrows.

You can continue to add guidelines anywhere on your slide to insert and align objects, text boxes, photos, and
so forth. (In the section on Adding Visuals and Features to Microsoft PowerPoint Slides, we will cover inserting
objects and images.) See Figure 6.23 for a visual example of what the guides look like after adding them to a
slide. (If you see that the Guides box is checked but no lines are apparent, just uncheck it and check it again.
That will usually bring the guides back into view.)

Figure 6.23 The lightly colored dashed lines set off a narrow margin around the slide. (Used with permission from Microsoft)

LINK TO LEARNING

Not every presentation has to be delivered by a person. There are many reasons why creating a self-
running presentation is valuable. Many companies will design a presentation that can be left unattended in
a booth or kiosk, at a trade show or convention, or saved as a video and sent to a client list. A self-running
presentation can also help address time-related constraints. Read Microsoft’s steps for creating a self-
running slideshow in PowerPoint (https://openstax.org/r/78MicroSelfRun) to learn more.

Design Principles
In this section, you will learn about some basic design principles that are best practices for designing your own
slides or choosing a theme for your presentation. You’ll find out how to use proximity, alignment, repetition,
contrast, and white space to make your design elements stand out.
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Proximity
In photography, proximity refers to nearness—the distance between the camera and the subject being
photographed. In the context of PowerPoint, it refers to the distance between the audience and the subject
matter being presented. You can control the relative proximity within a PowerPoint slide. In photography,
proximity can affect the composition of the photograph by changing the relative sizes of the elements in the
frame. For example, if the camera is positioned close to a small subject, the subject may appear larger in the
frame; if the camera is positioned farther away, the subject may appear smaller. The proximity of the camera to
the subject can also influence the overall look of the photograph. A photograph taken from a close distance
may have a more intimate or detailed appearance, while one taken from farther away may have a more distant
or expansive look.

Proximity is an important consideration in designing PowerPoint layouts because it can affect the composition,
perspective, and overall look of each slide. In Figure 6.24, you can see two different sizes of the budget sheet.
The first one is effective for an overall view of what the document looks like. The second one is more effective
if you want the audience to be able to read it. If so, it’s preferable to zoom in as close as possible to that
content.
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Figure 6.24 These slides show two examples of proximity as it relates to how information is displayed to the audience: (a) displays a
chart with a distant proximity to the subject matter and (b) displays the same information, but with the audience in closer proximity.
(Used with permission from Microsoft)

Alignment
Aligning objects or text on a page adds organization and creates a sense of cohesion, making your content in
general more usable. When alignment exists on a slide, the human eye knows where to focus, and the slide is
more comfortable to view. In PowerPoint, alignment is the way that text, images, and other elements are
positioned on a slide. Proper alignment is important because it helps to create a cohesive, professional-looking
presentation. When elements on a slide are aligned, they are more visually balanced, which can make the slide
look more organized and appealing to the audience. Properly aligned elements can help guide the viewer’s eye
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and create a natural flow from one element to the next, making the presentation easier to follow and
understand. In addition to the Guides checkbox that we reviewed in the section on Formatting Layout, there
are also checkboxes for Rulers and Gridlines. Ticking these boxes will show additional lines on the slide that
will help you align your slide elements.

Repetition
Repetition is the use of similar or identical elements, such as colors, fonts, or design elements, across multiple
slides in a presentation. In a slideshow, repetition—especially when similar elements are repeated across
multiple slides—can make the presentation feel more polished and professional and make it easy for the
audience to follow and understand. Repetition also promotes a consistent look and feel for the presentation.
Repetition of important elements such as headings or key points can establish a visual hierarchy that guides
the viewer’s eye and makes your presentation easier to follow.

Repetition of visual elements is a good way of reinforcing the key points you want to establish with the
audience because they know where to look. In this way, repetition makes the main message of your
presentation more memorable and connected for the audience.

Contrast
In presentations, contrast refers to the use of different elements, such as colors, fonts, and other design
elements, to focus attention and create visual interest. You may want to use contrasting colors, such as
complementary colors or light and dark shades, or contrasting fonts, such as a bold or decorative font for
headings and a simple font for body text. Using contrast helps create a hierarchy and makes your presentation
easier to follow.

Using contrasting design elements, such as different shapes or patterns, can help to add visual interest and
break up the slide into distinct sections. Overall, contrast is a useful tool in presentations because it can help to
draw attention, create visual interest, and make the presentation more effective and engaging for the
audience. Notice how in the new title slide of My Life in a Snapshot (Figure 6.21), the title is in large font, the
subtitle is in small font, and the colors used are off-white, red, and black. The different font sizes and colors
contrast with one another and create an engaging, yet professional, appearance.

White Space
The last design element to consider within this section is white space. White space, also known as negative
space, is the unoccupied areas of a slide that are not filled with text or other content. By leaving enough white
space around text and other elements, you can make the content easier to read and understand. White space
can be used to create visual interest by creating balance and separating different elements on the slide. By
surrounding a key point or element with white space, you can draw attention to it and make it stand out.
Additionally, using white space consistently throughout a presentation can help to create a cohesive look and
feel. It is an important element of slide design and can be used in a variety of ways to enhance the readability,
visual appeal, and effectiveness of a presentation. Filling your slides with text or images will make them look
too busy and hard for your audience to read. Using the Designer tool to suggest different layouts can help add
white space and sustain interest throughout the presentation with aesthetically pleasing slides.

Another principle that underlies all the design principles reviewed in this section is known as the rule of
thirds. This is a basic principle of photography and design that suggests that an image can be divided into
nine equal parts by two equally spaced horizontal lines and two equally spaced vertical lines. It is essentially a
tic-tac-toe game board!
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REAL-WORLD APPLICATION

Applying the Rule of Thirds

The rule of thirds theory suggests that if you place the important elements of the image along these lines,
or at their intersections, your photo or design will be more balanced and will have more visual interest. By
placing the main subject of your photo or design along one of the lines or at an intersection, you can create
a sense of tension and dynamism that draws the viewer’s eye into the image. Additionally, using the rule of
thirds can help you avoid placing the subject of your image dead center every time, which can make for a
static and uninteresting composition.

Although the rule of thirds is not a hard-and-fast rule, it is a useful guideline that can help you create more
visually appealing and dynamic compositions in your slide creations and layouts. Figure 6.25 provides an
example of a grid created according to the rule of thirds.

Figure 6.25 This is an example of how you might set up alignment guides using the rule of thirds. The red stars show some of the
ideal positions to place either text or images. (Used with permission from Microsoft)

There are other composition models you can use, as well. The point is that in design, composition is the basis
of it all. You want a well-composed layout and placement of text and images, aligned so that the eye moves
easily about the slide.

6.4 Adding Visuals and Features to Microsoft PowerPoint Slides

Learning Objectives
By the end of this section, you will be able to:

• Add tables to slides to organize and present data in a grid format
• Insert images into slides
• Add written information to slides
• Use symbols to enhance visual appeal
• Include equations to represent complex mathematical concepts
• Utilize WordArt to maximize the impact of text
• Use the tools in the Illustrations command group to increase the design appeal of slides

Adding visuals and features to Microsoft PowerPoint slides makes your presentation more engaging and
interesting for the audience. It’s best to do this after the text has been formatted and the general layout
established. Visuals such as images, charts, and videos can help to break up text and make the presentation
more visually appealing, keeping the audience engaged and making it easier for the audience to understand
and remember the information. Additionally, using relevant, high-quality images will help make your
presentation look more professional.
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Adding Tables
A table in PowerPoint is a structure for organizing and presenting data in a grid format. It is similar to the
Table feature in Microsoft Word. In Figure 6.26, the Table option has been selected within the Insert tab. You
will not need to include a table in your My Life in a Snapshot presentation, but tables are regularly included in
professional presentations.

Figure 6.26 The Insert Table option on the Insert tab of PowerPoint is identical to inserting a table in Word. (Used with permission
from Microsoft)

There is a grid located directly under the Table option, followed by Insert Table. Using the mouse, click and
hold to select the desired number of cells you want to include. In the figure, a 3 x 5 table has been
highlighted—specifically, three cells horizontally and five cells vertically. A 10 x 8 grid is provided, but if this size
is too limiting, the Insert Table option enables you to build a grid all the way up to 75 x 75. Keep in mind that
the facts and figures contained in your table need to be visible and easy for your audience to understand.

The Draw Table option allows you to create a table by literally drawing it on your slide. As you select the option,
the cursor becomes a pencil. You can first draw the table border and then sketch out cells that meet your
needs. This option is especially useful when you’re not looking for a perfectly symmetrical grid. If you prefer to
create tables within Microsoft Excel, you may prefer the last option within the table group, Microsoft Excel,
which opens an Excel worksheet inside the slide. You will have to save the Excel sheet as its own document, but
it will be stored within the PowerPoint slide.

Adding Images
The Images command group, located to the right of the Insert Table option, gives you the following options:
Pictures, Screenshot, and Photo Album. In general, an image is a visual representation of a scene, object, or
information, often captured or created through digital means. In today’s technological world, your cell phone
is also a professional camera with advanced formatting options, enabling you to share photos instantly on
social media and in texts and emails. Adding photos and screenshots in PowerPoint can be just as effective.
Those saved files can be at your fingertips to add to your presentation.

One good option is to use the Pictures feature to add an image to your PowerPoint presentation, either from
your device or from the internet. You can also add a stock image—a preexisting photograph or illustration
that you can purchase for use in websites, brochures, presentations, advertisements, and other forms of
media. Stock images are created by professional photographers and illustrators and are usually sold through
online stock image agencies. These images can be used by anyone who buys the rights to use them, rather
than having to commission a photo or illustration specifically for their project. Stock images can be used to
supplement or enhance a presentation, brochure, or website by adding relevant and interesting visual
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elements. They can also be used to illustrate a point or idea, by providing an image that represents a concept
or feeling. Stock images can save time and money, avoiding the need to create new images specifically for
your project.

Stock photos are often fairly generic and not specific to a location or brand. For example, you can use a stock
photo of a team working in an office environment to illustrate teamwork in the workplace. Many stock photos
are considered to be available in the public domain and therefore are free to use, although this is not true of
all stock photos. Be sure you keep copyright issues and licensing requirements in mind when using stock
photos in your presentation. You can find websites of stock photos such as Vecteezy or Shutterstock. Some
companies may have licenses or accounts with these websites. Some stock photo websites focus on specific
styles and types of photography, such as photos showcasing diverse groups of people.

To personalize My Life in a Snapshot, add two photos from your personal collection to the last slide. To add a
photo from your computer to a PowerPoint slide, follow these steps:

1. Open PowerPoint and select the slide on which you want to add the photo.
2. Click on the Insert tab in the ribbon at the top of the screen (Figure 6.27). In the Images command group,

click on Picture, then select This Device. (This means that you will be inserting a picture from your
computer.) If you want to add a picture from your phone, you can email the photo to yourself and
download it to your computer. If you want to use a picture from the internet, again, download the picture
and save it to your computer. A window will appear, allowing you to browse your computer for the photo
you want to add. Navigate to the folder where the photo is located, select it, and then click the Insert
button (Figure 6.28).

3. The photo will be inserted onto the slide. You can then move it around by clicking and dragging it to the
desired position. You can also resize the photo by clicking and dragging the handles (small squares)
around the edges of the photo (Figure 6.29).

Figure 6.27 PowerPoint also gives users the option to access stock photos or online pictures directly from the Insert Picture menu.
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(Used with permission from Microsoft)

Figure 6.28 After you locate the image file on your device, choose Insert to place the image on the slide. (Used with permission from
Microsoft)
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Figure 6.29 Once you have placed the image, you can resize it and move it on the slide. (Used with permission from Microsoft)

To format the picture, first select it with your cursor and then use the options under the Picture Format tab,
such as cropping, adjusting brightness and contrast, and adding a border. The Picture Format tab only shows
up if the picture is selected. When you are finished, save your presentation by clicking on the File menu and
selecting Save. By following these steps, you can add photos from your history that will be shared with
WorldCorp’s team.

The Picture option supports all picture formats. Notice that when any of the three pictures are highlighted/
selected, the Picture Format tab opens, as shown in Figure 6.30. This new ribbon tab will appear all the way on
the right end of the ribbon. The first command group, Adjust, lets you adjust and add corrections to the actual
picture, such as its color, brightness, and transparency. The last command group in this ribbon, Size, is helpful
to know. The Size group within the Picture Format ribbon contains a feature called Crop, which is available in
most Microsoft Office programs.

Figure 6.30 The Picture Format ribbon opens automatically when you select any kind of image. (Used with permission from
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Microsoft)

Having the ability to crop a picture to a preferred size can be a time-saver. You no longer need to find a perfect
image, but only a piece of the image that is perfect for your needs. Notice in Figure 6.31a how much ice is in
the picture. The ice skates appear small in relation to the entire slide. By cropping some of the ice out of the
picture, then enlarging the image to fit the space (Figure 6.31b), you can emphasize what you want your
audience to see.

Figure 6.31 Parts (a) and (b) show a before-and-after example of how a picture can be cropped to expand the focal point. (Used with
permission from Microsoft)

Adding Text
A great way to add a well-placed description of an image is to insert a text box. Let’s add a text box to your My
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Life in a Snapshot presentation, as shown in Figure 6.32.

To add a text box, open the PowerPoint presentation to the slide where you want to insert the text box. Click
on the Insert tab in the top menu. In the Text section, click the Text Box button. Click and drag on the slide to
create the text box. Type or paste your text into the text box that describes each photo that you selected to
share with the WorldCorp team.

Figure 6.32 By default, text boxes will not have visible borders unless you choose to add them. This gives a seamless look when
placed next to or on top of an image. (Used with permission from Microsoft)

You can use the Shape Format tab to customize the text box, such as changing the font, color, or size of the
text, just as you did when adding text to existing text boxes provided by PowerPoint in the various defined
layouts. Once finished, you can move the text box around by clicking and dragging it, much like any other
object or image within the slide.

Adding Symbols
You can add symbols to a PowerPoint slide to enhance the visual appeal of your presentation and to make it
more engaging. Symbols can include anything from emojis to arrows to creative shapes, like hearts. You can
use symbols to represent different ideas or concepts, to emphasize certain points, or to create a visual
hierarchy, arranging the elements of your design according to their level of importance. The purpose of visual
hierarchy is to guide the viewer’s eye to the most important information or elements first, then to less
important information. It’s a good idea to use symbols sparingly, and only when they add value to your
presentation, so they don’t become distracting. This first presentation doesn’t require the addition of a symbol,
but the steps for adding one to a slide are as follows:

1. Open the PowerPoint slide where you want to add the symbol.
2. Click on the Insert tab in the top menu.
3. In the Illustrations command group, click the Symbol button. A menu will appear with a selection of

symbols. Choose the symbol you want to use and click on it to add it to the slide. (Note that these steps
may vary slightly depending on the version of PowerPoint you are using. In some versions, Symbols is its
own command group on the ribbon.)

You can also use the Format tab to customize the symbol by changing its size, color, or shape.

It is helpful to know the most common types of symbols that you can use in a PowerPoint presentation:
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• Icons: simple, graphic symbols that you can use to represent concepts or ideas, such as an icon of a light
bulb to represent an idea or an icon of a person to represent a customer

• Arrows: used to direct attention, to show cause and effect, or to indicate a process
• Emojis: used to add a personal touch or to create an emotional impact
• Shapes: can include simple symbols such as check marks, stars, and hearts; they can be used to

emphasize a point or to indicate a positive or negative aspect

Always note that the symbols you use in your PowerPoint presentation should be appropriate for the context,
audience, and purpose of the presentation.

Adding Equations
Another feature to consider inserting in PowerPoint slides are designed equations. An equation is a
mathematical statement that shows the relationship between two or more quantities, using mathematical
symbols and operators. Equations are used to describe a wide range of physical, biological, and economic
phenomena, and are central to many areas of science and engineering. Simply click on the option on the
Insert tab and select from a list of drop-down options. (Note that the Equation option will be grayed out unless
your cursor is active on the slide canvas.) A new tab, Equations, will appear on the ribbon, revealing many
options for inserting and editing equations.

Adding an equation to a slide in PowerPoint can enable you to represent complex mathematical concepts in a
clear and concise manner, making it easier for your audience to follow your presentation. Equations can
convey a level of technical expertise and professionalism, which can be especially important in the STEM fields
(science, technology, engineering, and mathematics). They can be used to emphasize certain points in your
presentation, such as key formulas or important calculations. Using equations to support your arguments can
increase the credibility of your presentation and give your audience more confidence in your claims.
Additionally, you can use PowerPoint to create interactive equations that allow the audience to manipulate
variables—a useful option in fields like education and training.

You will not be asked to add an equation to My Life in a Snapshot. However, it is important to remember that
when adding anything, even equations, to your PowerPoint slides, they should be formatted correctly and
should be used in a way that supports the overall message of your presentation. The process for inserting and
editing equations is covered in more detail in the chapter on Document Preparation.

Adding WordArt
In PowerPoint, WordArt can add visual interest to a slide by using different font styles, colors, and effects that
are prebuilt and designed for maximum impact. This can make your presentation more engaging and
memorable for your audience.

WordArt can be used to emphasize important points or quotes in your presentation, making them stand out
from the rest of the text and allowing for more creative expression than a simple text box. For example, you
can create shapes, bend text, and add different effects to make your text more appealing than what is offered
in a simple text box.

WordArt can be used to give your presentation a consistent look and feel, which can be especially important
when creating presentations for work or business purposes as the exaggerated font is easy to duplicate across
different slides. Additionally, WordArt can be used to create a visual hierarchy, making it easier for people with
visual impairments to read your slide.

Now, let’s put this tool into action. As seen in Figure 6.33, start by selecting the fourth slide, Goals, to work on.
This slide tells the audience about your short-term and long-term goals within the coming year at WorldCorp.
To clearly separate the goals, we will use WordArt to change the headings for each.

1. Start by highlighting the heading “Long Term.”
2. Select Insert, WordArt, and then choose a style.
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3. Once selected, WordArt will appear in the center of the slide. Delete the original text box.
4. Select and drag over the WordArt text in replace of the original heading.
5. Repeat these steps for “Short Term” using a contrasting style choice (Figure 6.34).

Figure 6.33 WordArt can enhance your text beyond simple formatting, adding elements such as gradients, fills, and shadows. (Used
with permission from Microsoft)
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Figure 6.34 Giving slightly different styles to “Long Term” and “Short Term” helps differentiate the lists. (Used with permission from
Microsoft)

WordArt should be used sparingly, and only when it adds value to your presentation. It’s also important to
make sure that the WordArt doesn’t distract from the main message of your slide. Always consider if a text box
is more appropriate due to the length or positioning of the statement. In addition, consider if the provided text
needs to be formatted.

Shape Format Tab
You can easily create and change WordArt within the Shape Format tab. To format WordArt in PowerPoint,
open the PowerPoint slide where you want to format the WordArt. Click on the WordArt that you want to
format. Click on the Shape Format tab in the top menu. Use the options in the Text Effects and WordArt Styles
sections to change the font, color, and effects of the WordArt. Additionally, you can use the Text Fill and Text
Outline to change the fill and outline color of the WordArt. There are numerous options to explore and
evaluate on what may work best.

Use the Text Box to change the size and shape of the text box that contains the WordArt. Use Arrange to
change the position of the WordArt in the slide and use 3D Rotation to rotate the WordArt, as seen in Figure
6.35. As with all additions and changes, use WordArt sparingly, only when it enhances the overall look and feel
of your presentation and adds emphasis to certain points—but not every point!
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Figure 6.35 Rotating your WordArt-formatted text gives a dramatic appearance. Use caution when employing this feature, as it can
sometimes be too informal for business presentations. (Used with permission from Microsoft)

Adding Illustrations
Much like adding images, illustrations can have a lasting impact in a presentation. An illustration is an image
that’s “handmade,” so to speak, using either tangible elements such as pens and pencils or digital elements
such as media. In this case, please take note of understanding the copyrights of the original work before
selecting illustrations. In this section, we will walk through how to add a star to your presentation along with
exploring some of the various illustration options. There are several types of illustrations that can be inserted
in PowerPoint, including:

• Shapes: basic shapes such as rectangles, circles, and arrows, as well as more complex shapes like
flowchart symbols and callout shapes

• Icons: simple, symbolic images that can be used to represent concepts or ideas
• Charts: bar charts, line charts, and pie charts that can be used to present data in a visual way
• SmartArt: predesigned graphics that can be used to create diagrams, lists, and other types of illustrations
• 3D models: models that allow you to rotate and zoom in on an object to show it from different angles

These types of illustrations can be used to make slides more engaging and memorable and to effectively
convey the intended message. Now, we will take a closer look at shapes, icons, and the use of charts.
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Shapes
To add a shape to a slide in PowerPoint, first click on the Insert tab in the ribbon at the top of the PowerPoint
window. Click the Shapes button in the Illustrations command group. Select the desired shape from the drop-
down menu; in the next step of your project, you will be looking for the shape of a star (Figure 6.36). Click and
drag on the slide to create the shape. Shapes can be resized and positioned to enhance text and images on
slides.

Now, it’s your turn to add a shape to My Life in a Snapshot. When selecting the area to draw the shape,
consider that it can be formatted later on to fit more exactly. It may take several attempts and practice to get
the hang of working with these digital drawing tools. Simply select the corners of the shape and position the
shape according to the location in Figure 6.37.

Figure 6.36 PowerPoint includes a large inventory of shapes that can be used to enhance your slides’ visual appeal. (Used with
permission from Microsoft)
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Figure 6.37 Dragging any of the dots will allow you to resize your shape. Select and hold the curved arrow to rotate your shape.
(Used with permission from Microsoft)

Icons
Icons can be used in PowerPoint slides to enhance the visual appeal and convey information in a more exact
manner. An icon is a small graphic symbol that represents a specific function, feature, or tool. Icons can be
added much like Shapes by selecting the icon you want and then drawing it on the slide. These, too, can be
resized and formatted after being placed on the slide.

Icons are slightly different from shapes in that they are intended to be universal messaging tools used to
illustrate a point or concept for your audience. You might use a compass icon to indicate “direction” or a heart
icon to indicate “emotion.” You can also use icons as bullet points to make your slides more visually interesting
and easier to read, or you can add them to diagrams and flowcharts to help clarify the meaning of different
elements instead of using text. You can use premade icons from the PowerPoint library or from the internet, or
you can also create your own icons by combining different shapes and formatting them as you want, using
different colors, sizes, and other options to convey your message effectively.

Charts
PowerPoint provides various types of charts, including column, bar, line, pie, and scatter charts. To add charts
to your slides, go to the Insert tab, Illustrations command group (Figure 6.38). You can customize your charts
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with formatting options such as color, labels, and legends. Additionally, you can import data from external
sources, such as Excel and Microsoft Access, to create your chart in PowerPoint. This is another element you
won’t need to use in your My Life in a Snapshot presentation, but it will be a useful tool when presenting data.

Figure 6.38 Inserting a chart allows you to provide a visual representation of numbers and data in your presentation. (Used with
permission from Microsoft)

Depending on your settings, inserting a chart may automatically open Excel so that you can input data to
create your chart. Experiment with this process so that you can better understand how to create your data,
series labels, and categories.

SmartArt
SmartArt can be effectively used in a PowerPoint slide to visually represent information or ideas. It can be used
to create diagrams, flowcharts, organizational charts, and other types of graphic organizers. To use SmartArt
in a PowerPoint slide, you can select the Insert tab, then click the SmartArt button. This will open a menu of
different SmartArt options to choose from, as seen in Figure 6.39.
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Figure 6.39 SmartArt offers a list of options to select from with a preview screen on the right side. (Used with permission from
Microsoft)

Once you have selected the desired SmartArt option, you can enter the text or information that you want to
include in the graphic, as you would in a text box. You can also customize the appearance of the SmartArt by
changing the typical colors, shapes, and layouts. Each option is designed toward a particular function, such as
showing a linear process (like a flowchart) or relationships in a company (like an organizational chart). Take
your time looking through these options to ensure that the intent matches the design.

3D Models
One of the newest options that PowerPoint is offering is adding 3D models to a slide. A 3D model in
PowerPoint is a digital representation of a three-dimensional object that can be inserted into a presentation
and manipulated to show different views and perspectives. 3D models can be effectively used in a PowerPoint
slide to add visual interest and help convey complex information. They can be used to demonstrate products,
architecture, or other real-world objects in a more engaging and interactive way.

To use a 3D model in a PowerPoint slide, you can select the Insert tab, then click the 3D Models button, as seen
in Figure 6.40. This will open a menu of different 3D models to choose from, or you can also import your own
3D models. Once you have inserted a 3D model into your slide, you can rotate, pan, and zoom the model to
show different angles and perspectives. Additionally, you can customize the lighting, shadow, and material of
the model to suit your needs. A 3D model can help the audience to better understand the product or the
object you’re showcasing by capturing the exact angle or motion that is called on.
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Figure 6.40 By selecting one of the categories, a unique list of options can be reviewed and considered for use. Many of the graphics
show animation and movement. (Used with permission from Microsoft)

A good thing to note when deciding to work with 3D models: you will need to have a version of PowerPoint
that supports 3D models, such as PowerPoint 2019 or later.

6.5 Designing a Presentation in Google Slides

Learning Objectives
By the end of this section, you will be able to:

• Discuss similarities between Google Slides and Microsoft PowerPoint
• Review differences between Google Slides and Microsoft PowerPoint
• Explain the roles Google Slides and Microsoft PowerPoint play in a workplace

My Life in a Snapshot was intended to be a solo presentation, so you had no need to assemble a team. But
what if you need to design a presentation on a different topic that does require a team? What if, for example,
the presentation was a proposal for a new marketing campaign that you and four others have been working
on? Is Microsoft PowerPoint still the best option? This section will introduce Google Slides as another tool you
can use to create and build presentations.

Slides is the presentation application offered in the Google suite of products, which is a cloud-based system. To
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better understand the tool and its importance, let’s get started with the similarities it holds with PowerPoint.

Similarities between Google Slides and Microsoft PowerPoint
PowerPoint and Slides are both software programs that allow you to create and edit slideshows for
presentations. When you begin to create a presentation with Slides, you will be presented with several themes
and templates suitable for various applications in business, school projects, and general use. These designed
templates can be customized with color, text, and style. Figure 6.41 shows Slides when first opening the
program and selecting a new presentation; the default, a blank presentation, is circled. Next to the blank
presentation option are the different themes and templates.

Figure 6.41 The different templates and themes have descriptive titles, such as “Status report,” to help users choose an appropriate
one. (Google Slides is a trademark of Google LLC.)

As in PowerPoint, once a presentation is either opened or begun in Slides, you will see a ribbon with tabs and
options that are comparable with those in PowerPoint. In some cases, the programs even use identical word
choices, such as the File, View, and Insert menus. It is a good idea to review the tabs in Slides before beginning
a project. Look for the numerous overlaps in terminology and the familiar icons Slides shares with PowerPoint.
However, one distinct feature of Slides is that it offers drop-down boxes from each tab, rather than a changing
ribbon, as in PowerPoint.

There are other similarities between Slides and PowerPoint. For example, the thumbnails of the slides run
down the left side with the highlighted slide in the center of the frame, and tabs across the top of the sidebar
for navigation purposes. Both programs offer options for adding new slides, changing layouts, selecting
design elements, and inserting text/images.

Both programs can create professional, high-quality electronic presentations. As technology continues to
evolve, both programs adapt and continue to offer user-friendly tools. In general, both tools allow users to:

• add text, images, videos, charts, graphs, and links to any slide
• pick a custom font while selecting and using premade themes
• use basic transitions between slides and print to PDF
• collaborate with team members to greater or lesser degrees

Differences between Google Slides and Microsoft PowerPoint
Understanding some of the key differences between Slides and PowerPoint will help you decide which tool to
use and when it can be most helpful while working at WorldCorp. To start, PowerPoint is a stand-alone
software program that users can purchase or access through a provider such as a school, a company, or an
organization to which they belong. Stand-alone software programs are typically installed on a computer’s hard
drive and can be launched by double-clicking an icon on the desktop or by selecting the program from the list
of installed programs in the operating system. Stand-alone software programs are self-contained and do not
rely on external resources, such as a connection to the internet or services to function. They are referred to as
“offline capable.” The application, or app, is just a click away for the user to begin their work, regardless of
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their internet connection. As the program has advanced and added new features, it has expanded to include
online collaboration. PowerPoint now offers users online experiences through the combination of Microsoft
OneDrive and Microsoft 365.

Slides, by contrast, is a web-based software application that is part of the Google suite of productivity tools. As
covered in the chapter on Essentials of Software Applications for Business, web-based software programs are
hosted on a remote server and accessed over the internet using a web browser, rather than being installed on
a computer’s hard drive. This makes it possible for users to access the software from any device with an
internet connection, as the software and data are stored remotely and not on the user’s local machine. This
helps ensure that there are no delays or negative experiences such as slowing down a user’s internet
connection. They are often designed to be more lightweight, with fewer features compared with their desktop
counterparts.

As a cloud-based application, Slides offers a unique advantage to offline applications when collaborating in a
team. As with other Google programs, users can work on the same file in real time across multiple computers.
This facilitates collaboration and eliminates the need to pass files back and forth between team members.

However, Google does offer an offline option for users as well. When using Google’s web browser, Chrome,
users can install a browser extension that allows its online Google programs, such as Slides and Docs, to
download the applications to their local computer, allowing users to work on their projects even without access
to the internet. Additionally, Chrome operating systems typically come with other Google offline programs
preloaded. Google offline functionality is available for some mobile devices and most desktop operating
systems. It’s possible to use Google offline for some mobile devices and most desktop operating systems.

The most prominent difference between Slides and PowerPoint lies in their origins as a cloud-based
application versus a desktop application, respectively. Slides has a minimal appearance and relatively fewer
features, keeping things simple across their programs for ultimate user ease. Its goal is accessibility and
collaboration in an online environment. In contrast, PowerPoint offers more robust features with more
capabilities. In this respect, Slides works better than PowerPoint on mobile application devices.

However, it is still optimal to use a computer when creating a presentation in either program. Using a cell
phone or a tablet poses challenges for users who want to harness the full potential of PowerPoint. To
maximize the user experience, PowerPoint is recommended for use on a laptop or desktop computer due to
its overall capability and processing needs. Having a larger screen with a more robust computer processor can
make it easier to see subtle editorial changes or to handle large file size changes to a high-resolution image.

How Microsoft PowerPoint and Google Slides Function in a Workplace
Several features of Slides make it a unique and intriguing piece of software to have alongside PowerPoint.
Both programs are commonly used in workplace settings, but may be used with different goals and audiences
in mind. At WorldCorp, different teams use different tools in ways that work best for them; often, team
members find that a project requires a combination of both programs.

A best practice for a collaborative presentation would be for a team to start working in Slides. Team members
can work offline if they choose, or they can work together online constructing slides. Once the rough outline of
the presentation has been accomplished and agreed upon through online collaboration, the Slides
presentation can be saved as a PowerPoint file. Conveniently, Slides offers a way to quickly export
presentations as PowerPoint files. A member of the team who is well-versed in PowerPoint and digital
presentation development can then edit the slides if needed. They can work offline to unify and format each
slide into a cohesive slideshow.

Conversely, you can also open a PowerPoint file in Slides. However, note that because Slides is less feature-rich
than PowerPoint, you may not be able to preserve your slideshow exactly. Let’s look at converting the saved
PowerPoint presentation that you have been working on, My Life in a Snapshot, to Slides. First, upload your
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PowerPoint presentation to your Google Drive. Then, open Slides; the PowerPoint most likely will be listed as a
recently saved file on the opening screen. Select the file and begin. Figure 6.42 shows the warning that Slides
wants to issue before you start editing: “Some PowerPoint features can’t be displayed and will be dropped if
you make any changes” appears in a dialog box after selecting the saved file. There are fewer design options
with Slides, and Google does not include all of the features that PowerPoint does, such as WordArt. This means
that anything that was formatted as WordArt in PowerPoint will not appear correctly in the Google Slides
version, or may even be deleted entirely. For this project, please go ahead and dismiss the warning to begin.

Figure 6.42 When opening a saved PowerPoint presentation, Slides warns users of the potential loss in functionality. (Google Slides
is a trademark of Google LLC.)

You may want to do this conversion process if you want to open your PowerPoint file for online collaboration,
for instance. If your PowerPoint does not contain too many complex features, converting the file to Slides is
usually an easy process that results in a Slides presentation that looks extremely similar to your original
PowerPoint.

Sometimes, your choice of which program to use is determined by the software ecosystem that your company
is part of. Workplaces will often choose one type of program—Google, Microsoft, or another large brand—to
use at all levels of their company to streamline usage and file types. Preference and ecosystem requirements
will typically be the key drivers in determining which tool to use for your presentation, but once you have
learned one of the applications, you will have a faster learning curve when it comes to learning the other.
Because Microsoft has traditionally dominated the office workplace, applications like Word and PowerPoint are
more common in business settings. However, with schools and small businesses looking to offer free and
affordable options for newer users (for example, Chromebooks are required in some classrooms), Slides
continues to expand its reach. Its ease of use can attract those new to working with digital presentations or
collaborating with teams on a project. Knowing and being confident in both programs removes the walls of an
ecosystem, particularly if it is easy to change files from one type to the other. As we work in ever-diverse
workgroups, the ability to move from one program to another becomes increasingly important.

6.6 Creating Google Slides: Layout and Text

Learning Objectives
By the end of this section, you will be able to:

• Modify font
• Change spacing options
• Modify borders and lines
• Understand how editing layouts works

Google Slides is a successful program that continues to grow in popularity, particularly with the rise of mobile
technology, the use of digital tools in the classroom, and an increase in remote workplaces. At WorldCorp, you
will need to know how to use both Microsoft PowerPoint and Slides, and understand the strengths and
weaknesses of both programs. To become familiar with Slides, we will spend some time working with the tools
and options on your existing project, My Life in a Snapshot.
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How to Modify and Edit Text
As with any document, different fonts can convey different emotions and styles. Using a bold or italic font can
help to emphasize certain words or phrases, while a different font can be used to create a specific style or
theme for the presentation. If your presentation is for a business or organization, it may be important to use a
specific font that aligns with the company’s branding guidelines. WorldCorp prefers the Oswald font for
external documents. If text boxes are being used, be sure to modify each text box to the company standard.
Although this choice may feel limiting, this approach drives the consistency of brand messaging for WorldCorp
team members.

You may recall that converting a PowerPoint file to a Slides file may result in some changes. Take a look at slide
number 4, “Goals,” in Figure 6.43 and Figure 6.44. You will notice in Figure 6.44 that the WordArt formatting
used for “Short Term” and “Long Term” has been removed, because WordArt is not a feature of Slides.

Figure 6.43 In PowerPoint, the WordArt feature allows users to add formatting to text as shown in the headers on this slide. (Used
with permission from Microsoft)
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Figure 6.44 When converting PowerPoint slides to Google Slides, some formatting like WordArt is not supported and will be
removed. (Google Slides is a trademark of Google LLC.)

The headings on the Slides version are rather light-colored and hard to read against the gray background. We
can revisit the option of changing those to a new font color in the future. However, rather than modify the
headings again now, we will walk through how to modify the text below each heading to the company’s
preferred Oswald font. Please follow the four-step directions and refer to Figure 6.45.

1. Highlight the text within the text box.
2. Select the drop-down menu. Find Oswald in the list of fonts.
3. Select the Oswald font (this should alter the highlighted text).
4. Repeat for the text listed under Short Term.
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Figure 6.45 When you select a font from Google's drop-down list, that font will also appear at the top of your Recent fonts list.
(Google Slides is a trademark of Google LLC.)

Modifying the font can help to ensure consistency throughout the presentation and make it look more
professional. Some fonts may not be compatible with all devices or may not be accessible for people with
visual impairments. Modifying the font can help to ensure that the presentation is accessible to all viewers and
can be viewed correctly on different devices. However, note that the list of font options is drastically limited as
compared with PowerPoint.

How to Modify Line Spacing
To modify the spacing of the font in a Slides presentation, select the slide where you want to modify the font
spacing. In My Life in a Snapshot, there’s no need to modify spacing, but this option may come in handy when
working with large font sizes and unique font styles.

To get started, select the text box or shape that contains the text you want to modify. Click the Format option
in the top menu bar. In the Format menu, select Line & paragraph spacing. You can then choose the spacing
you want, such as single, double, or custom (which allows you to enter a specific value). Make sure that
Paragraph Spacing is set to 0. If not, spacing may continue to look off. Once the selection is made with the
desired changes, click the OK button to apply them to the selected text.

How to Modify Borders and Lines
An additional tool that can come in handy is the ability to format borders and lines. In general, format refers to
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the way something is arranged or structured, usually in terms of its appearance, organization, or presentation.
This term is used in a variety of contexts and can refer to various aspects of a document, file, or image, such as
its layout, font, color scheme, page margins, and overall design. When formatting a border, you may want to
consider the color, weight, type, dashes, and decorations.

To do this, open the slide where you want to modify the border of a text box. Select the text box, it will appear
highlighted in blue. Click on the Format tab at the top of the screen. In the drop-down menu, select Borders &
Lines. You can then choose the type of border you want, such as solid, dotted, or dashed. You can also choose
the color weight and transparency of the border. Once the selection has been made with the desired changes
applied, click the OK button to save the changes.

How to Modify the Layout of a Slide
As in PowerPoint, each time text or images are added to a particular slide, the size and positioning of objects
may need to be adjusted or changed. One option in Slides is to change the overall layout of the slide in the
Slide menu. The Slide tab is a drop-down menu that allows users to create, edit, and organize slides within
your presentation. Figure 6.46 shows the list of options from the drop-down menu.

Figure 6.46 The Slide menu gives you tools to customize your slides with themes, transitions, and background modifications.
(Google Slides is a trademark of Google LLC.)

Notice again the similarities between PowerPoint and Slides. PowerPoint’s Home tab contains many of the
same features that are available in the drop-down menu of the Slide tab in Slides. The Slide menu gives users a
wide range of tools and options for creating and organizing slides in a presentation, so you can create
engaging and effective presentations that can be easily shared and viewed by others.

The Slide menu also contains an interesting feature, Apply layout. This tool provides a default layout to the key
elements on your slide.

In addition to using the tools and features in the Slide menu, you can also simply select an object (image, text
box, or border), click and hold to move, then drag the object around the screen. Every object also comes with
positioning points around the edges of the object to resize and adjust the shape, or to rotate and spin the
object to the desired positioning. Take your time with these features. A special option for text box objects is
that they will offer a helpful shrink to fit option for overflow text when selected.
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You can also use the Arrange menu to change the layout of your slides. This menu offers options for bringing
objects forward and back, centering and aligning, and rotating objects.

As with many of its features, Slides has more limited options for formatting, particularly text boxes. While
PowerPoint will provide adjustment lines to help position the size and placement of similar objects next to one
another, Slides does not offer these tools. However, Slides has many advantages over PowerPoint when it
comes to ease of use, accessibility, and collaboration. Both tools are useful in different contexts.

6.7 Adding Visuals and Features to Google Slides

Learning Objectives
By the end of this section, you will be able to:

• Insert images and offer tips on best practices
• Insert and format a shape in a slide
• Insert a table into a slide
• Insert a chart into a slide
• Discuss why a diagram can be helpful to a slide presentation
• Add special characters
• Discuss how and why a link should be added to a slide presentation
• Explain the process of adding video to a slideshow

Adding visuals and features to Google Slides can enhance the overall presentation and make it more engaging
for your audience. Much like Microsoft PowerPoint, there are numerous reasons why it’s important to focus on
the visual aspect of a presentation that your audience will experience. To start, visuals can help convey
information more effectively such as images, charts, and diagrams conveying complex information in a way
that is easy to understand, making the presentation more effective. This also addresses a variety of learning
styles, as some individuals are more visual than audio learners. Adding these features to a Slides presentation
is fundamentally similar to how they are added in PowerPoint.

Let’s revise the My Life in a Snapshot presentation a little further. Because Slides does not have the same
designs and themes that we find in PowerPoint, let’s choose a theme that presents a professional appearance.
As we reviewed in the section on Similarities between Google Slides and Microsoft PowerPoint, choosing a
theme in Slides is quite straightforward. Let’s choose the Swiss theme (see Figure 6.47). Now that we’ve chosen
the theme we want to use, let’s move to inserting images and adjusting the rest of the presentation in Slides.

454 6 • Preparing Presentations

Access for free at openstax.org



Figure 6.47 This theme has a completely different background and layout from our theme in PowerPoint. Slides automatically
adjusted the image and text to fit. (Google Slides is a trademark of Google LLC.)

Inserting an Image
Our presentation already includes an image of Amir, but if you want to update or change the picture, you can
do so through Google Drive. Once your image is saved to Drive, we can easily insert the photo into the
presentation. Slides’s streamlined approach makes it simple to add imagery to slides. To add your new picture
to the first slide, start by making sure that you have the first slide selected in your Slides presentation. Click on
the Insert menu at the top of the screen. Select Image from the drop-down menu. You can then choose to
upload an image from your computer, or search for it in Drive, or select a photo from Google Photos. Select
Drive and select the recent profile picture you took on your smartphone. You can then move and resize the
image as needed.

Keep in mind that copyrighted and trademarked images are not to be used in professional presentations. Take
time to review the laws that apply and make sure that a basic understanding of where the images are derived
from is taken into consideration when adding images to a presentation.
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SPOTLIGHT ON ETHICS

Why Is Education Using Copyrighted Material?

Speaking in general terms, using copyrighted images for teaching and education is considered fair use. Fair
use is not always clear and must be decided on a case-by-case basis using the four factors presented in U.S.
Code, Title 17, Chapter 1, Section 107:

1. Purpose and character of the use, including whether such use is of a commercial nature or is for
nonprofit educational purposes

2. Nature of the copyrighted work
3. Amount and substantiality of the portion used in relation to the copyrighted work as a whole
4. Effect of the use on the potential market for or value of the copyrighted work

In general, it is considered fair use to use a copyrighted work in an educational setting, such as a college
classroom or during a group tutoring session. But does this fair use extend to the workplace? It depends.
An internal training session is a different scenario from a client-facing business presentation. Consider the
preceding guidelines each time you want to use a copyrighted image and see which ones, if any, apply to
you. To be safe, remember that it is always permissible to use a public domain image.

Inserting a Shape
You can choose from a variety of shapes, such as rectangles, circles, arrows, and more to add to any slide in a
slideshow. These design elements are useful and easy to adjust within Slides. Once you have selected a shape
from the Insert tab (see the options in Figure 6.48), click and drag on the side to create the desired size (Figure
6.49). You can then move, resize, and customize the shape as desired.

Figure 6.48 The drop-down window of the Insert tab in Slides has the option shapes listed. On further selection of shapes, a large
variety of useful options appears. (Google Slides is a trademark of Google LLC.)
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Figure 6.49 When you select the desired shape, you can resize it by dragging the outline of the shape. (Google Slides is a trademark
of Google LLC.)

One way to effectively use a shape in Slides is to create a flowchart to illustrate a process or workflow. Using
shapes also offers more customization than simply inserting a diagram. Once you have added the initial
shape, you can then add a connector, such as an arrow. Then, you can use the formatting options to customize
its appearance, such as changing its color or adding a border, as seen in Figure 6.50. You can also insert a text
box inside each of the rectangular or square shapes in your flowchart. In Slides, text boxes do not
automatically come with a border, but borders can be added. Shapes can be used to create any number of
diagrams, illustrations, and other types of visual aids to support your presentations. In the section on Inserting
a Diagram, we will learn more about using the preset diagrams in Slides.

Figure 6.50 These shapes show a simple example of a flowchart. But you could arrange the shapes in different ways or add extra
branches to the chart to represent your custom workflow. (Google Slides is a trademark of Google LLC.)

Inserting a Table
Tables are an important tool for displaying information because they organize and present data in a clear and
concise manner to an audience. They are useful for displaying large amounts of data in a compact format,
making it easy for the viewer to compare and contrast different values, as well as show how different variables
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are related to one another. For a slideshow, it may be best to use tables to showcase summary statistics, such
as means, medians, and standard deviations, which provide a quick overview of most datasets. You do not
want to overwhelm your audience with an overly detailed table with too many numbers. In general, tables are
an effective tool for displaying information because they provide the ability to display and understand complex
data sets in a concise way. They are widely used in fields such as finance, statistics, business, and scientific
research to communicate data and results.

To add a table to a Slides presentation, select the slide where you want to add it. Click on the Insert menu at
the top of the screen. Select Table from the drop-down menu and choose the number of rows and columns
you want for your table. Once you have selected the number of rows and columns, the table will be created
and added to the slide. You may adjust or move the table as needed within the slide.

Use the options in the toolbar to format the table, like changing the color, size, or merge cells when required.
Make sure the data is clear to view; try not to compress too much data into a single table by making the font
too small to read and easily take in.

Inserting a Chart
Data is important in decision making because it provides a basis for understanding the current state of a
problem or situation, and can be used to identify patterns, trends, and relationships that can inform the
decision-making process. Your audience may expect to see data in a slideshow, particularly if it concerns
finance or business, as data plays a crucial role in decision making by providing the information needed to
make informed and well-informed decisions. Charts can be a perfect vessel to display this information to
audiences.

The following will walk through the basic steps of adding a chart. Although your My Life in a Snapshot
presentation doesn’t require the support of data, knowing how to create one will be helpful for future business
presentations.

Follow these steps to add a chart to a Slides presentation:

1. Open your Slides presentation and select the slide where you want to add the chart.
2. Click on the Insert menu at the top of the screen. Select Chart from the drop-down menu. Choose the type

of chart you want to add, such as a bar chart, line chart, pie chart, and so on.
3. Once you have selected the type of chart, you will be prompted to enter the data for the chart. You can

also select data from a Google Sheets document.

Once the data has been entered, the chart will be added. Customizing the chart through options can be
accomplished in the toolbar of Slides. Such custom changes could be altering the colors, adding a title, and
editing data. Like most objects, you can also move and resize the chart as needed.

Inserting a Diagram
You may have noticed after attending numerous presentations how helpful diagrams can be for the audience.
A diagram is a graphical representation of information or data. Diagrams can be used to visually communicate
complex information, ideas, or concepts in a simple and intuitive way. A diagram can help all types of
audiences understand a concept by visually representing complex information in a simple and easy-to-
understand proven format. Diagrams can help to clarify relationships and connections between different
components or elements of a concept and can make it easier to identify patterns/trends. Additionally,
diagrams can be used to highlight important information and make it more prominent, making it easier for
the audience to retain and recall the information later. This drives the purpose home in your presentations.

We already learned about how to use shapes to create a custom diagram, like a flowchart. But Slides offers
many preset diagrams that can show relationships and processes in different ways. These can be easier to use
than shapes because the diagrams are already created for you. To add a diagram to a Slides presentation, click
on the Insert menu at the top of the screen. Select Diagram from the drop-down menu and choose the type of
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diagram you want to add, such as a Grid, Hierarchy, Timeline, Process, Relationship, or Cycle. Each broad
option offers several individual options to choose from, all with varying color themes and styles.

Once you have selected the desired type of diagram, Slides makes it intuitively easy to complete the diagram
by adding content. Take your time to get maximum impact and experiment with different diagrams. With
diagrams, you may find that a “less is more” approach works best when adding to a slide.

Inserting Special Characters
Much like PowerPoint, special characters have a useful effect when added. A special character in Slides is a
character or symbol that is not typically found on a keyboard, but can be inserted into a presentation to add
visual interest or convey specific meaning. Examples of special characters in Slides include arrows, currency
symbols, mathematical symbols, emojis, and various types of punctuation marks.

Open any project and select the slide where you want to add a specific special character. Click on the text box
or shape where the special character offers the most impact. Then, click on the Insert menu at the top of the
screen and select Special Characters from the drop-down menu. A dialog box will appear with a list of special
characters, such as currency symbols, mathematical symbols, and more.

Inserting a Link
For your My Life in a Snapshot presentation, you may not need to provide your audience members with any
links, but you might want to include your email address. You can make this appear as a link so that when it is
clicked on, it brings the user directly to their email client, like Outlook. This can be useful if a team member has
a quick follow-up question after the presentation, or if they just want to send you a welcome message.
Remember that the link will only work for them if the presentation has been distributed to them electronically.
You can do this by emailing a link to the Slides presentation to your audience, or by sharing it as an email
attachment.

To add a link to your Slides presentation, first type in your email address as normal text. (In Figure 6.51, we’ve
added Amir’s email address on the title slide, below his information.) Then, select the Insert tab that provides
the Link option near the bottom of the drop-down menu. Slides will recognize that it is an email address and
add the appropriate hyperlink necessary to launch the email address.
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Figure 6.51 When a link is “live,” it will turn bright blue and appear underlined. This lets you know you can click on it. (Google Slides is
a trademark of Google LLC.)

You may also want to provide clickable links within your presentation for your own demonstration purposes.
For example, you may want to show your audience a new website or a new cloud-based tool. Instead of
placing screenshots in your presentation to show these things, you could simply put a link to the content, and
then click on the link yourself during your presentation. Doing this should open up the link in a new browser
window or tab.

Inserting a Video
With video sharing and recording platforms like Zoom and YouTube easily accessible, creating and playing
videos has never been easier. Adding a short video clip to your presentation can pack a huge punch, and is
easy to do. Sharing video content may be exactly what you need to emphasize a message in a presentation,
perhaps preferable to showing an image or a chart. Be careful not to use a copyrighted video in professional
presentations. Review the rules and laws on what constitutes a copyrighted video before adding one to your
next presentation.

To add a video to a Slides presentation, open your Slides presentation and select the slide where you want to
add the video. Click on the Insert menu at the top of the screen. Select Video from the drop-down menu. You
can then choose to upload a video from your computer or search for a video on the internet using the Search
option. Once you have selected the video, it will be added to your slide. You can then move and resize the
video as needed. (You can also add a video by pasting a video link from a supported video hosting website
such as YouTube, Vimeo, etc., and it will automatically embed the video on the slide.)

As we move into the chapter on Advanced Presentation Skills, we will focus on more advanced aspects of both
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PowerPoint and Slides. You will learn more key skills for becoming an effective presenter in the next chapter, as
well as learn more about the advanced features of PowerPoint and Slides, such as customizing themes,
creating templates, and enhancing images. We will finalize Amir’s My Life in a Snapshot presentation in both
PowerPoint and in Slides.
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Chapter Review
Key Terms
3D model digital representation of a three-dimensional object that can be inserted into a presentation and

manipulated to show different views and perspectives
aesthetics study of how things look and how we perceive and respond to them; the overall look and feel of

something
aspect ratio relationship of a slide’s width to its height
coherency smooth and logical flow of the slideshow or slide deck within a presentation
consistency quality of always behaving or performing in a similar way, or of something always appearing or

occurring in a similar way
contrast use of different elements, such as colors, fonts, or design elements, to draw attention and create

visual interest
diagram graphical representation of information or data; diagrams can be used to visually communicate

complex information, ideas, or concepts in a simple and intuitive way
ecosystem brand of software that an organization primarily uses, particularly across programs
equation mathematical statement that shows the relationship between two or more quantities; equations

are used to describe a wide range of physical, biological, and economic phenomena, and are central to
many areas of science and engineering

icon small graphic symbol that represents a specific function, feature, or tool; icons are used in PowerPoint
to provide visual cues and to make it easier to navigate the software

PowerPoint template predesigned set of slides and slide elements that can be used as a starting point for
creating a presentation

presentation spoken or visual information delivered to an audience
proximity distance between the audience and the subject matter being presented in a slide
repetition use of similar or identical elements, such as colors, fonts, or design elements, across multiple

slides in a presentation
rule of thirds basic principle of photography and design that suggests that an image can be divided into

nine equal parts by two equally spaced horizontal lines and two equally spaced vertical lines; the theory is
that if you place the important elements of the image along these lines, or at the intersections of them,
your photo or design will be more balanced and will have more visual interest

seven-seven rule guideline for creating content for slides so that each slide in a presentation should contain
no more than seven lines of text and that each line of text should have no more than seven words

Slide Master template of the slide that shows each part of the slide
special character character or symbol that is not typically found on a keyboard but can be inserted into a

Slides presentation to add visual interest or convey specific meaning
stock image generic image created or licensed by a stock photography company, often used in professional

publications; may be copyrighted or only available through paid services
storyboard visual plan that separates topics out into different scenes or sections
table structure for organizing and presenting data in a grid format
title slide usually the first slide in presentation that includes the title of the slide as well as a subtitle such as

your name or the date of the presentation
variants design elements such as colors, fonts, and backgrounds that you can change in a theme
visual hierarchy arrangement of elements in a design according to their level of importance or emphasis;

the purpose of visual hierarchy is to guide the viewer’s eye to the most important elements first, and then
to less important information

white space unoccupied areas of a slide that are not filled with text or other content
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Summary
6.1 Presentation and Design Essentials

• Presentations are used in business to communicate information to both internal and external
stakeholders. They are typically used to educate or train, sell an idea, or simply convey information to
others.

• Understanding your audience should drive the purpose behind the presentation. This is to ensure the
presentation is geared toward the audience.

• Consistency and coherency are essential for creating a professional, finished presentation. Consistency
means ensuring that the presentation has a unified look and feel. Coherency means that the presentation
is logically unified and applies to both the slides and the presenter.

• It is important to create a plan or storyboard of the presentation, in the same way that it is important to
outline an essay. A visual plan can ensure all key topics are covered and laid out in an effective manner.

6.2 Designing a Presentation in Microsoft PowerPoint
• The default upon opening a new PowerPoint presentation starts with a blank slide. You can also open an

existing document or start from a template.
• Themes and templates can help create dynamic slides and slideshows. They can also help you save time by

applying color palettes and layouts to an entire presentation.
• The Home tab enables users to create new slides, add text, choose layouts, and customize paragraphs.
• The Design tab enables users to select a common theme for slides and apply variants to each style.
• The View tab helps users to better understand how different view options can be used to build and review

presentation content.

6.3 Formatting Microsoft PowerPoint Slides: Layout and Design Principles
• Adjusting the layout of the elements on a slide is an important skill. Formatting the layout includes

arranging the text, graphics, and other objects on a slide.
• Design principles provide guidelines and rules of thumb to consider as users start to change and

manipulate themes and layouts on slides.

6.4 Adding Visuals and Features to Microsoft PowerPoint Slides
• When including data on slides or related text elements, tables can be used to neatly organize the

information in a presentation. The Table tool is similar to inserting tables in Word.
• An impactful presentation includes visual elements such as images rather than just text. You can use

images from your computer, images provided by PowerPoint, or images you find online.
• The written (textual) information on a slide can be used to convey important details. However, keeping text

to a minimum on each slide makes for a more effective presentation design.
• Symbols and equations can be easily inserted into slides when mathematical content is needed.
• You can use the WordArt tool to enhance basic textual information by adding borders, shading effects,

and other elements.
• Slides that include several visual elements are often more appealing. Using the tools in the Illustrations

command group, you can insert shapes, pictures, and SmartArt into your slides.

6.5 Designing a Presentation in Google Slides
• Both Slides and PowerPoint have similar functionality when creating presentations. In some respects,

Slides is considered more user friendly, with enhanced collaboration tools.
• Slides is a web-based program, which has both advantages and disadvantages. One advantage is that you

can access your Slides files anywhere as long as you have internet access and access to your Google
account.

• Slides can be exported to a PowerPoint file format, and vice versa. This is useful when working in a
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workplace environment where one program is preferred over the other.

6.6 Creating Google Slides: Layout and Text
• You can modify text in Slides either by using the action bar or using the Format menu.
• You can adjust the spacing of text on a slide in Google with the Align & Indent tool or the Line spacing tool

found in the Format menu.
• Borders and lines can be used to enhance the look of slide elements such as a list of information or

images. You can add borders using the Format menu.
• The Arrange and Slide menus can be very helpful when finalizing your slides for a professional

appearance. The tools in these menus help with lining up elements on the slide such as text boxes or
images.

6.7 Adding Visuals and Features to Google Slides
• Images add visual interest to a presentation and enhance the audience’s understanding of the content.
• Shapes can be used to create diagrams, highlight information, or add visual interest to a slide. They can

also be used to create custom graphics or diagrams, or to illustrate a concept.
• Tables can be used to organize and present data in a clear, concise manner.
• Charts can be used to visualize data in a clear and meaningful way. Slides makes it simple to insert one

into a presentation.
• Diagrams can be used to represent complex ideas, processes, or relationships in a visual and

understandable format.
• Special characters can be used to add symbols, accents, or foreign characters to a slide.
• Links allow you to quickly navigate to other pages or websites from within your presentation. They can

also be used to provide additional information or resources, or to allow the audience to access additional
content related to the presentation.

• Adding video to your presentation can be a good way to add visual interest or provide a more immersive
experience for the audience.

Review Questions
1. How does having a clear purpose for your presentation help you connect to your audience?

a. It helps ensure that your presentation is coherent.
b. It helps ensure that your presentation is consistent.
c. It helps ensure that your presentation is relevant.
d. It helps ensure that your presentation has an appropriate outline.

2. A consistent color scheme should have ________.
a. elements that work together
b. a uniform look and feel
c. a focal point
d. a key message

3. To determine the appropriate number of slides for your presentation, you should consider ________.
a. whether the presentation will be delivered in person or via technology such as Zoom
b. the needs of your audience
c. the software you use to create the presentation
d. the category of the presentation

4. To create an effective plan for your presentation, you should ________.
a. focus on consistent design quality
b. ensure the slideshow has a coherent design quality
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c. make sure that you tell a story throughout the presentation
d. define the layout of your slides

5. The ________ in a presentation refers to the overall design and layout of the slides.
a. title slide
b. variants
c. theme
d. Slide Master

6. If you wanted to change the overall color style of a theme you are using, which option would be best?
a. Go to the Design tab, then Variants.
b. Go to the Home tab, then Slides.
c. Go to the Insert tab, then Text.
d. Go to the View tab, Outline View.

7. On the Home tab, the ________ command enables you to work with elements in your presentation such as
adding bullets and aligning text.
a. Layout
b. Font
c. Paragraph
d. Design Ideas

8. What is the advantage of the Design tab over the Design Ideas feature?
a. The Design tab has an on/off button that provides advanced slide layouts.
b. The Design tab enables you to adjust elements of your presentation such as line spacing and columns.
c. The Design tab offers the option of using a blank, white canvas to build your presentation.
d. The Design tab provides a collection of tools that enable you to change layout designs for all of your

slides at once.

9. To add a slide to your presentation, which option on the View tab should you select?
a. Notes View
b. Slide Sorter View
c. Reading View
d. Outline View

10. What type of slide layout offers the best way to present two or more different types of information in a
presentation?
a. Content with Caption
b. Section Header
c. Comparison
d. Title and Content

11. _________ refers to the use of similar or identical elements, such as colors, fonts, or design elements, across
multiple slides in a presentation.
a. Repetition
b. Contrast
c. Alignment
d. Proximity

12. A table in PowerPoint is used to ________.
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a. add special effects to text
b. create charts and graphs
c. present information in an organized format
d. add images and videos

13. You need a picture of a squirrel for your presentation, but you have been unable to take one with your cell
phone. What could you do instead?
a. Use the WordArt tool.
b. Use 3D models.
c. Use SmartArt.
d. Use a stock image.

14. WordArt in PowerPoint is used to ________.
a. add special effects to text
b. create charts and graphs
c. add images and videos
d. organize slides into sections

15. Why would you use a visual hierarchy in your presentation?
a. to emphasize certain points
b. to make the presentation more engaging
c. to minimize distractions in the presentation
d. to guide a viewer’s eyes to the most important information

16. As part of your presentation, you need to present data to your audience. To do this, which type of
illustration should you select?
a. SmartArt
b. icons
c. charts
d. 3D models

17. What is a distinct feature of Slides that is not present in PowerPoint?
a. changing ribbon
b. drop-down boxes from each tab
c. File, View, and Insert menus
d. thumbnails on the left side

18. What is a primary difference between Slides and PowerPoint?
a. Slides is a web-based software application, while PowerPoint is a stand-alone software program.
b. PowerPoint is recommended for online collaboration, while Slides is best for self-contained work.
c. Slides can only be used offline, while PowerPoint is ideal for mobile application devices.
d. PowerPoint can only be used through cloud-based applications, while Slides is a desktop application.

19. If your workplace uses only Microsoft products, which program would be a better choice for creating a
slideshow, and why?
a. PowerPoint, because it is more feature-rich than Slides
b. PowerPoint, because it is advantageous to remain within your workplace’s software ecosystem
c. Slides, because it is more user-friendly than PowerPoint
d. Slides, because it is better for online collaboration
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20. When you convert your presentation from PowerPoint to Slides, some of the font effects are missing. Why
does this happen?
a. Slides is a desktop application.
b. Slides does not include Illustrations tools.
c. Slides is a web-based software application.
d. Slides does not always convert WordArt consistently.

21. Which drop-down menu in Slides is best to access line spacing options for text?
a. Insert
b. Slide
c. Arrange
d. Format

22. To add a border to a text box in Slides, you must first do what?
a. Copy the text.
b. Select the text box,
c. Go to the Format menu.
d. A border cannot be added to a text box in Slides.

23. Which tool in Slides helps you change the layout of your slides?
a. Slide menu
b. Apply Layout
c. Change Background
d. Edit Theme

24. When adding images to your Slides presentation, what should you remember?
a. Only copyrighted and trademarked images should be used.
b. Before you insert the images into your presentation, they must be the correct size.
c. You should use the Format menu to insert images.
d. The images can come from any source, including pictures on your smartphone.

25. What is the advantage of using diagrams in a Slides presentation?
a. Slides automatically designs any diagram that you select.
b. You can copy and paste diagrams from other sources without making any modifications.
c. You can present complex information in a simple and intuitive way.
d. Diagrams make it easier to quickly create a presentation.

26. To present numerical data to your audience during a presentation using Slides, what tool(s) should you
use?
a. shapes and/or diagrams
b. text boxes
c. tables and/or charts
d. images

27. Why are special characters useful in presentations?
a. They add effects to text and make it more prominent.
b. They add visual interest or convey specific meanings.
c. They enable you to add images to a presentation.
d. They are the most appropriate tools for presenting numerical data.
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28. When using links in your presentation, what should you remember?
a. Links are important tools and should be used extensively in presentations.
b. Links can be used to make a presentation more visually appealing.
c. Links can be distributed to your audience electronically for their personal access.
d. Links should not be used if you have screenshots of the information you want to present.

Practice Exercises
29. Develop a storyboard that is both educational and persuasive, presenting the steps to making the best

possible sandwich (in your opinion). Create a plan for this presentation. Divide the presentation into seven
sections. Make sure that your storyboard includes information on each of these topics and why it is a
needed section of the plan for making the best sandwich.

30. After developing your presentation, you decide to add pictures to slides #4 and #7, along with a simple
animation to slide #12. You do not want to make any changes to other slides in the presentation. Explain
the best way to make these changes without affecting the overall presentation.

31. Your presentation is ready to go, but at the last minute, your supervisor asks you to create two additional
slides to provide updated information in the middle of the presentation. To accommodate this update, you
also need to move slide #11 and make it the fifth slide in the presentation. How will you make these
changes?

32. Use the elements about alignment to arrange six different objects into a slide. Choose images and text.
Choose a group of items such as cars, animals, or national parks. Start by sketching the design on a piece
of paper, then building the design into PowerPoint.

33. Choose a topic of interest such as your favorite vacation or your top three academic goals this year. Select
the appropriate layouts for a new presentation and create a short presentation about the chosen topic.
After the title slide, you need a slide that provides an overview of your presentation, followed by three
slides that you will use to present pictures with captions. Your presentation should be approximately five
slides long.

34. Tables are frequently used in professional presentations. Using what you’ve learned, insert a 5 x 5 table
into a presentation.

35. Using WordArt, demonstrate ways to emphasize an important point. You can either create a new
presentation or add it to your My Life in a Snapshot presentation.

36. Your team includes several people who have never worked with a digital presentation. To make your
project easier for them to complete, you need to convert a PowerPoint presentation to Slides. Create a
memo with a simple set of instructions to achieve this.

37. Open a new Slides file. Add a text box and include a list of items such as a shopping list or a packing list for
a trip. Using the skills you learned in this section, add a border to a text box. Format the rest of the slide in
a professional manner adding a background and color.

38. Create a new Slides file. Choose a theme such as landscape images or animals. Insert several images (at
least five) onto the slide. Use the tools in the Arrange menu to format the slide in an organized manner.
You might need to adjust the size of the images to make them all fit on the slide. Change the layout of the
slide to include a title.

39. Practice what you’ve learned by adding a diagram to your presentation. Select the appropriate type of
diagram, choose a color theme and style, and add content.

40. Practice what you’ve learned by adding a video to your presentation. Follow the appropriate steps to insert
a video from a platform such as YouTube or from your own collection of videos.
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Written Questions
41. What is the key difference between PowerPoint and Slides?

42. What are the key questions to ask when developing a sense of purpose in a presentation? Why are these
questions important?

43. Describe the main features and tools available on the Home tab in PowerPoint.

44. How is the Themes and Variants feature on the Design tab used?

45. How can you use white space effectively in PowerPoint to create visually appealing slides and improve the
overall design of your presentation?

46. Why are layouts important in PowerPoint presentations? As part of your answer, discuss three commonly
used slide layouts and explain how they can help create a professional presentation.

47. Reviewing the figure, make an argument for which of the three options works best for engaging your audience
during a Q&A session at the end of a presentation. There are no right or wrong answers, but you should make
a clear choice and defend that choice in the response.

48. While mathematical statements, or equations, can be complicated, they can also be useful tools in
presentations. Describe at least two situations where you could consider adding equations to your
presentations.

49. Describe the difference between stand-alone and web-based software programs.

50. Why would you need to adjust the layout of content in a Slides presentation?

51. How can you effectively add links to a Slides presentation to enhance interactivity and provide additional
resources for your audience?

Case Exercises
52. The Design tab in PowerPoint helps you quickly and easily change the overall look and feel of your

presentation with built-in templates, color schemes, and slide layouts. Demonstrate how to use the Design
tab options to transform roughed-out text into a professional presentation.
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Figure 7.1 Developing the right skills to give a presentation is just as important as knowing how to create one. (credit: modification

of “Man in Black Suit and Blue Denim Pants Standing beside Projector Screen” by Pavel Danilyuk/Pexels, CC0)

Chapter Outline
7.1 Effective Presentation Skills
7.2 Finalizing a Slide Collection
7.3 Preparing a Microsoft PowerPoint Collection for Presentation
7.4 Preparing a Google Slides Collection for Presentation

Chapter Scenario
In Preparing Presentations, you were shown how to put together a basic presentation. You designed a
professional presentation and are sure that it contains all relevant content and all the necessary elements.

Now the nerves start to set in, and the reality that you have to present this to an audience hits you. This
chapter focuses on that next step of presentation readiness and provides the knowledge and tools to give you
the confidence to present with ease. You will not only deepen your presenting skills by learning more
advanced functions of Microsoft PowerPoint and Google Slides, but you will also learn the equally important
skills of collaborating and presenting in a professional setting. Even if your slides are outstanding, you will still
need to practice your presentation and consider your audience. All of these skills will help you take your
presentation and your presenting skills to the next level, setting you up to be well prepared to give the
presentation in front of your WorldCorp colleagues.

Advanced Presentation Skills
7



7.1 Effective Presentation Skills

Learning Objectives
By the end of this section, you will be able to:

• Ensure the slideshow meets the needs of the presentation
• Craft a strong presentation hook
• Identify the key skills for presenting in front of an audience
• Describe the importance of a strong closing

A well-crafted set of slides is essential for an effective presentation. Equally essential are presentation skills. In
this first section, we discuss some best practices in presenting. Some people may be apprehensive about
presenting in front of a group; others may welcome the challenge. At this point in your academic career, you
may have also taken a course in public speaking. Regardless of your prior experience and your feelings about
presenting in front of others, some practice and attention to developing your skills as a presenter will be
worthwhile. We can all benefit from fine-tuning our public speaking and presenting abilities, even if we are
regularly in front of a group. These skills are relevant in all types of meetings, whether in person or virtual.

One of the best ways to improve your presenting is to practice. This can help you work through all of the
technological hiccups, as well as set your mind at ease. You should practice in the same space and with the
same technology, if possible, as well as practice what you are going to say and your demeanor during the
presentation. The importance of this prep work cannot be overemphasized. Consider recording yourself as you
are practicing to give you a firsthand look at your presentation skills. This strategy is helpful even if you are
presenting fully in person.

Ensuring the Final Presentation Meets Its Goals
In general, to create an effective presentation, you first need to understand the goal or intent of the
presentation. Your supervisor may provide those goals, or you may determine them yourself. Regardless,
setting your goals first will help you ensure that the look of your slides matches those goals. Presentations can
fall into one of the following categories, as outlined in Table 7.1: persuasive, instructional, informational, or
inspirational. Knowing the goal of your presentation helps you set the stage for developing the slides and
constructing your narrative.

For example, if you want to create a lively, inspirational presentation to encourage the audience to donate to a
nonprofit cause, a gray-tone slide presentation dominated by text will not be effective in meeting your goals.

Type Main Goal Example

Persuasive
To prompt the audience to act. Provide enough
information and support to move the audience in the
desired direction.

Encourage participation in a
local community cleanup
effort.

Instructional To educate the audience. Typical of training presentations.
New-hire training by the
human resources
department.

Table 7.1 Types of Presentations The goal of the presentation should guide all aspects of slide development, from color choices to
the graphics included on the slides to the overall tone of the presentation.
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Type Main Goal Example

Informational
To report on company performance or other metrics.
Include charts and visuals.

Quarterly sales reports for
each region in a company.

Inspirational
To energize the audience to evaluate and change a belief,
or to motivate the audience to act on that changed belief.

Solicit donations for a
nonprofit.

Table 7.1 Types of Presentations The goal of the presentation should guide all aspects of slide development, from color choices to
the graphics included on the slides to the overall tone of the presentation.

Opening a Presentation
There are many ways to start a presentation to engage your audience. What you do not want to do is jump
right into the content or start by simply introducing yourself. You want your audience to be interested and
engaged right away and to want to know more about what you are presenting.

To get your audience interested and engaged in the presentation from the get-go, consider developing a
strong opener, or hook. A hook is a statement, story, or question designed to get participants’ attention and
pique their interest.

For example, if you are presenting WorldCorp’s sales goals, you could begin with a personal anecdote about
how you once set a goal and achieved it. Alternatively, you could ask the audience to think about a time when
they faced a lofty goal and found a way to overcome the challenges. Be creative—think about a time when you
were in a meeting or presentation and found yourself engaged from the beginning. What did that speaker do
to get your attention? Did the presentation include compelling statistics? Maybe a short video or bit of humor
got your attention. The hook helps set the tone of the entire presentation and can establish rapport with the
group. It is your way to connect with the audience from the initial stages of the presentation.

Also, think about your goals and how they are relevant to the type of presentation you are giving. Do you want
to inspire the group and leave them with a call to action? Perhaps your presentation is a training session
where you will be assessing the participant’s learning at the end. Keeping the type of presentation in mind can
help you craft an impactful hook. After you have delivered the hook, transition into the introduction of the
slideshow, drawing the connection between the hook and the goal of the slideshow.

SPOTLIGHT ON ETHICS

Inclusivity and Presentations

When delivering presentations, consider the needs of all audience members and ensure accessibility for all
individuals, including those with disabilities. Presentations should be designed and delivered in a way that
accommodates individuals with visual, hearing, or other impairments, to ensure equal access to
information and an inclusive experience. Here is an example:

Imagine WorldCorp is conducting a large-scale conference at which it provides handouts of presentation
slides to attendees. In this case, it would be important to consider whether the handouts are available in
alternative formats, such as braille or accessible electronic formats. This ensures that individuals with visual
impairments can access the same information as everyone else.

Additionally, in the context of delivering presentations, presenters should consider incorporating accessible
features in their slides and delivery style. Some key considerations include the following:

• Clear and readable text: Use legible fonts, appropriate font sizes, and high contrast between text and

7.1 • Effective Presentation Skills 473



background colors to ensure readability for individuals with visual impairments.
• Alt text for visuals: Provide alternative text descriptions for images, graphs, and charts. This allows

individuals with visual impairments who use screen readers to understand the content presented
visually.

• Captioning and transcripts: If the presentation involves audio or video elements, provide closed
captions or transcripts. This helps individuals with hearing impairments or those who may have
difficulty understanding the spoken language.

• Verbal descriptions: When demonstrating visual elements, ensure that the presenter provides verbal
descriptions of what is being shown on the screen. This assists individuals who are visually impaired
and cannot see the visuals.

• Inclusive language and tone: Use inclusive language, and avoid making assumptions or generalizations
that could marginalize or exclude certain groups of individuals.

By considering these guidelines, presenters can create a more inclusive and accessible environment,
ensuring that their presentations are accessible to a broader range of individuals.

Key Presentation Skills
Specific skills can vary by the type of presentation. For example, if you are giving a persuasive presentation,
you might use more humor than you would in an informational presentation. There is no single standard set
of skills that all presenters should possess, and what defines a good presenter versus a bad presenter can be
quite subjective. However, there are some skills that pertain in all situations. A good presenter is one who is
prepared, professional, and able to communicate effectively with the audience.

First, consider what you are going to wear to the presentation. You should choose attire that is professional
and appropriate for the type of presentation you are giving. Make sure you feel comfortable too. Do not wear
clothing that you think you will be fidgeting with or accessories that you might handle if you are feeling
nervous, such as coins or keys in your pocket. If your hair falls on your face often, you may want to pull it back
for the presentation. The fewer distractions there are, the better. Consider the type of footwear you will wear. If
you will be moving around the room during the presentation, choose comfortable shoes that you are
confident walking in. The type of flooring in the room is also something to consider. Carpet is typically much
quieter when walking during the presentation. Certain shoes on tile floors can be quite loud and distracting.

Also, think about the temperature in the room. When you are presenting, you may warm up quickly because of
nerves and because you are active. Choose attire that will not show signs of sweat and will not let you become
overheated. You might also want to consider what fragrances you typically wear. In a smaller or warm room,
strong fragrances can quickly become overwhelming and distracting.

But first and foremost, be on time for your presentation. In fact, you should plan to arrive early. Arriving early
will help set your mind at ease and leave time for you to work out any issues that may arise. A good rule of
thumb is to arrive at least thirty minutes before your presentation is scheduled to start. Get the slideshow set
up before any participants arrive, and get prepared to begin. Remember, you will start with your hook. Be sure
to use your slides as a supplement to what you are saying. The slides should not be the centerpiece; they are
secondary and complementary to what you want to convey. Reference the content on the slides as necessary
to keep the audience engaged.

During the presentation, be aware of your body language. You want to appear confident and prepared. Make
eye contact with the audience, making sure you look at all sides of the room. Also, you should display body
language that shows the audience you are engaged and excited about the presentation. This means good
posture, using hand gestures as appropriate, and pausing to make sure the audience is following. There is
nothing worse than sitting through a presentation where the speaker appears disengaged and bored. Try not
to rely on the slides or your notes too much, and avoid turning your back to the audience. It is acceptable to
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walk out into the room a bit and not stay in the front of the room or behind a computer desk or podium.
However, too much moving around can be distracting to the audience and make you appear nervous and
unprepared.

Think about how your voice is coming across to the audience. Have good voice projection without yelling.
Maintain a conversational style of speaking, rather than sounding monotone and memorized. Avoid swearing
and inappropriate jokes. Be sensitive to audience members and aware of words or phrases that may reflect
any bias or discrimination. Use pauses and voice inflection when you want to draw attention to certain parts of
the presentation. Throughout the presentation, you can also repeat or rephrase important points for
emphasis. Speak slowly and clearly. Keep a bottle of water close in case you need it, especially if you will be
speaking for an extended period. If you lose your train of thought or are searching for the next phrase, avoid
using filler words such as “uh” and “um.” Instead, try silently counting to yourself for a few moments; this is
one strategy that can help you avoid using words to fill pauses. Sometimes a little silence is okay. You do not
need to fill every spare moment with speaking.

Again, consider recording yourself presenting to see where you can improve. Use the available technological
tools such as the Rehearse with Coach feature in PowerPoint. Your skills and comfort level will improve with
practice and preparation. The more you practice and present in front of others, the better you will get at it.

REAL-WORLD APPLICATION

TED Talks

One way to hone your presentation skills is to watch other presenters. TED Talks are an excellent source.
One TED Talk that is often recommended for its exceptional presentation skills and storytelling is “The
power of vulnerability” (https://openstax.org/r/78TEDBreneBrown) by Brené Brown. In this talk, Brown, a
renowned research professor and author, explores the topic of vulnerability and its connection to human
connection and personal growth.

Brown’s talk stands out for several reasons:

• Engaging storytelling: Brown captivates the audience with personal anecdotes, humor, and relatable
stories that make the topic accessible and relatable to a wide range of people. She uses storytelling as a
powerful tool to connect with the audience emotionally.

• Authenticity and vulnerability: As she discusses vulnerability, Brown displays a genuine and vulnerable
presence on stage. She shares personal experiences and openly acknowledges her own struggles and
fears. This authenticity creates a strong connection with the audience, making her talk even more
impactful.

• Research-based content: Brown supports her talk with research findings, which adds credibility and
depth to her message. She presents her research in a way that is easily understandable and relatable,
helping the audience grasp complex concepts.

• Humor and wit: Brown infuses her talk with humor and wit, using well-timed jokes and lighthearted
moments. This keeps the audience engaged and creates a pleasant atmosphere during the
presentation.

"The power of vulnerability" has millions of views and has resonated with people worldwide. It serves as an
excellent example of how effective storytelling, authenticity, and research-based content can create a
powerful and memorable presentation.

Closing a Presentation
Just as you need a strong hook to start off a presentation, you also need a strong closing statement. It should
be more than simply a summary of what you discussed in the presentation. Your closing statement should be
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a few words that leave a lasting, positive impression and that convey the essence of the slideshow. You want
your audience to remember the presentation, especially your key points. This is your last chance to bring it all
together for the audience.

To prepare your closing statement, start by making a list of the top three to five items you hope the audience
will walk away with after listening to your presentation. For Amir’s presentation at WorldCorp, he may want the
audience to remember his leadership skills, his teamwork ability, and a few items about his background. In
your closing, you can reemphasize these items in a creative way rather than simply listing them one by one.
For example, your closing slide might include a collage of pictures that visually represent your main points. If
you are giving a persuasive or inspirational presentation, you may want to close with a call to action—what
you hope the participants will be motivated to do after hearing your presentation.

For example, if you are giving a presentation to encourage people to donate to a nonprofit organization, in the
closing you can specifically ask about how to donate. Another option is to end the presentation with a story or
joke that sums up the main points. If you started with a story as your opening hook, you can come back to that
story and add more to it. Finally, you may want to use a quote from a famous historical or contemporary figure
that encapsulates what you hope the audience will take away from your presentation.

As you can see, there are many ways to close a presentation that go beyond simply ending with a “Thank You”
or “Questions” slide. Your main goal should be to get the audience to remember the presentation and the
message you set out to convey.

LINK TO LEARNING

One technique to engage the audience during a presentation is to tell a story rather than give a speech.
People are intrigued by stories. Using this approach encourages your listeners to create mental images. See
this blog on storytelling techniques used by the TED presenters (https://openstax.org/r/78Storytelling) for
some tips on using storytelling in presentations.

7.2 Finalizing a Slide Collection

Learning Objectives
By the end of this section, you will be able to:

• Choose an appropriate and engaging color scheme
• Modify a theme of a presentation
• Utilize design ideas options to change the look of individual slides
• Enhance images used in slides

At some point in your career, you might need to present an analysis of data to an audience of peers or
management. Your information must appear clear and professional and will likely include graphs and charts of
your analysis. In Preparing Presentations, we learned the basics of putting together a presentation and
including tables and images. However, when finalizing your presentation, you may want to adjust the colors,
slide layout, and other aspects to take your presentation to the next level. The theme and color choices of
these elements can be critical to developing a professional presentation that will impress the audience and
effectively communicate your intended message. In this section, the focus is on PowerPoint. The use of these
skills in Slides is covered in a later section.

Color Schemes
Through the use of color and other design elements, you can visually highlight key points. Your color choices
can also engage the audience by evoking emotions. If you are not careful, though, the color scheme can be
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distracting and take away from your message. You will also want to keep text to a minimum on each slide,
focusing on key words or ideas, and using the notes section to capture your speaking notes and detail.

LINK TO LEARNING

When preparing the colors for your presentations and charts, there are a few guiding principles you can
follow that will help make your presentation look professional. Some of these tips include the following:

• Keep the color scheme simple by using no more than three colors: one main color, a secondary color,
and an accent color. The main color should represent about 60 percent of the color in your
presentation, the secondary color should be about 30 percent, and the accent color should make up
the remaining 10 percent.

• Keep the colors in balance with tint and hue. For example, do not pair a rich royal blue with a pale,
pastel yellow. Choose high-contrast colors for the most impact.

• Spread the content out over several slides; do not put all the data or charts on a single slide.

Visit this web page on choosing the best colors for your presentations (https://openstax.org/r/
78ColorPresent) for more details on how to use color to create an effective presentation.

Choosing your own color scheme can be a fun way to create your own style for your presentation. However,
you may want to go with a preset color scheme to ensure that all the chosen colors go together in a
harmonious way. PowerPoint makes this process easy by providing themes, which provide a cohesive and
unified design scheme across the whole presentation, allowing you to maintain consistency across slides, even
if they have different content. When you apply a theme, PowerPoint automatically updates the color palette,
font styles, background designs, and other visual attributes of the presentation. This helps to save time and
effort by eliminating the need to manually adjust the appearance and colors of each slide individually.

Modifying a Theme
PowerPoint offers a variety of built-in themes to choose from, each with its own unique combination of colors,
fonts, and effects. Additionally, you can customize and create your own themes by modifying the visual
elements according to your preferences. Themes keep the look and feel of slides consistent. The theme is
applied to all slides you select and is designed with preset colors, fonts, and background styles.

Here we go more in depth about the changes you can make to the theme selected for a presentation. Let’s
practice by modifying the existing theme selected for the My Life in a Snapshot presentation that you created
in Preparing Presentations. You have decided that, after learning more about color theory and how colors can
evoke emotions in others, you want to change the theme and enhance some color elements. Figure 7.2 shows
the original theme selected for the presentation as well as a starting slide that you created in Preparing
Presentations. Recall that themes are accessed through the Design tab in PowerPoint. The theme includes
more muted, brown tones, and you want to add more color to the presentation to make it more engaging.
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Figure 7.2 Each thumbnail displays the main font that theme will use (as shown by the Aa) as well as the color palette, shown in the
form of the small rectangles at the bottom of each thumbnail. (Used with permission from Microsoft)

You decide to go with warm colors, as they convey energy and optimism. Let’s first look at how you can change
the elements and colors of the current theme. From the Design tab, choose the command group Variants to
make adjustments to the theme. Variants are changes to a theme such as colors or slide layouts—essentially,
variations to your selected theme. You can also find these options in the Slide Master tab. Figure 7.3 shows the
options you have for changing parts of the theme: Colors, Fonts, Effects, and Background Styles. Choose a
vibrant color scheme that includes orange and yellow colors. When you select a new color scheme, it will be
applied to all slides in the presentation. If you choose, you can also customize colors if you do not like the
preset color schemes.
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Figure 7.3 (a) In addition to colors, you can change other aspects of the theme, including fonts and backgrounds. (b) When you
choose an option under Colors, you will see the change to your slides immediately on the screen. (Used with permission from
Microsoft)

LINK TO LEARNING

Color theory focuses on the way colors mix together. Knowing a little bit about color theory and the color
wheel can go a long way toward helping you select a color scheme, or theme, for your presentation. Watch
this video on the basics of the color wheel and how to apply it to PowerPoint (https://openstax.org/r/
78ColorWheelPPT) to learn more.

To create a customized color scheme, click on the Design tab located in the PowerPoint ribbon at the top of the
screen. In the Variants section of the ribbon, click on the Colors drop-down button. This will display a list of
built-in color schemes and options. At the bottom of the Colors drop-down, select Customize Colors. A new
window titled Create New Theme Colors will appear. In the Create New Theme Colors window, you will see
several categories of colors, such as Text/Background, Accent 1, Accent 2, and so forth. To create a custom
color, click on the color square next to the category you want to customize.

For example, click on Text/Background to customize the color used for text and slide backgrounds. In the color
picker window, you have several options to create a custom color. You can use the sliders or input fields to
adjust the RGB (red, green, blue) values of the color. Alternatively, you can enter the hexadecimal value (or “hex
code”) of the desired color in the “#FFFFFF” format. You can also choose a color from the Standard or Custom
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color palettes. Choose Customize Colors at the bottom of the colors menu. To create a custom color by
selecting a color from your slide, click on the Eyedropper tool, and then click on the desired color within your
slide. Once you have set the desired color, click the OK button to save it. Repeat for other color categories if
you want to customize them as well. After customizing all the desired color categories, click the Save button in
the Create New Theme Colors window. In the Save dialog box, enter a name for your custom color scheme and
click Save (Figure 7.4). Naming the color scheme will save it for future use.

Figure 7.4 You can create a customized color scheme for your presentation and save it to use in future presentations. (Used with
permission from Microsoft)

Now adjust the color of the first text option to be a dark red color, as shown in Figure 7.5. Notice that the
thumbnails of all the slides have changed to reflect the new color scheme.
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Figure 7.5 The new dark red font color is used throughout the existing slides and any new slides created in the presentation. (Used
with permission from Microsoft)

Other options in Variants include changing the font for the theme and effects. To change the font, simply
select a new font, and it will be applied to all slides in the current presentation and any additional slides that
you might add. The Effects options change how images and other graphic elements are added to the slide. By
adjusting effects, you can change the shadowing, lines, and fill elements in a graphic added to a slide.

For example, let’s insert a list as a SmartArt graphic. (SmartArt was introduced in Preparing Presentations.)
Choose an option from the List section of SmartArt and modify it to include shadows to see how the effects
can change. Remember, when you change an item in Variants, whether it is a font, a color, or an effect, it will
apply to all slides in the presentation.

First, navigate to the Strengths & Skills slide in the My Life in a Snapshot presentation. You can either choose
the list from the slide view on the left panel or use the page down key on the keyboard to get to the slide. Then
go to the Insert tab to insert a SmartArt graphic that is appropriate for lists, such as the Basic Block List option.
When the graphic is inserted, choose a SmartArt style that has shadows (Figure 7.6).
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Figure 7.6 Effects changes the fill effects, lines, and shadows of inserted graphics. (Used with permission from Microsoft)

When you have selected the style, go back to the Design tab to adjust the Effects from the Variants command
group. Choose a new Effect to see how the elements of the SmartArt graphic are modified. For this example,
the Grunge Texture Effect was selected. You will see the change in the graphic as you hover over the various
effect modifications (see Figure 7.7).
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Figure 7.7 The new effect chosen, Grunge Texture Effect, will now apply to all graphics that are currently in or added to the slides in a
presentation. (Used with permission from Microsoft)

The last section of the Variants command group is the Background Style. This option allows you to change not
only the color but also the fill and texture of the background of the slides. As with the other selections, you
access this through the Design tab. Initially, you are given choices to change the color of the background. Note
that these colors are preselected for you based on the color scheme that you chose for the theme. As with the
other changes, you will see a preview of the change to the background color as you hover over the options
(Figure 7.8). Not all colors will work with your chosen font colors or other elements that you have included in
the presentation. For example, choosing a dark red background color with the dark red font will make the font
unreadable. The chosen color will be applied to all slides in the presentation and any new slides that you add,
so consider the entire presentation when selecting the background color.
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Figure 7.8 Keep in mind the color of the fonts as you choose a new background color. (Used with permission from Microsoft)

The Format Background option gives you the tools to change the gradient, transparency, and fill pattern of the
background. A gradient is when one color fades into another. For example, for a slide background, you could
add a gradient effect to a slide where the color blends and transitions from green to blue. When you select
Format Background, a panel will open on the right, giving options to change various aspects of the
background. There are preset gradient options that will also change the color of the background beyond the
few options that you originally have available in background styles, as Figure 7.9 shows. Or you can choose to
adjust the current option. In this example, we are using the Radial gradient. But that can be adjusted through
the Format Background options.
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Figure 7.9 (a) By changing the settings in the Format Background options, you can customize the look of your slides. (b) Preset
gradients offer many more color choices for the background colors. (Used with permission from Microsoft)

Designer
The latest version of PowerPoint includes a feature called Designer. This feature helps you create professional-
looking presentations and enables you to change the layout of slides automatically. You can use it to format a
slide using various preset formats and to add additional design elements to the slides. It gives you a nice way
to vary the layout and enhance the visual appeal of slides in a presentation. When a new slide design is
applied, it affects only the current slide, not the entire presentation.

Let’s try inserting a slide into the My Life in a Snapshot presentation after the title slide to include information
such as hometown, education, and a fun fact about yourself. Using the skills acquired from Preparing
Presentations, insert a slide that will include this information. Start filling in the slide content with the title
“Background.” Include the other items for the slide. Then select the Designer option on the Home tab to access
the assorted designs for this slide (Figure 7.10). The Designer tool can also be accessed through the Design
tab. Note that the Designer tool might not have any “ideas”; when this happens, you will receive a message:
“Sorry, no design ideas.” You might also receive suggestions that are not appropriate or helpful.
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Figure 7.10 Designer gives you various options for layout and design based on the information contained on the slide. Select one of
the designs from the list to apply to the current slide only. (Used with permission from Microsoft)

You can also apply a new design to an existing slide by first selecting the slide and then once again going to
Designer from the Home tab. The available slide design ideas vary by chosen theme. Some have more choices
than others. Figure 7.11 shows the options available when you change the theme of the presentation.

Figure 7.11 The Designer tool can be used to add variety and visual interest to your slides. (Used with permission from Microsoft)
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Advanced Tools for Image Enhancement
When creating a presentation, you are likely to include visual elements such as pictures, graphics, and tables.
You are likely to want to make some adjustments, such as cropping, to the images to make the pictures clearer
and more professional in your presentation. There are several techniques that can help when inserting visual
elements into your presentation. These include removing the background of a picture, cropping the picture,
and creating an overlay for the image.

Removing the Background of a Picture
When you have a slide that has a colored background, inserting an image with a different background color
can be problematic, because the image's background may clash or stand out in an undesirable way.
PowerPoint has a great tool to remove the background for images which allows you to select the areas to keep
in the image. Go back to the My Life in a Snapshot presentation. Do you recall the empty space next to the star
on slide 3? Let's add a picture of Amir next to the star. However, now that we have our yellow slide background,
the image’s white background seems a bit out of place (Figure 7.12). Let’s try removing it.

When you select the image, you get the Picture Format tab in the ribbon. Select the tab, and the Remove
Background tool is on the far left of the tab selections.

Figure 7.12 The Picture Format tab gives you tools to make changes to the image, including removing the background. (Used with
permission from Microsoft)

To begin the process for removing the white background from the image of Amir, select Remove Background.
PowerPoint will attempt to determine the background that you would like to remove by shading the space a
different color—in this example, purple, as shown in Figure 7.13a. Notice that Amir’s hair is part of the
selection—we do not want to remove his hair! From the tools, select Mark Areas to Keep and click on the hair
area of the image. When you select the tool, you will get a pencil icon that you can use to click on the areas
that should remain in the image. Repeat this step to keep the rest of his shirt in the image. When you are
finished with the selections, click on Keep Changes. The resulting image should have only the areas you
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selected removed (Figure 7.13b). To select areas to remove in an image, you follow a similar procedure.

Figure 7.13 (a) The bright purple highlight is a clear and obvious way for PowerPoint to indicate which parts of the image PowerPoint
suggests you should remove. (b) Removing the background from the image gives the slide a much cleaner look. (Used with
permission from Microsoft)

Crop and Fit Images to Shapes
Sometimes you may need to reduce the size of an image or change its shape to fit into a particular space on
the slide. To accomplish this, you use the crop tool. To crop means to cut out parts of the image. Images can
be cropped to remove items that are visible in the picture but that you do not want to see. For example, let’s
assume that on the Background slide, we want to showcase that Amir enjoys kayaking. He has a picture of
himself and his friend kayaking last summer, but he would like the image to include only himself. He can crop
the photo to remove his friend from the picture. To crop an image, select the image and select the crop tool
from the Picture Format tab (Figure 7.14). The image can also be cropped to a specific shape, such as a circle.
Additionally, the aspect ratio of the image can be changed to adjust the height (vertical) and width (horizontal)
of the image with preset values. The aspect ratio sets the ratio between the height and the width of an image.
We can also fit the image to a space or to specific dimensions.

For this example, let’s first crop the image to only include the top kayak. To do this, select the image and select
Crop. Notice that the outline of the image changes with black boundary lines that you can use to cut the
image. Click on one of the black lines or corners. In this example, we will crop the image by choosing the
bottom center line and pulling it up. To finish cropping the image, click on the slide area outside of the image
(Figure 7.15).
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Figure 7.14 By using the Crop tool, you can remove the unwanted parts of an image. You can crop an image from all sides and
corners. (Used with permission from Microsoft)

Figure 7.15 After you have finished cropping the image, the black lines around the picture will disappear. (Used with permission from
Microsoft)

The cropped image needs further adjustment to make it look appropriate in the space for the image. You can
take several steps to accomplish this: You can move the image down to center it in the box. You can enlarge
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the image to fill the space more fully. You can also crop the image to a specific shape to add visual interest
(Figure 7.16). Finally, you can add a text box to provide a description of the image for the audience, as we
learned in Preparing Presentations.

Figure 7.16 The Crop tool gives you many options to fit an image to a specific space on the slide. (Used with permission from
Microsoft)

Creating Transparent Picture Backgrounds
Suppose you decide that the kayaking picture might have more impact if it were placed in the background of
the slide, rather than in the white box off to the right. You can accomplish this by adjusting the transparency of
the image. The amount of light that is allowed to pass through an image is called transparency. If an object is
totally solid, like the star included on slide 3 of the presentation, it is considered opaque, meaning no light is
allowed through the shape. When we adjust the transparency, we are adjusting how opaque or translucent
(clear) the image is.

This type of change is easy to make in PowerPoint. First, you will need to change the design of the slide to
remove the framed box on the right of the slide. To do this, go to the Slide Master tab. (Recall that the Slide
Master tab summarizes all the features contained on a slide.) Choose the Hide Background Graphics box in the
Background command group (Figure 7.17). Now you will notice the frame around the picture has been hidden.
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Figure 7.17 The frame around the picture was added when we changed the design of the slide using Designer. We can hide it
because it is considered a “Background Graphic” of the slide. (Used with permission from Microsoft)

Next, click on the picture and access the Picture Format tab to make the picture transparent. The Transparency
tool is located in the Adjust command group. Choose the down arrow to see the transparency options for the
photo (Figure 7.18). When you have selected an option that works, you will need to resize the photo to take up
more of the background of the slide. You can also adjust the cropping of the image from the circle to a
different shape, if desired. It may be a good idea to change the font color of the text to make it stand out more
from the image background. There are other options in the Adjust command group to change the look of the
picture, such as the Artistic effects (Figure 7.19). Explore the options and see how the changes impact the
image. If desired, you can also reset the image to its original state.

Keep in mind that as you resize a picture, its quality may be diminished, depending on the original resolution
of the image. You may not be able to enlarge all images to fill the entire slide while maintaining the clarity of
the photo. In this example, the photo is slightly blurred, but because it is more transparent, the image quality
is still acceptable.
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Figure 7.18 You can adjust an image to various levels of transparency. (Used with permission from Microsoft)

Figure 7.19 There are numerous ways to enhance images using the Adjust command group tools. (Used with permission from
Microsoft)
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7.3 Preparing a Microsoft PowerPoint Collection for Presentation

Learning Objectives
By the end of this section, you will be able to:

• Add transitions to a presentation
• Add animations to objects and text boxes
• Use the tools in the Media command group
• Finalize your presentation for viewing
• Understand the hardware components of effective presentations
• Prepare for different types of presentations (in person, virtual, or hybrid)

You learned the basic workings of PowerPoint in Preparing Presentations. Now it’s time to learn how to turn
those basic slides into a presentation that not only informs but also engages the audience. You want to create
a presentation that’s seamless and easy to present from. For example, if you are giving an in-person
presentation, you don’t want to have to stand by the computer and manually advance the slides. Also, since
the My Life in a Snapshot presentation is a presentation about yourself, you want to convey that you are
competent with PowerPoint.

Your supervisor told you today that you will need to record the presentation so that it can be shared with
others at WorldCorp’s international office locations. In this section, you will acquire the skills to virtually
automate your presentation while also including the key information you will need to keep you on track as you
present in front of an audience.

Finally, you hope to be able to provide printed handouts to the participants in case they need the information
later on. Integral to that is learning about other tabs in PowerPoint—namely, the Transitions, Animations, Slide
Show, Record, and Review functions.

Transitions
The term transitions refers to the way one slide changes to the next slide. As you can see on the Transitions
tab in Figure 7.20, there are many ways to move between slides. The Transition to the Slide command group
contains options such as Fade, Split, and Shape. You can use the Timing command group tools to determine
the duration of the slide on the screen, or how quickly the slides move (transition) from one to the next. A
sound can be used as the slide transitions, or you can simply move to the next slide using a mouse click.

Figure 7.20 Transition effects can apply to a single slide or all slides in the presentation. (Used with permission from Microsoft)

There are many transitions to choose from (Figure 7.21). For example, you can have a slide fade into the next
slide or push one slide out of the way for the next one. You can have a slide zoom in from one side when
moving to the next slide. But keep in mind that not all the options available are necessary or even professional.
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Overuse of distracting transitions can take away from the professionalism of a presentation. Choose a
transition that works for your content and one that is not going to be too distracting to those viewing the
slideshow and that is not irritating to you as the presenter. Look at the available options for slide transitions
and see what they do when you advance to the next slide.

Practice with the transitions before you present in front of an audience. If a transition seems to take too much
time or seems to stand out more than what you are discussing, you should select a different one. You can
always choose to have no transition between the slides. This simply means when you advance the slide it will
move fully to the next slide, with no special effects. You must apply the transition to each slide individually.
Whatever you choose will not affect the entire presentation. To apply a transition to the current slide, simply
click on the desired transition. The Preview command on the far left allows you to see how the transition works
on the slide.

Stay focused on the message you are conveying, not on the way one slide transitions to the next. Always
remember that just because you can do something does not mean you should. With transitions, follow the
principle that less is more if you want to maintain a professional business look.

Figure 7.21 The Transitions tab shows the choices you have for moving between slides. Notice the transitions are grouped by theme:
Subtle, Exciting, and Dynamic Content. (Used with permission from Microsoft)

You will notice that the Transitions pane is organized by transition effect. For instance, the first command
group, titled Subtle, contains Morph, Fade, Push, Wipe, Split, Reveal, and Cut. (It contains more options, but
these are the most used.) A description of each is in Table 7.2. There are two other transition command
groups: Exciting and Dynamic Content. These transitions are more animated and may not be appropriate for
all presentations. But for certain types of presentations, such as sports media or sharing family photos in a
slideshow, these transitions might work.

494 7 • Advanced Presentation Skills

Access for free at openstax.org



Morph
Apply to a slide and the slide before it will dissolve out and the slide on which Morph is applied
dissolves in.

Fade One slide fades into the next, so both slides appear at the same time for a second.

Push Pushes one slide up and out of the way, revealing the next slide.

Wipe Wipes out a slide in a horizontal direction to reveal the next slide.

Split Makes a cut up the center of the slide; each half is pushed out of the way to reveal the next slide.

Reveal One slide blends out, and the next slide blends in.

Cut
Creates a sharp end to one slide and a sharp start to the next. Can be a jolting transition
experience.

Table 7.2 Subtle Transitions

For our title slide in My Life in a Snapshot, let’s choose the Wipe transition. Notice in Figure 7.22 that when you
choose a transition (other than “None”), the Preview tool will be available, as well as an Effect Options menu.
Again, Preview allows you to see the transition in action. The Effect Options gives you additional modifications
to the transition that you can apply to the slide. Keep in mind, any modifications are only on the current slide.
You will need to apply the transition and the modification to all slides if you want it to be consistent
throughout the presentation.

Figure 7.22 You can change the direction of the Wipe transition using Effect Options. (Used with permission from Microsoft)
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The last command group on the Transitions tab is Timing. Timing is where you can add sound to your
slideshow, as well as choose how many seconds to move from one slide to the next. The arrow gives you many
choices of prerecorded audio sounds, such as Applause, Explosion, and Wind, or you can choose a sound file
from your computer. When selecting a sound, consider the audience, the presentation environment, as well as
the intent: Is the sound relevant to the presentation? Does it enhance the presentation, or is it a distraction?
You can apply the sound to the whole slide or to an object on the slide. For example, perhaps your slideshow
was created to announce the winner of a competition. You can place a picture of the winner on a slide, and as
it is revealed, it is accompanied by a round of applause. Again, use this option with caution, as your audience is
not expecting to hear sudden sounds. This command group lets you set the duration of the sound as well.
Additionally, you can set the way the slideshow advances, by clicking the mouse or automatically after a set
amount of time.

Animations
Slides and presentations as a whole can also be enhanced with the addition of animations. An animation is a
special effect added to objects and elements on a slide. They will apply only to that object, shape, or other
element, not the entire slide. For example, you could choose to have a picture slowly fade away or come into
view during the presentation when you are discussing a current slide. This could be impactful if you want to
bring the audience’s attention to a particular element on a slide. As with other additions, keep in mind that
these special effects should have a purpose and be used to enhance or draw attention to something in a
presentation. They should not be overused to the extent of being distracting and taking away from the key
message you are trying to convey on a slide.

Let’s look at the Animations tab in more detail to see the options you can use for elements on a slide. Figure
7.23 shows the choices available. The first command group is Preview. Click on this and you can see in advance
the animations you have implemented. The second command group is Animation. Six choices are shown,
including None. Click on the More arrow and thirteen additional movements appear, as well as some emphasis
animations.

Figure 7.23 The Animations ribbon shows you all the options for animating elements on a slide. (Used with permission from
Microsoft)

By scrolling down, you will also see other animation options, including Exit Effects and Motion Paths (Figure
7.24).
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Figure 7.24 Additional animations are available, including some of the Emphasis animations. (Used with permission from Microsoft)

To add an animation to your presentation, click on a text box or an object, and then choose an animation from
the menu. Next, in the Timing command group, click the drop-down arrow for Start. You can leave it at Start on
Click, or you can choose Start With Previous or Start After Previous. You need to choose when the animation
will start.

Not all animations need to be dramatic or used for emphasis. For example, you can make a bullet list appear
one bullet at a time, as opposed to having the whole list appear at once. You can have the first bullet appear,
talk about it, and when you are ready, click the mouse again to have the second bullet appear, and so on. This
can help you control the flow of the discussion by limiting what your audience sees on the screen. For
consistency, you should use the same animation for each of the bullet points in the list.

We can use this approach to add animations to the bulleted list in our My Life in a Snapshot presentation. We
used a bulleted list in the Strengths & Skills slide; let’s apply an animation there.

To begin, click on the bulleted list to select it. Then go the Animations tab and choose an appropriate
animation. For this example, let’s choose Appear, so that the bullet will simply appear based on the settings
you choose in the Timings command group (see Figure 7.25). Notice when an animation is added to an object
or text box, the Preview tool is available on the left of the screen, as is a numbered list to the left of each item
in the bulleted list. These numbers allow you to adjust the settings for each of the bullet points in the list.
When you add an animation, there are also adjustments that can be made through the Effect Options drop-
down list. The list can appear as one object, all at once, or by paragraph.
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Figure 7.25 You can adjust the settings for each bullet to have a different animation. Here, the By Paragraph sequence is chosen so
that each bullet point can be sequentially added one by one when you click. (Used with permission from Microsoft)

You need to adjust the settings for each bullet so that one will follow the other. You can choose to have the
bullet appear after a certain amount of time or when you click. For now, let’s set it up so that the bullet points
will appear when you click, because you are not yet sure how long to talk about each one. For the first bullet
point, “Situational awareness,” the animation will start On Click, which you choose from the drop-down menu
in the Timing command group as shown in Figure 7.26. This will be the setting for each bullet. Selecting the
small number to the left of the bullet allows you to change the settings for each animation individually.

The other options in the Timing command group allow you to set the timing for the animation and the delay as
you move from one animation to the next. For this example, we left those at their default values and will
simply use either the mouse or the Enter key to click when we want to have the next bullet appear. Use the
Preview tool to make sure the animation is working.
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Figure 7.26 Each bullet can have a customized animation setting. (Used with permission from Microsoft)

The remaining command groups on the Animations tab are Advanced Animations and Timing (Figure 7.27). In
the Advanced Animations command group, you can control the Trigger for when slides transition. It could be a
click of the mouse or after a certain amount of time. In a presentation where you might be in a large room and
not close to the laptop or computer, having slides automatically advance might be helpful, although you will
need to be aware of how much time you have for each slide and make sure that you do not expect
interruptions until the end of the presentation. In this case, you will want to ask the audience to hold all
questions until you are finished with the presentation. Finally, if you are one presenter of several during a
session and you have very strict time requirements, the timing tools can help keep you on track.

Figure 7.27 The tools in the Advanced options allow you to further customize the chosen animation and to open the Animation Pane
to the right of the screen. (Used with permission from Microsoft)

Clicking on the first command, Add Animation, opens the same window that you see when you click on More in
the Animations group. At the bottom of the animation illustrations is a list. You can click on More Entrance
Effects, More Emphasis Effects, More Exit Effects, or More Motion Paths.

Another command in this Advanced group is Animation Pane. When you select this tool, a pane opens on the
right side of the screen that lists all the animations on the slide. Here you can play the animations or make
changes. The other commands include Trigger and Animation Painter. Trigger governs when an animation
begins, while Animation Painter is similar to Format Painter in that it copies an animation to another object.

The timer on the Animations tab refers to the timing options available for animations applied to objects or
elements on a slide. The timer allows you to control when and how the animations occur during a slideshow
presentation. On the far right of the Animations tab, you will find the Timing group. Select an object or
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element on a slide and apply an animation to it. Once selected, you can access the timer options to specify the
timing and duration of the animation. Table 7.3 summarizes the options.

Start

Determines when the animation starts playing. By default, it is set to On Click, meaning the
animation will start when you click the mouse during the slideshow. However, you can choose
other options such as With Previous (starts the animation simultaneously with the previous
animation on the slide) or After Previous (starts the animation right after the previous
animation finishes).

Duration
Sets the length of time the animation will take to complete. You can specify a specific duration
in seconds or milliseconds. The default duration varies depending on the animation type but
can be adjusted per your preference.

Delay
Introduces a delay before the animation starts. You can specify a delay in seconds or
milliseconds. This can be useful to create time gaps between different animations on a slide.

Repeat
Determines if the animation should repeat after it completes. You can choose to repeat the
animation a certain number of times or have it repeat indefinitely until the slide advances, or
the animation is manually stopped.

Rewind
when
done
playing

When selected, this option causes the animation to reset to its original state when it finishes
playing. This is useful for animations that involve movement or transformations.

Table 7.3 Timing Group Options

By adjusting these timer options, you can precisely control the timing and behavior of animations on your
slides, ensuring they align with your desired presentation flow and visual effects.

While it may be fun to animate all kinds of things in your presentation, remember that it is your message that
matters. Audiences can easily get distracted or fascinated by animations and not pay attention to the
substance of the presentation. Therefore, it is important to use animations judiciously and purposefully to
enhance, rather than distract from, your content. Animations in PowerPoint can be effective tools for
emphasizing key points, guiding the audience’s focus, or adding visual interest. However, it is essential to strike
a balance between engaging animations and maintaining the clarity and effectiveness of your message. Here
are a few best practices to consider:

• Keep it relevant: Only use animations that directly support or enhance the content of your presentation.
Avoid using excessive or flashy animations that serve no real purpose, as they can overshadow your
message.

• Enhance comprehension: Use animations to aid in the understanding of complex concepts or processes.
For example, you can use animations to sequentially reveal steps or demonstrate cause-and-effect
relationships.

• Use sparingly: Don’t apply animations to every element on every slide. Selectively choose elements that
truly benefit from animation to avoid overwhelming the audience or diluting the impact of your message.

• Prioritize readability: Ensure that animated text or objects remain easily readable and don’t become
distorted or hard to follow. Consider the size, font, and colors used in your animations to maintain
legibility.

• Practice timing: Fine-tune the timing of your animations to maintain a smooth flow throughout the
presentation. Avoid animations that are too fast or too slow, as they can disrupt the natural pace of your
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delivery.
• Rehearse and gather feedback: Before delivering your presentation, rehearse with the animations to

ensure they enhance your overall delivery. Seek feedback from trusted colleagues or friends to gauge if
the animations effectively support your message or if they become distractions.

Remember, the primary goal of your presentation is to convey a clear and impactful message. While
animations can be engaging, they should never overshadow or detract from the substance of your content.
Strive for a harmonious balance between captivating visuals and a compelling message to create a memorable
and effective presentation.

Media Command Group
The Media command group is used to add audio or video media to the presentation. There might be instances
where you would want to add a short clip of a video or audio to enhance the presentation of a topic. For
example, in your role in the marketing department at WorldCorp, you might want to share a clip of a new radio
ad campaign, or a short video showing some concepts for new ads to be placed on the website for a new line
of products. You can do this by embedding various media types into a slideshow presentation. The Media
command group is located all the way on the right side of the Insert ribbon tab. You have three options to
choose from, as shown in Figure 7.28: video, audio, and screen recording. The screen recording option will
allow you to record your computer screen and insert it into your presentation.

Figure 7.28 The Media menu makes it easy for you to choose which type of media you want to insert. (Used with permission from
Microsoft)

Let’s add a video to our kayaking slide. We have the option of adding a video that we have created ourselves, a
stock video that is already available in PowerPoint, or a video that is available online, such as from YouTube.
You will want to consider the source of your media, as well as how you will be presenting this material. For
instance, is the media file linked to the internet? If so, you will want to ensure you have internet connectivity in
order to play the video. For this example, let’s search stock videos for a kayaking video to insert into the slide.
As a word of caution: do not overuse these tools. Consider only the additions that will enhance the
presentation content. Not every slide should include media, and not all presentations are appropriate for
media.

To add media to a slide, select the slide for the addition. In this case, insert the video on the Background slide.
Go to the Insert tab and click on the Media command group. Select Video, then select Stock Videos from the
menu (Figure 7.29). In the search bar, type “kayak” to locate a kayaking video to insert onto the slide. Once the
video is on your slide, you have the option to resize it (Figure 7.30).
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Figure 7.29 (a) You can search online or through available videos in PowerPoint to find one to insert into the slide. (b) Choose Insert
to place the video into the slide. (Used with permission from Microsoft)
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Figure 7.30 (a) The video will insert at a large size. Click on it to resize it to fit on the slide. (b) You can play the video using the control
keys under the video insertion. (Used with permission from Microsoft)

Once the video is inserted into the slide, it will automatically play when you get to that slide in the
presentation. However, you can change this through the Playback tab that becomes available on the ribbon
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when the video is selected (Figure 7.31). It is important to preview the video before presenting or sending the
presentation to others. Previewing the video in your presentation ensures that it meets your expectations,
enhances your message, and delivers a seamless viewing experience to your audience. It allows you to
proactively address any issues, improve the overall quality, and ensure a successful presentation. Notice there
are several options available on the Playback tab. Experiment with the settings to see which ones appeal to
you most and give the slides a professional appearance.

Figure 7.31 Be sure to determine whether you want sound in the video. That can be adjusted with the Playback tab options. (Used
with permission from Microsoft)

Finalizing Your Slideshow
Before you complete your presentation, you should give it a final review so you can see exactly how it will
appear to your audience. It is also important to practice your presentation and consider the other, nondigital
elements involved in a presentation, such as monitoring the length of your presentation and interacting with
the audience.

By accessing the Slide Show tab, as shown in Figure 7.32, you can view the complete presentation from start to
finish. The first command group in this tab is called Start Slide Show, and you can choose From Beginning or
From Current Slide, and the presentation will do just that. This is a wonderful way to preview all the transitions
and animations you have added, as they will appear to the audience. Next, you can choose the option to
Present in Teams, which we covered in Essentials of Software Applications for Business. You need to be logged
into your Microsoft account to use this option. The next command is Custom Slide Show, which allows you to
choose the slides to use in the show. This is a helpful option should you need to shorten the presentation.

Figure 7.32 This is the ribbon where you can set up, rehearse, and make final adjustments to your presentation. (Used with
permission from Microsoft)

Next you can choose the Rehearse with Coach tool, which allows you to practice the presentation and get
feedback in real time. This tool will listen for things such as using “uh” or “um” in the presentation as well as
how fast you are speaking. Not only will the tool give you a summary of items related to your speaking skills,
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but it will also provide you with some strategies for improvement. You will need to have the microphone
enabled on your computer to use this feature. This is a helpful tool as you work to develop your skills
presenting in front of a group.

The next set of commands is in the Set Up command group. Rehearsing the timing, playing narration, and
other options are controlled through the tools in this command group. These tools allow you to fine-tune your
presentation options. Clicking on the Set Up Slide Show button, for example, opens a menu with a number of
different settings, as shown in Figure 7.33.

Figure 7.33 The Set Up Show tool allows you to control many different aspects of your presentation, particularly the hardware
elements, such as using multiple monitors and how your presentation will be viewed by others (Show type). (Used with permission
from Microsoft)

As you can see, you can set the Show type as either presented by a speaker in full screen mode, browsed by an
individual in window mode, or browsed at a kiosk in full screen mode. The default setting is presenting full
screen, where you can click through the slides as you present them. The window mode setting allows you to
present with the slides in a resizable window rather than in full screen. Finally, the kiosk setting is used when
you want to run the presentation continuously, such as at a company event. For example, suppose you want to
have a new marketing campaign available for employees to view at an internal conference. By choosing the
kiosk setting, the slideshow could run automatically and continuously until you turn it off.

The Set Up Slide Show tool also gives you the option to Hide a slide, Rehearse the timing, or Record the
slideshow. Other options in this window require just checking the appropriate boxes, such as Keep Slides
Updated, Play Narration, and so on.

The last command group on the Slide Show tab is Captions & Subtitles. The tools here allow you to turn on and
modify the captions and/or subtitles in your slideshow. You can determine where you would like the subtitles
to be placed—for example, at the top of the slide.

MAC TIP

When adjusting the caption and subtitle preferences on a Mac, you will be directed to your operating
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system’s Accessibility settings.

Record Tab
If you need to record the presentation to send to others or even for your own viewing, you will find the tools
you need in the Record tab (Figure 7.34). This feature in PowerPoint allows you to capture your presentation,
either from the beginning or starting from a specific slide, and customize the recording options (Figure 7.35).

In Recording Options, you can choose whether to record the entire presentation from the beginning or start
recording from a specific slide. This flexibility is helpful if you want to focus on specific sections or if you have
already recorded part of the presentation and want to continue from where you left off. PowerPoint allows you
to record audio along with your presentation. You can use a microphone to narrate your slides and explain
concepts, making the recording more engaging and informative. This feature is particularly useful for online
training sessions, narrated presentations, or self-paced learning materials.

Figure 7.34 Recording the presentation can help you as you rehearse to present in front of others. In the record mode, you will see
several tools such as exporting and adding notes to help you when presenting. (Used with permission from Microsoft)
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Figure 7.35 This is what your screen will look like after you hit the red Record button in the Record ribbon. (Used with permission
from Microsoft)

In addition to audio recording, PowerPoint offers screen recording functionality. This enables you to capture
actions on your screen, such as demonstrating software usage, showcasing a website, or walking through a
step-by-step process. Screen recording can enhance the clarity and understanding of your presentation,
especially when visual demonstrations are involved. After you complete the recording, you can export it as a
video file. This video can be shared with others, uploaded to video hosting platforms, or embedded in websites
or learning management systems. Exporting the recording as a video makes it more accessible and shareable
across different devices and platforms. During the recording process, you can add private notes to your slides
to help guide you through the presentation. These notes are only visible to you and serve as personal
reminders or prompts while delivering the presentation. They are not included in the recorded presentation
itself.

Review Tab
The Review tab, as shown in Figure 7.36, is used primarily when you are collaborating on a presentation with
someone else or incorporating feedback on your draft slides. However, this tab still offers valuable resources if
you are creating your presentation on your own. The first command group in this tab is Proofing. As with any
document you produce, it is essential that you proofread everything, including text, figure captions, and any
handouts you may have for the participants.

The presentation and handouts should reflect your professionalism and attention to detail. But, you should
not rely solely on the spell check tool to find all the errors. Among other things, spell check often does not
identify spelling errors in proper names or words that are spelled correctly but used incorrectly. Additionally,
errors will be much more noticeable when they are displayed on a large-format screen. It’s easy to overlook
errors in our own work, so be sure to have a friend or coworker review the slides to look for errors.

All of the proofing options can be set before you begin writing. This is done by choosing File, Options, and then
Proofing. These options are similar to what we covered in Essentials of Software Applications for Business.
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LINK TO LEARNING

Proofreading a presentation can be much different from proofreading a document. This article on the
importance of proofreading presentations (https://openstax.org/r/78ProofrdPresnt) addresses how to
effectively proofread PowerPoint presentations.

The Thesaurus tool is helpful when you write the dialog that will accompany the slideshow, as it will offer
alternatives to the words you have used in the presentation. For example, we used the word “hometown” in
our background slide. When we click on that word and choose Thesaurus from the Review tab, a pane will
open on the right offering alternative words that are similar to “hometown” (Figure 7.36). This tool can come in
handy if you find yourself using the same words multiple times in a presentation. You can vary the words used
and still convey the same message.

Figure 7.36 The Review tab covers Proofing options, adding comments, and comparing different versions of the show. The
Thesaurus will help you enhance the slides by offering synonyms for words, which will appear below the search bar. (Used with
permission from Microsoft)

MAC TIP

On Mac, this command is found in the PowerPoint menu, then Preferences, then Proofing.

Comments

As in other Microsoft products, the Review tab is also where you can find tools for collaboration and
commenting. (PowerPoint does not allow users to track changes.) We discuss a workaround for this in the
Compare section. When working with others to produce a presentation, your colleagues have the option of
adding comments to it. To do this, open the Review tab, then click on a word in the place where you want the
comment to appear, and then click on New Comment. As you can see in the example slide in Figure 7.37, the
Comments pane opens to the right. After you type the comment and click Enter, a reply text box becomes
available. You, or anyone else with permission to work on the presentation, can enter a reply to the comment
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here.

Notice that a callout symbol opens in the place where you want the comment to apply. You can move the
callout symbol around on the slide without affecting the content of the comment.

Figure 7.37 A Callout symbol helps you find where the comment is located. This is particularly useful when the commenter uses
directional references such as, “Let’s move the title here.” (Used with permission from Microsoft)

Compare

Unlike Word, PowerPoint does not offer a tracking function. However, you can use the Compare command,
also found under the Review tab, as a workaround to tracking changes. To use this tool, you will need to have
different versions of the presentation saved. The Compare command then will look for differences between
the two files, and you can either decide one by one to accept (or reject) each change or accept (or reject) all the
changes/differences between the two files.

To see how the Compare command works, let’s use the presentation we created in the previous chapter, along
with the updated version we have created thus far in this chapter. Here we have saved the previous chapter
presentation as “version 1” and the current presentation as “version 2.” Note that the different versions of the
presentations must have different names. To begin, choose the Compare command from the Review tab and
find the “version 1” file you are going to use to compare to the current version (Figure 7.38). Then click Open,
and you will notice that you now have access to other tools available in the Compare command group on the
Review tab. You can use the tools and the pane on the right of the screen to scroll through the differences
between the two files and determine if you want to accept or reject the changes. You can choose to accept or
reject the changes for each individual slide, or you can accept or reject them for the entire presentation as you
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move through the comparisons (Figure 7.39).

Figure 7.38 Make sure that the file you choose to compare to has a different file name. (Used with permission from Microsoft)
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Figure 7.39 Using the Compare tool is not quite the same as tracking changes, but it can be close. It allows you to compare different
versions of the same file. (Used with permission from Microsoft)

Printing a Presentation
Sometimes, as a presenter, you may wish to print your presentation as a handout for the audience. You could
provide the slides as a handout prior to the presentation so that the participants can take their own notes on
the information, or offer them to participants as they exit the presentation. PowerPoint gives you many
options for accomplishing this. On the File menu, click Print, and you will see a familiar pop-up menu, as
shown in Figure 7.40 and Figure 7.41.
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Figure 7.40 (a) When printing a presentation, you have several options. Many of these options are similar to what you might find
when printing a Microsoft Word document. (b) You can choose to print select slides or just a few slides. (Used with permission from
Microsoft)
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Figure 7.41 When printing the slides, you can choose to have several on one page to save paper. This might be a nice option if you
are printing for audience handouts. (Used with permission from Microsoft)

The Print All Slides option allows you to print the whole presentation, to print just the current slide on the
screen, or to selectively print only the slides you want. The Print Full Page Slides option brings up a menu of
layouts so you can print anywhere from two to nine slides to a page and can indicate whether you want them
to appear in a horizontal or vertical format. You may also choose to print the Notes page and the outline.
These can be helpful as you rehearse your presentation.

Other Considerations Before Presenting
In addition to the practical aspects of your slideshow—such as how the slides appear to your audience, what
media to include, and how to print your slides—there are other, less tangible things to consider before
showing your slide collection to an audience. These include the length of your presentation, audience
interaction, notetaking, and accessibility.

Presentation Length

When constructing and preparing for a presentation, you need to know how much time is allotted for the talk.
Is your presentation the main component of the meeting, or will several others also be presenting? Knowing
how much time you have to present will dictate how much information and, in turn, how many slides you will
have in the slideshow. Keep in mind that you should not overuse slides. You are the main part of the
presentation. The slides are there to enhance and support what you are saying by keeping the audience
engaged and conveying the main points you want to get across. They should not contain all the content you
are sharing. The optimal number of slides depends on the content you are sharing. For example, if you are
sharing complicated data in an informational presentation, you will need more slides to break up the material.
If you are giving an inspirational presentation, you may need fewer slides, most of which should be images
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rather than text.

A good strategy is to use allotted time to determine the number of slides. As a rule of thumb, each slide should
be on the screen for about a minute, so a ten-minute presentation would have about ten slides. Of course, this
can vary based on the type of information contained on the slides. The audience might need more than a
minute to digest and understand data and graphs on a slide, whereas they may need only fifteen or twenty
seconds to get the full effect of a slide consisting entirely of pictures. Practice your presentation; you may want
to have someone track the time, or you can simply set a timer on your phone. You could use the timer to
gauge how long you need to spend on each slide. You may even want to have this timer displayed on your
laptop screen close to your speaker’s notes so it will be in your line of sight. If you run out of time before you
have discussed all of the slides, you will know that you have too many slides. At that point, you can consider
either removing some slides altogether or merging information on two or more slides onto a single slide.

Audience Interaction and Questions

When you give a presentation, it is likely that there will be questions from the audience (Figure 7.42). During
your preparation phase, brainstorm a list of questions that might be asked or areas where you think more
clarification will be needed.

Figure 7.42 It can be helpful to have answers and comments prepared in anticipation of a lot of people having questions. Promising
to get back to attendees with questions that you can’t answer at the moment is acceptable as well. (credit: “person raising hand” by
pxfuel, Public Domain)

Consider creating a Frequently Asked Questions (FAQ) page to distribute to the audience for questions that
you feel are likely to be asked. You might even have a friend or family member listen to the presentation and
ask you tough questions. This exercise will not only help prepare you to answer tough questions but can also
help you maintain your composure if someone challenges you in front of the group. If that happens, you
should remain professional and not respond defensively to questions or challenges from participants. You may
even want to encourage interaction and questions from the audience. Take a bit of time to plan ahead for how
you will interact with the audience and address questions from participants. You can certainly ask the audience
to hold all questions until the end of the presentation, but be aware that this often reduces engagement, and
you may find that you have no questions at all at the end of the presentation—only silence. If you want to hold
questions until the presentation is over, you might ask a colleague or friend to be prepared to ask a question
that will get the conversation started. Sometimes participants will be more engaged after the first question, so
having a “plant” in the audience to ask the first question can get things moving.

Also consider a strategy where you have audience interaction from the beginning and encourage questions
during the presentation. One effective way to set the stage for having a dialog with the audience during the
presentation is to start by posing a question to participants. This can be very general—“How is everyone this
morning?”—or it can be something specific related to the presentation you are about to give. Amir’s
introduction presentation for WorldCorp conveys his leadership skills and his passion for kayaking, so he
might start by asking who in the audience enjoys water sports or what characteristics make a good leader. All
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of these ideas will set the stage for a more interactive presentation. Figure 7.43 outlines some other tips and
strategies for handling audience questions.

Figure 7.43 Have a strategy planned before the presentation to deal with audience questions.

Speaker’s Notes

You can convey a more professional and well-prepared appearance in front of a group if you present without
holding note cards or note pages during the presentation. However, it may be helpful for you to have a few
notes visible to keep you on track during the presentation or to capture details such as sales figures that you
want to be sure to quote exactly. This is where speaker’s notes can come into play. In Normal view, you can
see the space for notes at the bottom of the slide (Figure 7.44). If you do not see the Notes section at the
bottom of the slide, you can click on the Notes button from the View tab. When you add your notes, they will
appear as shown below the slide (Figure 7.45). Click to add the details and click Save.
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Figure 7.44 Slides do not come with any notes by default. If you want notes to appear with slides, you must add them. (Used with
permission from Microsoft)
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Figure 7.45 Speaker's notes appear directly below the slide. They are only visible to you, the presenter, and will not be shown to the
audience during the presentation. (Used with permission from Microsoft)

When you present your slideshow, do so using Presenter’s View. Make sure you check the box found on the
Slide Show ribbon. Your notes will appear on your laptop but not on the projection screen. Your audience will
not see your notes.

Accessibility and Languages

An additional consideration when preparing a slide presentation is making sure the information and format of
the presentation can be understood by all of your viewers. The Check Accessibility tool in PowerPoint functions
in the same way that it does in Word. This feature can be set to continue running while you are creating the
presentation. It will look for items that might cause accessibility issues, such as color contrast and font size,
and offer suggestions for correcting the issues. For example, the tool might find that there is not enough
contrast between the background color and the text color, making the text hard to read. Or it may flag text in a
table as being unreadable due to it being too small. The Accessibility tool will also indicate if images have
appropriate alt tags associated with them.

You may also have speakers of other languages in your audience. The Translate tool, found in the Review tab,
can be helpful if you need to make the material available in a language other than the one you wrote the
slideshow in. The Translate tool can be used to translate the entire presentation or just the current slide. (If
you speak a language other than English yourself, you can also set the default language to be different from
English when typing in content to the slides.) A word of caution for relying solely on the Translate tool: like the
spell check tool, it may not be completely accurate and should be reviewed by a person. It would be beneficial
to have a proficient speaker of the language review the translation for accuracy before you share the
presentation. As WorldCorp operates globally, this tool can be useful when sharing information with the
company’s international divisions.

7.3 • Preparing a Microsoft PowerPoint Collection for Presentation 517



Room Setup and Technology
You will likely be presenting with several types of technology, including the laptop on which you created the
slideshow, monitors, audio equipment, and others. As part of your preparation process, make sure you
understand the environment in which you will be presenting. If you can, visit the physical space in advance and
see how the room will be set up. This may mean you will need to make time to come to the room on a day
prior to your presentation or to show up early on the same day to familiarize yourself with the room and
technology.

When you are there, you should be looking at how the audience will be arranged in relation to you as the
speaker, as well as the setup of the technology. You will also want to know what the “speaker space” looks like.
Will you have space at the front of the room to walk back and forth a bit, or will you be restricted to standing
behind a podium or sitting at a computer terminal? You will also want to test the acoustics in the room. You
will want to know if your voice level will be appropriate or if a microphone will be needed. Another item to
consider is how you will manage printed handouts for the audience if you have incorporated these into the
presentation. Will the room setup give you easy access so you can distribute the handouts, or will you need to
have them available as participants enter the space? You may want to consider asking a colleague to be
responsible for passing out the materials.

The point is to be prepared and know the space before giving your presentation. This will not only set your
mind at ease if you are nervous, but it will convey a level of professionalism during the presentation. Coming
unprepared for the layout of the room can add an unnecessary layer of stress and confusion when giving an
important presentation.

It is even more advantageous if you can view your slideshow in the space you will be presenting in. Put your
slides up on the display screen and go to the back of the room to see how they look. Often, how slides appear
on the computer or laptop screen may not be how they show up on a large projector screen or a large monitor.
By previewing the slides from the back of the room, you can determine if changes are needed to color
schemes or font sizes to make the slides more readable from that distance.

Being prepared for the various technologies you will encounter is also important. Some technologies you can
provide yourself, such as a slide clicker. A slide clicker, or presentation remote, is a tool that can pair with your
laptop and allow you to click through your slides from a distance. Some remotes also include laser pointers, so
you can point to things on your slides from a distance. If the slide clicker has a laser pointer included, make
sure you know how to use the pointer and think about how you might incorporate it into your presentation.
You may also have several audio options available to you. Using a lapel microphone, or a mic that clips onto
your shirt, will allow you to move freely about the room. However, some spaces may only have a microphone at
a podium, so you will need to stand in one place to use it. Your approach to the presentation will likely change
if you have to click the slides at the computer and be at a podium for the microphone. There is more flexibility
to move about the room when giving a presentation if you have a slide clicker and lapel microphone.

It is also a good idea to test each piece of equipment to make sure it is functional and that you know how to
use the technology. It can be embarrassing to be in a situation where the technology is not working or you do
not know how to use the devices. Many venues and companies will have a person assigned to address
technology issues during presentations. This could be someone from the information technology department
or someone else who is familiar with the room and the technology. It is a good idea to find out if that person
will be in the room during your presentation or available quickly if needed.

Some additional technology considerations include issues of compatibility between your file and the computer
available in the room. We see this often when going from a Mac to a Windows environment. Make sure your
file is saved in a format that will be universally accessible. Often, saving your file in PDF format ensures it can
be accessed on a variety of platforms. (You can review how to do this in Essentials of Software Applications for
Business.) It is also a good idea to have your presentation file saved in multiple locations, for example, on the
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hard drive of your laptop, in One Drive, and on an external storage device such as a flash drive, in case the
internet is inaccessible. You may also want to email yourself a copy of the file so that you can access it that way
if necessary.

There is no expectation that you are a computer expert, but preparing and having a backup plan in place can
help ease your mind and reduce some stress associated with giving a big presentation. Also, if you know you
will have challenges with technology, be sure to let the meeting organizer know so they can be prepared to
help or have someone who can assist if needed.

Types of Presentations
With the technology available today, it is likely that you will be a part of a meeting that has virtual participants.
Many meetings will still be conducted fully in person with all participants in the same room, but it is becoming
more common for meetings to be either fully virtual or hybrid, with some in-person participants and some
online participants. Your preparation for such a meeting can vary based on the type of presentation you will be
giving. Most of our discussion so far has been centered on fully in-person presentations with the speaker and
the audience in the same physical space. If you will be part of a meeting where some or all will be participating
virtually, there are other items to consider.

Fully Virtual Meetings
Let’s first consider a fully virtual meeting, where you as the speaker as well as the participants are online.
Virtual presentations can be even more impactful and beneficial due to various web conferencing tools that
can enhance the presentation, like polls and other tools. This could be using a program such as Zoom or
Microsoft Teams. Each participant will join the meeting space via the internet and while being physically in
their own space. If you have had online courses, you may have already experienced such a meeting and may
have a good idea about some of the potential challenges and benefits. For example, a fully virtual meeting can
be accessible for everyone who has the technology needed to attend. In some cases, you can also share more
content in a virtual meeting than in an in-person meeting through the chat feature and other document
sharing options. The chat feature also allows a bit more audience interaction, as all participants can post
questions and comments in the chat. Finally, you may find an online presentation less stressful than an in-
person event because you do not have to stand in front of a crowd but can be in a familiar, comfortable space
such as your own office.

However, virtual presentations also pose numerous challenges. First, it is much harder to keep the audience
engaged, especially if participants do not have their cameras on. You can politely request participants keep
their cameras on during the presentation, but that does not automatically mean they are more engaged or
that they will comply. And this can be hard to manage as the speaker if there is a large audience. Think about
times that you have participated in an online class or meeting. You may be doing other things such as
checking email or dealing with issues at home during the meeting/class. One way to combat this in an online
meeting is to set up breakout sessions/groups where the participants interact with one another in a small
group setting. You can also use the chat feature or conduct a live poll to encourage audience participation. As
the speaker, you will need to make an active effort to engage participants. This can start even before the actual
presentation begins.

For example, you might send participants a questionnaire beforehand and address those questions during the
presentation. Or you can survey participants to identify key topics they would like you to address. Finally, if you
ask participants to pre-register, you will have a list of their names if you want to address them individually
during the presentation.

Preparing for a virtual presentation is the same in many ways as preparing for a fully in-person talk. For
example, preparing your slides is the same, but you may be able to include a bit more text on each slide
because participants will have the slides right in front of them. You will still need to prepare and practice with
the technology. Be sure you know how to mute and unmute participants and how to share your screen with

7.3 • Preparing a Microsoft PowerPoint Collection for Presentation 519



the audience so they can see the slides. These settings may be different depending on the software you are
using to present, whether it is Zoom, Google Meet, Webex, or another program. You need to make sure your
online connectivity is dependable and that you have good sound quality as you are speaking. You will need to
test the camera on your computer in the space that you will be in. Look at the lighting in the room and see
how it looks on the screen. Keep your camera at eye level and examine how you are spaced in the video
screen. You do not want to be either too close to the camera or too far away; either will make it harder to hear
what you are saying. To reduce distractions, turn off on-screen notifications for any apps installed on your
computer. (For example, make sure that participants won’t hear a “ding” every time you get an email.) Make
sure your presentation environment is a quiet, professional space, with minimal distractions. You probably do
not want unwanted guests, such as your cat or dog, making their appearance during the presentation. Look at
the background the audience will see behind you. Many virtual presentation platforms have tools that allow
you to blur and change the background for a more professional appearance. Make sure you are focused on
the camera and the presentation. You do not want to give the impression that you too are distracted and not
engaged, especially when you are the speaker.

Additionally, consider setting expectations for the audience at the very beginning of the presentation. Do you
want participants to put their questions in the chat, or would you like them to use features such as the “raise
hand” icon to indicate they have a question? Will you have breakout sessions during the talk? Ask participants
to turn on their cameras and mute themselves, and then let them know if the session is being recorded.
Addressing these items at the beginning of the presentation will help avoid distractions later.

Finally, decide how you are going to monitor the chat during the presentation. Will you be answering
questions and comments while you are speaking? It may be a better idea to ask a colleague to be responsible
for monitoring the chat and the participants for relevant questions and comments. That way, you can focus on
presenting without the added stress of keeping track of the chat.

Hybrid Presentations
Hybrid presentations, where some participants are in-person and others are virtual, pose additional
challenges. As much as possible, try to set the stage so that all participants have a similar experience and walk
away with the same information. However, you cannot control all the nuances of a hybrid presentation,
starting with the risk that online participants will feel left out of the conversation. Extra care will be needed to
make sure the virtual participants are fully engaged. At the beginning of the session, acknowledge and
welcome those who are online. When you are speaking to a hybrid group of participants, it is important to
make eye contact with both groups. Make sure to focus attention on the virtual participants on the screen as
much as those who are in the room. Again, asking participants to keep their cameras on will help keep them
engaged in the meeting. Remind yourself (or a helper) to check regularly for raised hands and chat comments
during the presentation. When a comment is posed in the chat by a virtual participant, read the comment
aloud for the in-person audience. If you are using breakout rooms during the session, include virtual
participants in the activity and combine groups so there is interaction between both in-person and virtual
participants. Consider displaying the virtual participants on a large screen so the in-person audience can see
them.

It is impossible to anticipate all the hiccups that can happen during a presentation. With careful planning
beforehand, however, you can be prepared for many of the likely issues and feel less anxiety when speaking in
front of a group, whether in person or virtual.

LINK TO LEARNING

Creating a real-time poll during your presentation can help increase engagement during a virtual or hybrid
presentation. Instructions on how to create a poll in Zoom (https://openstax.org/r/78ZoomPoll) are given on
the Zoom platform.

520 7 • Advanced Presentation Skills

Access for free at openstax.org

https://openstax.org/r/78ZoomPoll


7.4 Preparing a Google Slides Collection for Presentation

Learning Objectives
By the end of this section, you will be able to:

• Add slide transitions into a slide presentation
• Understand the commands in the Tools tab
• Add audio and video to a Slides presentation
• Know how to use the collaboration tools in Slides

Now that you have mastered creating an engaging presentation in PowerPoint, we will look at similar features
in Google Slides. Slides offers collaboration tools similar to those we saw with Docs. You can do much of the
same design work in Slides that you can in PowerPoint, albeit with some limitations and differences. Slides
offers many templates to get you started, but it also includes all the tools you need to create a presentation
from scratch. Here we are going to focus on adding the finishing touches to the Slides presentation you
created in Preparing Presentations.

Add Transitions
When presenting, strive to strike a balance between the information that the slideshow conveys and the way it
conveys that information. Your goal is to hold the audience’s attention, while not adding so many special
effects that you end up distracting them. Transitions are key to achieving this balance.

As with PowerPoint, transitions are the “how”—the way the slides move from one to the next. Transitions must
be applied to one slide at a time unless you click on Apply to all slides. When you click on Transitions, found on
the right side of the action bar, a sidebar will open up, where you will see a menu of different available
transitions (Figure 7.46).

Figure 7.46 The default is to have no transition between the slides, which means the next slide will appear with no special effects.
(Google Slides is a trademark of Google LLC.)

There are several choices to consider when adding transitions to your slides. Not all transitions will provide a
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professional appearance, and some may be more distracting than impactful. The same principles apply as
PowerPoint: always consider the audience’s perspective. As the speaker, could a transition be a helpful tool to
help you slow down a bit between slides or topics, or to give you a moment to gather your thoughts as you
move to the next slide? As you rehearse your presentation, keep these items in mind. Remember, if you find a
transition more bothersome than helpful, it will also be distracting to your audience.

Now, using the My Life in a Snapshot presentation, add a few slide transitions to engage the audience. Open
the presentation you created in Slides in Preparing Presentations. You may need to refer to the material in
Essentials of Software Applications for Business to remember how to open a file in Google.

Begin by adding a transition to the first slide. First select the slide, then go to Transition on the action bar.
Then, from the sidebar on the right, click the down arrow next to None to reveal what transitions are currently
applied to the slide. Then click on None in the drop-down menu to reveal the different transition options
(Figure 7.47).

Figure 7.47 (a) This drop-down menu shows that there are currently no transitions applied to the slide. (b) You can choose to apply a
transition to all slides or to the current slide only. (Google Slides is a trademark of Google LLC.)

Try a few options to see which you find most appropriate. To preview the transition, click the Play button at the
bottom of the pane. Notice that you can also change the speed of the transition by moving the slider between
slow and fast. After you have added the desired transition, adjusted the speed if needed, and looked at the
result, click the X in the upper-right-hand corner of the pane to close it out.

Tools Menu
The Tools menu in Slides includes many features for fine-tuning your slides. Here you will find tools for
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proofing, accessibility, linking objects, and much more (Figure 7.48).

Figure 7.48 The Tools menu contains some standard features, such as spell check, as well as features unique to Google, like the Q&A
history tool. (Google Slides is a trademark of Google LLC.)

Spelling
The first command in the Tools menu is Spelling. Clicking on Spelling opens a menu with three choices: Spell
check, Show spelling suggestions, and Personal dictionary. These are all standard proofing tools that behave
just like the ones you have already encountered in Docs (Collaborative Editing and Reviewing in Google Docs).
The Personal dictionary is especially useful if you use several terms that may be unique to your business,
including variations on the name of the business. For example, you could keep a list of employees’ names in
your Personal dictionary, which will save you time when you need to issue different documents to employees
and will prevent you from being stopped by spell check.

Linked Objects
Linked objects is also found in the Tools menu. Clicking on Linked objects brings up a viewing pane on the
right and lists anything in your presentation that contains a link to another file. For example, suppose you are
presenting WorldCorp quarterly sales data and notice an error in a table that was created in Docs and linked
on a slide. Using Linked objects, you can choose that Doc file from the list and make the needed revisions. This
would not only update the table in your slide but will also revise the original Docs file where the table was
created. This function is especially helpful when your presentation contains graphs and charts created in
another Google program, like Docs or Sheets. (You will learn more about Sheets in Working with
Spreadsheets.) Rather than going into the original data file, editing the material, then copying and pasting the
chart or graph back into your Slides presentation, you can simply make the edits in the original file and your
slide will automatically be updated.

Q&A
Q&A is a unique feature of Slides. It allows collaboration that goes beyond simply sharing the file with other
users. Using the Q&A tool, you can collaborate and interact directly with the audience during the presentation,
and audience members can interact with each other. You need to activate this tool before you can use it. To do
this, navigate to the top right corner of your screen and click on the down triangle next to Slideshow. (This is
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next to the Share button.) See Figure 7.49. You are offered two options: Presenter View and Start from
Beginning. Click on Presenter View.

Figure 7.49 The Presenter View will not only activate the Q&A tool but will also show you the speaker notes. (Google Slides is a
trademark of Google LLC.)

This brings up a new window that looks like Figure 7.50. This is what you will see when you are ready to accept
questions from the audience. When you are ready to start a Q&A session, click on Start new.

Figure 7.50 Select Audience Tools in the right pane. Then, click on Start new. (Google Slides is a trademark of Google LLC.)

You will then be taken to a page with a URL at the top for audience members. The Accepting questions from...
toggle will automatically be turned to On, though you can toggle it to Off at any time. When it is turned on,
you will see a URL, as shown in Figure 7.51. The audience can go to that URL on their phones or tablets; it will
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take them directly to the Ask a Question page, where they can type in their question and click Submit (Figure
7.52, Figure 7.53). This is the page where the questions will appear.

Figure 7.51 The Q&A feature is especially helpful when giving virtual presentations. (Google Slides is a trademark of Google LLC.)
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Figure 7.52 Participants use the URL at the top of the slide to submit a question. (Google Slides is a trademark of Google LLC.)
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Figure 7.53 If the participant is logged into Google, you will see their name/picture. The form through which participants can enter
their questions looks a lot like a Google Form. (Google Slides is a trademark of Google LLC.)

The questions will appear to the presenter as they come in, in the order in which they were asked (Figure 7.54).
Also, everyone will see the questions that come in from all members of the audience. Participants can also
interact with one another in the Q&A screen. They can Like questions or comments and can also reply to one
another. To shut down the Q&A, just move the On button at the top of the questions page to Off. The audience
will see a message something like this on their devices: “Sorry, this Q&A session is closed.” If you decide to take
questions from the audience later in your presentation, instead of selecting Start new, you can choose another
option: Continue Recent. This will continue the same Q&A session.
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Figure 7.54 In the Presenter view, you will see the questions as they are asked. (Google Slides is a trademark of Google LLC.)

Insert Audio and Video
Adding sound to your Slides presentation is another way to engage your audience. You can insert any audio
file, as long as they are in MP3 or WAV format. First, navigate to the Insert menu and click on Audio. Google
lets you choose where to search for audio files: My Drive, Shared with me, or Recent. When you find the file
you want, click on Select. An audio icon will come up with a play bar, which will show you the position in the
track and its length (Figure 7.55). Remember, the icon has to be selected to view the play bar.

Figure 7.55 This is the Audio icon after audio is inserted on a slide. (Google Slides is a trademark of Google LLC.)

To control the volume, hover your mouse over the speaker symbol. The Format Options pane (under the
Format tab) has other controls you may need, as shown in Figure 7.56.

528 7 • Advanced Presentation Skills

Access for free at openstax.org



Figure 7.56 The Format options pane gives you a few options to control and modify your audio output. (Google Slides is a trademark
of Google LLC.)

Use the Audio playback controls to set how the audio will start, either automatically with the slide or on the
click of the mouse. You can choose to loop the audio or to stop it with a slide change.

Inserting a video uses much the same process. Navigate to the Insert menu, then click on Video. As with
inserting an audio file, you can navigate to where your video file is located (in My Drive, or your hard drive, or
in a Shared Drive folder), or you can search YouTube or paste in a URL (Figure 7.57).

Figure 7.57 Remember your audience when selecting videos. Make sure they are a suitable length and fully vetted of any
controversial content. (Google Slides is a trademark of Google LLC.)

As in PowerPoint, the video will initially appear very large on your slide, but you can make it smaller by
dragging the corners. A Play button will appear in the center of the video thumbnail. When you have the video
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thumbnail selected, the Format options pane will appear on the right (Figure 7.58). There are a number of
different options and settings you can apply and modify. Try a few different ones to see what their effects are
like.

Figure 7.58 Videos take your slideshow to another level. Format options helps you present them on the slide to give them their due.
Alt Text, in particular, allows you to describe what’s in the video for those who can’t see it. (Google Slides is a trademark of Google
LLC.)

Collaboration Tools
As with any Google product, Slides makes it easy to collaborate with others. At any point when you wish to
share your work with others, click on the Share button in the upper right corner. Alternatively, you can click on
File and then choose Share, which is the first option in the File menu. Clicking Share first brings up a window
asking you for a title. You can enter a title or click on Skip this step. Then you will see a window called Share
with People and Groups, where you can add the names of people with whom you wish to share the
presentation. This window should look familiar to you, as it is the same sharing window that appears in Docs.
You have the usual options available to you: you can email your presentation to other individuals or groups
(the first option in the window) or get a link to the presentation that you can also email to others or post online
(the second option). You can also restrict or permit the actions of editors and change the options that you
allow to viewers and commenters via the settings icon in the top right corner.

Insert Comments
When you are collaborating with others, it is often necessary to add comments and have your comments
responded to. To insert comments in Slides, click on the comment icon in the action bar (Figure 7.59). You can
also access comments by clicking on Insert and then Comment.

Figure 7.59 Slides makes it easy to comment and collaborate on a presentation.

Click on the comment icon and a little window will pop up with a place for you to write your comment. Next,
click on Comment—it’s that simple. Communication is practically instantaneous. Now you can send your
presentation off to your colleagues or save it to Google Drive. Figure 7.60 shows an example of a comment
made on a slide as well as the response.
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Figure 7.60 The commenting interface is similar to the one in Docs. You can also tag other users so they get notified. (Google Slides
is a trademark of Google LLC.)

For every comment you insert, clicking on the three dots in the upper right corner allows you to edit the
comment or delete it. Note that you can reply to others’ comments but cannot edit them.
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Chapter Review
Key Terms
animation a special effect added to objects and elements on a slide
crop a tool used to remove portions of an image that is inserted onto a slide
Designer a feature that adds variety and interest to slides
hook a strong opening statement to engage the audience in the content of a presentation
speaker’s notes notes added by the presenter to the slides that are not intended for display to the audience;

intended to help presenters recall important points during their presentation
Timing the way and order in which transitions and animations can be programmed to appear or occur on

the screen
transitions a feature for determining how one slide moves to the next slide
transparency the degree of light that is allowed to pass through an image
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Summary
7.1 Effective Presentation Skills

• To prepare for a presentation, you should consider the goals of the presentation, how long you have to
present, and how you will interact with the audience before, during, and after the presentation.

• A strong opening statement or hook will get the audience engaged and interested in the rest of the
presentation.

• Although there is no standard set of skills for being a good presenter, there are some common
approaches that, with practice, will help you become a better public speaker.

• Just as a strong opening statement is needed, an impactful closing statement can bring the presentation
to a close in a memorable way for the audience.

7.2 Finalizing a Slide Collection
• Color can be used to enhance a presentation and convey emotions.
• There are a variety of ways to modify a theme used in a presentation. You can modify colors, fonts, and

placement of elements on the slide.
• The Designer tool gives you options for adding variety and interest to your slides.
• When images are included on slides, you can customize the size and look of an image through various

tools, including cropping, removing the background, and changing the transparency of the image.

7.3 Preparing a Microsoft PowerPoint Collection for Presentation
• Transitions and animations, if not overused, can add visual interest to your presentation. Choose

animations and transitions that retain the professionalism of the presentation.
• Adding media such as audio or video can enhance a presentation and, in some cases, better convey the

information contained on a slide.
• PowerPoint includes many features to help you get your slides “presentation ready.” These include

grammar/spell check, checking for accessibility issues, speaker’s notes on slides, and even a rehearsal
coach to help you prepare to speak in front of a group.

• Making plans to visit the room and try out the technology is a critical step in preparing for a presentation.
• With the technology available today, you are likely to be presenting to a fully virtual or hybrid group.

Through proper preparation, you can help ensure that all participants are engaged and have a meaningful
experience during the presentation.

7.4 Preparing a Google Slides Collection for Presentation
• Transitions can be added to slides to give some visual interest to the presentation and to help the speaker

slow down between slides and topics.
• The Tools menu contains features to check for spelling, facilitate a Q&A, and adjust speaker notes, among

other things.
• Adding audio or video files is easy to do in Slides. An audio file will appear as a speaker icon on the slide. A

video will appear as a thumbnail.
• The collaboration tools in Slides include standard sharing settings and commenting.

Review Questions
1. New Employee Orientation training is an example of which type of presentation?

a. persuasive
b. inspirational
c. informational
d. instructional

2. A ___________ is used to get the attention of the audience at the beginning of a presentation.
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a. hook
b. welcome slide
c. call to action
d. long pause

3. A(n) ___________ tone of speaking is best during a presentation.
a. excited
b. conversational
c. monotone
d. soft

4. A __________ is one effective way to end a presentation.
a. thank-you slide
b. questions slide
c. bullet summary list
d. quote or story

5. What is the suggested maximum number of colors that should be included when creating a custom
template for visual clarity?
a. two
b. three
c. four
d. five

6. Which tool is used to change the layout of an individual slide?
a. Crop
b. Designer
c. Picture format
d. Variants

7. To modify the shadow or line effects in a shape on a slide, where do you go?
a. the Designer tab
b. the Picture Format tab
c. the Variants command group
d. the Remove Background tool

8. The _________ describes the height and width of an image using preset values.
a. cropping tool
b. transparency
c. effect
d. aspect ratio

9. A split ____________ is one way to move from one slide to the next.
a. animation
b. transition
c. comment
d. Slide Master

10. The Rehearse with Coach tool is found on the __________ tab.
a. Review
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b. Transitions
c. Slide Show
d. Slide Master

11. The __________ tab appears when you insert a video on a slide.
a. Review
b. Transitions
c. Slide Show
d. Playback

12. What is one essential thing to do during the room and technology setup before your presentation?
a. Show up just as the presentation starts.
b. Try out all the technology you will be using.
c. Save your presentation to your hard drive.
d. Make sure you always have two monitors.

13. What is one strategy that will help keep virtual participants engaged during a presentation?
a. Turn off the cameras of virtual participants.
b. Don’t use the chat feature.
c. Use breakout rooms.
d. Show virtual participants only to the speaker.

14. In Google Slides, slide transitions are found on the __________.
a. Tools menu
b. Insert menu
c. action bar
d. Format options pane

15. To add comments to a slide, go to the __________.
a. Tools menu
b. Insert menu
c. Slide menu
d. Arrange menu

16. Which feature can you use to interact directly with the audience in real time during a presentation?
a. Comments
b. Share
c. Transitions
d. Q&A tool

17. How will an inserted video appear on your slide?
a. as a speaker icon
b. as a thumbnail
c. as a text description
d. as a link

Practice Exercises
18. Watch the TED Talk “Mosquitos, malaria, and education” (https://openstax.org/r/78TEDBillGates) from Bill

Gates. What makes the presentation engaging? Create a couple of slides that could have been used
during the presentation.
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19. Review the Section508.gov presentations training videos (https://openstax.org/r/78PresntTrn508) that
provide tips for making presentations accessible to all audiences. Using a slide presentation that you have
created or one that you find online, make some suggestions for improving the accessibility of the slides
based on the information on the site.

20. Dananjaya Hettiarachchi was the 2014 World Champion of Public Speaking. Review Hettiarachchi’s full
speech (https://openstax.org/r/78SpeakHettiar) on YouTube. As you listen and view, identify three skills
from the chapter that were used by the speaker. Explain how the skill was used, and comment on its
effectiveness.

21. Create a “Background” slide for yourself that includes information such as your hometown, your college,
and a couple of fun facts about yourself. Include a picture that is meaningful to you. Choose a theme for
the slide, and use the Designer tool to select an engaging design. Crop the image you include into the
shape of a star, and adjust the transparency of the image.

22. Design a custom color template for a presentation to highlight your company’s annual picnic. Include an
appropriate picture and remove the background of the image. Explain the use of your color choices in a
text box on the slide.

23. Design a slide to share three “lessons learned,” or takeaways, from this chapter using a SmartArt design of
your choice. Find an image that relates to the topic, and make it the slide background, and apply 75
percent transparency.

24. Using the Rehearse with Coach tool, rehearse the My Life in a Snapshot presentation that you have
created over the last two chapters. What information did you get from the tool? Was it helpful?

25. Imagine that you are preparing for a presentation at either your work or school. Choose a space to
explore for presentation readiness and actually go visit it. Prepare a slide to describe the chosen location,
the readiness of the space, the features that support your presentation, and steps to take to ensure
optimal preparedness.

26. Design a few slides to teach your audience how to complete a simple task of your choice. Find a video that
supports it and embed it within the slide. Include a transition to appear after the video ends to pop up a
summarized statement.

27. Add another transition to your My Life in a Snapshot Slides presentation. Which transition did you choose
and why? Make sure to apply the transition to at least three slides and adjust the speed if desired.

28. Add comments to two slides in your My Life in a Snapshot Slides presentation. Verbally add speaker notes
to help you during the presentation. Last, run spell check on the presentation. Did you find any errors?

29. Add sound to your My Life in a Snapshot Slides presentation. First, make or find an audio recording in MP3
or WAV format. Save the file to your computer and remember where you saved it. Play the recording
within your presentation by clicking on the audio icon. Did the sound enhance the presentation? Did you
modify it to make it better?

Written Questions
30. Describe some key skills for presenting that apply regardless of the type of presentation you are giving.

31. Describe one of the ways you can engage your audience in your presentation.

32. Describe why it is important to have a strong closing presentation.

33. Why would you apply a theme to a presentation, and why might you want to modify it?

34. Discuss reasons why the options on the Review tab are useful.

35. Discuss how speaker’s notes are added to a slide. How can they be used in a presentation? What
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information would you include in the speaker’s notes?

36. What are some things you need to address regarding the hardware and environmental components of
your presentation?

37. When preparing for a virtual/hybrid presentation versus a fully in-person presentation, what are some
items to consider?

38. Discuss how to add transitions to all slides in a Google Slides file and how to change the timing of the
transitions.

39. Discuss how to use the Q&A feature in a presentation.

40. Explain how to insert audio into a presentation.

Case Exercises
41. Examine the slides that follow. Based on what you have learned in this section about designing

presentations for all audiences, what suggestions can you make to improve the slides?
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42. You have been tasked with creating a training workshop presentation on effective communication skills.
The workshop aims to enhance interpersonal communication, presentation delivery, and active listening
abilities. In this exercise, you will focus on utilizing the image and SmartArt tools in PowerPoint to create
an engaging and visually appealing presentation. Create a PowerPoint with the following sequence:

1. Slide 1: Title slide
2. Slide 2: Introduction to effective communication. Consider using the SmartArt tool to create a diagram

or visual showcasing the different elements of effective communication, such as verbal skills, body
language, and active listening.

3. Slide 3: Content slide: illustrate common barriers to effective communication.
4. Slide 4: Content slide: present strategies for active listening.
5. Slide 5: Content slide: showcase the importance of nonverbal communication. Consider using the

image tool to insert pictures of individuals engaged in different nonverbal cues, such as eye contact,
body posture, and hand gestures.

6. Slide 6: Content slide: demonstrate effective presentation delivery techniques.
7. Slide 7: Conclusion: End the presentation with a call-to-action slide.
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Ensure consistent design elements, such as font styles, colors, and slide layouts. Choose high-quality and
relevant images that enhance the presentation’s visual appeal while aligning with the content and
objectives.

43. Your supervisor has asked you to prepare a training presentation for new hires, centered on giving
effective presentations. This will be divided into two parts: preparation and skills. Design a brief
presentation in either PowerPoint or Google Slides that will cover some tips for preparing to give a
presentation. Your presentation should contain at least four slides, including a title slide. Make sure to
cover items such as the room setup, the purpose of the presentation, how to handle questions, and
dealing with technology.

44. View this presentation from Kshivets O. Lung Cancer Surgery (https://openstax.org/r/78PresntKshivet) on
Slideshare. What are some issues with the presentation, and how would you correct them?
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Figure 8.1 Businesses small and large can make use of a content management system, which tracks customer data and provides

useful metrics to business owners. (credit: modification of “Happy florist giving a bouquet of flowers to lady” by Amina Filkins/Pexels,

CC0)

Chapter Outline
8.1 What Are Content Management Systems?
8.2 Common Content Management Systems
8.3 Creating Content with a Content Management System
8.4 Search Engine Optimization
8.5 Social Media in Business

Chapter Scenario
Although you may not be directly involved with content management in your career, it is important to have a
broad knowledge of the concept and all it entails. You are likely to encounter or work on a team with someone
who is responsible for content management within your company. The information in this chapter will give
you the language and basics of how managing online information works in an organization. At this point, you
have learned about many software applications that span across departments and functions. You have
mastered how to create documents and set up an effective presentation. You have created digital content. And
this content, when created within the bounds of your job and the company, becomes something that needs to
be managed, organized, and shared internally through content management systems, or externally for an
online community or customers.

Like many large corporations, WorldCorp encourages its employees to volunteer in the community and allows
employees to take time during working hours to assist nonprofit organizations. Each year, WorldCorp’s upper
management selects a theme for these volunteer efforts. This year’s theme is focused on abandoned pets. In
Raleigh, North Carolina, the location of one of WorldCorp’s corporate offices, there is a new pet adoption
nonprofit organization, Happy Tails WC. WorldCorp’s marketing department has agreed to develop a website
and social media presence for the pet adoption agency. This will involve managing content across several
different platforms and tracking the success of various posts or other marketing efforts. Happy Tails needs this
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assistance to launch its business and to attract the resources it needs, including donations, grants, and
potential pet owners.

8.1 What Are Content Management Systems?

Learning Objectives
By the end of this section, you will be able to:

• Describe what a content management system is and what it is used for
• Explain the ways businesses benefit from using content management systems
• Distinguish between different types of content
• Evaluate common features of content management systems

Figure 8.2 (a) Unlike the English alphabet, hieroglyphics used shapes or characters to represent the information to be conveyed. (b)
In today’s world, the basis for all information created and shared with computer technology is binary code (only using 0s and 1s).
(credit a: modification of “Hiéroglyphes” by iPhone-shoot/Flickr, CC BY 2.0; credit b: modification of “Magnifying glass and binary
code” by Marco Verch Professional Photographer/Flickr, CC BY 2.0)

The ancient Egyptians used hieroglyphic writing, a unique form of sharing content, for administrative,
business, literary, religious, and scientific purposes. Hieroglyphic writing was typically shape- and picture-
oriented. We see similarities with content created today for social media and other platforms using shapes and
other visual elements to convey a message. In today’s industrialized cultures, humans share content through
various platforms, including websites and social media across other various devices. Content refers to
information in visual or audio form—text, art, numbers, or images—that is intended for an end user. The
material presented can be viewed as data, information, or knowledge.

• Data, usually presented in numeric form, is content that can be analyzed, such as facts and figures. For
example, a company can use data on the number of customers visiting its website to determine the return
on investment (ROI) of its marketing efforts. The term data is also used to refer to the characters or
symbols used by a system and transmitted into different media.

• Information, in the form of text, audio, video, or images, consists of data that is put into
context—statements or facts that help users arrive at an answer to a specific question or problem. For
example, the managers at Happy Tails WC can use data gathered from the new website, such as the
number of views and the location where those viewers come from, to better understand the market for
their nonprofit. The data has been put into the context and used to answer a specific question. Happy Tails
WC can then use this data to tailor messages to specific locations or to plan events for specific populations
who visit the website often.

• Knowledge refers to familiarity with or understanding of skills, facts, or objects, which an individual
develops by analyzing or interacting with them—for example, company performance measures.

For the pet adoption agency, these concepts are as relevant as they would be for any business. The agency
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board would need to gather data on the cost factors related to the adoption of each pet and the associated
veterinarian bills. They might also want to keep track of the number of adoption applications by a pet (e.g.,
dog versus cat) or breed that comes into the agency. Relevant information would include pictures of the
adoptable pets, text about the history of the adoption agency, or videos showing the adopted pets in their new
homes. Finally, using the data and information, the agency’s board members could determine how to
strategically grow the agency to accommodate more pets or volunteers. They could also use the facts gathered
to seek out specific donations or grant opportunities to help the budget each month.

What Is Content Management?
To understand content and its management, revisit WorldCorp’s volunteer work with Happy Tails. Since the
adoption agency is newly formed, it needs help developing its brand, or organizational identity, as well as an
online presence to publicize both the company and the pets available for adoption. This will require the
development, distribution, and updating of a variety of multimedia content, including new branding (images,
color schemes, logos, and slogans). There will be some design work involved, and we will cover some
principles of design a bit later in the chapter. But for now, your teams will need to think broadly about all the
aspects of creating and managing content for this small, startup organization.

You have begun by asking the leaders at Happy Tails WC to answer some questions so you and your team can
start building the brand for the organization. Their answers will guide the development of the content for the
website and other aspects of the organization, both in print and online. Figure 8.3 shows a few questions to
consider when creating content and developing a brand image.

Figure 8.3 When creating a brand for a product or organization, it is important to think broadly about the message you want to
convey, whether delivered online or through print materials.

The content management process will vary depending on the size of the organization, particularly in the realm
of content creation. In large corporations, there are often entire departments, such as information technology
(IT) and marketing, working together on these efforts. Furthermore, within these departments there will be
experts on website development, social media marketing, and other similar functions, who will have primary
responsibility for a small portion of content management. It would be rare to find a single person handling all
content management for the business; rather, this would be a dedicated team effort. Teams need to work
cooperatively with nearly all business functions, including sales, accounting, and purchasing, to develop the
appropriate content and strategies used to maintain that content to meet their diverse needs.

In some cases, a large corporation might choose to outsource content management to a vendor that
specializes in this service. Managing content can take time and expertise. A large company may decide that the
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time and effort involved in content management might be better spent on the products or services they
provide, rather than on building a website and posting to social media sites.

You can also expect that large corporations will have content specific to their internal audience (perhaps a
company website for employees only) as well as content for external audiences. You might have some
experience with this idea at your school. On the school website, you might see a link or an area specially for
students. This might include links for your class schedule or where to order books. You probably also need a
password to access that area. The general website then contains information for an external audience:
prospective students or community members who want to find out more about the college. These two
different audience types require different types of content, and as such, different ways of managing that data
and information.

A content management system (CMS) is an application that uses a set of processes to manage web content,
social media content, and other information online, which allows multiple contributors to collect, create, edit,
and publish content. These processes go beyond simply creating and maintaining a website. A CMS could also
include managing multiple social media platforms as well as internal company sites where information is
stored. In a CMS, the content is stored in a database and displayed when accessed. Information stored in a
CMS is usually referred to as digital content. A company can update, delete, or add information as needed. The
best content management systems offer capabilities that include site design, content authoring, editing, and
personalization. The personalization might include items specific to the industry or company, such as online
sales capabilities or an event calendar that could be useful for Happy Tails WC employees as they plan
fundraising or pet adoption events.

The CMS is integral to delivering rich digital experiences across all digital channels and enables organizations
to manage multiple websites, support more than one language, and deliver a consistent customer experience.
These experiences could be through social media platforms such as X (formerly well known as Twitter) or
TikTok, or even through emails that prompt the customer to click on a link to find out more information.

REAL-WORLD APPLICATION

Using a CMS at the World Wildlife Fund

The World Wildlife Fund (WWF) utilized a CMS to successfully launch its Earth Hour campaign in 2020,
demonstrating the advantages of employing a robust content management system. By leveraging a CMS,
WWF effectively managed the challenges associated with handling high-volume traffic to its website,
ensuring that visitors encountered no impediments in terms of speed, security, or reliability. This seamless
user experience was vital for maintaining user engagement and maximizing campaign impact.

By utilizing a CMS, the WWF was able to gain valuable insights into user behavior, preferences, and
interactions with its website. This understanding of the customer journey allowed it to make informed
decisions to optimize its online presence and tailor its content to better resonate with its target audience
with the goal of enhancing engagement, fostering brand loyalty, and driving desired actions from their
audience.

An improved customer experience yields a multitude of benefits for businesses. First, it enhances customer
satisfaction. Satisfied customers are more likely to continue engaging with a brand, make repeat purchases,
and recommend the brand to others. A positive customer experience can significantly impact customer
retention rates, reducing customer churn and associated costs.

Furthermore, a better understanding of the customer experience enables businesses to identify pain
points, optimize customer journeys, and streamline its processes. This can result in improved operational
efficiency, reduced customer support costs, and increased conversion rates. By utilizing a CMS to gather
and analyze customer data, businesses can identify patterns, trends, and preferences, enabling them to
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make data-driven decisions, refine their marketing strategies, and deliver personalized experiences.

To illustrate the power of a CMS-driven campaign, consider the example of WWF’s Earth Hour campaign. Its
campaign goals included raising awareness about environmental conservation and mobilizing a global
movement for a sustainable future. By leveraging a CMS, WWF efficiently created, managed, and analyzed
content related to the campaign, ranging from engaging articles, visually captivating images, and impactful
videos. The CMS enabled the company to disseminate consistent messaging across various digital channels,
effectively reach its target audience, and foster meaningful engagement.

A CMS empowers organizations to seamlessly launch campaigns, gather crucial customer data, and derive
actionable insights. Understanding the customer experience is pivotal for businesses as it drives customer
satisfaction, loyalty, and advocacy. By utilizing a CMS, organizations can create personalized experiences,
optimize customer journeys, and meet specific campaign goals, ultimately propelling their business
success.

There are seven stages of the content management lifecycle: (1) organization, (2) creation, (3) storage, (4)
workflow, (5) editing/versioning, (6) publishing, and (7) removal/archiving (see Figure 8.4). In the organization
stage, the company’s goals, processes, and requirements are examined to establish measurable indicators for
meeting the company’s objectives. The creation stage allows the authoring of original content using editing
tools, web forms, and other media tools. At this stage, a company might be concerned with design such as
color choices and graphics. At the storage stage, decisions are made about how content will be formatted and
stored to facilitate access, delivery, and security based on company use. In the workflow stage, rules are
designed to streamline processes, ensuring consistency and adherence to company policies. Editing/
versioning involves accountability and tracking of multiple versions of content, such as updates, edits,
retrieval, and deletion of files. The publishing stage releases content to users so it is available to view on the
front end (customers) and back end (employees). Finally, in the removal/archiving stage, content that is
obsolete or infrequently accessed is either deleted or relocated to an archive. You will probably go back to the
editing and removal stages frequently as new content is added or as the business grows.

Figure 8.4 The content management lifecycle could include several stages of editing and versioning as the organization sees how
users interact with the published content.

A CMS helps an organization work through most stages of the content management lifecycle, starting with
creation. Its tools allow a company to design their brand and publish/maintain the content on the internet.
Now let’s look at how the content management lifecycle applies to Happy Tails.

After gathering answers to the questions you posed to Happy Tails leadership, you have a clearer picture of
the image they want to convey and how they want to use their online presence. These answers give you the
information you need for the organization stage. For example, you now understand that Happy Tails wants to
use their online presence not only for marketing their available pets, but also for fundraising efforts and
special events. You also know that they want to highlight not only pets available for adoption, but also success
stories from previous placements of pets with families. Happy Tails has indicated they want their brand to be
fresh and engaging, and to communicate the benefits of pet ownership.

8.1 • What Are Content Management Systems? 545



Next, the creation stage will solidify the brand, logo, and color choices for Happy Tails WC. This stage will take a
bit of time as you expect that organizational leadership will want to get feedback from others on the choices.
The next two stages, storage and workflow, will involve more in-depth discussions with Happy Tails WC. They
will need to decide who will maintain and update the content, who will be responsible for responding to
messages from potential adopting families, and how the content will be kept secure and up to date.

Additional tasks related to keeping the content current will occur in the editing/versioning stage. Here, Happy
Tails WC might consider developing a calendar of content and sites (social media posts) to use for scheduling
updates and posts. There will be more about this later in the chapter. Finally, once the content is ready to be
published and made available on the internet, there will need to be a plan in place to archive material as
needed, including old posts, past events, and other related material, to ensure that content remains current.

Benefits of Using a Content Management System
There are several advantages to using a CMS in any organization. One advantage is the ability to update the
public frequently on organizational news. For example, Happy Tails WC might want to be able to keep blog
posts as new pets become available for adoption and to have the blog posts match the social media post for
each pet. Figure 8.5 shows an example of a site that uses blogs. (You will often see Latin text on template
websites. It’s to show that you can put whatever text you want there.) You will see that what may seem like a
simple task actually involves many steps that need to be documented and managed. This is where a CMS
comes in.

Figure 8.5 A content management system can help you keep your online presence current and engaging. (credit: “Animal Shelter” by
Colorlib/Colorlib, CC BY 3.0)

Consider that for each update to the website that is needed, the marketing team needs to reach out to
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members of the adoption agency who manage the list of adoptable pets. You might start by sending an email
to the agency director, Tracy, who updates the document you need and then sends it back for you to update
the website with the new information. One day, you discover that Tracy is on leave for a week. This delays the
process, as you need to find someone else in the organization who can assist you. You locate Domenic, but he
is a volunteer who works another full-time job and may not be available to return your call for a few days. By
the time your inquiry is first seen, several days may have passed and you’ve missed the best window of
opportunity.

In this scenario, a CMS can help overcome the challenges posed by the back-and-forth transmittal of materials,
communication lapses, and scheduling. A CMS can centralize content and information sharing so that
documents, images, and other assets are accessible to all users at all times. Content can be edited, organized,
stored, and shared through the CMS. This will enable users from across different departments and even
different time zones to access the material they need to manage.

There are several benefits to using a CMS to operate your company website and to manage other digital
content.

Collaboration
First, a CMS promotes team collaboration by allowing multiple users/authors to access content from almost
any location. This increases productivity and helps streamline processes by distributing responsibility for
different tasks. For example, imagine you are working to update content and databases that are associated
with the company’s email communications. The author of a specific piece of content can give you access to
edit, upload, and delete that content, saving you time and allowing you to focus your efforts on quality control.

Quality Control
This leads to another benefit of using a CMS: quality control. The workflow for the new campaign requires
different departments to update specific content. For example, the marketing and sales team may be given
permission to update the branding and pricing on the site, but not to update any other information. As a
volunteer for the pet adoption agency, you may have the ability to update information on adoptable pets but
not to change the overall structure of the website. By controlling who is able to access what, a CMS allows
content updates to be reviewed by an approver before they go live on the site. Using a CMS also helps to
maintain consistency in message and appearance. By using the system to set design standards such as color
choices, preferred logos, and pictures, you can ensure that the brand is kept intact and that messages are
being constructed in a consistent manner across platforms.

User-Friendly Interface
Another benefit of a CMS is its user-friendly interface, which often does not require knowledge of
programming languages to change website content. Design changes are also simplified, involving less effort
than traditional methods of designing and adding content to a website. Although some understanding of
HTML and CSS (common programming languages for websites) can be helpful, it is not a requirement for
managing and editing content in a CMS. Employees may be experts in their content area and have innovative
ideas but may lack the coding experience to translate these ideas into web content. Instead of studying a
programming language, employees using a CMS can spend their time learning how to use the system to
complete their daily tasks, inputting images, audio, video, text, and other multimedia with the click of a button
or via a drag-and-drop feature.

Website Optimization
A CMS also automates certain website needs, such as optimizing keywords to help more people find your site
or social media accounts. Without a CMS, this function is done manually by assigning keywords to specific
pages within your website and by linking keywords and URLs. This functionality is called search engine
optimization (SEO). A CMS can enable you to set up your website to get the greatest possible exposure when
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someone searches on a topic related to your site. For example, Happy Tails WC might use SEO to tag keywords
such as “pets,” “animal shelters,” “adopting a dog,” and other related phrases so the website appears near the
top of the list in an internet search. Doing this manually could take anywhere from a few minutes to several
hours, depending on the number of pages managed. Also, entering each URL individually creates a risk of
introducing human error. Using a CMS eliminates the need for you to manually enter a URL for each page on
the website. You will learn more about SEO in Search Engine Optimization.

As you can see, a CMS adds value by providing tools for team collaboration, quality control, user-friendly
interfaces, and automation of certain functions. Other benefits include content organization, use of templates
and themes, and multilingual and multisite support.

Types of Content
Various types of content can be managed through a CMS, including web, mobile, enterprise, and social media,
as Figure 8.6 displays. Each plays a different role in creating the overall image of an organization and
managing the content that is available online.

Figure 8.6 Content management systems can be used to manage web content, information on social media sites, and information
intended for internal audiences.

Content on a website is managed with a web content management system (WCMS). These systems offer
website authoring, collaboration, and administration tools. An advantage of using a WCMS is that employees
do not have to understand web programming languages in order to use these systems. Instead, they can
manage content within the website, using features that give them the ability to design, organize, and update
information. Managers can also control content by viewing and approving material before publishing. As
described earlier, employees can be trained to use the features of the platform rather than needing to spend
time learning the mechanics of a new programming language.

A CMS can also be used to manage the content contained in social media sites. These sites were developed
primarily for connecting with others to create a virtual network of friends and connections. These social media
platforms have evolved since their inception and are now a source of marketing and connecting with
customers for businesses. Social media content management is the process of creating, scheduling,
publishing, and analyzing content for all your media platforms. Platforms like Instagram, Facebook, Pinterest,
X (Twitter), and TikTok have specific audiences and features that require customization when developing
original content. Content is tailored to the target audience, and strategies are developed to distribute and
manage social media profiles. These strategies include monitoring engagement, collaborating with
influencers, building a community, and analyzing reports to ensure you are receiving an adequate ROI. You will
learn more about social media engagement in Social Media in Business.

Sometimes it is necessary to make adjustments to websites and content so that it will display on mobile
devices properly. Again, a CMS can help make a company’s online presence compatible across a wide variety of
devices. A mobile content management system (MCMS) hosts a data store in a centralized location and
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allows content to be managed across multiple platforms. The MCMS may be a mobile app that needs to be
managed for different devices (iPhone, iPad) and platforms (iOS, Android) from a single tool. Another type of
MCMS consists of a responsive mobile website design that can manage content by displaying information
effectively regardless of the size of the screen.

It is generally necessary to maintain digital content for internal company use. This content could include
employee-specific information, such as payroll and benefits information; documents that are meant only for
certain departments within the organization; or pertinent strategic goals that are not publicly available. This is
known as enterprise content management, often referred to as document management. It facilitates the life
cycle of content within an organization, using strategies and tools designed to increase productivity and
provide the information employees need to complete their job duties. The enterprise content management
system is company-wide, not just for one department. The system allows processes to be implemented by
presenting a timeline for the organization’s content—including Microsoft Word documents, Microsoft Excel
spreadsheets, PDF files, and scanned images—to be created, approved, and distributed.

For your role in developing the digital content for Happy Tails WC, various types of content must be created
and managed by different individuals in the organization, including both paid staff and volunteers. Using a
CMS allows for easy development, upload, analysis, and management without the need to receive information
via email from another department. At first, you will be doing the majority of the work on uploading content.
But the plan is to train Happy Tails WC employees to take over that role as they become more familiar with
working in a CMS environment.

Once Happy Tails WC has been trained to use the CMS, they can assign different levels of access and allow
various types of content to be distributed. The next challenge is to assign specific types of content to different
individuals to optimize the workflow. This could mean that the fundraising director has control over
fundraising event information and the donations section of the website, whereas the adoption coordinator or
Tracy, the director, maintains the current list of adoptable pets. Also, if an issue or problem needs to be
addressed, more than one person can have access to view information and retrieve documents to help reach a
resolution in case the primary responsible person is not available.

Primary Features of Content Management Systems
Here, we will identify the primary features of CMS and their uses. These features and uses correspond to
different parts of the content management lifecycle discussed earlier in the chapter (see Figure 8.4). A major
benefit of many content management systems is that they contain different features that allow their users to
control every part of the content management lifecycle.

Content Creation and Editing
The first two stages of the content management lifecycle are centered on organizing and creating content.
However, that content will likely need be edited regularly to keep the information fresh and current. Creating
and editing content is a critical function of any CMS.

Many content management systems include the use of page templates, which are predesigned and
preformatted documents that maximize productivity by offering defined layouts customized for common uses,
such as social media, website banners, blogs, letters, and presentations. We have discussed templates in Word
and PowerPoint in previous chapters. Templates determine the specific size, structure, or layout that will best
meet the needs of the document. The designs and types of documents can be categorized into themes, and an
employee can select a theme for a campaign that aligns with the mood or use or customer base. Using page
templates also helps maintain quality control.

A content editor allows users to easily review the style and format of the content in a document, which
provides optimal design and readability. This editor may also offer drag-and-drop editing, which is a user-
friendly function that assists nonprogrammers in designing, editing, and arranging content. This is especially
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important for Happy Trails WC since you will be training employees to eventually edit, maintain, and update
content for the organization themselves.

A feature that allows anyone in the company to add content to a thread of posts is called blogging capability.
Users can upload images, tag keywords, and use an editor to style and format their posts. Additional features
include password protection for posts, which is ideal for memberships or communities that want to offer
exclusivity. This is where you hope to feature Happy Tails WC adoption success stories. The plan is to have a
regular spotlight through the blog to share the story.

Another critical functionality of any CMS is its storage system. Managing assets, like digital images, must be
maintained to use those assets in any product. A library of images, like the one in Figure 8.7, or documents
can be managed in a CMS, giving you the option of adding an image within your content. Images are stored
within a central image library, and the multiple file upload feature allows users to add different files to a site at
once. The library feature helps with archiving as well.

Figure 8.7 Image libraries will often have the option of viewing photos as thumbnails. This makes it easy for the user to select the
ones that they want.

Publishing
Workflow and publishing are two key stages in the content management lifecycle as previously covered. Once
your content is ready to be public, you want to publish the information online. Using content syndication
enables a third party to reuse original content and host it on another website, where it can reach a larger
audience. Also, through the calendaring features, users can plan content by scheduling future dates and
times to release information. This puts structure to the workflow of content creation. This is especially
important for organizations such as Happy Tails WC, where those managing the content have multiple job
responsibilities.

As an example, content management is just a small part of what Tracy does for Happy Tails WC. Happy Tails WC
can use the calendaring function to schedule reminder posts of upcoming events so that they can focus on the
actual tasks in planning the event. In larger organizations such as World Corp, which maintains multiple
websites and social media sites, the calendaring function can make uploading current content more efficient
as content can be scheduled weeks in advanced and synced across platforms.

Finally, e-commerce features are critical in today’s market. Built-in CMS software will enable users to create
product description pages; design the layout of the website, including payment information; track shipping;
and offer email sales funnels and promotions. This feature offers the ability to provide access to content from
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several devices, including mobile devices. Happy Tails WC hopes in the future to be able to sell branded
products such as dog and owner matching clothing with the Happy Tails WC logo. They also plan to accept
online monetary donations through the site, so this will need to be included during the organization and
creation stage of the process.

Because Happy Tails WC is a new organization, they are still trying to establish a presence and get their name
out to the community. Through analyzing information from their online presence, Happy Tails WC can get an
idea of how their marketing efforts are working. A CMS typically provides web analytics—insights or data that
can be evaluated against company objectives. For example, you can gain a visual display of how many users
visited a post, commented, and shared content. This data can be used to make changes to content, inform
decisions about particular initiatives, and help create new content. For example, if you notice that a
fundraising event scheduled for Happy Tails WC is not getting many visits, you can discuss with Tracy new
strategies on ways to market the event. Or if the analytics show that most people who visit the Happy Tails WC
website go first to the success stories blog, perhaps you make that page more central to your message and
overall image.

Security and Management Features
Larger organizations often have an administrator who oversees multiple site licenses, including local and
maybe even international sites. In this case, they might need to have one global administrator to manage all
sites as well as an individual administrator for each site. You can set permissions for global administrators to
manage all of the sites and also set individual permissions for those administrators managing specific sites.

This feature could also be important for Happy Tails WC. To maintain a consistent and clear message, the
organization wants to limit access to key personnel in the organization. Tracy, as the director, could be
identified as the global administrator, and the fundraising coordinator might also be an administrator, but with
more limited permissions. This structure can evolve as the organization grows and as personnel changes
occur. As the users at Happy Tails WC become more familiar with the site and with content management in
general, they will need to discuss the permissions and who should have certain permissions. This is part of the
workflow stage of the content management lifecycle. But it should be revisited regularly to make sure things
are working and the permissions are set appropriately.

Using a content management system makes establishing and changing permissions easy. Many content
management systems have access controls that allow user groups to be restricted or limited to viewing
specific pages within the website. Users who are not registered can be denied access to a page until they can
provide the required username and password to access that content. Logging in typically gives users access to
features of the website that are unavailable to unregistered users.

Content versioning allows you to keep documentation of any changes made in the organization of content.
You can view, restore, or compare any content in the system, including pages, database entries, media files,
shares, older and newer versions of content, and deleted and restored files. This is a key part of the removal
and archiving stage. You will be able to compare versions of items by viewing a modification log that identifies
all content changes. A history of how the content has been managed will provide insight on when changes
were made and usually will include keywords such as edit, publish, and delete.

Goals of CMS to the Enterprise
Content management systems simplify the process of creating, organizing, and publishing content,
empowering website owners or content creators to manage their digital presence effectively. Through a CMS,
content can be managed from start to finish to improve the quality of the output, as well as to avoid
duplicating efforts. Digital storage, data collection, and data distribution need to work together in a CMS to
promote system functionality. When the system is functioning well, it helps maintain the image of the “brand.”
For Happy Tails WC, developing a strong brand online is vital, as it is a new organization. It wants to make sure
that the mission, logo, location, and other related items are consistently and effectively communicated online
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through a variety of platforms. A CMS is intentionally designed as a “one-stop shop” for all content. For many
organizations, the investment in the program from both a financial and learning standpoint is well worth the
benefits in the long run.

Information storage and retrieval involves collecting and cataloging data to be accessed on demand, making
use of keywords to search for specific documents. Data collection gathers important information via forms or
surveys. A CMS can provide data fields in which users can enter their information, building a profile for future
use. Finally, using a CMS for data distribution (including news, updates, policy, and documentation) enables
company employees to avoid going through marketing and communication teams to approve content for
publishing. Instead, subject matter experts (SMEs) can deliver content directly within the website and reach
their target audience, whether the data is original content or is extracted from external sources. Establishing
processes to manage data distribution can lead to fewer errors when data is disseminated in several places
within the website.

8.2 Common Content Management Systems

Learning Objectives
By the end of this section, you will be able to:

• Define Web 2.0
• Distinguish between CMS types

Content management systems (CMS) consist of software that assists in building a website for personal or
professional use. In the past, building a website would require individuals to be skilled in using languages such
as HTML, CSS, and JavaScript. A CMS offers templates and extensions in a user-friendly WYSIWYG (What You
See Is What You Get) interface, which is a system that allows content to be edited in a form that resembles its
appearance when printed or displayed as a finished product (e.g., a printed document, a web page). This
means that you do not need to be skilled in using computer languages to build an attractive website.

The evolution of web technologies makes it easy to share information on your website and allow others to be a
part of the experience. We no longer simply read information and move on. Rather, we become involved with
what we view by reflecting, sharing, and having the ability to offer our own perspectives. The techniques and
tools available today make it possible for users not only to be viewers but also to add their value as
contributors.

What Is Web 2.0?
The internet has changed over time with advances in technology. The first version of the internet, Web 1.0,
included little interactive capability beyond searching, and was used more as a hub of information. Most
websites were fairly static, with few graphics (see Figure 8.8). Web 1.0 only allowed users to read the
information that was distributed by publishers and webmasters.
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Figure 8.8 Websites in the Web 1.0 era, such as this one for the Library of Congress, were text based, with very few visual or
interactive components.

We are now in the era of enhanced usage and development of online content on the web, known as Web 2.0,
as you can see in Figure 8.9. Web 2.0 enables users to also be designers, with the capability to read and write
on the internet.
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Figure 8.9 Web 2.0 is a more integrated approach to content on the internet, allowing for more interaction between the content and
its users. Not only do you see that Joni Mitchell won the 2023 Gershwin Prize, you can hear the song as well by clicking the arrow.

For example, under Web 1.0, a website developed for WorldCorp would have been created and published for
the public to view. Visitors would have been able to click on the different pages, watch videos, read articles and
blog posts, and find out about local events in their community, but this one-way stream of information would
have been all that viewers could experience. With Web 2.0, viewers are transformed into an online community
of contributors, who also have a voice. They can not only watch videos, but also comment about what
resonates with them, respond to other users’ comments about blog posts, and share information. The
audience’s personal experiences, resources, and opinions provide a valuable addition to the original content
published on your website. This information can now be monitored and used to help the company drive its
campaign to increase customer engagement and revenue.

LINK TO LEARNING

Review this video about the evolution of Web 2.0 (https://openstax.org/r/78Web2_0) and how it changed the
internet.
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Transforming viewers into contributors on your website can be done by using features, extensions, and a
WYSIWYG editor. For example, Photoshop is a WYSIWYG graphics program that displays images on the screen
that appear the same way they will look when printed on paper. A WYSIWYG editor makes it easier for
someone to act as a web developer without formal training.

Web development involves building a website using plain text, web applications, and other features for the
internet or intranet. Creating the client side, or front end—everything that is displayed on the user’s end of a
web application or device, such as text and images—involves building the layout, design, and interactivity
using HTML, CSS, and JavaScript (see Figure 8.10). As you can see, website code can become very detailed and
lengthy. Writing code such as this takes a skilled professional. This is where CMS programs come into play.
Anyone can build a website without this specialized training.

Figure 8.10 Behind the scenes, websites are built using computer programming code.

This code will exist when you and the marketing team at WorldCorp are developing the site for Happy Tails WC.
Your responsibilities could include developing everything the client sees when they type the URL into the web
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browser, such as the design, graphics, layout, and navigation of the website. The code will be established as
you build the site through the CMS.

Types of Content Management Systems
There are three main types of CMS: open-source, proprietary, and enterprise (Figure 8.11). An open-source
CMS, such as Drupal or WordPress, is maintained by a community of developers, as opposed to a corporation
or company. The source code is available to the public and can be modified to meet the needs of the individual
or group using the platform. Although the system is open and free to use, there may be fees associated with
additional services needed to run the system, such as hosting, support, or added features. Open-source
platforms are a good choice for businesses on a tight budget, including start-ups, nonprofits, and companies
with only a few employees.

A proprietary CMS, by contrast, is owned by the individual or group that created it. The source code is not
available to the public, and often only those who have purchased a special license key may use it. Using a
proprietary CMS may provide a quick turnaround and enable you to delegate a lot of work to a vendor. Popular
proprietary CMS include Microsoft SharePoint, IBM Enterprise Content Management, Pulse CMS, Sitecore, and
Shopify.

For example, Happy Tails WC can use Shopify to host and manage all its content for the adoption agency. The
platform offers several add-on features that can be customized to meet the needs of the company and allow
them to brand their product/service. However, because Shopify owns the platform and is providing a space for
others to use, it will display its brand on the Happy Tails WC site, like an advertisement. Happy Tails WC would
have to pay additional fees to remove Shopify’s branding from its website. This type of pay-to-use structure is
common among proprietary content management systems.

Finally, an enterprise content management (ECM) system helps companies track and distribute large volumes
of content such as documents, images, records, product information, emails, and web pages. Companies use
this software for storage and collaboration regarding content creation and special projects. Employees within
the organization can access and share information, with different levels of access based on privileges set by an
administrator. The benefit of using an ECM for business is the platform’s compatibility with different file types;
it can accept various documents, images, files, and email files. It has a high level of security and can handle
large amounts of content, making it perfect for high productivity.

Figure 8.11 A large company might have both a proprietary and an enterprise CMS.
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LINK TO LEARNING

You can visit this resource on enterprise content management (ECM) by Brandfolder (https://openstax.org/
r/78ECM) to learn more about ECM and its applications.

By exploring this resource, you can discover how ECM solutions can enhance content management
processes, improve collaboration, and optimize workflows in an enterprise setting.

Why Are There So Many Types of CMS?
Different content management systems are designed to meet the needs of many different industries and
business structures. Figure 8.12 shows the pros and cons of CMS. Open-source CMS software is easy to use
because you can download it at no initial cost, and there are no license or upgrade fees and no contracts.
However, you may have to pay for technical support, customizations, compatible templates, add-ons, and
other functionality. Additional fees may arise if you need to train staff members or update software.

The benefit of using open-source CMS is its ease of installation, low cost, and easy access. Using an open-
source product makes the most sense for Happy Tails WC since it is a new organization and currently has
limited resources to purchase a more sophisticated system. Also, some of the advanced features that might be
included in a proprietary or enterprise system are not really needed, since Happy Tails WC has a small staff and
a limited geographical area.

Proprietary or commercial CMS software is built and managed by a single company and offers more
customization features or options. Using this type of CMS generally involves purchasing license fees for the
software, monthly or annual fees for updates, technical support, customization, and training. Integrating a
proprietary CMS with an existing website may require extensive development work.

Some companies will benefit from working with an enterprise CMS. They will pay more in costs and upgrade
fees, and they will not be able to take advantage of free trials or free versions, but the CMS functionality will be
customized to meet their specific needs, offering features that may be critical to achieving their objectives.
Therefore, companies often use an enterprise CMS to manage electronic content through the life cycle of a
document, including creation, distribution, utilization, retention, and disposal. This system benefits
corporations by tracking information, reducing operating costs, saving time, improving customer service, and
minimizing risks.
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Figure 8.12 Benefits associated with a proprietary CMS include enhanced support and other features that you may not find in an
open-source CMS.

SPOTLIGHT ON ETHICS

Storing Private Information

When managing a content management system (CMS), it is crucial to consider various factors regarding the
storage of private information and protecting the privacy of individuals. Let’s explore these considerations:

• Storage of information: One key aspect to address is how the information will be stored within the CMS.
It is essential to implement secure storage protocols, such as encryption and secure servers, to
safeguard sensitive data from unauthorized access. By employing robust storage measures, the risk of
data breaches can be mitigated.

• Access control: Determining who will have access to the stored information is of utmost importance.
Implementing strict access control mechanisms ensures that only authorized individuals can access the
private data. By defining user roles and permissions within the CMS, organizations can limit access to
sensitive information and maintain accountability.

• Information Protection Policies: Establishing comprehensive policies is vital to prevent the exposure of
private information. These policies should outline guidelines for data protection, including password
requirements, regular system audits, and employee training on data privacy and security. By having
clear policies in place, organizations can create a culture of privacy awareness and mitigate the risk of
data breaches.

By addressing these considerations, organizations can effectively manage a CMS while prioritizing ethical
practices and protecting the privacy of individuals. Implementing secure storage methods, defining access
controls, and establishing robust information protection policies are essential steps to prevent data
exposure and uphold ethical standards in data management.
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8.3 Creating Content with a Content Management System

Learning Objectives
By the end of this section, you will be able to:

• Create and edit content with a WordPress account
• Evaluate WordPress as a tool for businesses

Developing and maintaining content can be tedious and can become overwhelming over time. The more
information that is created, curated, shared, or collected, the better equipped you must be to manage all the
data. This is where a CMS can make content managers’ roles easier. As you read more about tools like
WordPress and how to use different features to appeal to your audience and meet company objectives, you
will start to understand why this CMS is very popular.

WordPress is an open-source CMS. It can be a platform for small businesses, start-ups, nonprofits, and
bloggers. It is critical to begin by identifying your objectives for using WordPress so that you can stay focused
and select the WordPress functions that will enhance your business. We will cover WordPress in this text, but it
is just one example of an open-source CMS for smaller organizations. WordPress is a larger player in the CMS
market, garnering almost 40 percent of the market for website development. It is easy to use and can support
integration with Google.

What Is WordPress?
WordPress is an open-source CMS that allows hosting and building for websites. Whether you are looking to
build a business, blog, portfolio, or online store, it is a website platform for getting started. Without any
knowledge of coding, you can use its features and functions, such as plugins and templates, to customize any
website. For example, you can download WordPress e-commerce plug-ins to build an online store on your
website. With WordPress, you can create many different types of websites, such as websites for business,
portfolios, forums, blogs, events, and more. Once you are set up with a WordPress account, you can manage
your website from any location.

Getting Started with WordPress
There are some basics about terminology that are important to know before setting up your website. First, the
domain name is your website address. It is what people will use to get to your website. Generally, the domain
name is similar to, or the same as, your business or organization’s name. However, each website has a unique
domain name. It is possible your business name is already in use by another organization. So, you might have
to make modifications to the domain name to secure that domain for your organization’s use.

To have the information on your site available on the internet, it needs to be hosted by a hosting service.
Hosting service providers store your website files and allow you to publish the website for public viewing on
the internet. Your website has to have both a domain name (website address) and a hosting service.
WordPress is convenient because it guides you through the process of both securing a domain name and
hosting your website.

To get started with WordPress, go to get.wp.com and choose Get Started (see Figure 8.13). You will create an
account using a valid email address. Next, select a username and password. (Once you sign up, you will be
asked to verify the account with the email address used, so you must have immediate access to the email you
are connecting to the platform.)

8.3 • Creating Content with a Content Management System 559



Figure 8.13 You will need to create an account on WordPress to start building a website.

Now that you have created an account, let’s revisit the Happy Tails WC organization. First, we need to consider
an appropriate name for the domain name (website address). The next step will prompt you to enter a domain
name for the site. You will most likely pay to secure your domain name for the website. This usually ranges
from $10 to $20 per year depending on which type of domain you choose. WordPress does provide some
completely free options for domain names, but the name will have the wordpress.com extension at the end of
your website name rather than just having your organization’s name.

Start by typing in happytailwc. Notice there are several suggestions when you type in the organization name.
You can also create your own website name. Some options might be free for the first year, but you will pay
after (i.e., choosing to go with the .com suffix). If you choose a name that uses the wordpress.com extension, it
will be free (see Figure 8.14). This example shows the free version. On the next screen, choose “start with a free
site” at the top of the page (see Figure 8.15).
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Figure 8.14 Choose a website name that is a good description of your business or organization.

Figure 8.15 You can create the website entirely for free, or choose from a myriad of options depending on your needs.

The next two screens will prompt you to answer questions about the purpose and goals for the website. Then,
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you will be taken to the database of website designs. Notice that some designs are only available for premium
members (i.e., you must pay a fee to use them) while others are free, as shown in Figure 8.16. You also have
the option to skip the design selection and create your website from scratch. Let’s select “Skip for now” (in the
upper-right corner) to see more about what WordPress has to offer for building a site from scratch.

Figure 8.16 If you are unsure of where to begin building your website, choosing a design can help you get started.

Once your site is created, let’s explore the interface. The first screen you will see will display the overview of
your website. This is called the Wordpress dashboard. Here, you will be prompted to start building the pieces
of the website. First, you should give the website a title and tagline, which could vary somewhat from the
website address, but for this example, we will simply call it “Happy Tails WC.” Notice there is a menu of options
on the left to help you change the appearance and add elements to the site (see Figure 8.17). From this menu,
you can also establish users for the website and their privileges to edit the site. Once you set the title, you will
be prompted to update/edit the site’s design. WordPress will walk you through the steps along the way to build
your website. Be sure to save your settings as you make changes. WordPress will remind you to save your
settings as you move through the elements to build the site. Notice also that there are many links on the
dashboard to assist you in developing the layout and content. These links can be very helpful as you are
working on the design of the website.
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Figure 8.17 (a) When you select “Name Your Site,” you will be prompted on the next screen to enter a title and tagline. (b) On the
next screen, you will update the design of the site, including color schemes.

Before we design the layout, let’s choose a theme for the site. Choose Appearance and then Theme from the
menu on the left of the screen in the dashboard, as seen in Figure 8.18. A theme provides the framework for
the site that you can then customize. It is a good place to start rather than creating the layout and elements
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from scratch. A new screen will appear listing the current theme and then options to search and choose a new
theme (Figure 8.19).

Figure 8.18 (a) You can change the appearance of the site by using a built-in theme or customizing your own theme.
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Figure 8.19 WordPress has many theme templates available to use on your site.

For Happy Tails WC, we want to use an engaging theme. Let’s choose a theme that contains a good deal of
color and one that puts pictures on the home page so that we can pique the interest of individuals who are
interested in adopting the available pets. Themes are categorized by style, type of business, or use. For
example, one set of themes may be ideal for users who want to build a website for a personal blog, and
another set for a family website. Once you select a theme, you will notice that it comes with complete
branding, including fonts, color schemes, page layouts, and other features. After choosing a theme that
matches the feel or mood of your business, you can change the images, color scheme, and fonts, all while
keeping the same layout.

Choose the theme Snaps. This theme prominently displays pictures in a nice layout, while also being able to
accommodate text that would describe each pet available for adoption (see Figure 8.20).

8.3 • Creating Content with a Content Management System 565



Figure 8.20 Choose Activate this design to apply the theme to the website.

After you have activated the design theme, you can customize the site to fit your needs by changing colors and
fonts, adding images, building the website menu, and adding information for a post. You will be working in the
website screen as it will appear to users (WYSIWYG), so when you make a change to colors or content, you can
see immediately how the result will look to anyone visiting your site online (see Figure 8.21). You can add
information and add images in this view. When finished, choose Save Changes at the top left of the screen to
go back to the WordPress dashboard. (It will read Saved afterward.) If you need to get back to the
customization screen, you can access it from the Appearance menu in the dashboard.
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Figure 8.21 You can customize many aspects of the theme, including colors, fonts, and background image.

When you save your changes to the theme, you will go back to the WordPress dashboard. Notice you have
several options in the dashboard view, as Figure 8.22 shows. You can add pages to the site, you can modify/
add users and set permissions, and you can also draft posts and blogs for the website. Save your changes by
clicking “Update” in the upper-right corner. The best way to learn WordPress is to experiment with the options
and settings.

At this point, your website is not “live,” meaning it is not yet published on the internet. When you are satisfied
with the design of the site and are ready for people to see it, you need to make the site available on the
internet. To publish the site, simply choose Launch your site from the menu on the right side of the screen on
the dashboard. You will be prompted to select the domain and be asked to pay for hosting (see Figure 8.23).
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Figure 8.22 You can construct your first post using the blog feature of the site. By choosing “+” button below the text in the middle of
the page, you can add elements such as text or images to your website.

Figure 8.23 To make the website live on the internet, you will need to pay for web hosting.
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Take the time to work through the features of interest to you. Here, we have covered some of the basic
elements you need to get started, but there are many more things you can do in WordPress. As an editor
working in WordPress, you will create, edit, publish, and delete posts, as well as moderate, approve, and delete
comments written by others.

Editors may be given permission to change settings, add new users, or install plug-ins by their supervisor or
administrator. These abilities can come in handy when designing and editing a website. A plug-in is a software
application, similar to a smartphone app, that you can add to a WordPress website to extend its functionality.
For example, suppose you want to add a plug-in to track engagement on your blog posts so you can see what
content to curate or expand within the blog. Your plug-in might consist of a contact form that you use to
collect subscriber data, such as favorite color, shirt size, or hobbies—data you can use to improve the user
experience. WordPress currently has over 55,000 plug-ins, a figure that may seem overwhelming at first. You
can easily narrow down the options using the search-and-filter system as well as the plug-ins themselves.

Another important customizable feature of a WordPress website is the widget. Widgets are software
applications that display information or allow users to interface with a website. They can be difficult for users
to understand because they are typically something that developers deal with and require extensive coding.
But in WordPress, widgets manage the content in the design of your site without using code. Unlike plug-ins,
widgets impact the design of your website. For example, you may want to add a widget to your website that
embeds your social media feed, displaying posts, an email subscription form, testimonials, and a list of social
media icons.

Your entire website is made up of pages, much like the pages of a book, except that the user can choose to
view the web pages in any order they prefer. The pages will be consistent, giving the whole website a cohesive
look. Most websites will have a home page (Home), an About or About Us page that describes the
organization, and a Contact page, which provides a way to contact the organization. In WordPress, the pages
will look very similar to a post, which is a piece of information that can be added to your website and listed in
order from oldest to newest. Pages are the skeleton or core of the website and are organized as main pages
and subpages of the main pages. The pages of your website set up the framework for organizing the content
and how users will navigate your site. Posts, by contrast, are time-oriented and are generally meant for social
media. Often, posts are made to highlight certain events or news related to the organization.

Posts can be organized and made searchable to users through the use of tags. A tag is a keyword about
specific details in posts that help make the content in posts searchable. There are also categories for posts.
Categories are a method of organizing posts on a website so that visitors can sort them easily, similar to the
way search engines locate your content. Think of a category as the broad subject of the post and a tag as
something more specific in the post details. For example, Happy Tails might have a category entitled “Dogs
Available,” whereas a tag in a post could be “German Shepherd puppy.” It is a good idea to establish
categories; otherwise, WordPress will put all posts in a generic “Uncategorized” category. Tags are optional,
but they do help users get to the content you want them to see. There is also an option for visitors to sign up
for an RSS (Really Simple Syndication) feed to have posts delivered to them via email. RSS allows posts to be
shared quickly and increases the level of traffic to your website.

To add categories or tags to your site, go to Posts on the WordPress dashboard (see Figure 8.24). From there,
choose either categories or tags. Let’s add the category “Dogs available” (see Figure 8.25) and the tag “German
Shepherd puppy” (see Figure 8.26) to our Happy Tails WC site.
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Figure 8.24 Adding categories and tags helps users find specific information on your site.

Figure 8.25 Categories are broad descriptors of content on the site.
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Figure 8.26 Tags are more specific details about content.

Business Site Considerations
About 40 percent of internet websites, including small businesses, are developed using the WordPress
platform. WordPress offers features that can accommodate businesses of many different sizes and types, and
we have included it here because it is free and easy to use. But regardless of the platform you use to develop a
website—even if you hire a firm to do this for you—there are important considerations to examine. First and
foremost, how will the website be used? Will the site be used for e-commerce? Is the site used primarily to
share information? Is the company counting on the website to increase its market share through interactive
elements to build a customer base? The site should be in line with the company image and brand, as well as
reflect the company’s goals. Having a discussion about how the website will be integrated into the business is
a key step in the design process. This process often starts with choosing a unique domain name, like “Happy
Tails WC,” that expresses what your business is or does.

LINK TO LEARNING

If you are considering establishing your own WordPress site, it’s essential to have a reliable resource to
guide you through the process, especially if you’re new to the platform. For beginners, we recommend
checking out this comprehensive guide by WPBeginner (https://openstax.org/r/78WPBeginner) to learn
more.

This guide offers valuable insights, step-by-step instructions, and practical tips to help you navigate the
world of WordPress effectively.

Another factor to consider is how you will drive users to your website. This can be facilitated through SEO.
Recall that SEO is the process of increasing the visibility of a website to users who are searching for products
or services. The most common search engine is Google, with Bing as a very distant second. SEO works by
including keywords on each web page that identify titles, descriptions, and images. Adding these keywords will
help move your site closer to the top of the list when a user searches for a business similar to yours. Although
many search engines use different methods of ranking, including charging for the top spots in the results lists,
SEO is essential to get users to your website. We will learn more about SEO in Search Engine Optimization.
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REAL-WORLD APPLICATION

Content Accessibility

Improving the accessibility of your website is crucial to providing a positive user experience for all visitors,
regardless of their abilities or disabilities. By incorporating accessibility features, you can make your
website more user-friendly and inclusive, ensuring that all visitors can engage with your content and have a
positive user experience. Here are some features and considerations to enhance the accessibility of your
website:

• Alternative text (alt text): Adding descriptive alt text to images allows screen readers to convey the
content to visually impaired users. This ensures that they can understand the context and purpose of
the images on your website.

• Text equivalents: Providing text equivalents for non-text content, such as videos or audio files, allows
individuals with hearing impairments or those who are unable to access multimedia content to
understand the information presented.

• Proper heading structure: Using headings (H1, H2, H3, etc.) to organize your content in a logical and
hierarchical manner helps screen readers and users who rely on keyboard navigation to understand
the structure and easily navigate through your web pages.

• Color contrast: Ensuring sufficient color contrast between text and background improves readability,
particularly for individuals with visual impairments or color blindness. Using tools to check and adjust
color contrast can help meet accessibility standards.

• Keyboard accessibility: Designing your website to be navigable using a keyboard alone is vital for
individuals who cannot use a mouse or other pointing devices. This includes providing keyboard focus
indicators, ensuring all interactive elements are accessible via keyboard, and enabling users to skip
repetitive content.

• Captions and transcripts: Adding captions to videos and transcripts for audio content allows individuals
who are deaf or hard of hearing to access the information presented. It also benefits users who may
prefer reading or have difficulty understanding spoken language.

• Researching accessibility plug-ins: There are numerous accessibility plug-ins available that can help
enhance your website’s accessibility features. These plug-ins can provide additional functionalities such
as text resizing options, screen reader compatibility, color adjustments, and more. Research and select
plug-ins that align with your specific accessibility needs and requirements.

To explore further examples and important considerations for building accessible online content, visit the
Web Accessibility Initiative (WAI) website (https://openstax.org/r/78WAI) provided by W3.org. The website
includes wealth of valuable information and practical examples.

The security of your site is also important, so customers will feel safe entering their personal information. A
site that doesn’t look professional or that doesn’t have trusted security icons or safe payment method options
can deter customers and reduce sales. Some of the safest payment methods include credit cards with chip
technology and payment applications such as Google Pay, Apple Pay, Cash App, and Zelle.

Finally, you will need to use analytics that measure your website’s performance—how many visitors are coming
to your site, how much time they are spending on each page, how many users are contributing to your site,
and so on. These metrics are found in menu on the left side of the WordPress dashboard, which we will learn
more about in Search Engine Optimization.

572 8 • Content Management Systems and Social Media in Business

Access for free at openstax.org

https://openstax.org/r/78WAI


8.4 Search Engine Optimization

Learning Objectives
By the end of this section, you will be able to:

• Describe how search engines work
• Define and discuss search engine optimization
• Apply search engine optimization techniques

Search engines have been around since the internet was founded in 1990. Yahoo!, founded by Microsoft, was
the original search engine. Search engines are designed to help people find websites on the internet. But a
search engine is only useful if it delivers relevant results. This is where search engine optimization (SEO) comes
in. We have briefly discussed the concept in What Are Content Management Systems? and Creating Content
with a Content Management System. Here, we will go into more depth about SEO as it relates to developing
your online presence.

What Are Search Engines?
Search engines such as Google, Yahoo!, and Bing are web-based tools that use an algorithm, which is a
program used by a search engine to arrange pages in order from the most relevant to the least. Algorithms
generate search results based on user inquiries. In effect, a search engine acts as a personal researcher to
help the user locate relevant web pages or results based on the word, phrase, or sentence typed into the
search bar. Unlike a browser, whose sole purpose is to display a web page, a search engine is a locator tool.
Search engines “crawl” or explore the billions of pages that are available on the internet. Using different search
engines to search for the same topic or industry could yield different results because they might handle
keywords differently or have different ranking algorithms. However, because Google has more than 90 percent
of the market share, many websites tend to focus on SEO for Google, ignoring other search engines that are
much less widely used.

The goal of SEO is to increase traffic to a website. Higher traffic, or a greater number of visitors, is
accomplished by listing a website near the top of the search list when a user searches for a particular website.
The higher the site appears on the list, the more likely it is that visitors will click on it. More site visitors can
increase your online visibility and increase the potential for more sales, if you are an e-commerce site. Also,
sites that have a greater number of visitors tend to have the perception of being of higher quality than those
with fewer visits. Because of the sheer size of the internet and the number of websites hosted on the internet,
SEO can be a cost-effective way to reach more people. Figure 8.27 is an example of the type of information you
would find when measuring the reach of a website.
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Figure 8.27 Most hosting services provide data to help you see how many people have visited your website.

MAC TIP

Mac users can take advantage of the built-in tools and features available on macOS, such as the Safari Web
Inspector. Safari, the default web browser on Mac, comes with a powerful development tool called the Web
Inspector. It allows you to analyze and debug web pages, which can be valuable for SEO purposes. To
access it, follow these steps:

• Open Safari and navigate to the web page you want to inspect.
• Go to the Safari menu in the menu bar, then click on Preferences.
• In the Preferences window, click on the Advanced tab.
• Enable the option that says Show Develop menu in menu bar.
• Close the Preferences window.

You should now see a Develop menu in the menu bar. Click on it and choose Show Web Inspector. Once the
Web Inspector is open, you can use its various panels to analyze the structure of the web page, inspect
HTML elements, view and modify CSS styles, monitor network requests, and more. This can be helpful for
identifying SEO-related issues, such as missing meta tags, slow-loading resources, or improperly structured
content.
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How Does Google Work?
Google is a search engine that uses web crawler software to constantly roam the internet. Web crawling
means that the computer software scans the internet for certain words, tags, and links based on a particular
search term(s). These software programs are automated and sometimes referred to as “bots.” The bots browse
the internet when terms are put in the search bar and operate search engines for the purpose of web
indexing. An index on the web is similar to an index at the end of a book—it contains all website addresses
that are searchable by the bots. To get your website to be included in the index, the website content needs to
be deemed credible and of value to users, easy to navigate, and not to contain duplicate information. Once the
site is on the index, when a user puts in a search term that is tied to the information on the website, the
website will be returned and ranked. Higher-ranked websites will appear sooner in the search results list. You
can improve your website ranking by including keyword tags, categories, and links to other relevant websites.
You can also improve your website ranking by using search engine marketing and paying to have your
company’s information show up higher in the search results list. Google uses a sophisticated computer
algorithm to rank websites that are constantly updated. Most search engines will use similar technology for
searching on the internet. The Google search process has three stages:

1. Crawling: Automated programs seek out new or updated pages and organize their addresses in a list that
the user can view.

2. Indexing: Based on information from crawling, Google visits pages and analyzes their content, images,
videos, and other elements. The goal is to identify the type of page and store the information in an index.

3. Serving: In this stage, the search engine determines the best results based on user language, location,
device, and queries. For example, a user searching for a tea shop will have different results if they are in
Florida than if they are in India.

LINK TO LEARNING

We recommend watching this TED Talk by science writer and journalist Zeynep Tufekci
(https://openstax.org/r/78TEDZTufekci) to gain an insightful perspective on the influence of algorithms and
the potential dystopian consequences of building a digital world driven by ad clicks.

What Is Search Engine Optimization?
Search engine optimization (SEO) is a digital marketing strategy that business owners or individuals can apply
to their websites and web pages to increase the value and volume of traffic from different search engines.
Search engines sort results from different websites to show the public relevant information based on
keywords. Pages are ranked using an algorithm to help improve search results. A web page with more relevant
links will rank at the top of the list. PageRank is an algorithm used to help business owners promote online
visibility by increasing the number of internet search results for a website. To optimize search results, business
owners should update their information regularly and use relevant keywords within their web pages.
Keywords will be based on company products and services they offer. There are companies that will analyze
and provide SEO data for your website. Figure 8.28 shows just one example of how the data be summarized.
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Figure 8.28 Different analytics tools provide a variety of ways to analyze your website, such as keyword tags and SEO settings.

SEO is important for businesses to implement because it boosts the likelihood that their site will be seen
before their competition. A website with a higher rank will receive more clicks and visits from viewers. Higher
ranks can be obtained by including keywords multiple times and in multiple places on your site. For example,
Happy Tails WC might ensure that they get potential pet adopters to their site by using keywords such as “dog,”
“cat,” “adoption,” and their specific location multiple times throughout the website.

Companies can also improve their website’s rank by making sure the site loads quickly, can work on multiple
platforms such as tablets and phones, and has an easy-to-navigate layout. SEO can even impact the user
experience; consumers should be able to locate what they need by inputting specific keywords in a search. The
better the SEO is implemented on a site, the easier this process is for the end user. Implementing SEO also
adds credibility to a website by increasing exposure to customers.

Optimizing Your Site for Search Engines
Here are some steps you can take to optimize your website for search engines:

• Focus on producing rich content, such as crisp images and high-quality videos.
• Conduct keyword research that aligns with what your customers want.
• Identify your target audience and design your site to meet their needs. If your site is not well-designed, it

can be difficult for web crawler software to analyze the content effectively.
• Make sure you have a good hosting site that allows your website to load quickly and allows you to add

tags and categories to your website.
• Consider hiring an SEO expert who can analyze your website and help you improve your rank within

ethical guidelines.

Optimizing Specific Content
SEO keywords include specific words and phrases in your web content, making it easy for your site to
populate within search engines. If your website is optimized properly, the language used in your keywords will
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be identical or similar to the language used by your visitors. Therefore, it is essential to understand your target
market. Keywords help define what your site is about and connect your audience to you. For example, if you
have a T-shirt shop but fail to specify the types of T-shirts you sell, you will miss opportunities to reach
potential customers. For better results, use keywords that represent your niches, such as “wholesale T-shirts”
or “vintage T-shirts.” Make a list of relevant topics surrounding your niche and develop different keywords. It is
also a good idea to study your competition and see how they rank or what keywords are driving traffic.

To maximize the benefits of SEO, you need to provide well-organized, meaningful content that encourages
visitors to remain on the site longer. Using keywords in your content can help you build trust and establish
authority. Be sure to create titles that your target customer will use in a search engine, and use keywords
associated with your topic throughout your page, as well as links that connect to other reputable websites. For
Happy Tails, you might consider titles such as “adopting cats” or “caring for a new pet.” These titles and
descriptions should also be interesting, using catchy words and phrases to attract your audience. Descriptions
should be detailed, and neither too short nor too long. Here are some tips for writing titles and descriptions:

• Titles and descriptions should summarize what the page is about.
• Avoid using false narratives or titles to drive traffic to your website. This is considered unethical.
• Be sure your titles and descriptions use the same language your target audience would use, so they can

feel a connection. Consider hiring a copywriter that specializes in SEO or web content.

SPOTLIGHT ON ETHICS

SEO Ethics

When it comes to ethical considerations in SEO, ensuring accurate representation is of utmost importance.
Engaging in unethical practices, commonly known as Black Hat SEO or spam, can have severe
consequences for your online presence. While these practices may not be strictly illegal, they are widely
frowned upon in the business community. If search engines uncover your hidden agenda, you risk being
penalized with search engine bans or a significant drop in your ranking.

Review cases from HubSpot that highlight some of the biggest SEO blunders (https://openstax.org/r/
78UnethicalSEO) to gain a better understanding of the unethical practices to avoid. By exploring these
examples, you can learn from the mistakes of others and cultivate an ethical approach to SEO. The cases
presented provide valuable insights into the consequences of unethical practices.

Now, let’s examine three cases from HubSpot’s examples of unethical SEO practices, along with an
explanation of the specific unethical practice involved in each case:

• Case 1: Inflated Keyword Density: This case involves the excessive and unnatural stuffing of keywords
into content in an attempt to manipulate search engine rankings. This practice aims to deceive search
engines and artificially boost a website’s visibility. However, such keyword stuffing compromises the
quality and readability of the content, making it difficult for users to obtain valuable information.
Search engines consider this practice unethical and may penalize websites that engage in keyword
stuffing.

• Case 2: Hidden Text and Links: In this scenario, websites use hidden text or links that are not visible to
users but are intended to be detected by search engine crawlers. The hidden elements are often
stuffed with keywords or include links to unrelated or low-quality websites. By concealing these
elements, website owners aim to manipulate search engine rankings. However, this practice is
deceptive and violates search engine guidelines, as it misleads both users and search engines about
the actual content and purpose of the website.

• Case 3: Link Schemes: This case involves the creation of artificial and manipulative links with the goal of
improving search engine rankings. Unethical link schemes may include purchasing or exchanging links,

8.4 • Search Engine Optimization 577

https://openstax.org/r/78UnethicalSEO
https://openstax.org/r/78UnethicalSEO


participating in link farms or networks, or using automated tools to generate a large number of low-
quality backlinks. Search engines consider such practices as attempts to manipulate their algorithms
and devalue the trustworthiness and integrity of search results.

By understanding these unethical practices and their associated consequences, you can make informed
decisions to avoid them and uphold ethical standards in your SEO efforts. Remember, the focus should be
on providing valuable, relevant, and user-friendly content that aligns with search engine guidelines. By
taking an ethical approach to SEO, you can build a strong online presence, gain the trust of your audience,
and foster long-term success.

A uniform resource locator (URL) is used to access resources that are published on the internet. Most people
are familiar with its format: generally, they begin with “www.” and end with “.com” or similar. A good practice is
to design URLs in a way that will benefit users, while also being easy for search engines to understand. Here
are a few things you can do to optimize your URLs:

• Limit your URLs to fifty to sixty characters. This will not be sufficient to rank your site, but it is a good
practice because it helps make the URL easier for users to copy and paste, share on social media sites, and
remember for future use.

• Create SEO-friendly URLs that describe your content and include keywords.
• Use hyphens to separate words and lowercase letters.

Let’s look at some examples of good and not-so-great URLs. Figure 8.29 outlines some good URLs and URLS
that could use some work.

Figure 8.29 The URL should be descriptive and include specific keywords for the bots to use in the search.

Headings
Using headings on your website can help both visitors and search engines locate and understand your
content. Headings are used to partition content on a page with a good deal of text or other information. The
headings can break up the information to make it more readable and visually engaging. When a block of text
gets lengthy (generally more than five to eight lines of text), you should consider using headings to organize
the content. Headings can also enhance the accessibility of your site. A site with headings is easier to read and
can help visitors to the site jump to relevant sections. Headings are also used by many screen reading
technologies to aid in site navigation. If there are no headings, the reader can easily be confused and leave the
site. To organize your content, try some of these tips:

• Break up text by topic and add a short, descriptive heading for each.
• Include keywords in your header tags for SEO.
• Use headings to describe each section of the website that contains more than five lines of text.
• Make your header tags consistent in font size, color, and writing style, so visitors can recognize the

headings quickly.
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• Avoid using all caps for headings. Words typed in all caps have accessibility issues as they are often
difficult to read.

• Use catchy or relevant words.

Some website headings that might work for Happy Tails WC include “Join our Family” to volunteer for the
organization or “Find a New Friend” to see the adoptable pets.

8.5 Social Media in Business

Learning Objectives
By the end of this section, you will be able to:

• Explain why social media is important to a business
• Evaluate different strategies for maintaining audience engagement
• Analyze the value of using social media for a business

You are probably familiar with at least one social media platform. Businesses have come to see the value in
promoting their organization via social media platforms because of the cost-effectiveness and reach of social
media across nearly all demographics. For many businesses, building a social media presence is just as
important as building a website. But building a brand on social media is challenging because so many different
media platforms are available.

Social media is an integral part of content management in an organization. To manage content effectively,
organizations need to have a consistent message across platforms. However, the organization can use the
various platforms in different ways to get the same message across. For example, a post from a Happy Tails
WC social media account might just show a picture of a pet and a short description. But the post itself would
direct viewers to the Happy Tails WC website, where they could get more information about adopting that pet.
Conversely, some content is better suited for social media than for a regular website—for example, events,
which are more easily shared and publicized on social media. Generally, people spend less time on any
particular post on social media than they do engaging with a website. Therefore, it is critical to create content
that will catch the user’s eye as they scroll through their social media feeds. Also, by sharing particular items,
such as events or announcements, you can measure the reach of the posts through the social media metrics
generated.

For example, when you post a fundraising event for Happy Tails, you can get an idea of how many people will
attend the event, expected donations from the event, and even how far individuals will travel to attend the
event based on their location in their social media profiles. Engagement with users on social media is often a
bit more personalized, and you can create richer connections with your audience that you cannot with those
who simply visit a website. Social media gives you more of a relationship-building process than you have with
website interactions. These are just a few examples of how the same content can reach users differently across
different platforms. Research suggests that brands need to be savvy about their social media presence. They
should create engaging content that inspires sharing with followers, manage and create content for different
social media platforms, and strategically navigate the social landscape.

Why Is Social Media Important to a Business?
Using social media is an essential component of any business marketing strategy. By providing access to
customers’ feedback and interactions, social media platforms help businesses stay in tune with customers,
increase brand awareness, and boost their potential leads. Customers can use social media channels to ask
questions about products and services. By listening to customer feedback and analyzing the data provided by
social media, companies can improve their customer service and increase revenue.

There are several popular social media platforms, and it is expected that more will be developed in the future.
You may be active on one or more social media platforms. You might also engage with a business or
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organization through these platforms, whether by simply following a company’s social media page, by liking
and/or interacting with posts from the company, or by sharing information from the company on your
personal page. These are all ways that businesses want their target audience to interact. The more interaction
with the target group, the more brand recognition and loyalty can be built, contributing to an increase in
business for the company.

Not all social media apps are created equal. Some platforms are better suited for sharing photos, while others
are better for networking with potential employers. For example, Facebook and SnapChat are more visual,
whereas X (Twitter) and LinkedIn are more text based. Each, however, can play a role in your company’s overall
strategy. Figure 8.30 lists a few of the major social media platforms and their uses. More research will be
needed by your organization if they choose to use one of the platforms.

Figure 8.30 You should consider your target audience when selecting the appropriate social media platform.

A social media plan can be part of a business growth strategy, which should include a planned-out content
calendar, an arsenal of automation tools to schedule posts across platforms, tools for tracking performance
metrics, and more. Each post a company shares should be designed in advance to maximize the company’s
success on social media. Using the tools and strategies discussed previously, a robust social media marketing
plan that fits into the overall strategic goals of the company can be enormously beneficial to a business.

But as with any content management, integrating social media into your business plan can be challenging and
requires proper planning. The popular phrase “build it and they will come” is true only when strategies are in
place. You might get initial visits to your online content, but if the content is not engaging and meeting
customer needs, the visitors probably will not return. Therefore, before you implement the different strategies
described here, you should think about the key factor that will keep visitors returning: great content and
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customer service. To ensure content is fresh and trending, listen to what your audience wants and needs. To
drive traffic to your site, you need to know your customers—their demographics, their habits, their likes/
dislikes. You should also be sure to have a presence on the social media sites where your target audience
spends time.

Growing an audience can be a difficult task for a new business starting with zero customers. This will be
particularly important for Happy Tails WC managers to ensure as they are a new nonprofit. They will need to
build awareness so that they can secure the volunteers and donations needed to run the organization. They
will also need to market to get the pets adopted promptly. Understanding who your target audience is will
help you generate a better return on investment (ROI). Your target audience is the group of people who would
be most interested in your product or service. For Happy Tails, the target market can be large. They are looking
for individuals with a passion for animals. But they also need individuals who are good at fundraising and are
skilled in event planning. Members of this target audience will have a number of things in common, and you
can use this information to create content that resonates with them. Once you build a connection, it will be
easier to turn them into loyal customers.

One way to understand your business’s target audience is to figure out what kinds of things they like, and
make connections across those things. One way to do this is to partner with other businesses to tap into a
wider audience and spread your brand to other markets. For example, in 2013, Pottery Barn, a furniture
company, and Sherwin-Williams, a paint company, partnered to allow customers to select paint colors that
would coordinate well with furniture. This led customers to want to purchase Sherwin-Williams paint colors
because they were custom-selected to match perfectly with Pottery Barn furniture. Pottery Barn developed a
landing page that contained blog posts on ideas and tips for how to paint and decorate.

Another common strategy is to allow users to find and tag relevant information with hashtags. A hashtag is a
keyword tag that starts with “#” and can be used on a wide variety of social media sites. For example, you may
have seen the hashtag #ootd which stands for “outfit of the day.” Happy Tails WC could use hashtags to
promote their page such as #potw (pet of the week) or #adoptnotshop to promote the idea of adopting a pet
rather than going through a pet store. Hashtags are searchable by users. As a business, you can use hashtags
to promote your brand or cause. You can look at competitors’ hashtags and use similar ones for your posts.
Hashtags can be part of a broader social media campaign to drive traffic to your page and create content for
posts to be shared.

Many social media platforms also enable users to promote their posts to specific demographics or geographic
locations for a fee. This goes back to really understanding your target audience. Because of the data collected
via social media on individual users, there is a good deal of data available to help push posts to specific
audiences. In some instances, you can even promote specific posts based on purchasing habits or websites
visited. For example, Happy Tails WC can develop a post and pay to have the post promoted to individuals in
the communities around the adoption agency or to those who already have pets based on their social media
profiles. Each platform will have its own fee structure for promoting posts. For example, with Facebook, you
set your budget. You put in how much you are able to spend for promoting a post or an event and Facebook
will use that amount to promote the post. The minimum is $1 per day, which could reach up to almost 80
people based on your target audience and location. With $20 per day, that figure could rise to over 1,000
people. It is beyond the scope of this text to go into detail about promoting posts on various social media sites,
but you should be aware that this option exists. By searching the “Help” function for an individual social media
platform, you should be able to find specific information on paying for promoting posts.

A backlink, also referred to as an inbound or incoming link, is a hyperlink in a web page that takes you to
another website or another location on your site. Google’s ranking process will rank websites that have
backlinks higher than those that do not. When your site includes hyperlinks to other websites, it is viewed as
more trustworthy. This is similar to writing a research paper for a class. You will probably be required to cite
previous research in your paper to support your ideas and conclusions. Web pages work the same way.
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Backing up your information with sources (i.e., other websites) can increase your credibility. To be effective, the
backlink should be a trusted website itself and relevant to your website.

As a final consideration, you may want to think more deeply about the keywords you choose. In your initial
search for a website, you may use very general terms. For example, if you are interested in adopting a pet, you
might start with a search for the term “pet adoption.” But after further investigation, you may determine that
you really want to adopt a certain breed of pet, of a certain sex and a certain age. Your search terms then
become more detailed, such as “an adult female dachshund.” This is the concept of a long-tail keyword—a
more descriptive set of keywords that are specific to your business. Long-tail keywords are often used by
individuals who are closer to actually making a purchase or who want a more in-depth interaction with the
company. For Happy Tails WC, this might be the point at which an individual submits an application for a
specific pet or reaches out to discuss some options with the organization’s personnel. You may not generate as
many visits to the page with long-tail keywords, but the visits that are made will be higher quality and more
likely to generate customers.

Maintaining Audience Engagement
Creating original content for social media is called content creation. In the content management lifecycle
covered earlier in this chapter, content creation is part of both the organization and creation stages. In the
organization stage, you should determine which content will be on which platforms (e.g., website versus X
(Twitter)). Then, in the creation stage, you will create the content specific to that platform, with the
understanding that not all content is equally appropriate for all platforms. For example, the way adoptable
pets are highlighted on the Happy Tails WC website can differ from how the pets are showcased on Instagram.
To create engaging content, you will need to understand your topic and listen to your audience. If the content
is valuable to your audience, they will be more likely to reshare it.

When creating content, think about the “four Es:” (see Figure 8.31). Content should entertain, educate,
encourage, and engage through a call to action. Also think about the way your content is structured. Through
the use of headings, you can avoid posting long paragraphs and instead break the content down into bite-
sized pieces for your audience.

Figure 8.31 Creating engaging content increases the likelihood that your social media posts will be shared with others and thus
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increase their reach.

Another key to original content creation is writing for your audience. You want to develop an understanding of
your target market, and identify their demographic characteristics and pain points (recurring problems with
products or services that inconvenience or annoy customers). Use this information when you write content for
your business. Because social media platforms are primarily visual, your content should include visuals and
infographics as well as text. Tools like Canva (an online design and publishing tool that allows customers to
design anything and publish it online) can be used to style your content into posts that fit the specifications of
different social media. You can also use some of the tools in Google Slides and Microsoft PowerPoint to design
engaging visuals. There are many other tools you can use to create various types of content—for example,
YouTube for video, SurveyMonkey for short surveys, Anchor for podcasting, and Spotify for playlists.

Collecting information on a relevant topic and sharing with added value is called content curation. When the
content is shared on social media, credit is given to its original owners. Curating content allows you to add
value to your site by collecting information and organizing it to appeal to your audience. This is similar in
concept to backlinks: The goal is to locate thought-provoking or engaging content to build upon original
content and enhance your credibility. As a content manager, you will be a researcher who sorts data online
and identifies relevant and purposeful content. Essentially, you will manage and oversee the content for the
organization. For example, HubSpot is a company that focuses on creating software solutions for marketing
and customer service management. The site creates content regularly to demonstrate to its audience how to
use social media for marketing in the form of blog posts. They pull a variety of content from case studies,
social media tools, resources, etc. to provide resources on best practices in marketing that are relevant to their
target market.

Strategies for Repeat Visitors
Repeat visitors to a website, social media, or blog are good for businesses that want to develop brand loyalty
or build an online community. There are a few strategies that will assist in increasing the traffic to your
business (see Figure 8.32).

Figure 8.32 To drive traffic to your social media sites, you can use various methods that have been found to attract and retain
customers.

Start with a “call to action.” This is a way of encouraging your site visitors to do something. Encourage your
visitors to leave a comment, share an image, or enter a contest. Some businesses center their relationship with
their customers around product sharing. For example, customers might take an image of themselves with the
product and use a special hashtag to be identified and posted. You can also build a loyalty program,
encouraging visitors to return by having them subscribe or join a membership rewards program. This will give
visitors something to look forward to in your business.

An example of this strategy is having users download an app and earn rewards toward a free purchase.
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Starbucks, Chick-Fil-A, and Chipotle all have these types of rewards built into their apps. Offer incentives for
reposting and sharing your organization’s posts on their own personal social media pages. You can create
even more engagement by asking them to tag their friends in the repost. Finally, one of the best ways to have
repeat visitors is to create a consistent experience with excellent customer service. This is an essential part of
making visitors want to stay involved in the process of buying from your business.

Engagement Management
Any interaction between two parties on social media platforms, such as sharing, linking, or commenting, is
called engagement. Organizations use engagement management (EM) as a tool that allows them to engage
with members or clients anywhere or anytime. It involves a team of client relations (sales and support), project
management, delivery, and quality management to satisfy clients. EM operates across multiple projects and
ongoing relationships. For example, Hootsuite (https://openstax.org/r/78Hootsuite) is a social media
management platform that integrates social media networks and helps clients focus on engagement.
Companies can curate content, schedule posts across different social media platforms, and manage team
members. Hootsuite offers integration for X (Twitter), Facebook, Instagram, LinkedIn, and YouTube, making it
easy for clients to measure ROI. There are other similar software programs available to help your organization
manage multiple social media platforms.

A key advantage of using one of these programs is that you can schedule your social media posts and
incorporate the social media calendar discussed previously. For example, when a post is made on one social
media platform, such as X (Twitter), the same post can be made to Facebook automatically. This can facilitate
your social media marketing plan to ensure consistency. It can also help keep your posts organized and can
save you time if you have limited resources to dedicate to social media.

Social Media Analytics
Businesses should ensure that their marketing efforts are producing measurable results that align with the
company’s goals and strategies. Businesses can use social media analytics to collect data from different
social channels—including information on demographics, behaviors, favorites, and the like—and measure
performance and drive business decisions.

For example, a social media management company may monitor your social platforms to see how many
people are following and engaging with your accounts. They will view how many times people interacted with
your account to share, like, or comment on posts. This data allows you to identify patterns for your customer,
which will help with ROI. Some top social media analytic platforms are BuzzSumo, HubSpot, Sprout Social, and
TapInfluence. However, within each social media platform, you can find analytics about your posts, as seen in
Figure 8.33. You will get summary data showing the reach of your posts, the number of times each post was
shared and reshared, how many people liked the post, and other related information.
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Figure 8.33 By tracking engagement of posts, you can determine which posts resonate more with your audience.

Social Media Calendar
Using a social media calendar allows you to plan your content ahead of time and update as necessary. Social
media editorial calendars are spreadsheets or apps used to schedule social posts in advance. They are also
used to plan which content will be shared and when, to manage campaigns, and to track deadlines. Your
calendar can be a simple one using spreadsheets or a pen and notebook, or it can make use of special
software (see Figure 8.34). You could start off by setting up a spreadsheet of your posts across various
platforms. You will learn the skills to do this in the chapter on Working with Spreadsheets.
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Figure 8.34 Social media calendars can help you keep track of posts and schedule them for publication. (Google Sheets is a
trademark of Google LLC.)

Whichever route you take to developing social media content, you should have the following main topics: type
of social media platform, date and time, topic/theme of posts, links, and tags connected to posts. A more
complicated calendar could also include several platforms and details, such as if the post will be linked to an
event or if you will pay to promote the post to a greater audience.
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Chapter Review
Key Terms
access controls ability to restrict or limit user groups to viewing specific pages within a website
algorithm program used by a search engine to arrange pages in order from the most relevant to the least
backlink link to another website that is related to your site and is designed to increase the rank of your site
blogging capability feature that allows anyone in the company to add content in a thread of posts
calendaring feature that allows you to plan content by scheduling future dates and times to release

information
category method of organizing posts on a website so that visitors can sort them easily
client side everything that is displayed or occurs on the user’s end of a web application or device, such as

text and image
content creation development of original content for social media
content curation process of gathering information on a topic and then sharing it on social media with

added value
content editor allows users to easily review the style and format of the content in a document, which

provides optimal design and readability
content management lifecycle process for managing content through the seven stages of organization,

creation, storage, workflow, editing/versioning, publishing, and removal/archiving
content management system (CMS) application that uses a set of processes to manage web content,

allowing multiple contributors to collect, create, edit, and publish content
content syndication allowing content on one site to be hosted on another site to reach a larger audience
crawling process by which a search engine collects data from the internet
engagement any interaction between two parties on social media platforms, such as sharing, linking, or

commenting
engagement management (EM) systematic approach that begins with the sales process and ends with

engagement closing
enterprise content management system that facilitates the life cycle of content within an organization by

creating a timeline for content to be created, approved, and distributed
hashtag word or keyword phrase preceded by a hash symbol (#); used to pull up and filter content
indexing process by which search engines visit pages, analyze their content, and store the information in an

index
keywords specific words and phrases in your web content that make it easy for your site to populate within

search engines
library where content in CMS programs are organized and stored
long-tail keyword extended key words that are more descriptive and provide more specific internet search

results
mobile content management system (MCMS) CMS that hosts a data store in a centralized location and

allows content to be managed for multiple platforms
open-source CMS CMS that is maintained by a community of developers and is open to the public
PageRank algorithm used to help business owners promote online visibility by increasing the number of

internet search results for a website
pages framework that makes up a website
plug-in extension or app that customizes and enhances the functionality of a website
post piece of information that can be added to your website and listed in order from oldest to newest
proprietary CMS CMS that is owned by the individual or group that created it and can be used only by those

who purchase a license key
RSS (Really Simple Syndication) method of delivering posts to a website
search engine optimization (SEO) using keywords to help content on your site reach audiences
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serving process by which a search engine determines the best results based on user language, location,
device, and queries

social media analytics information gathered and measured to support business decisions
social media content management process of creating, scheduling, publishing, and analyzing content for

all your media platforms
tag keyword for specific content on the site that can be used to organize information
Web 2.0 websites that provide two-way communication or interaction
web analytics insights or data that can be evaluated against company objectives
web content management system (WCMS) software content management system that offers website

authoring, collaboration, and administration tools
web crawler software computer software that scans the internet for certain words, tags, and links based on

a particular search term
widget tool that can be used to embed consistent information, such as advertising, on headers, footers, and

sidebars within a website
Wordpress dashboard main screen that allows you to see the administration of a website
WYSIWYG (What You See Is What You Get) editing software that allows content to be displayed in the same

format it will appear when printed or shown
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Summary
8.1 What Are Content Management Systems?

• Content management systems allow users to manage content on all platforms, such as social media and
web content, to create a consistent message and image for the organization.

• Using a CMS promotes collaboration and quality control and facilitates search engine optimization,
security, and the ability to reuse content.

• There are seven stages of the content management lifecycle: organization, creation, storage, workflow,
editing/versioning, publishing, and removal/archiving.

• Content management systems include features for controlling each part of the content management
lifecycle, including page templates, document libraries, and calendaring.

8.2 Common Content Management Systems
• Web 2.0 enables users to create, curate, and manage content by using WYSIWYG software, which allows

them to visualize how their content will be displayed.
• There are three main types of CMS: open-source, proprietary, and enterprise. An open-source CMS

provides free access to basic features and functionality. A proprietary CMS can offer faster, more
customized solutions but requires licensing. An enterprise CMS offers high storage capacity and security,
making it an ideal platform for day-to-day workflow.

8.3 Creating Content with a Content Management System
• WordPress is a CMS that is easy to install, free, and open-source. This makes it an ideal platform for small

businesses, start-ups, nonprofits, and bloggers.
• To create a business website with WordPress, you may want to make use of features such as search

engine optimization (SEO) and analytics that measure your site’s performance.

8.4 Search Engine Optimization
• Search engines use computer programs that filter through keywords and website content to return and

rank search lists.
• SEO refers to processes that help optimize search results to increase the chance that your company’s

website will appear higher up in the user’s search results list.
• Techniques for optimizing your website for effective searches include using an easy-to-understand URL,

using descriptive titles, and keeping your page heading engaging.

8.5 Social Media in Business
• Businesses can use social media to reach their target audience, connect with existing customers, engage

new customers, and make use of customer feedback.
• Using the appropriate social media and networking platforms can benefit a business by generating more

customers, building a loyal customer base, and providing exposure to other audiences.
• Creating original content for social media requires developing and producing posts as well as curating

your content in ways that are consistent with your brand.

Review Questions
1. Once you learn the context of data, it is considered ________.

a. analyzed data
b. knowledge
c. information
d. content

2. A content management system manages ________.
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a. a blog
b. e-commerce
c. site visitors
d. web content

3. ________ organize internal documents and the information employees may need to do their jobs.
a. Enterprise content management systems
b. Mobile content management systems
c. Social media content management systems
d. Web content management systems

4. A CMS allows editing, publishing, modifying content, and site administration. If you are managing a team
of developers, designers, writers, and editors, which feature are you most likely to use and manage?
a. editing
b. publishing
c. modifying content
d. site administration

5. Multiple people are working on updating the website to match the theme of the new launch. An employee
was supposed to edit images on the site, but when you log in, you find that some files are missing. The
system allows you to see the time, date, and user, so you can identify when any changes were made and
who made them. This feature is known as ________.
a. authoring
b. content versioning
c. multiple users
d. site administration

6. ________ allows user engagement to actually create content on a company website.
a. Enterprise content
b. Web 1.0
c. Web 2.0
d. Open-source

7. A(n) ________ CMS involves no initial costs and allows the user to download the software without a contract.
a. open-source
b. proprietary
c. enterprise-enabled
d. CMS

8. WordPress uses ________ to control user access to different features in the site.
a. cookies
b. usernames
c. roles
d. code

9. Where do you find the metrics in WordPress that are used to measure the effectiveness of your website?
a. dashboard
b. stats
c. edit
d. posts
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10. Google uses ________ to generate search results.
a. an algorithm
b. crawling
c. indexing
d. a URL

11. The purpose of SEO is to ________.
a. categorize blogs
b. search for keywords
c. target paid traffic to a website
d. improve the quality of a website

12. When using multiple words in the URL, you should use a(n) ________ to separate words.
a. underscore
b. hyphen
c. space
d. period

13. What is one reason having a social media presence would help a small business?
a. Guarantee sales.
b. Increase brand awareness.
c. Reduce product costs.
d. Automatically respond to complaints.

14. What is one key advantage of engagement management (EM)?
a. creating content
b. encouraging single site visits
c. not having a website
d. scheduling posts

15. What is a social media calendar?
a. data collected from different social channels to measure performance
b. a tool that allows organizations to engage with members and involves a team of client relations to

satisfy clients
c. a spreadsheet or app used to schedule social posts in advance
d. hyperlinks in a web page that take you to another website or another location on your site

Practice Exercises
16. If you were working on the content for Happy Tails WC, what kind of content would you need to get

started? What information would you include on a website versus on social media?

17. Think about an organization you are involved with or perhaps where you work. What tools would you use
to promote the organization or business? Are there specific social media platforms that can be utilized?
What functionality would you want to have with the website?

18. Choose a case study from HubSpot and reflect on how a company can use a CMS to increase its
conversion rate. See HubSpot’s Case Studies Directory (https://openstax.org/r/78HubSpotCase).

19. As a consultant, you are approached by a small venture that wants to know which type of CMS they should
use for their nonprofit, which promotes awareness of recycling in the community. They have about ten
employees, one of whom is responsible for adding and managing content about the company’s mission.
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Write an email responding to the client about which CMS you suggest and why.

20. An eco-friendly blogger has hired you to develop and design their website using WordPress. You are
tasked with selecting an appropriate theme and adding content to the home page based on the blogger’s
needs, as described. Browse the themes and select an appropriate theme for the blogger.

• The blogger is selling an e-book that helps people live an eco-friendly lifestyle.
• The website requires an area for daily, weekly, and monthly blog posts, plus space to sell the e-book.
• The blogger wants the site to have a coastal beach vibe and color scheme.

21. Go to the following websites for two different pet-related organizations. Compare and contrast the
websites. Which one is more effective? What are the features you notice about each? Do the websites look
current and secure?

• Petland Columbus, Ohio (https://openstax.org/r/78PetlandOhio)
• Clinton County Humane Society of Ohio (https://openstax.org/r/78CCHSOhio)

22. Read this article on writing SEO-friendly content (https://openstax.org/r/78SEOContent) and then develop
a blog post about the article using SEO strategies.

23. Go to the website of your favorite retailer. Looking at the content on the site, what are some categories
and key terms that should be used for SEO? Now go to a specific product on the site. Does the URL follow
the guidelines covered in the section? What suggestions do you have to improve the URL?

24. Develop a one-week content calendar for an upcoming pet adoption event focused on cats available at
Happy Tails WC and include various platforms such as Facebook, LinkedIn, Instagram, and X (Twitter).

25. Provided here are some summary reports from a college business program Facebook page that is student-run.
What are some insights you can gather from the summary report? How can this information be used to more
effectively use the Facebook page?
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Written Questions
26. Why should an organization have a CMS?

27. How can teams collaborate using a CMS?

28. What are the major differences between Web 1.0 and Web 2.0?

29. What is WYSIWYG and how is it important in website development on the client side?

30. Discuss who might be the appropriate person or persons to maintain the website for Happy Tails WC.

31. Discuss some of the items you should consider when developing a website for a business that will sell
products online.

32. How do search engines drive better traffic to a website?

33. How can a business use SEO to optimize its website?

34. How do businesses benefit from using social media?

35. How can curated content create stronger backlinks?

36. What are two critical factors in engaging return visitors to a website?
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37. How can analytics be used to earn repeat visitors to a website?

Case Exercises
38. Read the case study on how a company switched from using Word to a CMS to manage documents

(https://openstax.org/r/78EnergirCase) from Énergir. What were the benefits of using a CMS over
managing information in traditional ways?

39. You have been asked to help Happy Tails with their first blog post, which will highlight an upcoming
fundraising event for the organization. The event will be a casino night with a silent auction. Create a blog
post for the event, including relevant details such as date, time, and location. Include some ideas for
graphics that could be included in the blog post.
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Figure 9.1 A spreadsheet is a useful tool for working with large sets of numerical data. (credit: modification of "Notebook, Typing,

Coffee" by Pexels/Pixabay, CC0)

Chapter Outline
9.1 Microsoft Excel Basics
9.2 Text and Numbers in Microsoft Excel
9.3 Calculations and Basic Formulas in Microsoft Excel
9.4 Formatting and Templates in Microsoft Excel
9.5 Google Sheets Basics
9.6 Text and Numbers in Google Sheets
9.7 Calculations and Basic Formulas in Google Sheets
9.8 Formatting and Templates in Google Sheets

Chapter Scenario
WorldCorp’s Portland, Maine, location receives many finished products at their warehouse. Some of the
products they sell include LCD TVs, home stereo systems, computer accessories, and tablets. They add these
items to the inventory and then ship them to different destinations. Their orders include a wide variety of
products, each with a different price, for many clients, and with multiple sales agents. Because WorldCorp’s
business model includes multiple locations and various business units, they have a large volume of data, so
collaboration and sharing of information is necessary for the company to be successful. This is especially true
when communicating sales information company-wide. The information needs to be organized and effectively
communicated to various entities within the corporation. It will also need to be put into sales reports that
follow corporate standards for reporting and be accessible by the appropriate entities for editing. By using
spreadsheets, sales agents and upper management at WorldCorp can access the information they need to
make informed decisions about inventory levels and distribution channels.

A spreadsheet is a powerful tool to organize, present, and analyze critical information that allows WorldCorp to
effectively manage their diverse business. For example, WorldCorp can use a spreadsheet program such as
Microsoft Excel or Google Sheets to summarize quarterly sales information for the sales agents in a particular
region. A more in-depth review by upper management could be centered on analyzing the performance of
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sales agents or regions to set targets for the next year. Spreadsheets can be used to track inventory levels that
then can be evaluated by product type or price. Generated reports can be used by the accounting department
when billing customers and reconciling accounts. Finally, the programs can even be used to make sales
projections or to examine the impact of price changes on profits.

9.1 Microsoft Excel Basics

Learning Objectives
By the end of this section, you will be able to:

• Identify common uses for Excel spreadsheets
• Use basic features of Excel
• Describe the essential functions of each tab on the ribbon
• Differentiate between worksheets and workbooks
• Create worksheets and navigate existing files
• Print a workbook and a worksheet

WorldCorp sells many consumer electronics, including tablets, HD antennas, headphones, and TVs. The
Portland location is in a port city, so it can dispatch orders anywhere in the world, but most of its orders go to
the northern United States and Canada. As you receive more and more orders from clients, you need a
spreadsheet or database to keep all data flowing so that the warehouse knows where the shipment will be
sent, what products are in the order, and how much the total shipment costs. This data, in turn, can be added
to the financial statements in the accounting system, which will help the senior managers analyze the sales
results of the company. Microsoft Excel is a powerful tool that can be used for creating sales order tables.

Common Uses of Spreadsheets
Excel is a spreadsheet software application type that has rows and columns in a grid pattern. A cell is the
intersection of a row and a column, and it looks like a rectangle. You can enter data into the cells to design
tables and graphs and perform data analysis. A workbook is a file that contains at least one worksheet, which
is a tab within a workbook where you can input data and design tables and graphs that use the data (Figure
9.2). The terms worksheet and spreadsheet are interchangeable, but Excel uses the worksheet terminology.

A workbook may contain several worksheets, similar to taking a hard copy of a set of data and adding it to
another hard copy in a file folder. One benefit of using a workbook is that the worksheets within it can
communicate with each other. Having multiple worksheets in one workbook gives you flexibility in organizing
and analyzing your data. Data analysis grows in complexity as a business grows. Even a simple accounting
system for a small business designed in Excel will require many sheets, and each worksheet can feed or
receive data from other worksheets. One workbook can contain all of these worksheets together, as in a
manila file folder.
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Figure 9.2 An Excel workbook contains individual worksheets made up of cells. (Used with permission from Microsoft)

The cells are named based on their location. For example, the upper-left cell is in column A and row 1, so Excel
designates its address relative to the other cells in the worksheet, or its cell reference, as A1. You can use
these cell references to perform operations that use either formulas or functions. A formula is a mathematical
operation that may use constants or cell references, or a combination of constants and cell references. All
formulas must begin with “=.” For example, you can calculate 4 + 4 by typing “=4+4” in a cell, or you can add the
contents of cell A1 and 4 by typing “=A1+4” or typing “=” and then clicking on cell A1 and then completing the
formula.

A function is a mathematical or analytical operation that uses words instead of mathematical operators. All
functions must also begin with “=” in Excel. For example, to calculate 4 + 4, you can type “=sum(4,4).” Excel can
do the calculations for you just as you would using a calculator. Excel’s formulas and functions can take the
place of a calculator.

One use for spreadsheets is to create a monthly food budget. You can keep track of how much you spend on
groceries by category and on eating out at restaurants. You could list it by the type of product (i.e., milk) and by
restaurant. Over time, you can use these numbers to determine your average cost for groceries and for eating
out, and you will then be able to predict what you will spend on groceries. This tracking can serve as a control
on your budget and will help you save money in the long run. You can use a similar process for all your
personal finance and family expenses to enable you to create a budget that works for your situation by
tracking expenses.

In business, the same principles apply. If you can track business sales, you will be able to allocate the money
more effectively. In other words, by having a better accounting system and dispatching of orders, a manager
will be able to see where money is being generated. If the manager realizes that a certain product is
generating a higher profit, then the manager can allocate resources to increase the sales of that product. For
example, the company could increase the unit production and hire more sales agents to sell that product,
which in turn will increase distribution venues, such as corporate retail clients that sell the products in their
stores. Not only that, the company may also increase the marketing and advertisement expenses of these
products, to gain new clients. All of these actions stemmed from the tracking of sales and analyzing what
products sell the most units. In all these layers of actions, there will be many worksheets tracking data, such as
an order-dispatching spreadsheet or the unit cost manufacturing sheets.
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LINK TO LEARNING

Mallory is an Australian website that offers career advice and tips to recent college grads or high-school
students about to enter the job market. Read the article that discusses different ways businesses use Excel
(https://openstax.org/r/78ExcelinBus) to learn more.

Basic Features
The most salient Excel feature is the arrangement of cells in columns and rows. The appearance of Excel is
similar to graph paper. You can easily customize the width or height to fit words or numbers in the cells. To
navigate through the cells in the spreadsheet, you can click on the cell and then use the Enter or Return key to
move down to the next row, use the Tab key to move to the next column, or use the arrows on your keyboard
to move around the worksheet.

Spreadsheets are designed for data analysis. Each cell has its own integrated calculators that automatically
compute the result when you type in a formula or function. Another major benefit to Excel is that you can
quickly and easily copy an equation into other cells, so that you do not have to retype it. Excel has many other
features that can save you time over using a calculator.

To demonstrate how efficient Excel can be in organizing and analyzing data, let’s look at an order-dispatching
spreadsheet (Figure 9.3). Each row represents one order, and each column represents a different characteristic
of the order, identified by the labels in the top row (called the headers), with the data separated into different
cells.

Figure 9.3 Separating data by columns makes it easier to analyze and perform calculations with the data. (Used with permission
from Microsoft)

Separating the data by columns serves multiple purposes. First, it allows a user to organize the information by
any one or more of the columns. For example, you could organize the data by date, as shown in Figure 9.3 or
by destination. You can also keep different types of data, such as item description (column D) and price per
unit (column G), separated. That way, if the price per unit changed, it could be updated quickly and easily.
Further, if they were combined in a single column, you would be unable to use formulas to do calculations,
because Excel cannot perform calculations when there are both letters and numbers in a cell. Excel recognizes
numerals for calculations but cannot perform calculations with words or letters, just as a calculator cannot
calculate letters. Another benefit of separating data into categories by column is that each column can later
become a graph and help the user visually analyze the information.

The data in column E and column G in Figure 9.3 are not linked to other columns; in other words, they do not
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contain formulas or functions but are raw quantities entered into the spreadsheet. Column H, however, is a
quantity based on the data in columns E and G. The FOB $ is the number of products (column E) multiplied by
the price per unit (column G). The formula is displayed at the top of the Excel worksheet in the Formula Bar,
which is next to the “fx ” symbol. You can see in the Formula Bar in Figure 9.4 that the formula is “=E2*G2,” yet
the cell displays the result of the multiplication. The “*” is the mathematical symbol Excel uses for
multiplication. This simple multiplication formula shows how Excel calculates numbers.

Figure 9.4 Clicking on a cell reveals the formula above the headers in the Formula Bar, while the result of the calculation shows in the
cell. (Used with permission from Microsoft)

In order to apply this calculation to the rest of the data, you can repeat the formula in other cells in the same
column. In Figure 9.5a, all data has been removed from column H, except for the first cell, which contains our
formula “=E2*G2.” The easiest way to repeat the formula is to use AutoFill. Place the cursor on the lower-right
corner of the cell, until the cursor changes to a black cross. Then, click and drag the cross to the end of your
column of data, which copies the formula into each cell. Figure 9.5b shows the result of dragging the formula
from H2 to H18. AutoFill is also a useful feature for repeating text. The text could be a static value, such as
when you enter multiple orders that contain the same item, or a time value, such as months of the year or
days of the week. You can simply type in “January” and then use AutoFill to drag across or down to fill in the
rest of the months. This method works for dates, days of the week, other text such as Quarter 1 and Quarter 2,
and nearly any pattern of numbers (i.e., odd numbers or counting by 5). When using AutoFill for a pattern of
numbers or text you want to repeat, you need to select enough of the pattern so that Excel can recognize the
repetition. For example, if you want to generate a list of numbers counting up by 5, you will need to select at
least the cells that contain 5 and 10 so that Excel understands you want to increase the value in each row in
the AutoFill by 5.

Figure 9.5 The AutoFill feature is useful to get the results without retyping or copying and pasting the formula. (a) Column H is
empty, except for the first cell, which contains the formula, as seen in the Formula Bar. Clicking and dragging the formula to the end
of the column automatically applies the same formula to subsequent rows. (b) By dragging the formula down the column using the
AutoFill feature (small black cross sign in the lower-right corner of a cell), the values are calculated for each row. (Used with
permission from Microsoft)

MAC TIP

On a Mac, you can simply double-click on the cross, and the formula will copy down the column to the last
row that contains data.
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The Ribbon
As you recall from Essentials of Software Applications for Business, Excel’s interface includes a ribbon of
commands, grouped into categories that are similar across Microsoft Office programs. The Home tab for Excel
(Figure 9.6a) has commands such as conditional formatting and inserting/deleting columns or cells. The Insert
tab (Figure 9.6b) includes inserting a chart or equation, which is not included on the Insert tab of other
programs such as Microsoft Word. The Formulas (Figure 9.6c) and Data (Figure 9.6d) tabs are specific to Excel.
These tabs include commands for analyzing data in various ways.

Figure 9.6 The Excel interface uses a ribbon to organize commands into tabs, which include (a) the Home tab and (b) the Insert tab,
which are similar to other Office programs. The Excel ribbon also includes tabs specific to Excel, including (c) the Formulas tab, and
(d) the Data tab. (Used with permission from Microsoft)

Creating Worksheets and Navigating Existing Files
Now that you understand how to navigate a worksheet, let’s see how to apply this skill. Suppose you need to
build sales figures of different retail store locations. Each location will have its own worksheet, and then you’ll
add one more sheet to total the sales figures and make a comparison using a table. Figure 9.7a gives the data
for location X. You will need to use the copy-and-paste method to use this table to make the table for location
Y. In the copy-and-paste method, copy text or objects by typing Ctrl+C (or right-click to Copy or use the
Clipboard command group on the Home tab), and then typing Ctrl+V to paste the text or object in the new
area. To use this procedure in this workbook, follow these steps:

1. Highlight the table, as shown in Figure 9.7a.
2. Press Ctrl+C to copy the table.
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3. Create a new sheet by clicking on the circled plus sign at the bottom of the worksheet.
4. Click on cell A1.
5. Press Ctrl+V to paste the table into your new sheet.

This process copies the table exactly, so you will need to change the data so that it reflects the sales figures of
location Y using the sales figures received from the finance department.

MAC TIP

Macs use a Command key, whereas PCs use a Ctrl (control) key. These keyboard shortcuts on a Mac are
Command+C to copy and Command+V to paste. Mac also uses Ctrl+click to bring up the right-click menu
Windows uses.

Data that you provide or that is provided to you is often raw data, and designing a worksheet or even a
workbook helps to organize it. Replace the data from location X with the data from location Y and change the
location, as shown in Figure 9.7b. Using the copy-and-paste procedure saves time when dealing with the same
or similar scenarios because it eliminates the need to create a new table from scratch. Note, however, that this
process works with cells that contain numbers and not formulas; copying and pasting tables with formulas
requires additional work after the initial copy and paste to retain the correct formulas and cell references.

Figure 9.7 The copy-and-paste process makes it easy to create multiple tables that are similar to each other. Start with a formatted
data table for location X. (a) Highlight (select) the table and copy it. Notice the dotted line around the selection to show that it has
been copied. (b) Paste the table in a new worksheet and update it with the data for location Y. (Used with permission from Microsoft)

Now, replicate the steps for location Z: copy and paste the table, and then retype the real data. Next, focus on
creating the final sheet that displays the totals. In the workbook, this would be “Sheet 4.” Because the
summary table needs to be a similar structure to the other tables, you can copy and paste the same table here,
but you will need to modify Column D so that it adds up the units sold in each location. However, the summary
table will need to use the data from Sheets 1, 2, and 3.

To calculate the totals, you need an addition formula. Follow the same process used previously to insert a
formula. First, in cell D2, type “=,” which tells Excel that a formula or a function is being entered. Next, click on
the tab for Sheet 1 and then on cell D2 in that sheet (Figure 9.8a). Then, type the operator (in this case +), and
then repeat the process for the appropriate cells in Sheets 2 and 3. When finished, press Enter, and Excel will
display the total in the cell. Notice in the syntax that Excel has inserted “Sheet1!” before the cell designation in
the first part of the formula. This tells Excel that it needs to use the contents of cell D2 in Sheet 1 for that
portion of the calculation. The next element is “Sheet2!D2,” which is cell D2 in Sheet 2.
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Figure 9.8 Excel allows formulas to reference data appearing on any worksheet in the workbook. To create a total of the number of
units sold at each location, begin the equation with an equals sign. (a) Then, click on the relevant cell in the first worksheet. Insert the
mathematical operator and click on another cell you want in the formula. The formula shows the references to other worksheets.
AutoFill can complete the table with formulas that reference the relevant cells. (b) The completed table uses data from other
worksheets. (Used with permission from Microsoft)

Now that the formula is in place for cell D2, use the AutoFill feature to apply the formula to subsequent rows.
Highlight cell D2, click on the cross, and drag it to the bottom of the table. If you then click on cell D3, for
example, you will see that the formula has been repeated but references cells D3 in the other sheets. Figure
9.8b shows the completed table.

This summary table can be very useful. In addition to providing a straightforward list of the totals, you could
create graphs using this data and have a visual representation of sales trends. This is a simple scenario
assumption; in the real-world sales totals, you would have much more than just five TV models. Imagine
adding all the unit and dollar sale figures of three Best Buy locations in a given city; there would be hundreds
of different products. You will learn increased complexity that will help in analyzing real-world problems such
as this as your knowledge of Excel grows. The sorting and filtering feature is covered in Data Tables and
Ranges, where you will learn how to set up a condition and a criterion to hide or show values for analysis.

Printing Worksheets
Excel offers two options for printing: either printing each worksheet separately or printing the whole
workbook. To do either, first go to the File tab, and then click on Print (Figure 9.9). The default is to print only
the currently opened worksheet, so we’ll do that first. Choose the number of copies you want for this page,
then choose the correct printer. There are other options for printing, include changing the size of the paper,
changing vertical or horizontal orientation of the paper, adjusting the margins, and regulating the scaling (i.e.,
zooming in or not while printing). Once you have chosen your settings, click on the Print icon, and Sheet 1 will
come out of the printer. Different printers might have different options for you to choose from.
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Figure 9.9 The options for printing are on the File tab. Click on Print. To print only a worksheet, leave the default selection of Print
Active Sheets and make any necessary changes to the options. To print the whole workbook, select Print Entire Workbook from the
first menu in the Settings. On a Mac, the steps are the same, but the appearance will differ slightly. (Used with permission from
Microsoft)

It is important to note that, when constructing spreadsheets, what you see on the computer screen is rarely
how it looks when you actually print the workbook. When you have large spreadsheets with multiple rows or
columns, they may not always fit within the bounds of the printed page. When you print the document, the
result could be columns of data split oddly across several pages. Be sure to preview the printed version prior to
printing. When you select Print, you will see the print preview on the right of the screen. Double-check that the
columns and rows are displayed in the way you would like them to print. If not, you can change the margins of
the worksheet or insert a page break as appropriate to print a final, professional workbook. More will be
covered about formatting the worksheets and workbook in Formatting and Templates in Excel.

MAC TIP

You can get to the Print menu with Command+P, but you can also use the File tab at the top of the window.
There is a separate menu in the File menu to set your print area, and you can select which worksheets to
print from the Print menu.

If you want to print all the sheets in the workbook, select Print Entire Workbook from the drop-down menu
under Settings (Figure 9.9). Then, click on the Print icon, and this time all the worksheets will be printed
(including any blank worksheets that are in the workbook), instead of individual worksheets.
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REAL-WORLD APPLICATION

Using Excel for Personal Finance

Excel is a powerful tool for business; however, it can also be a very useful tool for managing personal
finances. You can set up Excel to manage all your personal finances, link bank accounts and other financial
documents, help with managing documentation for income taxes, and perform many other personal
finance tasks. Excel has all the features needed to set up a budget and manage personal and projected
income, track expenditures, and analyze investments and other personal revenue trends. You will want to
organize your financial information into separate functional worksheets within your budget workbook to
ensure you keep your finances organized from the start. For instance, consider keeping separate
worksheets to record income, expenditures, savings, and investments. You can start small as you grow in
your comfort level in using Excel to record your financial transactions; for instance, you might want to start
with a weekly or monthly expenditure sheet to track what you spend your money on, then move into
savings and tracking interest accrued. This disciplined approach will ensure data is recorded in a timely
manner, reducing the potential for missed information and errors, ultimately helping you maximize your
dollars. What’s more, there are a number of free templates available online and through Microsoft to help
set up your budget workbook with little effort.

What software or other tools do you use now to help you track your budget? Do a Google or template
search in Excel and identify a budget template you might adopt. Once you find one you like, set up your
monthly budget.

9.2 Text and Numbers in Microsoft Excel

Learning Objectives
By the end of this section, you will be able to:

• Explain the basics of data and data analysis
• Enter and format numeric data in a worksheet cell
• Use the Text and General formats for cell data
• Use the commands in the Page Layout and Review tabs

WorldCorp receives many orders every day, and they rely on databases for recording all data. Large
corporations like WorldCorp also keep an inventory of direct materials for manufacturing. These materials,
such as bolts and screws, come from many suppliers on multiple orders. They need to store all this inventory
information in the accounting system. Finished products—the products that the company packages for
shipping and sells—are built with various components and parts, and they record a list of all this information
for every item that is manufactured. When a client places an order from a sales agent, these transactions are
recorded in a customer relationship management (CRM) database. Although many large corporations use
Oracle or SAP databases, many other software companies furnish solutions to big, medium, and small
organizations. Medium-sized companies may use Microsoft Access and/or Microsoft Dynamics for their
database purposes and for the financial accounting. Organizations of all sizes can utilize Microsoft Excel.

Here, you will learn some of the basic sales order database capabilities in Excel. For WorldCorp, Excel is an
appropriate tool to gather, organize, and analyze information within the smaller business units such as by
region or product line. The company-wide information might be stored in another type of program suited for
large corporations, but at the business-unit level, Excel can be a powerful tool to feed into the corporate
information database.
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Data Fundamentals
For the purpose of spreadsheet programs, data can be textual (such as a product description) or numerical
(such as a price per unit), and it represents what an organization has determined is valuable. If you decide to
compare the prices of oranges at different grocery stores, then you are researching and creating data. You can
write your data on paper, but a more efficient and common method today for capturing and storing data is
with computers. Data is collected primarily to use later in data analysis, a scientific discipline that uses
mathematical and statistical tools to measure trends. For example, a company could track the sales trends of
three locations over the span of a few months. Watching the data could reveal slumps in sales, which could
trigger the company to introduce a corrective action.

There are different kinds of data that businesses like to collect from their clients. Demographic data can
segment a growing list of clients so that a company can give them better service based on their likes or
dislikes. Financial and accounting data can keep track of a business’s sales, unit costs, overhead costs, and so
on. In addition to client data, machines are constantly generating data related to their performance. All
manufacturing plants have machines that output data to computers for engineers and managers to analyze.

Excel can manage many types of datasets but works better when the dataset is relatively small. Access
databases are appropriate for large sets of data or data that will continue to grow. There are other industrial-
sized data storage and analysis solutions like SAP and Oracle, as well as others that might work better for
larger data files. Programs such as Sage and QuickBooks that are specific to accounting and finance provide
additional features for financial analysis that are not offered in Excel.

Entering and Formatting Numeric Data in a Worksheet Cell
The information made of numerals that Excel reads like a calculator to perform mathematical equations is
called numeric data. There are many purposes of numerical values in spreadsheets. The numbers can
represent quantities, currency, dates, time stamps, percentages, and more. Table 9.1 summarizes the
numerical values Excel uses.

Type of
Numerical

Value
Description

Number
Data has two decimal places by default, but you can add or remove them, depending on
what your needs are. It accepts negative numbers as well. You can add a thousands
separator.

Currency

Data has two decimal places by default. It accepts negative numbers and will display them
within parentheses or with a negative sign in red or black font. The thousands separator is
turned on by default. A zero is displayed with two decimal places. Excel adds the appropriate
currency symbol preceding the number, and the numbers are aligned to the right with no
spaces to the edges.

Accounting

Data has two decimal places by default. It accepts negative numbers and will display in
parentheses only. The thousands separator is given. The zeros are displayed as “-”. Excel adds
a currency symbol aligned to the left. The difference between Currency and Accounting is
that with the Accounting format, all currency symbols are aligned.

Table 9.1 Numerical Values in Excel
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Type of
Numerical

Value
Description

Date
Data is displayed in the American format by default (i.e., month/day/year). There are options
to change the location or to change the format to one of many different choices, such as
day/month/year or year/month/day.

Time Data uses the 24-hour clock or AM/PM format by default.

Percentage
Data analyzes the portion of a whole and the data is displayed as a percentage with the %
symbol and no decimal points by default.

Fraction
Data analyzes the portion of a whole and displays the values as in the percentages. You can
convert a fraction to a percentage before entering data.

Scientific

Data can be shortened numbers written in exponential form. To shorten a number, display
the first digit, add a decimal point, and then list the next two digits. Then, add “E” and the
number of zeros the whole number contains. For example, 644362623 would be 6.44E+9.
These truncated forms of numbers are commonly used in all sorts of sciences.

Table 9.1 Numerical Values in Excel

MAC TIP

Percentages are shown with two decimal points by default.

You can choose the type of numerical value appropriate for your data on the Home tab. Figure 9.10 shows the
drop-down menu in the Number command group where you can choose the type of numerical data you have.
You can also access more details about the number type by selecting the arrow in the lower-right corner of the
Number command group. This will open up the Format Cells dialog box that allows you to specify many more
types of number formatting, including the number of decimal places. If you’re starting from a blank
worksheet, you can plan in your mind what kind of values your tables will contain, so that you can design them
to be informative and display logical information. You can even do this prewrite of the table on a piece of
paper, or as you go through the process of designing the document in Excel.
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Figure 9.10 You can format numbers on the Home tab. The Number command group contains several buttons for commonly used
formats and a drop-down menu. The drop-down menu contains an expanded list of common number formats. More options are
available in the Format Cells dialog box. (Used with permission from Microsoft)

The Format Cells dialog box allows you to choose the category and formatting for your cell, based on the data.
For example, you can determine the number of decimal places you want to show with your Accounting data.
You can also use the Custom formatting category. There are numerous complicated formatting options in the
Custom category, such as combining a date with a time, but you can also design your own by modifying an
existing one to meet your needs.

Say a sales report table contains a set of orders and the name of the salesperson who fulfilled them. This
worksheet contains a variety of types of data: dates, text, general, number, accounting, and more. In order to
determine the type of data, click on the cell, and check the drop-down menu in the Number command group.
Figure 9.11 shows that cell A2 is a Date. You can convert any number to currency by selecting a cell and then
clicking on the “$” button on the Home tab.

Figure 9.11 When a worksheet has multiple types of data, make sure to format it as the most appropriate type. Column A is
formatted as a Date. (Used with permission from Microsoft)

Figure 9.12a shows a summary of the sales figures of all agents. You will notice that the first row is shaded
blue and the text is bolded. This is an effective way to differentiate the headings for each column, often
referred to as the column header, title row, or header row. More about formatting cells will be covered in
Formatting and Templates in Excel. For now, to make the header row stand out, you can highlight (select) the
row and use the commands in the Font command group on the Home tab to change the formatting, such as
bolding, shading (fill), or text color.

Figure 9.12a includes a column for each agent’s percentage of the FOB $ total, but by default, Excel formats
cell contents as General, so it displays the calculation as a decimal number. You can format it as a Percentage
by selecting the cell and changing the number format in the drop-down menu or by clicking on the button in
the Number command group. We can use the same process to display the next cell as a fraction. Figure 9.12b
shows the finished table.
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Figure 9.12 By default, Excel formats cells as General, so formatting may require adjustment for numbers to display properly. (a) The
unformatted table shows percentages and fractions as decimals. You can choose the Percentage format for the cells in the
Percentage column. You can choose the Fraction format for the cells in the Fraction column. (b) The formatted table displays the
percentages and fractions correctly. (Used with permission from Microsoft)

Using the Text and General Cell Formats
When your worksheet uses text data, which is information made up of words, letters, numerals, or a
combination of those things, you can use the General or the Text cell format. For example, say you have
salespersons’ names in Text format, and item descriptions in the General format. In a blank worksheet, you
can enter your data using the default General format, and Excel will automatically format it according to the
type of data you’re entering. For example, if you type a date in a cell formatted as General, Excel will identify it
as a date and reformat it accordingly. If Excel detects a number or text, it will remain in the General format.
General formatting is flexible and can accommodate numbers or text. Because Excel may automatically
change the format of your cell contents if you leave the format as General, consider formatting all numbers as
Number or Accounting, as appropriate.

If you format your words or letters as Text, then Excel will not try to autoformat them. Figure 9.13 compares
the same data formatted as Text and formatted as Number. The Text format is flexible in that it can store
numbers, letters, symbols, and words.

Figure 9.13 Numbers can be stored as text data to retain symbols or leading zeros, which are regularly used in some government
reports, identification numbers, and some phone numbers. (Used with permission from Microsoft)

You are not restricted to the autoformatting that occurs when you type your data into a cell with General
formatting. If you enter a number using the General format (Figure 9.14a), but you want the number to display
as currency, for example, simply select the cell or column and then choose Currency from the Number
command group’s drop-down menu (Figure 9.14b). Excel will automatically add the currency symbol and two
decimal places. All cells in a new workbook are by default set to General format, but you can design your tables
with the correct format for your purpose.
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Figure 9.14 The default formatting for cell data is (a) General, but if you change it to (b) Currency, Excel will add two decimal places
and a currency symbol. (Used with permission from Microsoft)

Page Layout and Review Tabs
The Page Layout tab (Figure 9.15) lets the user control the page setup for printing, such as the paper size, the
vertical or horizontal orientation, and the print margins. It also contains the settings for arranging graphical
objects on a worksheet. One of the most useful commands here is the Breaks drop-down menu, where you
can insert page breaks, just like in Microsoft Word, so that when you print your worksheet, the page breaks
occur where you want them to.

Figure 9.15 The Page Layout tab includes commands for page setup and manipulation of objects. (Used with permission from
Microsoft)

The Review tab contains the commands for adding and reviewing comments and activating the track-changes
tool, as shown in Figure 9.16. It also has password protection options, where you can restrict others’ editing
capabilities when you are collaborating on the same project. The spell checker and thesaurus tools are also
included in the Review tab. Your Review tab might look somewhat different based on the version of Excel that
you are using. If these commands are not included on your ribbon, you can add those using the process
outlined in Essentials of Business Software Applications for Business.

Figure 9.16 The Review tab lets you manage comments, sharing settings, and spelling tools. (Used with permission from Microsoft)
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9.3 Calculations and Basic Formulas in Microsoft Excel

Learning Objectives
By the end of this section, you will be able to:

• Create basic formulas
• Add numbers in Excel using a formula or function
• Subtract numbers in Excel using a formula or function
• Multiply numbers in Excel using a formula or function
• Divide numbers in Excel using a formula or function

At WorldCorp, you manage several account teams, each of which has a sales team. Part of your job is to
compare the sales agents’ revenues using some basic data analysis, which you can extend to other
applications in your job. To assess the performance of the agents and the sales team, you will need to create
some basic formulas. These formulas could include the total sales during a specific time period by agent or the
average sales per time period for the whole team. These values can then be used to put together a report of
the performance of your entire team. Upper management compiles the reports from all the teams to
summarize the company’s performance. Using basic formulas in Microsoft Excel expedites the process and
helps management to uniformly analyze the information.

Setting Up Basic Formulas
Now that you have learned how to set up a table or spreadsheet, you can perform calculations on the data.
First, select the cell where you want the calculation to appear. Use the Formula Bar located below the ribbon to
type in the formula or function, starting with the “=” sign (Figure 9.17).

Figure 9.17 Formulas must begin with the “=” sign and contain mathematical operators (i.e., +, -, *, /). (Used with permission from
Microsoft)

Adding Numbers
You have learned the two ways to add quantities in Excel: formulas and functions. We can use WorldCorp’s
sales data to illustrate how to add numbers. Figure 9.18a contains a set of sales data, with a row at the bottom
for the total of all the sales but with the total amount missing. To fill in this empty cell, first, type “=” to open
the calculation procedure. Then, click on the first cell you want to add, type a “+” sign, then click on the next
cell in the column. Continue this process until all the cells you want to add are included. Figure 9.18b shows
the finished formula that includes all the cells in the columns. Notice that Excel adds colors to the cells to help
you follow the formulas.
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Figure 9.18 You can use a formula to find the sum of a set of cells. (a) The table has a cell for the total sales. First, type an “=” sign,
then use the cell references or click on the cells and a plus sign to construct the formula. (b) The finished formula shows all of the
cells referenced. (Used with permission from Microsoft)

When you have a small set of data, or when the numbers you are adding using the “+” operator are not all in
one row or column, using an addition formula may be the best way to find your sum. However, Excel has built-
in shortcuts, such as the SUM function. Functions can often save you time over performing the same
calculations using formulas. Like formulas, functions must begin with an equals sign, but rather than using cell
references to build an equation, you type the function name, in this case, SUM (Figure 9.19). Then, type an
open parenthesis, insert the cell references, separated by commas, and then close the parentheses. You can
click on each cell individually or type its cell reference, as in Figure 9.20, but you’ll notice that this method does
not save time because you are still entering or clicking each cell reference. Functions allow users to reference
individual cells, but they also allow us to choose multiple cells at the same time, which does save time. To
select a range of cells, which is a group of cells that are contiguous, you can type in the function and opening
parenthesis, and then highlight the cells you want to add. You can also type in the range, separating the first
cell and the last cell with a colon. Figure 9.21 shows the range as F3:F11. Functions are often faster to type than
formulas, but sometimes you will need to use both formulas and functions to perform complex calculations.
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Figure 9.19 Functions are time-saving methods for performing calculations on data. To find the sum of a range of cells, type the
equals sign and “SUM.” (Used with permission from Microsoft)

Figure 9.20 Then, choose the cells you want to include. (Used with permission from Microsoft)

Figure 9.21 Using a range, rather than listing individual cells, can save you time. (Used with permission from Microsoft)
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LINK TO LEARNING

The Formula Builder is a tool in Excel that can help you create a function based on your data and your
needs. Read the tutorial on the SUM function (https://openstax.org/r/78SUMTutorial) to learn how to use
the Formula Builder.

Subtracting Numbers
Understanding how to add numbers in Excel makes subtracting them rather intuitive. If you wanted to
subtract many cells in a column, you could type out a long subtraction equation, starting with the equals sign
and using cell references and the hyphen key, for example, “=F3-F4-F5-F6-F7-F8-F9-F10-F11.” Using a new set of
data, you can see in Figure 9.22 that the margin is the price minus the cost. You can carry this formula down
the rows in the same column.

Figure 9.22 Subtraction in Excel uses formulas that are similar to addition formulas, but there is no subtraction function. (Used with
permission from Microsoft)

Multiplying Numbers
With multiplication, formulas and functions start getting more complicated. Sometimes, you may need to
multiply the values of two or more cells, and other times, you may need to multiply a cell value by a constant
value such as a percentage. One may be more efficient than the other, depending on the data. In Figure 9.23,
the price per unit is the same for every row, so you can use cell references to multiply the quantity cell by the
price-per-unit cell. Because this table contains only one product, the unit price does not change, and it can be
tedious to enter the same price for each sale. You can enter the price per unit in the first row and then click
and drag the value to the bottom of your table. Another method would be to simplify your table by eliminating
the price-per-unit column and including the value in the formula Figure 9.24. Condensing a table in this
manner is helpful, especially if you have a large table of data. To construct a multiplication formula, start with
an equals sign and use an asterisk (*) as the mathematical operator.
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Figure 9.23 For multiplication, use cell references to construct formulas. (Used with permission from Microsoft)

Figure 9.24 You can also use constants to construct formulas. (Used with permission from Microsoft)

For multiplication, you can also use the PRODUCT function. Figure 9.25 shows an example of the function
syntax. When you have entered all of the cell references, close the parentheses, and the product will be the
same as it would if you had used a formula.

Figure 9.25 You can use the PRODUCT function for multiplication. (Used with permission from Microsoft)

614 9 • Working with Spreadsheets

Access for free at openstax.org



Dividing Numbers
Division calculations use the operator “/” and follow a similar syntax as other basic mathematical formulas.
Figure 9.26a shows an example of division for determining increases or decreases in prices of aluminum. As
you can see, the gain on 1/10/2021 was 2.36 percent. Excel does have a QUOTIENT function, but it returns only
whole numbers, leaving off the decimal portion of the quotient (Figure 9.26b). It may be useful for some
situations, but formulas provide more exact answers.

Figure 9.26 The division formula uses a slash and returns (a) a quotient with decimal places, but you can format it to be (b) a
percentage. (Used with permission from Microsoft)

9.4 Formatting and Templates in Microsoft Excel

Learning Objectives
By the end of this section, you will be able to:

• Format and manipulate a cell or group of cells
• Design column and row headers
• Use conditional formatting
• Work with templates to format worksheets

At WorldCorp, there is so much data that it is impossible to look at it all at once. For example, on a long
worksheet with several hundred or thousand orders, you might want to see only orders over a certain value. In
the previous sections, you learned how to organize the information in a spreadsheet and analyze the data
using some basic calculations. These calculations provide the information needed to present the data to other
entities in the corporation, but it might not yet be formatted in a professional manner. You may want to ensure
the data meets certain criteria; you might want to add additional formatting to highlight certain trends in the
data or group the data in a different way to show meaningful differences. With the skills you learned in the
previous sections and those to follow, you can create a meaningful report and analysis of the data to
effectively communicate company performance. This report can be utilized to measure company progress
toward strategic goals or to compare WorldCorp to their competitors.

Formatting Cells
We’ve discussed formatting cells according to their contents, such as number, percentage, or text, but
formatting extends to the visual presentation of a worksheet. In this context, formatting involves applying
colors, font types, and borders to cells for styling purposes. It can make a presentation more visually appealing
or distinct from other presentations. Another important reason for formatting is to increase the readability
and comprehension of data. Formatting can be applied to text and numbers, to cell backgrounds, or to cell
borders. It is important to remember that sometimes additional formatting may not be necessary. The goal is
to have a professional presentation of the information. Too much formatting such as bright colors or
distracting fonts does not enhance the presentation of the information. It is advisable to stick to simple
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formatting that is not distracting and is in line with company standards for your corporation.

Using Color and Fonts
Colors and fonts can be used to highlight specific parts of a worksheet such as the header row or the total row
and to indicate the end of a table. Highlighting values that are outside of a certain range or to show trends in a
dataset can also be useful. In accounting, the convention is to have negative numbers in red font and positive
numbers in black font. These uses of colors and fonts provide meaningful information to the user at a glance.

In Figure 9.27a, the current header row is gray with white font. Suppose your manager wants to follow the
color scheme of the company and wants the header row to be highlighted with a blue cell fill and a larger font.
To change the fill color of the cells, first select the cells you want to change (Figure 9.27a) and then click on the
paint bucket in the Font command group on the Home tab. The drop-down arrow next to the bucket allows
you to choose from many preset colors, or you can create your own by clicking on More Colors. For this table,
click on the blue fill box in the middle of the fifth column of colors. Now that the background is blue, the white
font is harder to read, so you should change it to a darker color. To change the color of the font, select the cells
and click on the text icon next to the paint bucket. You can change the font by clicking on the Font drop-down
menu and the size by clicking on the adjacent Font Size drop-down menu (Figure 9.27b). You can also change
the formatting of individual cells, but it saves time to highlight all of the header cells and format them at the
same time.

Figure 9.27 You can easily change the cell fill color, font type, and text color. (a) Select the paint bucket from the Home tab to change
the color of the background fill. A drop-down menu gives you many options or you can define your own color using More Colors. The
new background fill color is more visually appealing, but the text does not stand out as it would in a different color. (b) Font size, type,
and color can also be changed using the commands in the Font command group. (Used with permission from Microsoft)

Borders
The default style in Excel is for gridlines to be visible in order to distinguish one cell from another when viewed
on the screen. However, there may be times when that distinction could be clearer, or you want to divide
groups of columns or rows. You can use borders to make these distinctions. Let’s assume you would like to put
a border around the total cell. To add this border, first select the cell or cells where you want to add a border
(Figure 9.28). Then, from the Home tab, in the Font command group, you will find the Border command drop-
down menu. You can also access this by right-clicking after you selected the cells and choosing Format Cells
and then the Borders tab (Figure 9.29a). By selecting the down arrow of the Border command, you can choose
the appropriate border for the cell or cells. You can change the border style and color. First, select the style and
thickness of the outline, change the color if you want it to be a color other than black, then apply it on the
preview on the right by clicking on each border (Figure 9.29b). You can choose multiple styles of borders or
leave cells without borders, such as if you wanted a border around your table but not within the rows and
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columns. More border options are available by choosing More Borders at the bottom of the list. This will bring
up the Format Cells dialog box, Borders tab. Make sure your header row is now formatted consistently.

Figure 9.28 To add borders, select the cells you want to add a border to. (Used with permission from Microsoft)
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Figure 9.29 (a) You can use the Borders command drop-down menu or right-click and choose Format Cells. (b) You can select various
thickness levels of the border around the cell. (Used with permission from Microsoft)

Wrapping Text
When you are working with text that is long, you can extend the width of your columns to fit it all in. One way
is to do it manually. Hover over the line between two columns. The cursor will change to a black vertical line
with opposite arrows. Click on this line and drag the column to your preferred width. You can also use the
AutoFit command to automatically size the columns to fit the data contained in that column (Figure 9.30a). To
AutoFit the columns, hover over the line between the columns, as you would to do it manually. Then, double-
click on the line, and the column will adjust to the width of the contents. For example, to automatically size
column E to the appropriate size for the data in the column, double-click on the line between the D and F
columns at the top of the spreadsheet.

Sometimes, the text is so long that the whole width of the column is not visible on your screen; other times,
you may not want a column to take up most of the width of your table. In those cases, the text is cut off. In
Figure 9.30a, the header for column E is too long to fit in the cell. To fix this, select the cell, then on the Home
tab, click on Wrap Text. The Wrap Text feature arranges the text in a cell so that it extends onto another line
and increases the height of the row (Figure 9.30b).
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Figure 9.30 Text wrapping can make long text fit in a column. (a) The header for column E is too long for the width of the column.
Double-click or click and drag the line between columns to widen or narrow a column. The Wrap Text feature allows you to see text
that is cut off. (b) Text wrapping changes the height of a row to accommodate long text. (Used with permission from Microsoft)

Merging Cells
Borders provided one method of grouping content in a table, but there are other ways to show that some rows
or columns of data should be grouped together. The merge feature combines the content from two or more
cells. When merging, the content and formatting of the first cell supersedes the content and formatting of the
others. Merging cells can increase the readability of the tables. Figure 9.31a shows a row added above the
header row to group some of the columns together to identify important sales order information to the port
dispatchers. The first two columns tell the port dispatchers when the order was placed, so you want the cell
that says “When” to span both columns. First, add “When” to the first cell. Then, select both cells over the
columns you want the header to span and click on Merge & Center on the Home tab. Figure 9.31b shows the
merged and centered cells. This can be repeated with cells E3 and F3. You can also merge content within a
table. At the bottom, merge cell A14 with cells B14, C14, D14, E14, and F14, to make the Total row more
readable. Now that the merging is complete, you can format the border outlines. Format the top row, making
sure all cell contents are centered and have borders, and add borders to the bottom row to highlight the
totals. Figure 9.31c shows the completed table.
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Figure 9.31 Merging cells is useful for presentation and readability purposes. You can (a) group columns by adding a row above the
header row, merge and center cells to create a new label above the date and time, (b) merge and center cells to group the quantity
and the code, and merge cells next to the total to create a more readable total. You can also add borders. (c) The final table is clear
and readable. (Used with permission from Microsoft)

LINK TO LEARNING

Did you know that you can embed Excel objects and components into other Microsoft applications? You can
insert all or parts of an Excel worksheet into your presentations and documents, saving time from re-
creating the same content in these applications. Embedding content also helps ensure that the content
provided in your document or presentation is accurate, as changes in Excel will update in these files as well.
Visit this Microsoft page that shows how to embed Excel content in PowerPoint (https://openstax.org/r/
78ExcelinPPT) to learn more.

Working with Columns and Rows
The label added to tables at the top of a column or to the left of a row to make the data understandable is
called a header. You’ve already learned to type words at the top of a column and format cells so that the
headers look different from the rest of the table. Fonts can be bolded or centered, and background colors or
shading applied. You can also freeze columns and rows so that the viewer of the document can see the header
even if the document extends beyond the screen. Hiding rows and columns can also be useful for reducing the
size of a worksheet.
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Freezing Columns and Rows
When you have a large set of data, you will need to scroll beyond the edges of your screen to see all of it. You
will need to be able to look at the data in each column or row but scrolling can take the header row or column
off the screen. To ensure that the column or row headers are visible, you can use a command called Freeze
Panes, which fixes the headers on the screen while allowing users to scroll through the rest of the data. The
table in Figure 9.32a extends beyond row 22. As you scroll down through the data, notice that you can no
longer see the column headers, so you will want to freeze the header row so that you can still see the column
headers when you scroll down through the data. Figure 9.32b shows the choices in the Freeze Panes command
on the View tab. You can freeze the top row, the first column, or both. For this data, freeze the top row so that
scrolling down will keep the column headers in view. Figure 9.32b shows a line below the top row that indicates
that the row is frozen. You are not limited to only freezing a header row or column. Excel allows you to use
Freeze Panes anywhere in the spreadsheet. Just click on a cell and then on Freeze Panes, and it will freeze
everything above and to the left of it.

Figure 9.32 Using the Freezing Panes command keeps headers visible when data extends off the screen. (a) Before the header row is
frozen, scrolling down removes the header from view. (b) The Freeze Panes options are found on the View tab. Clicking on Freeze
Panes allows for freezing the top row, first column, or both. Freezing the header row shows a line that indicates the row is frozen and
keeps it in view while scrolling. (Used with permission from Microsoft)
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MAC TIP

On a Mac, Excel uses icons for many of the drop-down menus that appear in the Windows version. The
Freeze tool, for example, is always visible at the top of your active workbook.

LINK TO LEARNING

Go Skills is a company that offers a variety of free or paid online courses. Go to their website to review
presentation tips for Excel tables (https://openstax.org/r/78ExcelPresent) and learn more.

Hiding Columns and Rows
Sometimes when working with data, information may be irrelevant for one use but cannot be deleted. This
could be important when formatting spreadsheets for various users or when performing calculations. A user
might not need to see all the data that goes into the formula but needs to see the final result of the formula.
For example, in Figure 9.32a, column B contains the name of the port, but all of the visible data for the port is
the same. If the port of Portland, Maine, is working with this data, they won’t need to see the column that
contains the port name. Additionally, the workers at the port won’t need to know the price per unit. To make
the table more usable for these workers, you can use the Hide command, which temporarily removes
designated rows or columns from view. To hide a row or column, click on the row or column designation (the
number to the left of the row header or the letter above the column header) to select the whole row or
column, then right-click and select Hide from the menu (column B in Figure 9.33a). The result is shown in
Figure 9.33b. To unhide a column, select the two columns that surround the hidden column, right-click, and
select Unhide (Figure 9.34a). The column appears again, as shown in Figure 9.34b.

You can tell when a row or column is hidden by looking at the header, where you can see that letters or
numbers are missing and there are two lines between the column or row designations. For example, we can
see in Figure 9.33b that the header row goes from column A to column C. B is hidden and is not shown as a
header. It is important to watch for that when you are using a spreadsheet that you did not create.

Figure 9.33 Using the Hide command makes rows/columns temporarily not visible in a table. (a) Right-click on the column and select
Hide. (b) When columns are hidden, double lines and skipped letters are indicated in the letter designation header. (Used with
permission from Microsoft)
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Figure 9.34 (a) To reveal the columns again, select the two columns on either side of the hidden one, right-click, and select Unhide.
(b) All columns are visible again. (Used with permission from Microsoft)

MAC TIP

To access the Hide function, hold the Control key and click on the column.

Conditional Formatting
All of the formatting you have learned about so far has involved manually configuring individual cells or
groups of cells. Excel has additional formatting features that can save you the time of manual formatting. One
of these features, conditional formatting, analyzes the cell contents and applies certain preset designs or
layouts based on the content. One example is to change the color of the font if the data is above or below a
certain threshold (Figure 9.35). Conditional formatting is not turned on by default, so you will need to apply
and customize it. Click on the drop-down menu next to Conditional Formatting on the Home tab and choose
the formatting you want to use. You can set up the parameters using the dialog box shown in Figure 9.36a.
Figure 9.36b shows another example of conditional formatting: highlighting the top ten FOB $ values.
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Figure 9.35 Conditional formatting automatically applies designated formatting to values that meet a certain criterion. The
Conditional Formatting drop-down menu lists several commonly used choices. (Used with permission from Microsoft)

Figure 9.36 (a) The dialog box allows you to set the parameters. (b) There are numerous preset conditional formatting choices. (Used
with permission from Microsoft)
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REAL-WORLD APPLICATION

Excel in the Construction Industry

The construction industry in the United States employs nearly ten million people and contributes over $1
trillion to the economy in structures built each year.1 Excel can manage all the information needed to share
among the various entities involved in a construction project. From building a small home garden shed to
constructing an office complex, Excel can help manage the overall progress of a construction project. Excel
can be helpful when estimating costs for construction projects to submit bids for particular projects. Items
that can be summarized, tracked, and analyzed in Excel include order tracking, calculating needed
quantities of materials such as lumber or piping, and payroll. Even for the small construction management
company, Excel can be used to effectively manage a large construction project to keep the project on time
and within budget. There are many templates available to help set up a construction project from start to
finish.

What are some other industries where Excel could be a useful tool?

Working with Templates
As in the other Office applications, Excel has built-in and online templates. Microsoft has their own online
templates for Office (https://openstax.org/r/78OfficeTempl), but many other websites offer free Excel
templates. Templates are blank, formatted workbooks that you populate with your own data. Microsoft
provides some built-in templates. Figure 9.37 shows the selection of a sales report, which has five sheets. This
sales report has an order ledger, called “Sales Data,” with the product name, customer code, and quarterly
sales figures. The template comes with a few lines of generic data. The other sheets use the data you enter on
the first sheet. The second sheet uses the sales data but organizes it by product. The third sheet organizes the
same data by customer. The fourth sheet filters the data to show the top 10 products, and the fifth sheet filters
the data to show the top 10 customers. You should be able to find a similar template in your version of Excel,
but there are many other sales reports templates available. The template library is frequently updated by
Microsoft, so the versions you see might look a bit different than what we have shown here. The functionality
will be similar, but the colors and the layout could vary.

1 Ken Simonson. “Construction Data.” Associated General Contractors of America.
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Figure 9.37 Templates are preformatted and predesigned tables. You can find the templates by clicking on File and New. A sales
report has formatting and formulas preset so that all you need to do is enter your data. (Used with permission from Microsoft)

Figure 9.38 shows a product price list downloaded from http://templates.office.com (https://openstax.org/r/
78OfficeTempl) that has columns for a product inventory number, product name, product description, retail
price, and volume-selling price. This sort of price list is an information sheet for potential business clients who
are considering products from you. These templates are modifiable, so you can update the header with your
company’s information. You can also add more products or change the headers.

Figure 9.38 Although templates come with their own formatting, you can customize them based on your needs. (Used with
permission from Microsoft)
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SPOTLIGHT ON ETHICS

Ethical Considerations in Using Templates

Templates are a wonderful resource and can save time and money in creating spreadsheets and workbooks
in Excel. Templates can come with preset formatting and formulas, with little more to do than enter your
own data. There are many templates available online, but you must choose one carefully. You will need to
consider the purpose of the template you are using, company policy regarding branding, the version of the
software you are using, as well as copyright and licensing of the template itself prior to using it for business
purposes. For instance, perhaps you are using a template to create an invoice to provide clients. The
template may hold a license that allows you to use the template for commercial use so long as you do not
resell the template itself, or the license might prohibit commercial use altogether, restricting its use to
nonprofit activities only. If that is the case, you should not use the template for business purposes as it may
place the business at risk of litigation. It is always best to carefully read the user agreement and license of a
template prior to implementing it.

Where might you find a template’s licensing and permissible usage information? How can you be sure you
are permitted to use a template in the manner in which you intend?

9.5 Google Sheets Basics

Learning Objectives
By the end of this section, you will be able to:

• Identify common uses and basic features of Google Sheets
• Describe the essential functions of each command group on the toolbar
• Create a worksheet in Google Sheets
• Open an existing workbook in Google Sheets
• Print a Google Sheets file

Google Sheets is another spreadsheet application that has much of the same functionality as Microsoft Excel.
They have similar GUIs, in that they use window menus and a toolbar. Excel has the ribbon, which has wide
tabs filled with commands. Sheets only has one toolbar menu, although its button commands grow over time
as the product is updated. Sheets contains all the same basic features as Excel, but Excel is more robust with
regard to higher-level tools.

Common Uses and Basic Features
Sheets serves the same basic purposes as Excel and can be used for most of the same purposes that any
spreadsheet could serve. Google Workspace is a web-based service and does not have desktop versions like
Microsoft Office. Because of this, there are some limitations to the functionality of Sheets compared with Excel.
To access Sheets, you need to have internet access and a Gmail account.

The basic features are the same as any other spreadsheet program. Similar to Excel, Sheets has rows and
columns in an interface that does calculations for the user. It has automated features like autofill and easy
copying of formatting. You can create all tables you’ve created in Excel in Sheets, including your order-
dispatching worksheets or sales reports. Sheets also requires you to separate the values in each column so
that the spreadsheet can read the numbers and calculate the desired result. Words and letters should be
separated from numbers in order for spreadsheets to use the numbers for calculations. Sheets doesn’t have
the same library of functions that you can find in Excel. On its own, Sheets may not be able to handle in-depth
analysis like Excel can.
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The Toolbar Overview
Sheets does not have any ribbon tabs like Excel. Instead, the toolbar is composed of menus and commands.
The menu options are similar to those you see in Excel in the ribbon tabs. The menus are as follows: File, Edit,
View, Insert, Format, Data, Tools, and Extensions. To view the contents in the menu, simply hover over the
menu title with your cursor. The File and Edit menus are similar to those for Google Docs, as covered in
Essentials of Google Workspace. The View menu gives the user the ability to freeze and group cells together.
Inserting and deleting cells can be accessed in the Insert menu. The data and text can be formatted using the
commands contained in the Format menu. The Data menu includes commands similar to the Data tab in Excel
that are useful for analyzing data in a spreadsheet. The Tools menu is like the Review tab in Excel with spelling
and grammar checking commands. Advanced features are in the Extensions menu.

The toolbar is called the action bar, and it mostly remains static, yet sometimes it adds functions based on
usage. Figure 9.39 shows the toolbar. In addition to the menus, the toolbar includes buttons for the more
frequently used commands for easy access. These commands can be accessed through the menus, but here
they are available with one click. You will notice there is some similarity in the look of the icons in Sheets and
Excel. The first two commands are Undo and Redo, then Print, and Paint format. After that, you see the Zoom
drop-down menu, the Format as currency, Format as percent, Decrease decimal places or Increase decimal
places, and more formats. Next are the menus for the font type and size, font formatting, border lines,
alignment, text wrapping, and text rotation. The last group includes linking, commenting, and adding a graph,
filter, or function.

Figure 9.39 The toolbar in Sheets has one row of commands. (Google Sheets is a trademark of Google LLC.)

MAC TIP

On a Mac, the Google Sheets action bar shows the menu, like on a PC. However, rather than simply
hovering, you will need to click on the menu title to see its contents.

Creating Sheets
Figure 9.40 shows a finished sales report, much like an Excel worksheet. As in Excel, when you open Sheets,
there is only one worksheet, called “Sheet1.” To add another sheet, you can click on the plus sign at the bottom
left. This will add another sheet called “Sheet2.” Let’s walk through the steps to create this table in Sheets. Let’s
assume that you have handwritten invoices of a set of orders, and you want to enter these invoices in Excel or
Sheets. The receipt-block pads are customized with a unique receipt number, your company logo, contact data,
and other business information. These were popular before small and medium businesses started to use
computerized receipts, yet you may still see these handwritten receipts sometimes. In such a case, after the
sale has occurred, you need to input the data into Excel or Sheets.

The first step in re-creating the table in Figure 9.40 is to insert and format the headers in a blank worksheet.
Then, select the first 20 rows below the headers, since the table has 20 rows of data (Figure 9.41), click on the
Borders drop-down menu, and choose All Borders. Next, change the format type for each column based on
the contents of the column (Figure 9.42). For cells A2 to A21, use the Date format under the More Formats
drop-down menu. Format cells B2 to B21 and C2 to C21 as Plain Text. You can leave cells D2 to D21 as
Automatic or change them to Plain Text. Format cells E2 to E21 and G2 to G21 as Accounting. Automatic as a
format type is the equivalent of “General” in Excel. To select two columns that are not contiguous, select the
first one, in this case E, then press Ctrl on the keyboard, and select G. This is called the Ctrl+Select process. For
column F, you can leave it as Automatic or format it as a number. Now, you are ready to do the data entry of
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the manual invoicing. You will format the header after entering the data.

Figure 9.40 Formatting a normal sales report table in Sheets is similar to formatting in Excel. The table contains different types of
data. First, create the headers. (Google Sheets is a trademark of Google LLC.)

Figure 9.41 Then, highlight the cells you will be filling in to add borders. (Google Sheets is a trademark of Google LLC.)
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Figure 9.42 Format each column according to the type of data it will contain. The first column is a date, so you can choose Date from
the menu. The next two columns can be formatted as plain text. Columns E and G can be formatted as Accounting. You can use
Ctrl+Select to format both of them at the same time. (Google Sheets is a trademark of Google LLC.)

Next, enter the data in row 2, and follow the same steps for subsequent rows. The first several columns only
require typing in data from the data source. The first order was placed on February 27, 2021, for 14 model
E-900s 32-inch LCD TVs for $170 each. First, enter the date as 02-27-21 (Figure 9.43a). Because we selected the
format in advance, it will automatically be formatted to the desired format of 02/27/2021. Fill in the rest of the
data from the order across the row (Figure 9.43b). The price is already in accounting format, so you do not
need to type the currency symbol. The Revenue, column G, is the product of the price and the quantity, so type
in a formula, “=E2*F2” (Figure 9.43b).

Figure 9.43 First, populate the first row of the table. (a) The date should automatically be formatted as month/day/year. The rest of
the data can be copied from the order. (b) The revenue cell needs a formula so that it calculates the product of the price and the
quantity. Notice the date is formatted correctly once you press Enter or navigate to another cell. (Google Sheets is a trademark of
Google LLC.)

Now that the first row is finished, you will adjust the width of each column to accommodate the data so it looks
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like the original table. Place your cursor on the edge of column A, and the cursor will change to an arrow
(Figure 9.44a), then double-click it. The column automatically adjusts to the width of the contents. To do this
with a single action, highlight the entire table and then double-click between any two columns. This will apply
the AutoFit function to all columns you have selected (highlighted). When you do this for all columns, the
columns all have different widths (Figure 9.44b). Finally, to format the header row, select the whole row and
click on the Fill color command, choosing a similar color, as shown in Figure 9.45.

Figure 9.44 After entering a row of data, you can do the final formatting of the table. (a) Double-click at the edge of a column to
change the width automatically. (b) Repeat this process for all columns. (Google Sheets is a trademark of Google LLC.)

Figure 9.45 You can change the white fill color of the header row to match the original table by choosing blue from the Fill color
command. (Google Sheets is a trademark of Google LLC.)

Navigating Existing Sheets
To open existing sheets, you start from Google Drive. Sign into your Drive account, then browse through your
files to look for the existing workbooks. Double-click on an existing Sheets file, and it will open in a new
browser tab. Figure 9.46 shows several files in Google Drive. You will need to recognize the icon for Sheets to
know which are workbooks. The icon for Sheets is green. Sheets can also open Excel files. To browse for the
saved Excel files not found in your Google Drive, choose Upload.
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Figure 9.46 To open a Sheets file from Google Drive, you need to recognize the icon for spreadsheets. The first arrow points to an
Excel file, and the second arrow points to a Sheets file. Sheets can open both types. (Google Sheets is a trademark of Google LLC.)

SPOTLIGHT ON ETHICS

Maintaining Accountability with Version History

In order to open Docs or Sheets, you will need to create or log in to your Google account. Every time you
make a change to a file, Google Workspace uses your username to track it. If multiple people have been
given access to open or edit the file, Google tracks these changes. You can review the changes different
collaborators in your company make to a file using the Version History feature located near the bottom of
the File menu. Version history is tracked from file creation. If a user has editing privileges for a document,
they can see the version history. You can also filter changes by date to see what users changed on a specific
date. You can check what changes any coworker made in the document. Having access to the version
history of the document protects the integrity of collaborating with others by establishing accountability.
Changes to the file cannot be made without other collaborators knowing that changes have been made.
This allows transparency of information flow between collaborators. This can become important in tracking
down errors in the file and can guide you if you need to revert to an earlier version of a document. It is also
an important feature that helps collaboration when the individuals are not in the same location.

Printing Sheets
The process for printing worksheets in Sheets is the same as it is in Excel. Choose Print from the File menu
(Figure 9.47a). The dialog box that opens (Figure 9.47b) lets you choose the print settings, such as page setup,
range of pages to print, and zoom level, just like in Excel. The Print dialog box allows you to adjust the margins
and add page breaks to make sure the spreadsheet prints as you would like. To adjust the margins, choose the
Margins menu from the right side of the display. To add page breaks, choose Set Custom Page Breaks and
move the lines to the desired location for the page breaks. Then, choose Confirm Breaks in the upper-right
corner. You can also choose to print the active worksheet or the whole workbook. The whole workbook choice
is shown in Figure 9.47b. When you click Next, Sheets will generate a preview of the file you are printing.
Typically, your printer is listed as the default destination for printing. Choose the down arrow to choose your
printer if it is not automatically listed. You can also generate a .pdf file, which you can save and then download
from the browser into your computer. You can then open the .pdf file in Adobe Acrobat or any other .pdf
viewer, such as Microsoft Edge, and print it there.
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Figure 9.47 Printing from Sheets is similar to printing from Excel. (a) Select Print from the File menu. You can print the current sheet.
(b) You can also print the entire workbook. Choose your printer from the Destination drop-down menu or save the file as a .pdf.
(Google Sheets is a trademark of Google LLC.)

9.6 Text and Numbers in Google Sheets

Learning Objectives
By the end of this section, you will be able to:

• Use the insert and copy-and-paste functions in Google Sheets
• Enter numeric and text data in a Sheets cell
• Create basic graphs from numeric and text data
• Use page layout and review features

There is a great need for text and numeric data in databases. For example, in WorldCorp’s database, the
client’s surnames and given names are in two separate text data columns. The address, city, and state are each
in their own text columns, too. The zip code and telephone may be in text format. This is because these values
are numerical, but they are not used to perform any calculations. They are instead providing information
about the client. Order quantity may be a number, and total dollar value per client is in accounting format.
Sheets can handle large datasets in a similar manner to Excel. The cell formatting in Sheets is similar to that of
Excel. Sometimes it is more a matter of company and/or personal preference. Some companies may be used
to using Sheets for collaboration and information sharing, or a user might prefer the Sheets GUI over Excel.
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One drawback of Sheets is that it offers fewer options for charts and graphs than Excel.

Using the Copy-and-Paste and Insert Functions
Before learning to design and build a table from a blank worksheet, you need to understand how to use
formatting from an existing table, as with Excel. Say a table to be copied to a new blank worksheet. Follow the
same basic procedure as with Excel. First, select the table (Figure 9.48), then choose Copy from the Edit menu
or press Ctrl+C on the keyboard. Next, go to the new worksheet and choose Paste from the Edit menu or press
Ctrl+V. There will be are a few minor differences between your new table and the original. For example, the
column widths of the original were adjusted to their contents, whereas in the pasted table, all columns have
the same width. To adjust the widths, you can double-click on the edges of the header row between two
columns you want to adjust.

MAC TIP

As in Excel, Mac uses the Command key instead of the Control key, so the shortcut for copy is Command+C
and the shortcut for paste is Command+V.

You have now created a new table using the formatting of an existing table, but the table isn’t exactly what we
need. Your manager asks you to add a new column between existing columns for the destination. To do this,
first click on the top of column C to highlight the whole column, because you will insert the new column to its
left. Then, click on the Insert menu to select Column Left (Figure 9.49a), which will insert a blank column
(Figure 9.49b) where you can input your new data.

Figure 9.48 Using the formatting of an existing table can make it easier to create a new one. The table being copied has formatted
headers and cells. First, highlight the table and copy it. Then, paste it into the new workbook. Since the columns are all the same size,
they need to be resized. (Google Sheets is a trademark of Google LLC.)
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Figure 9.49 (a) Insert a column to the left of the item description. (b) The empty column keeps the visual formatting in the header.
Then, you can enter the data in the new column. (Google Sheets is a trademark of Google LLC.)

Working with Numeric and Text Data in a Sheets Cell
Copying the formatting from an existing table is helpful, but it is not always an option. In some cases, you will
need to create a table from scratch. The first step is to establish the headers in the first row (Figure 9.50a).
Based on the headers, you can then choose the most appropriate format for the data (Figure 9.50b).
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Figure 9.50 Creating a table from scratch requires many steps. First, enter your headers in the first row. (a) Then, format each
column for the type of data it will contain. Adjust the column width when necessary. Format your header row by bolding and
centering the content. (b) Finally, add the background fill from the custom color menu. (Google Sheets is a trademark of Google LLC.)

The format types Sheets uses are similar to the ones Excel uses. Table 9.3 compares the formats between
Sheets and Excel. The names differ slightly, but many mean almost the same thing. There are minor
differences like the order the format types appear in the menu, and there are some formats that are unique to
Sheets. Sheets has the Financial, Currency rounded, Date time, and Duration formats that are not available in
Excel.
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Type of Numerical Value Difference Compared to Excel

Number Same as Excel

Percentage Same as Excel

Scientific Same as Excel

Accounting Same as Excel

Financial Similar to Accounting, but without the currency symbol

Currency Same as Excel

Currency rounded Similar to Currency, but with no decimals

Date Same as Excel

Time Same as Excel

Date time Similar to Date and Time but together in one cell

Duration Unique to Sheets; a new way to measure time

Table 9.3 Data Formats in Google Sheets Compared with Excel

Once you have your headers in place, you can apply the appropriate format to the cells below. Select all of
column A and go to the More formats drop-down menu, and use the Date format (Figure 9.50a). You can set
the next three columns as Plain Text and leave columns E and F as Automatic format. Set column G as
Accounting. Then, you can fill in the table by adding each order. With all of the data entered, you can make any
final formatting changes. First, adjust the width of the columns by double-clicking at the edge of each column.
Next, drag the edge of column F to make it narrower so that the header has one word per line. Then, center
align and apply bold font on all headers. Finally, apply the background color from the Custom set of colors,
which shows recently used colors (Figure 9.50b).

Using Numeric and Text Data to Create Basic Graphs
To create a chart or graph in Sheets, the process is slightly different from Excel. First, select the data as you
would do when creating a graph or chart in Excel. Then, go to the Insert menu and choose Chart. The chart will
appear on the screen in the spreadsheet you have created. Google will analyze the type of data and choose the
chart that seems appropriate for the data you have selected. The Chart Editor window will appear to the right.
Here, you can adjust the type of chart you want to use and customize the chart with titles and other formatting
options. Use the sales report created in Figure 9.50b to make a graph that compares the FOB $ to the Date. In
other words, it will show the amount of money traded on each day. Sheets analyzes the data before creating
the graph and will manipulate the data to be chronological, if necessary. It will also use its built-in artificial
intelligence to choose the type of graph most appropriate for the data. You can override the graph type Sheets
selects if there is one you feel is more appropriate. PivotTables/Charts goes into more detail about creating
graphs and charts.

To create a basic graph, first select the columns you want to compare (Figure 9.51), using the Ctrl key to select
two noncontiguous columns. Then, click on Insert Chart, and Sheets will create the graph it determines is the
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most appropriate. You can change the type of graph if you prefer a different type. Using the Chart Type drop-
down menu, you can choose a different layout (Figure 9.52). Two other options for this data are a bar chart
with the chronological order inversed, and an area chart, which is similar to the line chart. When choosing any
chart option, Sheets will automatically reorder the dates.

Figure 9.51 Creating graphs in Sheets is simple because of the built-in analysis the application performs. First, choose the columns
you want to compare and click on Insert Chart. Sheets automatically chose a line chart for the data. (Google Sheets is a trademark of
Google LLC.)

Figure 9.52 The Chart Editor sidebar gives other options for the type of chart. Another option for this set of data is a bar chart.
(Google Sheets is a trademark of Google LLC.)

LINK TO LEARNING

The help forums for Sheets contain a short introduction to all the types of graphs you can build. They
describe the use of each of the graphs, previews, and short step-by-step instructions. Go to Google’s
support page on the different graph types (https://openstax.org/r/78GoogleGraph) to learn more.
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Page Layout and Review Menus
Sheets does not have menus that directly compare to the Page Layout and Review tabs in Excel, but it does
have many of the same features. One feature Sheets does not have is Page Setup. The items in the Page Setup
command group such as margins and page orientation are managed in the Print Setting in Google. Similar to
the Themes command group in Excel, Sheets has a Theme option found in the Format menu (Figure 9.53).
Excel’s Page Layout tab also has the Background command that allows you to choose an image for the
background of your worksheet. This feature is partly available in Sheets in the Insert menu, which allows you
to insert an “Image in cell” or “Image over cells” (Figure 9.54a). The result of placing an image in a cell is shown
in Figure 9.54b. The inserted image (either in a cell or over cells) sits on top of the information in the cells,
unlike in Excel, where the image is in the background. The other functions, like moving an object forward or
backward, adding gridlines, or scaling settings, are partly available in Sheets. You can insert objects such as
Google Draw files, Google Forms, charts, and images into the worksheets, but moving them around may be
more cumbersome and less robust compared with Excel.

Figure 9.53 Page layout features in Sheets differ somewhat from those in Excel. Themes are used to set a color scheme and/or font
type for your spreadsheet. (Google Sheets is a trademark of Google LLC.)
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Figure 9.54 (a) You can insert an image in a single cell or over all of the cells in a worksheet. (b) Inserting an image in a single cell fills
the cell with the image. (Google Sheets is a trademark of Google LLC.)

The review features in Sheets differ somewhat from the Review tab commands in Excel. Sheets allows you to
insert a comment (Figure 9.55) and view all the comments on the document by clicking on the Comment
History button on the top. The Tools menu in Sheets has a spelling and grammar check (Figure 9.56).
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Figure 9.55 Some review features in Sheets are similar to those of Excel. Comments are available in the Insert menu. You can also
review all comments in a workbook. (Google Sheets is a trademark of Google LLC.)

Figure 9.56 The spelling and grammar check are in the Tools menu. (Google Sheets is a trademark of Google LLC.)

9.7 Calculations and Basic Formulas in Google Sheets

Learning Objectives
By the end of this section, you will be able to:

• Add numbers in Sheets
• Subtract numbers in Sheets
• Multiply numbers in Sheets
• Divide numbers in Sheets
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Microsoft Excel has been around for decades, yet there are no functions for subtracting or dividing numbers.
Users must still build formulas with the appropriate mathematical operator to divide or subtract numbers.
Google Sheets has added a MINUS and a DIVIDE function. WorldCorp likes being able to use these functions in
their number crunching.

Adding Numbers
Adding numbers in Sheets uses the same commands and formulas as Excel does. Here, you will compare
orders from two clients, Client A and Client B, who ordered the same product—headphones—but at different
times and in different quantities. Figure 9.57 is a snapshot of these orders, showing the two clients’ order
history in two different tables.

Figure 9.57 The addition formula in Sheets works the same way as in Excel. We can use the addition formula to summarize this
information into one shorter table. (Google Sheets is a trademark of Google LLC.)

You will design a new table that summarizes these orders by client and by month using the data found in the
two client tables. Figure 9.58 shows a snapshot of the summarized orders of each client, separated by month.
In this table, we used the + sign to add the cells containing numbers (for example:
=G3+G4+G5+G6+G7+G8+G9) in the formula bar to add together total sales for each month by client. Note this
syntax is the same as Excel.
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Figure 9.58 You can use the addition formula to add up all of the sales that occur in a specific month. (Google Sheets is a trademark
of Google LLC.)

The same calculations can occur using functions. You can use the table in Figure 9.58, but replace the plus sign
with the SUM function, like Excel. Type “=SUM", an open parenthesis, then list the cells you wish to add, putting
a comma after each cell reference. Then close the formula with a closing parenthesis (Figure 9.59). Repeat the
process for all sales data by month and client.

Figure 9.59 Sheets offers a SUM function that can be used instead of formulas. (Google Sheets is a trademark of Google LLC.)
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Subtracting Numbers
One way to use subtraction in data analysis is to determine how far an order is above or below the average
order. This information can tell us which clients might need more attention to increase their orders or to
analyze ordering patterns due to seasonality. To perform this calculation, we will measure the distance from
the average. First, find the average, which is the total sales divided by the number of orders. Using the data in
Figure 9.57, insert two columns after Quantity for the average quantity and distance from average and insert
two more columns after FOB $ for the average FOB $ and distance from average. Then, find the average for
each of these and repeat the value in all cells in that column. Then, to find the distance from average, subtract
the average from the individual order, for both Quantity and FOB $. Figure 9.60 shows the average columns
and the formula for finding the distance from average. Then, apply the formula to all rows (Figure 9.61).
Repeat the process for the distance from average for FOB $ (Figure 9.62). In these statistical analyses, you can
see that there are some large orders that make the average high, which in turn makes many smaller orders
have a negative distance from average and makes them seem even smaller by comparison.

Figure 9.60 You can perform subtraction calculations in Sheets using formulas, just as in Excel. After finding the average, subtract
the average from the quantity to get the distance from average. (Google Sheets is a trademark of Google LLC.)
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Figure 9.61 Then, copy the formula to all cells in the same row. (Google Sheets is a trademark of Google LLC.)

Figure 9.62 Do the same calculation to find the distance from average for the FOB $. (Google Sheets is a trademark of Google LLC.)

Sheets also offers a subtraction function, unlike Excel. You can replace the subtraction formula with the MINUS
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function. First, type “=minus(” and list the cell references separated by a comma (Figure 9.63). The MINUS
function subtracts numbers in the order they appear in the formula just as if they were separated by “-” in a
formula. You can repeat this for all the subtraction formulas in the table. You can only subtract two numbers
using the MINUS function.

Figure 9.63 Sheets has the advantage over Excel in that it has a MINUS function. (Google Sheets is a trademark of Google LLC.)

Multiplying Numbers
As in Excel, when using the multiplication formula in Sheets, you can multiply a cell reference by a constant or
a cell reference by a cell reference. Using the same dataset, you can find the FOB $ by multiplying the quantity
by the price per unit. Figure 9.64a shows multiplication of the cell reference from the Quantity column by the
constant price per unit without adding a column for the value. A Price per Unit column is added and the
constant in the formula is replaced with the cell reference (Figure 9.64b). You can repeat the calculation for all
rows, as previously illustrated.

Figure 9.64 You can use cell references and constants for multiplication using formulas in Sheets. (a) The price per unit is the same
for all items in this table, so you can multiply the quantity by the price without adding a column. Alternatively, you can add a column
for the price per unit and (b) use cell references to perform the calculation. (Google Sheets is a trademark of Google LLC.)

To use the function, replace the formula with “=multiply(” and add the constant and/or cell references in
parentheses, separated by commas (Figure 9.65). You can only multiply two numbers using the MULTIPLY
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function. Sheets has another function, PRODUCT, that can multiply a series of numbers rather than just two.

Figure 9.65 The function for multiplication in Sheets is MULTIPLY. (Google Sheets is a trademark of Google LLC.)

Dividing Numbers
Dividing numbers using formulas in Sheets is also the same as in Excel. You can use the same sales data to
find the proportion of sales of each client compared with the total. Start with the data from Figure 9.58,
organized by month. Add a column for the total sales for each month and one for the proportion, and then
add a formula to calculate the total sales for clients A and B for each month (Figure 9.66).

Now that you have the totals, find the proportion by dividing the FOB $ in O3 by the total in Q3 (Figure 9.67).
Repeat the same operation for the other three rows (Figure 9.68). This analysis shows the sales behavior
differences between clients A and B. This data analyses shows that in December, client B had 52.36 percent of
the sales, and in January client A had 65.81 percent of the sales. The proportion can be changed into a
percentage to increase readability, as shown in Figure 9.69.

Figure 9.66 You can use division to find the proportion of sales by client and by month. First, find the total sales for each month.
(Google Sheets is a trademark of Google LLC.)

Figure 9.67 Then, use the division formula to divide the client’s total by the total monthly sales. (Google Sheets is a trademark of
Google LLC.)
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Figure 9.68 Carry these formulas down the column to get the proportion for each client in each month. (Google Sheets is a
trademark of Google LLC.)

Figure 9.69 Reformatting the cells as percentages makes the data more useful. (Google Sheets is a trademark of Google LLC.)

The division function in Sheets works in the same way as other mathematical functions. You can type “=divide(”
and then enter the cell references, separated by a comma (Figure 9.70). Notice that the result of the DIVIDE
function is a decimal. The numbers are divided in the order in which they are placed in the function, and you
can only divide two numbers using the DIVIDE function. The QUOTIENT function in Sheets also works in the
same way as Excel. The result of the QUOTIENT function will be a whole number, not a decimal. For example,
when you divide 5 by 4, the answer is 1.25, but using the QUOTIENT function, the answer will be displayed as
1.

Figure 9.70 You may use DIVIDE as a function in Sheets. (Google Sheets is a trademark of Google LLC.)

9.8 Formatting and Templates in Google Sheets

Learning Objectives
By the end of this section, you will be able to:

• Format and manipulate a cell or group of cells
• Design column and row header
• Use conditional formatting
• Work with templates to format worksheets
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Google Sheets has the same formatting features that Microsoft Excel does. The cell formatting of fonts and
shading of cells is part of everyday use when making headers. Text wrapping is also a feature in Sheets. Like
Excel, there are numerous Sheets templates available online and within the application. All of these features
make Sheets a valuable spreadsheet application for WorldCorp.

Formatting Cells
Sheets has the same functionality for formatting cells as Excel does. For example, you can use contrasting
color combinations to make text easier to read. The main difference in formatting cells between Sheets and
Excel is the location of the tools.

Using Color and Fonts
The tables in Figure 9.57 have the standard blue headers we’ve been using. Starting with these tables, we will
apply formatting changes. First, let’s change the font of the headers and the body of the tables. Click on the
header row and choose Courier New from the Font drop-down box (Figure 9.71a). Next, change the color of
the font. Since the headers are still selected after the font change, go to the action bar and click on the Text
color command. Select dark orange (last option in the third column from the left) as the text color. You can
then change the background color to a lighter blue using the Fill color command on the action bar (Figure
9.71b). In this case, changing the color of the background or the color of the font can make the column
headers stand out more and is more visually appealing.

Figure 9.71 In Sheets, you can format headers by (a) changing the font, changing the color of the font, and (b) changing the cell
background color, just as in Excel. (Google Sheets is a trademark of Google LLC.)
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Borders
The Borders command lets users modify the borders on each cell. Using the same table, let’s change the
thickness of the borders around the headers to differentiate them from the body. You will also add an outside
border for the body of the table. First, select the headers and click on the Borders command on the action bar,
then click on the Border style drop-down menu and select the third thickest (Figure 9.72a). To apply the thicker
border, click on the command for All borders (Figure 9.72b).

Figure 9.72 You can change the borders from the action bar. Click on the Borders command and choose Border style. (a) There are
several border styles to choose from in the list. (b) After choosing the style, apply it to all borders. (Google Sheets is a trademark of
Google LLC.)

For the border around the table body, repeat the same first step, selecting the third thickest. Then, instead of
applying it to all borders, choose the Outer borders option (Figure 9.73).

Figure 9.73 The header borders are formatted, and the same styling can be used to add a border to the outside of the table. Click on
the Borders command, choose the border style, and then apply it to the outer borders. The final table looks neat and professional
with borders. (Google Sheets is a trademark of Google LLC.)

Wrapping Text
You may have noticed that because you changed the font, the header in column C does not fit the width of the
column. This is easily fixed by using the Text wrapping command on the action bar. First, select cell C2, then
click the Text wrapping command, and select the middle command for Wrap (Figure 9.74a). Now all of the text
is visible, as seen in Figure 9.74b. If the text is still a little tight, widen the column slightly by hovering over the
edge of the column until the cursor changes to a double arrow, then drag the edge of the column to the right
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to accommodate the text.

Figure 9.74 When the text does not fit in a cell, one option is to wrap the text. (a) Select the cell and use the Wrap command. (b) The
text should automatically fit in the cell. (Google Sheets is a trademark of Google LLC.)

Merging Cells
As with Excel, Sheets allows cell merging. This enables information to be grouped to make it more readable for
the user. For example, the Merge cells command could group sales agents by region. To use this function, first
select the cells you would like to merge. Then, use the Merge cells tool in the action bar, as shown in Figure
9.75. You have several options with the tool: Merge all, Merge vertically (working with rows), Merge
horizontally (working with columns), and Unmerge.

9.8 • Formatting and Templates in Google Sheets 651



Figure 9.75 The Merge cells tool is found on the action bar. First, select the cells to be merged, then select the Merge cells tool.
(Google Sheets is a trademark of Google LLC.)

Designing Column and Row Headers
You have learned how to change the font, font color, background color, and width for header styling. Header
text can be bolded and centered to make them easier to read, and background colors can be applied and
changed. Figure 9.76 shows the formatting applied to cell B2 in the header. The font is bold and the text is
centered.
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Figure 9.76 Most professionally designed tables (a) use bold font on the headers and (b) are center aligned. (Google Sheets is a
trademark of Google LLC.)

Freezing Columns and Rows
Freezing columns and rows is useful when the data in your sheet does not fit the available viewing space. In
Sheets, you can freeze panes anywhere in the worksheet, but it’s certainly most useful to freeze column and
row headers. First, select the row that you want to freeze, then select Freeze from the View menu and choose
Up to current row. Sheets freezes that row and all rows above it, as shown in Figure 9.77.
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Figure 9.77 You can freeze panes anywhere on a sheet. Click on the row that you want to freeze and freeze up to that row. That row
freezes, and you can scroll through the data below it. (Google Sheets is a trademark of Google LLC.)

Hiding Columns and Rows
Sheets also supports hiding columns and rows. Select the row or column you want to hide. Right-click and then
click on Hide row or Hide column (Figure 9.78a). To unhide it, select the two on either side of the hidden row or
column, right-click and click on Unhide rows or Unhide columns (Figure 9.78b), or click on one of the two small
arrows in the header.

Figure 9.78 Hiding and unhiding columns in Sheets is similar to the process in Excel. (a) Select the column you want to hide, right-
click, and click on Hide column. (b) To unhide, select the columns on either side of the hidden column, right-click, and click on Unhide
columns. (Google Sheets is a trademark of Google LLC.)

Conditional Formatting
Conditional formatting allows us to apply preset formatting to data that meets certain criteria. You can find the
conditional formatting feature in Sheets on the Format menu (Figure 9.79). First, select the cells to format, and
then choose the conditional formatting feature. A sidebar opens where you can set up the conditional
formatting. In this example, the conditions are set so that Sheets will highlight in the default color any cells in
the range G2:G11 that have values greater than 999. The table updates instantly (Figure 9.80).
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Figure 9.79 In Sheets, you can set up conditional formatting as in Excel. Conditional formatting is in the Format menu. The sidebar
opens up to set the criteria. (Google Sheets is a trademark of Google LLC.)

Figure 9.80 When the criteria are set, the table instantly updates. (Google Sheets is a trademark of Google LLC.)

Working with Templates
Sheets offers many templates on the Welcome screen (Figure 9.81). If you do not find what you are looking for
in this screen, you can search for other online templates, but you have to use certain criteria. You need to use
the Google search engine, and type “X template site:https://docs.google.com.” For example, if you are looking
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for business budget reports, you would type “business budget report template site:https://docs.google.com.”
Searching in this manner will give you results from other Google Docs users’ Google Drive accounts, meaning
that they are sharing their templates with other users and they are available for use and not protected or
restricted. This also means that the templates have been formatted for Sheets and not for Excel. In some
cases, importing Excel files into Sheets can alter the formatting.

When you find the one you want to use, click on it, and a little ball will appear in the middle while you wait for
the document to open. You can then edit the document that was generated using the template to customize it
for your needs (Figure 9.82).

Figure 9.81 Sheets templates are available on the Welcome screen. (Google Sheets is a trademark of Google LLC.)

Figure 9.82 Sheet templates are also available online from other users. (Google Sheets is a trademark of Google LLC.)
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LINK TO LEARNING

It is not always easy to present data in an appealing and interesting way. Following a few simple steps and
best practices in formatting Sheets can ensure you are able to get your message across, while also
engaging your audience. Check out these best practices for presenting data (https://openstax.org/r/
78DataBestPract) to learn more.
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Chapter Review
Key Terms
cell reference address of a cell relative to the other cells in a worksheet
conditional formatting feature in Excel that analyzes the cell contents and applies certain preset designs or

layouts based on the content
Ctrl+Select command that allows you to select two or more areas that are not contiguous
data analysis scientific discipline that uses mathematical and statistical tools to measure trends
formatting applying colors, font types, and borders to cells for styling purposes
formula mathematical operation that may use constants or cell references, or a combination of constants

and cell references
freeze panes fixing the headers on the screen while allowing users to scroll through the rest of the data
function mathematical or analytical operation that uses words instead of mathematical operators
header label added to tables at the top of the columns or to the left of the rows to make the data

understandable
hide temporarily remove designated rows or columns from view
merge combine content from two or more cells
numeric data information made of numerals that Excel reads like a calculator to perform mathematical

equations
spreadsheet software application type that has rows and columns in a grid pattern where you can enter data

to design tables and graphs and perform data analysis
text data information made up of words, letters, numerals, or a combination
workbook file that contains one or more worksheets
worksheet tab within a workbook where you can input data and design tables and graphs that use the data
Wrap Text feature that arranges the text in a cell so that it extends onto another line and increases the

height of the row

658 9 • Chapter Review

Access for free at openstax.org



Summary
9.1 Microsoft Excel Basics

• A spreadsheet is a type of software that allows you to calculate mathematical equations and design tables
that you can use for financial documents and that performs data analysis and mathematical calculations.

• The GUI of Excel is designed for manipulating the cells of the spreadsheet. The GUI also has a ribbon,
which is a wide, multitabbed menu that contains features for customizing and formatting tables.

• The spreadsheet file is called a workbook and is composed of worksheets. A workbook can contain only
one worksheet. However, you cannot have a worksheet without a workbook.

• Add new worksheets to a workbook by clicking on the + next to the sheet tabs found along the bottom of
the interface.

• The Print feature of Excel allows you to print a single worksheet or the whole workbook.

9.2 Text and Numbers in Microsoft Excel
• Excel is a powerful tool to manage small to somewhat large sets of data.
• Data can be collected in Excel and analyzed to track a business’s sales or costs or a machine’s output, for

example.
• Both text and numbers can be formatted to match the contents of the data such as formatting a

description as text or a cost as accounting.
• The Page Layout tab includes commands to help you format the printed page in a professional manner.
• The Review tab is especially useful when sharing the spreadsheet for collaboration and ensuring accuracy

in spelling and grammar.

9.3 Calculations and Basic Formulas in Microsoft Excel
• Excel uses the formula syntax to add, subtract, multiply, or divide. The formula syntax is comparable to

writing out math equations by hand, with numbers and mathematical operators.
• The function syntax can perform the same calculations as the formula syntax for addition and

multiplication but not for subtraction or division. The function syntax uses function names with cell
references or ranges in parentheses to calculate.

9.4 Formatting and Templates in Microsoft Excel
• Formatting cells using colors, fonts, and borders can make a worksheet more readable and visually

appealing. Other commands such as Merge Cells and Wrap Text can be used to adjust the information in
the cells to enhance the professional presentation of the spreadsheet.

• By hiding columns or rows, you can make a more manageable worksheet or control what other users see
and how they interact with it.

• Freezing rows or columns keeps the information visible when navigating large spreadsheets.
• Using conditional formatting identifies trends in the data or highlights values that are inside or outside a

certain range.
• There are a variety of templates available within Excel and online for many uses such as invoicing, sales

reports, and budgeting.

9.5 Google Sheets Basics
• Sheets serves many of the same purposes as Excel, but some of its tools are limited, compared with Excel.

Many of the features are the same as or similar to Excel.
• The toolbar on Sheets is called the action bar. It is just one row of commands, unlike the wider Microsoft

Office ribbon, with menus that are essentially the same as the tools in Excel, but the action bar also
includes a row of buttons for frequently used commands.

• The process of creating a worksheet and formatting cells in an existing worksheet in Sheets is similar to
that of Excel, with drop-down menus for common commands.
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• Printing in Sheets is similar to printing in Excel.

9.6 Text and Numbers in Google Sheets
• The copy-and-paste function in Sheets works the same way as in Excel and allows the user to use the

structure of an existing table to create a new one. Users can then manipulate the table by inserting
columns or rows.

• To create a new table, first create header rows and then format the cells below it based on their contents.
Then, as you add text or numbers, Sheets will automatically format them based on the type of data.

• Basic graphs require selecting the data for analysis and then inserting a graph. Sheets chooses the type of
graph based on the type of data. You can change the graph type using the sidebar.

• Sheets has many of the same page layout and review features as Excel, with the major difference being
the location of the tools in the interface.

9.7 Calculations and Basic Formulas in Google Sheets
• In Sheets, mathematical calculations such as addition, subtraction, multiplication, and division can use

formulas, mathematical operators, and/or functions.
• The functions in Sheets differ some from Excel. Sheets has a few functions such as MINUS and DIVIDE that

are not in Excel.

9.8 Formatting and Templates in Google Sheets
• Sheets has many of the same formatting functionalities as Excel, such as colors, fonts, borders, text

wrapping, and merging cells.
• The formatting features allow for designing professional column and row headers. Hiding and unhiding

columns or rows can simplify a worksheet to make it easier to use.
• Conditional formatting works the same as in Excel.
• Sheets contains some templates on the Welcome screen, but users of Sheets also share their own.

Searching among only those publicly available templates can help you find many additional templates.

Review Questions
1. Excel is a spreadsheet software that can design sales report tables and calculate math equations using

______.
a. data, lines, and rectangles
b. calculators, graph paper, text
c. numbers, GUI, WordArt
d. cells, formulas, and functions

2. What is the primary difference between worksheets and workbooks?
a. Worksheets are tabs in a workbook.
b. Workbooks are tabs in a worksheet.
c. Worksheets are cells in a workbook.
d. Workbooks are cells in a worksheet.

3. Which command can be used to paste information that was recently copied?
a. Ctrl+C
b. Ctrl+A
c. Ctrl+V
d. Ctrl+=

4. What is the cell format that lets you type long numbers using just the first three digits?
a. Scientific
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b. Date
c. Accounting
d. General

5. What are examples of the benefits of using both numerical and text data in your worksheet but keeping
them in separate columns?
a. Numerical data can be combined with text data for writing descriptions of objects and their

measurements.
b. Text data can be used for autofilling a calculation of multiple scenarios.
c. Numerical data can be used in accounting, dates, or number formats, while text is used for

descriptions or headers.
d. Text and numerical data are easily typed and interpreted by Excel, as it can read words, thus they can

be used for computable lists.

6. What is a benefit of preformatting cells in Excel?
a. You can automatically fill the data without typing it by inserting an image from the phone.
b. You can type the data and Excel will apply the format, so it looks how you want it to.
c. You can send a Bluetooth connection to the data, and it will be autofilled.
d. You can use the cell references to do mathematical operations.

7. What are the two methods to add numbers in Excel?
a. using the SUM function and the “+” sign in formulas
b. using constants and cell references
c. using variables and constants
d. using functions such as PRODUCT and constants

8. The ______ function does not have the same functionality compared with the “/” because it does not return
a full answer if it has decimals.
a. DIVISION
b. PRODUCT
c. QUOTIENT
d. PROPORTION

9. Where in the ribbon can you change the font?
a. You can change the font in the Alignment command group on the Home tab.
b. You can change the font in the Text command group on the Insert tab.
c. You can change the font in the Symbols command group on the Insert tab.
d. You can change the font in the Font command group on the Home tab.

10. Identify the steps for automatically highlighting any cells from a column that are greater than a certain
number.
a. Select the cell you want to analyze, click on Conditional Formatting, go to Highlight cell rules, click

Greater than, and set the parameters.
b. Select the column in question, then click on Conditional Formatting, go to Highlight cell rules, click

Greater than, and set the parameters.
c. Select the column in question, then click on Conditional Formatting, go to Highlight cell rules, click

Between, and set the parameters.
d. Select the cell you want to analyze, click on Conditional Formatting, go to Highlight cell rules, and click

Top 10%.
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11. Where do you find the Spell check command in Sheets?
a. Format menu
b. Extensions menu
c. Tools menu
d. File menu

12. ______ is the process to select two noncontiguous cell ranges.
a. Ctrl+Select
b. Shift+Select
c. mouse left-click select
d. mouse right-click select

13. What commands or tools are found on the toolbar?
a. all the options that are contained on the Tools menu
b. tools that the user selects to be placed on the toolbar
c. the more widely used tools/commands
d. all of the commands and tools from the File and Data menus

14. What menu would you use to add cells in a worksheet in Sheets?
a. Tools
b. Insert
c. Edit
d. Data

15. Double-clicking on the cell edge between the column header row will ______.
a. change the format of the cell to financial
b. automatically resize the column width to the data in the column
c. remove the data in that column
d. highlight the column for graphing

16. Where will you find the Themes settings in Sheets?
a. Format menu
b. Insert menu
c. action bar
d. Page Layout menu

17. What is the function name for subtracting in Sheets?
a. There is none.
b. MINUS
c. SUBTRACT
d. DIFFERENCE

18. ______ is the name of the function for multiplication of two values in Sheets.
a. PRODUCT
b. TIMES
c. MULTIPLY
d. RESULT

19. What is the difference between the QUOTIENT and DIVIDE functions?
a. DIVIDE gives you decimals in the result, and QUOTIENT gives you whole numbers.
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b. There is no difference; they will always produce the same answer.
c. QUOTIENT will give a result with the first two decimal places, whereas DIVIDE gives a result that

includes all decimal places.
d. You can use QUOTIENT in Sheets, and you can use DIVIDE in Excel.

20. What would be a general header style most favored by the corporate world?
a. leaving it plain text, as it can be easily read by Sheets
b. aligning the text to the right, applying a bright color background, and plain type
c. applying bold text, with no background or alignment
d. applying a background color shading, bold font, and center aligned

21. How do you look for public templates in Sheets?
a. You need to go to the Welcome screen, and search for templates there.
b. You need to go to Google.com, and type “X template site:docs.google.com”.
c. You can’t because Sheets doesn’t have access to public templates.
d. You can look for Microsoft Word templates because they work in Sheets, too.

22. What is the main difference between freezing panes in Excel and in Sheets?
a. In Sheets, you can choose the row or column at any part of the worksheet.
b. In Excel, you can choose the row or column at any part of the worksheet.
c. In Sheets, you can only start the pane freeze at the first row or column.
d. Both are the same in all aspects.

Practice Exercises

23. Using part (a) of the
figure, move to the next column to the right. This new column will be for adding the average. This average
can easily be calculated by typing the AVERAGE function. Research the syntax and use it in the new
column. Once you find the average, copy the formula down the column.

24. WorldCorp’s sales team uses a customer relations management (CRM) software that gives the user the
option to export data. This exported data needs to be formatted when you open it with Excel. Design a
table with the following headers: Date, Product, Qty, Price per Unit, Total Value, and Notes and preformat
each column based on its respective type of data.

25. Using the table from the last exercise, add the data shown in the following table. Insert a calculation for
the total value instead of typing in the dollar amount from the table.
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Date Product Price Qty Total

12/20/2020 Headphones $48.00 57 $2,736.00

12/28/2020 Headphones $48.00 74 $3,552.00

1/3/2021 LED 65 $780.00 13 $10,140.00

1/3/2021 Headphones $48.00 9 $432.00

1/5/2021 Headphones $48.00 10 $480.00

1/7/2021 OLED 45 $48.00 77 $30,800.00

1/8/2021 LED 65 $780.00 14 $10,920.00

1/8/2021 Headphones $48.00 16 $768.00

1/11/2021 LCD 42 $380.00 48 $18,240.00

1/13/2021 Plasma 65 $855.00 12 $10,260.00

1/13/2021 Headphones $48.00 85 $4,080.00

1/15/2021 Headphones $48.00 158 $7,584.00

1/17/2021 LCD 42 $380.00 55 $20,900.00

1/17/2021 Headphones $48.00 115 $5,520.00

1/21/2021 Plasma 65 $855.00 11 $9,405.00

1/22/2021 Headphones $48.00 15 $720.00

1/25/2021 LCD 42 $380.00 54 $20,520.00

1/27/2021 QLED 55 $620.00 10 $6,200.00

1/30/2021 LED 55 $550.00 10 $5,500.00

2/4/2021 LCD 32 $170.00 43 $7,310.00

2/7/2021 QLED 55 $620.00 15 $9,300.00

2/9/2021 OLED 45 $400.00 37 $14,800.00

2/11/2021 Plasma 65 $855.00 34 $29,070.00
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Date Product Price Qty Total

2/15/2021 DLP 32 $250.00 97 $24,250.00

2/18/2021 LED 65 $780.00 54 $42,120.00

2/21/2021 LED 55 $550.00 21 $11,550.00

2/25/2021 LCD 42 $380.00 54 $20,520.00

2/27/2021 LCD 32 $170.00 14 $2,380.00

Table 9.2

26. Refer to Figure 9.23.
Use the figure to find the average of the marginal profit value. First, determine the total volume sold and
total marginal profit. Then, divide those two numbers to find the average marginal profit per unit sold.
Design this extended table.

27. Refer to Figure 9.24.
WorldCorp handed you an assignment to use the figure to determine the FOB $ average of all orders and
then to compare the average order and the invoice order individually in a new column. Create the new
column to show the difference between each individual order and the FOB $ average. Finally, divide that
difference by the FOB $ to get a percent difference. Be sure to format the data as a percentage. Construct
this table.

28. WorldCorp sells various business tablets that are designed to be rugged. In the past month, the model
FE-546 sold 435, the model FR-765 sold 324, and the model FH-985 sold 213. They cost $356, $467, and
$586, respectively. Construct a table with these values. Include a total column as well.

29. Refer to Figure 9.28.
Using the data in the figure, construct a line chart comparing dates and sales. Build this chart. Look for
information on the internet on how to build basic graphs using Excel.

30. Your manager at WorldCorp asks you to design a sales report with the following columns: date, model,
price, quantity, and sales total. Enter four different fictional orders in the table. Use formatting that you
feel is appropriate for the header rows.

31. Your manager at WorldCorp tells you to print the document. Explain in detail what you would do to print
five copies of the document, which contains only one worksheet.

32. WorldCorp makes many products and sells them to thousands of customers. The sales team keeps call
logs for when they make calls to their corporate clients to generate sales. These clients are retailers that
buy directly from WorldCorp because of the volume discount. Design and create a call log with the date of
the call, the purchasing executive’s name, the client’s name, the phone number, and the order details. The
order details are separated in different columns for text description, units, sale value, and optional notes.
These optional notes contain special delivery requests from the client. Use the cell formatting methods
you have learned so far.

33. Create an address book using information for four friends or family members. The table should include
their names, street addresses, phone numbers, and email addresses. Their street addresses should be
separated into four columns: the street and house/apartment number, the city, the state, and the zip code.
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Use the formatting methods you have learned so far.

34. WorldCorp is releasing a new universal remote control model that has a touch screen and is
programmable for any model of TV, stereo, cable box, and movie player. The sales figures for the
preorders need to be added together by location and then multiplied by the price per unit to get the final
sales figures. Enter the data into Sheets and complete the table using functions.

35. WorldCorp sells tablets to educational organizations. Each basic tablet’s price is $157.64, on a discounted
rate because they are purchased for hundreds of students. The tablet comes with its own keyboard, all in
one package. WorldCorp sold 654 in Fairfax, Virginia; 867 in Portland, Maine; and 532 in Deeville, Texas.
Make a table forecasting the revenues of each location. Compare the locations with the total sales revenue
using a proportion. Make a graph comparing these three locations’ performances. Use the best practices
discussed in the chapter for designing tables.

36. WorldCorp sells tablets to educational organizations. Each basic tablet’s price is $157.64, on a discounted
rate because they are to be bought for hundreds of students. The tablet comes with its own keyboard, all
in one package. WorldCorp sold 654 in Fairfax, Virginia; 867 in Portland, Maine; and 532 in Deeville,
Kansas. Make a table forecasting the revenues of each location. Use a conditional formatting of “Greater
than” and set the minimum to be $100,000. Explain the significance of the conditional formatting in these
three revenue comparisons.

Written Questions
37. How can AutoFill help you fill a table with values? Explain.

38. Discuss how the ribbon in Excel differs from other Microsoft programs.

39. Discuss the differences between formulas and functions. Give an example of each.

40. What is the benefit of the AutoFill feature in Excel?

41. What is the common use of the Review tab? Explain.

42. Why would you choose to use the function PRODUCT instead of the “*” operator? Give examples.

43. What are the advantages of using the SUM function?

44. Describe in steps the way to access the border outlines.

45. Describe the purpose and process of freezing panes.

46. Why might a business use Sheets over Excel?

47. Why would you use cell formatting for designing tables?

48. How do you create a graph in Sheets?

49. Why would you use the currency, accounting, and financial cell formats? Explain each one.

50. Describe the process of making a sales line chart.
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51. Why would you use functions instead of formulas? Explain.

52. What are some of the uses of the four mathematical functions SUM, MINUS, MULTIPLY, and DIVIDE?

53. Describe how you could use the following concepts to create a budget that analyzes your average daily
spending: formatting, creating a chart, using functions.

54. Why would you use conditional formatting?

55. What is the main difference between freezing panes in Excel compared with Sheets?

56. Describe the steps of hiding and then unhiding a column.

Case Exercises
57. Go to the International Trade Administration website (https://openstax.org/r/78ITA). On the right, select

Product 334 – Computers and Electronics from the Products drop-down menu, then select Imports under
Trade Flow. Next, select Download from the top of the window and choose Crosstab. When prompted, select
CSV and then download. These steps generated and saved a set of data that you can use for the following Case
Exercises. Be sure to save the .csv file for use later in the chapter.

A. Open the .csv file with Excel and format the cells. Select the columns that have text data and format the
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information as text. Select the columns that have accounting format and use the appropriate number
format. Delete unnecessary columns. Then, use Save As to save the file in .xlsx format, so that you can
keep the changes.

B. On the headers, choose an appealing background color, bold font, and centered alignment.
C. Select the whole table to apply border lines around all cells.
D. Use the process of double-clicking between the tops of columns so that they are automatically fitted. You

will be able to see all the numbers.

58. These exercises use the .csv (comma separated values) file from the NAICS-334 chart. Upload it to your
Google Drive.
A. Open the .csv file with Sheets and format the cells. Select the columns that have text data and label it

as such. Select the columns that have accounting format and label it as such.
B. On the headers, apply traditional corporate styles, with background color, bold font, and centered

alignment.
C. Select the whole table to apply border lines around all cells.
D. Set the column widths based on their contents by double-clicking on them so that you can see all the

numbers.
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Figure 10.1 Manufacturing involves a lot of data analysis, and Excel’s data analytics supports corporations every day. (credit:

modification of "Man Standing Beside Heavy Equipment" by Kateryna Babaieva/Pexels, CC0)

Chapter Outline
10.1 Data Tables and Ranges
10.2 More About Formulas
10.3 Using Arithmetic, Statistical, and Logical Functions
10.4 PivotTables
10.5 Auditing Formulas and Fixing Errors
10.6 Advanced Formatting Techniques

Chapter Scenario
WorldCorp’s Fairfax, Virginia, location is a manufacturer of consumer electronics, and it regularly fulfills orders
for its Portland, Maine, location, where their products are shipped worldwide through the port. WorldCorp’s
sales are increasing, but the Fairfax plant is struggling to keep up with the orders. Their Fairfax location is
more than ten years old and no longer has the capacity they need. The corporate headquarters has approved
an expansion of their facility. The regional manager wants to keep the original facility but increase the amount
of square footage through adjacent additions. Executing this expansion will involve project planning, acquiring
the needed materials, determining the needed funding, working with outside suppliers, and so forth. The data
generated during the expansion will need to be evaluated and regularly tracked to ensure the project stays on
time and within the budgeted resources.

Microsoft Excel can facilitate this type of analysis to aid the decision makers as the projects progress. In this
chapter, you will use the “what-if” scenarios of each location in the walk-throughs and exercises to rename cell
ranges, use the AutoFill feature in tables, and practice simultaneous calculations of formulas. Excel also
supports the associated statistical and financial analyses required for WorldCorp.

Advanced Excel Formulas, Functions, and Techniques
10



10.1 Data Tables and Ranges

Learning Objectives
By the end of this section, you will be able to:

• Differentiate between a spreadsheet and a Data Table
• Explain the advantages of a Data Table
• Create/insert a Data Table from data in a spreadsheet
• Define a cell range
• Select and name a cell range
• Differentiate between a cell range and an array

WorldCorp has sufficient savings for capital investment for the Fairfax project, yet the chief financial officer
(CFO) wants to borrow from a bank about 50 percent of the amount of the estimate for the new addition.
There are many banks in Fairfax, each offering different interest rates and years to pay back the loan. The CFO
is not sure which offer is best, as the longer the loan period is, the more interest WorldCorp will end up paying,
yet the shorter the loan period, the higher the payment will be. The CFO is also analyzing the different interest
rates and how they affect the installments and subsequently the total interest charge over the life of the loan.

This case shows why it’s important to learn the intricacies of using Microsoft Excel’s Data Tables. Data Tables
can be helpful to assist management in determining the best course of action by evaluating interest charges
and monthly payments. In this section, you will create a data table from existing data and will discover the
advantages of using the Data Table tool in the What-If Analysis, plus related concepts and definitions, such as
data ranges and arrays. The Data Table’s powerful analysis options will be further explored in Organizing and
Presenting Data.

Differentiating Between a Spreadsheet and a Data Table
Spreadsheets have a wide variety of applications and can be used for accounting, budgeting, data collection
and analysis, and operations efficiency. Spreadsheets are used in all departments of corporations, such as
marketing or operations. These departments can use spreadsheets in a variety of ways, such as compiling
information from market studies, or performing statistical analysis on operations from the manufacturing
plant.

A Data Table is a scenario-building tool. It lets users choose a set of cells on the spreadsheet, and then
outputs different solutions or forecasts depending on different scenarios. The difference between a Data Table
and a spreadsheet is that a spreadsheet is a file with blank cells that can be formatted using the various tools
and commands contained in the application. A Data Table can be part of (embedded in) a spreadsheet, but a
spreadsheet can also include a graph, some text for information, or the listing of the inputs for the Data Table.
The Data Table feature of Excel automatically builds a table of data based on certain inputs that is part of the
spreadsheet. Figure 10.2 shows an example of an Excel-generated Data Table, as well as the data used in the
scenarios. You will build a Data Table after learning more about its uses.
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Figure 10.2 Data Tables are added to a spreadsheet and are autogenerated in Excel based on the input you select. (Used with
permission from Microsoft)

The Advantages of a Data Table
The advantages of Data Tables are many. One of their most important advantages is their ability to automate
scenario-building. Another advantage is increased accuracy due to less manual entry of data. If you were to
create a scenario from a blank workbook, you would need to build out the formulas initially and then copy
them through the desired levels of the inputs. This increases the possibility of user error caused by inputting
values or formulas incorrectly. By using the Data Table feature, all that work is done automatically—and
quickly. Data Tables allow users to view all the levels of inputs in a single table without inputting multiple
formulas.

Consider the example of expanding Fairfax’s WorldCorp location. You have gathered the needed information
to determine the amount of the loan you will need to finance the added capacity. You have the loan terms
from banks in the area and you know that the loan payment period will be ten years. WorldCorp is working on
its annual budget, so the CFO wants you to investigate the annual payments, not the monthly payments. The
CFO also wants to examine the variability of the annual installment if the interest rate is increased by 0.5
percent increments per year over the life of the loan. The Data Table in the What-If Analysis will automatically
perform the annual payment calculations for each increment. The CFO will then be able to look at the results
and determine which loan from which bank will best meet the company’s needs.

The first step in this analysis is to set up your data. Since you’re looking at how the interest rate affects the
annual payment, you can use Excel’s Payment (PMT) function, which uses the present value (the value of the
loan), the number of payments, and the rate. The PMT function is in the Financial library of functions found on
the Formulas tab. The present value (PV) is principal to be borrowed; in this case, we will use $750,000, which is
half of the total cost of the expansion. This was determined by the initial research by the CFO as the amount
needed to finance the company growth. The time period of the loan has been set at ten years. Most loans are
paid monthly, but since you are analyzing the annual payments, you will use 10 (not 120) for N (shown as Nper
in the function builder) to define the number of payments. After gathering all the interest rates offered by the
banks, it was determined that the average interest rate (I) of all is 6.5 percent. Using these input values, the
yearly payment can be determined using the financial PMT function. Figure 10.3 shows the building of the PMT
function in Excel.
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Figure 10.3 Using the inputs of the interest rate, the number of years, and the principal amount, you can quickly determine the
annual payment for the loan. (Used with permission from Microsoft)

The result is an annual payment on the loan of $104,328.52 (Figure 10.4). The output for Excel with the PMT
function is negative by default, which is displayed in parentheses and in red. This is to indicate that the loan
total will decrease by that amount each year after the payment is made. Keep this in mind as you examine the
output.

Figure 10.4 The PMT function in Excel calculates the payment required for a loan. The output is negative by default to show that the
loan will decrease by that amount each time a payment is made. (Used with permission from Microsoft)

The next step in the analysis is to compare the payments with different loan terms. You can calculate the
payment manually using the PMT function many times—that is, every time you change the interest rate. You
can play around with it by changing the interest rate and seeing how it affects the payment. If the rate is lower,
the payment will be lower, and if the rate is higher, the payment will be higher. For example, in Figure 10.3, if
you change the rate to 5 percent, the payment automatically updates to $97,128.43. However, this approach
does not retain all of the options easily. Unless you make a separate table to capture the impact of changes in
the interest rate on the payment, that information is lost each time you make a change to the inputs. If you do
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create a table, you would need to format it in a manner suitable for additional analysis and decision making. It
would be a time-consuming exercise to record all of the data for each interest rate, and then you would need
to take an extra step to summarize it in an easy-to-follow table. By creating a Data Table, you can use various
levels of the interest rate to calculate the payment and summarize it in one concise table.

REAL-WORLD APPLICATION

Calculating Mortgage Payoff Schedule

PMT is a useful tool for comparing different interest rates and their impact on monthly payment. It can also
be used to determine a mortgage payoff schedule. Paying down a mortgage at a faster pace than agreed
upon can lead to significant savings in interest payments. Even one additional payment a year can have a
large impact on the amount of interest paid. You can find any number of amortization templates available
online, either where you input the information and the site calculates it for you, or through an Excel
template. Do some online research to find an Excel template to help you calculate your mortgage payoff
schedule. Open the template and review the formulas. Notice the use of IF and PMT functions throughout.
Using the template, locate a home to purchase and determine the payoff schedule for the home using
today’s interest rates. If you own a home already, determine what one additional payment per year will do
to your final home cost upon payoff.

Creating a Data Table from Data in a Spreadsheet
To facilitate the process of comparing various interest rates on the annual payment, you can create a Data
Table. To do so, the information must be arranged on the spreadsheet in a specific way. First, make a list in a
column of the interest rates being examined. The order doesn’t matter to Excel, but it makes the data easier to
analyze if you put them in numerical order, either lowest rate to highest or vice versa. In the next column to
the right and one row above, use the PMT function to calculate the payment at the current rate (recall, you
used 6.5 percent), as shown in Figure 10.5.

Figure 10.5 To create a Data Table, you must first determine the list of input values, in this case the changing interest rate. (Used
with permission from Microsoft)

Next, select the area of the spreadsheet where the changing input values are contained. In this example, that
is cells E1:F8. On the Data tab, you will see the What-If Analysis menu group on the right side. Select the drop-
down arrow and choose Data Table (Figure 10.6).
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Figure 10.6 To create a Data Table, use the What-If Analysis menu. (Used with permission from Microsoft)

When the Data Table tool is selected, a dialog box appears for inputting data. Because the interest rates are
listed in columns, use the “Column input cell” box. In this cell, place the cell reference for the original interest
rate used in the PMT function. Notice the dollar sign ($) in front of the letter and number in the cell reference.
This will set the column input cell to always refer to the value in cell B2. This is referred to as an absolute
reference. You will learn more about absolute references in Absolute Cell References. For this example, the cell
is B2 (Figure 10.7).

Figure 10.7 If you had placed the interest rates in a row rather than a column, you would use the “Row input cell” box instead of the
“Column input cell” box. (Used with permission from Microsoft)

The Data Table will automatically calculate the payment at each of the interest rates listed in the column below
the PMT, as shown in Figure 10.8. You will need to format the data to be Accounting or Currency.

Figure 10.8 When the Data Table is created, the output is not formatted. Use the Accounting or Currency format to display the data
correctly. (Used with permission from Microsoft)

This process will save a lot of time, as it eliminates manually creating a formula for each cell. Furthermore, with
the same Data Table, any of the values in the list can be changed and the information will automatically update
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to the correct value. For example, to see the payments for a 6.4 percent interest rate instead of 6.5 percent,
simply change that one value, and the row’s value will be autofilled to calculate the new installment payment.
The rest of the data table stays the same, as you can see in Figure 10.9.

Figure 10.9 Notice that by changing the cell to 6.4 percent, the payment changes only for that value. (Used with permission from
Microsoft)

Suppose you have taken this Data Table to the WorldCorp CFO, who tells you that the company will not pay
high interest rates and will only negotiate and meet with the executives of banks that offer rates at or below 7
percent. There is no need to create a new Data Table that only includes the data for that range of rates
because you may need the information at a later point. Instead, you can temporarily hide the values that
exceed the 7 percent maximum using Excel’s filtering tools. A filter is a tool that lets you select certain criteria
so that only data with your chosen criteria is shown.

To use a filter within the Data Table, select the rate column, and then go to the Data tab. In the Sort & Filter
command group, select Filter (the funnel icon). When Filter is selected, a small arrow will appear at the top of
the column, as shown in Figure 10.10a. Select that arrow and go to Number Filters, then select Less Than Or
Equal To.... On the dialog box that appears next, select 7.00% from the choices, and then click OK. The result is
that the Data Table will only show values that are less than or equal to 7 percent, as shown in Figure 10.10b.

Figure 10.10 (a) In the drop-down menu, there are many different filter options. (b) The funnel icon in a cell indicates that a filter has
been applied to that column. (Used with permission from Microsoft)

Now that you have created a Data Table with one variable, you will follow a similar process to analyze two
variables. With the added capacity in Fairfax, WorldCorp can sell more products to help the company reach its
strategic goals. Increasing unit sales could also allow the company to reduce its price per unit. You would like
to better understand the impact of the increased sales and price changes on the annual revenue for
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WorldCorp. Let’s assume that in 2020, WorldCorp sold 5,000 RX-500 digital scales in the state of Virginia, at the
retail price of $17.99 per unit. That would mean an annual revenue of $89,950 for this item. What would
happen if the price was decreased to $16.99, in hopes that the unit sales would increase? Or, conversely, what
would happen if the price increased to $18.99? WorldCorp is not sure how the public will react to either option,
but you can estimate the revenue it will produce. Let’s assume that either sales will stay the same (i.e., 5,000
per year), decrease to 3,000, or increase to 7,000. With the Data Table tool located in the What-If Analysis, all
the revenues will be autofilled for the different unit sales and the different prices (Figure 10.11). To create this
table, follow the steps for the loan interest rate example. However, instead of only including the column input,
also include the row input.

Figure 10.11 In contrast to the previous example with loan interest rates, this Data Table uses two variables: price (row input) and
quantity sold (column input). (Used with permission from Microsoft)

Defining, Selecting, and Naming a Cell Range
A cell range is a selection of rows or columns of cells that is given a name to make it easier for the worksheet
designer to find that specific group of cells later. It can include a group of cells that are next to each other or
separated across the worksheet or workbook. Defining a cell range is especially useful when designing a large
Excel worksheet with a substantial amount of data, or when interconnecting datasets or different
spreadsheets. Naming a range of cells is referred to in Excel as defining a range. You can define a range in
three different ways.

Method 1: Define a Range
First, select the range of cells you want to name. Then, click on the leftmost box below the ribbon (Excel calls
this the Name Box). After the cursor on the Name Box begins blinking, type the name you want to use for the
data range, and press Enter. Subsequently, you may refer to this range of cells as the name you typed in the
Name Box. Type “digital scale” in the Name Box, as shown in Figure 10.12.

Figure 10.12 The Name Box sits just below the ribbon and above the column letters. (Used with permission from Microsoft)

Method 2: Define a Range
Begin by selecting the desired range of cells, then go to the Formulas tab, and select Define Name. A new
dialog box will appear; it has three fields: Name, Scope, and Comment. Next to Name, simply type the name
you want to use for the data range; under Scope, select Workbook; the Comment field is optional. Click OK to
complete the process (Figure 10.13).
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Figure 10.13 The Define Name option is in the center of the Formulas tab ribbon area. (Used with permission from Microsoft)

Method 3: Define a Range
The third way to define a range is more comprehensive, as it allows you to select various columns or a whole
Data Table. You need to select the entire table, or the set of columns (or rows), that you want to define. After
making your selection, go to the Formulas tab in the ribbon and choose Create from Selection. A dialog box
will appear and where you select the headers. (Many tables have column headings only, and other tables have
row headings.) In the dialog box, you will select if the table has the column headings on the bottom or on the
top, or if the row headings are on the right or on the left.

Using the WorldCorp example of the loan interest rates, choose Left column, and click OK, as shown in Figure
10.14. Because you didn’t type anything, as this method is more geared for tables, Excel automatically gave
defined names to the data ranges (rows). Excel uses the text in the left column of the table to name (define)
the data ranges. Spaces are automatically converted to “_” by Excel. Consequently, the data ranges are
Years_N, Rate_I, Principal_PV, and Payment_PMT.
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Figure 10.14 (a) To activate the Create from Selection command, click on the area shown after first selecting the data table. (b) Notice
that cell B1 has been renamed Years_N based on the title for that row listed in the left column (column A). (Used with permission
from Microsoft)

Differentiating Between a Cell Range and an Array
An array is similar to a cell range in that it is a collection of data in ranges of cells, but arrays do not have to be
contiguous (right next to each other). Arrays can contain text or numbers and can span multiple rows and
columns if needed. The array can be a collection of cells that consists of unrelated elements, whereas cell
ranges have a start and finish and are made of elements related to each other. Arrays also are different from
data ranges in that they can work creatively to simultaneously calculate different computations at the same
time. An array can replace many standard formulas and make simple computations more efficient. The array
formula performs multiple calculations on several values, so using arrays and array formulas can save users
time.

Let’s use the WorldCorp digital scale example and recalculate it using arrays. The unit sales of each model are
added to the previous data in column C. Then, using arrays, you can determine the total revenue without
calculating the revenue for each model separately. Figure 10.15a shows how you can add a column for the
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revenue of each model and then add them up to get the total revenue of the digital scales. Figure 10.15b
shows the total revenue for sales of all models in cell C7, without any of the individual calculations, using an
array.

To use an array to calculate the total revenue in Figure 10.15b, click on a blank cell (here, cell C7), and type the
function =sum(b2:b6*c2:c6) and hold down Ctrl+Shift as you press Enter. This function calculates the sum of
the revenue for each item, as shown in the ranges in the parentheses. As visible in the Formula Bar, Excel
recognizes b2:b6 from the defined data ranges, and renames it “Price” in the formula. Excel also adds a curly
brace (“{ }”) before and after the whole function (Figure 10.15b) because it recognizes it as an array. Excel then
does all of the calculations we did manually in Figure 10.15a in one step and provides the total revenue. You’ll
notice that the total revenue values match, regardless of whether you do the calculations manually or use an
array. When a selection is defined as an array, then any formula is calculated as an array formula, which allows
for multiple calculations to happen simultaneously.

Figure 10.15 The array formula enables Excel to derive the same results using less space in the sheet. (a) You can calculate each
model’s revenue and then add those values to get the total revenue. (b) You can also use an array, which determines each model’s
revenue and adds them up in one step. (Used with permission from Microsoft)

10.2 More About Formulas

Learning Objectives
By the end of this section, you will be able to:

• Create complex formulas
• Use cell references in formulas
• Use comparison operators
• Use arrays in formulas

Portland is a small city in Cumberland County, Maine, and is Maine’s most populous city. Its main commercial
attraction is that it is a port city, and among the main economic activity in the region is marine transport
services. WorldCorp has an office there, as the company uses the port facilities to export some of their
products to different destinations. The WorldCorp regional manager has to use intricate spreadsheets to keep
track of the large volume of cargo coming from different cities in the United States. The manager wants to
start using data automation intelligence tools in Excel, allowing the manager to make operational decisions
more quickly.

The shipping information may contain data such as the origin city, the destination, types of inventory included
in the cargo, the weight of each shipment, and specific international shipping terms for the shipment. The
manager receives this information separately in each bill of lading (a summary of the shipment) and has
constructed many complex Excel workbooks with different tabs, each containing the raw data from the cargo.
With shipments increasing year by year, this raw data has grown and become unwieldy. Using Excel’s built-in
analytical tools, such as cell references, comparison operators, and array formulas, the manager can make
sense of this raw data to use and process it in a more helpful way.
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As a WorldCorp employee, you are asked to deliver recurring reports based on this data. These reports can be
tedious to create if you are not able to immediately find the information you need in your spreadsheets. In this
case, you are asked to find the heaviest shipment, the average tonnage, the most-used destination, and other
report highlights.

Excel’s analytical tools like cell references, comparison operators such as greater than (>), and array formulas
allow all the information in your spreadsheet to be summarized automatically. Using comparison operators
enables powerful functions that are used for different purposes when constructing array formulas. Cell
reference notations—relative, absolute, and mixed—are used to construct automated tables. A relative cell
reference means that the cell used in the formula will change if it is copied to another part of the spreadsheet.
More specifically, both the column and row location are not fixed. An absolute cell reference occurs when both
the row and the column are fixed to that exact cell, so if you copy the formula to another location in the
spreadsheet, it will always reference the same cell. A mixed cell reference is when either the column or the row
is fixed. If the column is fixed, the row will be relative when copied to another location in the spreadsheet, and
if the row is fixed, the column will be relative. Understanding cell reference notations will help you learn to
build and use complex formulas using the correct order of operations. More advanced use of cell references
will allow you to use comparison operators and arrays in different situations.

Complex Formulas
As calculations grow in complexity, they require the use of several operators, such as +, –, /, *, and ^, in the
same formula. This is the basic definition of a complex formula, a formula that uses several operators to
calculate an output. One important aspect of complex formulas is that Excel will automatically calculate them
in a specific order. When first working with complex formulas, it can be helpful to write out the formula on
paper first. To input formulas into Excel, use parentheses to separate the different mathematical functions.
Multiple parentheses might be needed when working with complex and long formulas. For example, to add

cells A1 and B1 and then divide by cell C1, it would look like if you wrote out the formula. In Excel,

the formula is one single line: =(A1+B1)/C1. Another strategy when dealing with complex formulas is to break
down the formula into parts. To break down the previous example, you would do the addition part of the
equation in one cell, and then in the next cell, do the division. Excel employs a color-coding system in complex
formulas to help you follow the math, as shown in Figure 10.16.

Figure 10.16 The color-coding system for complex formulas is also applied when using multiple sets of parentheses in a formula.
(Used with permission from Microsoft)

Insert Function Tool
Recall, the Formula Bar is located right above the lettered columns, right beneath the ribbon. The Formula Bar
can be used for double-checking that what you typed in the cell was what you intended, or for editing the
relative cell references of a copied cell. However, there is another feature in the Formula Bar using the Insert
Function tool, which is essentially an assistant to help users build formulas. It contains the whole roster of
Excel functions, categorized by discipline (e.g., engineering, financial, math and trigonometry, statistical), so
users can explore and search for functions. Insert Function is activated by clicking on the “ƒx” icon that you see
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in the Formula Bar, or by going to the Formulas tab, and selecting Insert Function. The Function Library
command group on the Formulas tab also shows formulas grouped by category.

MAC TIP

In the Mac version, the Formula Bar only shows the most commonly used formulas, but you can expand the
Formulas tab.

Let’s examine how to use the Insert Function tool for a simple function, the SUM function. (Note that the Insert
Function tool is typically used for more complex and specialized functions because it is quick and easy to just
type in the simple formulas; however, here, the SUM function provides a simple example.) First, select the cell
where you want the summed total to appear. Then, click on the Insert Function icon. The dialog box will open,
asking for the function you want to use; select the Math & Trig category, and look for SUM (they are listed
alphabetically). When selected, a second screen will appear and ask for the range on which to perform the
addition. Select the range and then click OK.

MAC TIP

In the Mac version, the Formula Builder defaults to the last formula you used.

One useful feature of the Insert Function tool is that it can automatically detect what your range might be
(Figure 10.17a). In Figure 10.17b, Excel automatically guessed that the user would want to sum the range
F2:F5. This Insert Function tool is useful when you do not want to manually type the formula in the Formula
Bar.
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Figure 10.17 The Insert Function tool includes tips on how to apply each function. (Used with permission from Microsoft)

Order of Operations
In all math equations, there are rules regarding the order in which calculations must be completed. Otherwise,
the equation result will be incorrect. The order of operations is the universal law of math used to prescribe
the order of doing each calculation in an equation: parentheses, exponents, multiplication, division, addition,
and subtraction, going from left to right (the acronym PEMDAS can help you remember the order). For
example, if you calculate 5+3*3–5 from left to right, you would add 5 and 3 to get 8, then multiply 8 by 3 to get
24, and then subtract 5 to get 19, which is incorrect. Following the mathematical order of operations, the
equation should be done in this order: multiply 3 by 3 to get 9, then add 5 to get 14, then subtract 5 to get 9.
You can also use parentheses to help show the correct order of operations, such as 5+(3*3)–5. The parentheses
show that the multiplication should be done first. Excel requires equations to follow the correct order of
operations, using parentheses when combining operations in a single cell.

Let’s look at some WorldCorp revenue streams to see this on a larger scale. WorldCorp produces thousands of
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different consumer electronic products, including TVs. Figure 10.18 shows the number of TVs sold for each of
these models in the Volume Sold column. To calculate the margin for each model, subtract the cost from the
price. Then, to calculate the profit per each model (Marginal Profit), multiply the margin by the volume sold.

Figure 10.18 Several simple formulas were used to calculate the profit margin for each model. (Used with permission from
Microsoft)

To calculate the total profit margin, you can use the SUM function on the Marginal Profit column. This simply
adds up all of the profit margin amounts for each model. Alternatively, you can get this same total by creating
a complex formula. Subtract the cost from the price, then multiply the difference by the volume sold, then add
the product of each model and the quantity. Remember to use parentheses to make sure that each section of
the formula is completed in the right order. The formula would look something like this:
=((Price1-Cost1)*Volume Sold1)+((Price2-Cost2)*Volume Sold2)+((Price3-Cost3)*Volume Sold3) [etc.].

The calculation in Figure 10.19a shows the wrong answer that would result from not using parentheses in the
formula. It uses the formula =Price1-Cost1*Volume Sold1+Price2-Cost2*Volume Sold2+Price3-Cost3*Volume
Sold3 [etc.], which means the cost is multiplied by the volume sold first, before being subtracted from the
price, which is not correct. Figure 10.19b shows the formula written the correct way (with the parentheses). It
uses =((B4-C4)*D4)+((B5-C5)*D5)+((B6-C6)*D6)+((B7-C7)*D7), which gives the correct result.
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Figure 10.19 In (a) the volume sold is incorrect because the parentheses that determine the order of operations in the formula are
missing; (b) is correct. These formulas show how easy it is to make a mistake in the order of operations. (Used with permission from
Microsoft)

Cell References in Formulas
In Defining, Selecting, and Naming a Cell Range, you learned about cell references and how to define a range
of cells. Now, we will expand this into Excel’s cell reference notation and learn how to use relative, absolute,
and mixed cell references.

Relative Cell References
Formulas use relative cell references by default in Excel. A relative cell reference is one in which the cell
reference in a formula or function updates automatically to reference an adjacent cell when you copy that
formula or function to another cell; in other words, if your formula refers to cells A2 and B2, Excel knows that
this means the columns are next to one another and in the same row. If you copy a formula with these values
to the next row, Excel will automatically change the cell references to A3 and B3.

Let’s consider an example. You want to replicate the TV profit calculation
=((B4-C4)*D4)+((B5-C5)*D5)+((B6-C6)*D6)+((B7-C7)*D7) in another table with different models of TVs. You
simply need to copy (Ctrl+C) the cell with the formula in it (D8), and paste (Ctrl+V) it into a new cell (D15). As
shown in Figure 10.20a, all of the Price, Cost, and Volume Sold values in the new table are different, and cell
D15 is blank. Once you copy the formula into cell D15 (as in Figure 10.20b), the result is that the formula will be
exactly the same, but the cell references will automatically be changed to reflect the new table:
=((B11-C11)*D11)+((B12-C12)*D12)+((B13-C13)*D13)+((B14-C14)*D14). As a word of caution, this only works if
the tables are uniform and the formulas needed are the same.
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Figure 10.20 Because the tables are identical in size and column values, the formula from (a) the first table will work perfectly when
copied to (b) the second table. (Used with permission from Microsoft)

MAC TIP

As a reminder, all shortcuts that use Ctrl on a PC use Command on a Mac.

Yet, as easy as relative cell references can be, they might not be appropriate for all circumstances. For
example, you may have a set of informational data that will be used recurrently, but you don’t want Excel to
move the reference of one or more cells, so the relative cell reference function will not work. This is when a
different type of cell reference can be used.

Absolute Cell References
An absolute cell reference is one in which the cell reference is fixed, regardless of where you copy the
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formula. To use the absolute cell reference feature, put a “$”before the column and row reference. For
example, $A$3 means that the reference to column A, row 3 is fixed. If you don’t add both “$” symbols, the
absolute cell reference won’t work, and you will simply have a relative cell reference. Another way to use the
absolute cell reference is with a shortcut. Click on the cell you would like to fix, and then click F4, and Excel will
automatically add the “$” to the cell.

Recall the loan you were analyzing for WorldCorp, but instead of using a Data Table What-If Analysis, you will
use the PMT function and absolute cell references. As shown in Figure 10.21a, the same loan interest rate data
remains, but now you will calculate the payments using absolute references. The formula in cell F3:
=PMT(E3,$C$2,-$C$4,0,0). You can click on the fill handle (the lower-right corner of the cell) of cell F3 and drag
it to F9. This copies the formula so that all the PMTs will automatically be calculated for you, using the fixed
references to cells C2 and C4. Figure 10.21b shows the completed table, and the formula in cell F9 shows the
updated formula with absolute cell references.

Figure 10.21 Using absolute cell references allows you to copy the formula to other cells without having to update your formula. (a)
The PMT formula in cell C5 calculates it using relative cell references. (b) Using the absolute cell references for cells C2 and C4, you
can create a table that shows the payment for various interest rates. (Used with permission from Microsoft)

Let’s examine this formula without absolute cell references; in other words, using relative cell references. If cell
F3 is =PMT(E3,C2,-C4,0,0), and you drag the fill handle to cell F9, then all the values from F4 to F9 will be
incorrect (Figure 10.22). Essentially, you have copied the same formula, but the relative cell references have
moved location along with the location of the formula. Instead of referring to cells C2 and C4 for each iteration
of the formula, the reference moved down one row for each row you copied the formula down the table.
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Figure 10.22 Using absolute cell references will avoid errors in your formulas when you are using the same cell in each of your
formulas. (Used with permission from Microsoft)

REAL-WORLD APPLICATION

Excel Horror Stories

Even the employee with the most certifications and skills in Excel can make mistakes. Excel facilitates most
computations, but if the user makes an error in the formula or with entering the data, there can be
significant consequences. For instance, you might think copying and pasting information would reduce
errors. However, that was not the case for an employee working at JP Morgan Chase. In 2012, an employee
copied and pasted content and formulas from one spreadsheet to another while working on a Value Risk
model. The data and formulas were untested and unverified, and errors were carried over into the model.

You should also consider the veracity and completeness of files you might receive. Barclays ended up
purchasing 179 contracts they did not want from the Lehman Brothers in 2008. Why? They received a
spreadsheet of Lehman’s assets, in PDF form. When they reviewed the Excel spreadsheet, they identified
179 contracts they did not want to purchase and hid those rows, but those notes were omitted from the
PDF when it was converted, and the hidden rows were visible. Excel is a very powerful tool; with that power
comes the potential for grave mistakes that can be incredibly costly. The utmost care and integrity must be
taken to ensure fidelity of any spreadsheet generated and/or shared.

Mixed Cell References
A mixed cell reference uses a combination of both relative and absolute cell references. A mixed cell
reference might have a fixed row but a relative column or a fixed column but a relative row. When the “$” is
directly to the left of the row number only (e.g., B$1), the row is absolute and the column is relative. When the
“$” is directly to the left of the column only (e.g., $B1), the column is absolute and the row is relative.

Let’s look at another example. The WorldCorp Portland, Maine, location offers different promotional discounts
as a percentage of the TV retail price depending on the month. The manager asks you to create an autofilled
table of the unit prices per TV model for the year 2020. That is easy to achieve manually, multiplying the
monthly discount times the retail price, but each cell reference has to be fixed as they move. To automate the
calculation, you can use mixed cell references. Figure 10.23 shows the retail prices per unit and the monthly
discount rates.
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Figure 10.23 Calculating outputs from tables with two sets of variables can be a good use of mixed cell references. (Used with
permission from Microsoft)

In Figure 10.24, the discounted retail price for model 32" LCD #E-900s is $168.30 to be calculated in cell D9.
This is obtained by multiplying the Price in column C9 by (1-discount rate found in cell D5). For this example,
this would be 170*(1-0.01) or C9*(1-D5). Without absolute cell references for either the column or row, the
table will not calculate correctly when the formula is copied (see Figure 10.23). Placing the $ before the column
(column C) for the price will fix the formula to always calculate the output based on column C, and the table
will fill properly with the discounted prices when you copy the formula from D9 into the remaining cells.

Figure 10.24 By having the columns fixed, the formula always references the Price column. (Used with permission from Microsoft)

Comparison Operators
The Excel comparison operators are the same as the inequality symbols used in math. These are: < (less
than), > (greater than), or >= (greater than or equal to), or <= (less than or equal to), = (equal to), and <>
(not equal to). Comparison operators can be used for comparing numbers. Comparison operators are valuable
because of their use in the IF functions. With the IF function (or similar functions like SUMIF, COUNTIF, etc.),
comparison operators can automatically search for important information. More will be covered about these
functions in Logical Functions.
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Arrays in Formulas
Array formulas can save time when used for basic or intermediate calculations (recall saving the time of
adding an extra column in Figure 10.15). But more importantly, array formulas are used for higher-level
calculations that may involve statistical and financial analysis, such as figuring out maximums and minimums
of a certain product (similar to MINIF and MAXIF functions) or summing certain X or Y rows/columns (similar to
SUMIF). In short, most array applications can be done in other ways in Excel, but using arrays allows you to do
multiple calculations at the same time.

Let’s use a manufacturing example to see how to use arrays in formulas. WorldCorp’s Fairfax, Virginia,
manufacturing plant transports their items by truck to the Portland, Maine, location. The Fairfax plant has
plenty of stock for some of the items in the orders, but not for all of them. Figure 10.25 shows the available
stock in the Fairfax plant (Quantity In Stock) and the amounts needed to complete the orders (Quantity
Planned). Let’s calculate the difference between these two numbers to determine if more is needed.
Specifically, if the Quantity in Stock (Column E) is larger than the Quantity Planned (Column D), we will not
need to manufacture more. To make this simple, we will use a simple subtraction calculation: Quantity in Stock
– Quantity Planned. If this value is a positive number, there is plenty in stock. This would be the case with Row
6 – Tablets 7in. The Quantity in Stock is 425 and the Quantity planned is 143. So, 425 – 143 = 282. So, there will
be 282 units remaining after filling the Quantity Planned order. If the value of the subtraction formula is
negative, then more product is needed. We see this in Row 4 where the Quantity in Stock is 464, but 542 are
Planned. Using the equation, 464 – 542, we are left with a shortfall of 78 units or -78. First, determine the
difference between the values in Column E and Column D using an array. This will allow us to do the
calculations for all rows in one step. Highlight cells G4 to G12. Then, in the Formula Bar, type the formula:
E4:E12 – D4:12 (Figure 10.25a), and then press Ctrl+Shift+Enter simultaneously for the curly braces to appear,
as shown in Figure 10.25b. The formula then is automatically entered for all highlighted rows.
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Figure 10.25 Make sure to highlight all the cells you want the formula to be entered into. (a) Notice the color coding of the formula
that corresponds to the colors in the columns below. (b) If you don’t press the Ctrl+Shift+Enter combination, the array will not work.
You will see the curly braces when you have a formula as an array. (Used with permission from Microsoft)

LINK TO LEARNING

For those who are new to using the Excel math syntax and notation, the first section of this video tutorial on
using math in Excel (https://openstax.org/r/78MathExcel) has a series of handwritten math exercises set
alongside the same calculations using Excel. Seeing math equations written out in the “traditional” way may
help you better understand how to devise Excel formulas. You can access the companion handout
(https://openstax.org/r/78CompHandout) to use as a reference.
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10.3 Using Arithmetic, Statistical, and Logical Functions

Learning Objectives
By the end of this section, you will be able to:

• Use basic financial functions
• Identify and use arithmetic and statistical functions
• Insert logical functions

The world has changed rapidly in the decades since the 1980s, as personal computers became commonplace
in offices and homes. Business calculations that used to be done by people in highly specialized accounting
departments using manual methods became automated. Production plans and managerial oversight are
informed with data from ever-expanding datasets that include data from sales to manufacturing. To manage
this data, WorldCorp uses complex worksheets that may link to other worksheets (or other workbooks), with
the aim of producing actionable business intelligence. To generate policies and strategic decisions, managers
must use every tool at their disposal, including functions like MIN, MAX, STDEV; financial calculations like PV,
FV, PMT; and logical functions like IF, AND, and OR.

Arithmetic and Statistical Functions
Functions used in basic math, or arithmetic functions, help users to add, multiply, find averages, and perform
other types of mathematical operations. You have already learned how to use basic math functions, but there
are others that will be very useful in basic data analysis, such as financial functions and statistical functions.

AVERAGE
The average, or mean, is a number found by adding up a group of values, and then dividing it by the number
of values you added up. Simply select the cell where you want to calculate the mean and type
=AVERAGE(range), and identify the range of the values you want to average.

SPOTLIGHT ON ETHICS

The Problem of Using Averages of Averages

When reporting on data, it may be tempting to average a series of averages to summarize information or
determine if there is a mass effect. It is especially tempting to do this in Excel, as it makes this process quick
and easy. However, averaging averages is very problematic and can indicate a greater impact than actually
realized. It is much better to use the original numbers to determine the actual average versus attempting
to average averages. That said, what happens if you do not have the original numbers? This may happen if
you are handed processed analysis separated from the original data source. In this case, using weighted
averages is a better approach. Weighted averages take into consideration the varying levels of importance
of different numbers that can be found within a given dataset; to ensure you capture the percent or
proportion of importance of these numbers, each number within the dataset is multiplied by a
predetermined value before the average is found.

To underscore, it is best to avoid averaging averages and instead use original values to calculate the
average of the totality of these values. If these are not available, you must use weighted averages that will
factor in the number of values included in the averages to determine the correct average. You can do your
own research regarding how to perform this calculation. There are plenty of simple but effective tutorials
available online.
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COUNT, ROWS, and COLUMNS
The function COUNT is useful when you have a large dataset of rows (or columns) and want to know how many
there are. When you type =COUNT(range), Excel will count the rows or columns with numerical values in the
range you identify. The major drawback of the COUNT function is that it will only count the number of rows/
columns that have numerical values, and it will ignore any text values. In this scenario, you need to use the
ROWS or COLUMNS function to count all of the rows/columns. Write them in the same way: =ROWS(range) or
=COLUMNS(range). Knowing the number of rows of invoices, for instance, can be useful if you need to have
the exact number of n for an equation.

MAX and MIN
Excel has functions that can determine the highest or lowest numbers in a dataset: MAX (=MAX(range)) finds
the highest value, and MIN (=MIN(range)) finds the lowest value (Figure 10.26). The range is the set of all of the
cells you are analyzing to find the maximum or minimum value.

Figure 10.26 The MAX and MIN functions are useful if the dataset is very large, and you cannot see the minimum or maximum value
with a quick glance. (Used with permission from Microsoft)

Standard Deviation
A common statistical tool used by many data analysts to calculate the variability of the figures in a dataset
from the arithmetic mean is called standard deviation. In other words, it tells how much the figures vary from
the average. For example, if you have a dataset of invoices from client A, and the bills vary in their total by a
considerable amount, then you would have a high standard deviation. If the invoices of client B vary less,
meaning their totals are similar every time, then the standard deviation will be low. Excel has a quick way to
calculate this: the STDEV function. Type =STDEV(range) and Excel will give the standard deviation for that
range. For example, Figure 10.27 shows the standard deviation for the range F3:F11.
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Figure 10.27 The standard deviation is probably the most used statistical tool in the data analysis set of formulas. (Used with
permission from Microsoft)

Financial Functions
The main functions used for calculating loan installments, investment returns, net present value of capital
investments, mortgage payment comparisons, and many more real-world applications are called basic
financial functions. These functions are NPER, RATE, PV, PMT, and FV, which correspond to the N, I, PV, PMT,
and FV in financial calculators. You learned about the PMT function in The Advantages of a Data Table.

Date and Time Functions
On their own, the DATE and TIME functions do not seem very useful, as you can easily just enter a date or a
time in a cell by typing them. But these functions are often used in conjunction with other Excel features, such
as in array formulas or complex IF functions. To enter a date, write =DATE(year,month,day), using the date’s
numerical values, and Excel will return with a formatted date, such as 3/31/2021. For the TIME function, write
=TIME(hour,minute,second) in 24-hour format, and Excel returns a time in am/pm format. If you typed
=TIME(14,44,24) Excel would return 2:44 PM.

Logical Functions
Typically, logical functions are long formulas with embedded logical tests and often use comparison
operators to search for delimited data. They compare two values in your worksheet and return one result if the
comparison is true and a different result if the comparison is false. These logical functions are powerful tools
for allocating and sourcing large amounts of data.

The IF function is one of the most used functions in Excel. It is regularly used in conjunction with other
functions. Moreover, IF functions are regularly combined with array formulas. Figure 10.28 shows an example
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from the WorldCorp Portland, Maine, shipments. The IF formula, written as =IF(logical test,value if true,value if
false), analyzes the FOB values, and inserts “Over 20K” if they are greater than or equal to $20,000.

Figure 10.28 Excel gives users the freedom to invent their own true and false tags. (Used with permission from Microsoft)

SUMIF and COUNTIF are other logical functions that are very useful. The SUMIF formula, written as
=SUMIF(range,criteria,sum_range) will give a total of a given range (sum_range) if certain criteria are met. For
example, you can create a SUMIF function to search for and add up the amounts of all purchase orders of
more than 30 servers (=SUMIF(C3:C235,“>30”,D3:D235)).

The COUNTIF (=COUNTIF(range, criteria)) function is similar except that it gives you the number of cells that
meet the criteria rather than a total. You can use a COUNTIF formula to find the number of invoices that are
equal to a certain sale amount (=COUNTIF(A2:A500, “=5000”)). Using these formulas with comparison
operators makes gathering intelligence from large datasets easy.

Let’s revisit our WorldCorp example. WorldCorp exports that go through Portland, Maine, use container ships
to transport goods to their destination. Figure 10.29 shows the shipment data from March 2021. Apply
COUNTIF and SUMIF formulas to gather information on how many shipments meet certain criteria. The Excel
notation used for the COUNTIF formula in cell I7 is =COUNTIF(D2:D10,“>=1000”), which calculates how many
shipments (column D, “Quantity”) contained more than 1,000 pieces. The SUMIF formula in cell I2 is
=SUMIF(F2:F10,“>=20000”), which adds up all of the FOB amounts that were more than $20,000. (Notice how
the comparison operators and their numbers are in quotation marks—this is necessary to calculate the
formula correctly.)
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Figure 10.29 Different types of IF formulas are often used to look up values that meet a certain criterion. (Used with permission from
Microsoft)

The AND, written as =AND(logical1, logical2), is regularly used in combination with the IF function. It can be
used in limits, establishing a low and a high limit, and labeling them if they meet these criteria. In our
WorldCorp example, this could help sales managers at the Fairfax, Virginia, location identify any invoices that
are below a certain value, thus flagging those customers who might be retail consumers instead of wholesale.
The formula in cell G2, in Figure 10.30, sets up an IF test: if both of the AND criteria are true (if the FOB is
greater than $0 and less than $1,000), then the tag “Low Value” appears in column G.

Figure 10.30 The AND function can be used as an interval, as shown here. (Used with permission from Microsoft)

The OR is similar to the AND function in that it compares two values, but with the OR function, only one
argument needs to be satisfied. It, too, is often used in conjunction with the IF function. In Figure 10.31, the
sales manager is automating the Excel worksheet to show when quantities fall outside of certain values. This
could flag a product if sales fall below 200 units, for example, because it could indicate that it requires more
marketing or additional investigation into the drop in sales. Likewise, the sales manager wants to know when
quantities are above 1,000 units, which might trigger a discount for customers or additional incentives for the
sales agent. Use the OR function to “flag” these orders for additional review.
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Figure 10.31 The OR function is more flexible than the AND function, as the interval can be either. (Used with permission from
Microsoft)

The NOT can also be used to look for values that meet a certain criterion. It is regularly used in combination
with the AND, OR, and IF functions. In Figure 10.32, NOT negates the criteria set forth by the AND function;
namely, that if the FOB amount is not greater than or equal to $0 and also less than $1,000, then the tag “High
Value” should appear in column G.

Figure 10.32 The NOT function is regularly used in complicated IF functions. (Used with permission from Microsoft)

LINK TO LEARNING

Nesting occurs when we have a formula that uses a function and includes a function as one of the
arguments; these functions are typically known as nested functions. Nested functions are used in the
workplace to evaluate several conditions at a time. This can be helpful when you have multiple criteria that
influence a single outcome. This can be a powerful approach to performing calculations in Excel; however,
they can be very complicated as they require a specific structure in order to ensure accuracy. This tutorial
from Microsoft (https://openstax.org/r/78NestTutorial) walks us through this structure. The uses for this
approach are limitless, as you can nest up to 64 levels.
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10.4 PivotTables

Learning Objectives
By the end of this section, you will be able to:

• Define a PivotTable
• Organize and clean your data prior to designing a PivotTable
• Design/insert a PivotTable
• Understand and use the recommended PivotTable tool
• Add a PivotChart to pictorially present the data

PivotTables help data analysts use raw data and organize it into an interactive tool for summarizing and
analyzing the data points. WorldCorp can, for example, gather their manufacturing datasets of each machine’s
daily performance and put this information into a table that the PivotTable tool can use to analyze the
information. This type of organization would be useful for producing various metrics (such as machine
performance) and company Key Performance Indicators (KPIs). The PivotTable tool can also divide data into a
set of criteria, which will organize your data by variables you choose. This separation and division of data help
you create business intelligence with ease.

Definition and Uses
Excel has various ways to store data and various tools that aid in data intelligence queries. You’ve learned the
purpose of using What-If Data Tables, naming ranges, using comparison operators and writing statistical and
logical functions—all of which can be combined with arrays (or other tools) to make interactive and automated
tables. Excel has an even quicker way to make relational tables and automated business intelligence:
PivotTables.

A PivotTable lets users create interactive charts and tables from raw datasets. They can process large, raw
datasets and allow the user to choose how the data will be tabulated and summarized using easy drag-and-
drop features. PivotTables also help summarize the data for a professional appearance and to show it in a
more user-friendly way. Out of thousands of rows and columns of raw data, you can produce a simple, easy-to-
read table with different options for displaying your metrics. Some applications of PivotTables might include
producing metrics for website views and ad clicks, displaying demographic information for a county or city, or
gathering information about small business revenue. In each of these cases, PivotTables can be used to
process large, ever-growing datasets into readable tables.

Organizing and Cleaning Your Data
Let’s return to the example of shipped products from WorldCorp’s Portland, Maine, location. PivotTables can be
used to aggregate values and create an actionable market analysis and business intelligence for the company.

The first step of creating this PivotTable is to organize and summarize the data. Having a digestible raw data
sheet that Excel can read well enough to aggregate the data is critical. To clean the data, you should ensure
that:

• There are no merged cells anywhere in the data.
• All filters are inactive.
• There are no SUM functions on the bottom or sides of the worksheets.
• All erroneous, duplicate, and/or blank values are deleted from the data.
• All values in each column are of the same value (e.g., currency, date, text).

Next, convert your data into a top-down table, meaning that all of the data range headers should run along
the top row of the sheet. This is the typical format for tables and will make using PivotTables much easier. In
general, horizontal tables can be hard to follow. Cross-tabular source data (with headers on top/bottom and
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left/right) are even more difficult to read for the PivotTable generator. Designate a unique name for each top
header; do not repeat any column header names. Figure 10.33 shows a correctly formatted worksheet. You
can copy this worksheet into Excel, or you can use the data in the "pivot_table_data" tab of the downloadable
Chapter 10 data file (https://openstax.org/r/78Ch10DataFile) workbook.

Figure 10.33 This small representation of data is a sample of what could be hundreds, thousands, or millions of individual shipments
a month. (Used with permission from Microsoft)

Inserting a PivotTable and Rearranging Variables
To create a PivotTable, go to the Insert tab, choose the PivotTable icon located on the far left, select the entire
dataset, and output to New Worksheet. (Alternatively, you may name your data ranges, as instructed in
Defining, Selecting, and Naming a Cell Range, and simply select the named ranges for your data.) The Field List
will activate and ask which columns to display, as shown in Figure 10.34. Select the headers (variables) in the
order that you want the PivotTable to display them. In the WorldCorp example, to see the quantity each client
is buying, select Destination, then Quantity, and then FOB $. As shown in Figure 10.35, the PivotTable neatly
displays the data, with interactive features allowing the user to select different pieces of information as
variables.

Figure 10.34 The PivotTable wizard can help to create clean, interactive tables from raw data. (Used with permission from Microsoft)
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Figure 10.35 The PivotTable displays the data. (Used with permission from Microsoft)

Now, to further delimit the details of the clients, add Date to the variables (Figure 10.36a). Because you chose
Destination first, you are separating all the variables and ordering them by client to know what the client is
consuming in volume and in dollar amount. Adding the date allows you to see total sales but also breaks down
the data by month.

This is only one way to create a PivotTable with this data. If you were to change the order in which you selected
the headers in the PivotTable wizard, the whole table would be different. Additionally, you can choose a
different set of data to display, which changes how the information is grouped. To demonstrate this, uncheck
Date (you have to uncheck Months, too) and instead check Product. As seen in Figure 10.36b, the table gives a
totally different perspective. Instead of seeing the data grouped by Date, the grouping has changed to show
the products the client ordered and the quantity of each.

Figure 10.36 Selecting headers in a different order will change where and how they appear in a PivotTable. (a) The original table
broke the data down by date, and (b) the new table breaks down the data by product. (Used with permission from Microsoft)

You can easily change the arrangement of the PivotTable using the fields in the lower half of the Field List. You
can drag and drop the variables from one field to another to change how they appear in the PivotTable. For
example, you can change the arrangement of the rows by putting Product first. This automatically changes the
PivotTable completely, from being destination oriented (as seen in Figure 10.37a) to being product oriented
(Figure 10.37b).
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Figure 10.37 Changing the headers can change the entire table. (a) You can rearrange the data so that product comes first. (b) The
PivotTable looks completely different from the previous destination-oriented table. (Used with permission from Microsoft)

Let’s apply a filter to the results from Figure 10.37b. To filter by date, first check the Date and Month variables
on the top half of the Field List. Then, drag and drop the dates from the Rows to the Filter field, as shown in
Figure 10.38a. This will allow you to apply a filter to the dates and be able to select only certain dates. To see
just the February sales, go to the Month drop-down menu on the PivotTable and select Feb. Now, only the
sales from that month will appear (Figure 10.38b).
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Figure 10.38 Filters are useful for when you want to see only a subset of your data. (a) You can choose a single month in the filters.
(b) The table then shows you only that month’s data. (Used with permission from Microsoft)
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Using the Recommended PivotTable Tool
If you are unsure how to organize a PivotTable for your data, Excel can recommend one depending on how the
data is organized. Let’s see what using a recommended PivotTable might look like.

Go to the Insert tab and select the Recommended PivotTables icon. A dialog box appears with a handful of
recommended charts. Scroll and select the one you like best. These recommended tables may be helpful to get
you started, but they only compare one variable at a time. However, if you choose one, the new PivotTable will
appear in another worksheet, and you can customize it there, adding or reorganizing variables until you have
a PivotTable that presents your data in a way that makes sense.

Adding a PivotChart to Visually Present Data
Excel has a feature that allows you to create a PivotChart to visually present the data in your PivotTable. The
first step is to select the entire PivotTable, which causes the ribbon tab “PivotTable Analyze” to appear. Next,
select the PivotChart icon. You will use a small dataset from Figure 10.31 to create a chart of the information.
More in-depth coverage of PivotTables is in PivotTables/Charts. Figure 10.39 shows the original data and Figure
10.40 shows the data summarized in a PivotTable by sales agent. To create a chart of the data summarized in
the PivotTable, choose PivotChart from the PivotTable Analyze tab.

Figure 10.39 The data is summarized in a simple table. (Used with permission from Microsoft)
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Figure 10.40 Placing the data in a PivotTable enables further analysis and filtering of the data to meet specific needs. (Used with
permission from Microsoft)

For the data in Figure 10.40, a bar chart, pie chart, or clustered column chart would be optimal. These chart
types are appropriate because they allow you to see the difference in scale between the sales levels of the
agents. For this example, choose the column chart. With the column chart, the higher the column, the greater
the sales totals for that agent. You can further customize the column chart by adding percentages or labels.
The Agent drop-down menu in Figure 10.41 allows you to further filter or change the column chart.
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Figure 10.41 You can further customize the PivotChart by adding features such as value labels or by sorting the information in a
different order. (Used with permission from Microsoft)

REAL-WORLD APPLICATION

Using PivotTables to Track Spending

PivotTables can be a powerful tool for businesses in budgeting and creating other financial reports and
analyses. You can also use PivotTables for your own personal budgeting. There are many budgeting
services available online or through apps, but you can create your own powerful budgets that can help
track all personal finance matters, including spending, without paying for an online service or app. As an
individual, you might be able to track your budget fairly easily; however, as your financial matters become
more complex, or as your family grows, Excel can come in handy to assist you in managing your budgets
without the additional expense of a service or application.

To get started, you can download a CSV file of your transactions from your financial accounts. Most
institutions will have this function where you review your account and transaction information online. You
will want to collect all information, particularly from your spending accounts, such as credit cards. Once
these are gathered, be sure to validate the information, then create a column heading named Category.
You will then create your categories, such as Food or Entertainment. Some credit cards will auto populate
these categories when you download your transactions, but you will want to verify these are accurate. From
there, you will complete your PivotTables using the instructions you can find in this textbook. You can opt to
create different timelines of your budget, such as daily, monthly, or yearly, depending on your own budget
analysis needs.
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10.5 Auditing Formulas and Fixing Errors

Learning Objectives
By the end of this section, you will be able to:

• Explain the reasons formulas may need to be audited
• Identify the various errors that may be present in worksheets and tables
• Identify the cells involved in a formula
• Implement the appropriate options for auditing various aspects of formulas

WorldCorp receives many client orders every day, and the corporation needs to have an accurate count of
inventory to ensure that they have the capacity to deliver orders on time. This real-time inventory handling and
customer relationship management can only happen by implementing computer systems that track these
business activities. Microsoft Excel can be programmed to help in fulfilling these tasks with the right data. Yet,
as you can imagine, this enormous data load can be daunting, and occasionally, small errors may be made in
some formulas. Excel has various tools for the user to identify such errors, and thus correct them.

Reasons to Audit Formulas
As a business grows, its activities grow in complexity, requiring higher-level and concurrent data analyses. As a
result, managers build large Excel workbooks to handle these business operations, designing spreadsheets
with a wide selection of formulas, functions, PivotTables, arrays, data ranges, What-If Data Tables, and other
Excel data exploration tools. Each of these tools requires user input, which makes them inevitably subject to
user error. The process of using Excel tools to monitor and fix errors in worksheets is called auditing
formulas.

Remember that almost all formulas or functions have relationships to other areas of the workbook. Cell
references or named ranges may even refer to other cell references, creating a complex web of references. If
the key data points do not have the right formula or function, the resulting value will not be correct. You may
also see an error message in Excel if the user settings are set to alert the user when a formula or function has
a broken link or incorrect syntax.

Identifying Errors in Worksheets and Tables
There are many ways to check for errors in your workbook. These include tracing precedent functions, tracing
dependent functions, showing the formula, and automated checking of errors. When tracing precedent or
dependent functions, you are finding the relationships between cells.

When you are tracing precedent functions, you are finding the source of an error in a formula by locating the
cells that provide the data to perform the calculation in the active cell. The arrows will point to the cells that are
used to construct the formula used in the active cell so you may review them before making a correction.
When you are tracing dependent functions, you are finding any cells affected by the active cell. You would
want to do this before deleting a cell from a worksheet. These specifically relate to checking cell references and
the information found within them. Figure 10.42 shows the output when tracing precedents for a cell.
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Figure 10.42 The arrows point to cells B2 and E2 that are used to determine the highest value in the formula. (Used with permission
from Microsoft)

Showing the formula is simply looking at a certain formula or function and manually checking its syntax. There
is a command on the Formulas tab called Show Formulas that will automatically show which cells contain
formulas. The actual formula in the cell is displayed, replacing the value that was calculated from that formula.
It changes the content of the worksheet to show exactly what formulas are in the cells. This is a good first step
to finding errors in formulas. To hide the formulas and return to the original spreadsheet with the computed
values, simply select the Show Formulas command again. There is also an Error Checking command, which can
help to identify specific errors in formulas.

Before any error checking can occur, first make sure that your version of Excel is tracking the errors when they
happen. Click on the File tab and select Options. In the dialog box, choose the Formulas tab, and check the
“Enable background error checking” option. You should also check all of the “Error checking rules” boxes, and
then click OK, as shown in Figure 10.43.
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Figure 10.43 Error checking starts with having Excel notify you if any error happens. (Used with permission from Microsoft)

Remember that there are two main characteristics that all formulas have:

1. All formulas must start with the equals sign (=).
2. Formulas have constants, cell references, or both, and operators, functions, or both.

Constants are numbers that are typed inside a formula; they can be integers or rational numbers. Operators
are math notation signs for performing different calculations, such as +, –, *, /, and ^. These operators must
respect the order of operations (PEMDAS). If the formula is complex—if it has multiple functions, for
example—you must ensure that the function’s syntax rules are obeyed. For example, the PV function must
include values for RATE, NPER, PMT, and FV, in that order, or the function will not work.

There are several types of potential errors. You may have syntax errors (not having the right argument in the
function or having too few or too many arguments); capacity errors (in Excel, you cannot have more than 64
functions in a cell); or sheet or cell reference errors. It is worth noting that, when linking a formula in one
worksheet to a cell in another worksheet, Excel automatically adds the sheet’s name and “!” after the sheet’s
name; you must double-check that you didn’t delete this mark. For example, WorldCorp’s data for two clients is
seen in Figure 10.44a. You summarize the overall total on a separate sheet, which references the first sheet.
Notice in the formula the “!” after the worksheet named “data” and before the cell reference you include in the
calculation (Figure 10.44b).
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Figure 10.44 (a) You can use the data on one worksheet in a formula on another worksheet. (b) Excel will include the name of the
worksheet followed by “!” in the formula. (Used with permission from Microsoft)

Additionally, several errors have specific code assignations that should automatically appear in your cell if you
have an error. These code errors are preceded by “#” to indicate that they are errors. Some of the common
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code errors are described in Table 10.5.

# Code Explanation How to Fix It

####

This common error is a
formatting error rather than a
formula error. It occurs when
the column is not wide enough
for the numbers to be
displayed.

Make the column wider.

#NAME?

This error is displayed if the
function is not well-written,
such as if there is a typo in the
name of the function, or the
designated function name is not
complete or is written
incorrectly.

Find the correct wording of the function by clicking
on the Insert Function tool.

#DIV/0!

This error happens when you
divide by zero. This can also be
caused if a linked cell reference
has no value.

Enter a value in the cell, or add the correct constant
in the denominator.

#NULL!

This happens when the Excel
notation syntax rules are not
obeyed, such as if an operator is
incorrect or missing.

Follow the pop-up menu that appears when writing
a function. It tells where commas should be, what
value should be referenced, and so on. If the error
was made in the past, you can consult the roster of
functions on the Formulas tab in the ribbon and
selecting the Insert Function icon.

#NUM!

This happens when a cell
reference contains
contradictory or unsound
numbers that stop the function
from calculating the result.

Check the referenced cells, and retype the numbers
that are unsound.

#REF!

This means that the cell
references in a formula are not
there anymore, or the cell
reference was entered
incorrectly in the formula.

Find the correct cell reference and fix the formula.

Table 10.5 Common Code Errors These are many of the most common code errors, and how to fix them.
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# Code Explanation How to Fix It

#VALUE!

This happens when a cell
reference has a different data
type, for example, when you
use a function that requires two
numerical values but you insert
text for one of them.

Use the same data types.

#N/A
This happens when a function
searches for a certain value and
the function cannot find it.

Change the criterion on the search operators (e.g.,
LOOKUP function).

#GETTING_DATA

This is a temporary error. While
waiting for Excel to calculate a
complicated query, Excel will
process the answer in a few
seconds and display this error.

Wait for Excel to calculate the answer.

Table 10.5 Common Code Errors These are many of the most common code errors, and how to fix them.

Identifying the Cells Involved in a Formula
Excel makes it easy to find cells that meet certain criteria. For example, Excel can highlight all cells in a
worksheet that contain formulas. To do this, select a cell (Figure 10.45) and go to the Find and Select icon on
the Home tab, then choose Go To Special (Figure 10.46a). Next, select Formulas, then click OK (Figure 10.46b).
All the cells that contain formulas will be selected (highlighted) in that worksheet.

Excel also has a built-in feature, called the Watch Window, that allows users to see where each constant,
reference, and operators are correct. Select the Watch Window icon (on the Formulas tab in the ribbon). The
Watch Window will be blank, so choose Add Watch, and select the cell or cells you want to analyze, as shown in
Figure 10.47. Putting a cell or a range in the Watch Window allows you to monitor the cells you choose to
ensure they remain error-free as you continue to work in a worksheet. You can add multiple cells to the Watch
Window by following the same process. The Watch Window tells you the value and the function, the sheet, the
workbook, the cell, and the defined name to help you identify any errors.
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Figure 10.45 The Watch Window can tell you the relationships of the cell to other cells. You can use Find and Select to highlight cells
that contain items such as Notes or Formulas. (Used with permission from Microsoft)

Figure 10.46 (a) Use Go To Special to define what elements you want Excel to search for in the cells on the worksheet. (b) Watch
Window is an alternative to see the formulas in cells on a worksheet. (Used with permission from Microsoft)
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Figure 10.47 Click Add Watch to list the cells and the formulas. (Used with permission from Microsoft)

Another way to dissect a formula is by selecting the cell and choosing Evaluate Formula (on the Formulas tab).
This command solves the formula piece by piece to ensure that the formula is built correctly. First, the formula
displays as shown in Figure 10.48. Then, select Evaluate, which will solve the first argument of the function,
then click on Evaluate again and the second argument gets resolved. Continue to click Evaluate to solve the
formula one argument at a time, until you reach the last argument, where the final step is the calculation
result. This lets you confirm that the cell is calculating correctly.

Figure 10.48 shows the Evaluate window when it first opens, and Figure 10.49 shows the last step before the
final answer is shown in the window. If clicking the Evaluate button does not provide clarity on the formula,
you can use Step In, which shows a more detailed view of all of the components of the formula. You are
essentially going into the formula to see all the cell references that contribute to the data in that cell. If you use
Step In, you will need to click Step Out to go back to the macro view of the formula and to proceed to the next
argument, as shown in Figure 10.50. You can use this method to break down complex formulas that might
include cell references in other worksheets.

Figure 10.48 The Evaluate Formula tool can easily show where the error is by solving for each argument. Choose Evaluate to go step-
by-step through the formula. (Used with permission from Microsoft)
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Figure 10.49 To see the result, choose Evaluate. (Used with permission from Microsoft)

Figure 10.50 Step In takes you into the formula for a more detailed view, and Step Out goes back to the original full formula instead
of the individual components. (Used with permission from Microsoft)

Another way to see the references of a formula is by simply selecting the cell in question, and then pressing
Ctrl+[ (Control and open bracket) to see dependent references, or Ctrl+] (Control and close bracket) to see
precedents. This simple method selects all the cell references of the formula in question, as shown in Figure
10.51a. You can see that cells C2, C4, and E3 are selected and shaded in. These commands serve a similar
function as the Trace Dependents and Trace Precedents tools; they show the dependent cells or precedents,
but they do not draw a line like the Trace Dependents and Trace Precedents tools do.

If a cell has no dependent cells—cells that are depending on this data from other worksheets, or workbooks,
or from another table in the same worksheet—then you cannot perform the Ctrl+[ command, as shown in
Figure 10.51b. In this example, there were no dependent cells.
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Figure 10.51 The Ctrl+[ command is a simple way to see dependent cells. (a) Excel highlights the dependent cells. (b) If there are no
dependent cells, Excel will let you know that there are none. (Used with permission from Microsoft)

The most comprehensive way to see your cell relationships is by installing the Inquire add-in. First, go to the
Add-ins menu (File > Options > Add-ins) (Figure 10.52). Look for Manage drop-down at the bottom of the
window and select COM Add-ins, from the drop-down menu. Then, select Go. Then, check Inquire and click OK,
as shown in Figure 10.53a. Excel adds a new tab to the ribbon. From that ribbon tab, select Workbook Analysis
(Figure 10.53b). The workbook will be displayed with all its formulas and connections between cells, and all
formulas will be categorized by the type of function used (Figure 10.54). This new ribbon tab also offers the
features Workbook Relationship, Worksheet Relationship, and Cell Relationship, all of which give a graph of the
relationship between the sheet and the precedents and dependents in the worksheet.
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Figure 10.52 Access Excel Options from the File tab to find Add-Ins. (Used with permission from Microsoft)
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Figure 10.53 (a) Inquire is a formula-auditing tool that does what the Watch Window does but also gives the found errors and
organizes the formulas by categories. (b) Inquire will be added as a tab giving you several options to choose from. (Used with
permission from Microsoft)
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Figure 10.54 You will be able to see all formulas in the spreadsheet with their location identified by the cell reference. (Used with
permission from Microsoft)

MAC TIP

In the Mac version, all add-ins are located in the Tools menu.

Choosing and Implementing Formula Auditing Options
Let’s look at an example to practice identifying errors and choosing and implementing the correct ways to fix
those errors. Using the WorldCorp loan installment example, suppose that the loan the company settled on
has a 5.5 percent interest rate, resulting in a payment of $99,500.83 per year in interest and principal.
Therefore, the total cost of the increase in capacity for the manufacturing plant will be $995,008.27. Cell F4
now has precedents and dependents, as shown in the arrows in Figure 10.55.
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Figure 10.55 The cell pulls data from many other cells. By using Trace Precedents and Dependents, we can visually see the cells that
are connected by formulas. (Used with permission from Microsoft)

The data in Figure 10.55 looks good, but suppose you get a #NUM! error in cell F4 (Figure 10.56). Recall that
this type of error means that the formula contains contradictory or unsound numbers that stop the formula
from calculating the correct result. First, try the Error Checking tool. Change the location of the N variable to a
blank cell, C1. This gives the error shown in the figure. The formula cannot be calculated based on a blank cell.
Choose the Error Checking tool from the Formulas tab in the Formula Auditing command group.

MAC TIP

In the Mac version, the Error Checking tool is located in the Formulas menu.

When the window appears, choose Show Calculation Steps (Figure 10.56). This opens the Evaluate Formula
command, which shows the formula already solved (Figure 10.57a). When examining the formula, you can see
the values of 0.065 for the rate and 750,000 for the principal. Because the PMT function requires you to input
N, or the number of payment periods, you would also expect to see 10 in the formula, but there is a 0 instead
of a 10 in the N variable location in the formula. Thus, you can see where the problem in the formula is, so you
can fix it. If you then close the Evaluate Formula window, you are taken back to the Error Checking tool from
where you can choose Edit in Formula Bar. When selected, the cells used in the formula are highlighted. At this
point, you should see that the formula uses cell C1, not C2 as was intended. Revise the formula to replace C1
with C2 (Figure 10.57b), and run the Error Checking tool again. Now the worksheet doesn’t have any errors
(Figure 10.58c).
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Figure 10.56 The formula cannot calculate an answer because of an error on the worksheet. The Error Checking tool is similar to the
Evaluate Formula tool, except that it checks the whole worksheet at once. (Used with permission from Microsoft)
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Figure 10.57 (a) Show Calculation steps will show you where the error is located. (b) You can adjust the formula to address the error
on the spreadsheet. (Used with permission from Microsoft)
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Figure 10.58 Running Error Check again indicates that the spreadsheet is now error-free. (Used with permission from Microsoft)

SPOTLIGHT ON ETHICS

The Tick and Tie Method

All businesses should have multiple ways of checking and auditing their financial statements. Often this is
referred to as “checks and balances.” One example for banking purposes would be to require two
signatures on all checks that are written on the account. That then ensures that two different people have
approved the check. The concept of auditing in accounting is checking and double-checking that the
financial statements are accurate and follow the appropriate accounting standards. This not only protects
the company from the consequences of errors, but it can also ensure that the company employees are not
committing any wrongdoing.

One method to accomplish this is the “tick and tie” internal auditing method, which involves verifying the
numbers on one financial statement with those on another. Managers can use this method internally to
monitor transactions for irregularities (payments to unknown vendors, for example) or verify that company
financial statements balance before the external auditors do a yearly review. It is better to monitor
constantly and consistently than to wait for the external auditor to find the errors. Also, by having a regular
internal audit of the finances of the company, you can create a culture that expects honesty and integrity. If
you happen to find a deliberate error by an employee, you can address it quickly. By using the tools
available in Excel, you can set up an internal audit system to use regularly, thus creating the culture in the
organization and identifying misconduct quickly.

10.6 Advanced Formatting Techniques

Learning Objectives
By the end of this section, you will be able to:

• Create custom formats for worksheet or table for appearance
• Create custom formats for a worksheet or table for content
• Copy formatting from one range of data to a new range of data

It is important for organizations to use uniform branding and style, which can appear anywhere, from emails
to invoice templates to Excel files. Having a uniform style within an organization adds a level of
professionalism and consistency to the business, and these may be tied to the company’s intellectual property
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and similar protections. Many organizations provide guidelines or manuals for all files produced, to ensure
that all employees can easily follow the same style or use the same templates.

Microsoft Excel offers many prepackaged themes and styles that can be easily applied to tables and
spreadsheets. But it is also possible to create your own custom format. This can be ideal for businesses that
want their products to look a certain way and contain specific branding.

Custom Formats for Appearance
The tables and datasets you’ve been working with were finished versions, with color, font, table size, and
background set. Here, you’ll create these tables step-by-step with themes and other style elements.

Using Existing Themes
To make formatting easy to use and high quality, Excel offers Themes. Applying a Theme can quickly change
the color scheme, fonts, and size of a table or graph. For example, you could easily change the formatting of a
table without manually readjusting everything. If your objective is to save time when changing the overall
formatting, choose a default theme and all the formatting will be handled automatically.

To access Themes, go to the Page Layout tab and select the Themes icon (Figure 10.59a). Then, choose any of
the available themes. (“Wisp” is shown in Figure 10.61.) All of the formatted tables and graphs in that particular
workbook will be changed. If you have a simple worksheet with no specific formatting such as colors, font
style, and the like, when you choose a theme, nothing will change. However, if you have a worksheet with
formatted headings and charts, you will notice changes when you select a theme. The Color combo box lets
users further modify the theme by selecting a different color palette (Figure 10.59b).

For additional changes, the Home tab has a combo box called Cell Styles that lets users select other font sizes
or background colors, as shown in Figure 10.60. Depending on your selection in the Colors menu in the
Themes command group (Page Layout tab), the options in the Styles menu will change. For instance, use Blue
from the palette, and in the Styles combo box, select Heading 3 and Accent 5, 40%. If an orange color palette
from the Color menu was chosen, the Styles options would be orange tones.

722 10 • Advanced Excel Formulas, Functions, and Techniques

Access for free at openstax.org



Figure 10.59 (a) Themes are useful if your company has a custom theme to apply for all charts. (b) Color schemes can be customized
to meet your needs. (Used with permission from Microsoft)
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Figure 10.60 You can use the built-in themes to automatically format heading and numbers. (Used with permission from Microsoft)

Figure 10.61 Applying a theme is easier than formatting each section of the table individually. (Used with permission from Microsoft)

Creating Custom Themes
Often companies will have a color scheme for all communications and materials within and outside of the
company. The palette is usually linked to the company logo and is an essential part of creating a unified and
professional appearance for marketing purposes and legal usage. If a company has a specific theme, it can be
saved and used by all employees. The saved theme file can be shared company-wide to ensure consistency.
Moreover, the saved theme can be used across all Microsoft products.

There are two ways to create a custom theme. First, users can create the theme from scratch. This means you
define the font, color, and other elements of the theme. Second, and perhaps easier, is to start with an existing
theme that is close to the desired theme. You can then make the needed adjustments such as changing the
font or modifying heading colors slightly. First, format your table using the desired settings, and then choose
Save Current Theme at the bottom of the Themes menu to save the theme as a file that can be used in other
Microsoft products and/or shared with others.
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LINK TO LEARNING

Go to Microsoft’s theme repository (https://openstax.org/r/78MicroThemeRep) and look for Excel themes.
Think about how they might be used in a business. Look for themes that might be appropriate for an
accounting department or a human resources department.

Other Formatting Tools
Another time-saving strategy is using the Format as Table tool. On the Home tab, select the Format as Table
combo box to see many options for formatting tables (Figure 10.62). The background color, heading font, and
borders can be changed; additionally, column widths will change automatically to fit the text. This feature also
automatically adds filters to the columns, which can help with organizing the data in a table Figure 10.63.
However, using the Format as Table feature does not format cells according to their content, such as currency.
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Figure 10.62 The Format as Table tool is a simple way to add full formatting to basic tables. When you format the selection as a
table, there are several color options and themes to choose from. (Used with permission from Microsoft)

Figure 10.63 You get a filter option after the selection is formatted as a table. (Used with permission from Microsoft)

Adding Images to the Background
Beyond formatting cell content, you can also add an image to a table’s background. The background is a
canvas that is displayed behind the cell contents of a worksheet. It could be useful to add a logo, or a topic-
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related image to the background of a table, especially for an internal or client-facing presentation. Often, this
feature is used to indicate that documents are not finalized but in a “draft” stage.

To add an image in the background, first select the table, then go to the Page Layout tab and select
Background. You will then be prompted to select an existing file, or you can search online for an image. An
image of the word “Confidential” has been added in Figure 10.64 to show that this report should be kept
confidential and not shared. You may insert an existing file or search the internet for a picture.

Figure 10.64 The background change tool is useful for design purposes or for company branding. (Used with permission from
Microsoft)

Custom Formats for Content
Custom formats for content allow users to design a format for data contained in cells. For example, you can
use custom formatting to set a format type for how your purchase order numbers are input into your
company’s system, or to change how dates are displayed. This feature is different from merely changing a
cell’s format such as the decimal points displayed or how months are abbreviated. Instead, the custom format
can be saved as a format that is then widely applied to worksheets. You can create a format from scratch, but it
is easier to use one of the built-in formats and adjust if necessary. You can customize most aspects of the
formatting—from spacing, to displayed decimals, to font color.

Shortening Large Numbers
Sometimes, the appearance of many repeated large numbers in a spreadsheet can be overwhelming. Other
times, you may simply want to reduce numbers to estimates. Excel can shorten large numbers so that they are
summarized by a letter, such as K (for “thousands”) or M (for “millions”). Figure 10.65 shows that the estimated
COGS varies depending on the quantity sold and the unit cost.

Figure 10.65 Shortening estimated figures can be useful for presentations and reports, as they will be easier to read than these long
numbers. (Used with permission from Microsoft)
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Since these figures are estimations for the coming period, they can be abbreviated to the million by marking
with an “m.” To do this, select the cells on which to perform this process, and then right-click and select Format
Cells. In the Format Cells dialog box, go to Custom, as shown in Figure 10.66. In the Type field, delete the
existing text, type [0,,“m”], and then click OK. Using the 0 indicates no decimal points and to use only whole
numbers. The “m” is used to round to the million units. Excel will change the figures in the selected cells to be
rounded up to the nearest million, as shown in Figure 10.66.

Figure 10.66 There are multiple “Custom” formatting codes, as you can see in the list. (Used with permission from Microsoft)

Figure 10.67 Choosing to format large numbers to display as millions can make a table more readable. The finished product could
now be further formatted for appearance. (Used with permission from Microsoft)

Common Number Formats
Some number formats come up frequently, such as addresses, phone numbers, or Social Security Numbers
(SSNs). Their formats may be consistent in a specific region (like SSNs in the United States), or they may be
similar with variations (like phone numbers with all hyphens, hyphens and parentheses, or spaces).

In Figure 10.68, you can see a table of names and contact information. However, there are some issues with
the data: the numbers all look the same. Phone numbers should be separated by parentheses for the area
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code and a hyphen after the exchange, and SSNs use hyphens around the middle two digits. Zip codes should
be five digits long, but some are showing up as only four digits; this is because Excel does not recognize the
leading zero. As is, the data in the current table is confusing. Microsoft offers a standard command to format
cells in these situations.

Figure 10.68 There are ways to fix the formatting issues in this table without having to manually fix each one. (Used with permission
from Microsoft)

First, select each column separately, right-click each column, select Format Cells, and then select Special. For
formatting zip codes (Figure 10.69), select the Zip Code column values (but not the header), and in the Special
format cell dialog box, select Zip Code, and choose OK. Follow the same steps for formatting phone numbers
(Figure 10.70). As you can see in the result shown in Figure 10.71, Excel already has special formats for these
number types.

Figure 10.69 Microsoft already has preset formatting for many number types, including zip codes. (Used with permission from
Microsoft)
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Figure 10.70 Another preset formatting is for phone numbers. (Used with permission from Microsoft)

Figure 10.71 The finished product can save the consuming process of writing the parentheses or hyphens manually and decreases
data entry errors. (Used with permission from Microsoft)

LINK TO LEARNING

The mail merge feature of Microsoft Word allows the user to create letters, mailing labels, or envelopes
from a list of names and addresses such as a customer list. This can make the process much quicker than
formatting each letter or envelope individually. Often lists of customers with contact information such as
addresses and emails will be organized in a spreadsheet. Mail merge connects a Word document to an
Excel data table to seamlessly create the documents needed for mailing. Watch this tutorial from Business
Insider on Mail Merge (https://openstax.org/r/78MailMerge) to learn the steps.

Copy Formatting
Copying the format of a given cell is one of the most used commands in Microsoft Office because it is available
not only in Excel, but in all other Office applications. The Format Painter command lets a user copy a certain
range’s formatting and apply it to a new range by selecting the cell with the desired format to be copied, and
then selecting the Format Painter icon on the Home tab. Format Painter can be used to transfer the formatting
from one cell or a whole table to another cell or table. The Format Painter tool is the paintbrush icon on the
Home tab in the Clipboard command group. To use the tool, first select the cell or cells that have the
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formatting you want to apply to other cells. Figure 10.72 shows the selected cells E1 to G7. Then, click on the
paintbrush icon on the Home tab. As you do, your cursor will change to a paintbrush. With that paintbrush,
select the range of cells to which you want to apply the formatting. In this example, those cells are A1 to C7.
The unformatted table will then be formatted in the same manner as the formatted table. The result is
apparent in Figure 10.73. The only step left is adjusting the columns by clicking on the border of each column
on top.

Figure 10.72 The Format Painter tool allows you to copy the formatting from one table and apply it to another. Notice the cursor
paintbrush next to it. (Used with permission from Microsoft)

Figure 10.73 Both tables are formatted using the same font, fill color, and number format. (Used with permission from Microsoft)

MAC TIP

The Mac version uses Cell Styles to format cells.

There are also other ways to copy formatting. Another way is to use the Paste Special tool. You first select the
whole formatted table and press Ctrl+C (to copy it), then select your entire unformatted table (Figure 10.74a).
Then, on the Home tab, choose Paste Special from the Paste menu and click on Formatting (R) from the last
row, as shown in Figure 10.74b. This tool will paste just the formatting from your original selection; it will not
paste any of the values or formulas (Figure 10.74c).
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Figure 10.74 Paste Special can be used instead of the Format Painter tool. (a) First, copy the table with the formatting you want to
apply. Then, highlight the table where you want to apply the formatting. (b) Choose Paste Special. (c) The tool applies the formatting
only; it does not copy any of the cell contents. You would then adjust your column widths to avoid the error. (Used with permission
from Microsoft)
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Chapter Review
Key Terms
absolute cell reference one in which the cell reference is fixed, regardless of where you copy the formula
array selection of rows or columns that do not have to be contiguous
auditing formulas process of using Excel tools to monitor and fix errors in worksheets
average number found by adding up a group of values, and then dividing it by the number of values you

added up; also called the mean
background canvas that is displayed behind the cell contents of a worksheet
basic financial functions main functions used for calculating loan installments, investment returns, net

present value of capital investments, mortgage payment comparisons, and many more real-world
applications

cell range selection of rows or columns that is given a name to make it easier for the worksheet designer to
find that specific group of cells later

Cell Style tool that lets you select other font sizes and background colors
comparison operators inequality symbols used in math; includes <, >, , , =, and <>
complex formula one that uses several operators to calculate an output
Data Table scenario-building tool in Excel that lets users choose a set of cells on the spreadsheet, and then

outputs different solutions or forecasts depending on different scenarios
filter tool in Excel that lets the user select certain criteria so that only data with that criteria is shown
Format Painter tool that lets you copy a certain range’s formatting and apply it to a new range
logical functions long formulas with embedded logical tests that often use comparison operators to search

for delimited data
MAX function that finds the highest value in a dataset
MIN function that finds the lowest value in a dataset
mixed cell reference one that uses a combination of both relative and absolute cell references
order of operations universal law of math used to prescribe the order of doing each calculation in an

equation
PivotTable tool in Excel that lets users create interactive charts and tables from raw datasets
relative cell reference one in which the cell reference in a formula or function updates automatically to

reference an adjacent cell when you copy that formula or function to another cell
standard deviation common statistical tool used by many data analysts that calculates the variability of the

figures in a dataset from the arithmetic mean
tracing dependent functions finding the source of an error in a formula by finding any cells affected by the

active cell
tracing precedent functions finding the source of an error in a formula by locating the cells that provide the

data to perform the calculation in the active cell
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Summary
10.1 Data Tables and Ranges

• Data Tables can be used for automatically generating multiple possible scenarios. This can be used to
predict future outcomes, such as revenues, unit sales projections, installment payments, interest rate
changes, and many other variables.

• Businesses need to construct complex datasets for their everyday control and management of the
company. For that purpose, Excel has data ranges, which help the user define a name for a particular set
of cells. This allows the user to use the given name of the data range instead of cell references.

• Arrays also simplify the complexity of huge worksheets, as they let the user autofill and compute multiple
calculations simultaneously.

10.2 More About Formulas
• Businesses need spreadsheets to handle datasets that are updated every minute with information. Cell

references, comparison operators, and array formulas can help analyze large sets of changing data.
• Complex equations need complex formulas to solve them. Excel formulas use the same math symbols as

“pencil and paper” math and follow the same order of operations. An easy way to remember the order of
operations is with the acronym PEMDAS.

• Cell references are needed in formulas and in constructing autofilled tables. There are three types of cell
references: relative, absolute, and mixed. Relative cell references are when a cell copies its links to other
cells relative to where it is located. Absolute cell references lock a reference to a specific cell, row, or
column. Mixed cell references use both.

• Comparison operators are math inequalities used in Excel formulas. They use logical operators like the IF
function to make your workbook pull information for you.

• Array formulas make simultaneous calculations, which saves time. They do the same operations that other
default Excel functions do but allow the user to customize the calculation given the designed criteria in the
formula.

10.3 Using Arithmetic, Statistical, and Logical Functions
• The tools introduced in this section will help you use and make sense of internal business data, such as

client orders, invoice amounts, and machinery operative data. The arithmetic functions and statistical tools
can give you an idea of the operations’ tendencies and cycles.

• The basic financial functions can be used to determine monthly or annual loan payments or the number of
years needed to pay off a loan.

• Logical functions are used for making inferences or deductions. Many logical functions can be embedded
within one another to create complex logical scenarios.

10.4 PivotTables
• Corporations need to analyze their datasets to produce metrics or insights. However, these datasets need

to be organized and cleaned before they can be processed.
• A PivotTable is a tool that reads raw datasets. It has user-friendly drag-and-drop capabilities that can help

organize the table information for the business.
• These PivotTables are malleable, as the user can rearrange the variables in different ways to generate

entirely different data highlights.
• Visual representations of PivotTables can be generated using another Excel tool, PivotChart.

10.5 Auditing Formulas and Fixing Errors
• All organizations should use auditing formula techniques to double-check their datasets. Errors can occur

in a variety of ways, from user error to cell reference errors.
• Running the Trace Precedents and Trace Dependents tools on a cell can diagram the problem with that
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formula or the information contained in that cell.
• Auditing formulas is a manageable process if you use the right tools. You need to specify the correct

options in the Excel settings to be able to see all the error codes, and be aware of all the built-in error-
checking tools Excel has to offer, such as the Inquire add-in.

10.6 Advanced Formatting Techniques
• Using consistent branding and style throughout a company’s documents is important for promoting

professionalism. This can be achieved by using a company-wide branding or style manual.
• The Themes tool lets you change a formatting scheme throughout an entire workbook. You can further

adjust the theme by using the Styles combo-box options.
• Excel lets you save time by copying a format using the Format Painter or the Paste Special method.

Review Questions
1. What is one method to name data ranges?

a. On the Page Layout tab, use options in the Sheet Options command group.
b. Use the Formula Bar.
c. Press Ctrl+Shift+Enter.
d. On the Formulas tab, select Define Name in the Defined Names command group.

2. What is one example of a benefit of using Data Tables in your worksheet?
a. renaming a cell reference
b. reorganizing the values from large to small
c. adding an extra column on your table with results
d. autofilling and calculating multiple scenarios

3. Where is the Data Table tool?
a. on the Home tab in the Sort & Filter command group
b. on the Data tab under the What-If Analysis menu
c. on the Insert tab in the Charts command group
d. on the Formulas tab under Financial functions

4. What are the benefits of using data ranges in your worksheets?
a. You can autofill and compute scenarios.
b. You can simultaneously calculate different operations in different worksheets.
c. You can save time by not going back to search for named cells.
d. You can reorganize the data following different criteria.

5. Which comparison operator represents “not equal”?
a. <>
b. =/
c. >=
d. ><

6. What is a mixed cell reference?
a. when you combine cells together
b. when either the row or the column is fixed
c. an absolute cell reference
d. a relative cell reference

7. Which function is used to total a range based on a certain criteria?
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a. COUNT
b. SUM
c. NPER
d. SUMIF

8. Identify the correct order for the PV function.
a. =pv(rate,nper,pmt,fv)
b. =pv(rate,nper,pmt,pv)
c. =pv(rate,nper,pv,fv)
d. =pv(rate,pmt,pv,fv)

9. What is a PivotTable?
a. a tool that derives information from raw data, which it processes in different arrangements depending

on the variables the user chooses
b. a tool that autoformats your workbook by automatically changing the background canvas, fonts, and

data types
c. a tool that defines the names of given ranges, so that you can use them for building formulas with

certain cell references
d. a tool that automatically makes simultaneous calculations in one cell, yet needs you to design and

write the formulas

10. What does the Recommended PivotTable tool provide?
a. The tool recommends and constructs a PivotTable with several variables based on your data.
b. The tool creates both a PivotTable and a PivotChart from the selected data.
c. The tool recommends PivotTable variables (i.e., headings) to be the leading data presented in one-

dimensional tables.
d. The tool recommends appropriate formulas to analyze the data in the PivotTable.

11. Where do you select the headers you want to use in a PivotTable?
a. on the Insert tab in the Text command group
b. on the Data tab under What-If Analysis
c. in the PivotTable Field List after creating a PivotTable
d. on the Insert tab using the Insert PivotTable command

12. What is one reason you might audit a formula?
a. You would audit a formula if you get a negative number.
b. You would audit a formula to copy it to another cell.
c. You would audit a formula if your PivotTable is not formatting correctly.
d. You would audit a formula if you have an error such as #NUM! on the spreadsheet.

13. How does a user inspect if the current cell has input and/or output problems?
a. The user would use the Step In tool.
b. The user would use the Inquire add-in.
c. The user would use the Watch Window.
d. The user can run the Trace Precedents and Dependents tools.

14. How would you create a custom color in a theme?
a. A custom theme color is created using the Format Painter.
b. Choose cell styles from the Home tab.
c. On the Page Layout tab, choose Colors.
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d. The custom color can be created using the Effects menu.

15. Where would you go to reformat a phone number?
a. the Format Cells tool in the Number command group on the Home tab
b. in the Page Layout menu in the Themes command group
c. using the Format Painter
d. using Cell Styles from the Home tab

Practice Exercises
16. WorldCorp sells servers to small and medium technology companies. WorldCorp offers different features

for each model of server, but the average unit price is $1,500. Last year, they sold 550 servers in the
Fairfax, Virginia, area. The product VP wants to calculate a forecast of how much revenue the company will
make depending on how many they sell in the coming year. Revenue is determined by multiplying the
Price * Quantity Sold. The VP wants you to complete a table with the revenue outputs. The VP wrote these
numbers on a paper, and gave it to you to put into Excel. Use these numbers (units sold) for your
autofilled data table.

17. WorldCorp builds TVs, and the best-selling model is the E-900. As you can see in the table, each model has
a different sales price. Define a data range in this exercise. Choose one that you think is appropriate.
Describe the steps you had to follow.

18. WorldCorp manufactures 32-inch LCD screens that cost them an average of $85 per unit. The COO wants
to save money by decreasing the manufacturing cost per average unit and thus the total Costs of Good
Sold (COGS). Total COGS is determined by Unit Cost * Quantity Sold. The COO has started a table of
possible savings by decreasing the unit cost, but wants an analyst to finish the table. What Excel tool or
combination of tools would you use for completing this table? Describe your process, then complete the
table. Lastly, define the second table using a data range method learned in this chapter.

19. The WorldCorp sales team uses a Customer Relationship Management (CRM) software to keep track of
customer data. It tells them when they should call their customers again, how much the customer has
ordered in the past, and other notes about the customer. The sales agents receive a salary, but if their
customer orders are over $20,000, they are given an additional 5 percent commission. Use the

10 • Chapter Review 737



information and the data in the figure to design a formula that can calculate the total commission the
sales agent will receive and an overall total for commissions paid.

Date Item Description Quantity FOB$ 5% Commission for sales

3/29/2021 Tablets, 7in 143 $10,582.00 $2,736.00

3/27/2021 Computer Server Accessories 2500 $21,350.00 $3,552.00

3/22/2021 Headphones 542 $26,016.00 $10,140.00

3/21/2021 LED TVs, 55in and 65in 53 $14,575.00 $432.00

3/17/2021 LCD TVs, 32in and 45in 97 $64,505.00 $480.00

3/15/2021 Cellular Phone Accessories 3000 $22,920.00 $30,800.00

3/10/2021 Home Stereo Systems 74 $7,252.00 $10,920.00

3/7/2021 Blu-Ray Players 127 $10,922.00 $768.00

3/5/2021 HDTV Antennas 768 $21,504.00 $18,240.00

1/13/2021 Plasma 65 $855.00 12 $10,260.00

1/13/2021 Headphones $48.00 85 $4,080.00

1/15/2021 Headphones $48.00 158 $7,584.00

1/17/2021 LCD 42 $380.00 55 $20,900.00

1/17/2021 Headphones $48.00 115 $5,520.00

1/21/2021 Plasma 65 $855.00 11 $9,405.00

1/22/2021 Headphones $48.00 15 $720.00

1/25/2021 LCD 42 $380.00 54 $20,520.00

1/27/2021 QLED 55 $620.00 10 $6,200.00

1/30/2021 LED 55 $550.00 10 $5,500.00

2/4/2021 LCD 32 $170.00 43 $7,310.00

2/7/2021 QLED 55 $620.00 15 $9,300.00

Table 10.1
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Date Item Description Quantity FOB$ 5% Commission for sales

2/9/2021 OLED 45 $400.00 37 $14,800.00

2/11/2021 Plasma 65 $855.00 34 $29,070.00

2/15/2021 DLP 32 $250.00 97 $24,250.00

2/18/2021 LED 65 $780.00 54 $42,120.00

2/21/2021 LED 55 $550.00 21 $11,550.00

2/25/2021 LCD 42 $380.00 54 $20,520.00

2/27/2021 LCD 32 $170.00 14 $2,380.00

Table 10.1

20. The Fairfax regional manager wants to know some Key Performance Indicators (KPIs) about their sales
team. They need the average quantity sold, the top invoice, and the lowest invoice of all the sales agents.
Use an array formula to figure out these metrics for each sales agent using the WorldCorp data.

Date Agent Item Description Quantity FOB$
5% Commission for

sales

3/29/
2021

Antonio Tablets, 7in 143 $10,582.00 NO

3/27/
2021

Izabelle
Computer Server
Accessories

2500 $21,350.00 YES

3/22/
2021

Antonio Headphones 542 $26,016.00 YES

3/21/
2021

Izabelle LED TVs, 55in and 65in 53 $14,575.00 NO

3/17/
2021

James LCD TVs, 32in and 45in 97 $64,505.00 YES

3/15/
2021

James
Cellular Phone
Accessories

3000 $22,920.00 YES

3/10/
2021

Antonio Home Stereo Systems 74 $7,252.00 NO

Table 10.2
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Date Agent Item Description Quantity FOB$
5% Commission for

sales

3/7/2021 Izabelle Blu-Ray Players 127 $10,922.00 NO

3/5/2021 James HDTV Antennas 768 $21,504.00 YES

Table 10.2

21. The Fairfax location’s regional manager wants to know the maximum of the units sold per order, and the
minimum FOB $. Use functions to find these values.

Date Agent Item Description Quantity FOB$

3/29/2021 Antonio Tablets, 7in 143 $10,582.00

3/27/2021 Izabelle Computer Server Accessories 2500 $21,350.00

3/22/2021 Antonio Headphones 542 $26,016.00

3/21/2021 Izabelle LED TVs, 55in and 65in 53 $14,575.00

3/17/2021 James LCD TVs, 32in and 45in 97 $64,505.00

3/15/2021 James Cellular Phone Accessories 3000 $22,920.00

3/10/2021 Antonio Home Stereo Systems 74 $7,252.00

3/7/2021 Izabelle Blu-Ray Players 127 $10,922.00

3/5/2021 James HDTV Antennas 768 $21,504.00

Max Units

Min $

Table 10.3

22. The Fairfax regional manager is comparing two customers. The manager wants to know when the units
fall below the average for the customer and when the dollar per order is below the average. Use the Insert
Function tool to find out which functions you can use for this purpose, then calculate these values. If one
of the customers is more variable than the other, use an IF function to tell the manager either if it’s
customer A or B.
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Customer A

Date Port Item Description Quantity Unique Quantity Code FOB $

1/22/2021 Portland, ME Headphones 15 PCS $720.00

1/17/2021 Portland, ME Headphones 115 PCS $5,520.00

1/15/2021 Portland, ME Headphones 158 PCS $7,584.00

1/13/2021 Portland, ME Headphones 85 PCS $4,080.00

1/8/2021 Portland, ME Headphones 16 PCS $768.00

1/5/2021 Portland, ME Headphones 10 PCS $480.00

1/3/2021 Portland, ME Headphones 9 PCS $432.00

12/28/2020 Portland, ME Headphones 74 PCS $3,552.00

12/20/2020 Portland, ME Headphones 57 PCS $2,736.00

Customer B

Date Port Item Description Quantity Unique Quantity Code FOB $

1/20/2021 Portland, ME Headphones 43 PCS $2,064.00

1/15/2021 Portland, ME Headphones 39 PCS $1,872.00

1/12/2021 Portland, ME Headphones 45 PCS $2,160.00

1/9/2021 Portland, ME Headphones 38 PCS $1,824.00

1/4/2021 Portland, ME Headphones 47 PCS $2,256.00

12/27/2020 Portland, ME Headphones 31 PCS $1,488.00

12/20/2020 Portland, ME Headphones 44 PCS $2,112.00

12/18/2020 Portland, ME Headphones 34 PCS $1,632.00

12/15/2020 Portland, ME Headphones 35 PCS $1,680.00

Table 10.4

23. The WorldCorp Fairfax, Virginia, location has one client who purchased various TV technologies in 2021.
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The product manager for TVs wants to gather some metrics on which technology sells best for this
customer, as well as the revenue per product type. Use the raw data in the "worldcorp_tv_data" tab of the
downloadable Chapter 10 data file (https://openstax.org/r/78Ch10DataFile) workbook to construct a
PivotTable that shows the metrics according to what the product manager wants to see.

24. WorldCorp collects thousands of datasets every week. A large part of the managers’ jobs is monitoring
this data, and they cannot monitor it efficiently if a workbook has mistakes. See this figure for a current
dataset with some #VALUE! errors. What does this #VALUE! error code mean? What would you
recommend doing in the formula audit process? What are the tools you would use, and how would you do
it? Explain.

Operational Budget for the Fairfax, VA
Manufacturing Plant

Component Projected Cost Actual Cost Difference

Direct Materials $52,536,474.63 $56,436,363.00 $3,899,888.37

Direct Labor $64,236,234.33 $67,436,356.00 $3,200,121.37

Manufacturing Overhead $53,386,433.99 $52,453,476.00 #VALUE!

Maintenance $535,252.00 $446,736.00 $(88,516.00)

Utility Services $4,526,236.00 $5,736,363.00 $1,210,127.00

Administrative Costs $4,256,236.00 $4,156,477.00 $(100,296.00)

Sales Costs $7,755,674.64 $7,537,363.00 $(218,311.64)

Depreciation $85,670.00 $86,845.00 $1,175.00

$187,318,748.59 $137,853,616.00 #VALUE!

Table 10.6

25. WorldCorp is buying an industrial robot that will pack small- to medium-sized consumer electronics in
sealed plastic bags. The new machine will increase productivity because it will be faster than human
workers. The financial manager is taking out a loan from the bank to pay for this machine; the loan will be
paid out over the course of ten years. WorldCorp will pay 15 percent of the total cost up front, but the rest
will be the principal for the loan. The total cost of the machine is $7,327,749. The interest rate is 5 percent.
The manager has designed a repayment schedule, but clearly there are some mistakes in the table. How
would you find the errors? Which tool would you use to fix them? Explain which tools you ultimately used
to find and solve the errors.
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Year Payment Principal Interest Balance

1 $806,630.47 $495,201.13 $311,429.33 $5,733,385.52

2 $806,630.47 $519,961.19 $286,669.28 $5,213,424.32

3 $806,630.47 $545,959.25 $260,671.22 $4,667,465.07

4 $806,630.47 $1,040,003.72 $233,373.25 $3,627,461.35

5 $806,630.47 $625,257.40 $181,373.07 $3,002,203.95

6 $806,630.47 $656,520.27 $150,110.20 $2,345,683.69

7 $806,630.47 $(46,107,043.25) $46,913,673.72 $48,452,726.93

8 $806,630.47 $(1,616,005.88) $2,422,636.35 $50,068,732.81

9 $806,630.47 $(1,696,806.17) $2,503,436.64 $51,765,538.99

10 $806,630.47 $(1,781,646.48) $2,588,276.95 $53,547,185.47

Table 10.7

26. Replicate the table in this figure using a Theme and Style of your choice. Explain your process step-by-
step.

Written Questions
27. What are the main differences between a cell range and an array?

28. How is a Data Table different from a spreadsheet? Explain the objectives of using a Data Table.

29. Why is the order of operations important? What role does it play when writing your formulas in Excel?
Explain.

30. What is the difference between using array formulas and simply using a function?

31. When working with large datasets, what can go wrong?

32. Explain the purpose of using the IF function in dataset analysis.

33. What sort of complications can arise from a client with highly fluctuating unit orders? How is the standard
deviation useful in this case?

34. What is the benefit of the drag-and-drop interface of PivotTables?

35. How should the raw source data of a PivotTable be formatted? Explain why.

36. Describe how to determine what kind of PivotTable variables you can use in a graph.
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37. Why would formulas need to be audited?

38. Why is it important to install the Inquire add-in before doing any precedents and dependents diagrams?

39. Describe the purpose of using the Watch Window.

40. What is the difference between using the Themes tool and formatting a set of tables by copying the
formatting? Explain.

41. Why would you need to create your own theme?

42. Why is formatting important?

Case Exercises
43. This video introduces crop budgets (https://openstax.org/r/78CropBudget) in the state of Nebraska. This

crop budget monitoring is done by the University of Nebraska-Lincoln, and they have all the input costs
that go into producing the crop yield. You can download the datasets by visiting the University of
Nebraska-Lincoln’s website (http://openstax.org/r/78UNebraskaLinc). Download any of their current year
crop budgets in Excel format.
A. Copy and paste the Materials tab into a new workbook.
B. Create a PivotTable from this data to examine the Applied Price (total) by Category.
C. Insert a PivotChart for the data.
D. Write a short summary of the data set.
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Figure 11.1 Using the advanced tools in Excel can help businesses evaluate the effectiveness of their social media marketing efforts.

(credit: modification of "Group of Women gathered inside Conference Room" by Christina Morillo/Pexels, CC0)

Chapter Outline
11.1 Understanding Data, Data Validation, and Data Tables
11.2 Statistical Functions
11.3 What-If Analysis
11.4 PivotTables/Charts
11.5 Data Analysis Charts

Chapter Scenario
As with many corporations, at WorldCorp there is a need to share information internally across various
business functions, such as marketing, accounting, and operations. This could include information about
current customers and their purchasing patterns or price changes in shipping cost over the last five years. This
type of information can then be used by each department to evaluate their performance or to identify
opportunities. The data used by each group might vary and the analysis will also differ based on the needs of
the department. The information gathered internally might also be shared with external stakeholders in the
business, such as customers or investors. Data shared with external entities could include shipping volume per
customer or overall profit calculations for key investors in the business.

Microsoft Excel can facilitate data analysis at various levels within WorldCorp and for external audiences. It is a
useful tool for assisting management with decision making and to understand the business at a higher level.
Excel’s advanced tools facilitate the management, interpretation, and presentation of data critical to managing
a business or an organization.

Advanced Excel Spreadsheets: Statistical and Data Analysis
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11.1 Understanding Data, Data Validation, and Data Tables

Learning Objectives
By the end of this section, you will be able to:

• Describe the different types of data
• Define data validation and describe the different techniques for validating data
• Construct a Data Table for a dataset

Data can come in a variety of forms. It can fit into specific categories, or it can be more general in nature. We
can collect data in different ways, such as through instruments like a thermometer or through an open-ended
survey. Regardless of the type of data and how it is collected, the information is useless without analysis. Data
analysis is a powerful tool that can guide key strategic decisions. Businesses rarely make important decisions
without some data analysis to support them. A key step in the analysis process is ensuring the reliability and
validity of data. A business can then use various techniques to understand the information better. Microsoft
Excel provides several tools to make that process a bit easier for the business decision maker.

Business analytics is one career field that uses extensive Excel skills. This field focuses on careful analysis of
data to provide insights and recommendations to the management team on ways to monitor and improve
performance. The soft skills needed in this field include critical thinking, analytical thinking, problem solving,
attention to detail, and communication. The business analyst must dig deeper into data by asking the “why”
questions and then be able to clearly communicate their findings to colleagues who may not know the
terminology and techniques. The vast amount of data in today’s business world creates a high demand for
these positions. Over the next decade, the number of jobs in the field is expected to grow over 10 percent with
the positions commanding salaries over $80,000 per year.1 Even if you choose to take a different path in your
career, learning these skills can greatly increase your value to an organization.

What Is Data?
To analyze data, let’s examine the various forms that data can take and how to collect and organize it. In
essence, data consists of facts or information that can be used for reference, performance monitoring, and/or
analysis. For example, data can be collected about online purchasing habits to monitor the market share
performance of select brands. A business can then analyze the data to reveal trends such as the purchasing
habits of certain demographic groups.

Businesses use many methods to collect data. One common approach is using surveys, which can collect a
wide variety of information. Also, with today’s technology, surveys can often reach a large audience by using
email or social media distribution. Businesses also often have a lot of data stored in both internal and external
databases. Internal databases consist of information a company has collected itself, such as customer
demographic information, past purchases, or frequency of purchases. WorldCorp’s internal database includes
key contact information for each of their customers, order sizes and frequency of orders, and payment history.
External databases are collected by data providers. Often, a business can purchase this data from a provider to
obtain information on market demographics, competitor products, and industry statistics. Many sources of
compiled data can be accessed for free. U.S. Census data, available at the United States Census Bureau
(https://openstax.org/r/78Census) website, is one example. This site provides a lot of varied information on
U.S. residents, such as education levels and median incomes. The data can be filtered based on specific
criteria, such as location. WorldCorp can use this census data to identify and evaluate new locations for
warehouses. They can use the data to determine if a particular city has the employee base needed to open the
new warehouse and what the salary ranges in the region are (Figure 11.2).

1 U.S. Bureau of Labor Statistics. Management Analysts: Summary. Occupational Outlook Handbook. https://www.bls.gov/ooh/
business-and-financial/management-analysts.htm (https://www.bls.gov/ooh/business-and-financial/management-analysts.htm).
Modified September 8, 2022.
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Figure 11.2 Using census data can help you gather a good deal of detailed information about a geographic location.

Interviews and focus groups are also methods for collecting data such as customer preferences for a product
or for understanding the impact of price changes, but they do not provide as much data for deep analysis.
Excel is better suited for numerical information. However, some information from interviews and focus groups
can be transformed into quantitative data. For example, if you ask potential customers if they would still
purchase a product if the price increased by 5 percent or a certain dollar amount, you could record the number
(or percentage of respondents) who replied yes and no to that question. Both methods can be time intensive
and generally provide information that is more exploratory in nature.

The information gathered from interviews or focus groups can often help data analysts determine the
appropriate data they might need for a more in-depth analysis. The information about a price change could
then be further explored with more research to determine at what point a price increase becomes too much
and the customer will no longer purchase the product.
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SPOTLIGHT ON ETHICS

Is Your Information Safe Online?

Database marketing is a business strategy that uses information collected on consumers to better market
their products or services to them. This could include collecting information from people’s online activities
or buying information collected by marketing research firms on their purchasing habits. User data and
information about online activities is collected at an astonishing rate.2 All of this available data brings up
valid concerns related to privacy and protecting your information from unlawful activities. What’s more,
many people often provide sensitive information freely, such as when completing online surveys or taking
social media quizzes that often are designed to determine usernames and passwords. In 2019, nearly
fifteen million people were the victims of identity fraud. Some strategies to protect yourself include using
strong passwords and changing them often, only visiting trusted sites, using prepaid cards for online
transactions, and hiding personal information when you can. You will also want to avoid providing personal
information unless absolutely necessary and be mindful of how you use the sites you visit.

Once data is collected, it can be grouped into two broad categories: qualitative and quantitative. The first
category, qualitative data, is categorical information that does not include numbers, or if it does include
numbers, those numbers do not have a true mathematical meaning. For example, a question on a class
evaluation survey could ask the mode of delivery for the course and could be as follows: 1 – in person, 2 –
online, or 3 – hybrid. The numbers in this case do not have a meaning; instead, they are placeholders to
indicate the category you select. However, because Excel cannot analyze text information, converting the
categories to numbers allows for some analysis of this qualitative data. Other qualitative data can be in the
form of text that includes statements of opinion. For example, a customer review that reads “This product is
wonderful!” is a qualitative assessment of the product.

The second category, quantitative data, involves numerical evaluations. It could include numerical
expressions of opinions but also could be facts such as the cost of a specific product. Along with a glowing
qualitative review of a product, a customer could also provide a rating of five on a scale of one to five. In this
example, the same assessment, the customer’s opinion of the product, can be expressed in both qualitative
and quantitative terms. This is similar in concept to what you might see for a product rating on an e-commerce
site. A buyer can give a product five stars and add some textual comments about their experience with the
product.

Quantitative data can be further classified as discrete or continuous. Information that can only take on a
specific set of values is called discrete data. For example, the number of customers in a store is discrete
information. You cannot have a portion of a customer. So, the number of customers in the store is restricted to
certain values, in this case, whole numbers. Discrete data is counted. In contrast, continuous data is
information that is measured and can take on an infinite set of values. For example, you could weigh yourself
at home on a digital scale that only measures to one-tenth of a pound (i.e., 132.7 lbs.). Your doctor might have
a more precise scale that will display your weight in hundredths of a pound (i.e., 132.65 lbs.). There is an
infinite range to which the data can be reported, and it is constrained by the measurement device.

Data is grouped by the level of measurement represented by the information. There are four categories of
measurement into which all data can be placed: nominal, ordinal, interval, and ratio. The nominal level of
measurement is the lowest level of analysis. With nominal data, the information can only be placed in
categories. No category is more important than another, and the categories cannot be placed in any logical
order. One example of nominal data is marital status. With four possible answers (single, married, divorced, or

2 Nicole Marti. “How Much Data Is Collected Every Minute Of The Day.” Forbes. August 12, 2019. https://www.forbes.com/sites/
nicolemartin1/2019/08/07/how-much-data-is-collected-every-minute-of-the-day/?sh=30871fd03d66 (https://www.forbes.com/sites/
nicolemartin1/2019/08/07/how-much-data-is-collected-every-minute-of-the-day/?sh=30871fd03d66)
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widowed), every response can be placed into one of the four categories.

The next level of measurement is ordinal. At this level, data is placed into categories, but then those categories
can be put in order. Ordinal data gives the company more information than nominal data does, but there is still
not enough information for an in-depth analysis. The distance between the levels of the categories is not
defined, but one category is of a higher order than another. A typical example is an opinion scale, often
referred to as a Likert scale (Figure 11.3). As a company, you know that you want customers to be Very
Satisfied as opposed to Unsatisfied. WorldCorp often uses this scale to get feedback on the customers’
interactions with sales agents. They can then rank the responses to determine which sales agents are ranked
higher than others. But what you do not know is the degree of difference between Very Satisfied and
Unsatisfied.

Figure 11.3 A Likert scale is used to gather ordinal data that can be analyzed.

LINK TO LEARNING

Organizations often use surveys to gather data to inform their organizational and business practices. For
instance, a business might send out a satisfaction survey to their clients. Or they might survey employees
regarding their work preferences. Regardless of the purpose, you will need to write questions and provide
options for responses that will capture exactly the information you need to answer the questions you are
asking. Read this article from Survey Monkey regarding how to craft effective survey questions
(https://openstax.org/r/78SurveyMonk) to learn more.

The last two levels are interval and ratio. Both allow data to be put into categories (nominal) and establish an
order of the categories (ordinal), but now quantitative data is added so that the difference between each
category is defined. The key difference between interval and ratio is how they treat a value of zero. With the
interval level, zero acts as a placeholder rather than representing the value of zero, or the absence of
something. One example is a survey question in which zero represents a neutral response. In this case, the
respondent has no strong feelings either way on the question being asked. In contrast, with the ratio level of
measurement, zero takes on the value of zero. If your product sold zero units this week, there was an absence
of sales for the product. Understanding the differences between these levels of measurement can help you
determine the best strategy to analyze the data you have collected. Figure 11.4 summarizes the levels of
measurement.
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Figure 11.4 The levels of measurement differentiate data based on the depth of analysis possible.

Categorical Data
Nominal and ordinal data make up categorical data, which is grouped into categories based on attributes or
characteristics. Categorical data is considered qualitative data. The data can be represented with numbers;
however, those numbers do not have a mathematical meaning. Some examples would be gender, marital
status, or employment status (see Figure 11.4). Numbers can be assigned to these categories to make analysis
possible with Excel, but those assignments are arbitrary. For example, you could represent full-time
employment with the number 1 and unemployment with a 0. The same analysis could happen if the numbers
were 2 and 4. There is no mathematical meaning behind the assigned numbers.

An advantage of using categorical data is that you can capture assessments of behaviors, opinions, and
emotions. These concepts are not quantifiable, but using categorical data, you can assess and analyze these
concepts to better understand the situation at hand. A disadvantage of categorical data is that deeper analysis
using statistical methods may not be possible. Categorical data is often represented in a table format and
graphically displayed with pie charts or bar charts. The data is most often analyzed through percentages in
each of the categories of interest.

Numerical Data
The interval and ratio levels of measurement are numerical data. Numerical data is quantitative data and
represents measures of variables, and it can either be discrete or continuous. The key feature is that the
numbers have mathematical meaning with respect to the attribute or variable being evaluated. For example, a
manager could determine the distance between two office locations in miles to determine the mileage
reimbursement for employees traveling between the two sites. Other examples include the length of time
waiting for a table at a restaurant, the amount of money spent by a customer at a particular shop, or the fuel
efficiency of a vehicle (Figure 11.5). The advantage of using numerical data is that you can do in-depth analysis
with statistics and use the data to develop predictions for future performance. This could be helpful for a
business to forecast sales in the next quarter or predict expenses for the next year. Numerical data can be
graphed using scatter plots and histograms. The data can be analyzed using various statistical methods. These
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could include mean, mode, median, standard deviation, and regression modeling.

Figure 11.5 Categorical data can be used for behaviors and emotions. Numerical data is used for more objective information such as
distances or sales figures.

What Is Data Validation?
Data validation is another technique that can be used to verify data. In essence, data validation is the process
of ensuring that the data values fall within a predetermined range. For example, if you know that there are
only fifteen sales agents at WorldCorp, you can use data validation to make sure that the values assigned to
various sales transactions in the monthly sales data spreadsheet are only whole numbers from 1 through 15.
Data validation can also be used to ensure that product codes for the HDTVs sold by WorldCorp are accurately
entered into the spreadsheet.

Two components are often used to ensure you are working with quality data: data verification and
benchmarking. The process that ensures your data is accurate and reliable is called data verification. It is
important to check the accuracy because if the data is not valid, then any analysis using that data will also be
invalid, which could lead to critical mistakes if key strategic business decisions are based on the inaccurate
data. WorldCorp could use data verification to ensure that product codes or prices are entered correctly into
the spreadsheet used by the accounting department. You can imagine the issues that could arise if the price
entered is incorrect. WorldCorp could be charging customers incorrectly for the product, which could lead to
issues with both internal recordkeeping and external customer relations.

There are several approaches to checking the validity of your data. One way is to check the data that has been
inputted in the spreadsheet against the original paper copy of the data. You could also use benchmarking, a
tool that checks the validity of your data with similar datasets or a set standard. Benchmarking involves
checking specific values such as price points or sales projections against known standards. These known
standards could be from competitors or from established company goals. Sometimes, standards are set by
government organizations as well. WorldCorp could use benchmarking to evaluate their product shipping
speeds and costs versus that of their closest competitor. If their competitor ships products faster and at a
cheaper price, WorldCorp might decide to investigate the impact of lowering their prices. Benchmarking can
also be used to measure how your company’s sales are growing versus that of your competitors.
Benchmarking against industry-wide data is also commonly used when assessing the performance. The
benchmarking process can help a company determine where there might be gaps in performance compared
with the competition or ways to enhance their position in the marketplace.

The Process and Techniques of Data Validation
Data validation techniques can be used to ensure that quality information is being used in decision making.
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Errors can occur when inputting data into the spreadsheet. Data can be entered in the cell incorrectly, data can
be accidently duplicated, or numbers can be transposed. Through data validation, many of these common
errors can be identified and then the user can correct those errors as appropriate. Data validation can also be
used as a part of ongoing process improvement efforts in conjunction with benchmarks from key competitors
or industry values. The tools available in Excel for data validation help ensure that your data has as few errors
as possible and check business performance against internal standards or competitors.

SPOTLIGHT ON ETHICS

Keeping Accurate Data

Professional ethics dictates that businesses keep accurate and up-to-date information and data; this
includes information they may collect with consent from clients and internal business information, as well
as information they may create and consume in their interactions with external stakeholders across all
platforms, including in spreadsheets where much of their financial information will likely be found. As such,
quality data is accurate data and businesses can incorporate a number of ways to ensure data is recorded
accurately, such as using Excel’s data validation capabilities. Data validation simply means we have a
process in place to ensure the information is entered correctly and that it is appropriately checked to
ensure it is both accurate and useful. For instance, businesses can ensure employees use effective and
accurate data entry practices, such as shortcuts, AutoFill, and drop-down menus.

In addition, Excel can also restrict what content is input in certain cells to ensure it is correct—for instance,
you can use data validation to have Excel reject an entry of 000-000-0000 as a valid phone number. In Excel,
you would enter this validation criteria in data validation settings (Data tab, Data Validation, then select
Settings). You can also prompt the person entering the data with an input message, giving them
instructions to enter specific information in a cell.

Data Validation
The process of validating data is made easier with Excel. There are several ways to customize the validation
processes to meet specific needs. One simple validation approach is removing duplicates. You access this tool
through the Data tab. This function is helpful if you are unsure whether there are duplicate entries in your
data.

Consider an example in which there are twenty employees at WorldCorp’s warehouse location in Portland and
each of those employees has a unique company identification number. In a spreadsheet keeping track of the
number of days of vacation remaining for the year for each employee, you would not expect to have more
than one line per employee. For a dataset of only twenty employees, it would be easy to identify a duplicate
entry. But what if your company had two thousand employees? This could take a good bit of time to manually
identify duplicates.

To remove duplicates from your data, first open the spreadsheet that you want to examine. Click on the Data
tab and then on the Remove Duplicates tool (Figure 11.6).
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Figure 11.6 The Remove Duplicates dialog box allows you to choose the data from which you need to remove the duplicates. (Used
with permission from Microsoft)

The dialog box that opens has several options. First, ensure that the box next to “My data has headers” is
checked if your data has a header row, as shown in Figure 11.6. Then, choose which columns you want to
check for duplicates. In this case, you will check both columns for rows that have duplicate data in both. The
removal of the duplicate information in this example requires checking both columns and only occurs if both
columns have duplicate information. You can check only one column if desired as well. In this example,
though, you choose both columns because the information is grouped by rows. Thus, the Employee number is
matched up with their days of vacation left.

After you’ve chosen the data to check, click OK. Notice that employee number 2959 (rows 8 and 9) appears
twice, with the same number of days left. Excel will remove one of these entries. If you had only selected the
first column, Excel would delete any rows that had duplicate information in Column A, regardless of the
content of Column B. For this reason, you need to be careful to ensure that your criteria will not
unintentionally delete too much data. Once the tool has finished removing duplicates in the selected data,
Excel will notify you of the number of duplicates that were removed from the selection and indicate how many
unique values remain (Figure 11.7).
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Figure 11.7 The Remove Duplicates tool removed Employee 2959, who appeared twice in the data, from row 9. (Used with
permission from Microsoft)

Further validation of data can be accomplished using Excel’s Data Validation tool accessed through the Data
tab in the Data Tools command group. This tool checks a selection of data to determine if it falls within a
specific range of numbers.

There are several options available with the Data Validation tool. You can set the tool to check the data within a
certain date range, to verify if all numbers are whole numbers, or to check for all positive numbers. You can
also create a drop-down list of options from which the user can choose. Additionally, you can set the tool to
display an error message when a data point does not meet the criteria you have established.

How to Add Data Validation

Adding data validation means that you are requiring that a dataset meet certain specifications to be deemed
valid. If these specifications are not met, the formula will not work. To demonstrate how to add data validation,
you’ll go back to the example of employee vacation days.

In the spreadsheet, first select the data (B2:B21) you want to examine. Do not select the column headers when
selecting the data. Only select/highlight the numerical information. Next, click on the Data tab and choose the
Data Validation tool (Figure 11.8). The Data Validation window will open. Once open, there are three tabs
available.
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Figure 11.8 When using the Data Validation tool, first select the data and then choose the tool from the Data Tools command group.
(Used with permission from Microsoft)

The Settings tab allows you to set parameters/ranges for the data validation. Assume that each employee is
allocated two weeks (or 14 days) of paid vacation per year. This simple spreadsheet shows the number of
vacation days remaining for each of the employees. Make sure that all entries are from 0 through 14. Using
the Settings tab, change the value box under Allow to indicate a whole number (Figure 11.9). Then, under
Data, choose “less than or equal to” and enter 14 in the Maximum box. Examine the other options available
under Data. You could choose to have the number fall between two values. You could select greater than,
greater than or equal to, and not between two values. The many choices will accommodate most data
validation needs.
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Figure 11.9 Use the Allow and Data fields to change the parameters of the data validation. (Used with permission from Microsoft)

Next, go to the Input Message tab. This is used to show a message to a user of a spreadsheet when they click
in a cell to add data. For example, this message could indicate that the number must fall within a certain
range. This is particularly useful if you have multiple users for an Excel spreadsheet.

Finally, the Error Alert tab will display a message to the user when they have entered an invalid entry. There
are three different types of errors available. The Stop error gives you the option only to retype an entry or
cancel. The Warning error allows the user to add an entry that is not in the predetermined list. Finally, the
Information error simply states to the user that the entry does not match the validation rules, but the entry is
still allowed. When an entry triggers an error, a small green triangle will appear in the upper-left corner of the
cell. Clicking on the triangle will show what caused the error. Finally, you have the option to not display an
error alert at all. By selecting this checkbox, all entries are permitted.

Once the parameters and messages are established in the previous steps, click OK. Now, using those settings,
Excel can check the data. Under the Data Validation tool, click on the small down arrow to the right of the
button to open the additional options. Select Circle Invalid Data. You then will see all data that does not meet
the established criteria circled in orange (Figure 11.10).
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Figure 11.10 You input the settings for validating data with data validation. Then, to do the validation, choose “Circle Invalid Data.”
The circle is placed around data that does not meet the parameter of the data validation. (Used with permission from Microsoft)

You can clear the circles by clicking on Clear Validation Circles. To remove data validation entirely, select the
Data Validation tool, and in the lower left, choose Clear All. This will clear the validation rules from the cells.
Here are the general steps for using the Data Validation tool to find invalid data:

1. Highlight the desired data (include only numbers, not text).
2. Click on the Data tab and select the Data Validation tool.
3. Set the parameters for the validation under the Settings tab.
4. Set an input message if desired.
5. Set an error alert message if desired.
6. Click OK.
7. Choose Circle Invalid Data under the Data Validation tool to identify data that does not meet the

parameters established in Step 3.

Data Validation List

Creating a data validation list is a convenient way to ensure that only specific values are entered into a
spreadsheet. The user chooses the appropriate response from a predetermined set of values, which can be
numbers or text. This assures that only acceptable values will be entered into the spreadsheet. For example,
let’s add a column to the employee spreadsheet that indicates the employee’s location. Suppose the company
has three different locations: North, East, and South. The management team may want to review staffing at
the various locations when vacation time is used, so this column might provide helpful information for
scheduling purposes.

To create a data validation list, first click in an empty cell on the spreadsheet. Then, access the Data Validation
tool. On the Settings tab under Allow, choose List. In the Source, you have two options. You can input text or
values into the box separated by commas (Figure 11.11a), or if you have the list already in the named range,
you can reference the named range in the Source box (Figure 11.11b). By using the cell range reference, the

11.1 • Understanding Data, Data Validation, and Data Tables 757



drop-down list is dynamic and will update if you change the source list. This is often the preferred method
unless it is certain that the options will remain the same.

Figure 11.11 When establishing a data validation list, you can (a) directly enter the text or values, but it is preferred to use (b) cell
references so that the drop-down list is dynamic. (Used with permission from Microsoft)

Either method will give the user a drop-down list to choose from when inputting information into the
spreadsheet (Figure 11.12). If the list needs to be copied to other cells, it can be copied using the Paste Special
technique (see Essentials of Software Application for Business).

Figure 11.12 The drop-down list will show the text from the data validation list so the user can choose from the permitted values.
(Used with permission from Microsoft)

Custom Data Validation Rules

If there are specific validation needs that are not covered by the existing built-in choices in data validation, you
can create a custom data validation rule. This allows you to set your own parameters for the cells. Open the
Data Validation tool and in the Allow drop-down menu, choose Custom. This offers a great deal of flexibility to
use formulas and functions in data validation. You can use any of the available functions for data validation,
even those that look at text or characters. Using data validation to look at text or characters could help you
identify product codes or city names that were spelled incorrectly.

Using the employee vacation list, let’s add the employee names to the data. Create a column called Name. To
ensure that only textual information is entered into the cell, you will use the custom data validation option.
Open the Data Validation tool. Select Custom. In the Formula Bar of the window, use the ISTEXT function to
restrict the entries to text data only (Figure 11.13). You can also add an input message and error alert if
desired. Click OK.

758 11 • Advanced Excel Spreadsheets: Statistical and Data Analysis

Access for free at openstax.org



Figure 11.13 Data validation can be set to ensure that only text is input into a cell or group of cells. (Used with permission from
Microsoft)

If the user tries to enter a number in the cell and you have enabled error alerts, an alert message will appear.
Other custom data validation rules include not allowing any punctuation, restricting entries to not exceed a
certain total, or entering data within a specified range.

The custom data validation rule option helps to ensure the accuracy of data entered based on scenarios that
are appropriate to your specific application. These options are useful when creating spreadsheets that have
multiple users. Data quality issues can be mitigated by setting up validation rules or adding drop-down lists.
Data validation along with other skills, such as protecting sheets or cells, can be critical to maintaining the
integrity of the spreadsheet and the data analysis built from the information in the spreadsheet.

Editing Validation Rules

To edit existing validation rules, first identify the cells where data validation rules are located. To do this, on the
Home tab, go to Find & Select on the far right side of the tab, and choose the down arrow. When the menu
appears, choose Data Validation. This will highlight all cells that have data validation rules. To view the
parameters of that rule, simply click in one of the highlighted cells. Then, go to the Data Validation tool. The
tool window will appear and list the restrictions of the data validation rule. If you want to make any changes,
you can make them here. However, before closing the window, ensure that you check the box next to the
instruction “Apply these changes to all other cells with the same settings” (Figure 11.14). This will then apply
the changes to the other cells with the same data validation rule.
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Figure 11.14 Be sure to select this checkbox to apply changes to all cells using the same data validation rule. (Used with permission
from Microsoft)

Organizing and Presenting Data
A benefit of using Excel to organize data is the wide variety of formatting choices available for presenting the
information in a professional manner. Remember the basic formatting concepts you learned in Working with
Spreadsheets. Organizing the data in a table format with headers, colors, and other formatting options makes
the information visually appealing and often makes it easier to understand. This is especially important when
dealing with a large spreadsheet of information. When formatting data in your spreadsheet, there are a few
settings that will allow you to present the data in a more professional way:

• Adjust the alignment so that numbers are aligned to the right and text is aligned to the left. This allows
users to easily distinguish between text and numerical information.

• Add formatting to column and row headings, such as bold fonts or a larger text size. You might consider
adding a border to the header row but avoid using all capital letters in the header row because it makes
text difficult to read.

• Filler colors can highlight your header row or make it easier to distinguish between rows of data. Too
many colors, however, can distract from the professional look of the spreadsheet. One clean and simple
way to distinguish rows is to use a light gray filler for every other row or column, as illustrated with the
WorldCorp dataset from the previous chapter, shown here in Figure 11.15.

• When choosing fonts for your data, use only one font, and use fonts that are easy to read, such as Times
New Roman or Calibri. Avoid script fonts and fonts that look artistic.

• Adjust column widths and row heights to make the spreadsheet more readable.
• In large datasets, consider freezing the header row so that when the user scrolls, the column headings

remain visible. To do this, go to the View tab, select Freeze Panes, and then Freeze Top Row. This keeps the
top header row visible while scrolling.

There are many built-in settings that might be useful when formatting your data for a professional look. You
can access them through the Cell Styles menu on the Home tab (see Working with Spreadsheets).
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Figure 11.15 Built-in Cell Styles make datasets with many rows more visually appealing. (Used with permission from Microsoft)

Another way to present data in a spreadsheet is to display it in a graphic format. The type of chart or graph
you should choose depends on the type of data. For example, a bar chart is appropriate for categorical data,
while a line graph is appropriate for numerical data. When the data includes categories that equal 100 percent,
a pie chart (Figure 11.16) is an effective option, such as with the data presented in Figure 11.15. Using a pie
chart with the data, you can see the proportion of each product compared with each other. Charts will be
covered in more depth later in Data Analysis Charts.

Figure 11.16 Pie charts are an effective way to visually represent data when categories equal 100 percent.

Constructing a Data Table
To add even more functionality, you can format data to be an Excel Data Table, rather than simply a table of
numbers. Using the Data Table formatting sets the data as a separate object in the spreadsheet. It is more
than simply adding column or row headings. This feature allows you to easily add rows or columns, is
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automatically formatted to look professional, and allows you to quickly sort and filter information with a filter
button at the top of the column. The table will automatically expand with the insertion of new rows or
columns, and the preset formatting will carry over to these additions. Column headings are always visible
without manually freezing the row, and formulas entered into cells are automatically applied to all cells in that
column. Although these functions are available without formatting a set of data as a Data Table, working with
the data is much easier if it is set this way.

You can create a Data Table from scratch and then add the data at another time. However, it is often easier to
work from an existing spreadsheet of data to create the Data Table. To do so, open the "pivot_table_data" tab
in the downloadable Chapter 11 data file (https://openstax.org/r/78Ch11DataFile) workbook. There are two
ways to format the data as a Data Table. For both, first highlight the data you want to convert to a Data Table.
Then, press Ctrl+T, which opens a small window showing the selected range and a checkbox if the data
contains a header row (Figure 11.17). Click OK. The other method is to click on the Home tab and choose
Format as a Table in the Styles command group.

Figure 11.17 To create a Data Table, first select the columns and rows to be included in the table. (Used with permission from
Microsoft)

Once you click OK, you will notice that your data looks different. There are drop-down arrows associated with
each column, and there is a new tab in the ribbon: the Table Design tab (Figure 11.18).
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Figure 11.18 When data are in a Data Table, you will see a Table Design tab for formatting options. (Used with permission from
Microsoft)

The Table Design tab appears when you click inside the Data Table and allows you to customize the table. You
can change the color scheme, name the table, summarize the data, and refresh the information.

The drop-down arrows on each column header allow you to filter and sort the data. You can sort the data in
many ways, and you can filter the data to only show selected information. You could sort this example to show
certain destinations, such as Metairie, LA (Figure 11.19).

Figure 11.19 The drop-down menu with each column in a Data Table is a convenient way to filter information. (Used with permission
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from Microsoft)

To accomplish this, select the down arrow in the Destination column. Then, deselect all the destinations except
Metairie. This will filter the entire table to only display those products for Metairie (Figure 11.20). You can tell
that the data is filtered because the row number starts at a number other than 2 (row 1 is the header row). In
this case, it starts at row 6. The other data is still contained in the table, but it does not display when this filter
is applied. Also notice that the drop-down arrow changes to a funnel icon to indicate that the table has been
filtered based on the information in this column. To remove the filter, click on the funnel icon and choose Clear
Filter. This will remove the filtering from the table, and it will return to its original form. The funnel icon will
change back to a drop-down arrow. If you do not want to filter your data, you can choose to not have the filter
buttons displayed in your table using the Table Design tab in the Table Style Options command group. You can
also use the Table Styles Options command group to add a total row to your Data Table.

Figure 11.20 Customize the Data Table using the options in the Table Style Options command group. (Used with permission from
Microsoft)

To customize the color scheme of the Data Table, choose the Table Style Options command group in the Table
Design tab. There are many color choices and designs to choose from. You can also create a custom style,
perhaps with your company colors, by choosing New Table Style. A window appears that allows you to format
each section of the table with various fonts or colors.

Another benefit of using Data Tables is that you can easily summarize the data using PivotTables. This feature
allows you to display the data in various ways to better analyze the information. You can create subtotals and
summations of various factors within the table. To use this feature, choose Summarize with PivotTable from
the Tools command group on the Table Design tab. We will discuss PivotTables in PivotTables/Charts.

If you no longer want to use a Data Table object for your data, you can revert it to a regular data range.
Choose Convert to Range in the Tools command group on the Table Design tab. This will keep all the
formatting but will leave the data as a range rather than a Data Table object in the spreadsheet. This makes it
easier to copy and paste the information into a document or a presentation when communicating the analysis
to others.

One-Variable Data Tables
Data Tables allow you to change cell values and see the result those changes have on other cells containing
formulas. The tables can be used to evaluate possible scenarios to help make decisions within a business.
Often, Data Tables are used to understand the financial implications of decisions.

Data Tables can use one variable or two variables. The Data Table tool is part of the What-If Analysis options on
the Data tab. A one-variable Data Table investigates the impact of manipulating a single cell on another cell.
Imagine you are interested in looking at the impact to your company’s overall profit if the price of one product
is changed. Begin by setting up a model of the current data. For this example, let’s look at WorldCorp’s 32” LCD
TV that sells for $170 and costs WorldCorp $85 to make. Let’s assume that marketing and administrative costs
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are $5,000 annually. You can set up an initial spreadsheet that reflects the current model and an abbreviated
income statement to show the company profit (Figure 11.21). The formulas are shown in column D so that you
can see how the cells were calculated.

Figure 11.21 For a one-variable Data Table, you will model a single variable such as Net Income. (Used with permission from
Microsoft)

You are interested in seeing the impact to profit, or cell C10, in this example. The value in this cell becomes the
top row of the Data Table, so repeat it below the model. Next, identify the new prices to investigate. With a
one-variable Data Table, those values are placed in the column to the left of the impacted cell. In this example,
put the values in column B, starting in the row below the impacted cell. At this point, you can format the values
using the Currency style to be more representative of what is being investigated. Then, select the cells to
include in the Data Table, including all the price-level changes being evaluated.

Now, construct the Data Table. Go to the Data tab, click the arrow next to What-If Analysis, and select Data
Table from the list (Figure 11.22). When the input window appears, choose the input value (price in this
example) in the Column input cell box. You only use the Column input cell for a one-variable Data Table (Figure
11.23). Notice the dotted line around the input cell and the highlighted region for the Data Table. Click OK.
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Figure 11.22 (a) For the new data table, first choose the What-If Analysis option from the Data tab. (b) Then select Data Table from
the drop-down menu. (Used with permission from Microsoft)

Figure 11.23 The impact of the Price per unit on overall Net Income is the desired output. (Used with permission from Microsoft)

When you click OK, Excel will use the information from the model to calculate the Net Income at each of the
price points (Figure 11.24).
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Figure 11.24 The change in net income due to the change in the price per unit is automatically generated. (Used with permission
from Microsoft)

Excel shows that if the price point per unit is adjusted to $165.00, the Net Income will be $695,160, as shown in
cell C15. When Excel creates the Data Table, the results are not automatically formatted. You can format the
information after the Data Table is created, or you can set the number style to accounting or currency for the
cells C14:C18 prior to creating the table. This simple example demonstrates the value of creating a Data Table.
Excel quickly calculates the impacted cell values based on the predetermined formulas. This allows the
decision maker to see all options in a single table.

Two-Variable Data Tables
Often in data analysis, there is more than one variable. You may need to investigate the interaction between
two variables to get more information. For example, a two-variable Data Table could analyze the performance
of various locations during each quarter of the year or could examine different production levels at various
price points to investigate the impact on profit.

Let’s continue with the example of product price and impact on profit, and add various quantities sold into the
analysis. Again, the target impacted cell is C10, Net Income. Put the quantity values across the top of the table
and the prices down the side, as with the one-variable Data Table. Format the output cells (D14:H17) as
currency. Next, highlight the table area and go to the Data Table tool in What-If Analysis. For the Row input cell,
choose the # units, C4, and for the Column input cell, use the unit price, C2. Click OK (Figure 11.25). Notice the
output cells are formatted to the Currency style. As a manager, you can see the impact on your profit outlook
when you change the two variables (Figure 11.26). For example, if the price is lowered to $165 and you sell
9,500 units, your profit would be 755,000 (cell G15).
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Figure 11.25 Two-variable Data Tables can manipulate two cells. Use the Data Table tool to enter your input cells. (Used with
permission from Microsoft)

Figure 11.26 The final Data Table shows the impact of changing one or both variables. (Used with permission from Microsoft)

Visualizing Mixed Variables
Data collected by businesses comes in a wide variety of forms. It may not always be numerical. It might include
income or age data reported as ranges of numbers rather than an exact number. Sales data may report a
purchase was made but not include the sales price. The Data Table in Figure 11.27 includes both numerical
data (the number of units sold) and categorical data (the sales agent). Summarizing both categorical and
numerical data in the same table is appropriate and useful in many cases. The data can also be visually
presented with a combination of charts and graphs. However, for any in-depth analysis, you will need to adjust
the categorical data.
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Figure 11.27 Information in a Data Table can be numerical or categorial. (Used with permission from Microsoft)

One strategy to adjust categorical data is to replace the text with a numerical value. Using the data in Figure
11.27, you could replace all instances of “Antonio” with the number 1, “Izabelle” with the number 2, and
“James” with the number 3. When making a substitution like this, be sure the spreadsheet includes a legend
that identifies each category and its corresponding number. This could be a simple chart on the same
worksheet or on another worksheet that explains what each number represents. When there are only two
categories, such as a Yes/No question, you can use the binary system with 0 for No and 1 for Yes. Using the
Find and Replace tool makes the process of changing text to numbers easier. Categorical data combined with
numerical data can also be analyzed using PivotTables.

11.2 Statistical Functions

Learning Objectives
By the end of this section, you will be able to:

• Use basic statistical functions to describe a dataset
• Describe other useful functions for data analysis in Microsoft Excel
• Use the Data Analysis tool for advanced statistical functions
• Understand the Solver add-in and its use for data analysis

Data surrounds us. In business, there is always a need to better understand the company, the competitors,
and the customers. You gain this understanding through data collection and data analysis. The field of
statistics is centered on analyzing and making sense out of data. You may have taken a statistics class at some
point, but even if you have not taken a statistics class, you have probably used some statistical
concepts—maybe more often than you think. Concepts such as averages and probabilities are often applicable
to everyday life. For example, you may have been exposed to some statistical concepts when learning about
political candidates prior to an election. This could include the percentage of registered voters of a particular
demographic or the correlation between geographic location and political party. Statistics can be applied
across nearly all fields and situations, and there is almost always a need to know more and dig deeper into
what the data are showing.

There are two branches of statistics: descriptive and inferential. Descriptive statistics, as the name implies,
describe situations. For example, the average transaction amount for purchases in a store at a specific location
is descriptive information about that location. Another example of descriptive information is the turnover rate
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of employees in a manufacturing facility.

Inferential statistics relate to predicting and forecasting. With inferential statistics, you are using historical data
and trends to forecast future performance. The regional sales manager might use the last five years of sales
data to make a forecast for this year’s total sales. A nonprofit organization might use historical fundraising
efforts to make predictions about fundraising for the next two years. Both branches are useful in
understanding data. Information garnered from statistics can be used in a variety of ways in businesses to
improve performance and track progress. Microsoft Excel has a variety of tools to make statistical analysis
easier.

Basic Statistical Functions
There are several commonly used statistical functions that can give you a basic summary and understanding
of the information in your spreadsheet. You can access the functions through the Formulas tab. From this tab,
you can either choose Insert Function on the far left of the tab or use the grouped functions in the Function
Library (Figure 11.28). The Function Library is helpful if you are not quite sure of the appropriate function for
your needs. The functions are organized by application (e.g., financial) and include the ones that are most
commonly used.

Figure 11.28 Functions can be found in the Insert Function tool or in the Function Library. (Used with permission from Microsoft)

Using the Insert Function command has some advantages. When you click on Insert Function, a window
appears with the functions grouped by category like in the Function Library, and then listed alphabetically
within each category. When you click on a function, a brief description of the function appears in the window.
There is also an option to search for functions by typing a description or keyword. This is useful if you are
unsure of the function’s purpose (Figure 11.29).

Figure 11.29 The Insert Function window lists all the built-in functions in Excel. (Used with permission from Microsoft)
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To use functions, first, click in the empty cell where you want to put the function. Then, use either the Insert
Function option or the Function Library to select the function. For this example, you will choose the AVERAGE
function to calculate the average of a list of data. When you select a function from the Insert Function window,
an input window will appear where you will select the range of data for analysis (Figure 11.30). After you select
the range, click OK. Notice that the result of the function is displayed in the lower left of the input window. Also
notice that a dotted line will surround the data identified for analysis. The function will also be visible in the
Formula Bar.

Figure 11.30 The input window to insert a function will display the answer for the given function at the bottom of the window. (Used
with permission from Microsoft)

When you select a function from one of the groups in the Function Library, the function will appear in the
spreadsheet (Figure 11.31). You can select the data for analysis and press Enter. A dotted line will still appear
around the selected range of cells, and the function still displays in the Formula Bar.
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Figure 11.31 The selected cells for the function are displayed on the spreadsheet. (Used with permission from Microsoft)

One of the most commonly used functions is SUM. It even has its own button on the Home tab as the
AutoSum feature (Figure 11.32). The function gives the total for a selected range of cells. Other commonly
used functions in data analysis are MODE, RANGE, MEDIAN, and AVERAGE, which returns the mean of a
selected range of data.

Figure 11.32 The AutoSum shortcut is a very useful tool. (Used with permission from Microsoft)

Other Useful Functions
There are several other functions available that are not specifically statistical functions, but they can be quite
useful when dealing with large datasets or with text. Some of these were covered in Advanced Excel Formulas,
Functions, and Techniques. These functions can help you manage and sort datasets of any size. Table 11.1
summarizes some useful functions for data analysis.

Function Definition

AVERAGEIF Returns the average of a range that meets specific criteria

COUNT Counts the number of entries in a range

COUNTIF Returns the count of a range that meets specific criteria

Table 11.1 Numerical Functions
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Function Definition

CORR Returns the correlation between two ranges of data

IF Tests a condition and returns a predetermined value

MAX Returns the maximum value in a range

MIN Returns the minimum value in a range

SUMIF Returns the sum of a range that meets a specific criterion

SUMIFS Returns the sum of a range that meets multiple specific criteria

Table 11.1 Numerical Functions

Let us look closer at the AVERAGEIF function. It returns the average of a selected range according to a set of
criteria. As with other functions, it is accessed through the Insert Function button on the Data tab or from the
Function Library. When selected from the Insert Function tool, an input window will appear with three
arguments to fill in (Figure 11.33). In the first box, input the range to examine against the criteria. In the
second box, set the criteria, and in the third box, input the range of numbers to be averaged. Both formulas
and text can be entered into the criteria. Be sure to put text elements in quotation marks when establishing
criteria.

Figure 11.33 The AVERAGEIF function returns the average of a selected range according to a set of criteria. (Used with permission
from Microsoft)

Let’s revisit the employee vacation data and use it to find the average number of vacation days employees
have remaining for the North location. The criteria range is the Location column (D2:D21), the criteria is
“North,” and the average range is the Days Left column (C2:C21) (Figure 11.34). The function then returns the
average number of vacation days remaining for all the employees in the list at the North location.
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Figure 11.34 The function can use categorical data as criteria instead of just numerical information. (Used with permission from
Microsoft)

In some cases, you might need to evaluate data using more than a single criterion. The AVERAGEIFS,
COUNTIFS, and SUMIFS functions give the flexibility to add additional criteria. Just remember that each
criterion must be matched with a range where the function will search (Figure 11.35). To add an additional
criterion with its corresponding range to the analysis, simply press the Tab key on your keyboard and
additional criteria will be added to the function arguments.

Figure 11.35 If multiple criteria are needed, use the AVERAGEIFS function. (Used with permission from Microsoft)

The functions we have discussed so far deal with numbers, but there are some functions that are useful for
dealing with text. These can be particularly helpful when you are importing data into a spreadsheet. These
functions can separate out parts of text or take the first several characters and put them in a separate column.
Table 11.2 summarizes some useful functions for managing text in a spreadsheet.
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Function Description

CONCATENATE Combines information in multiple cells into one cell

LEFT Will extract characters from the left of text

RIGHT Will extract characters from the right of text

TRIM Removes spaces from cells except the single space between words

Table 11.2 Text Functions

The CONCATENATE function is useful when data comes from a database or other files. It combines information
from multiple columns into a single column. For example, data imported into an Excel spreadsheet often
contains first and last names in separate columns. With the CONCATENATE function, you can easily combine
those two columns into a single column. To use the function, select the text elements that you want to
combine into one cell (Figure 11.36). To include a space, in the Text2 argument insert “ ” (quotation marks with
a space between). This will then output the first name last name correctly spaced (Figure 11.37). Use AutoFill to
copy the CONCATENATE function through the entire list. In newer versions of Excel, the function has been
replaced with CONCAT, which includes additional features.

Figure 11.36 The CONCATENATE function can be useful when importing data from a database. The CONCAT function takes data from
two columns. (Used with permission from Microsoft)
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Figure 11.37 Then the CONCAT function combines it into one column. (Used with permission from Microsoft)

The Text to Columns tool on the Data tab is the opposite of the CONCATENATE function. It takes a single
column of text and separates it into two or more columns. This tool is also a helpful tool if you are importing
information. Sometimes data imported from another program might not be in the format you desire or need
for further analysis. For example, you can use this tool to place First Name and Last Name in a separate
column if they are imported into a single column. Text to Columns can also be used to separate out City, State,
and Zip into columns.

Data Analysis Tools Add-in
Excel has many advanced data analysis tools available. These include a wide variety of simple and more
complex statistical functions that are available as individual functions in Excel, but it is easier to access the
tools through the add-in called Data Analysis. This add-in puts all the statistical tools together in one place. As
this section discusses these tools, it will keep the focus on using the tools within Excel and not on statistical
techniques, their assumptions, and usage for data analysis. (You can learn more about those topics in a
statistics course or resource.) Some of the most commonly used built-in tools include Correlation, Descriptive
Statistics, Histogram, and Regression. Additional advanced tools include Analysis of variance (ANOVA), and
several tools for testing hypothesis, including the F-Test, t-Test, and z-Test.

Excel also offers a helpful feature to guide you through ideas for analyzing your dataset, called the Analyze
Data help feature, accessed on the far-right side of the Home tab (Figure 11.38). This tool allows you to search
for helpful functions or Excel tools to analyze your dataset. A pop-out will appear on the right side of the
screen, listing a few examples of ways to understand the data better. If you are finding it difficult to get started
on analyzing a dataset, this might be an effective way to generate ideas as you work through the information.
Suggested items for data analysis might include charts, graphs, or a PivotTable.

Figure 11.38 The Analyze Data tool offers some suggestions to analyze a dataset. (Used with permission from Microsoft)
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LINK TO LEARNING

GCFGlobal.org provides 100 percent free online courses (https://openstax.org/r/78GCFGlobal) in a number
of topics relevant to career preparation. This includes a variety of technology and computer skills courses.
They currently offer a number of micro-courses in Excel. Go to this page to see a list of these courses, as
well as others offered (https://openstax.org/r/78GCFCourses) on the site.

Getting the Data Analysis Tool
Because the Data Analysis tools are an add-in, they are included with Excel but generally not installed by
default. To obtain the add-in, go to the File tab, select Options, and select Add-Ins. From there, click on Analysis
ToolPak and select Go at the bottom left of the window (Figure 11.39a). Then, select the checkbox for Analysis
ToolPak, Analysis ToolPak - VBA, and Solver Add-in. Click OK (Figure 11.39b). This will add both the Data
Analysis tool and the Solver add-in to the far-right side of the Data tab (Figure 11.40).

Figure 11.39 Select Go instead of OK to add the Analysis ToolPak. (Used with permission from Microsoft)
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Figure 11.40 Select Analysis ToolPak, Analysis ToolPak - VBA, and Solver Add-in to add the appropriate tools. (Used with permission
from Microsoft)

Figure 11.41 The Solver add-in is found on the Data tab. (Used with permission from Microsoft)

Built-in Data Analysis Tools
The Data Analysis tool add-in offers a variety of statistical tools. You likely won’t use many of them unless you
are doing in-depth statistical analysis. However, there are several that are quite helpful for evaluating most
datasets. These tools are some of the more frequently used statistical analysis tools regardless of the industry
or application. The functions and tools are listed in the Data Analysis library in alphabetical order. Detailed
explanations of the context, analysis, and use of these statistical analysis tools is outside the scope of this text.
Rather than focus on the statistics here, this section will walk through the steps involved in using each tool.

Correlation

Correlation is used to analyze the relationship between two variables. The function in Excel computes the
correlation between two or more variables at one time. The output is in the form of a correlation matrix or grid
that shows how the variables are connected to each other. The closer the correlation value is to either +1 or −1,
the more strongly connected the variables are to each other. A value closer to zero is a sign that the two values
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are not strongly connected. A positive correlation indicates that the variables will move in the same direction.
This means if one variable is higher, the other variable will also be higher, for instance, when a company’s
increased sales also increase their overall company profit. A negative correlation value indicates that the data
move in opposite directions, for example, if an increase in price decreases the quantity sold. Only numerical
data can be analyzed using correlation. If you have categorical data that you are interested in analyzing, you
will need to code it using numbers.

To use the tool, go to the Data tab and select the Data Analysis tool and then Correlation. Then, select the data
of interest and click OK (Figure 11.42). Be sure to select Labels in First Row if your dataset contains column
headings. It is generally good practice to include these in your analysis as it helps to identify the information
and has a more professional look. If there are no headings, the output will list the data by column number. You
can also select an area on the page to display the output or have the output on a new tab in the current
worksheet or a new worksheet entirely. The output will be static. That means if you change any of the data
points in the selection, the correlation will not be updated. You will need to run the Correlation tool again to
update it based on new or different data.

WorldCorp would like to investigate the relationship between the price of their products and the quantity sold.
Management thinks that the items with the lower prices sell more. For this example, the selected range is the
Quantity column and the Price column. Be sure to check Labels in First Row to tell Excel that there are column
headings in your selection.

Figure 11.42 Correlation is used to find the relationship between two variables. (Used with permission from Microsoft)

Using the dataset from WorldCorp’s product sales, you can create the correlation matrix in Figure 11.43 as the
output. The default for Excel is to include several decimal points. Often, this level of detail is not necessary, so
you may need to clean the output by reducing the number of decimal points and changing the column widths.
You might also consider additional formatting such as bolding certain numbers or filling cells with color.
According to the output, the correlation between sales and price is not very strong. The value −0.092 is closer
to zero than it is to one, which indicates that management’s suspicion that more products at the lower price
range are sold is not correct.
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Figure 11.43 The output from the correlation function gives you a matrix of correlation values for the selected variables. (Used with
permission from Microsoft)

Descriptive Statistics

The Descriptive Statistics tool provides a summary of the dataset in a table format. The summary information
includes items such as the mean, variance, standard deviation, and range. You can select a single column of
data or multiple columns at once. You can also analyze data that is grouped in rows rather than columns. Be
sure to check the appropriate box when prompted if your data is in rows. As with correlation, you can display
the information on the current worksheet, on a new worksheet, or in an entirely new workbook. To access
Descriptive Statistics, go to the Data tab and then Data Analysis. Choose Descriptive Statistics (Figure 11.44).
When the input window appears, select the data you want to analyze. Be sure to check the box to indicate that
the data has a header row. Next, determine the desired location for the output result. Finally, select Summary
Statistics at the bottom of the input window and click OK.

Figure 11.44 The Descriptive Statistics tool is a quick way to summarize a dataset. (Used with permission from Microsoft)

Notice that you also have an option to select confidence levels and both the Kth largest and smallest values in
the output. These are more advanced level statistical analyses. If desired, choose those options to be included
in the output. The default setting for confidence intervals in Excel is 95 percent, but you can customize that
setting. If you use the dataset for WorldCorp, you obtain the following output when you use the Descriptive
Statistics tool (Figure 11.45).
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Figure 11.45 The output from the Descriptive Statistics tools includes values such as the mean and standard deviation. (Used with
permission from Microsoft)

Notice with this output, you will again need to adjust the number of displayed decimal points to give it a more
professional look. You can also choose to format the numbers with commas or as currency, if applicable.

Histograms

A histogram is a chart that displays the number of occurrences of data within a defined range. This is a
convenient way to easily see the ranges of most of the data. It is not an in-depth statistical analysis of the data;
instead, it provides a summary of the overall distribution of the data. Histograms can be used with data that is
at least at the ordinal level of measurement. The histogram function can be accessed through the Data
Analysis library. When selected, as with others in the analysis library, an input window will appear (Figure
11.46). You will need to input some information such as the input range and the bin range.

Figure 11.46 The input range and the bin range are needed to construct a histogram of the data. (Used with permission from
Microsoft)

The input range represents the data being divided into the various “bins,” or category ranges. These bins must
be mutually exclusive and collectively exhaustive. In other words, each data point needs to have only one bin
into which it fits. This means the bin ranges must be set up to accommodate the maximum and minimum
values. Excel will sort the data correctly into the bins. Other options for the Histogram tool are to include the
cumulative percentage, output a sorted histogram, or have the output be in the form of a chart in addition to
sorting the data into each of the bins.
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Let us look at the WorldCorp sales data again. To construct the histogram, establish the number of bins and
the size of the bins you will be using. Be sure to include enough bins to show differences that may exist in the
dataset but not so many that it is difficult to see trends or that several bins have no data in them. A general
rule of thumb is to divide the range of the data (highest data point – lowest data point) by the width of the
categories. For example, if the range is 800 and you want each category or bin to increase by 50, you will need
approximately 16 bins. You can also determine the range of each bin by first determining how many bins you
want. For your range of 800, if you want 20 bins, each bin will have a range of 40.

The column of data you will use for the histogram is column E, Unit Price. When using the Descriptive Statistics
tool, you determined that the minimum number is $7.64 and the maximum number is $14,353. The output
also gave the range of the dataset, $14,345.36. If you divide the range by the number of desired bins, you get
the approximate size of the bins you should use. In this example, let’s use 15 bins. That would be 14,345.36/15
or 95.62. You then use this as a basis to establish the bin range that you will use in the Histogram tool. You can
use whole number categories to make the histogram easier to follow and look cleaner. You could set the first
bin at $100 since the value calculated was almost $100 ($95.62). This means that all data up to, but not
including $100 will be included in that bin. Each subsequent bin will increase by 100 until you reach 16 bins.
You record these bins in the spreadsheet manually. Excel does not create the bins for you. These bins can be
either on the dataset worksheet or a separate worksheet. You will use these cells as your bin range when
creating the histogram.
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Figure 11.47 You can create a histogram of WorldCorp data. The bin range defines the category limits for the histogram. (a) You can
then use the Histogram tool to set the criteria. (b) The output of the Histogram tool displays the frequency in each bin or category.
(Used with permission from Microsoft)

Open the Histogram tool in Data Analysis. Select the input range, the Unit Price column, and then select the
bin range. Be sure to select the Labels checkbox if you are including the column header in the input data
selection. You must also include a column heading for the bin range if the data range has a column heading
(Figure 11.47a).

The output for the histogram Data Table shows the count in each of the established bins for the input range
selected (Figure 11.47b). Excel will automatically add a “More” bin at the end to include all data that falls
outside of the range that you establish. Even if you have a bin to accommodate the maximum data point, Excel
will add the “More” bin at the end of the histogram Data Table.

From this table of data, you can create the histogram using the options on the Insert tab. Alternatively, you can
select the chart output and create the chart at the same time you create the data by checking the Chart Output
option at the bottom of the window. You can also include cumulative percentages in the output by checking
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the Cumulative Percentage (Figure 11.48). Creating a histogram chart from a dataset not using the Data
Analysis tools will be covered in Histogram.

Figure 11.48 If selected, the histogram can also be displayed graphically. (Used with permission from Microsoft)

Regression

Regression is a tool used in inferential statistics. It determines the best fit line or data model for a given
dataset. There are many types of regressions, but linear regression is the method most used in business.
Linear regression can be used to forecast sales and expenses for the next year, to better understand the
drivers of customer purchasing levels, or to investigate how price changes might impact profit. With the
regression process, you have one dependent variable you are predicting (Y) and one or more independent
variables (X) you are using to predict Y. With the tool in Excel, you can have as many X variables as you need.

REAL-WORLD APPLICATION

Regression in Business

Regression is the primary tool used by businesses to determine if a relationship between variables exists, as
well as the magnitude and nature of this relationship should it exist. In business, regression can be helpful
in optimization and business forecasting across a variety of industries. For instance, you can investigate the
increase in new home sales based on economic growth. You can also make determinations about how
much inventory to purchase.

Regression is one of the Data Analysis tools. As with the other tools, when you open it, an input window will
appear (Figure 11.49). Select the column to use for the Y variable and then select the column(s) to use for the
independent variable(s) X. If using more than one independent variable, be sure that all the X variable columns
are next to each other. Also note that you must have equal numbers of rows for all variables you select for
analysis.

784 11 • Advanced Excel Spreadsheets: Statistical and Data Analysis

Access for free at openstax.org



Figure 11.49 The input window for the Regression tool allows you to select the Y and the X variable(s). (Used with permission from
Microsoft)

Be sure to check the Labels box if you included the column headings. It is good practice to include the
headings, as the output for regression will be more specific to your dataset. Other checkboxes relate to
residuals and line fit plots, so check them if they apply to your situation. These options are more advanced
statistical tools that can be used. As with the other tools, you can decide where to place the output of the
function. The output will be a detailed regression analysis from which you can extract the relevant information,
such as R2 and the regression equation, using the coefficients column.

Using the same dataset you’ve been using, you can run a single regression using Quantity as the independent
variable (X) to predict the FOB $ as the dependent variable (Y). These values were chosen to investigate the
impact that Quantity has on FOB $. Management believes that although Unit Price and Quantity are not
strongly connected, the Quantity value is a good predictor of FOB $ (Figure 11.50). To begin, go to the Data
tab, and choose Data Analysis. Then, select Regression from the list. Select the data in column F, FOB $, as the
Y input range and column D, Quantity, as the X input range. Check the Labels box if you also included the
column headings. Then, click OK. Make sure to clean up the data, such as by reducing the number of decimal
places, and format it to give it a professional look (Figure 11.51).
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Figure 11.50 This example uses Quantity as the X variable and FOB $ as the Y variable. (a) The Regression tool shows the ranges for
each of the variables. (Used with permission from Microsoft)

Figure 11.51 The output provides many statistics a business can use for forecasting. (Used with permission from Microsoft)

If the dataset has more than one independent variable, the information for each variable will be listed in the
output as an additional row under the Intercept row.

Advanced Data Analysis Tools
The Data Analysis library of tools has many other statistical analysis tools. These are used in business less
frequently than the tools discussed so far, but they do offer some opportunities for more in-depth analysis.
You might see these tools used in more scientific disciplines such as chemistry or biology. This section will
briefly introduce how to use these functions in Excel.
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Analysis of Variance

Analysis of variance (ANOVA) is a statistical technique used to compare more than two groups at the same
time. It involves conducting an analysis to determine if differences are present in the data based on their
respective variances.

There are three types of ANOVA analyses available in Excel that are easily accessed through the Data Analysis
tool. The input windows for the ANOVA functions look very similar, so be sure to check the title at the top of the
input window.

ANOVA: Single Factor focuses on analyzing information for a single variable (Figure 11.52). For example,
perhaps you want to do some price checking on your favorite brands at three retailers. You could use ANOVA
to determine if there are price differences between the retailers.

Figure 11.52 Single Factor ANOVA is centered on differences between a single variable. (Used with permission from Microsoft)

To use the Single Factor function, simply select the data of interest and choose the appropriate grouping of the
data (columns or rows). Be sure to check the Labels box if you included the headings in your selection. You also
have the option to change the alpha (significance level) for your analysis. The output will be in the form of a
typical ANOVA table, which you may have seen in a statistics course.

ANOVA: Two-Factor With Replication is used to test two variables and to determine if there is any interaction
present in the variables (Figure 11.53). The input window looks like that of the Single Factor, except you will
need to add the number of rows per sample. This number will need to be the same for all categories. You must
also have row and column headings for this option. Excel assumes that the first column and the first row in the
selection will include the headings for the data, so there is no Labels checkbox.

Figure 11.53 ANOVA: Two-Factor With Replication requires that all samples have an equal number of rows. (Used with permission
from Microsoft)

The final type of ANOVA in Excel is ANOVA: Two-Factor Without Replication, which allows you to test two
variables. Unlike With Replication, here you will not be testing for the interaction between the two variables.
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Instead, you are testing the two variables independent of each other, but simultaneously. Notice in Figure
11.54 that the window looks the same as the window for Single Factor, except for the title. There is no box to fill
in the Rows per Sample, as there is in Two-Factor With Replication.

Figure 11.54 Two-Factor Without Replication has a single row per sample. (Used with permission from Microsoft)

LINK TO LEARNING

Through the use of the advanced statistical tools in Excel, you can better analyze data and discover
differences among various groups of consumers in your target market. Watch this video on how ANOVA can
be used to understand consumers in the craft beer industry (https://openstax.org/r/78ANOVA) to learn
more.

F-Test

The F-Test is used to determine if two datasets are from the same population based on their variances. It is
another type of hypothesis test that can be used for in-depth statistical analysis. Select F-Test: Two Sample for
Variances from the Data Analysis tool library. As with the other functions, an input window will appear (Figure
11.55). You will need to select the range of each variable separately. The ranges do not need to be the same
size. Check the Labels box if you included the column headings. Click OK when you are ready to analyze the
data.

Figure 11.55 The F-Test function examines the variances between two datasets. (Used with permission from Microsoft)

T-Tests

T-Tests are also hypothesis tests. T-Tests are used when data does not follow the normal distribution (a
concept in statistics), when the sample sizes are small (generally less than 30), or when you do not have a
population standard deviation. It is often used in statistics to test for statistical differences between two
groups of data. There are three t-Tests available in Excel. The input windows look the same, except for the title
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of the input window, so make sure you have selected the appropriate test. The first type, t-Test: Paired Two
Sample for Means is for dependent datasets, such as if you are determining the success of a coupon
campaign. You could track sales for a group of customers before the coupon and then track the sales for the
same group of customers after the coupon campaign. You can then use this test to determine if there is a
statistical difference between the means of the two groups, or you can input a specific level for the difference
in the Hypothesized Mean Difference input argument (Figure 11.56). If there is no set difference level you are
investigating, then type “0” in the Hypothesized Mean Difference box.

Figure 11.56 The Paired Two Sample for Means test examines before and after comparisons. (Used with permission from Microsoft)

The two remaining t-Tests in Excel are for analysis with independent datasets. The tests are t-Test: Two-Sample
Assuming Equal Variances and t-Test: Two-Sample Assuming Unequal Variances. You could use the two-sample
t-Test to determine if there is a difference between purchase amounts for males and females. You could also
use the test to determine if sales have changed between last year and this year. The difference between the
two tests is that one deals with equal variances, and the other deals with unequal variances. You will need to
determine before selecting the test if the variances are nearly equal or not. You can determine if the variances
of two datasets are equal by using the Descriptive Statistics tool discussed in Descriptive Statistics. When you
choose the appropriate function, an input window will appear (Figure 11.57). As with the Paired test, you will
need to select the two ranges of data and a Hypothesized Mean Difference. If there is no difference, then type
“0” into the Hypothesized Mean Difference box.

Figure 11.57 The Two-Sample Assuming Equal Variances function examines statistical differences between two datasets when the
variances are equal. (Used with permission from Microsoft)

Using the WorldCorp data file with unit price, you can determine if there is a difference in the unit price
between Home Stereo Systems and Computer Servers Accessories. The t-Test is appropriate for this analysis
because the population standard deviation is not known. In other words, you do not know whether the data
follows the normal distribution. Upon verification, you determine that the variances of the two groups are very
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different, so you should choose the t-Test: Two-Sample Assuming Unequal Variances (Figure 11.58).

Figure 11.58 If the variances are known to be not equal, use the t-Test Two-Sample Assuming Unequal Variances function. (Used
with permission from Microsoft)

The output from the function gives all the information needed to make the decision for the hypothesis test. As
with previous functions, clean up the decimal points and reformat. The output obtained from using the other t-
Test functions will look like Figure 11.59.

Figure 11.59 The output from the t-Test function shows the P value for both a one-tail and two-tail test. (Used with permission from
Microsoft)

Z-Test

The z-Test: Two Sample for Means (Figure 11.60) tests for differences between two independent datasets that
follow the normal distribution. It is like the t-Test except that the data is normal.
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Figure 11.60 The z-Test function is used when datasets are known to be normal. (Used with permission from Microsoft)

You will need to select the two ranges for analysis and include a Hypothesized Mean Difference if desired. In
addition, you will need to enter the variance for each of the variable ranges. If you don’t already know the
variance, you can use the Descriptive Statistics tool previously discussed or the variance function in the Insert
Function library to obtain it. The variance you enter must be a number, not a cell reference. Check the Labels
box, if appropriate, and then click OK. The output obtained from the z-Test will be much like the output for the
t-Tests.

The Solver Add-in
The Solver add-in offers additional ways to analyze a dataset. This section will just cover the basics, but you can
research the tool further if you want to know more about Solver and its uses for data analysis. Solver appears
with Data Analysis on the Data tab (Figure 11.61).

Figure 11.61 The Solver add-in is found on the Data tab. (Used with permission from Microsoft)

The Solver tool allows you to change levels in a dataset according to specific constraints you set up (Figure
11.62). Then, you can see the various solutions under those constraints. This is a helpful tool if you have
multiple variables within a dataset. The output provides an optimal solution with the dataset given the
constraints you establish.
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Figure 11.62 The Solver tool allows you to change levels in a dataset according to specific constraints. (Used with permission from
Microsoft)

To use the tool, you need to determine the target cell for optimization and the criteria (maximum, minimum,
or a specific value). Then, you add the various constraints to the dataset. You can add up to 100 constraints to
the Solver tool. Solver will find a solution to meet the criteria for the target cell assuming there is a solution.
You can apply the solution to your dataset by choosing “Keep Solver Solution” with the output. There are many
applications in business for Solver. For example, you could use the tool to determine the optimal level needed
to minimize costs or maximize revenues in a business. You can use it to find the optimal solution for
allocations in a retirement fund to enable you to retire at your desired age. You can also use it to determine
the conditions necessary to pay off a mortgage loan in half the time. Take a look at the data in the "solvsamp"
tabs of the downloadable Chapter 11 data file (https://openstax.org/r/78Ch11DataFile) ("solvsamp1-7") for
some great examples of Solver and applications of the tool to various problems.

SPOTLIGHT ON ETHICS

Data Integrity

There are many ways that information and data can be manipulated to tell a different story from what is
factual or to influence your interpretation of the information to slant a certain way. Simple changes such as
adjusting the scaling on a chart or adding formatting changes to numbers can alter the way people
interpret the information. For instance, you may want to show a larger than actual impact. You might
decide to use a baseline number other than zero along the x-axis to show a much larger trend in the data
than what is real. Or, perhaps you can choose to emphasize information and impacts by using very small
units of measure. With today’s endless access to data, the influence of the media, and the ever-present
“fake news” online, it is important to be diligent about making sure that data is accurately reported,
analyzed, and presented to the intended audience.
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11.3 What-If Analysis

Learning Objectives
By the end of this section, you will be able to:

• Use Scenario Manager to evaluate different variables
• Determine a desired result using Goal Seek

Having a backup plan is helpful when things do not go as expected. The plan offers an alternative course of
action to pursue in case the first path does not work out. In business, this practice is called contingency
planning, and it is essential for the business to be successful. This planning process can involve investigating
alternatives if sales are lower than expected. It can involve planning for the eventual retirement of key
personnel in the business. It could also address items such as the long-term strategic direction of the
company. The contingency plan is a proactive attempt to anticipate some situations that might be different
from your expected course of action and that might negatively impact the success of your business. Having
this plan in place certainly does not guarantee that nothing outside of the plan will happen, but it helps a
business to deal with specific situations they have identified as well as some degree of uncertainty. You cannot
always plan for the unexpected, such as natural disasters or shifts in consumer preferences, but there are
some things that you can plan around. For example, the business can have a plan in place in the event sales
are lower than expected. This plan could involve budget cuts or enhanced marketing efforts to boost sales.

There is a process to developing a contingency plan for a business. These steps might also be helpful in your
personal life as you plan for your future career. The first step is to list the risks or the events that have some
uncertainty associated with them. For example, if you are unsure of what the utility costs might be for a new
building, that could be a risk for your business. Some areas where a business may experience risks are
unplanned issues with time or schedule, cost adjustments, availability of resources, or technical problems.
Next, you will need to rank the risks according to the impact to the business. For example, if your business is
an e-commerce site, a technical issue that crashes your website would be a significant priority over increased
office supply expenses. Next, you need to set a plan for each event that you have identified. Each plan should
be detailed enough to provide an alternative course of action for the business. Your business should revisit the
contingency plan often and make any adjustments necessary, based on any changes in the business. There are
many templates online that can help you with contingency planning in business. Some Excel templates use
formatting to make the plan easy to understand and professional so that you can easily share it with others in
the company.

Using Scenario Manager
The Scenario Manager tool in Excel provides a way to look quantitatively at contingency planning. It allows the
user to change attributes without altering live data to examine the resulting impact on key variables. You can
change up to 32 cells and view the results of those changes all at the same time. This feature can be quite
helpful for contingency planning. For example, you might already have metrics that identify the best- and
worst-case scenarios for sales. Using this range and the Scenario Manager tool, you can look at the impact to
the overall profit picture for the business. You could also use the tool for planning your personal finances. You
could investigate the impact of increasing your monthly mortgage payment on the time it will take you to pay
off the loan. The tool can be instrumental in helping a business navigate multiple courses of action to
determine the best approach moving forward. You can also merge the scenarios from a single or multiple
worksheets together for more in-depth analysis.

What Is a Scenario?
The Scenario Manager is part of the What-If Analysis tools suite in the Forecast command group. The tool is
accessed from the Data tab and is in the Forecast command group (Figure 11.63).
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Figure 11.63 The Scenario Manager tool provides a way to look quantitatively at contingency planning. (Used with permission from
Microsoft)

A scenario determines the values that Excel will use to change the input cells. You can save different scenarios
with different values to view the impact on your target cell(s) at the same time. When you choose Scenario
Manager, an input window will appear (Figure 11.64). From here, you will set the changing cells that define the
scenario and the target cell for the results.

Figure 11.64 To use the Scenario Manager, first set the changing cells and target cell. (Used with permission from Microsoft)

Let’s begin with a simple example of obtaining a home mortgage. The initial mortgage is for $150,000 for 30
years with an interest rate of 5 percent. You want to find a better interest rate and see the impact that rate will
have on your payment and the total amount you will pay. Using the PMT (payment) and FV (future value)
functions from the Function Library, you can quickly determine the status of the loan (Figure 11.65). With these
values at the current rate of 5 percent, you will pay just over $800 per month and at the end of the life of the
loan, you will have paid nearly $260,000. The functions by default return a negative number for the results, as
indicated by the parentheses and the red font color. You will need to adjust the equation to convert the
number to a positive number. You can either put a “-” in front of the function or use the ABS function at the
beginning of the formula to use the absolute value of the number. You can use the Scenario Manager to
investigate different interest rates and different payment terms if you decide you want to pay the loan over 15
years or a time frame other than the standard 30-year mortgage term. You will use the same mortgage
example to investigate different levels for the interest rate and repayment terms.

794 11 • Advanced Excel Spreadsheets: Statistical and Data Analysis

Access for free at openstax.org



Figure 11.65 The functions by default return a negative number for the results as indicated by the parentheses and the red font
color. (Used with permission from Microsoft)

Adding and Deleting a Scenario
Using the mortgage example, you can create a scenario to look at the impact of lowering the interest rate on
both the payment and the total amount paid for the loan. First, to add a scenario, go to the Data tab, choose
What-If Analysis, and select Scenario Manager. Click Add and the Add Scenario dialog box will appear (Figure
11.66). Here, you will define the changing cells and name the scenario. You can name this scenario “rate
changes.”

Figure 11.66 To add a scenario, click Add in the Scenario Manager window and define your scenario in the dialog box. (Used with
permission from Microsoft)

Next, select the cell you want to change. To change the rate, you would select cell A3. The Scenario Manager
does allow you to add more than one cell in the scenario. In this example, you will also change the length of
time for the loan. Select A3:B3 for Changing cells. You can add comments if desired to explain the scenario,
such as details about the reason for the selected ranges and other relevant information. Then, click OK. Next,
you will define the levels or range of values that Excel will use to change the value in cells A3 and B3. Assume
you want to compare the impact of a rate higher than the original 5 percent and a loan term shorter than the
original 360 months to the impact of a lower rate and longer loan term (Figure 11.67). Add two separate
scenarios at the various levels for each cell, A3 and B3. Click OK. This will take you back to the Scenario
Manager window. Add the other scenario in the same way.
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Figure 11.67 Define the ranges of values for Excel to manipulate in the scenario. (Used with permission from Microsoft)

Notice that you have two scenarios listed in the Scenario Manager (Figure 11.68).

Figure 11.68 The Scenario Manager lists all the active scenarios on a spreadsheet. (Used with permission from Microsoft)

There are a couple of options at this point. If you want to see the results from either scenario on the
spreadsheet, click the appropriate scenario in the list and click Show. This will change the value in the
spreadsheet, but only for one scenario at a time. If you choose Summary, the Scenario Manager will compile
the information for all the scenarios in the list in a clear table on a separate worksheet so that you can
compare the results (Figure 11.69). You can then format and adjust the table to fit your needs. One other
functionality of the Scenario Manager is that it can merge scenarios from other worksheets into a single
worksheet using the Merge button.
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Figure 11.69 The Scenario Manager tool provides a summary of the results on a separate worksheet. (Used with permission from
Microsoft)

To delete a scenario, go to the Scenario Manager and select the scenario you want to delete from the list and
choose Delete. If you have created a scenario summary table, the table will remain even if you delete the
scenario. If you instead selected Show and the scenario is displayed on the spreadsheet, the numbers will not
revert to the original values even if you delete the scenario. Rather, you will lose your original data. For this
reason, it is generally better to use the Scenario Summary rather than the Show option.

REAL-WORLD APPLICATION

Personal Budgeting

You’ve learned that Excel can be a helpful tool for managing your personal finances. It can also be a handy
tool to help you plan for future purchases and accumulate savings for retirement. Take a look at this article
to see how the Scenario Manager can help with budgeting (https://openstax.org/r/78ScenarioManag) your
personal finances. Let’s use the Scenario Manager to save for a vacation. You will need to investigate the
cost of the vacation—for instance, factor in all costs associated with the travel (flight, hotel, food, etc.).
Ideally, you will want to compare more than one cost associated with the vacation—perhaps you are
comparing hotels, or flights, or even another destination altogether. Then, determine what your sources of
income might be. You will use the Scenario Manager to determine the costs of the vacation by comparing
the different vacation options using your budget information.

Think about the following:

• How can the Scenario Manager tool be used to help you reach your goals?
• What assumptions did you need to make in order to establish your budget?

Editing a Scenario
To edit a scenario, open the Scenario Manager, select the scenario you want to edit, and choose Edit on the
right of the window. This will open the initial scenario window. You can make changes to the target cells,
comments, or name of the scenario. Then, click OK. You will be prompted to adjust the values if desired. Then,
click OK. You will need to run the Summary again to see the updated results based on the changes you made.
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Using Goal Seek
Goal Seek is another tool in the What-If Analysis group. It is like Solver but restricted to a single input variable.
The Goal Seek tool allows you to select a target cell and value for that cell by changing another cell that
contains a formula. For example, Goal Seek could determine how much money you need to set aside to reach
your retirement fund goal. It could also determine the mortgage interest rate needed to keep a monthly
payment within your budget. In a small business, this tool can help when considering a purchase of
equipment or property for the business. In this case, the duration and the total amount of the loan are
typically known. Goal Seek can investigate financing options to get the monthly installment payment within
budget. Conversely, Goal Seek can determine how much in total a person or business can afford for a loan
based on a set interest rate and length of the loan.

To begin, open the spreadsheet with the information needed for your analysis or create a new one. Using the
mortgage example, suppose you would like to determine what value of home you can afford. Most mortgages
have a term of 30 years (360 months), and you are planning on a 5 percent interest rate. You would like a
monthly payment not to exceed $850. The Goal Seek tool can determine the loan amount that will keep the
mortgage payment within your budget. Go to the Data tab, click on the drop-down arrow next to What-If
Analysis, and choose Goal Seek (Figure 11.70). Notice the input window has three arguments: Set cell, To value,
and By changing cell.

Figure 11.70 Goal Seek is similar to Solver, but you are restricted to a single input variable. (Used with permission from Microsoft)

In this example, type $D$3 in the Set cell field, 850 in the To value field, and $C$3 in the By changing cell field
(loan amount). Click OK (Figure 11.71). The result will display in the window if Excel found a solution.

Figure 11.71 Goal Seek displays the result if a solution is found in the Goal Seek Status window. (Used with permission from
Microsoft)

Your budgeted monthly payment of $850 will allow you to afford a home that is approximately $158,000. The
result window also provides the target value (850) and current value ($850.00) for the solution. When you click
OK, Excel retains the solution in the spreadsheet. If you want the values to return to their original numbers,
click Cancel instead. You can use the tool to examine various options, such as the price you could afford if you
increased your monthly payment to $900. This tool provides information for data analysis and contingency
planning when you are focused on one input variable, but it is limited in its use for in-depth planning and
analysis.
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11.4 PivotTables/Charts

Learning Objectives
By the end of this section, you will be able to:

• Manipulate and create calculated fields in a PivotTable
• Add slicers to a PivotTable
• Use timelines in a PivotTable

In business, you will sometimes hear references made to “big data.” In this context, “big data” represents the
large, growing, diverse datasets used by businesses to analyze their performance and attract more customers.
There are three components to big data: the velocity of growth in the amount of data, the massive volume of
data collected, and the variety of data that is collected and used in businesses. This data is collected through a
process called data mining, which involves using software to make sense of all the data collected by the
company and from outside sources. The goal is to analyze and evaluate large quantities of information and
discover trends that may be useful to the company. Those trends could show purchasing patterns for a specific
demographic group or identify a new competitor that businesses need to combat. The possibilities are as
endless as the data that is collected. Through programs such as Excel and sophisticated data analytic software
packages, the data can be synthesized to aid in decision making in the business. The use of data for decision
making is applicable to all types and sizes of businesses and organizations.

You learned about PivotTables in Advanced Excel Formulas, Functions, and Techniques. Here, you will focus on
the advanced features of PivotTables that help with data analysis. The PivotTable Analyze tab provides several
tools that make data analysis a bit easier. Recall that the PivotTable Analyze tab is available when you have
data formatted as a PivotTable and you click inside the table (Figure 11.72).

Figure 11.72 The PivotTable Analyze tab provides several tools that make data analysis streamlined. (Used with permission from
Microsoft)

The Timeline and Slicer tools offer a more visual way to filter the data in the PivotTable. The Fields, Items, &
Sets menu allows you to include more calculations in your analysis. There are additional options in this menu
that can help facilitate data analysis in the PivotTable.

Insert Timeline
The Insert Timeline feature for a PivotTable allows you to quickly filter information based on a date field. You
must have a field formatted as a date to use the Insert Timeline tool. Using the first four tabs in the Chapter 11
data file (https://openstax.org/r/78Ch11DataFile) workbook ("timeline1," "timeline2," "timeline3," and
"timeline4"), you can create a PivotTable using the skills learned in Advanced Excel Formulas, Functions, and
Techniques. The PivotTable summarizes the enrollment English Index Score (EN Index Score) for various
majors at a university over several years (Figure 11.73). You can use this data to see if there have been changes
in the score over time. The Insert Timeline feature on the PivotTable Analyze tab allows you to add a date filter
to the table.
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Figure 11.73 A date filter can be applied to a dataset with the Insert Timeline tool. (Used with permission from Microsoft)

Click in the PivotTable to bring up the PivotTable Analyze tab. Choose Insert Timeline from the Filter command
group. Click the checkbox next to the field title that contains the date. In this example, the field is called DATE.
Click OK. The timeline scroll bar will appear (Figure 11.74). In this case, you only have annual data, so you can
change the unit to years instead of quarters, months, or days.
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Figure 11.74 The timeline scroll bar offers a quick way to filter data using time such as years. (Used with permission from Microsoft)

Currently, the PivotTable shows all years available in the dataset. You can deselect those years that you do not
want and keep only those that you are interested in examining. Let’s select 2017 and 2018, which filters the
table using those dates only. You can then use this filtered data for more in-depth analysis and calculations. To
remove the timeline, right-click on the timeline scroll bar and choose Remove Timeline. If you had already
filtered the data with the timeline, the data in the PivotTable will remain filtered to those dates. If you want the
table to return to its original form with all of the dates included, be sure to click on the Remove Filter button
prior to removing the timeline.

Insert Slicer
A slicer is a visual, interactive way to filter data in a PivotTable. When a PivotTable has slicers available, you can
filter the data by clicking on buttons in the slicer as opposed to using the filter options in the column headings
of a PivotTable. They are particularly useful when there are multiple users of a PivotTable who need to view the
information that is relevant to their needs. You can add slicers through the PivotTable Analyze tab in the Filter
command group.

Let’s look again at the dataset of enrollment ACT scores. A PivotTable can be created to include the years,
major, average high school grade point average (HS GPA), EN Index Score, and average ACT Math. You can
insert a slicer to delve deeper into the data. Assume you want to look at the HS GPA for biology and chemistry
majors compared with that of accounting and business majors. You can use a slicer to make this process
easier. First, click in the PivotTable to access the PivotTable Analyze tab. Then, choose Insert Slicer. A selection
window will appear (Figure 11.75). Click the checkbox next to Major 1. Click OK.
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Figure 11.75 The Insert Slicer tool allows you to choose which variable to filter. (Used with permission from Microsoft)

The slicer will appear on the spreadsheet with selection buttons for each of the majors in the list. You can
resize and format the slicer to meet your needs. You can also choose various slicer styles under the Slicer tab
that becomes accessible when you click inside the slicer (Figure 11.76).

Figure 11.76 The Slicer tab appears when you have inserted a slicer into a PivotTable. (Used with permission from Microsoft)

When you insert the slicer, the default is for all majors to be selected, as indicated by the blue highlighted
buttons (Figure 11.77). You can click on the Multi-Select option to remove all the majors and start building your
table for analysis. For this example, you want to look at the differences in HS GPA for Biology, Chemistry,
Accounting, and Business Administration. You will choose only those majors to be displayed in your PivotTable
(Figure 11.78).
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Figure 11.77 By inserting a slicer, a user can quickly filter data by simply clicking on the major of interest in this example. (Used with
permission from Microsoft)

Figure 11.78 To remove a filter, click on the Remove Filter button. (Used with permission from Microsoft)

Choosing only these majors filters the table for an easier and more direct comparison. Remember, you could
simply use the filter option in the column heading, but slicers are a convenient and interactive way to filter
data. To remove the filter, click on the Remove Filter button in the top right of the slicer window. To remove the
slicer entirely, right-click on the slicer and choose Remove Slicer. Be sure to remove the filters first if you want
the data to return to its original form. Simply removing the slicer window will not also remove the filters you
set in place.
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Slicers are also available when you have data in a Data Table. With the data formatted as a Data Table, click
inside the Data Table to bring up the Table Design tab. The Insert Slicer option is in the Tools command group
(Figure 11.79). The process to insert, format, use, and remove slicers is the same as it is for PivotTables.

Figure 11.79 Slicers can be used with Data Tables as well through the Table Design tab. (Used with permission from Microsoft)

LINK TO LEARNING

PivotTable slicers are a great way to set up an interface so that users can better navigate the data file. You
can make a dashboard of slicers to make it easier for users to select the data they need to see from the
PivotTable. Read this article that provides a detailed example of setting up a dashboard with both slicers
and timelines (https://openstax.org/r/78ExDashboard) to learn more.

Calculated Field
The Calculated Field tool allows you to add columns of calculations to your PivotTable. The Calculated Field
tool is accessed through the Fields, Items, & Sets menu on the PivotTable Analyze tab (Figure 11.80).

Figure 11.80 Calculated fields are added to a PivotTable through the PivotTable Analyze tab. (Used with permission from Microsoft)
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These calculated field columns cannot be used with slicers, but they allow you to analyze the data in other
ways. Using the dataset of enrollments and ACT scores, assume you want to get the average ACT scores across
the various content areas (English, Math, etc.). You will need to get an average of the four ACT scores as a
calculated field column. Click inside the PivotTable to access the PivotTable Analyze tab; choose Fields, Items, &
Sets; and click on Calculated Field. An input window will appear (Figure 11.81).

Figure 11.81 Select the variable for the calculated field in the Insert Calculated Field window. (Used with permission from Microsoft)

You will need to name the calculated field—use “ACT average” for this example—and then you can input the
formula. Remember that all formulas in Excel need to begin with an equals sign. You can use functions such as
AVERAGE, SUM, and IF, as appropriate for your needs. For this example, you want the average of the English,
Math, Reading, and Science fields. To accomplish this, type in the Formula input box “=AVERAGE(” to begin.
Then, choose “eng” from the Fields list and select Insert Field. Then, type a comma and insert the next field,
“math.” At the end of the formula, make sure to close your parentheses and then check for extra spaces in the
formula. Then, click Add to create the calculated field. Finally, click OK (Figure 11.82a). You will now see the
calculated field column in your PivotTable (Figure 11.82b).
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Figure 11.82 Using the (a) Calculated Field feature will add (b) a new column to the PivotTable. (Used with permission from Microsoft)

The default setting for the column headings in PivotTables is “Sum of” even though you are calculating an
average. When you created the calculated field, you named the field ACT average, but that is not the column
heading Excel will use. Excel will automatically add on “Sum of” to the column heading. You can change that by
simply clicking on the column heading and deleting the words “Sum of.” Notice the data in the first cell in the
ACT average column for each major is much larger than the other numbers in the major. This cell represents
the sum of all the averages for the subgroup. For accounting, 131.49 is the sum of the average ACT numbers
for the years 2015 to 2020. Excel automatically adds the subtotal to the first field in the Rows list. This number
is probably not as valuable as the averages per year under each major. You can delete this value by choosing
the field settings for Major 1 and under Subtotals, select None (Figure 11.83).
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Figure 11.83 The default setting is “Automatic.” This adds the subtotal for the first field in Rows in the PivotTable. (Used with
permission from Microsoft)

Adding this calculated field for the accounting majors, you can see that the average ACT was at its lowest in
2019 and at its highest in 2018. Calculated fields can be used with sales and expense information to determine
your profit, profit margin, and other similar calculations.

There are other options in the Insert Calculated Field input window that may also be useful. You can select the
calculated field from the list and modify it to make changes. You can also select that calculated field and delete
it entirely. Click OK after making your changes or deleting the calculated field. If you delete the field, the
column will be removed from the PivotTable.

List Formulas
If there are multiple users of a data file, it can be important to ensure everyone is aware of the calculations
behind the columns. This will assist the users in understanding the dataset and the information contained
within. The List Formulas option in the Fields, Items, & Sets menu creates a separate tab that lists all the
formulas (calculated fields) used in a PivotTable (Figure 11.84). This option is accessed when you are in the
PivotTable in the PivotTable Analyze tab. Then, go to Field, Items, & Sets to get to List Formulas. It is good
practice to include this with all data files that have multiple calculated fields. The list is not dynamic. If you
create additional fields after the list is created, you will need to delete the original list and create a new one.
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Figure 11.84 If there are multiple users for a spreadsheet, use the List Formulas tool to make sure all users are aware of the
calculated fields and solve order in a PivotTable. (Used with permission from Microsoft)

REAL-WORLD APPLICATION

Tracking Spending

PivotTables can be a powerful tool to manage finances in a business or for your personal retirement
planning. They allow you to compare data, as well as identify trends and patterns in the data. They are
especially useful when you have a large amount of data. PivotTables can summarize this data, as well as
provide interactive capabilities that allow you to adjust the different variables and investigate their
influence. For instance, perhaps you would like to investigate spending and determine different
considerations, such as how much is being spent, by whom, and on what. The same scenario can be applied
to your own personal budget. Consider how you can use a PivotTable to track your own spending:

• How might this process be adjusted for a small business?
• What are some other uses of PivotTables in small businesses that you can think of?

11.5 Data Analysis Charts

Learning Objectives
By the end of this section, you will be able to:

• Determine the most appropriate chart for a given dataset or analysis
• Create a chart template
• Use the Quick Analysis tool to add sparklines to a table

At some point in your career, you might need to present an analysis of data to an audience of peers or
management. Your information must appear clear and professional and will likely include graphs and charts of
your analysis. Recall that the theme and color choices of these elements can be critical to developing a
professional presentation that will effectively and clearly communicate your intended message (see Preparing
Presentations for a review of design strategies and tips).

You learned how to create graphs and charts in PivotTables. Some of those skills, such as using legends,
adding gridlines, editing axis titles and labels, and including chart titles, will make for a professional
presentation of the data. This section will discuss several types of charts and graphs and when they might be
appropriate to use based on your dataset.
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With data visuals, it is key that you select the type of chart or graph that works best for a particular dataset and
makes the information easy to understand. You cannot simply select a graph or a chart based on its
appearance. All types of graphs and charts are not appropriate for every dataset. As you decide which chart or
graph to use, consider the type and level of data that you have (Table 11.3). You should also consider what kind
of message you are trying to convey. Are you trying to inform, compare, show trends over time, or reveal
relationships? Your purpose can dictate what type of chart you will use.

Purpose Appropriate Charts/Graphs

Comparisons Bar chart, pie chart, stacked bar chart, clustered column chart

Changes Line graph, area chart, timeline

Relationships Scatter plot, histogram, combo column/line chart

Table 11.3 Usage of Graphs and Charts

LINK TO LEARNING

Selecting the right type of chart to represent your data is not always easy. How you present your data is
incredibly important. You need to always be mindful that you are accurately presenting your data visually in
a way that tells the story objectively, with no apparent bias or intention. Visit this link to read strategies for
choosing the correct chart (https://openstax.org/r/78ChooseChart) to visualize your data.

Clustered Column Chart
A clustered column chart is simply a column chart that includes multiple variables to show the comparison
between the groups. A column chart compares one variable against another variable. For example, you might
put the sales region on the horizontal axis and the total sales on the vertical axis. A clustered column would
have that, but it would include the same data for multiple years of data. The clustered column chart is great for
showing comparisons (Figure 11.85). Using the WorldCorp data, you can create a clustered column chart to see
the comparisons between the quantity sold for each product type over time. A drawback of the clustered
column chart is that it is not appropriate for large amounts of data. If you have more than five sets of data, the
chart can look too busy and overwhelm your audience. The clustered column chart also works better with a 2D
display rather than a 3D display. The 3D display can look too busy and can make it difficult to interpret the
information easily.

Figure 11.85 A clustered column chart can show data for multiple products at the same time.
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Combination Chart
A combination chart combines two different chart types in one visual, allowing you to display data at
different levels on the same chart. You can use combination charts to understand and examine comparisons
between groups and the relationship between different variables. With this example, a combination chart can
be created to show the FOB $ for each month based on the quantity sold for each of the two product types.
With the combination chart, you determine which chart is appropriate for each data series you are including.
Figure 11.86 uses a column chart for quantity sold and a line graph for FOB $. Combination charts are often
easier to interpret as 2D than as 3D. Consider using contrasting colors to make the plotted series more visible.

Figure 11.86 Combination charts can be used to show different types of data on the same chart.

Stacked Column Chart
The stacked column chart compares data like the clustered column chart but displays it in a different format. It
shows the relationship between groups using the same scales. Instead of the columns being next to each
other, the data is stacked, one series on top of the other, in a single column. A stacked column chart can be
used to show part-to-whole relationships. Using contrasting colors will help make the distinction between the
groups more visible. Using one of the 3D options for displaying a stacked column chart can give it a
professional appearance that is easy to interpret (Figure 11.87). This stacked column chart shows WorldCorp’s
sales agents’ FOB $ during a three-week period.
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Figure 11.87 A stacked column chart is a different way to display multiple series of data.

Bar Chart
A bar chart is a horizontal column chart. It is sometimes used to communicate complex datasets and can be
easier to interpret in certain situations. Bar charts are effective for displaying negative and positive numbers
together. They also work well for charts with long text labels along the y-axis because the labels are more
readable when placed horizontally (Figure 11.88). You can create clustered and stacked bar charts to display
multiple series in a single chart. Use a simple layout and contrasting colors for the most professional look. Like
a clustered column chart, bar charts work best with smaller datasets. Too many bars on the chart can make it
unreadable. Use a bar chart when you have ten or fewer categories to display. You can use WorldCorp data to
construct a bar chart of the volume sold for four different sizes of televisions.
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Figure 11.88 Bar charts can be good for displaying complex sets of data. (Used with permission from Microsoft)

Line Chart
A line chart is used to show changes over time. It is appropriate for trend analysis and graphing continuous
datasets. Line charts are not appropriate for categorical data. Be careful of the scaling of the axis so as to not
overemphasize or deemphasize the trend in either the vertical or horizontal directions. Keep the chart to four
lines or fewer for the most effective presentation of the material, and use thicker, solid lines rather than thin
lines or dotted/dashed lines. Be sure to include a legend if you are plotting more than one series of data
(Figure 11.89). Also consider including data markers on the lines to make interpretation clearer. The 3D line
chart is difficult to interpret even with a single line; the 2D line chart presents data more clearly. You can
examine the changes in sales for Home Stereo Systems at WorldCorp for the month of March with a line chart.
Adding gridlines or data labels can help your audience quickly see values at certain points in time.
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Figure 11.89 A line chart can be used to show changes over time.

REAL-WORLD APPLICATION

Misleading Graphs

Earlier, you learned the importance of accurately representing data in a chart to prevent misinterpretation
of the information. When you are presenting charts and graphs as opposed to the actual data, special care
should be taken to make sure the data representation is valid. By adjusting the scaling on either axis, you
can drastically change the interpretation of the information presented in a chart. Take a look at this article
on how mistakes have been made in representing data (https://openstax.org/r/78MisleadGraphs) to learn
more. Now select one chart represented in the preceding link and re-create the chart so that it is not
misleading, and then answer the following questions:

• What was the major issue(s) with the selected chart?
• What are some of the incorrect conclusions drawn from the chart?
• What adjustments did you make? How does it more accurately reflect the information?

Scatter Chart
A scatter chart or scatter plot shows the relationship between two variables. It is often used as part of a
regression analysis, and it easily shows the direction of the slope of the line (Figure 11.90). A positive slope
indicates a positive correlation between the variables, and a negative slope indicates a negative correlation. A
positive slope is when the two variables move in the same direction. The chart of data will have a line that
moves from the lower-left to the upper-right corner. A negative slope means the variables move in opposite
directions. The chart of a negative slope will start in the upper-left corner and move down toward the lower-
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right corner of the chart. If the chart is relatively flat, meaning a near 0 slope, then there is little relationship
between the two variables. The scatter plot for FOB $ versus Quantity Sold show a slight positive (upward)
trend in the data.

Figure 11.90 A scatter chart is used in regression analysis.

A scatter chart can show if a relationship exists. It does not provide a quantitative measure of the relationship
between the two variables; it simply shows the estimated relationship. In a scatter plot, the data points are not
connected. Instead, it uses the data points only and then, if desired, you can add in a best fit regression line to
examine the information more closely (Figure 11.91). If the data points are clustered around the best fit
regression line, the relationship is strong. If the data points are scattered and show little to no discernible
pattern around the fitted regression line, the relationship is weak. When you add the trendline to the previous
scatter plot, you can see that the data points are not clustered around that trendline. Instead, they are quite
spread out. This is a visual indication that the variables (FOB $ and Quantity Sold) are not strongly connected
to each other.

814 11 • Advanced Excel Spreadsheets: Statistical and Data Analysis

Access for free at openstax.org



Figure 11.91 Adding a trendline gives a visual representation of the strength of the relationship between two variables.

Histogram
A histogram represents a single variable at various levels/ranges for that variable. With a histogram, a dataset
is condensed into categories for a quick analysis of the distribution of the data (Figure 11.92). It is the visual
representation of a histogram table. Histograms can represent discrete or continuous data, such as the
distribution of customers. They are used frequently for a quick assessment of a dataset and to visually convey
large datasets in an easy-to-understand format. They readily show outliers or gaps in information. The process
of creating histograms was covered in more detail in Histograms.

11.5 • Data Analysis Charts 815



Figure 11.92 A histogram is a visual representation of a histogram table.

Stock Chart
Stock charts are used to represent market data to show the highs and lows for stocks. They can also be used in
quality control to show the range of data on a certain day or shift for a production process. To create a stock
chart, you will need a date or time reference and the high values and low values for that date or time. The
horizontal axis will be the span of time and the vertical axis will be dollars, in the case of a stock market chart.
It could be another measure if you are using the stock chart for quality control purposes (Figure 11.93).
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Figure 11.93 A stock chart shows the changes in stock prices over time.

Chart Template
If you are creating the same type of chart on a regular basis, creating a chart template will save time. You can
save features, themes, colors, and formats as a template that you can use with other data files. To begin,
create the chart as you would normally create it. Add the desired customization to the chart. This could include
formatting the chart with company colors or including the company logo as a watermark in the chart. When
you are finished, right-click on the chart you just created and formatted (Figure 11.94). Choose Save As
Template. You will then be prompted to enter a name for the chart template you just created (Figure 11.95).
Consider a name for the template that will help identify the template’s use. Make sure the type is listed as
Chart Template Files. Input a name and click Save.
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Figure 11.94 If you use a chart format and design on a regular basis, it might be easier to save it as a template for future use. (Used
with permission from Microsoft)

Figure 11.95 Remember to give it a file name and that the Save as file type is a chart template file. (Used with permission from
Microsoft)
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To access the saved template, go to the Insert tab and choose Recommended Charts (Figure 11.96). Then,
select All Charts and Templates. The saved template should be listed, and you can select that template to apply
to the new dataset. Click on the template, then click OK, and Excel creates the chart based on your new
dataset.

Figure 11.96 Chart templates are found under All Charts, then choose Templates. (Used with permission from Microsoft)

Quick Analysis Tool
The Quick Analysis tool provides a shortcut to analyzing a dataset with a group of options located in one place
for ease of use. You can use these options to add formatting, to automatically insert totals and subtotals, or to
add sparklines to your Data Table. There are three ways to access the Quick Analysis tool. If you highlight the
Data Table you are interested in analyzing, the Quick Analysis tool icon will appear in the lower right of the
selection (Figure 11.97). You can also use Ctrl+Q or right-click on a cell inside the dataset and select Quick
Analysis from the menu that appears.

Figure 11.97 The Quick Analysis tool can be used to add sparklines to the Data Table. (Used with permission from Microsoft)

When you access the tool, a menu of options appears (Figure 11.98). Choose the appropriate tab and click on
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the option you want to use.

Figure 11.98 There are various formatting options in the Quick Analysis tool. (Used with permission from Microsoft)

Formatting
The Formatting options in the Quick Analysis tool will insert conditional formatting based on the criteria you
select. You can also access these options through the Home tab in the Styles command group. Select the drop-
down menu next to the Conditional Formatting button. Conditional Formatting provided more detail on using
conditional formatting for data. For formatting graphs and charts, there are a few options to choose from
under the Conditional Formatting menu, and you can stack the formatting options upon each other. For
example, you can choose to have both the Data Bars and Icon Set displayed in your table at the same time.
You can add data bars into the selected cells, and they will appear on top of the values and will be
appropriately sized for the data in that cell (Figure 11.99). You can format the bars through the Conditional
Formatting menu on the Home tab. To remove the data bars, click on Clear Format on the far right of the
Format tab in the Quick Analysis tools. You can also clear the formats by choosing the Clear Rules option in the
Conditional Format menu on the Home tab.

Figure 11.99 Data bars provide a visual representation of the magnitude of the data in a cell in relation to the other cells. (Used with
permission from Microsoft)

The Color Scale option adds colors to the cells based on the values relative to each other. There are several
different color scales you can choose. For example, one color scale uses blues to represent the higher values
and reds to represent the lower values in the dataset (Figure 11.100). Again, to remove the colors, click on
Clear Formats in the Quick Analysis tools or Clear Rules under Conditional Formatting.
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Figure 11.100 Color scales are colors added to the cells based on the values relative to each other. (Used with permission from
Microsoft)

Icon sets are a more visual way to see differences between the values in a dataset (Figure 11.101). The default
icon is an arrow that is either red, yellow, or green based on the value in the cell. The icon can be changed by
accessing the Conditional Formatting menu on the Home tab.

Figure 11.101 Adding an icon set is yet another way to visually examine the differences within a dataset. (Used with permission from
Microsoft)

The Greater Than option in the Quick Analysis tools will highlight data that is greater than the value you set
(Figure 11.102). You set this value in the input window, choose the color scheme for the highlighted cells that
meet the criteria, and then click OK. Using the default color scheme, the cells that are greater than the value
you set will be highlighted with a light red fill and a dark red text.

Figure 11.102 Using Greater Than, data that is outside the criteria you select is highlighted. (Used with permission from Microsoft)

The final option in the Formatting tab of the Quick Analysis tools is the Top 10% tool. This tool highlights the
values that are in the top 10 percent in the dataset. The default is to highlight those with light red fill and dark
red text. This can be changed as desired (Figure 11.103).
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Figure 11.103 The Top 10% tool is helpful to quickly see the top values in a dataset. (Used with permission from Microsoft)

Charts
The Quick Analysis tools give you the option to quickly insert a chart of the data (Figure 11.104) using the
Charts tab. The chart will be inserted directly on the worksheet using the default color schemes. After you have
created the chart, you can choose to customize it to meet your needs using the skills you have already learned.
You can access charts not listed specifically by clicking on More Charts.

Figure 11.104 The Quick Analysis tool allows you to easily access several charting options. (Used with permission from Microsoft)

Totals
The Totals tab in the Quick Analysis tool gives you several options for summarizing your dataset. You can
access the same options through the Formulas tab, but the process is much simpler through the Quick
Analysis tool (Figure 11.105a). You can include the total of data (sum), average, count, percent of total, and
running total. These options are available for both columns and rows. To access the additional formulas, click
on the small arrow to the right of the window. With any of the options, the result of the formula will be
included in your Data Table as another row or column (Figure 11.105b).
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Figure 11.105 The Quick Analysis tool tab gives several ways to summarize the dataset. (a) The Totals tab has many options; more
tools are available if you click on the arrow. (b) Adding the sum of a column inserts a new row with the total. (Used with permission
from Microsoft)

Sparklines
One way to show trends in your data is to use a sparkline, a small chart inserted into a cell next to your data
that shows changes over time. There are three options in the Sparklines tab: Line, Column, and Win/Loss
(Figure 11.106). These can also be accessed through the Insert menu in the Sparklines command group.

Figure 11.106 Sparklines are another option to add visual interest to your Data Table. (Used with permission from Microsoft)

By default, sparklines are inserted at the end of each row. Once the sparkline is inserted, you have access to
the Sparkline formatting tab. Here, you can format the sparkline’s style, change the input data, or change the
type of sparkline. You can also add markers to the sparkline to show the highest and lowest points. In Figure
11.107, the Line sparkline was inserted. With just a quick glance, you can see that Antonio had the most sales
in week two but did not do as well in week three, whereas Izabelle and James improved consistently.
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Figure 11.107 There are several design options for Sparklines. (Used with permission from Microsoft)

LINK TO LEARNING

Marimekko charts are a way to visually examine market share. They are used often in consulting and
finance companies. You can also include different segments within an industry. Read this article to find out
more about this special type of chart and how to create it (https://openstax.org/r/78Marimekko) in Excel.
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Chapter Review
Key Terms
bar chart horizontal column chart
benchmarking tool that checks the validity of your data with similar datasets or a set standard
Calculated Field tool that allows addition of columns of calculations to a PivotTable
categorical data data that is grouped into categories based on attributes or characteristics
clustered column chart column chart that includes multiple variables to show the comparison between the

groups
combination chart chart that combines two different chart types in one visual
continuous data information that is measured and can take on an infinite set of values
Correlation used to analyze the relationship between two variables
data validation process of ensuring that data values fall within a predetermined range
data verification process used to ensure that your data is accurate and reliable
discrete data information that can only take on a specific set of values
histogram chart that displays the number of occurrences of data within a defined range
line chart chart used to show changes over time
numerical data data that is quantitative and represents measures of the variables
qualitative data categorical information that does not include numbers; if it does include numbers, they do

not have a true mathematical meaning
quantitative data data that involves numerical evaluations
scatter chart chart used to show the relationship between two variables
slicer visual, interactive way to filter data in a PivotTable
sparkline small charts inserted into cells next to data that show changes over time
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Summary
11.1 Understanding Data, Data Validation, and Data Tables

• Data can be qualitative or quantitative.
• There are four levels of measurement for data.
• Data verification and the Data Validation tool can ensure the quality of data in your spreadsheets.
• Excel Data Tables can be used to quickly format information in a professional manner.
• Data Tables can be used to filter and better understand the information contained in a spreadsheet.

11.2 Statistical Functions
• Data analysis is critical for any business to be successful.
• Excel’s built-in statistical functions, such as SUM, AVERAGE, MODE, RANGE, and MEDIAN, provide basic

information about a dataset.
• The Analysis ToolPak add-in provides a collection of statistical tools for data analysis such as regression

and ANOVA.
• Descriptive Statistics is a quick way to summarize a dataset by giving you values such as the average, the

range, and the maximum number.
• Regression is used for forecasting and budgeting.
• The Solver add-in is used to find optimal solutions given a set of predetermined constraints.

11.3 What-If Analysis
• Scenario Manager and Goal Seek are part of the What-If Analysis tool group.
• The Scenario Manager is a tool that allows you to investigate the impact of various changes to input cells

on target cells.
• The Scenario Manager can give you a summary of all scenarios to help with decision making.
• Goal Seek is used when you have a single input variable.
• Goal Seek is used to set a target value for a cell by changing the values in another cell.

11.4 PivotTables/Charts
• The PivotTable Analyze tab offers tools to make data analysis and filtering easier.
• Timelines can be inserted to filter the PivotTable data by date.
• Slicers can be used in PivotTables and Data Tables to filter data with visual buttons.
• Calculated fields can be added to PivotTables for additional analysis using formulas.
• The List Formulas tool creates a separate worksheet that includes all formulas used in the PivotTable. It is

a valuable tool when there are multiple users of a single workbook.

11.5 Data Analysis Charts
• There are many types of charts to visually present your data.
• Some options for charts or graphs include bar charts, pie charts, column charts, line graphs, and scatter

plots.
• A column chart can be used to show comparisons between groups.
• A line chart is useful to show changes over time.
• Scatter plots visually show the relationship between two variables and are often used with regression.
• Chart templates can be created for chart formats you use frequently such as those with company colors or

logos.
• The Quick Analysis tool gives you access to several options such as conditional formatting, adding totals to

the rows or columns, or quick links to creating a chart of the data.
• Sparklines added to your Data Table can be used to quickly assess trends.
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Review Questions
1. The distance from your home to the grocery store is an example of:

a. discrete data
b. qualitative data
c. continuous data
d. ordinal data

2. The Data Validation tool is found on which tab?
a. Home
b. Data
c. Insert
d. Review

3. Which level of measurement is appropriate for an opinion question with responses such as Disagree,
Agree, or Neutral?
a. nominal
b. ratio
c. interval
d. ordinal

4. You would find the tool to format a selection as a table on which tab?
a. Home
b. Data
c. Insert
d. Page Layout

5. ______ is used to summarize data into certain ranges that you define in table format.
a. Regression
b. Descriptive Statistics
c. Correlation
d. A histogram

6. The _____ function returns the mean of a dataset with multiple criteria.
a. SUMIFS
b. AVERAGEIFS
c. TRIM
d. COUNT

7. Descriptive Statistics is found under which add-in?
a. Data Analysis
b. Solver
c. ANOVA
d. Data tab

8. Which test do you use when you have two groups of normal data to investigate statistical differences?
a. Regression
b. t-Test: Two Sample Assuming Unequal Variances
c. z-Test: Two Sample for Means
d. ANOVA
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9. The Text to Columns tool is the opposite of the ________ function.
a. CONCATENATE
b. CORRELATION
c. TRIM
d. Solver

10. Which Excel tool can help you find an optimal solution when you have several variables?
a. ANOVA
b. Data Analysis
c. Solver
d. z-Test

11. Where is the Scenario Manager found?
a. Home tab > Analyze Data
b. Review tab
c. What-If Analysis tools
d. Formulas tab > Insert Function

12. Which tool is used to find a solution when changing a single variable?
a. Goal Seek
b. What-If Analysis
c. Scenario Manager
d. Solver

13. Choosing ________ creates a separate table of the results of the scenarios you created in Scenario Manager.
a. Goal Seek
b. Show
c. Edit
d. Summary

14. What-If Analysis tools are accessed from which tab?
a. Insert
b. Data
c. Home
d. Formulas

15. Calculated fields in a PivotTable are inserted from which tab?
a. Slicer
b. Formulas
c. PivotTable Analyze
d. Data

16. _______ are a more visual way to filter information in a PivotTable.
a. Slicers
b. Calculated fields
c. Timelines
d. Formulas

17. How do you remove a timeline in a PivotTable?
a. Click out of the PivotTable.
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b. Choose a different year.
c. Right-click on the timeline scroll bar.
d. Use the Timeline tab.

18. Which chart is best to show trends over time?
a. column
b. bar
c. line
d. scatter

19. Small line charts inserted into worksheet cells are called _____.
a. Slicers
b. Sparklines
c. Icon sets
d. Data bars

20. Where do you find saved chart templates?
a. Home tab
b. Quick Access tool
c. Recommended Charts
d. Conditional formatting

Practice Exercises
21. Go to the World Bank Data Catalog (https://openstax.org/r/78WorldBank) and find a dataset or topic that

interests you, then download the Excel file. Format the data as a Data Table. Filter the data using one of
the criteria. Change the Table Style. What information can be gleaned from the Data Table?

22. Using the data in the "mgmt_jobs" tab of the downloadable Chapter 11 data file (https://openstax.org/r/
78Ch11DataFile), create a Data Table. Filter the data to find those rows that use the word “manager” and
have median earnings greater than $50,000 per year.

23. Create a two-variable Data Table for profit for a product with a unit price of $25 and a cost per unit of $18.
Investigate various levels of both the number of units sold and the price per unit.

24. Go to Kaggle to find a dataset (https://openstax.org/r/78KaggleData) that interests you. (Note: You may
need to create an account.) Download the Excel file. Create the Correlation matrix for the dataset. You may
need to adjust the data if nominal or ordinal data is included in the file. (Hint: Code the data using
numbers.)

25. Using a dataset from Kaggle (https://openstax.org/r/78KaggleData), get the Descriptive Statistics for the
information.

26. Using a dataset from Kaggle (https://openstax.org/r/78KaggleData), create a histogram with a chart for
one of the key variables.

27. Using a dataset from Kaggle (https://openstax.org/r/78KaggleData), use the Analyze Data tool to discover
some additional ways to analyze the information.

28. Use Goal Seek to determine what grade you will need on a final exam in a class to get the grade you
desire. You can use your grades from a class in which you are currently enrolled. You will need to know
from the syllabus how your final grade is calculated.

29. Use the Scenario Manager to look at the different financing options for buying a car that you are
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interested in purchasing. Look at scenarios such as a lower interest rate or a shorter loan term. Create the
summary table of the scenarios.

30. Using the data in the "grads" tab of the downloadable Chapter 11 data file (https://openstax.org/r/
78Ch11DataFile), create a PivotTable of the information. Insert a slicer to filter the data by type of
institution. Insert a calculated field to find the average number of independent and public institutions.

31. Go to Google Trends and choose a topic (https://openstax.org/r/78GoogleTrends) that interests you.
Download a dataset and create a chart appropriate for the data.

32. Go to the Contextures website (https://openstax.org/r/78Contextures) and scroll down to the Sample Data
Files options. Download the office supply data file. Use the same dataset, use the Quick Analysis tool to
add conditional formatting or sparklines to the Data Table.

33. Go to Google Trends and choose another topic (https://openstax.org/r/78GoogleTrends) that interests
you. Download a dataset and create a chart appropriate for the data. Then, save that chart as a chart
template.

Written Questions
34. What is the difference between data verification and data validation?

35. Discuss the differences between discrete and continuous data.

36. What are some advantages of using the Excel Data Table tool?

37. List and briefly describe the four levels of measurement.

38. Imagine you work in the human resources department of a regional hospital. You would like to survey
employees about their satisfaction with their job. Develop two survey questions that are categorical.
Develop two questions that are numerical. How might this data be analyzed in Excel?

39. What Excel tool would you use if you wanted to get an overall summary of a dataset?

40. How can regression be used in business?

41. Describe a few of the functions useful for dealing with data imported into a spreadsheet.

42. Describe the difference between the three types of t-Tests in Excel.

43. How do you get the Solver add-in?

44. Imagine you are an entrepreneur and are interested in starting a coffee shop in your hometown. How
might you envision Excel being useful for you as you research whether the coffee shop is a good idea for
the city?

45. How does Goal Seek differ from Solver?

46. Discuss a few examples where Scenario Manager might be used.

47. When would you use the List Formulas tool?

48. Describe how to insert a slicer into a PivotTable.

49. How do you access the Quick Analysis tool?

50. How are the clustered column chart and the histogram different?

51. How do you create a chart template?

Case Exercises
52. Using the idea of starting a coffee shop (or another business idea you might have) in your hometown, find
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and summarize information from the U.S. Census Bureau (https://openstax.org/r/78CensComSurv) that
will help you gather information about the market for your business. Consider selecting a few
surrounding counties and analyzing variables such as age, diversity, income, and education.

53. Go to the Contextures website (https://openstax.org/r/78Contextures) and scroll down to the Sample Data
Files options. Download the office supply data file. Create a chart of the total sales by region. Then, create
a chart of units sold by item. What trends do you notice?

54. Using the same dataset, use the Quick Analysis tool to add totals and data bars to the Data Table.
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Figure 12.1 Something as simple as buying a cup of coffee involves numerous financial calculations. The point-of-sale system uses

standard calculations to determine tax on the purchase and change due for a cash payment. (credit: modification of "A Woman

Receiving Money from the Customer" by RDNE Stock project/Pexels, CC0)

Chapter Outline
12.1 Basic Accounting
12.2 Financial Functions in Microsoft Excel
12.3 Integrating Microsoft Excel and Accounting Programs

Chapter Scenario
WorldCorp has grown into a large, global corporation, requiring sophisticated and complex accounting. This
also means that the company’s overall finances must be handled by comprehensive accounting software.
However, within WorldCorp, many departments need to understand and analyze information from the
accounting software at the department, unit, or project levels, which they can do using Microsoft Excel
spreadsheets. Excel can be useful for calculating potential expenses for a new project or initiative and for
projecting revenue for various scenarios.

Having a sound understanding of the basics of accounting is a valuable asset for many workers, even if they
are not directly or formally involved in the company’s accounting processes. Being familiar with the basic
concepts and terminology of accounting can help you understand financial decisions. This includes knowing
common financial accounting formulas, relating expenses and revenue, being familiar with financial
statements, and understanding which software applications are used for different levels of accounting. As
another benefit, learning accounting principles can provide a valuable framework for understanding and
managing personal finances.

Using Excel in Accounting and Financial Reporting
12



12.1 Basic Accounting

Learning Objectives
By the end of this section, you will be able to:

• Define accounting
• Distinguish between financial and managerial accounting
• Understand how accounting information is created and used by internal and external stakeholders

of a business

Financial accounting information is mostly historical in nature—that is, accountants prepare financial reports
that summarize what has already occurred in an organization. A business can use this financial accounting
information as a predictive tool, but with limitations. Business involves a large amount of uncertainty, and
accountants cannot predict how the organization will perform in the future. However, by observing historical
financial information, users of the information can detect patterns or trends that may be useful for estimating
the company’s future financial performance. Collecting and analyzing a series of historical financial data can
provide important information to both internal and external users. Microsoft Excel is a useful tool for this
purpose.

What Is Accounting?
The process of organizing, analyzing, and communicating financial information that is used for decision
making is accounting. Financial information is typically prepared by accountants—those trained in the specific
techniques and practices of the profession. However, a solid understanding of how financial information is
prepared and used can serve as a useful resource for many people in their workplace.

A traditional adage states that “accounting is the language of business.” While that is true, you can also say
that “accounting is the language of life” because, at some point, most people will make a decision that relies on
accounting information. For example, you may have to decide whether it is better to lease or buy a vehicle.
Likewise, a college graduate may have to decide whether it is better to take a higher-paying job in a big city
with a high cost of living or a job in a smaller community where both the pay and cost of living may be lower.

In a professional setting like WorldCorp, an executive may want to know if the most recent product release was
profitable. Similarly, a department head may want to know whether it is worthwhile to pay an employee to be
“on call” for emergencies during off-hours and weekends. Whether personal or professional, accounting
information plays a vital role in decisions like these.

SPOTLIGHT ON ETHICS

Financial Regulations

Individuals performing financial services such as accounting must ascribe to a set of rules and regulations
prescribed by the government and other financial regulatory agencies. Various laws and regulations are
passed on a regular basis, and it is important for accountants and other money handlers to keep up with
changes and ensure they are compliant. Additionally, accountants must also ascribe to a strict set of ethical
guidelines, such as ensuring confidentiality and completing a certain number of hours in professional
development every year. Companies that fail to comply with these various rules and guidelines are at risk of
heavy penalties, and even incarceration. Notable high-profile cases have contributed to the need for these
rules, including Enron and Bernie Madoff. The Enron scandal, wherein Enron was found guilty of a number
of fraudulent and otherwise questionable business and accounting practices leading to their demise in
2001, led to the Sarbanes-Oxley Act, which ushered in reforms in a number of business financial practices.
Bernie Madoff, once the chair of NASDAQ, was sentenced to jail for running the biggest Ponzi scheme in the
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history of the United States, stealing over $64 billion from unsuspecting individuals, including several
celebrities. His arrest led to a number of reforms put in place to protect individuals from fraud. Hence, it is
the responsibility of those holding these positions to remain current and uphold the strictest of ethical and
just business and accounting practices.

Financial and Managerial Accounting
Accounting is divided into two main areas: financial and managerial. In essence, financial accounting
measures the financial performance of an organization using standard conventions to prepare and distribute
financial reports. Financial accounting is used to generate information for stakeholders outside of an
organization, such as investors, loan officers, and governmental entities, such as the Internal Revenue Service
(IRS).

Financial accounting is also a foundation for understanding managerial accounting, which uses both
financial and nonfinancial information as a basis for making decisions within an organization. The purpose is
to equip decision makers with the information they need to set and evaluate business goals and to make other
decisions for the business. Managerial accounting information tends to be used internally. Internal users
include managers and other employees who use financial information to confirm past results and help make
adjustments for future activities for such purposes as budgeting, pricing, and determining production costs.

Understanding financial and managerial accounting is valuable across a business. Management of
WorldCorp’s LCD screen manufacturing division, for example, would use both financial and managerial
accounting information to help improve the business. Managers in the screen manufacturing division may
want to know how much scrap is generated from a particular step in the manufacturing process. While
identifying and improving the manufacturing process (i.e., reducing scrap) helps the company financially, it
may also help other areas of the production process that are indirectly related, such as quality control and
shipping efficiencies.

External users also use the historical pattern of an organization’s financial performance as a predictive tool.
For example, when deciding whether to loan money to an organization, a bank may require a certain number
of years of financial statements and other financial information from the organization. An Excel spreadsheet
can be used to analyze this data in greater detail. The bank will assess the historical performance in order to
make an informed decision about the organization’s ability to repay the loan and interest (the cost of
borrowing money). Similarly, a potential investor may look at a business’s past financial performance in order
to assess whether or not to invest money in the company. In this scenario, the investor wants to know if the
organization will provide a sufficient and consistent return on the investment.

How Accounting Information Is Created and Used
Organizations measure financial performance in monetary terms. In the United States, the dollar is used as
the standard measurement basis. Measuring financial performance in monetary terms allows managers to
compare the organization’s performance to previous periods, to expectations, and to other organizations or
industry standards. Accounting information is created by an accounting system and can be downloaded into
Excel for further analysis.

Several financial calculations are standardized and used to make many business decisions such as forecasting
sales or establishing sales goals. These include functions such as calculating interest rates, payments due, and
asset depreciation, which is when something the company owns loses value over time because of the wear
and tear of regular use. Financial Functions in Microsoft Excel will cover the most common financial equations
used in Excel.

A company’s financial information is generally gathered and kept in standard bookkeeping software rather
than in Excel. The larger-scale financial data that is captured through the software helps to determine a
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company’s current financial status and predict future financial health. That type of financial information is
primarily communicated through financial statements. These financial statements ensure the information is
consistent from one time period to another and generally comparable between organizations. Details about
the statements are beyond the scope of this text, but you can find more information in a standard accounting
textbook. The information contained in the statements can be downloaded into Excel for further examination
and analysis.

REAL-WORLD APPLICATION

Your Personal Accounting Equation

The accounting equation is a basic principle used in accounting that states that a company’s assets (what
they own and the predicted value of the manufacturing, sales, or service they provide) are equal to its
liabilities (debt) and equity (net worth of the company):

Assets = Liabilities + Equity

This concept is not just for business. It can be used to understand your personal finances as well. Try this
exercise.

On a sheet of paper, use three columns to create your own accounting equation. In the first column, list all
of the things you own (assets). In the second column, list any amounts owed (liabilities) for each asset. In
the third column, using the accounting equation, calculate the net amount of the asset (equity) by
subtracting the liability from the value of the asset. When you’ve finished with each asset, total the columns
to determine your net worth. You can also do the calculations without determining the equity of each asset.
To do this, you only need two columns, one for assets and one for liabilities. Add up each column and then
subtract the sum of all of your liabilities from the sum of all of your assets. This gives you your total equity.

Here is something else to consider: Is it possible to have negative equity? It sure is . . . ask any college
student who has taken out loans. At first glance, there is no asset directly associated with the amount of the
loan. But is that, in fact, the case? You might ask yourself why make an investment in a college
education—what is the benefit (asset) of going to college? The answer lies in the difference in lifetime
earnings with a college degree versus without a college degree. This is influenced by many things, including
the supply and demand of jobs and employees. It is also influenced by the earnings for the type of college
degree pursued. (Where do you think accounting ranks?)

Accountants often use computerized accounting systems to record and summarize the financial reports, which
offer many benefits. The primary benefit of a computerized accounting system is the efficiency by which
transactions can be recorded and summarized, and financial reports prepared. In addition, computerized
accounting systems store data, which allows organizations to easily extract historical financial information to
import into Excel for further analysis or sharing with other stakeholders.

Common computerized accounting systems include QuickBooks, which is designed for small organizations,
and SAP (Systems, Applications, and Products) enterprise resource planning software, which is designed for
large and/or multinational organizations. QuickBooks is popular with smaller, less complex entities, and you
will learn more about it in Integrating Microsoft Excel and Accounting Programs. It is less expensive than more
sophisticated software packages, such as Oracle or SAP, and incorporates many user-friendly features that can
reduce both training time and costs spent on acclimating new employees to an employer’s software system.
While QuickBooks has many advantages, once a company’s operations reach a certain level of
complexity—such as with the global corporation WorldCorp—it will need a more robust software package or
platform, such as Oracle or SAP, which is then customized to meet the unique informational needs of the
entity. Some advanced capabilities include automation of invoicing and receiving payments, payroll services,
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and tracking and paying sales taxes.

12.2 Financial Functions in Microsoft Excel

Learning Objectives
By the end of this section, you will be able to:

• Describe the use of financial functions
• Use common financial functions in Excel

WorldCorp and all other corporations all over the world use financial equations to manage their businesses.
These equations can help business leaders understand the impact of taking out a loan to purchase equipment,
the value of a particular financial investment, and other related decisions. Microsoft Excel has programmed
many of the more common financial equations as functions so that you do not need to type a formula.
Instead, you use the name of the function and the variables. This means that if you want to calculate the
investment of a stock or bond, you may need to have three of the five financial variables in the time value of
money theory. Similar to a financial calculator, you can use FV, PV, PMT, N, or I to figure out if an investment is
worthwhile. You have already been briefly introduced to some of these functions in The Advantages of a Data
Table.

In this section, you will learn how to use financial functions in Excel in the context of the time value of money
theory and depreciation. These are common accounting principles that will be briefly discussed. More
information on these concepts can be found in a standard accounting textbook.

REAL-WORLD APPLICATION

Add-ins

Excel comes with standard financial functions; however, many users are able to “add-in” other functions and
utilities. Of course, the common user will find the preexisting functions more than sufficient for most of
their needs; however, if you have any financial responsibilities at an organization, you may find a need for
these additional functions or features to help speed up your work. You can find preset add-ins on the Insert
tab under either My Add-ins for existing ones that you may have installed already or Get Add-ins for others
available through Office or from other companies. You will find an interesting list of choices when searching
for add-ins, such as data analytics, productivity, and financial connector. Under Financial Connector, some of
the add-ins available include a stock connector, as well as additional financial analysis and financial analytics
tools. These can serve as powerful features to further automate and keep current financial information you
are using to populate your sheets.

Applications of Financial Functions
Financial functions are used for calculating a diverse set of common key performance indicators in a business,
or for predicting the value of money through time. The time value of money theory states that money loses
value as time passes. It is a simple concept that is ingrained in every business decision because it is important
for a business to use financial instruments and investments to increase the value of their savings or idle cash.
One way you can see this theory in practice is in the steady increase in the sales prices of goods over time.

Common Financial Functions in Practice
You were introduced to the Excel function PMT in The Advantages of a Data Table for determining the monthly
(or yearly, daily, or quarterly) payment of an investment or loan. There are other important variables involved
in the financial functions related to the time value of money theory, which can help a business determine
profitability. This section will focus on an annual payment rather than a monthly payment. But keep in mind,
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many loans require monthly payments and the variables in the function will need to be adjusted accordingly.

There are five main time value of money variables (PMT, RATE, NPER, PV, and FV) used in these calculations.
Table 12.1 lists these variables and what they represent in Excel. To find the answer to a time value of money
problem, you must have the values of at least three of the five variables. There is an additional variable that
you need to consider and that is “Type.” In the functions, “Type” represents when payments are made. If they
are made at the beginning of the term, use 1 in the function. If you do not enter anything, Excel will use the
default of “0,” meaning payments are made at the end of the term. The timing of the payments impacts the
amount of interest paid.

One way to calculate any of these time value of money variables is to use a financial calculator, which works
like a regular calculator, except that it has certain financial functions programmed into it. A financial calculator
has a button associated with each of the time value of money variables. Excel also has these functions
programmed into it.

Variable Definition

PMT The payment of an investment or loan per period (usually monthly)

RATE The interest rate on an investment, loan, or bond yield

NPER The number of periods in a calculation (usually years, quarters, or months)

PV The initial investment of a business or security purchase

FV The monetary value of a business or security investment at the end of all periods

Type
Whether payments are made at the beginning of the term or at the end of the term; the default
is “0” or at the end of the term

Table 12.1 Time Value of Money Variables

PMT
To calculate PMT, you need at least three of the other variables. For this example, assume that WorldCorp is
building a new manufacturing plant, at a cost of $4,743,542. To finance the investment, they will borrow the
money from a bank, rather than use their savings. The bank terms are 5.6 percent for a twelve-year loan. You
will use these variables to find the amount WorldCorp will pay each year for a loan. You know the loan term
(NPER, which is the number of periods for the loan), the interest rate (RATE), and the original amount of the
loan (PV). You do not know the future value (FV) or the yearly payment installment (PMT).

Excel performs these time value of money calculations using functions and the values of the known variables.
First, construct a table that lists the five variables and the values you have. You can then use the Excel function
to calculate PMT (Figure 12.2). Recall that this function can be found on the Formulas tab under Financial in the
Function Library command group. You enter all of the values into the dialog box or in the Formula Bar using
the cell references. Figure 12.2 shows the PMT function using the variables and the cell references.
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Figure 12.2 If you do not know the installment, but you know the periods, the interest, and the principal, you can calculate the
installment. Excel will use the default of “0” for type. You do not need to enter anything for FV. (Used with permission from Microsoft)

Figure 12.3a shows the yearly installment WorldCorp will have to pay on this loan. As was noted in The
Advantages of a Data Table, Excel gives the PMT answer as a negative number by default. You can change this
by putting a “-” sign in front of the PV cell reference or after the “=” in the formula in the Formula Bar (Figure
12.3b).

Figure 12.3 (a) Notice the final answer is negative (as indicated by “()” and red font. (b) The “-” in front of D3 changes the installment
payment to a positive number. (Used with permission from Microsoft)
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MAC TIP

In the Mac version of Excel, using the functions for all of the time value of money variables does not open a
dialog box, as it does in the Windows version. Instead, you must enter the values between the parentheses
in the Formula Bar.

RATE
The RATE function works in the same way as the PMT function. Again, you can find the RATE function in the
financial functions library. For this example, WorldCorp wants to open another manufacturing plant for
making headphones. The cost of the site and the machinery is $3,843,974, but they will use a down payment of
$450,000. The loan they would need then would be $3,393,974 (total cost − $450,000). The bank loan will be
over twelve years, with yearly payments of $427,308.08. You need to determine the interest rate. Figure 12.4
shows the table of variables, but this time the interest rate is missing. You can then use the RATE function to
determine the interest rate (Figure 12.5).

Figure 12.4 You can find the interest rate if you have the loan term, the loan amount, and the payment. Recall that you need at least
three of the variables and be sure to enter a “-” in front of the PMT. (Used with permission from Microsoft)
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Figure 12.5 The function returns the interest rate based on the other variable values. (Used with permission from Microsoft)

NPER
You can use the NPER function in Excel in the same way as the other time value of money functions to
determine the amount of time required to repay the loan. For this example, WorldCorp has decided to change
the look of their retail stores. They asked you, a financial analyst, to find the best bank loan terms—the one
that costs the company the least amount in total payment. The average cost of each store renovation is
$64,757. Bank X offers an interest rate of 5.45 percent and Bank Y offers an interest rate of 6.55 percent. Bank
Y is your current bank, and you have a great working relationship with the employees. You want to keep
banking there, but want to understand the long-term impact of the higher interest rate for this loan. You have
budgeted $1,500 each month toward the loan for an annual payment of $18,000 ($1,500 × 12 months). You can
use those values in the NPER function Figure 12.6 to determine the repayment time period for each loan
Figure 12.7, which you can then use to determine the total payment of the loan. You would multiply the PMT
by the NPER you just found.
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Figure 12.6 Bank X and Bank Y offer different interest rates. Use the NPER function to find the number of payment periods for Bank
X. (Used with permission from Microsoft)

Figure 12.7 Repeat the NPER function for Bank Y. (Used with permission from Microsoft)
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The difference between the two options might not seem that significant: 4.11 years compared with 4.24 years.
However, when you take that number and multiply it by the yearly installment, you can see the overall
difference between the two loans. For Bank X, you will pay a total of $74,027.02 (= 4.11 × $1,800) and using the
same process for Bank Y, the total cost is $76,239.91. It would save you more than $2,000 by going with Bank
X. You will need to decide if that is enough savings to take the business away from your current bank. This
example shows you that sometimes decisions are not always based on the numbers. Sometimes nonfinancial
aspects must be considered when making decisions such as this.

MAC TIP

The Mac version requires the periods to be in months.

PV
Excel’s PV function allows you to calculate the principal of a loan. Suppose you are WorldCorp’s new financial
analyst, and your supervisor asked you to track down all of the company’s outstanding bank loans and their
original principals. The first loan you find has a monthly payment of $8,673.38, a period of eight years and an
annual interest rate of 6.55 percent. As with other examples, the first step is to set up your table of
information. However, the table you have been using has the term set up in years, but the term of this loan is
in months. You will need to multiply 8 years by 12 months to get NPER, and you will need to divide your annual
interest (RATE) by 12 months (Figure 12.8) to get the monthly interest. Now that you have converted all of your
figures to months, you can use the PV function from Excel to get the original principal of $646,743.00 (Figure
12.9).
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Figure 12.8 The financial functions in Excel are based on yearly information. The Excel function PV calculates the principal of a loan,
but you need to convert yearly information to monthly information. (Used with permission from Microsoft)

Figure 12.9 PV gives you the principal amount of the loan based on the interest rate and repayment period. (Used with permission
from Microsoft)

LINK TO LEARNING

An amortization schedule is a summary table of all the principal and interest payments made on a loan.
This helps the borrower understand the impact of the interest rate and the timeline to pay back a loan such
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as one for a car or a home. Excel is a great tool for constructing such a table. Read this Ablebits tutorial
about creating a loan amortization schedule in Excel (https://openstax.org/r/78Amortization) to learn more
about how to create a loan payment schedule.

FV
The final time value of money function you will use is for the future value, which the previous examples have
not used. For this example, you will analyze a stock investment. As a financial analyst at WorldCorp, you need
to assess the value of investments in a savings account to determine whether it would be better for WorldCorp
to use this cash for buying stock of other companies to get a greater return. The stocks they are considering
will increase in market value in the future, so you will need to calculate the amount WorldCorp will gain when
they sell it. They have $5,456,254.00 in their savings account now. They are considering investing that savings
in other company stocks that increase in value on average 6.57 percent per year, and they would plan to hold
on to the stock for nine years. You would use the FV function, as shown in Figure 12.10 to determine this value.
You can then compare that with what they would get if they just keep the funds in the savings account during
that nine-year time period (Figure 12.11).

Figure 12.10 In this example, there is no annual payment you are making. Calculating the future value uses the FV function and
three of the other four time value of money variables. Excel assumes PMT is “0” if no value is entered. (Used with permission from
Microsoft)
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Figure 12.11 Again, like the other functions, the result will be negative if you do not add the “-” before the investment amount. (Used
with permission from Microsoft)

Depreciation
Depreciation is not one of the five variables used in time value of money theory, but it is an important function
used in accounting. The steady decrease in value of an asset, such as a piece of equipment, over time is called
depreciation. The IRS lets businesses calculate depreciation as an expenditure, which in turn reduces the total
amount they are taxed each year. There are several different depreciation functions in Excel, but this section
will focus on the DB (declining balance) function. This is one of the most used methods of depreciation in
accounting. With this function, you are essentially reducing the total value of the asset over a period of time.

The formula for depreciation takes into account the original price, the current market value of the item (or the
salvage value), the years of use (or useful life), and the period. The years of use is the average lifespan of the
machine. The period is the time that has passed since the purchase. The other variable in the function is
Month. This can be used if the machine was purchased in the middle of the year. Excel will assume a normal
twelve-month year for the first year if you leave this value blank. The number you enter here is the number of
months the business owned the asset during a partial year. For this example, you will use the values in Figure
12.12, which shows the DB function. Figure 12.13 shows the depreciation of the asset. As shown, during period
2, the machine is $18,627.12 less than its original value, meaning that in year 2 the machine is worth
$61,372.88 (or $80,000 − $18,627.12).
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Figure 12.12 The salvage value is the worth of the asset if you were to sell it. The DB function calculates depreciation, which can
reduce a company’s taxes. (Used with permission from Microsoft)

Figure 12.13 The resulting value is the annual depreciation of the asset to be deducted as an expense. (Used with permission from
Microsoft)

SPOTLIGHT ON ETHICS

Procedures and Reporting Standards

Financial accounting follows a set of standardized rules. All publicly traded corporations use Generally
Accepted Accounting Procedures (GAAP) or International Financial Reporting Standards (IFRS) standards.
There are options within GAAP that let the company report some accounts differently. For example,
inventory can be valued as first in, first out (FIFO) or last in, first out (LIFO). It is important for a company to
disclose all these optional changes to the GAAP in the financial statement notes, and in the annual report.
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For example, a company can explain how they calculated depreciation or value of inventory. Auditors use
this information to ensure that the company has followed the appropriate accounting practices and that the
financial statements are an accurate reflection of the company’s financial health.

These notes also allow potential investors to consider them in an analysis of a company and in comparing
the company with another company in the same industry. Without including full financial statement notes
to explain variations in accounting principles, auditors and investors may not be able to determine the
accuracy of a company’s financial statement, which could lead to questioning a company’s ethics and their
adherence to GAAP or IFRS.

12.3 Integrating Microsoft Excel and Accounting Programs

Learning Objectives
By the end of this section, you will be able to:

• Discuss the pros and cons of using Excel for accounting purposes
• Describe how Excel and QuickBooks can be integrated

WorldCorp uses Microsoft Excel for managerial accounting and data analysis, but they use an accounting
software suite to handle the financial accounting. Excel can be used in conjunction with your accounting
system, but it cannot replace the accounting system. Accounting software also allows for real-time acceptance
and recording of transactions. That means that all purchases through a retail store using a cash register and
printed receipts are also recorded in the accounting software at the same time. While all these transactions are
happening all over the country and internationally, the financial statements are automatically updated.
Accounting suites allow for more automation than Excel, but Excel can still be useful in data analysis. This
section will compare Excel with accounting suites like QuickBooks and explain how to import or export data
into and out of accounting software suites.

Pros and Cons of Using Excel for Accounting
Accounting principles are not programmed into Excel, so it does not perform automatic calculations or create
documents in the same way accounting suites do. Accounting suites are designed specifically for accounting
and bookkeeping, whereas Excel is a spreadsheet program that has broader uses than accounting, such as
calculating mathematical equations using functions and formulas, building tables, and performing data
analysis. You can use Excel as a tool for deeper analysis and comparison of decision alternatives by importing
the information from the accounting-specific software programs. It can be used for analyzing any data in
numerous disciplines, such as science, humanities, social sciences, and sports. It can create charts and graphs,
which makes it easy to share information and collaborate using OneDrive or SharePoint, and thus it is very
useful for managerial accounting.

Graphs, statistical tools, and charts offer insight and are used in reports and presentations. These Excel tools
are not commonly found in financial accounting suites. Within Excel, these tools can build relatable
visualizations using PivotTables to increase comprehension of data. This level of data analysis is not offered in
financial accounting suites. You may find some of these features in larger accounting systems, but they are not
typical. Also, as technology advances and user needs are incorporated into software updates, it is possible
some additional data analysis capabilities could be added in accounting suites. But for now, data analysis of
the accounting data is often done in Excel. You would need to extract the data and import it to Excel to make it
visually impactful. You can also combine several accounts from the accounting software program in a single
export file to Excel and analyze them together using a table or chart.

QuickBooks is one common accounting suite that is easy to use. Its interface has icons that represent the most
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common needs of business managers. The program is divided into the areas of vendors, customers,
employees, companies, and banks. The vendor section is for handling billing and accounts payable and is also
a central database for all vendors in the company. Having this list reduces the need for each department to
have their own database of vendors. In the vendor section, you can manage the vendor information such as
the contact email and the area of the company to which the vendor is assigned. The customer section is for
generating invoices and handling accounts receivable and includes all the payment methods that customers
may use. Just as the vendor section is used to manage vendors and create the database for the company, the
same is true for the customer section. The customer section includes the master list of all customers in the
company. The employee section is for handling the payroll. The company section is for organizing the Chart of
Accounts and performing other similar functions. The banking section is for writing checks, tracking checks,
recording deposits, and reconciling transactions.

The main advantage of an accounting suite compared with a spreadsheet is that it makes all needed tables
and interconnections automatically. In Excel, you would have to build all tables from scratch and use cell
references to make them communicate, which would be time-consuming. In an accounting suite, you can track
transactions and costs without building tables like in Excel. QuickBooks even adds its own specialized features,
such as scanning invoices from vendors automatically, without any typing.

LINK TO LEARNING

Running a small business is easier using an accounting suite like QuickBooks, but you should still consider
using an accountant to help you with things like bookkeeping and taxes. Read this article on basic business
accounting (https://openstax.org/r/78CPACheck) and the types of daily, weekly, monthly, quarterly, and
annual tasks you should be performing. Maintaining good bookkeeping will save you time and money; if
you use QuickBooks, you will save on hourly CPA charges, as the consultant will have to work less. Using
Excel for bookkeeping requires the CPA to work more hours to accomplish the same tasks.

Integrating Excel and QuickBooks
You have learned different situations in which a company may want to analyze accounting data in Excel, but
you have also learned that Excel should not be used alone for a company’s bookkeeping. Accounting suites
allow for easy data export for analysis in Excel. For accounting in small- to medium-sized businesses, over two-
thirds of the market has been held by Intuit’s QuickBooks for many decades. QuickBooks is easy to use for
most people comfortable with technology and data, and to use it, you don’t have to be an accountant. You
create a chart of accounts when you first install the software or sign up online and feed it with daily invoices
and expenses. Once it’s set up, it automatically forms your financial statements in real time. The application
can generate tax-related reports such as the annual business tax filings or sales tax for submitting to
government agencies.

LINK TO LEARNING

If you want a more visual tutorial on extracting data from QuickBooks to Excel, see this detailed guide that
walks you through the steps (https://openstax.org/r/78ExtractQuickB) in the desktop version.

Fortunately, Intuit and Microsoft have made their applications compatible. Excel also integrates well with
QuickBooks and other accounting software. Both accounting applications readily accept importation of Excel
files, and they both can export data to Excel. Excel opens their exported file with ease, and you can gather
insights with these datasets by utilizing data analytics processes, forming data visualizations, and designing
business intelligence queries. Most accounting programs have a tool or command button for importing Excel
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data into the program or for exporting the data to Excel for additional analysis. When the data is imported into
the program, it is converted to that program’s data file type. Importing data from Excel into these specialized
programs can be helpful to check for errors and to uncover inconsistencies in financial data.

When starting to implement QuickBooks in your business, you may need to import a lot of data from Excel
files. Maybe you have your listing of products in an Excel file. In QuickBooks, there is a quick, automated way
to import this data. In the online version, you use the Import Data feature. This process lets you import many
different types of data, as you can see in Figure 12.14. For importing customer data, you will need to make
sure that the Excel spreadsheet matches the instructions provided in QuickBooks so that it can map the data
(Figure 12.15). It may involve some formatting and cleaning up of your Excel spreadsheet. If you want to
export from QuickBooks to Excel, you can easily filter out what kind of data you want to export (such as certain
transaction types or a date range) and export it to Excel format (Figure 12.16).

Figure 12.14 QuickBooks walks you through the process of selecting the type of data you want to import. (Reprinted with permission
© Intuit Inc. All rights reserved.)

Figure 12.15 QuickBooks also walks you through choosing the file and ensuring the data is in the correct format. (Reprinted with
permission © Intuit Inc. All rights reserved.)
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Figure 12.16 QuickBooks will ask what kind of data you want to export (such as certain transaction types or a date range) and export
it to Excel format. (Reprinted with permission © Intuit Inc. All rights reserved.)

SPOTLIGHT ON ETHICS

Financial Auditing

The purpose of the financial audit is to ensure that the company is following the rules and governmental
guidelines for managing and reporting financial information. It is also designed to assess the risk of the
company for potential legal action for inaccuracies or wrongdoing. Audits are greatly facilitated with the
use of software. It reduces human error and can even detect issues that might not be discoverable by the
individual auditor. Deliberate manipulation of financial information can cost the company millions of
dollars. In 2001, Enron was found to be inflating their company earnings by hiding debt. This results in
Enron’s shareholders losing billions of dollars and the share price collapsed. Enron employees were
convicted of wrongdoing and the company eventually went bankrupt.
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Chapter Review
Key Terms
accounting process of organizing, analyzing, reporting, and communicating financial information that is

used for decision making
depreciation steady decrease in value of an asset over time
financial accounting measures the financial performance of an organization using standard conventions to

prepare financial reports used by external entities
managerial accounting process that uses both financial and nonfinancial information as a basis for making

decisions within an organization
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Summary
12.1 Basic Accounting

• Accounting is the process of organizing, analyzing, and communicating financial information that is used
for decision making.

• Financial accounting measures performance using financial reports and communicates results to those
outside of the organization who may have an interest in the company’s performance, such as investors
and creditors.

• Managerial accounting uses both financial and nonfinancial information to aid in internal decision making.

12.2 Financial Functions in Microsoft Excel
• The time value of money theory, or the theory that money loses value as time passes, is the basis of many

financial decisions and can be useful in helping decision makers understand the long-term impacts of
their choices now.

• The time value of money variables are PV, RATE, NPER, PMT, and FV. They allow you to calculate the time
value of money.

• Depreciation is a mathematical formula that allows business owners to quantify how much value an asset
loses over time so that they can plan for replacing the asset.

12.3 Integrating Microsoft Excel and Accounting Programs
• QuickBooks is an accounting software suite. It is a different kind of software from Excel, and they both

have their advantages and disadvantages for use in accounting.
• Accounting software programs can better keep track of revenues and expenditures and do so

automatically and following IRS rules.
• Accounting software programs do not do well in data analysis, because the database is designed to be for

financial analysis. You would have to export data from the program to an Excel file, then use Excel to
further analyze the data.

• Excel’s extensive data analysis capabilities meet the needs of managerial accounting. Excel also integrates
well with accounting software programs.

Review Questions
1. Accounting is sometimes called the “language of ________.”

a. Wall Street
b. business
c. assets and liabilities
d. financial statements

2. Financial accounting information ________.
a. should be incomplete in order to confuse competitors
b. should be prepared differently by each company
c. provides investors with guarantees about the future
d. summarizes business activities in the company that have already occurred

3. ________ is an example of an external user of financial accounting information.
a. A new employee to the company
b. The CEO
c. The marketing department of the company
d. A potential investor

4. Which groups typically create initial managerial accounting reports?
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a. bankers
b. investors
c. competitors of the business
d. internal company decision makers

5. Which function input is used to determine the monetary value of an investment at the end of a time
period?
a. PV
b. FV
c. NPER
d. Type

6. ________ is the decrease in value of an asset over time.
a. Future value
b. Time value of money
c. Depreciation
d. Present value

7. What is the underlying financial concept used to compare money balances for different periods?
a. time value of money
b. financial value of money
c. debt sorting
d. economic inflation theory

8. What is one advantage that Excel has over QuickBooks?
a. Making financial statements is easier.
b. Excel is better equipped to do analysis of the numbers.
c. Excel makes it easy to track payroll.
d. Excel can generate tax reports.

9. Which feature is available in accounting software programs such as QuickBooks?
a. analysis showing major spending categories by averages
b. forming graphs and charts of the information
c. determining which expenses are outside of the normal range
d. generating tax reports

Practice Exercises
10. You have been saving $10 every week since you were five years old. Your parents put all of these savings

into a mutual fund. Now, you are twenty-two. The mutual fund paid on average 5 percent each year. What
function would you use to find out the value of the fund today? What is the value today?

11. You start saving for a condo that you plan to pay $80,000 for in four years. You have investments that will
produce an estimated 7 percent return during the four years. How much do you need to save a year to
reach your goal of $80,000?

12. You invested in two pre-owned cars for your business two years ago. You expect the cars to last ten years.
The initial investment of both cars was about $45,000. The salvage value for the cars combined is $12,000.
What is the annual depreciation for the vehicles? What is the current value to the business now?

13. Describe how WorldCorp might compare sales executives using Excel, QuickBooks, or both. What data will
you use? How would you compare them (using what methodology, and what software)?
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Written Questions
14. Think about a recent significant purchase you made. Describe what financial and nonfinancial factors

went into that purchase. Rank the factors from most important to least important and explain how you
made the final decision to purchase the item.

15. Computerized accounting systems help businesses efficiently record and utilize financial information.
QuickBooks is a popular software package for small businesses. Explore the QuickBooks website
(https://openstax.org/r/78QuickBooks) to learn more about this software. Select one of the QuickBooks
plans and discuss some of the capabilities of the software. Taking the perspective of a small business
owner, explain how this software might help the business.

16. Describe a situation in which you would use one of the five financial functions introduced in this chapter.

17. What is the purpose of the depreciation expenditure? Explain.

18. Why would you want to know the future value of an investment? Explain.

19. Why might you use Excel in conjunction with QuickBooks for accounting purposes?

20. What are the advantages of using QuickBooks for a small business owner?

Case Exercises
21. What other accounting software programs are on the market? Are they geared toward large businesses or

small organizations? Provide a brief review of some of the leading accounting software programs.
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Figure 13.1 Warehouses like this one require complex systems to manage their inventory. Microsoft Access is designed to handle

and report on large amounts of data. (credit: modification of “Man Standing in an Aisle of a Warehouse Carrying a Box” by Tiger Lily/

Pexels, CC0)

Chapter Outline
13.1 What Is a Database?
13.2 Microsoft Access: Main Features and Navigation
13.3 Querying a Database
13.4 Maintaining Records in a Database
13.5 Creating Reports in Microsoft Access
13.6 Creating Forms in Microsoft Access

Chapter Scenario
Welcome to the Business Analysis Department at WorldCorp. We are happy you will be working here. Your role
as an analyst is to work with data professionals who support various teams within WorldCorp. Most of the
time, you will be tasked with supporting the sales and marketing team, though you may also work with data
from other areas of the company. To get started, you will learn what a database is and how to use its data,
maintain its records, and create data reports. We focus on Microsoft Access in this chapter, but other database
programs have similar features and functionality.

Understanding and Using Databases
13



13.1 What Is a Database?

Learning Objectives
By the end of this section, you will be able to:

• Discuss how databases are used in organizations
• Compare and contrast the features of a relational database system with other types of databases

and data storage
• Describe the objects in a relational database
• Evaluate applications of relational database management systems in organizations

Data—bits of information about people, places, and things—is a key part of the world of business and
technology. It can take the form of words or numbers and is frequently collected without active individual
involvement. For example, the internet is constantly collecting information on what consumers look at, click
on, and read. This information is then often passed on to a database or even parsed out to several databases.
Other technology, including sensors and the so-called Internet of Things, is also constantly recording and
storing data for businesses to use in a myriad of ways.

One of the challenges of managing and analyzing data is understanding what data is, what it can be, and how
it can transform the world around us. Data on its own is not valuable or actionable. To make a difference, data
needs to be processed and organized to give it context. When this occurs, we have information. Then,
knowledge is generated from data that has been transformed into information and then finally analyzed in a
way to give meaning and draw conclusions about the data.

No matter how much data is collected, it is useless without organization and structure. Think about all the
things you interact with in a typical day. If those things were collected but had no structure (imagine bits of
paper with single words or numbers thrown into a pile), you would not be able to make sense of them. Since
the value of data lies in its ability to inform decisions and help us understand the world, both past and present,
the structure and storage of data are critical.

A database stores a large amount of data in an effective way that will allow for efficient retrieval in a
computerized environment. Databases may be physical objects, such as address books or file folders, each of
which provides a place to keep data in an organized fashion so we can quickly locate what we need. Physical
storage has limits, however, because its structure is easily overwhelmed when datasets get too large, and
retrieval of meaningful information becomes impossible.

A digital database is a computerized file that not only stores data in a structured or organized way but also
allows users to make changes to transform data. Digital databases are often contained within a program such
as Access on a desktop computer or Microsoft Azure or an structured query language (SQL) server at the
companywide level. Digital databases add new features and capabilities to business decision-making by
combining the power of analytics with the structure of tables and rows.

MAC TIP

Access is only available on desktops and laptops with a Windows operating system. It is not available on
Mac, Chrome, or Linux devices. Mac has a comparable desktop/laptop database called FileMaker.

Digital databases provide structure, organization, and access. But unlike physical objects, they provide a
flexible structure that enables us to capture, store, and organize large, complicated sets of data, and that also
gives us options for retrieving and using information. Using digital databases enables users to transform data,
creating new ways of informing decisions. Because businesses must make decisions based on data every day,
the key to good decision-making is creating a database that contains accessible, organized, actionable data.
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The Role of Databases in an Organization
Databases drive nearly all business functions in organizations throughout the world. Any business that uses
the internet has a digital platform or foundational technology that is built on databases. A digital platform is
a place where users can interact with and explore the products and services offered by a company. Digital
platforms often come in the form of an app, website, or social media. The term database is ubiquitous in
organizations, where you can assume that every function and every employee or customer are interacting with
many databases.

Organizations use databases to store information about customers, employees, vendors, products, supply
chain, transportation, maintenance, sales, inventory, and much more. Anywhere an organization is working
with data, some type of database will be involved. Often the database is the foundation for the work, and the
people who interact with the database may not even be aware that it is there.

Data in organizations comes from a variety of inputs, such as from direct input by employees or customers.
Some examples include entering new customer information, recording human resources information, creating
maintenance requests, purchasing goods for company use, and engaging in sales transactions. Data can also
come from technology that records information related to the business—for example, technology that tracks
items such as inventory levels, building management (temperature, air quality, occupancy), traffic patterns
(employee use of resources), resource use by customers, and customer contact (frequency and method of
contact, as well as the results).

Sales and marketing departments collect a great deal of data about their operations and customers. In
addition to typical customer information and sales history, a business is also likely to look at daily performance
data on marketing and sales operations. This can include sales force performance, customer service, and
experience data; social media promotion; and web platform performance. Automatic data collection tends to
generate a very large quantity of data that needs to be connected (or related) and then aggregated (or
summarized) to be understandable and useful.

Businesses also capture public data from other sources. For example, sales and marketing departments need
to look at public data, which is available from the government and other organizations. Public data includes
demographics and financial information and may even include climate change and environmental data that
affects how businesses work. These datasets are free, very large, constantly changing, and challenging to
locate and use. A clear plan for identifying and using this data benefits a sales and marketing department.

All of this data has to go somewhere, and that is the digital platform and the databases it comprises. It is not
enough to have data—data needs to be organized to be useful. Since data is key to decision-making and action
in most organizations, the digital platform is mission critical.

Data Collection and Storage in Organizations
In a typical business, a production database contains live data that the business uses to produce transactions
such as customer requests, inventory management, and sales transactions. Because production databases are
in constant use, they should not be used for testing or analysis. Any change to a production database makes
the system unavailable for some period of time, which is not desirable when the database is the interface
between the company and its customers, suppliers, and other important people outside the company. Instead,
when an organization needs to work with a production database, it moves its data to either a development
database (used for testing) or an analytical database (used for analysis).

SPOTLIGHT ON ETHICS

Working with Live Data

One of the best practices for working with databases is that users do not work directly with the production

13.1 • What Is a Database? 859



system—that is, the production database containing the live data that actively run the business. But why? It
seems that working directly with the production system would be the most efficient choice. In this case,
however, following best practices prevents users from making mistakes that can seriously compromise the
business. “Don’t work with the production system” is an ethical issue—part of the code of conduct that all
analysts are expected to follow. Watch this video using a case study to discuss this problem
(https://openstax.org/r/78WorkLiveData) to learn more about why this has become a standard in database
work.

Access is a desktop-based relational database program that can be used to work with a wide variety of data
quickly and easily, regardless of its source. Users can request data from the department in charge of the data
warehouse, which is a type of data management system that businesses use, then download the dataset to
work with to provide actionable information. Let’s see how this might look at WorldCorp.

John works as a data analyst for WorldCorp. The company has a robust data warehouse that stores vast
amounts of customer data, sales records, and inventory information. The data warehouse is managed by the
Data Management Department (DMD) within WorldCorp. (Other companies may choose to contract out their
data management department to a third party.)

John is tasked with analyzing the sales trends of a particular product category to identify potential areas for
improvement. To do so, he needs access to a specific dataset from the data warehouse. John follows the
established procedure and sends a formal request to the DMD, specifying the dataset he requires and
providing relevant details about his analysis objectives. The request outlines the specific parameters, such as
the time frame, region, and product category of interest.

Upon receiving the request, the DMD acknowledges John’s inquiry and begins processing it. They retrieve the
requested dataset from the data warehouse, ensuring that it contains the relevant information needed by John
to perform his analysis. After completing the data retrieval process, the DMD notifies John that the dataset is
ready for download. John receives an email with a link to access the dataset securely.

John clicks on the provided link, which directs him to a secure portal where he can download the dataset. He
verifies his credentials and proceeds to download the dataset onto his local machine. With the dataset now
available on his computer, John starts working with the data using specialized analysis tools. He cleans the
dataset, performs statistical analyses, and generates insightful visualizations to gain a better understanding of
the sales trends in the specified product category.

After extensive analysis, John identifies certain regions where the product category is underperforming. He
also discovers opportunities for strategic marketing campaigns and potential adjustments to the product
assortment. John compiles his findings into a comprehensive report, highlighting actionable insights and
recommendations based on the analysis of the downloaded dataset. He presents this report to the company’s
management team, enabling them to make informed decisions to improve the performance of the product
category.

In this example, the user (John) requests data from the department in charge of the data warehouse (DMD),
downloads the dataset, and uses it to generate actionable information through analysis.

Data can come in a variety of formats and configurations. The way in which data is stored can affect how the
data can be used, so it is important that a business carefully consider how its data will be stored. There are
advantages and disadvantages to each storage medium, but based on the type and volume of data being
stored, some storage formats are more suitable than others.

Data Warehouses

When we discuss data storage, we are typically talking about the data warehouse—a data management
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system that stores and manages data, especially data related to business intelligence operations and activities.
Data warehouses are built for storage, accessibility, and retrieval, as Figure 13.2 illustrates, and often integrate
data from a variety of sources within the organization. You may also hear the term data mart, which is a
subset of the data warehouse that is optimized for specific workgroups or functions. Typically, data flows into
the warehouse on a predetermined schedule, adding to the existing data available for analytical work.

Figure 13.2 Data can be transformed in the database through organizing and processing. (credit: modification of “Extract,
Transform, Load Data Flow Diagram” by Bamyers99/Wikimedia Commons, Public Domain)

A data warehouse is also a type of database, but it differs from the type of database you will use in Access. As
an organization’s central data repositories, data warehouses hold a lot of information and use a complex
structure. Typically, a department or team will include someone who is trained to interact with the data
warehouse, using business intelligence tools or other analytics technology. That employee can then use
Microsoft products such as an Access database or an Excel spreadsheet for analysis and preparation for
management to aid in decision-making.

Flat Files

Many businesses store their data in flat files—individual files that have a tabular structure, including single
spreadsheets, other tables, and stand-alone lists of information. Flat files have no set links to other
information. In fact, if there are any links, they will be obvious to employees but typically not in documents or
parts of the file itself. Flat files tend to look like tables, with headers at the top and a row representing each
record, as Figure 13.3 shows.

Figure 13.3 Flat files are mostly static repositories of data, usually represented in tables, that workers access directly as needed.

Flat files are easiest to use when datasets are small and when the individual using them understands the data
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well. But even flat files that are quite large, containing thousands or hundreds of thousands of records, can be
usable if all records follow a consistent pattern. Flat files are typically created by departments and individual
employees in the course of their work, and most organizations have a huge number of these files, which are
stored on personal computers and may not be updated or even available beyond the person who created
them. In this way, they are a form of dark data—data that is not used or actionable for the organization.

Flat-file databases are also used in other ways, including the transfer of information from one system to
another. For example, suppose a sales organization wants to examine inventory records from a warehouse. In
this case, the warehouse may send them a flat-file database that follows a uniform pattern, with columns for
fields and rows for records. This type of flat file merely stores information; it does not have an indexed system
or any links to other systems, and it is typically in a text format. Common examples of file formats that contain
plain text include CSV (comma-separated values, where data items are separated by commas), txt (text, where
items are separated by space in the file), or tsv (tab-separated values, where items are separated by tabs).
Often businesses must consider the other systems that their database will interact with before deciding on a
data format. Plain text is one of the most universally supported formats for data, making it simple to move
data between business systems.

Relational Database Management Systems
The power in a digital database comes from the ability to connect data from one area to another. A relational
database management system (RDBMS) is software that houses, manages, accesses, and retrieves data in
its database. The term relational refers to the way that data links together by creating relationships between
the tables that hold the data itself. In this way, relational databases can hold much more information that is
complex and yet easily accessible.

There are many different types of RDBMS in use today. Access is a desktop system that holds information that
is typically generated in other, larger database systems running on dedicated database infrastructure servers.
For example, a data analyst might use Access at their computer at their desk at headquarters but will pull the
data from the more powerful relational database systems running in WorldCorp’s dedicated data center. Still,
Access is also an RDBMS, with the power to manage relationships between tables, making it possible to create
complex reports.

A relational database is a type of database that stores and provides access to data. Relational databases hold
a collection of items, with preset relationships between them. Sometimes people use data, database, and
relational databases interchangeably, though you may need to pay attention to context to understand if a
person is talking about the data, the database, or the system itself.

A relational database and RDBMS are designed to give structure to data and to ensure that data is stored and
used effectively. Examples of large-scale RDBMS include MySQL, IBM DB2, Oracle DB, and Microsoft SQL
Server. Although each of these larger databases support querying and generating reports, in many small to
medium-sized businesses, data is often exported and brought into an Access relational database for further
refinement, analysis, and reporting or brought into Microsoft Excel for more complex statistical analysis.

Relational databases, running in an RDBMS, allow us to join or connect tables, perform complex analysis, and
run reports efficiently. A join is a function within an RDBMS that sets up the relationship between records in
two tables. In a data warehouse environment, relationships (or joins) that connect tables make it possible to
store vast quantities of data and still be able to retrieve them quickly and efficiently.

Access, as a desktop RDBMS, uses the same idea of connecting tables through joins to make data retrieval
quick and efficient and has the added benefit of using a graphical user interface. To work with data in Access,
you do not need to know a language such as Java, Python, R, or SQL. Since we often need to analyze
information from a larger data store, like the data warehouse, being able to work with relationships makes it
possible to efficiently access information from multiple parts of the database.
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Storing Data in an RDBMS
An RDBMS stores data in a database, which is a series of connected tables. The RDBMS provides the software
and system structure for the data; the database is the holding area of the data. In practice, the term database
is usually used for both of these, but it is important to understand that the data is separate from the program
housing it. As a result, you can move data from one software to another program, such as from Access to
Outlook or Word for communication distribution.

A database can hold a variety of data types in its data tables. A relational database that uses structured data
can recognize and process data based on its type; for example, it can understand the difference between text
and numbers and process them accordingly. Data types in Access are shown in Table 13.1.

Data Type Description

Text Alphanumeric data (in either short or long format)

Number Numerical data

Date/time Date and time

Currency Monetary data with four decimal places

Autonumber Unique value set by Access

Yes/No Data stored as yes/no (true/false)

OLE object Pictures, graphics, or other files that are stored

Hyperlink Link to a document (online, local computer, or network)

Attachment Full file attachment stored in the database

Calculated Mathematical expression (or calculation)

Lookup Wizard Field that uses the contents of another table to populate the field

Table 13.1 Data Types in Access These are some data types typically housed in a relational database.

Data Manipulation
One of the strengths of a database is that it enables users to manipulate data, changing it in a way that makes
the data more useful and actionable. An example of data manipulation is the creation of new fields based on
combining and calculating existing fields within the database. WorldCorp often manipulates its data as new
products are added to its portfolio or old products are updated with new features. Data manipulation allows
users to set up the data in a way that helps them and their audience make sense of it and transform it into
business intelligence.

Objects and Relationships
Objects and relationships are key concepts in a database. Objects are the items that make up a database,
including tables, queries, forms, and reports. Relationships link objects together in the database, as Figure
13.4 illustrates, which in turn improves the performance of the database itself.
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Figure 13.4 Relational databases use tables with defined relationships between them to organize and manage data, while flat-file
databases typically do not have this level of relational structure.

A database object is used to store, reference, or interact with the database. There are four main types of
objects in an Access database:

• Tables: the structures that hold individual data records
• Queries: structured data requests
• Forms: formatted screens for inputting or viewing data
• Reports: formatted summaries of specific information in the database

A relationship (also known as a join) tells the database that two records have a connection. This means we can
break up a table into many tables, which in turn keeps screens manageable and speeds up processing.
Relationships are created by using a key field, which is a field in a table that serves as a unique identifier for
an individual record in a table. For example, in a database about employees, an employee ID number would be
a key field and would act as the link between tables that hold employee information, payroll information, and
even performance information in a sales department. Instead of trying to hold all this data in one extremely
large table, we can have many smaller tables, each specializing in a particular type of data and linked to other
tables by key fields, such as primary or foreign keys.

Tables
Tables hold the data within a database organized into rows and columns in two dimensions. A table consists of
columns, each of which is a field, and rows, each of which is a record. The column or field names apply to each
record in the table and create the structure the database uses to organize information. A database can include
many tables that are joined together by relationships between fields. This structure makes relational
databases fast and efficient when retrieving data.

Each table typically contains a key field. A primary key field is a unique field in the table, which serves as a
unique identifier for the individual record you are looking at. A table can also have a foreign key field, which
refers to the primary key field in another table. For example, an invoice number for a sales record is a primary
key field—it is unique—but it can also appear as a foreign key field in other tables. In this way, the primary key
field prevents duplication in a sales invoice table and also provides a link to the sales invoice list as a foreign
key when it appears elsewhere in the database. In Access, primary key fields have an image of a key next to
them when viewed in Design View, as shown in Figure 13.5.
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Figure 13.5 The primary key is a unique identifier within a database table that ensures each record is distinct and provides a reliable
way to access, reference, and link data across tables. (Used with permission from Microsoft)

Key fields make it simple to gather useful information about a single data point from multiple tables.
WorldCorp might use a model number as a key field in a database that stores the features, availability, and
price of their products. In another database, WorldCorp can use a customer identification number to track
various customer metrics such as location, purchase history, and contact information across various tables.

Queries
In a large database, it can be difficult or even impossible to find the information you need by simply scrolling
through the records. It is even more difficult when a database contains many tables linked by joins. Instead,
you can design or build a query, a structured request that allows you to set up criteria instructing the
database to return what you are looking for.

For example, suppose your boss at WorldCorp asks you to gather sales transactions on a specific date or all
transactions for a certain dollar amount. Or you might want to be more specific, asking for all sales of a
specific product in a specified time period that exceeded a certain dollar amount. In each case, you can use
queries to ask the database to provide the information you need. In many relational databases, structured
query language (SQL) is used to create and run queries. SQL is a system of written commands used to
manipulate data in a database; it was developed by IBM in the 1970s to allow its engineers to interface with
database systems more efficiently. SQL is in Access; however, users can create queries without knowing SQL.

Forms
A form is a database object that simplifies the use of information within the database. A form creates a user
interface—a way for individuals to interact with the database—without directly using the table, which can be
slow, overwhelming, and risky (because data in the table can be inadvertently changed). A form can be used to
input information into a database (e.g., new customer information that customers enter themselves). A form
can also be used to retrieve information (e.g., when a customer service representative needs to look up a
specific customer record to resolve an issue). Examples of sales forms include customer information, sales
invoices, and sales records.

Reports
A report is a formatted output of a database, ready for use and action. A report summarizes data in a way that
matches the needs of the audience. For example, a product listing on a website or in print is a format ready for
presentation to a customer or someone else who needs to see all products at a glance. A listing of sales,
summarized by month, is also ready for presentation if the audience needs to know monthly sales figures for a
decision or action. Reports are typically one of the final outputs of a database, as they are directly linked to the
actionable goal or business intelligence activities of a specific workgroup, team, or project. An example of a
sales report may cover sales by product or sales over a time period, such as a month or year.
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Applications of RDBMS
Databases offer unique functionality that goes beyond the calculations and statistics provided by other
programs such as Excel. This is because of the RDBMS functionality. A relational database provides structure
for data, includes relationships that connect pieces of data in meaningful ways, and allows controlled access
through queries, forms, and reports. Because of this advanced functionality, RDBMSs are used in a variety of
use cases across multiple industries.

As organizations work to transform themselves to meet the needs of the twenty-first century, companies are
shifting how they view customers, employees, and work in general. Databases play an integral role in this shift.
Digital transformation relies on data, and for companies to transform, they need not only good data but
actionable data, available when they need it, where they need it. The core of this change is the data
management system, and an organization’s data landscape is a constantly growing and evolving part of the
business plan. Since the digital transformation of a business or organization is about leveraging technology to
change the way a business is run, an organization’s collection and use of data is an ongoing process, with the
focus on people—not technology—and how we enable people to be more innovative, responsive, and
successful.

Large organizations typically collect data through transactions and sensors, which then store the data.
Eventually, data is transferred to a data warehouse, which stores data for historical purposes. From the data
warehouse, organizations can bring datasets to a relational database such as Access for analytics and use.
Data warehouses and Access are built on relational database models, which provide benefits, including the
following:

• Data accuracy: The use of primary and foreign keys improves accuracy.
• Easy access to data: Data is held in tables that are easily accessed through queries, improving speed and

efficiency.
• Flexibility: A RDBMS easily scales to include more data and tables as needed by the organization, without

affecting the existing structure or the data in the database.
• Security: Because data is held in separate tables, it is possible to create a variety of user roles and

permissions, allowing individuals to access some data without needing full system access.
• Adaptability: Databases can be easily modified as business requirements change.

Because data in an organization is created in production systems and then brought to the analytical system for
work, an RDBMS focuses on keeping the data organized and ready for retrieval. The RDBMS also allows the
analyst to create database objects that make working with the data more accurate, effective, and efficient.

Examples of Database Use
How do companies apply the information they get from databases? They do so in many ways, most commonly
through their marketing and customer service initiatives, for example. WorldCorp’s Sales and Marketing
Department depends on databases to inform marketing strategy and customer service processes and
procedures and to understand sales trends and future opportunities.

Example: Marketing Strategy

Recall that WorldCorp manufactures health-care products. Its leadership has been looking at their online
promotion of allergy medications. They have a variety of advertisements online, served by social media
platforms. While they can easily look at the data to see the click-through rate (which is the number of times a
consumer clicks an online ad in relation to how many times the ad is shown) and the purchase rate on specific
partner sites, they also want to know if they can better understand the customers who are considering
purchasing but have not yet done so.

Using the data warehouse, you as the WorldCorp employee can request a report of all shopping carts that
were populated with a particular medication from an online shopping site partner. Since the data warehouse
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stores both the WorldCorp information and key information on sales from major partners, you are able to ask
for a year’s worth of sales data, with customer demographics including location, family structure, and other
related purchase information such as, say, other antihistamine and allergy comfort items. You receive the data,
import it into Access, analyze it to identify who was likely to add the item to the cart and what they did after
placing it in the cart (purchase the item, purchase something else, or another action), and prepare this data for
the strategy meeting.

Example: Customer Service

WorldCorp supplies medication to its vendor partners, including online distributors (both over-the-counter and
online pharmacies) and physical distributors, as well as health-care organizations. They are looking to improve
the customer experience for their vendors. Now you are the analyst working with the customer service team in
the Sales and Marketing Department. You need to understand where vendor needs pain points are to prepare
a report for the leadership team. You request a list of all vendor support contacts, which includes the vendor
name and contact information, the request itself (including date, time, and method of request), and the
resolution. You analyze them to determine the most common types of questions and requests, where these
requests originate from, and how they were resolved. You use the dataset to create a report for the leadership
team that summarizes and highlights the top issues over the past eighteen months.

Example: Sales Trends

Next, the sales team at WorldCorp is looking at where to focus their attention for the upcoming year in terms
of promoting their medication for obstructive airway diseases such as chronic obstructive pulmonary disease.
The team wants to identify areas in the world where their medications may be needed and prepare for the
demand. Working with their public health experts, they know that obstructive airway diseases are more
common in people who smoke or breathe in secondhand smoke or who live in areas with high pollution. They
also learn that people are often over age 40 years when symptoms appear, that asthma increases the chances
of developing these diseases, and that they occur more commonly in individuals with certain jobs or who have
had a high number of respiratory infections in childhood.

You, again as the business analyst, want to identify the geographic areas that are most likely to increase the
risk of obstructive airway diseases and look at sales trends in these areas over the past five years. You work
with the Data Science Department to ensure that the public data that WorldCorp has available and the internal
sales data (including the data from the vendor) are available. You then create reports that show specific
geographic areas and risks and the sales trends for these areas over the past five years.

NoSQL Databases
In addition to Microsoft Access and other databases that define the relationships between data stored in them,
which are the main topics of this chapter, there are other ways that organizations can capture and store data:
nonrelational databases. A NoSQL database (NoSQL stands for “not only SQL”) stores data in a different way
than the databases we are discussing in this chapter. A NoSQL database, also known as a nonrelational
database, is a type of database management system that provides a mechanism for storing and retrieving
data that is different from traditional relational databases. Unlike relational databases, which store data in
structured tables with predefined schemas, NoSQL databases store data in a variety of ways and are designed
to handle large volumes of unstructured or semistructured data. NoSQL databases have gained popularity due
to their flexibility, scalability, and high performance.

NoSQL databases often store documents and images and manage large amounts of data in their original
formats, rather than in tables; this is also known as unstructured data. NoSQL tends to be used when an
organization needs to store huge volumes of both structured and unstructured data and also needs the ability
to quickly develop and scale data initiatives. Scaling data initiatives is the process of expanding and advancing
data-related projects, strategies, and operations to handle larger volumes of data, accommodate increased
complexity, and support the growing needs of an organization. It involves implementing measures and
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techniques to effectively manage, process, and analyze data on a larger scale, often in terms of volume,
velocity, and variety. For example, WorldCorp uses a NoSQL database to record logistics for shipping its
products. Because the data involved with logistics has unique structure and is greatly varied, a NoSQL
database is an ideal candidate for managing this data.

Data Lakes

You may also hear about data lakes in your organization. A data lake is a centralized repository that allows for
the storage and analysis of vast amounts of diverse data in its original, raw, unprocessed format. A data lake
can store both structured and unstructured data and make it available for use and analysis as needed. In a
data lake, data is collected from various sources, such as databases, applications, sensors, social media feeds,
and more, without the need for up-front structuring or transformation. This raw data is stored as is, preserving
its original format and granularity. This includes structured data (e.g., relational tables), semistructured data
(e.g., JSON, XML), and unstructured data (e.g., text documents, images, videos). Data lakes offer several
advantages, including the ability to store and analyze large volumes of diverse data, support for flexible data
exploration and discovery, and the potential to uncover valuable insights and patterns. However, they also
present challenges related to data quality, data integration, and ensuring proper governance practices, as the
raw, unstructured data may require additional effort for data preparation and cleansing.

Although many organizations use NoSQL databases and data lakes, RDBMSs are still the most common type of
databases used to power transactional systems, such as managing and tracking customer profiles at
WorldCorp. At present, Access does not have a built-in mechanism to directly interface with NoSQL systems or
data lakes, although data that comes from a NoSQL database or data lake can be formatted and sent to you
for analysis.

13.2 Microsoft Access: Main Features and Navigation

Learning Objectives
By the end of this section, you will be able to:

• Demonstrate navigation of the Microsoft Access screen interface
• Identify the main features of Access
• Understand how to close Access

The benefit of Microsoft Access is that its design and structure enable it to communicate with other systems
that hold data. Unlike larger database systems that run on dedicated servers, Access runs on a regular
desktop computer. Because it is a desktop database system, the user can work within the database without
connecting to those larger systems.

As a Microsoft software package, Access follows many of the conventions of Microsoft Office. This provides a
consistent, familiar interface for work and ensures that file transfer is seamless between Microsoft Office
software, for example, between Access and Excel.

What Is Access?
Access is a RDBMS that can import and manipulate data from other systems on your desktop computer. While
data science professionals work directly with the data warehouse and can create queries using programming
languages such as R and Python, individuals who need to analyze data as part of their jobs within a
department often find Access to be a user-friendly software package that has the power to access, retrieve,
and report data using a Microsoft interface. Access also integrates well with Microsoft Excel, providing even
more analytical and reporting power that can inform decision-making.

In small businesses and organizations, Access can act as the main data store; however, it is much more likely
that you will use data that is collected and stored in other systems and then imported into Access for analysis.
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The Role of Access in an Organization
Access is one of the many tools that make up an organization’s data landscape—the entirety of data storage
and sharing in an organization. An organization may have both production databases and analytical
databases.

Production databases are systems that handle daily transactions related to an organization’s core business
functions, such as sales, inventory, human resources, payroll, and purchasing. Because production databases
provide value to the organization, companies devote significant resources to ensure they remain online and
active. Companies do not work directly with a production system when analyzing a business because this may
interfere with regular operations for customer transactions; instead, companies use a data warehouse or
analytical database for building new applications or testing new features. This type of database is entirely
separate from the production database, so changes to the analytical database will not modify the production
database until the developer is ready to push the changes to the production database after thorough testing.

Analytical databases (data warehouses) serve as an organization’s single point of truth (SPOT) in which a
primary copy of a data element is stored. Changes made to a data element outside of the data warehouse are
not considered final until the primary data element in the data warehouse is also updated. These large
databases contain a vast number of records, each of which stores historical information about the
organization itself. A data warehouse is not a production system; rather, it is filled with data from the
production system, collected over time and organized in a way that makes retrieval and use easier for business
use. We can request information from the data warehouse, which is then exported to a file we can use in our
analytical software, such as Access or Excel. The ultimate goal of using data is to make good decisions based
on the data and not on emotions.

An organization’s data landscape can also contain numerous flat files held within teams and workgroups,
other systems that run on databases that should be connected to the data warehouse, and even information
from vendors and public sources that can inform data. The data landscape may include information scraped
from the web, downloaded and processed from public sources, and environmental data. The extent of an
organization’s data landscape is based on the size and role of the company; larger companies will often have
more complex data landscapes, as will organizations that are undergoing digital transformation and either
have or are building a core platform for all business functions.

Access and Excel
Access and Excel are both software packages in Microsoft Office. They are complementary: Although they have
some functions in common, each package is designed for specific uses. Sometimes, the overlap or
commonalities between them can make it difficult to know which is most useful. Both Access and Excel can
store large amounts of data, run powerful queries, use analysis tools to manipulate data, and perform
complex calculations. However, each software has its own strengths, and choosing the right software will make
your work easier, as Table 13.2 outlines.

Use Excel to: Use Access when you:

Analyze a specific dataset Need to track and record data regularly

Perform complex numerical
calculations

Need to ensure data integrity

Work with a table for
calculations

Expect data to be accessed by multiple users

Table 13.2 Choosing Excel or Access Excel and Access each have different strengths when handling information.
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Use Excel to: Use Access when you:

Perform what-if analysis to run
scenarios

Store data in multiple tables

Create advanced pivot tables
and charts

Need to connect to other data sources to refresh data (either manually
or on a schedule)

Create visualizations
Secure data at the user level (each user can have different roles and
access to specific data)

Table 13.2 Choosing Excel or Access Excel and Access each have different strengths when handling information.

Access and Excel can be used together. It is possible to move data from the data warehouse to Access and
then, as necessary, query and export data from Access to Excel for further analysis and visualization.
Transferring data from one program to another is one of the benefits of using a desktop database program; as
part of the Microsoft suite of products, both Access and Excel can communicate effectively, so users can also
import flat files from Excel and convert them to relational tables.

Features of Access
Access is a cost-effective database solution. It runs on a desktop computer and provides an easy-to-use
interface that is familiar to users of other Microsoft software. Access interacts well with Excel for deeper
analysis, with Word for reporting, and with PowerPoint for presentations. It can work with data from external
sources, such as a data warehouse, or with exported files from the web and other systems.

Microsoft Access:

• Creates the framework or structure to store small bits of information (data) in a database
• Allows users to open tables and scroll through records
• Provides an easy-to-use interface for adding, modifying, and retrieving records
• Has a process for creating queries to select, combine, and calculate data from multiple tables
• Provides user-friendly screens and support for creating queries, forms, and reports that allow access and

use of the data held in the database

One difference between Access and other Microsoft 365 software is in its introduction or opening screens.
Access loads one database at a time, and all screens focus on the open database. When you first open Access,
the screen will be blank, Figure 13.6 until you load a database. Once loaded, the screen shows all available
commands.
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Figure 13.6 The Home screen will give you the options to create a new blank database, choose from preloaded templates provided
by Access, or search for an existing database file. (Used with permission from Microsoft)

As you move through Access, different commands will become available based on the active objects. For
example, you will see different commands when working in tables versus working with queries. The main
working area in Access is the center of the screen, with navigation on the left and commands across the top.

The Opening Screen
When Access is open without a database, most commands either do not appear or are unavailable (grayed
out). Without a database, the software is inactive. When a database is open on the screen, you will see
commands available on the ribbon along the top (Figure 13.7) and a navigation area along the left edge of
your screen (Figure 13.8). Only one database can be open at a time in Access, and all software is focused on
supporting your open database.

Figure 13.7 The Create tab provides tools and options for creating various database objects such as tables, forms, queries, reports,
and macros to design and manage a database system. (Used with permission from Microsoft)
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Figure 13.8 Access has many reports and models already built and modifiable; you might want to consider these before creating one
from scratch. (Used with permission from Microsoft)

As you click through the ribbon, notice that some commands are not available unless you have specific
database objects open, and you can move between objects in your database by using the navigation area on
the left side of your database screen.

Although there are many different database software programs in use, most of them have the same parts.
Access, as a RDBMS, follows the typical database conventions, or standards, in use in all relational database
systems.

You can think of Access as a container that holds database objects, which, recall, are items in a relational
database. Each object plays a role in managing the database and the data it stores. Because the database is
electronic, it can grow to hold many objects and can create links and new uses for each over time.
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Like many databases, Access databases usually contain tables, forms, reports, and queries. (They can also
contain macros and modules, which you will learn about in Advanced Database Use.)

Locating and Opening Database Objects
Once you open the database or the container that holds database the object, you will see a navigation area
open on the left side of the screen. This area has headings for each type of object that is present in the
database, followed by the names of each object you have. To open any object, double-click on its name, and it
will open in the main work area on the right side of the screen (Figure 13.9). To close an object, click on the X
next to the name of the object.

Figure 13.9 Open an object from a database in Access. (Used with permission from Microsoft)

Tables

Tables hold the data in a database. One database can contain many tables, each of which holds a different
record (or set of related information) or parts of a record. One benefit of a relational database is its ability to
split large sets of information about a specific item, person, or idea over multiple tables. This action speeds up
processing and gives the database a better organizational structure.

As you learned in What Is a Database?, tables are built with rows and columns. The rows of a table consist of
individual records or lines of related data. The columns represent fields or headings referring to information
that is likely to be included in all the records. This structure, which characterizes all relational databases, makes
it possible to share datasets between different database software packages. An example of table structure is
presented in Table 13.3.

ID FirstName LastName MiddleInitial

1234 Mary Nanas A

2345 Jose Garcia I

3456 Andre Williams C

Table 13.3 Table Structure This structure characterizes all
relational databases, allowing the sharing of datasets between
different database software packages.
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ID FirstName LastName MiddleInitial

4567 Lisa Estrich J

5678 Pat Johnson E

6789 Stevie Larose Y

Table 13.3 Table Structure This structure characterizes all
relational databases, allowing the sharing of datasets between
different database software packages.

This small table contains four fields—ID, FirstName, LastName, MiddleInitial—and six records, which contain
the information for each field for six different employees.

Queries

Queries are a way of asking questions of a dataset. Recall that a query is a structured request for information,
allowing you to choose what information appears, the order in which it appears, and how it is organized.
Queries can also be used to calculate information based on fields. Typically, when you interact with the
database, you will be creating queries to satisfy business requirements.

Like other database objects, queries appear in the navigation area of the database. To open a query, double-
click it, and it will appear in the work area of your screen. In Access, you can change how you view a query,
choosing either Datasheet View, which shows the results of the query in table form, or Design View, which
shows the structure of the query and allows you to modify it. You will learn more about these views in
Querying a Database.

Reports

A report shows the results of a query, formatted in a business-friendly way. Creating a report allows you to
choose the precise information you want to include and the format in which you would like your audience to
view it. Since tables and queries typically return results in the form of tables, reports allow you to focus on the
message your audience will need for decision-making, not on the data. One advantage of creating reports is
that you can set up standard reports that you will need to run frequently (e.g., a report of sales totals) and
then open them and view the latest results as often as necessary.

Like other objects, reports in Access can be created in a Wizard that walks you through the basics, and then
you can adjust the report in Design View. Building a useful report can take time and care to ensure it
summarizes and displays information in an actionable way that supports the work group’s goals.

Forms

Recall that a form in a database allows users to work with records in an easy-to-use format. Forms limit the
individual’s view of the database to what is necessary for a specific task or information request. On most
websites, we interact with forms that are built on the basis of queries: They request and present data taken
from the underlying table and query structure. Forms are often based on predefined queries that run over and
over again and, as with a search for a product, may prompt the user for a response.

Forms appear in the navigation area of the database and can be opened in Layout or Design View, which
allows you to modify the form itself (Figure 13.10), or in Form View (ready for use) (Figure 13.11).
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Figure 13.10 Design View allows users to modify and customize the structure and properties of database objects, such as tables,
queries, forms, and reports, providing a detailed and precise way to design their database elements. (Used with permission from
Microsoft)
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Figure 13.11 Form View is the user-friendly interface for interacting with and entering data into a database, presenting records in a
user-readable format and allowing data input and editing. (Used with permission from Microsoft)

LINK TO LEARNING

Sometimes the best way to learn is to explore on your own. Visit Microsoft’s featured Access templates page
(https://openstax.org/r/78AccessTemp) to choose a template and then download, open, and explore it in
Access.

Closing Databases
In Access, only one database can be open at a time. As you work, all on-screen commands will focus on this
open database, and you will need to close the database itself to end your working session. When you are ready
to close the database, Access will either save objects automatically or prompt you to save objects before
closing. In general, Access will automatically save records when you are done with them (i.e., when you leave
the row) but will prompt you to save changes to objects, such as tables and queries, so you can decide whether
you want to save them.

If you want to make sure an object is saved in Access before you close the database, you can use any typical
Save command shortcut (e.g., File>Save, Ctrl+S) to request that Access save your changes. Access will prompt
you if you need to take any additional steps.

When you are done working with your database, click on File>Close to close all objects and exit the Access
software. Be sure to close your database every time you are done using it; this will ensure that all objects are
closed and that data is correctly written to the records within the database.

876 13 • Understanding and Using Databases

Access for free at openstax.org

https://openstax.org/r/78AccessTemp
https://openstax.org/r/78AccessTemp


13.3 Querying a Database

Learning Objectives
By the end of this section, you will be able to:

• Explain the uses of queries to explore data in a database
• Build and edit a query in Access through the query grid
• Establish a relationship between tables with a simple query

WorldCorp collects data constantly in all its departments. The Human Resources Department maintains
employee records; the Maintenance Department monitors equipment, repair, and inspection records; and the
Accounting Department keeps records on all purchases, to name just a few departments. The data collected in
all of these areas can inform decisions, as long as it is accessible and analyzable.

The WorldCorp product and sales division constantly updates customer records, processes sales, and
maintains inventory levels. It has a data warehouse that powers its transactions, which is continuously working
in real time. This information is key to its success, but it cannot work with it directly because that would mean
turning the system off. Instead of taking a production system offline for analysis, you will work with a dataset
based on last week’s work.

Working with a dataset can be complicated, and as the datasets get more complex with more records, you will
need to be able to query or ask questions using Access. Because Access runs on your computer against a
database file, it is quick and responsive and integrates well with other Microsoft programs like Excel for
visualization and Word and PowerPoint for communication.

Understanding Queries
Queries allow you to ask questions of a database or take an action within a database. To write a query, you
need to know the question you want to answer. For example, you might need a listing of all products sold over
the past quarter, a list of equipment that needs to be inspected, or a list of products in the company’s
inventory. Once you establish what you want to know, you can then write a query that will ask the database to
share the correct information.

A query is really a question written in computer syntax. The query collects data that meets your specifications
by running against the table(s) in your database. A query can be simple—for example, returning all values in a
field in the table, such as product ID number. A query can also be complex, limiting the dataset and results to
precisely what you are looking for. Expressions that a database management system uses to limit the results of
a query based on matching field values are called criteria. Adding criteria enables you to control what data
you see so that you can identify the records you need and omit the ones that do not meet your needs. In turn,
this makes it easier to answer questions and visualize the data you need.

Before you create a query in Access, you should have a strong understanding of what you want from your
dataset. For example, WorldCorp could be interested in discovering how their latest product has been selling
based on data in their transactional database. To accomplish this, you might need to look for sales that match
certain criteria, such as sales for a specific product identification number. Knowing this in advance and putting
it in writing will help you craft useful queries. When planning a query, you will want to identify the following:

• The fields you want
• The value(s) you expect in each field
• Any calculations or changes you want from the data
• How you want the data displayed (e.g., in order by date)

Although the steps are the same in building both simple and complex queries, the planning process becomes
more important the more complex your queries are.

13.3 • Querying a Database 877



Queries can be designed for a single use or built for ongoing work. Ad hoc queries typically answer a specific
question and are needed only at the moment you create them. Once you are done with an ad hoc query, you
will not use it again, so it does not need to be stored or saved. Other queries, called predefined queries, are
set up and saved. Predefined queries are used to automate data management tasks that meet specific
organizational needs. An example of a predefined query is a sales report or top-selling product report that you
frequently run without change (or with only minor changes). In this case, you will want to save the query to
make your work easier. You might even want to set up a screen with all of your predefined queries.

The Purpose of Queries in Databases
Queries are an essential part of making a database accessible. Imagine trying to make sense of hundreds,
thousands, or even more records without a tool to help you. It is simply not possible. The more complex your
dataset, the more important it is to use queries and reports to retrieve data. Most databases have too many
records to work with unless you have well-written queries. A well-written query is specific, organized, and
comprehensive, meaning that it contains everything you need.

SPOTLIGHT ON ETHICS

Protecting the Privacy of Data

The Target data breach in 2013 was a significant security incident, resulting in the theft of forty million
credit and debit records and seventy million customer records. The breach demonstrated that such
incidents can severely undermine customer trust and confidence in data security. Customers concerned
about the potential leakage of their data became wary of Target, leading to decreased sales reputational
damage.

The breach also highlighted the need for companies to ensure the security of their vendors. Target’s
compromise, for example, originated from a third-party vendor. Cybersecurity is a weakest link proposition:
Organizations must consider the security of all parties involved in their data ecosystem.

Although Target’s handling of the breach included prompt notification to customers, it was clear that
additional precautions could have been taken that would have made the attack more challenging for
cybercriminals. The incident highlights the need for proactive security measures and robust disaster
preparedness plans. Furthermore, the breach had financial implications that went beyond the settlement
costs; Target experienced reduced earnings and a decline in customer patronage. The ultimate cost of the
breach was estimated to be well over $200 million.

The Target data breach serves as a reminder for organizations to prioritize data security, protect customer
information, engage in proactive defenses, and have strategies in place to restore customer trust if a
breach occurs.

See this coverage of the Target data breach (https://openstax.org/r/78TargtDataBrch) and think about how
your data may be stored and used by companies and websites and also about how you, as a professional,
need to manage data to protect it and the people who have shared it with you and your company.

You are most likely to use queries to retrieve a specific record or set of records, but queries have other
functions as well. For example, they can summarize data and perform calculations. You can even set up
queries that show you the most current data in the database each time you refresh your records.

Designing Queries
Before building a query, you need to take some time to think through how the query will work and what it will
accomplish. Start with a question, such as one of the following examples:
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• What does inventory look like right now?
• What sales were made last week?
• What were the top products sold, based on volume, last quarter?

These questions demonstrate in detail how to structure the query. Once we have the question in mind, we can
then consider other items that inform our query design: what data is available, where it is located, how it may
need to be processed (e.g., sorted, filtered, or calculated) to get to the answer, and how the output should be
organized (e.g., sorted by date).

This design, or model, tells you how to create the query in your software. Once you have created the query in
Access, you will need to test it by running it a few times to make sure it returns the values you are looking for.
You will likely revise your queries as you test them. Remember that the more complex a query is, the more
revision and testing you will need to do.

A query based on your question or need for information contains specific components. In Access, these are as
follows:

• The name of the query (if you will be saving it), which appears at the top of the query screen
• The field in which your data is stored
• The table in which the field is located
• Sort, which determines the column that will be used to sort the query (e.g., in numerical order by product

ID)
• Criteria (text that can be used to limit the results of a query)
• Or, which allows you to create more complex statements

When you create a query in Access through the Query Wizard (Figure 13.12), these areas will be filled in by the
wizard. If you need to modify a query or want to create one without using the wizard, you will use the query
grid to set up the query. You learn more about this later in the section on Editing Queries with the QBE Grid
and in the chapter on Advanced Database Use.

Figure 13.12 The Query Wizard guides users through the process of creating database queries step by step. It provides a graphical
interface to help users select tables, fields, criteria, and sort options, making it easier to generate complex queries without writing
code manually. (Used with permission from Microsoft)

Using these areas of the query allows you to accomplish multiple tasks, including choosing the data you want
to include, omitting data that is not of interest to you, sorting data, and even combining data from multiple
tables.
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Running a Simple Query
A simple query is one that finds and displays information. Very simple queries may show all the data in the
database, in columns, or all the information in one specific field or column. Once a query has been created and
saved, you can run the query whenever it is needed to return the updated results. Each saved query has a
name associated with it, and typically these names follow a specific pattern that helps you to differentiate
between them. For example, a version of a customer list sorted by last name and the same list sorted by state
would be named qryCustomerLastNameState.

In the Access database with queries, you will see a list of saved queries in the navigation section of your
database. For example, in the database shown in Figure 13.13, you can see four queries under the Queries
heading: ProductCategoryList, ProductList with client information, ProductsACTIVE, and ProductsALL. These
simple queries are already created; to run them, simply double-click on the name of the query you want.

Figure 13.13 Use Saved Queries to prevent repetitive query design in Access. Here, the saved query ProductList with client
information is selected. (Used with permission from Microsoft)

Once you double-click on a query name, it will open and show you the results table. The query will generate
updated results every time it is opened, allowing users to use a simple query over and over, even as data is
refreshed in your database.

When queries—or any database objects—are open, you will see the name of the object on a tab above your
work area. To close a query, click on the X to the right of the object’s name.

Switching Views
Access can switch between the Design View of the query and the results of the query. For queries, you will
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frequently change views to move back and forth between the underlying query structure and the results of
running the query. When you look at the structure in Layout View, you can modify how the query works. When
you go to SQL View, you are also able to modify the query structure (see Figure 13.14).

Figure 13.14 Viewing a query in SQL View allows you to see and edit the underlying SQL code that defines the query’s structure and
criteria. (Used with permission from Microsoft)

To change views, first click on the View command on the ribbon, and then choose the view you would like to
see. You can choose from three views:

• Datasheet View shows you the results of the query in table form.
• SQL View shows the query in structured query language form.
• Design View shows the query in the form of a QBE (query by example) grid.

Using these views, you can see your query in multiple ways, first visualizing the query and then seeing the
results quickly.

Query Walkthrough
In today’s fast-paced business landscape, staying ahead of the competition requires a deep understanding of
your products and their performance. WorldCorp’s state-of-the-art sales and marketing database is designed
to maximize their sales potential. At the core of this powerful database lies the ability to perform queries that
deliver invaluable insights. A query in WorldCorp’s sales and marketing database returns a list of products,
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including the product ID code, product category code, and notes (if any are present). Notice that there is only
one table, called the Product List, and that all three fields are used in the query.

First, Figure 13.15 shows the query in Design View. Note that the list is sorted in ascending order based on the
product ID. The result of the query is shown in Figure 13.16.

Figure 13.15 Using a query creates a list of all products found in a database. (Used with permission from Microsoft)
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Figure 13.16 The result of the query will return everything in the database that fits the criteria you included in your query fields.
(Used with permission from Microsoft)

Now, let’s look at a query that uses more than one table. In this example, the query returns a list of products
with information about wholesalers who have showed interest in those products. Three tables are used:

• ProductList: list of products that WorldCorp offers
• WholesalerList: list of wholesalers that WorldCorp works with
• WholesalerInterestList: table that includes ProductID (from ProductList) and WholesalerID (from

WholesalerList)

See that the tables are joined by the fields ProductID and WholesalerID. If you used only the
WholesalerInterestList table, you would not be able to display the product category or the wholesaler
name—information needed to make the results of the query useful for the sales and marketing team. If you
look at the grid in Figure 13.17, you will also see that the table uses sorting and an expression (a combination
of two fields displayed together). The results are shown in Figure 13.18.
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Figure 13.17 A query across several tables can create a sorted list of products from the database by combining data from more than
one table. (Used with permission from Microsoft)

Figure 13.18 The results will display only the columns that you chose to show in your query. (Used with permission from Microsoft)

Notice that this query combines several different techniques, including the use of multiple tables, sorting,
criteria, and even an expression that combines fields in the query (in this case, the wholesaler ID and name).
This is just a small demonstration of the power of queries.
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REAL-WORLD APPLICATION

Using Data to Make Informed Decisions

Netflix collects and analyzes vast amounts of user data, including viewing history, ratings, and preferences,
to drive their content strategy and personalized recommendations. By analyzing this data, Netflix can
determine which TV shows and movies are popular among different segments of their user base, make
data-driven decisions on content acquisition and production, and provide personalized recommendations
that enhance the user experience. This data-driven approach has contributed to Netflix’s success in
delivering highly relevant and engaging content to their subscribers.

Netflix also uses data to make informed decisions in other aspects of its business, including the following:

• Content acquisition and production: Netflix analyzes viewership data, user preferences, and market
trends to help it make informed decisions about acquiring rights to existing content or investing in
original content production.

• Audience segmentation and targeting: Netflix leverages user data to segment its audience based on
viewing habits, preferences, and demographics.

• Pricing and packaging strategies: Netflix analyzes data on user subscriptions, engagement levels, and
pricing experiments to assess the impact of different pricing and packaging strategies.

• User experience and interface design: Netflix utilizes data on user interactions, browsing behavior, and
feedback to continuously improve its user interface design and user experience. Netflix runs
experiments, conducts A/B tests, and gathers user feedback to refine features, layout, and content
presentation, ensuring an intuitive and engaging viewing experience.

• Customer service and support: Data analysis helps Netflix identify patterns and trends in customer
support interactions, enabling it to improve response times, identify common issues, and enhance
customer satisfaction. Netflix can also proactively address potential issues by analyzing data on
streaming quality, buffering, and device compatibility.

Using this data-driven approach, Netflix can make informed decisions that drive customer acquisition,
retention, and overall business growth, allowing it to stay ahead of the competition, continuously improve
service, and deliver a highly personalized and satisfying entertainment experience to millions of subscribers
worldwide.

Saving and Closing the Query
The first time you create a query, you need to give it a name. After that, if you modify the query, you will need
to save it, and doing so will update the copy you have. To save the query, you can click on the Save icon on the
quick access toolbar or use Ctrl+S on the keyboard. Access will also prompt you to save when you close a query
that you modified.

If you do not plan on using a query again or if it is extremely straightforward, you may not want to save it, but
if you are likely to reuse the query, you will want to give it a descriptive name. It makes sense to create a
naming schema that you can continue. For example, if you are querying for a specific project team, you may
start with the team name, like ProductTeam, to help you identify the query later on.

Building and Creating Queries
WorldCorp needs to quickly gather data related to sales records of their new health-care product in the market
of Southeast Asia. Although you could design a query to gather relevant information from scratch, Access has
a convenient wizard that can help you design a suitable query. Wizards are small programs that run within
Access to help you set up the objects in your database. A wizard will prompt you to add the information you
need. For example, the Query Wizard will ask questions that will help you decide what table (or tables) you
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want to work with, the fields you will use, and how you will display the output. Once you have created a query
with the wizard, you can modify it however you like.

To access the Query Wizard in Access:

1. Click on the Create menu and locate the command for Query Wizard.
2. Choose the type of query you want to build. In this case, we choose the Simple Query Wizard, as you can

see in Figure 13.19, which selects and displays specific records. This is the most commonly used query.

Figure 13.19 The Query Wizard can be used to create simple queries, crosstab queries, or queries to find duplicate or
unmatched records. (Used with permission from Microsoft)

3. Use the ≫ button to choose the table or queries and the fields you want to use in the query. You can add
from different tables or queries by changing the Table/Queries drop-down menu to choose a different
object to work with. When you are finished, click Next to move to the next screen (see Figure 13.20).

Figure 13.20 The Query Wizard allows you to select individual fields you want to include in your final query. (Used with
permission from Microsoft)

4. Once you have set up your query, you can name it on the last screen and choose whether you would like
to see the results of the query (View Information) or modify the design of the query (Modify Design). Then
click Finish Figure 13.21 to build the query.
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Figure 13.21 The Query Wizard allows you to title your query before finishing it. (Used with permission from Microsoft)

Editing Queries with the QBE Grid
Once a query is built, you can edit it using the QBE grid, which gives you the ability to look at a query and
rearrange, modify, and add to it, as well as the ability to run the query and see the results.

To open a query in the QBE grid, right-click the query in the navigation area of the screen, or to open the
query, click on the View command, and choose Design View, as Figure 13.22 shows.

Figure 13.22 The View command gives you a few different options for viewing a query. (Used with permission from Microsoft)

The QBE grid (Figure 13.23) allows you to interact with a query visually. It places the elements of the query on
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screen in order from left to right and gives you the ability to modify the format of the query. You can do the
following using the QBE grid:

• View, add, or change the tables used in the query
• Add or reorder fields
• Sort values returned by the field
• Choose whether a field is shown in the query (e.g., you may want to sort or use a field but not have it

appear in the results)
• Add criteria to limit the records returned by the query

Figure 13.23 Use the QBE grid to interact with or modify a query. (Used with permission from Microsoft)

Building a Query with the QBE Grid
Although the Query Wizard is a useful tool and a good way to quickly start a query, using the QBE grid gives
you more options for building complex queries. The QBE grid consists of a table that makes commands
available.
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In setting up the query, follow these steps:

1. Add tables.
2. Choose fields, one per column header.
3. Choose the sorting criteria.
4. Run the criteria to see results.
5. Return to Layout View to continue working.

To set a sort order, which will control the order of records displayed in the query, follow these steps:

1. View the query in Design View.
2. Locate the column you want to sort.
3. Click on the down arrow in the Sort row and choose the sort order (ascending, descending, or not sorted).

By default, the column is not sorted.

You can also set criteria here to control which records are displayed. Criteria are commands that are written
using symbols together with a text string that tells Access what you want the query to do. A criterion
statement has two parts: the criterion/operator and descriptive text. For example, in the criterion statement

= 100

the equals sign serves as the operator, and 100 is the descriptor.

There are several different criteria you can use within your queries. Some of the operations (criteria) are
displayed in Table 13.4.

Criterion Result

=
Returns values that are equal
=99 will return all values that are 99

>
Returns values that are greater than
>99 will return all values greater than 99

<
Returns values that are less than
<99 will return all values less than 99

Is null Returns records with empty cells (Note: “null” signifies empty, not 0)

“ ” Return records that are an exact match to whatever is between the “ ”

Like
Returns records that contain the value between “ ”
“Like gp” will return all values containing gp

Not
Returns values that do not match the criteria
“Not 100” will return all values that are not 100

Table 13.4 Display Criteria Using criterion statements adds power to a query. They allow you to build
complex queries that organize data in interesting and useful ways.

Databases can hold hundreds, thousands, and even hundreds of thousands of records. One way to limit the
results to what is relevant to your project or to the decision you need to make is to use criteria to limit the data
that a query returns. Limiting the results makes it easier for you to work with the data and helps ensure that
your decisions are both accurate and effective.
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Setting criteria can help you select specific items in an Access database by showing only items that match the
criteria you have set in creating the query. Individual criteria can be used in expressions, or statements, that
specify values to select or omit.

Using Tables in Queries
The query grid will open with a blank gray area, a blank table across the bottom of your screen, and a window
in which you can add tables. To add a table to the screen to work with it, double-click the table name or click
and drag it into the gray area (Figure 13.24).

You will likely want to work with more than one table at a time, as one of the reasons we use relational
databases is to be able to split our data into multiple tables and then combine them as needed, giving us
enhanced performance and flexibility. To work with multiple tables, drag them onto the screen or double-click
them.

If you have a query open in the QBE grid, you can add tables to the screen by right-clicking anywhere in the
table area and choosing the Show Table command.

Figure 13.24 Adding an additional table to the query grid view allows you to create queries that involve multiple tables, enabling you
to retrieve and analyze data from multiple sources simultaneously. (Used with permission from Microsoft)

Joining Tables
Splitting data into tables in a relational database like Access enhances database performance, which is a key
issue in working with very large datasets. It also increases flexibility by allowing us to chunk, or separate, our
data into smaller sets, which are easier to work with. Splitting up the data also enables us to avoid creating
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many null (empty) fields. (Imagine using a single spreadsheet to manage all your information—it would not be
useful, as it would have too many fields, and many of those fields would be blank.)

When using a relational database to separate data into smaller, ID-focused tables (e.g., a table including only
salespersons, another for clients), you need to join these tables based on key fields. In this example, you would
likely create a primary key, SalesRepID, on the sales rep table, and then include this same field as a foreign key
on the client table. You can then create queries that will join these tables by making sure that Access
understands the connection between the fields.

In fact, the ability to create and define relationships between tables is one of the most important functions of a
relational database. If you consider a database a set of data tables with relationships between them, Access
needs to be able to connect related fields between one table and another. It does so by means of the
connection or relationship known as a join.

A primary key, or unique key, is a field that uniquely identifies a record. As with an ID number, no two records
can have the same primary key. A foreign key field is a primary key field that appears in another table. We can
join foreign keys to primary keys to create a relationship between the two fields.

Recall that a join refers to the relationship between two fields in different tables. Access will create a
relationship or join when it sees a primary key field in one table and the same primary key used in another.
This is because Access understands that these fields have a relationship.

Joins appear between two fields in two or more tables in the query design screen. They are shown as lines
connecting the fields, which represent the relationship between the two tables as a one-to-one, one-to-many,
or many-to-many join. Access will create a join automatically when it recognizes the same field in two tables. At
times, however, Access will not recognize the relationship, or you may want to relate two fields for the purpose
of a specific query. In these instances—when we realize that two fields are related but that Access does not
automatically understand this—we can also create joins manually. For example, this happens when different
field names apply to the same field: A person may realize that CustomerNumber and CustomerID are the
same, but Access likely would not recognize this. In this case, it is our job to add the relationship, letting Access
know that these fields should be joined when we perform a query, as Figure 13.25 and Figure 13.26 show.
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Figure 13.25 Using joins in a query allows you to establish connections between fields in different database tables, enabling you to
retrieve and display related data by specifying how the tables are linked based on shared values or keys. (Used with permission from
Microsoft)

Figure 13.26 The Join Properties dialog box enables users to specify the type and criteria for joining tables in a database query,
defining how records from multiple tables are related and included in the query results. (Used with permission from Microsoft)

Types of Joins
There are two main types of joins: inner and outer. The type of join controls what data will display when the
query runs. In an inner join, Access looks at the common fields and data between the two tables and only
displays the matches, omitting any records from either table that do not match. The inner join is the most
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common type of join and is the default type for Access.

In an outer join, Access looks at the common fields and displays the related (matched) data plus the rest of the
records from a single specified table. You can use the Join Properties box to choose which table will have all its
records displayed.

As an example of an inner join, the sales and marketing database has a table with client information and a
table with sales invoices. Both tables include the field ClientID. These tables are related using the default join
type, the inner join.

Suppose the team at WorldCorp needs to see a list of all products with the clients that have purchased them so
they can share new sales information appropriately. The tables in Figure 13.27 include the fields ClientInfo and
SalesInvoices.

Figure 13.27 Access uses lines between tables to denote that a relationship exists between them. (Used with permission from
Microsoft)

After looking at what the team actually needs for the process, you decide to add the fields from ClientInfo,
including ClientID, ClientName, and ClientMailingAddressAll, and to use two SalesInvoices table
fields—ClientID and ProductID—to narrow the results to just the clients who have purchased specific products.

After creating a new query and adding both tables to the grid, you realize that Access did not automatically
create the join. You drag ClientID from the Client table to the matching ClientID in the SalesInvoice table. This
creates an inner join, which will return only the details for the records that match.

You then add the fields for the query into the query grid. Add the ProductID field first because it should appear
first on the screen. Then add the ClientID field, followed by ClientName and ClientMailingAddressAll.

Using these fields, as Figure 13.28 shows, you created a query that returns a list of each product, followed by
the clients that purchased it. By adding ClientID, ClientName, and ClientMailingAddressAll, the team can send
the correct mailings to the customers that have purchased these specific products in the past.
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Figure 13.28 A query can use joins to return lists with data from multiple tables. (Used with permission from Microsoft)

Creating Joins
To create a join in Access, you need to have both tables open on the query design screen. With the tables
open, click on the field you want to join in one table and drag it to the matching field on the other table. Access
will usually create an inner join, displaying only the records that match on both tables.

If you want to display the data differently, you can double-click the join line and change the type of join. To
change a join, double-click on the join itself in the query grid. The Join Properties box (Figure 13.29) will open.
In the box, you can change the tables or columns of the join and can also change the type of join relationship.
Sometimes it is helpful to modify the join on a dataset to see the results. The Join Properties box is helpful
because it gives you a quick reminder of the results you can expect from the join, using the names of your
tables.

Figure 13.29 You can change a join in the Join Properties box. (Used with permission from Microsoft)
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If you decide you do not want or need a join for any reason, you can click on the join line in the query layout
view and click Del on your keyboard. The join will be removed.

13.4 Maintaining Records in a Database

Learning Objectives
By the end of this section, you will be able to:

• Examine existing records in a database
• Construct new records to add to a database
• Update existing records in a database
• Demonstrate the process to delete records from a database

Most of the time, when employees maintain and work with a database, they access data that has been
provided to them from another data storage area, such as the company’s data warehouse. The tasks in the
analysis are to import the data, review the data to ensure that it is brought into the database correctly, and
then use the data. Sometimes, however, users need to complete other tasks to ensure that the database
processes the data correctly.

LINK TO LEARNING

Data integrity is a cornerstone of the digital organization. Without data that can be trusted, companies
cannot transform themselves to be successful in the digital world. Transformation comes with two data-
related problems—how companies store and access data and the quality of that data. For an overview of
these issues, read this article on data integrity in business (https://openstax.org/r/78DataIntegrity) and
think about the ethical requirements for the data professional and organizational leadership and how they
need to balance the quality, security, and accessibility of data within the organization.

Reviewing Records in a Database
It is possible to view records in database tables but be sure to not change the records.

In a table, records are shown on a datasheet, with each column equaling a field name (a value that all records
have) and each row representing an individual record. On the datasheet, there are commands that let you
move between records. You can also use the scroll bars to look at different parts of the table. Although using
the datasheet to view records can be useful in limited situations, databases typically hold a great deal of data,
so in general, querying the table will be a much more efficient way of finding the records you need (Figure
13.30).
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Figure 13.30 Reviewing records in a datasheet provides a broad overview of the data, while querying allows you to filter and retrieve
specific information that answers particular questions or meets specific criteria. Queries are used to extract precise and targeted
data from a database, whereas a datasheet presents a more comprehensive view of the data. (Used with permission from Microsoft)

REAL-WORLD APPLICATION

Data Flow Processes

Figure 13.31 Data flows through an organization’s information systems from collection to analysis.

Data moves across the data landscape from transactional production databases, including sales, customer
service, human resources, and other systems, to storage databases such as the data warehouse, which can
hold historical information (online transaction processing (OLTP)). Once housed in a data store, datasets
can be made available to databases like Access and spreadsheets like Excel for local use and analysis (online
analytical processing (OLAP)). Why would it be important to keep in mind how and when data was collected
from a production system when performing analysis on that data in Access?

If you need to look at records in Datasheet View, there are commands at the bottom of the screen that will
help you move between them. When a datasheet view is open, these commands appear automatically in
Access, on the bottom left side of the screen.

The record navigation buttons open any time that records are shown. As you work in the database, you will
see these buttons in Datasheet View and in certain form views. The command buttons include jumping to the
first or last record in the series, navigating one record ahead or back, and adding a new record, as you can see
in Figure 13.32. You can also add a filter or use the search feature to find a specific field value.
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Figure 13.32 Using the record navigation buttons to progress through a datasheet can save you a lot of time. (Used with permission
from Microsoft)

Constructing New Records
Databases are historical in that they record past details about an organization, but they also need to be
updated as time goes on. There are a variety of ways to update a database, including both manual and
automated updates. Most of the time, when you use Access, you will import a dataset or file from another
system, such as the organization’s data warehouse.

Adding a Record Manually
If you need to add a record into a database, you can either add the record to the table manually or import it
from another database. To add a record manually:

1. Open the table in Datasheet View.
2. On the Home tab, click the command New in the Records group.
3. Fill in the information, using Tab or the left and right arrow keys to move through the record.
4. Once you are done, use Tab or the up and down arrows to move to the next record, or press Shift+Enter

(or any version of Save that saves a record).

Importing a Record
Creating files that can be imported to other systems is a hallmark of a digital organization. When working with
Access, we are likely to import files from other, larger systems. Data is collected in business units across an
organization, and using that data is key to an effective business. Business units routinely transfer files between
systems, which in turn lets units analyze and create actionable information.

Most systems can create comma-delimited (CSV) files, which use commas as delimiters or breakpoints to tell
Access (or any other program) where data should be separated. CSV files can be read into most Microsoft
products and other popular software packages. There are also other formats designed for importing and
exporting files, which use another type of formatting to delimit, or separate, data.

Access can import a variety of file types, including Excel, CSV, and XML, as well as files specific to databases
and other systems or software products. Even so, CSV is one of the most common formats for data importing
(Figure 13.33).

Before importing a file, be familiar with the file and its contents. To make the import process easier, you may
want to rename fields so that they match in the file and the database.

Once your file is ready, you will likely want to import it to a new table so you can catch and correct any errors
without corrupting the data in your other data tables. Depending on the specific type of work you are doing,
you can either set up a table ahead of time or import the data into a new table.
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Figure 13.33 A CSV (comma-separated values) file is a plaintext file format commonly used for storing tabular data, such as
spreadsheets or databases. (Used with permission from Microsoft)

Note: Access has the ability to import data directly into existing tables manually through the Import command
and by connecting automatically with a database or system.

Follow these steps in importing a file:

1. With your database open, select the External Data tab in Access.
2. Choose the New Data Source button.
3. Choose the file type you want to work with—for example, text. A dialog box will open.
4. Select the file you want to import.
5. Choose the import type that fits best with your project. If you are concerned about an import, try

importing the data into a new table to be sure you have all of the fields and parameters set correctly.
6. Click on OK; the import screen will open (see Figure 13.34).
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Figure 13.34 Importing a file using the Import Text Wizard allows the user to select the correct format for their file. (Used with
permission from Microsoft)

7. The Import Wizard, which is a part of the import process, will open and ask you to choose how your text
file is structured. (Hint: Most text files are delimited, and CSV files use commas as the delimiting or
separating character.) Once you choose whether the file is delimited or fixed width (broken up based on a
certain number of characters), click Next to continue.

8. On the next screen, set your delimiter (comma for a CSV file) and click the first row that contains field
names (assuming your first row is titles or labels). Then preview the data and, when you are sure it is
correct, click Next to move to the next screen. See Figure 13.35.

13.4 • Maintaining Records in a Database 899



Figure 13.35 For files that use a delimiter, the Import Text Wizard requires that the user define which delimiting character is used.
(Used with permission from Microsoft)

In the screen that appears, you can change field names and data types, if necessary (Figure 13.36). Once you
are ready, click Next to continue.
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Figure 13.36 The Import Text Wizard allows you to specify various field properties, such as name and data type, before importing the
file to Access. (Used with permission from Microsoft)

The Import Wizard will ask if you would like to set a primary key or have Access set it for you. Make your
choice, as seen in Figure 13.37, and click Next to continue.
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Figure 13.37 You should select a primary key for any imported tables. This primary key can serve as a unique identifier for each
record in your database. (Used with permission from Microsoft)

The final Import Wizard screen will allow you to name your new table. Be sure to use a descriptive name that
distinguishes it from the tables you already have in the database.

When you are done, click Finish to view your new table. If your table has errors (e.g., if data cannot be
imported because of mismatches in the field type), a new table containing the errors will appear in your list, as
Figure 13.38 shows. If you find any errors, you may want to delete your imported tables and walk through
these steps again.

Figure 13.38 A table with errors will still be imported, but the errors will be identified in a new table with the phrase “ImportErrors” in
the title. (Used with permission from Microsoft)
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LINK TO LEARNING

Data management is a bigger concern than just tables and fields—data professionals at all levels need to
understand the data landscape and how organizations can manage it. This article on data lineage
(https://openstax.org/r/78DataLineage) provides an overview of some of the challenges and considerations
in data management.

Editing or Deleting an Existing Record
Once you locate the record you want to update, you can edit it. To edit a record:

1. Open the table in Datasheet View (or Form View).
2. Click on the field you would like to edit.
3. Place your cursor where you want the information to appear.
4. Enter your text.
5. Use Tab to move across your record.

As you work, Access will save your changes whenever you move your cursor from one field to another. If you
want to save the record manually to be sure your data is saved, you can either click the Home tab then click
Save in the Records group, or press Shift+Enter on the keyboard.

When you are updating a record, you may see symbols appear that share the status of that record, as Figure
13.39 shows. As you manually edit records, pay attention to these data entry symbols.

Figure 13.39 These are some of the common icons you will use in data entry. (Used with permission from Microsoft)

Deleting a Record
If you need to delete a record or set of records for any reason, you can do so through either the datasheet or
the form.

1. Open the table in Datasheet View or Form View.
2. Select the record by clicking on the record selector. To select multiple records, either click and drag across

record selectors or use Ctrl+Click.
3. Press Delete or select Home>Records>Delete.

13.5 Creating Reports in Microsoft Access

Learning Objectives
By the end of this section, you will be able to:

• Understand why reports are useful
• Create and edit a report using the Report Wizard
• Customize a report by adding images and text
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Databases are useful only if they enable us to transform data into information that will be ready for use when
it is needed. Although queries are helpful in extracting the data that we need and even transforming it into
actionable information, most decision-makers will need more refinement, formatting, and preparation before
the data is ready for use.

Recall that a report is a formatted display of information designed for a specific use case or project. Reports do
more than summarize information; they also create the foundation for making sound decisions. When we
combine queries with formatting, we create reports that we can use in our work.

Using Reports in a Database
Reports are a cornerstone for business decisions. We can generate reports within a database for a specific
request, and we can also set up reports to provide summaries and information that we will need on an
ongoing basis. Access enables us to set up reports (e.g., a financial, sales, or summary report) that we can then
access as necessary for decision-making. Companies routinely run reports on key performance indicators
(KPIs) that show an organization’s effectiveness, efficiency, quality, economics, project performance, resource
use, and personnel and workforce performance. Companies also routinely look at revenue, profit, and
customer and employee satisfaction. Because tables filled with data do not adequately describe KPIs,
businesses rely on reports as part of their evidence-based decision-making.

Tables are extremely efficient ways of storing data, and using a relational database with connections across
tables is an effective way of building information storage. Unfortunately, however, tables do not display
information in ways that people easily understand. We can manage this by creating reports—formatted,
attractive displays of information. Reports use combinations of labels, values, and even graphics to present the
results of a query in a way that supports action. Once designed, a report can easily be reused or copied and
revised. Like other objects such as queries and forms, reports will show the most up-to-date information each
time the database changes. Among the many reasons to generate reports are the need to create summary
reports, to save snapshots of data, and to provide detail about specific customers or products.

Consider this example. Anna, an analyst in the sales and marketing group at WorldCorp, has been asked to get
data ready for a meeting with sales representatives. The meeting will focus on products that are on hold, and
the representatives will need to identify wholesale companies that may be interested in these products. Anna
begins by determining what the sales representatives will need for the meeting and the level of detail they will
want to have available for decision-making. She then looks at the available data and decides how to create the
report. Anna’s final report includes two sets of information—the list of on-hold products and the list of
wholesalers who have shown an interest in those products. Therefore, she creates two versions of the report:

• List of on-hold products with a list of interested wholesalers for each product
• List of wholesalers with a list of on-hold products that may be of interest to each wholesaler

Anna sends the final report to the person in charge of the meeting for review and comment.

Tips for Effective Reports
The way you design a report will depend on the data it will include, the audience that will use the report for
decision-making, and the way the data will be used. Reports can be as brief as a few lines of summary text, or
they can be highly detailed spreadsheets or within datasheets with many rows of records. The key to building a
useful report is communication—your communication with the audience that needs the report, so you
understand them, and the communication of the information to the audience so they can use it.

Effective reports should utilize the headers and footers of a report and its pages to aid the reader when
navigating the report. Headers and footers should contain useful information such as the report title, author,
and page numbers. This makes it easier for a report reader to quickly find the information they are looking for
across multiple reports.
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LINK TO LEARNING

Data is only good to the extent that it is both accurate and actionable. Raw data without any use is just
clutter. With this in mind, watch this video on how to make data actionable (https://openstax.org/r/
78DataAction) and consider how reports can summarize large amounts of data and make that data
actionable.

The goal of a report is to eliminate as many individual lines of information as possible and to simplify
information through summary wherever you can. In general, consider the following when preparing effective
reports:

• Minimize line-by-line data
• Use labels to explain the data that is shown on the report
• Use formatting to designate titles and other labels
• Incorporate white space to ensure readability
• Test with possible audience members to be sure the report makes sense to the final audience
• Focus on answering specific business questions generated by the person or people who request the

report

Organizing a Report
A report can be flat, with one record per line, or you can use grouping to further organize the data. When
designing a report, think about organizing your data as follows:

• Sorting to order your data by an important field (e.g., Name), when you are discussing customers or sales
region

• Grouping records based on a field, such as active versus inactive products, regions that met specific
targets versus those that are lagging in meeting goals, or geographical area

• Totaling groups of data, such as sales figures, to show both the detailed figures (e.g., an individual
salesperson’s sales figures) and the figures for the overall region

Access will allow you to quickly add and preview sorting, groups, and totals to ensure the report communicates
what you need it to for the audience you are working with.

Creating and Editing Reports with the Report Wizard
WorldCorp is interested in creating a summary of their recent sales data for their latest product line. The
report should include useful information such as which products have the highest total sales, which products
have the highest net profit, and which customers are purchasing the most products. WorldCorp could create
this report from a blank canvas, but it would be much easier to generate a report using the Report Wizard. This
is a small program that will walk you through the steps of setting up a report, which you can then modify to
meet your needs.

Using the Report Wizard is usually an efficient and easy way to start a report. Most reports will need some
form of customization, but the Wizard will provide a good starting point and will save steps by adding fields
that are bound to the database.

Creating a Report
To start a report with the Report Wizard, click on the Create menu in the ribbon and then choose the Report
Wizard command from the reports section. The Wizard will walk you through each question before creating
your report.

Step 1: In step 1 (Figure 13.40), you can set the table(s) and/or queries you want to work on within the report.
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This gives you flexibility, as you can use data from more than one table or query in your work. (Hint: Consider
setting up a query for your report before starting the report. This will enable you to check the data before
setting it up for display.) Once you have chosen and added tables, queries, and fields to the report (use the >>
button to move fields to the selection box), click Next to move to the next screen in the Wizard.

Figure 13.40 The Report Wizard allows you to select fields to include in the report. (Used with permission from Microsoft)

Step 2: In step 2 (Figure 13.41), you can choose grouping for your report. (Skip this step if grouping does not
make sense for your report.) A group is a heading that organizes data with something in common. For
example, you might group data based on the region a customer is assigned to. When used as a group, all
customers belonging to a specific region will appear together. Once you set up grouping, you can click Next to
continue.

Figure 13.41 In this example, grouping by product ID has been used, creating a report that first lists each product, with the client
info of every client who has purchased that product listed under the ProductID. (Used with permission from Microsoft)

Step 3: Step 3 of the Report Wizard asks how you want to sort your records, as Figure 13.42 shows. Access
allows you to sort by up to four fields in the designated order. For example, to create a report that fits the
needs of your audience, you may want to sort a set of records by sales region in alphabetical order and then
sort further by product ID. Once you set up sorting, you can move to the next step in the Wizard.
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Figure 13.42 Using the ClientID field with the Report Wizard allows you to sort records in ascending order, from smallest to largest or
from A to Z. (Used with permission from Microsoft)

Step 4: After you have set the sort order, the Wizard will ask you to choose the layout for your report (Figure
13.43). You can also set the orientation and ask Access to adjust all fields to make sure they fit on a page.

Figure 13.43 Setting the report layout in the Report Wizard allows for limited customization of the final report. (Used with permission
from Microsoft)

Step 5: The final step in the Wizard allows you to set a unique title for your report and then choose whether
you want to provide the results or go into design to modify the report (Figure 13.44). Usually, viewing the
report will be useful, as it will show you what you want to change. When you are done, click Finish to continue
the work.
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Figure 13.44 Setting a name for the report is the final step before Report Wizard generates a preliminary report. (Used with
permission from Microsoft)

Reviewing a Report
When you double-click on a report in the navigation area, the report will open with current data displayed.
Let’s look at a simple report in Figure 13.45: a listing of all product categories.

This report, named ProductCategoryList, was created quickly by clicking on Create and then Report.

Figure 13.45 The report generated by the Report Wizard is well organized and easy to read. (Used with permission from Microsoft)

The title at the top of the report shows the date the report was run, followed by two columns that list the
product category ID and the description. This report is set up by Access and has not been modified. In Design
View (Figure 13.46), this report appears differently, with the design and grid available for modification. This
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report is usable as is but taking a few minutes to customize it will make it more useful for your audience.

Figure 13.46 Access allows you to fully customize the layout and content of a report depending on your specific needs. (Used with
permission from Microsoft)

In Design View, the report header appears on the first page and includes the title and dates of the report. This
is followed by the page header which appears on each page and includes information useful to the report
user, such as page number or report author. The report detail is the area where data from the database is
displayed for each record. Each record will show the product category ID and description. The report has a
page footer, which displays useful information, such as the page number, and appears on each page. The
report footer shares the number of pages in the entire report. As you build reports, you will likely switch back
and forth between the Report View and Design View to change elements such as spacing and formatting so
that your report is useful for your audience.

LINK TO LEARNING

Personal and company data needs to be safeguarded, and reports that summarize data related to projects
and goals also need to be protected. Therefore, one of the responsibilities of anyone dealing with data and
reports is data security. To this end, governments have put laws and procedures in place to guide how
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organizations manage data and reporting. This article on data privacy laws (https://openstax.org/r/
78DataPrivLaws) provides an overview of some of the laws in this area.

Customizing Reports
Although Access does a nice job of starting a report, you will likely want to modify reports before using them.
Following are some of the changes you may want to make:

• Changing the size of fields (e.g., shortening them)
• Formatting the text of the report (e.g., by adding boldface)
• Shifting text boxes to lay the screen out more effectively

Page Layout View
Page layout view gives you a simple way to make changes to the overall appearance of a report. Changes
made to a field in page layout view will be applied to all fields of the same type (e.g., if you boldface a field, all
fields of the same type will also be bold). Page layout view displays live data while you make your changes,
which makes decision-making easier.

To enter Layout View, click on the View command on the Home tab while you have a report open on the
screen. You can preview the report by changing to the report view. When you are finished working, save and
close your report.

Design View
The Design View screen has more options for customizing your report. To switch to Design View, use the View
command on the ribbon.

Design View gives you a layout grid for your form and the ability to move each label and field independently,
change the formatting of the text, and even change the attributes for each element on the report.

A common change in Design View is modifying the size of the field on the screen. For example, you may find
that Access cuts off some of the label or content in a field. You can modify the size of the field or label by
clicking on the element and then using the selection handles on the left and right sides to stretch or shrink the
element.

You can also move elements manually by clicking and dragging them or by clicking on multiple items and
using the commands on the Arrange tab on the ribbon. These commands allow you to move items up or
down, arrange them together, or control how the elements are arranged on the report itself.

Adding an Image or Custom Text
You may want to include a logo or even a disclaimer as an image in a report. These images can add
information or (as in the example of a logo) provide identification. Images typically appear at the top or
bottom of a report. Remember that if you place an image in the detail section of the report, it will repeat for
every line. (This is useful when you want to have each line start with a symbol or logo.)

To add an image in Design View, click on the Form Layout Design tab and choose the image that you want to
add. You can also add any image to the page by clicking Insert Image (see Figure 13.47) and then locating the
image file. Again, be aware that when images are placed in the detail section of the form, they will repeat for
every line. If you would like the image to appear only at the top or bottom of a page, place the image in the
page header or footer.

You may want to add elements that are not strictly images but display on the report (e.g., titles, dates, and
times). Note that these items will be displayed on the report but will not be stored in the database; they will
change each time you open the form.
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Figure 13.47 You can export selected Access objects to an Excel worksheet. (Used with permission from Microsoft)

When you create and modify a report, Access will prompt you to name and save it. Each time you modify an
existing report and close it, Access should prompt you to save it. You can save manually by right-clicking on the
name of the tab in the work area and choosing the Save command.

To close a report that is open in the work area, click on the X next to the tab name.

13.6 Creating Forms in Microsoft Access

Learning Objectives
By the end of this section, you will be able to:

• Understand why forms are useful
• Create and edit a form using the Form Wizard
• Customize a form by adding images and text

Relational databases are built on a structure of tables; each table is made up of columns, which hold fields,
and rows, which hold the information for each field for a specific record. This is an effective structure for the
organization, but as the database becomes more complex and we use joins in queries to create relationships
between data across tables, we need an easier and more manageable way to work with the database. Using
forms to interact with our database tables has two benefits:

• Forms provide an easy way to interact with the database.
• Forms protect the data and underlying table structure from accidental changes.

Most websites are based on databases and use forms to connect to the database. In fact, online shopping sites
use a combination of forms, preset queries, and reports to create a positive user experience. Forms are the
pages themselves, which allow us to search and retrieve information (e.g., a product listing) by running preset
queries and returning detail in either a form or report format. When we look at a website, we do not see the
underlying data tables; we see forms and the results of queries based on forms or formatted as results.
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Using Forms in a Database
Forms are objects that are positioned between the data and the individual user. When individuals work with a
database using forms, they do not see the table structure with thousands or hundreds of thousands of
records. Instead, they see only a specific view designed to make the data accessible and useful for them.
Forms are typically bound to the database, which means that the fields within the forms are the same fields as
in the database, and any changes in either the form or the table are reflected in the other.

You can also create an unbound form containing buttons and commands that allow an individual to access the
database but that does not display any information. An unbound form is likely to be used as an interface to the
database and can create a “home page” that makes it possible for someone unfamiliar with the database to
easily access and use what they need.

If you were going to build a database that was simple and used only by you, you might not need a form. Even
so, a form would make it easier for you to navigate, interact with, and complete tasks. You could build a form
that would let you automate tasks that you perform often, like updating inventory. For a single person
accessing a database, forms make work more efficient, although they may not be critical to success.

When a database needs to be used by many people, including some who are relatively unfamiliar with the
database or with database technology, forms are a critical tool. They provide both an interface to the database
and a way to navigate and access data that is pleasant to use, makes sense, is designed for the specific use
case, and enables anyone to use the database while ensuring data integrity and security.

The sales and marketing group at WorldCorp has asked you to set up a database that the team can use to look
at sales figures for different time periods based on products. The team is not familiar with Access or with
databases in general and does not want to spend time learning the technology. Instead, they want an easy-to-
use interface that will allow them to search and retrieve summary data. You already have a database with all
this information that is ready for use, but it was not designed for the sales and marketing team. You decide to
create a form that will allow the team to add a date range and a product type, then return a summarized
report showing the necessary sales.

You build a form with this function and then add text that explains the purpose of the form and how to use it.
Once the form is finished, you create a dashboard for the team that allows the team to choose this specific
form by clicking a labeled button. After you have built and tested the forms, you alert them to the new
function. This gives them a powerful new way of looking at sales data and retrieving the information they
need, when they need it, in a format that works for them—all without needing to modify the database or its
objects.

SPOTLIGHT ON ETHICS

Addressing Data Security Risks

Employees who work with data need to be aware of data security and able to manage security issues.
Nevertheless, many employees may not be aware of the risks that their behavior poses to personal and
business data. Even as we work to increase technical security, employees’ irresponsible or unethical
behaviors may put their own, their coworkers, and even the organization’s data at risk. According to Forbes,
risks to consider include the following:

• Social engineering vulnerabilities: The risk of employees being tricked into revealing credentials or
installing malware through tactics like phishing attacks.

• Unmanaged IoT devices: The challenges posed by the increasing number of unmanaged Internet of
Things (IoT) devices, which lack proper policies and controls.

• Lack of awareness: The risk associated with employees’ inability to detect frauds, scams, and phishing
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emails, emphasizing the need for strong security awareness training.
• Data loss: The importance of adopting a data-centric approach and implementing data loss prevention

measures to safeguard data and ensure compliance.
• Personal data accessibility: The need to ensure that customer data is only accessed by authorized

individuals through proper security protocols.
• Managing the increasingly complex digital business environment: The difficulty in consistently

following security rules in a growing and complex digital landscape.
• Insider threats: The significance of paying attention to insider threats and ensuring that employees and

other individuals with access to corporate data do not misuse their privileges.
• Insecure applications: The risk associated with applications storing and transmitting sensitive data,

especially through insecure application programming interfaces and third-party channels.
• Untrained end users: The vulnerabilities arising from employees who fall prey to phishing emails,

download malware, or mishandle confidential data, emphasizing the importance of ongoing training.
• Consumer trust in data repositories: The impact of data breaches on consumer trust and the need for

comprehensive asset audits and robust segmentation to mitigate such threats.
• Third-party risk: The importance of evaluating and securing third-party relationships to prevent data

from being exposed to a wider network.
• Overestimating the ability of network defenses to ensure data security: The need to protect data within

applications through encryption, authentication, and secure key management, rather than relying
solely on network defenses.

• Misconfigured cloud servers: The risks associated with misconfigured servers in cloud environments
and the need for automated security solutions to identify and remediate misconfigurations.

• Lack of data access oversight: The risk posed by granting employees and contractors excessive data
access privileges, necessitating continuous data classification and auditing efforts.

Addressing these risks is crucial for businesses to protect their data, minimize potential financial losses, and
maintain customer trust and confidence.

Types of Forms
As mentioned, you might decide to create a form as a user interface or a form that accesses and displays
information. A form that acts as an interface is likely to be unbound (meaning it is not connected to any
specific table or database query) and to include a combination of text, images, and command buttons that
access certain objects in the database. These forms can also include search fields if that function is valuable to
your audience.

In a bound form, the fields are linked directly to objects in the database. We use bound forms when we want
to access data in tables or through queries. Remember, any modification to a field value in a form also updates
the underlying data in the table.

Here are some common forms that you can create in Access:

• Simple form: a form that displays and allows editing of a single record at a time.
• Split form: a form that has two functions; for example, it might display a single record as well as a view of

the datasheet in which the record is held. A split form is useful when you need to see the larger set of data
but work with only one record at a time.

• Multiple-item form: a form that displays information about more than one record or item at a time. It
appears like a datasheet but allows you to add commands, format text, and add other controls.

• Navigation form: a form that allows you to add formatting, text, and commands to act as an interface, or
navigation area, for your database. (These are typically unbounded forms.)
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Tips for Effective Forms
Creating useful and effective forms requires a clear understanding of the data you have, the audience that will
use the form, and the use case for the data. Good forms are more than just boxes on a screen; they
demonstrate an awareness of how people will interact with the data and use it on a daily basis. A good form
should anticipate user expectations and adapt to meet them. For example, using white spaces to separate
information into useful blocks can make it easier for the reader to quickly navigate the form. In addition, you
can use the form to control what users can enter into fields. Customers should not be able to enter in numbers
as their name for example. To ensure data integrity, you should consider restrictions on what can be entered
into forms. If you are using free-form fields, those filling out the form could really put in anything they want,
resulting in unusable data for your organization.

Here are some tips for creating effective forms:

• Label your fields (to the left or above the point where data will be entered or viewed).
• Do not use spacing in field names.
• Stack your fields on top of one another to increase readability.
• Mark required fields with an asterisk (*).
• When there are more than five or six choices, use a drop-down menu.
• Break forms into steps if you have many fields to fill in.
• Adjust field size based on the length of the answer.
• Keep related areas on the form together (e.g., all name fields should be together).
• Offer ways for people to get help (including instructions, email addresses, and phone numbers).
• Keep the form as brief as possible; make sure the size fits the use of the form.
• Use white space (blank space) on your form to help your users understand and work with the form

comfortably.
• Test your form with different people in the target workgroup and on different technology when possible.
• Do test prints with PDF files to see if records will be visually attractive if saved.

Creating and Editing Forms with the Form Wizard
You have several options for creating forms in Access. You can use the Form Wizard, which walks you through
the steps to set up a simple form. Alternatively, you can use a preset form, or you can work entirely in Design
View, where you have complete control over your layout and contents. Each method has its benefits, and many
people use a variety of techniques (e.g., starting with the Wizard or another type of form, then customizing
your form in Layout or Design View).

The Form Wizard gives you a quick way to create a form that you can later modify as needed. Like other
Microsoft Office Wizards, the Form Wizard asks you a series of questions and uses your responses to format
the desired object.

Creating a Form
To start the Wizard, click on the Create tab. Then, in the Forms group, click on Form Wizard. Once the Wizard
opens, walk through each screen, making choices at each step to design and complete your form.

Step 1: Choose the table(s) and fields you want to appear on the form. Move fields to the form by clicking on
the >> button. Note: To use fields from more than one table, switch tables while on this screen and move the
appropriate fields to the right using the >> button (see Figure 13.48).
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Figure 13.48 Using the Form Wizard, you can select fields to include in your form. (Used with permission from Microsoft)

Step 2: Choose the layout you want for the form and click Next:

• Columnar layout shows a single record set up on the screen.
• Tabular layout creates a listing of all records in columns, similar to a datasheet (but formatted

differently).
• Datasheet layout gives you a list of records as they would appear in a datasheet.
• Justified layout creates a record-by-record form, arranged across the screen.

Once the form is built, you can modify it to ensure it looks the way you feel is best for your data and audience
(see Figure 13.49).

Figure 13.49 You can modify the layout of a form using the Form Wizard. Some data will lend itself to one format over another. (Used
with permission from Microsoft)

Step 3: Enter a unique name for the form and choose whether you want to see the form in design or view
mode. Click Finish to create the form.

Forms can also be built from any table or query or a combination of both. One way to streamline setting up a
form is to set up a specific query with the fields you want to be displayed on the form. Once the query is ready,
you can do the following:
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1. Click on the table or query from which you want to build the form.
2. Click on the Create menu, then click the Form command. Access will create a form and open it in Layout

View for review and modification.

Using the More Forms Command
If a simple form does not provide what you need for your database, consider using the More Forms command
on the Create menu. This command offers four form types, built directly on the table or query you click on in
the navigation pane.

To use the More Forms command:

1. Click on the table or query on which you want to base your form in the All Access Objects navigation area.
2. Click on the Create menu and then the More Forms command under the Forms section.
3. Choose the type of form you want to work with. Access will immediately create the form, which you can

then modify to suit your needs (see Figure 13.50).

Figure 13.50 You can select the type of form you wish to create using the More Forms command. (Used with permission from
Microsoft)

Reviewing a Form
Regardless of the method you use, once your form is created you can view it either in view mode (which shows
how your audience will view the form) or in Layout View or Design View, which allows you to modify the form
(see Figure 13.51). To change your view, click on the Home tab and then on the View command. Under the View
command, choose one of the following:

• Form View: to see how the audience will view the form
• Layout View: to modify the layout and formatting of the form
• Design View: to modify any and all attributes of the form

Figure 13.51 As with viewing reports, there are three different options for viewing a form. (Used with permission from
Microsoft)

The forms that Access builds can be used as is, but you will often want to add to a form or slightly adjust its
formatting. You can do this in two views: in Layout View, which allows you to change the overall layout and
formatting, and in Design View, which allows you to change any attributes in the form.

When you edit a form in either Layout View or Design View, you will have the ability to work with fields and
controls. Fields are columns within the database where data is stored. You can add and remove fields from
your form to ensure that you display the data you need to your audience when they work with the form. Fields
in the form reference field values in the database and display information from the database. When you are in
Layout View, you can see this as you work; in Design View, you will see the design elements but not values.
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You can also add controls to a form. Controls are items that are part of your form and can enhance its usability.
Bound controls are connected (or bound) to a specific field, table, or query in your database. Unbound controls
are not tied to the database but exist only in your form, where they run a specific command or action or
display specific information.

Some common controls in Access include text boxes (see Figure 13.52), labels, buttons, and links. Each of these
controls adds functionality to your form. You can add a command to open a form in Design View by clicking on
the specific command in the Controls group on the Form Design tab in the ribbon.

Depending on the control you add, you may need to work with the Control Wizard, complete a screen, adjust
properties, or complete the control on screen. When you begin working with forms in Access, you may work
with the Control Wizard and then preview the form in the View menu to see how the control works in practice.

Figure 13.52 Adding controls to a form can be easily done with the Control Wizard. (Used with permission from Microsoft)

Note that in Access, a text box is typically linked to a field in a database. To add static text to a form, you should
instead use a label. Labels do not change on the form based on the data within the database, unlike text
boxes.

Customizing Forms
In both the Layout View and the Design View, you can customize elements of the forms to meet your needed.
This goes beyond simply adding, reordering, or removing fields from your form. You can change the size of the
field and the caption that the users see for that field. In the Design View, you can change the size of the fields
by simply clicking on the field box and resizing the box. To change the caption for the field, double-click on the
text in the field, and the Property Sheet screen will appear on the right side of the screen. Conversely, you can
simply click on the Property Sheet tool in the Tools command group on the Form Design tab to change the
captions. Through the Property Sheet tool, you can also adjust items such as the font, color, background color,
and border of the fields in the form. You can adjust these settings for each field independently. This means
that one field could have different settings than another field. More is covered about the Property Sheet
options in the following section.

You might want to add header or footer information to your form. Typical information contained in a form
header would be specific company details such as the company logo, address, and contact information.
WorldCorp has standard header information that should be included on all files as was covered in previous
chapters. This information is customized on the form through the Form Design tab and the Header/Footer
command group. You can have text, images, and the date and time added to the header. This information can
also be added in the same manner to the header. To adjust the text, simply click on the existing text in the
header or footer and replace with the text you want to include. Note that Access will give a header to the form
based on the name of the table used to create the form. You will likely want to replace this header with
something more descriptive. For example, if you are creating a form based on a table called “Sales Data,” the
form header will be “Sales Data” as well. You could replace that with something like “Sales Data for Region 3,
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2023.”

In summary, customizing forms in Access is similar to customizing reports, which we covered earlier in this
chapter. You can generally customize just about every aspect of the form from the font, to colors, to adding
images, and other related aspects.

Layout View
The Layout View screen gives you a good look at your form, with real data showing on the screen. This enables
you to modify the screen’s visual appearance, including the size and placement of controls. Not all tasks are
available in Layout View; depending on your goal, you may find that you need to change to Design View.

To modify a form in Layout View, start by opening the form in Layout View. Then, proceed as follows:

1. To add a field, click on the Format tab in the Controls group; then click Add existing fields and drag the
field to the form.

2. To move a control, click on any instance of the control and drag it to a new location. (Note: You will have
limited options for moving a control.)

3. To resize a control, click on the control, select its border, and click and drag until it is sized properly.
4. To add an image to the page, click on the Insert Image command on the Controls group and choose the

file. Once the image is on the form, you can move and resize it.

These are only a few of the options available to you in Layout View; to see more options for customizing your
form, hover over the command on the ribbon and read the description. Remember, what you see on screen in
Layout View reflects the final form, making it easier to set up a form that meets your needs and has the
appearance you feel works best for your data and your audience.

Design View
If you find that you need to make changes to a complex form, you will likely want to switch from Layout View
to Design View. The Design View screen gives you complete control over the appearance of the form but is
more complex to use. You may want to use Design View for tasks such as moving elements and controls,
adding images, adding simple controls, and changing form properties.

In Design View, you will see tabs that control how you lay out the form. You may also see floating menus and
boxes that appear depending on the items you click on:

• The Design tab contains commands that control the overall design scheme (colors and fonts), controls you
can add to the form, and commands that allow you to insert items and change properties of items on the
form.

• The Arrange tab contains commands that allow you to line up items; insert, move, and arrange items; and
manage the layout of items on the page. (Note: This tab may not be available unless you select more than
one item, such as an image or a control.)

• The Format tab contains commands that let you format the text on the form and add background images
and formatting.

To move items manually, click and drag them or click on multiple items and use the commands on the Arrange
tab on the ribbon. To move a single item (control, image, text), click and drag the item. To move more than one
item, hold down Control, click on each item, and then move all of them at once.

Adding an Image
It can be beneficial to add an image, such as a logo, to a form for customization. You may also create a text
explanation or block of text in a graphics program and then insert it into the database as an image.

To add an image in Design View, click on the Form Design tab and choose the image that you would like to
add. You can add any image to the page by clicking on Insert Image and locating the file (be aware that if you
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insert an image in the detail section of the form, it will repeat in each row). To add a logo, click on Logo in the
Header/Footer group and the image will appear at the top of your form, in the header.

In addition to images, you can also add a title or date and time in the header/footer section of the form. These
items will be displayed for your users but will not be stored as data in the database.

Changing Form Properties
Properties describe how a form control or field acts in a form. Form controls determine how the form works.
There is a long list of properties that you can control; initially, you will likely only change basic properties such
as the width of a screen or the addition of scroll bars (see Figure 13.53).

To change a form property:

1. In the open form, click on the command Property Sheet (Form Design, Tools group). The property sheet
will open.

2. In the property sheet, verify that Form shows as the selection type.
3. Modify the properties you would like to change, and click on the category of property you would like to

work with (e.g., you might want to format items on the form).

Here are a few examples:

• To add a caption to the form, click on the Format tab within the property sheet and add caption text.
• To change the default view, click on the default view and switch the type of form.
• To control the width of the form, set the width in the width row.

13.6 • Creating Forms in Microsoft Access 919



Figure 13.53 Each form contains a number of properties that can be edited and customized depending on the purpose of the form.
(Used with permission from Microsoft)

When you create a form or modify an existing form, Access will prompt you to name and save it. You can save
manually by right-clicking on the name of the tab in the work area and choosing the Save command. To close a
form that is open in the work area, click on the X next to the tab name.
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Chapter Review
Key Terms
analytical database a database used by an organization for analytics and decision-making
columnar layout a form layout that shows a single record
criteria expressions that a database management system uses to limit the results of a query based on

matching field values
dark data data that is typically not used for analysis and therefore may or may not be valuable to an

organization
data lake a place to store data that keeps raw copies of the original documents
data landscape the entirety of data storage and sharing in an organization
data mart a subset of a data warehouse, optimized for specific workgroups or functions
data warehouse a large store of data within an organization, often holding historical information and used

for decision-making
database a structured set of data stored in a way that allows us to make use of it
datasheet layout a form layout that lists all records as they would appear in a datasheet
Datasheet View view that shows the result of a query in table form
Design View view that shows a query in the form of a QBE (query by example) grid
development database a database used for experimental testing so that problems can be found and

resolved before being pushed to the production database
digital database a computerized file that stores data in a structured or organized way and also allows users

to make changes to transform data
digital platform a place where users can interact with and explore the products and services offered by a

company
flat files individual digital files that have a tabular structure, such as spreadsheets, tables, and lists
group heading that organizes data items that have something in common
join a clause used to create a relationship or connection between two records in a table
justified layout a layout showing a record-by-record form, arranged across the screen
key field a field in a table that serves as a unique identifier for an individual record in a table
multiple-item form a form that displays information about more than one record or item at a time
navigation form a form that allows you to add formatting, text, and commands to act as an interface, or

navigation area, for your database
NoSQL database database that stores large amounts of data, including documents and images, in their

original format, not in tables
object an item in a relational database
page footer the bottom section of a document page, which typically repeats across pages and contains

information useful to the report reader
page header the top section of a document page, which typically repeats across pages and contains

information useful to the report reader
predefined queries queries used to answer frequently asked questions that meet specific organizational

needs
production database a database that runs transactions related to an organization’s core business functions
query a structured data request
record navigation buttons options that open whenever records are shown, enabling users to execute

commands in a database
relational database a database whose design and structure enable it to communicate with other systems

that hold data
relational database management system (RDBMS) computer software that provides the functions for a

relational database
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relationship the association between two or more tables based on common fields or columns. It represents
the way data is related and connected across different tables within the database

report formatted summary of specific information in a database
report detail the area where data from the Access database is displayed for each record
report footer the bottom section of a report that does not typically repeat across pages and contains the

name and dates of the report
report header the bottom section of a report that does not typically repeat across pages and contains the

number of pages in the entire report
simple form a form that displays and allows editing of a single record at a time
single point of truth (SPOT) the idea that there is one place storing information that all business units agree

is factual
split form a form that has two functions; for example, it might display a single record as well as a view of the

datasheet in which the record is held
SQL View a view that shows a query in structured query language form
structured query language (SQL) language used to create and run queries in many relational databases
table the structure that holds individual data records in a database
tabular layout a form layout that shows all records listed in columns, similar to a datasheet
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Summary
13.1 What Is a Database?

• Databases are storage areas for data, small bits of information that are collected all around us.
Organizations typically have production systems, which run and store the transactions necessary for the
organization itself, and analytical systems, which store historical data that can be analyzed and used for
business intelligence.

• Databases consist of objects, including tables, queries, forms, and reports. These objects can be used for
data manipulation and for applications within a business.

13.2 Microsoft Access: Main Features and Navigation
• Access is a relational database management system that can work with other systems.
• Access contains typical database objects such as tables, queries, forms, and reports.
• Closing and saving your work in Access is an important process, as only one database can be open at a

time.

13.3 Querying a Database
• Queries can return data from one or more tables and can sort, limit, or calculate values from tables. SQL is

a universal language used for queries; however, it is not necessary in Access.
• Access queries can be set up using either the Query Wizard or the QBE grid.
• Joins, representing relationships between fields across tables, can be created, changed, or removed.

13.4 Maintaining Records in a Database
• Microsoft Access can be used to locate and review records.
• You will likely add records to a database by importing from other data sources.
• It is possible to edit or delete records in a database, but these functions are less common.

13.5 Creating Reports in Microsoft Access
• Reports compile and summarize data in actionable, useful formats that can be used for business decision-

making. Reports update with current information each time we open them and can be modified to show
only the information most useful to a reader.

• We can use the Report Wizard to create new reports that we can later customize.
• Reports can be customized to include images and custom text, like logos.

13.6 Creating Forms in Microsoft Access
• Forms provide an easy-to-use interface with a database. Most websites use forms for inputting,

requesting, and accessing information.
• Forms can be created and edited using the Form Wizard.
• Forms can be customized in either Layout View or Design View.

Review Questions
1. Data must be ___________ to be useful for digital transformation.

a. unorganized
b. inaccessible
c. actionable
d. live

2. The most common type of database used to power transactional systems is __________.
a. NoSQL
b. RDBMS
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c. SQL
d. analytical database

3. ________ link objects together.
a. Relationships
b. Flat files
c. Joins
d. Queries

4. Which database system should be used for testing and experimentation?
a. production database
b. development database
c. transactional database
d. relational database

5. Which object in Access stores data for use?
a. report
b. query
c. table
d. form

6. When would you use Access instead of Excel?
a. to store data in multiple tables
b. to perform complex numerical analysis
c. to create visualizations
d. to create a PivotTable

7. How many databases can be open in Access at one time?
a. one
b. two
c. three
d. four

8. Queries are used in databases to __________.
a. access and prepare records
b. raise questions in business discussions
c. manage simple datasets
d. write questions for presentations

9. In a(n) ______ join, the common fields and data between the two tables are looked at and only displays the
matches.
a. QBE
b. outer
c. foreign key field
d. inner

10. The parts of an Access query include __________.
a. field names and criteria only
b. table names, field names, and other detail
c. table names, field names, and sort order
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d. criteria and sort questions only

11. When would you navigate through a database using the navigation buttons on the datasheet?
a. when you have many records to look at
b. when you want to see thousands of records at a glance
c. when you do not want to take the time to create a query
d. when you are looking at a small set of records (e.g., from a query)

12. Which statement best explains the process of manually adding a record to a database?
a. You never add a record manually to a database because this is not a function in Access.
b. You are unlikely to add a record manually but can do so when necessary.
c. You are likely to add records to ensure that the database matches the production database.
d. You will scan records but will not manually input them to update the production database.

13. What is the keyboard shortcut to save a record manually?
a. Ctrl+Enter
b. Shift+Enter
c. Ctrl+S
d. There is no shortcut, you have to use the Home tab.

14. Why should you use reports when working with a database?
a. because data is confusing
b. because data is ugly
c. because reports are attractive
d. because reports provide data in a more usable form

15. If you want an image to show up at the top of each page of the report, where do you put it?
a. detail section
b. in the page header
c. in the footer
d. in the report header

16. Reports in Access are best used to summarize what type of information?
a. record detail
b. header code
c. total code
d. summary header

17. Which tab may not be available unless you select multiple items in the form?
a. Form Design
b. Format
c. Arrange
d. Create

18. What tool provides an efficient way to create a form?
a. Form Wizard
b. Form Code
c. Form Grid
d. Form SQL
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19. Forms can be created based on __________.
a. reports or other forms
b. tables or queries
c. tables or reports
d. queries or other forms

Practice Exercises
20. Find a dataset from Kaggle (https://openstax.org/r/78KaggleData) that catches your eye. Make sure that

the dataset you select is relatively small (<50 MB), and click Download. Open the data file in Excel or a text
editor like Notepad. Note the kind of data included in your data file and how it is structured. What kind of
data does your file include? How does your file organize individual items of data? What kind of company
or organization might this data be useful for?

21. Imagine that you are setting up a database to support a company’s human resources function. Explain the
benefits of using Access to a leadership team that is considering what software your department will
need.

22. The foundation of a digital organization is its data platform. Choose a business that provides products or
services and consider the organization’s data landscape and what types of databases are likely in use. Use
evidence from the company’s website and marketing materials to support your prediction.

23. Build a simple database and create a query that joins information. You are currently working with
information about the sales and marketing team. You want to keep track of the team members and the
regions they work with. Set up a database with the following tables (remember, you would separate this
data into at least two tables to make the database more efficient and easy to work with):

Table:TeamMember
TMID
TMFirstName
TMLastName
TMPhone
TMEmail
Table:SalesRegion
SalesRegionName
SalesRegionNotes
Table:SalesRecord
TMID
SalesRegion
Once you have set up the tables, create a query that returns the team member’s first and last names and
the sales region they are assigned to. Add any fields you think are necessary to create a list of team
members’ names with their region. You may want to try sorting to improve the query output.

24. Imagine that you are conducting a human resources analysis. You have a table containing all the names
and personal information for a team of employees. You have another table that contains the learning
records for all training and certifications that individuals have completed. Both tables have a field called
EMPLID, which stores the employee ID. Design a query that returns the EMPLID, employee name, location,
and all training or learning activities they have completed. After you design the query, write it in SQL. (Use
Microsoft's Access SQL support page (https://openstax.org/r/78AccessSQL) for assistance with the code.)
Table: EMPLInfo
EmplID
EmplFirstName
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EmplLastName
EmplAddress
EmplCity
EmplState
EmplZip
Table: EMPLLearning
EmplID
TrainingName
TrainingDate

25. Importing records is an important function when working with a database like Access. Complete the
following steps to create a database from scratch:

1. Create a blank database using Access and then import the colors.csv file from the LEGO Database
(https://openstax.org/r/78LEGODatabase) found on Kaggle.

2. Then use your navigation buttons to do the following:
a. Add a record with the values:

ID: 2000
Name: Vivid burgundy
RGBN: 990033
is_trans: f

b. Modify the record to say “dragon-scale burgundy.”
c. Delete the record.
d. Undo the change.

26. LEGO has decided to stop offering the following colors: Sand Purple, Dark Green, Light Salmon, Metallic
Gold, and Lavender. They have tasked you with removing these colors from their database. Using your
database with the imported colors.csv file from the LEGO Database (https://openstax.org/r/
78LEGODatabase) on Kaggle, locate and delete all records for the colors listed.

27. WorldCorp leadership would like a visually attractive list of all employees that can be used in a publication.
They would like the WorldCorp logo to appear on the file and would like to display each employee’s first
and last name, alphabetized by last name. Please create a report that meets these criteria using the
Human Resources Data Set (https://openstax.org/r/78HRData) from the Kaggle website.

28. The WorldCorp Human Resources Department has asked you to create reports to support the following
inquiries using the Human Resources Data Set (https://openstax.org/r/78HRData) from the Kaggle
website. Before creating the reports, look at the type of data available and decide what data needs to be
included or omitted. Which fields should be considered to answer these inquiries?

• Which employees have high performance scores? Low performance scores?
• Which departments are currently the most diverse?
• How has the company acquired its most diverse employees to date?
• Is pay equitable across all divisions and positions in the company?

29. Imagine that you are the human resources manager for the Northeast WorldCorp region. You have a
dataset of employees from the region, and you would like to be able to look through employee records to
identify employees who may be unhappy in their position so you can offer support and intervention.
Using the Human Resources Data Set (https://openstax.org/r/78HRData) from Kaggle, import the data and
create a form that will allow you to navigate between employee records to look at employee performance,
satisfaction, and other data you think would be useful in determining whom you can assist.

30. Using the Human Resources Data Set (https://openstax.org/r/78HRData) from Kaggle (or the database you
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built in Exercise 1), create forms that support the following business functions:

• Evaluating employee performance (including attendance and lateness)
• Understanding employee roles (including position, department, location)
• Reviewing employee hiring information (including recruitment and position)

31. The internet runs on forms. Most of the websites you interact with are based on databases using forms
for what you see. Look at a website you use frequently and identify which screens are likely forms that
show you data from the underlying website database. Using the form you have identified, determine what
the table(s) under it likely hold. Draw the table and explain your rationale, including a screen capture of
the form you based your work on.

Written Questions
32. A business sells its products online through its website. What type of database powers the website?

33. A business needs to analyze its sales figures for the past two years. What type of system holds the
historical data that could be used in analytics?

34. Why is it advantageous for a database to be able to model real-world relationships in data, such as the
relationship between a customer and their purchase history?

35. Describe the similarities between Access and Excel.

36. Describe the main features of Access.

37. Why would you use Access in a business environment?

38. How does the query grid (as opposed to using the Query Wizard) help you build and edit queries?

39. What is a query, and how can queries help a user understand their data?

40. How are relationships used in queries?

41. Why is it important to have the ability to add new records to an imported dataset?

42. Why should an Access user pay attention to the data entry symbols when changing records in a dataset?

43. Give an example of a case in which it may be more efficient to use the Datasheet View of a table instead of
using queries to examine records.

44. Why is it important to review and customize reports even after Access automatically generates them?

45. When might it be more appropriate to use Layout View rather than Design View in creating a new form?

Case Exercises
46. Like many digital service companies today, Spotify, a music streaming platform, routinely tracks user

consumption of content on its app and website. Spotify can use this data to spot music trends, improve
recommendations, and drive consumer engagement with its product. Using the Top Hits Spotify from
2000–2019 dataset (https://openstax.org/r/78SpotifyData) from Kaggle, import the data for top song hits
into Access. Design some simple queries that will allow you to examine the data more closely in this
database. Do you see any patterns from your cursory review? For example, are there specific genres that
tend to have higher popularity, or are there some artists that have multiple top hits? How might more
advanced analysis of a database like this be useful for a company like Spotify?

47. One use for forms in Access is to create an interface that makes it easier for casual users to interact with
and find information from your database. Serving a similar function is Google Trends
(https://openstax.org/r/78GoogleTrends) which is an interface that enables Google users to explore data
that the company has collected based on its database of historical search trends. Try searching for a
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specific term, such as “World Cup,” and look over the results. Note that the results are conveniently
displayed in several graphical images, such as search term interest over time. You can also download a
CSV file containing the data that is presented to you. Download and open the “interest over time” data for
the term that you searched. Which format do you think is easiest for a casual user to interpret? How might
including images and other graphics help improve Access forms?
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Figure 14.1 As businesses grow, they often need to use more advanced features in Microsoft Access for complex database design

and querying to help with tasks like managing inventory. (credit: modification of “Man in Black and Gray Plaid Dress Shirt Holding

Black Smartphone” by Tiger Lily/Pexels, CC0)

Chapter Outline
14.1 Advanced Queries in Microsoft Access
14.2 Multiple Table Forms
14.3 Customizing Forms
14.4 Customizing Reports
14.5 Using Macros
14.6 Data Analysis and Integration

Chapter Scenario
Now it is time to discuss advanced database applications at WorldCorp. As you continue to grow with the
company, we will expect you to dive deeper into what is possible with data analysis. Your role will continue to
advance as an analyst working with data professionals supporting various teams within WorldCorp.

WorldCorp wants to grow and expand into its independent retail locations to better serve its vast customer
base. It still needs to create a database to manage inventory for these new locations. This would involve more
complex database design and querying, as well as the use of advanced features in Microsoft Access.

First, we want to determine the data WorldCorp might need to store. We can start by identifying the key
elements to track—potential product names, SKU numbers, locations, quantity on hand, and likely reorder
points—and designing a table structure to best serve each type of data. For example, you could create a
“Products” table with fields for product name, SKU number, description, and unit cost, as well as a “Locations”
table with fields for location name and address.

WorldCorp would need a user interface to enter the data for each product and location into their respective
tables. We will walk through some advanced steps in Access queries to retrieve specific sets of data from
specific tables—for example, a query to find all products with a quantity on hand below the reorder point, or to
find all products located in a specific store. You will also learn how to create reports to help keep track of
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inventory by summarizing and displaying data in a user-friendly format. For example, you could create a
report that shows inventory levels by location, or one that shows sales trends by product category.

14.1 Advanced Queries in Microsoft Access

Learning Objectives
By the end of this section, you will be able to:

• Create a query with multiple criteria
• Create queries that use operators and expressions
• Design queries that select, aggregate, and run actions

As your database continues to evolve, the incorporation of advanced queries aids in the management and
manipulation of the exact data of interest. For example, at WorldCorp, you might need to collect all types of
information on customers (e.g., email, phone, address, demographics, shopping history). This information
often needs to be stored across multiple tables for both speed and efficiency. As an example, a new customer’s
basic information will be stored in one table. We assume this information doesn’t change often—only when
the customer moves to a different location or makes a major life change. In addition to contact and location,
basic information could include demographic information, which may never change in our records.

In a separate table, we would store a record of each time the customer makes a transaction. Transactions may
happen often and are usually unique, as each one has a particular time/date, exact location of purchase, and
possible coupons or rewards points added. Additionally, a customer’s purchase may be for a single item,
several items, or perhaps 100 or more different items (think of a trip to the grocery store) on the same
transaction.

By using an advanced query, you can isolate both customer information and purchasing information at the
same time from both tables. For example, suppose you want to know how many customers shop for a
particular service or item at locations at least twenty miles from their homes. Determining this would require
enforcing multiple criteria across multiple tables and using advanced features in query design to find the exact
data requested. The design tools available in Access allow for this level of advanced database design and
function.

Queries with Multiple Criteria
A query criterion is a kind of formula used in Access to filter the records based on values in fields of interest
to determine whether to include the record in your query results. Criteria may take the form of a number, full
or partial text, or any combination of data points within a table, such as “Red” or “=>5”. You can include criteria
for each field, as shown in Figure 14.2. Only items that match all the criteria you enter will appear in the query
results.
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Figure 14.2 Access data can be filtered and sorted using criterion such as customer or order date. (Used with permission from
Microsoft)

Types of Criteria
Listed are the different types of criteria that can be used in an Access query:

Simple criteria: This type of criteria involves specifying an exact value or expression to filter the results. For
example, when building out the inventory database for our potential freestanding retail locations, you could
use simple criteria to specify which exact type of inventory you want to isolate.

Comparison operator: Comparison operators are used to compare two values or expressions. Examples
include =, <>, <, >, <=, and >=. The < operator can be helpful to find out what inventory has less than a specified
quantity on hand.

Wildcard: Wildcards are used to represent unknown characters in a search string. The two most common
wildcards in Access are the asterisk (*) and the question mark (?). For example, a wildcard can be used to find
all customers whose last name starts with a particular letter. Table 14.1 shows the most common wildcard
symbols and a description of how they can be used when you have incomplete information or unknown
characters.

Symbol Description Example

*
Identifies zero or more characters. Often used as the first or last
character in the character string.

“ba*” finds ba, bat, ball, and
balloon

? Finds any single alphabetic character. “w?ll” finds will and well

Table 14.1 Wildcard Characters Wildcard characters are useful when filtering where data could lack uniformity or you have
incomplete information.
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Symbol Description Example

[ ] Matches any character found within the brackets.
“T[ae]m” finds Tam and
Tem, but not Tim

! Identifies all characters not in the brackets.
“B[!ai]d” finds bed and bold,
but not bad or bid

-
Ties any one of a range of characters. Users must specify the
range in ascending order (A to Z, not Z to A).

“c[a-c]t” finds cat, cbt, and
cct

# Finds any single numeric character.
“5#4” finds 504, 514, and
524

Table 14.1 Wildcard Characters Wildcard characters are useful when filtering where data could lack uniformity or you have
incomplete information.

Range criteria: Range criteria are used to specify a range of values for a field. As an example, a vender that we
buy from to resell in our new retail locations may want to know all of the orders we have sold of theirs within a
specific date range that have been taken out of our inventory. Rather than waiting for our next order, our
vender could receive critical information on how much we may be looking to order in the near future.

Null criteria: Null criteria are used to find records that have a null value in a particular field. For example, you
could use null criteria to find any inventory labels that do not include product descriptions.

Logical operator: Logical operators are used to combine multiple criteria in a query. The two most common
logical operators in Access are AND and OR. For example, you could use the AND operator to find all orders
with a total greater than $100 and placed by a specific customer. Table 14.2 summarizes common logical
operators.

Logical
Operator

Description Example

AND
Returns TRUE if both operands are true, and FALSE otherwise. It is
represented by the symbol &.

[quantity] > 100 AND
[location] = Philadelphia

OR
Returns FALSE if at least one of the operands is true, and FALSE
otherwise. It is represented by the symbol |.

[quantity] > 100 OR
[location] = Philadelphia

EQV
Returns TRUE if both operands are either true or false, and FALSE
otherwise. It is represented by the symbol <=>.

[quantity] <=> 25 OR
[location] = Philadelphia

NOT
Returns TRUE if both operands are false, and FALSE otherwise. It is
represented by the symbol ~|.

NOT ([quantity] > 10 OR
[location] =
Philadelphia)

Table 14.2 Logical Operators Logical operators are used often with databases to allow you to filter information with multiple criteria
such as several locations, specific customers, or noncontiguous date ranges.
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Logical
Operator

Description Example

XOR
Returns TRUE if exactly one of the operands is true, and FALSE
otherwise. It is represented by the symbol ^.

([quantity] > 10) ^
(quantity] > 100)

IMP
Returns FALSE if the first operand is true and the second operand
is false, and TRUE otherwise. It is represented by the symbol ->.

[location] = Philadelphia
-> [quantity] > 100

Table 14.2 Logical Operators Logical operators are used often with databases to allow you to filter information with multiple criteria
such as several locations, specific customers, or noncontiguous date ranges.

By using these different types of criteria in an Access query, you can create powerful and flexible queries that
can help you analyze and manipulate your data effectively.

Figure 14.3 displays a few sample criteria, shown in the highlighted box, and explains how they work with
operators.

Figure 14.3 When delimiters are used to filter a database you will notice the criteria listed under the field column. (Used with
permission from Microsoft)

At WorldCorp, you may need to isolate orders that took place during a certain time frame. For example, how
did our marketing campaign do in sales over a particular time period for our retail locations? How many orders
did we do over the past week? How many did we do over the past month? You might need this information to
help schedule orders for our retail locations. This example returns items with yesterday’s date (Date()–1). Thus,
if the current date is 5/12/2024, you will see only items for the previous day, 5/11/2024.

In addition to the Date() function, there is also a Now() function to consider in Access. Both Date() and Now()
are used to retrieve the current date and time, but they have different purposes and applications. The Date()
function returns only the current date, without any time component. It is useful for calculating dates and time
intervals, such as the number of days between two dates, or for filtering data based on a specific date. On the
other hand, the Now() function returns both the current date and time, including the hours, minutes, and
seconds. It is useful for tracking events that occur at a specific date and time, such as recording the time that a
delivery showed up in inventory at a retail location.

Some reasons why you might choose to use the Now() function instead of the Date() function in Access can
include the need to record time stamps. If you need to keep track of when events occur, such as the time of
day when items are most likely to sell, the Now() function can be used to record the time stamp accurately. In
addition, if you want to filter records based on a specific time range, such as all transactions that occurred
within the last hour, then you will make use of the Now() function. In designing tables, note that it is important
to use the correct format for each field used in the table you are pulling from in the query so that the unique
expressions can be applied to that field.
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In the example shown in Figure 14.4, the field labeled Order has a criterion of less than 50, so you will see only
amounts that are less than $50 from what our customers spent at WorldCorp. The amount found in this field is
calculated by multiplying two fields (price and qty) and grouping the results by sum for a total of all unique
Order ID numbers. Greater-than (>), less-than (<), equal-to (=), greater-than-equal-to (=>), less-than-equal-to
(=<), and other mathematical expressions can be used to query all fields that are formatted as numbers,
including currency, integers, autonumbers, and calculated fields.

Figure 14.4 A logical operator is used for order price to only display orders that are less than $50. (Used with permission from
Microsoft)

In the example shown in Figure 14.5, the Notes field in a query is based on a table that stores notes from sales
orders that are formatted as long-text. A note can contain any amount of text, ranging from no words to a few
words or even multiple paragraphs, depending on the order and the customer’s requirements. This criterion
isolates all notes that contain the string Express, signifying the customer’s urgent need for the product. The
key word “Express” can be extracted from all of the text logged in the Notes field, regardless of the order or
length of the note.

Figure 14.5 Notice the asterisk following the word “Express” as a wildcard to filter the data where the word in any form appears in
the notes section. (Used with permission from Microsoft)

Depending on how you format the data, your next task is to select the appropriate expression to extract the
data. Yes/No, OLE objects, hyperlinks, and attachments all have unique expressions to help optimize Access’s
ability to match your desired outcome. Again, formatting the data within tables is key to developing successful
criteria expressions.

Building a Query with Criteria
When you create or modify a query in Access, you will be identifying/creating fields of data to isolate. These
fields will represent the data you want to include, omit data that is not of interest to you, sort the data, and
even combine data from multiple tables, as Figure 14.6 shows.
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Figure 14.6 Several layers of filtering can be used in one query to build a customized list to meet specific needs. (Used with
permission from Microsoft)

The example shown in Figure 14.6 of a query at WorldCorp combines two tables and isolates five fields from
the related tables. The tables are related by the OrderID field. When a new order comes in, a unique OrderID is
created in the TCustomerOrder table. Then, the order details are created in the TCustomerOrder table. The
two tables are related by OrderID. This means that every order can have multiple sales items on the order. In
short, every order is uniquely related to a customer. However, every order can have multiple sales items on the
order. Those items are stored as a list in a separate table. Every customer, every order, and every list of order
details need their own tables.

This example’s five fields to review are: OrderID, Order Date, Notes, Price, and Qty. Because running this query
would yield every order, it may not be useful unless you create criteria to isolate a particular question.

Within Query Design tab, choose the column of the field to which you want to apply a criterion. Click in the box
below the field name in the Criteria row for that field. Type in your first expression or right-click in the Criteria
box and choose “Build” to utilize the Criteria Wizard. Repeat these steps for each field for which you want
criteria that help answer the question at hand question. For instance, if you are concerned about offering free
next-day shipping on all orders because of the rising costs of shipping, you might want to look at low-dollar
purchases to see how often customers are asking for express shipping. One option is to review only those
orders from yesterday (criterion #1), that were less than $50 (criterion #2), and also had the string “Express” in
the notes (criterion #3) on the receipt. The following criteria would be typed out or built through the wizard for
each field highlighted, in order, as Figure 14.7 shows.
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Figure 14.7 The Criteria Wizard can assist you in building a more complex query, or you can also type criteria directly into the query
if you are familiar with the appropriate syntax needed. (Used with permission from Microsoft)

LINK TO LEARNING

Have you ever wondered how books made into movies do in theaters? And if it is a series of books such as
Harry Potter or The Hunger Games, which book/movie is more popular? Databases can be used to find out
these answers. The power of a relational database lies in its ability to efficiently manage and organize large
amounts of data in a structured and flexible way. To find answers—for a person, an organization, or society
as a whole—data needs to be processed in a way that helps transform it into useful information. To learn
more, watch this video discussing how to build a query with basic criteria using data points
(https://openstax.org/r/78BldQryData) using the Harry Potter movies for reference.

Using Operators and Expressions
As you develop an inventory system for WorldCorp’s future retail locations, inventory becomes tied with POS
(point of sale) systems. The actual sales amount for each inventory item has not been calculated yet. Taxes,
discounts, and price corrections all have to be considered for a total. Expressions become an important
element to know and understand.

You might want to use expressions to create a formula to calculate a total order amount. The order amount is
calculated by multiplying the price-per-item in stock to the quantity ordered of each item. As discussed in the
previous example, or any number of other requests, if the number can be calculated, there may not be a need
to store it in a table. In the previous example, the field “Order” has no associated table syntax is important to
consider and be aware of when writing expressions in Access because it defines the rules and structure for
how the expression is written. The set of rules by which the words and symbols in an expression are correctly
combined is called syntax. Access uses a specific syntax to understand and interpret expressions, and any
deviation from that syntax can result in errors or unexpected results. Proper syntax ensures that the
expression is written in a way that Access can understand and process it correctly. It helps to avoid errors such
as syntax errors, calculation errors, or incorrect results. Additionally, consistent use of syntax can make the
expression more readable and understandable to other users or developers who may need to review or
modify the expressions you create in the future.

Overall, understanding and using proper syntax is crucial for writing accurate and efficient expressions in
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Access (see Figure 14.8). Many of the expressions that are used in tables and forms are also applicable to
writing/building expressions as criteria in queries. An expression is a combination of operators, identifiers,
functions, and constants that are used to perform a calculation or to produce a result. An expression can be
used in a variety of contexts, such as in queries, forms, reports, or macros.

Figure 14.8 Through expressions, you can restrict queries based on text, numbers, and also perform functions. (Used with
permission from Microsoft)

To be a valid expression in Access, an expression must contain the following elements:

• Values: Every expression must contain constants that include one or more values, such as a number,
string, or date. Values may be constants, which are entered directly into the expression. Values may also
be retrieved from fields or controls in a table or form.

• Operators: Operators are required symbols or keywords used to perform mathematical and/or logical
operations on values.

• Functions: Functions are predefined calculations or operations that can be used in an expression, but are
not required. Access includes a wide range of built-in functions to perform such tasks as calculating totals,
formatting values, and manipulating text.

• Parentheses: Parentheses are used to group parts of an expression and control the order in which
calculations are performed. Following the rules of mathematics, expressions within parentheses are
evaluated first.

• Identifiers: Identifiers are names used to refer to tables, fields, and other objects in an Access database.
Identifiers must follow specific naming conventions, such as not containing spaces or special characters,
and must be enclosed in square brackets to work within expressions.

• Commas: Commas are used to separate multiple arguments in a function or expression.

In addition to containing these elements, keep in mind that correct syntax is established and maintained.

Understanding Operators and Expressions
The two most common logical operators used in building an expression for criteria in a query are AND and OR.
These are assumed depending on where you place the expression in query design. Any expression placed in
line with the Criteria line is defined as an AND operator. Our last example used all AND operators for the three
expressions. See Figure 14.9 as an example.
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Figure 14.9 By default, when criteria are added to more than one field, those criteria will be used simultaneously in the query using
the “AND” operator. (Used with permission from Microsoft)

Placing all three criteria on the same line means that the query will display only those items that are from
yesterday and are less than $50 and contain the string Express. If you want the query to look for any of the
three criteria, that is yesterday, or less than $50, or containing the string Express each needs to be on a
separate line. Date()-1 would be in the criteria row, <50 in the or row, and then place Like Express in the row
below the or row. Rather than a dataset needing to match all three criteria or to match either of the two
requirements, it can now match any of the criteria.

Any expression placed below the Criteria line is then defined as an OR logical operator. If we change our last
example by rearranging the placement of the expressions, it operates very differently, as Figure 14.10 shows.

Figure 14.10 To query using the “OR” operator, the selected criteria should be moved one line below to the “or:” line. (Used with
permission from Microsoft)

Placing the second and third expressions on the line below the first criterion means that the query will now
yield those items that are from yesterday “or” are less than $50 “and” contain the string “Express.” Rather than
a dataset needing to match all three criteria, it now needs to match either of the two requirements.

Common Operators
In both Excel and Access, the most common operators are arithmetic, comparison, and logical. Each has its
own function and returns different results.

• An arithmetic operator is used to calculate a value from two or more numbers or to change the sign of a
number from positive to negative or vice versa (Table 14.3).

Operator Description

- Subtraction (2-1=1)

* Multiplication (2*3=6)

/ Division (12/4=3)

Table 14.3 Arithmetic Operators A
mathematical operator could be used to
combine data such as getting the total sales
amount for two or more company purchases.
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Operator Description

\ Integer division (6\4=1)

+ Addition (15+4=19)

Table 14.3 Arithmetic Operators A
mathematical operator could be used to
combine data such as getting the total sales
amount for two or more company purchases.

• A comparison operator is used to compare values and return a result that is true, false, or null (Table 14.4).

Operator Description

< Less than

<= Less than or equal to

<> Not equal to

= Equal to

>= Greater than or equal to

> Greater than

Between “Value1” And
“Value2”

Between two values, inclusive (for example, “Between 1 And 3” would
return 1, 2, 3)

Table 14.4 Comparison Operators To compare one customer’s sales to another, you can use comparison operators such as
greater than or less than.

• A logical operator is used to combine two Boolean values and return a true, false, or null result. There are
three main logical operators that are commonly used in Access:
◦ AND operator: This is used to combine two or more expressions and returns TRUE only if all the

expressions are true. For example, the expression ‘sizes > 8 AND Color = 'Blue'’ will return TRUE only if
the size of a shirt is greater than 8 and the color is blue.

◦ OR operator: This is used to combine two or more expressions and returns TRUE if any one of the
expressions is true. For example, the expression “Size > 8 OR Color = 'Red'” will return TRUE if either the
size is greater than 8 or the color of the shirt in inventory is red.

◦ NOT operator: This is used to reverse the logical value of an expression. It returns TRUE if the
expression is false and FALSE if the expression is true. For example, the expression “NOT (size > 8)” will
return TRUE if the size of the shirt is less than or equal to 8.

These logical operators can be used in combination with comparison operators such as =, <, >, <=, >=, and <>
to create complex expressions that evaluate to true or false (Table 14.5).
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Operator Description

AND Both elements of an expression must be true.

NOT The expression must evaluate as false.

OR At least one element of an expression must be true.

XOR Exactly one element of an expression must be true, not both.

Table 14.5 Logical Operators Queries that filter using several layers might involve logical
operators to extract information from a large database.

The next example, shown in Figure 14.11, is a query designed to help create a report—in this case, you need to
generate an invoice after a customer places a new order with WorldCorp. Invoices for customer sales include
items such as the customer information, the date, the products ordered, price for each product, and total for
the entire invoice. Refer to the chapter on Advanced Document Preparation for examples of invoices. For the
report to work properly, two different criteria must be used with the logical operator AND. The first expression
is [Forms]![frmOutBound2]![Document], which uses identifiers to isolate which document number the report
will generate. In essence, this expression uses identifiers to query only the exact document number that is in
use on the frmOutBound2 form, which is used to place all new orders from customers. By identifying the form
number, the invoice will generate the exact order and only the called-upon order.

Figure 14.11 Access not only lists the fields in text, but also provides a visual representation of how elements are connected in the
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database. (Used with permission from Microsoft)

The second criterion is a function expression that isolates the order date to today, and today only, ensuring
that the query only creates new invoices that represent new orders from today (see Figure 14.12).

Figure 14.12 Notice how several fields are used to perform the query using logical operators. (Used with permission from Microsoft)

This example shows a query designed to help show which items a T-shirt design company has in stock. Each
stock item has four fields that collectively describe the piece of clothing: style, size, primary color, and graphic
design on the item. In this example, a customer wants to know what graphic designs are available on a hoodie
that is size XL and has a base color of green or red. These criteria combine both constants and logical
operators to help isolate the data requested by the customer.

Guidelines for Using Criteria
There are best practices to follow when using criteria:

• Keep it simple. Do not try to do too much with any one query to get an answer. A query can do a great
deal, one strategy is to copy previously designed queries and rename before making small changes to
each copied query for a very specific purpose.

• To stay organized, be consistent in how your queries are named. When you first learn the syntax used in
creating criteria, it is tempting to try to use all of the syntax in a single query. When creating a query,
however, it is more important to keep the main purpose of the query in mind. If you have several
questions, don’t be afraid to create multiple queries—a separate one for each question or task.

• Be sure to create tables carefully, using the correct format for each field within each table. Using good
naming practices is important: A key reason that queries won’t run is likely to be the formatting of the
fields rather than incorrect syntax.

• Develop a list of expressions that you know and can use for future projects. Often, these can be repeated
in various queries for various uses.
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Designing Queries to Run Actions
Now that you know how to build a query, let’s look at the different types of queries in Access. There are five
types of queries, each with a unique function and use: (1) select queries, (2) action queries, (3) parameter
queries, (4) crosstab queries, and (5) SQL (structured query language) queries.

Select query is the most common type of query and the easiest to use. They retrieve data from one or more
tables and display the result in a datasheet. Select queries are also used to group records and calculate
averages, sums, counts, and other types of totals. As an example, a select query might be used to group
customers by state to see which states have the highest demand.

Action query specifies a particular action, such as creating a new table, deleting rows, updating records, or
creating new records. Action queries are very popular in data management because they allow for many
records to be changed at one time. For example, suppose you need to update your records to reflect a new
state tax rate that affects numerous types of transactions. Creating an action query can help update records
across various tables.

There are four types of action queries:

1. Append query: Adds records from one or more tables to the end of one or more tables.
2. Update query: Makes global changes to a group of records in one or more tables. For example, you can

use an update query to increase the prices on your menu by 25 percent for products within certain
categories.

3. Delete query: Deletes a group of records from one or more tables. For example, you can use a delete
query to remove products that have been discontinued or for which there are no orders.

4. Make-table query: Creates a new table and populates it with data from one or more existing tables. When
you create a make-table query, you specify the fields and criteria that you want to include in the new table.
Access then creates a new table and copies the selected data from the existing table(s) into the new table.
The new table will have the same field names and data types as the original table(s). These queries can be
useful in a variety of situations, such as creating an archive or backup of data. You can use a make-table
query to create a backup copy of important data before making changes to it. In addition, simplifying
complex data can be very helpful. As an example, if you have a table with many fields or complex
relationships, you can use a make-table query to create a simplified version of the data that is easier to
work with on a different project. Also, aggregating data can be accomplished. You can use the query to
aggregate data from multiple tables into a single table, which can be useful for reporting or analysis
purposes.

Parameter query is a type of query that prompts the user for input values when it is run. The input values are
used to filter the data that is returned by the query, based on the specified criteria. Parameter queries are
useful when you want to create a query that can be easily customized to return different results based on
specific criteria. For example, this query can be used in building a form that asks users which employee is
logging into the Main Menu screen to start a transaction at WorldCorp; you type [Which User?] on the Criteria
line. When the query runs, Access will prompt the WorldCorp employee for the answer to your question.

Crosstab query calculates and restructures data for easier analysis when looking for trends or patterns. Much
like the PivotTable option in Excel, Crosstab queries calculate a sum, average, count, or other type of total for
data that is grouped according to two different types of information. For example, total sales for WorldCorp
might be grouped in two ways: by salesperson, listed down the left side of the datasheet, and also by month
and year, listed across the top of the datasheet, which now shows total sales for each salesperson by month
and year.

SQL query is created by using an SQL statement. When you create a query in Query Design View, Access builds
the equivalent SQL statements for you behind the scenes. You can view or edit the SQL statement in SQL View.
Upon viewing any of the created statements by Access, you can edit or add to the statement. This creates

944 14 • Advanced Database Use

Access for free at openstax.org



additional options for you that are often more efficient than using the Query Design View options.

Building a Query that Aggregates
Aggregate query lets you carry out calculations on record groups rather than performing individual
operations. An aggregate query considers the total, subset, or gross amount of records.

Aggregation is a powerful tool because of the nature of relational data. By looking across the connected tables
and through the built-in relationships, these can be accounted for when performing complex data searches
and totals among a vast area of applications.

Often, the first step in building an aggregate query is to turn on the Totals tool that is found within the Query
Design tab, as seen in Figure 14.13.

Figure 14.13 The Totals tool is found in the Show/Hide command group when you are designing a query. (Used with permission
from Microsoft)

After you select Total from the menu, a new row, labeled Total, appears just below the field names, with an
option area in the Access query, as seen in Figure 14.14.

Figure 14.14 Although the word “Total” is used, you can choose to get values other than just the sum of the numbers such as the
average or the maximum number in the field. (Used with permission from Microsoft)

The default option is Group By, which groups all identical data items in the field. For example, if you wanted to
know which stock item in your company’s inventory sold the most units, you could use the StockID in two
ways:

1. Create a field for StockID in the query, and list the Totals as Group By. This will provide a list of each type of
item you have sold.

2. Create another field, also with the StockID, but this time, choose the Sum function of the Total to provide a
complete sales count for each unique item. Both fields together provide a report on which items have sold
the most and the least.

Examples of Aggregate Queries

Scenario #1: You have an online business that has customers from around the country, and you want to find
out which states have the fewest customers. You decide to create an aggregate query to summarize the list of
states and count the number of instances in which each state appears among your current customers.
Selecting the Totals option creates the following query from the customer table, as Figure 14.15 shows: Group
By StateName and Count StateName.
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Figure 14.15 This query will give a summary of the total number of customers in each state using the “Count” operator. (Used with
permission from Microsoft)

Scenario #2: You receive two free tickets to the Super Bowl. Unfortunately, you cannot attend this year’s game,
so you want to give the tickets away as a thank-you gift to the customer with whom you have done business
the longest. To determine the recipient, you decide to do an aggregate query on customer orders, using date
ranges to identify the longest-standing customer. The following aggregate query (shown in Figure 14.16) is
then created by grouping the customer ID, using DateOut as the minimum total (first order) and then using
DateOut as a maximum total to establish the last sale the customer made (last order).
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Figure 14.16 More complex queries can be constructed to compare dates or other fields using the Total tool. (Used with permission
from Microsoft)

In this scenario, it would be best to build an additional query to calculate the length of time between
FirstOrder and LastOrder, as determined in the original aggregate query. The query has to solve both totals
before it can calculate the difference in time between the two fields using the Min and Max functions.

14.2 Multiple Table Forms

Learning Objectives
By the end of this section, you will be able to:

• Create a form that uses data from two different tables
• Create a form that contains subforms

Much like any global manufacturing corporation, we have an extensive list of assets that include company
vehicles, equipment, and facilities to operate and manage. At WorldCorp, when you work with relational data,
it is often convenient to be able to view multiple tables on the same form. For example, suppose you are
reviewing a fleet of vehicles for one of our manufacturing facilities in Germany. Initially, you built a form that
lists all the vehicles in use and enables you to add and subtract vehicles. You also built a form to create service
records for each vehicle that WorldCorp owns.

When a new vehicle is added to the fleet, it receives an initial oil change and fresh fluids, and these service
records are logged. You want to create a form that will make it easy to add a new vehicle and simultaneously
add the initial maintenance and repair notes for that vehicle. To do this, you need to add a vehicle to a list of
fleet vehicles on one table and, at the same time, add information about the maintenance/repair that has been
done to the vehicle on another table. To accomplish this goal, you may want to combine data from two tables
in one form or create subforms. This section presents several methods to help you create advanced forms.

Adding Data from Two Tables in a Single Form
If you want to add data across multiple tables in one form, this could help with efficiency when managing a
fleet of vehicles at WorldCorp. Primarily, it can speed data entry while maintaining the organization of tables,
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fields, and records.

To effectively create forms that feed into multiple tables, you should use a query as a critical building block.
Recall from the chapter on Understanding and Using Databases that a query is an Access object used to view,
analyze, or modify data. The query design determines which fields and records you see and their sort order.
Using the example of our manufacturing facility fleet vehicle program, you can review how the query is
designed, how to adjust it for user experience, and how to use the Form Wizard to build a form that can add
data to two tables.

Using Queries for a Form
First, a query needs to be designed to build a relational database for the fleet vehicle program. In this
example, you have two tables of information, as seen in Figure 14.17: tblVehicle and tblMaintenance.

Figure 14.17 Forms are used in a variety of ways in organizations and using Access collects the data automatically into a table. (Used
with permission from Microsoft)

The tblVehicle table represents each unique car/truck the company owns. The tblMaintenance table represents
every maintenance record (oil changes, new tires, chipped glass repair, inspections, etc.) on all vehicles. In this
section, you will see how to design a form that can add information to both tables simultaneously.

Remember that the ultimate goal of the new form is to add a new vehicle to the fleet and to include that
vehicle’s initial service information (oil change, safety inspection, cleaning, company decals, etc.) so that
WorldCorp does not lose track or misuse valued assets. The new form will serve as a quick form for all new
vehicles. For the query to be effective, a clear relationship needs to be established between the two tables.

In this example, VehicleID is the primary key of tblVehicle and is listed as a required field of tblMaintenance.
Recall from the chapter Understanding and Using Databases that a primary key is a field or set of fields with
values that are unique throughout a table. Values of the primary key can be used to refer to entire records
because each record has a different value for the key, as shown in Figure 14.18.
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Figure 14.18 Similar to defining the number type in Excel, when you create fields you can determine the type of information in that
field. (Used with permission from Microsoft)

Access provides different data types for formatting field names. Rather than setting the VehicleID field in the
tblMaintenance to short text, autonumber, or number, you can use the Lookup Wizard to build a relationship
between tables. The example, shown in a series of screenshots (Figure 14.19, Figure 14.20, Figure 14.21, Figure
14.22, Figure 14.23, and Figure 14.24) will walk through the use of the Lookup Wizard steps that are used to
create a relationship.

Figure 14.19 The Lookup Wizard can be used to create fields in a table in a step by step fashion either from an existing table or you
can create a new table. (Used with permission from Microsoft)
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Figure 14.20 If you choose to pull fields from an existing table in the database, you will need to identify the specific table. (Used with
permission from Microsoft)

Figure 14.21 Only fields contained in the table you select will be listed. (Used with permission from Microsoft)

Figure 14.22 Sort the information using a logical field such as the specific car details. (Used with permission from Microsoft)
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Figure 14.23 Recall the primary key is the field that ties the tables together. (Used with permission from Microsoft)

Figure 14.24 Enabling data integrity is a good idea if you are collaborating with others in the same database file. (Used with
permission from Microsoft)

Now that you have created a relationship between the tables, build a query that joins the fields from the two
tables together. To start, go to Query Design and bring in all the fields from both tables. In this example, the
query will be saved as qryNewVehicles, as it will be the driver for the New Vehicle form to use in the vehicle
fleet program (see Figure 14.25).
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Figure 14.25 (a) In the query view you can see the primary keys identified in each table. (b) Define the relationship between the two
tables and which records are created in the new table created from the form. (Used with permission from Microsoft)

Select qryNewVehicle from the list of All Access Objects to create the form “fromNewVehicle” (see Figure 14.26).
Access will create the form automatically. This form allows the user to enter both the new vehicle that is part of
the fleet and the initial check-in service performed on the vehicle.
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Figure 14.26 Because relationships were created previously between the two tables using the Wizard, when data is entered into the
form, both tables are populated with the information. (Used with permission from Microsoft)

Using Subforms
A subform is a form that is inserted in another form (known as the main form). A form/subform combination
may be referred to as a hierarchical form, a master/detail form, or a parent/child form. Subforms are generally
used whenever you want to display data from multiple tables where there is a one-to-many relationship.

In a one-to-one relationship, each record in one table has no more than one related record in another table.
This type of relationship is not common, as most information related in this way would be in one table, so
there would be no need for a second table.

By contrast, a one-to-many relationship is the most common type of relationship. In a one-to-many
relationship, a record in one table can have many matching records in another table, and the opposite is true
as well.

For example, suppose you have two tables in your database, one called Employees and another called
Employee Details. The Employees table contains basic information about each employee, such as their name,
ID number, and job title. The Employee Details table contains additional details about each employee, such as
their address, phone number, and emergency contact information. Because each employee has only one set of
details, there is a one-to-one relationship between the Employees and Employee Details tables. To view and
edit this information on the same form, you can use a subform.

To do this, you could create a main form based on the Employees table, with fields for Employee ID, First
Name, Last Name, and other relevant information. Then, you could add a subform based on the Employee
Details table, with fields for Address, Phone Number, Emergency Contact, and other relevant information. By
embedding the Employee Details subform within the Employees main form, you can easily view and edit data
for both the employee and their details on the same screen. You can navigate between records in the
Employees table and see the corresponding details in the subform, or you can add a new employee and their
details at the same time.

A many-to-many relationship means that for each record in one table, there can be many records in another
table; likewise, for each record in the second table, there can be many in the first. Many-to-many relationships
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cannot be directly represented in relational database programs; they have to be built by using two or more
one-to-many relationships. For example, for any business, a many-to-many relationship exists between
customers and products. Customers can purchase various products and various amounts of a product, and
products can be purchased by many different customers. A third table is required to create the relationship
between customers (many) and products (many).

Understanding How Subforms and Relationships Work
Using subforms is an effective way to create one-to-many relationships and offers unlimited options for
business use. In this type of association between two tables, the primary key value of each record in the
primary table corresponds to the value in the matching field or fields of many records in the related table.

For example, if you want to display an order with all of its details, you will use a subform. The order
information would display on the “main” form (one detail), and the order details would display on the subform
(many details). The data in the CustomerOrder table in Figure 14.27 is the “one” side of the relationship in this
example. It creates a Document number for the transaction, identifies the Customer, provides room for Notes
(delivery instructions, special handling, etc.), and date-stamps the transaction. In contrast, the data in the
OrderDetails table is the “many” side of the relationship, showing an unlimited list of items purchased in a
transaction.

Figure 14.27 The main form provides the lookup values to determine what to populate in the subform, which lists the items ordered.
(Used with permission from Microsoft)

The main form and subform are linked so that the subform displays only records that are related to the
current record in the main form. For example, when the main form displays a Customer Order by Arnold on 1/
20/22, as shown, the subform then displays items that were included on Arnold’s #2 order only. If the form and
subform were unlinked, the subform would display all the items that Arnold ever ordered, not just those
ordered on 1/20/22, on Document #2.

Adding a Subform through the Subform Wizard
There are two common ways to add a subform to a main form. The quickest way is to simply open a form in
Design View and then drag and drop a form (from your list of completed forms) that you want to be the
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“many” as your subform. However, using the Form Wizard can ensure that the correct relationships are
established when creating the advanced form. The following example will walk you through the use of the
Form/Subform Wizard to track your time away from the WorldCorp office on the golf course.

Start by designing a query that helps ensure that relationships between the tables are created. To help you
think through the query design, you might consider sketching it out on paper or in another app with boxes
and arrows to show how fields are connected. Then you can take this plan and use it as your work through the
queries when designing a form. Using the Form/Subform Wizard can also make designing the queries and the
form easier. In this example, shown in Figure 14.28, you will design a golfing relational database that keeps
track of individual scores and rounds. It may sound like a complicated task to create for a weekend activity, but
with the wizard, it can take just a few minutes to have a great application in place for your out-of-office
recreation.

First, create four tables to help keep track of (1) the different courses (tblCourseID), (2) the different players
(tblPlayer), (3) each round played (tblRound), and (4) the score shot on each hole played per round (TblScore).
Then, create a query that will bring together all four tables with all the fields from each table using the skills
covered earlier in the chapter. The goal is to make tblPlayer the main form; with tblRound and tblScore listed
as subforms.

Figure 14.28 Four tables are joined in this query to create the main form and two subforms. (Used with permission from Microsoft)

Now that you have created a query, save and close it. The next step, shown in Figure 14.29, is to select the
Form Wizard from the Create tab in Access.
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Figure 14.29 The query established the relationships between the tables and the Form Wizard found on the Create tab is used to
create the form from the query. (Used with permission from Microsoft)

The following sequence of figures walks through the different options in the wizard. Once you have used the
wizard a few times, you will find it easier to plan future forms and subforms for data management (see Figure
14.30, Figure 14.31, Figure 14.32, and Figure 14.33). Remember that we also used the Form Wizard in
Understanding and Using Databases.

Figure 14.30 The Form Wizard begins with determining the fields that will be used in the form and from which tables those fields
come from. (Used with permission from Microsoft)
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Figure 14.31 Rather than creating a form with a subform, you can instead create two separate forms and link them together. (Used
with permission from Microsoft)

Figure 14.32 Each subform can be displayed differently on the main form. (Used with permission from Microsoft)

Figure 14.33 Choose Modify to preview the form before using it to collect data. (Used with permission from Microsoft)
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After you select Finish in the wizard, the following form is created Figure 14.34. This database, built with four
tables, one query, and three forms, will provide a way to keep track of weekend golf performance for years to
come.

Figure 14.34 This form was designed as a training aid to demonstrate how the Form Wizard can be used to create subforms. The
subform to collect the scores is displayed in a tabular form. (Used with permission from Microsoft)

To review, the Form Wizard created three forms, as shown in the All Access Objects section: Player, Round, and
Score. When you open the Player form, it will display all three forms. In this example, Larry is the selected
player on the main form—PlayerID #1. The subforms will display information related to only Larry. He is
currently playing his first round at Twin Oaks on 5/24/22. We know this because the information displayed
within the Round subform is clearly highlighted in blue. Round is set to be a subform of Player. Additionally,
Larry has just entered his score on hole #3 of his first round. His score was a 3, and he also marked that the
hole was listed as a par 3; Larry shot par!

Score is a subform of Round, so only scores for the selected round will be stored. As Larry continues his round,
he can simply add additional rows of data from each hole he plays on the Score subform. These scores will
both be saved under RoundID #1 and kept as Larry’s unique scores. If Larry is playing against another player,
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you would navigate to the correct player on the main form and enter their round/score as well.

Larry can use this simple yet powerful form to keep track of unlimited rounds of golf. In the office, he might
apply these steps to developing a way to keep track of a variety of business tasks or projects. For example,
each of his employees could have an assigned project with numerous unique details concerning each project.
The employee would be the main form, while the project names and project details could be the subforms.

Adjusting a Subform in Design View
Subforms are difficult to change and update within Design View of the main form that they are sitting on. A
much easier way to alter a subform is to open that form separately (first making sure the main form has been
closed). Using the previous golf example, if you want to add details to the Round subform (for example, add a
place for notes on weather or course conditions), it is best to open up the Round form by itself and make the
changes. Once the changes have been made, you can save and close the form, then reopen the main form (in
this example, Player) to see whether you need to adjust the size. After making any changes, always make sure
the subform displays the new information within the main form.

14.3 Customizing Forms

Learning Objectives
By the end of this section, you will be able to:

• Use the tools to build a custom form
• Modify and add controls to a form
• Customize the appearance of a form by including images and modifying fonts

WorldCorp has manufacturing locations in the United States, China, and Germany, with headquarters in key
metropolitan areas in those same countries. Smaller functional units are located in offices around the world,
and there is an established international remote workforce. As you continue to develop an inventory database
for potential retail locations its customers experience, forms will help users add data records to fields within
tables. Those working in the new retail locations become the users of forms. As they receive shipments of
inventory or create sales transactions for customers, their input is what truly creates the data. Above all, a
form should be functional for them. Beyond functionality, a form that is customized in a way that makes it
easier and faster to use will create a more enjoyable user experience. Consider our diverse workforce around
the world. Knowing how to customize a form for cultural business practices is crucial in supporting the user.
This will be no different as you develop and design an inventory database for a potential booming retail arm of
WorldCorp.

Typically, one of the first forms all users experience is the Main Menu at WorldCorp, which helps them navigate
through all the other forms available to them in the database. Rather than scrolling through the entire list, the
user can go to the Main Menu, a starting point for all navigation.

LINK TO LEARNING

A quick way to prioritize a Main Menu for any graphical user interface is to manage its settings. A Main
Menu can be created either all at once quickly or over time, and the process can be creative and fun. Be
sure to set the Display Form option to Main Menu so that when the database is first opened, the Main Menu
form is opened up and ready for the user.

This video on creating a menu GUI in Access 2013 (https://openstax.org/r/78MainMenuGUI) discusses the
basic steps in creating a Main Menu and, most important, walks through the display options.
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Building a Custom Form
In general, using the Form Wizard will be the quickest and most efficient way to create a custom form. We
covered how to do that in Understanding and Using Databases. Here, however, we will walk through the steps
of building a form from scratch, in Design View, to demonstrate all of the possibilities. Start by selecting the
Query Design option under the Create tab in Access, and you will create a blank form in which you can start
working. Figure 14.35 shows the Detail section that appears when you create a blank form.

Figure 14.35 From the Create tab, choose Form Design to create the form from scratch. (Used with permission from Microsoft)

The next step is to save the form (frmMainMenu) and start planning how you want the Main Menu to look and
operate.

Form Views and Tools
Right-click on the top of the form to see the list of options, as Figure 14.36 shows. Here, we will review the four
ways to view a form: Form View, Layout View, Design View, and Datasheet View.

Figure 14.36 To begin a new form, you must first save it. (Used with permission from Microsoft)

Form View

Form View shows us what the form will look like for the user. Data can be changed in Form View, but
formatting cannot be changed. Whenever a form is launched, it will first be displayed in Form View. It is
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recommended to continually check the Form View while creating a form to make sure that the final version of
the form displays all of the desired options.

Layout View

Layout View is a feature that allows us to design and customize the layout of forms and reports visually, by
dragging and dropping fields and other objects onto the design surface. It is helpful for inexperienced users
because it provides a more intuitive and user-friendly way to create forms and reports than the traditional
Design View. In Layout View, you can see how your form or report will look as you design it, and you can easily
move fields and other objects around to create the desired layout.

For example, let’s say you want to create a form to enter data about damaged items that need to be removed
from inventory. In Layout View, you can drag and drop fields such as Item Name, UPC Code, Quantity,
Description of Damage, and Date onto the form, and then arrange them in a way that makes sense for your
users. You can also add other objects such as labels, images, and buttons to make the form more user-friendly.
Overall, Layout View is a helpful tool for creating forms and reports in Access, particularly for the least
experienced users, who may not be familiar with the intricacies of Design View.

Design View

Design View is a feature that allows us to create and modify the structure of tables, queries, forms, and reports
in a more detailed and precise way. Similar to Layout View, in Design View for forms and reports, you can add
and arrange fields, labels, buttons, and other objects, and set their properties to control their behavior and
appearance. However, Design View provides a more granular level of control over the structure and properties
of your database objects, allowing you to create more complex and customized solutions. It also allows you to
view and modify the underlying SQL code that Access generates for your objects, which can be helpful for
troubleshooting and advanced customization.

Design view is a powerful tool for creating and customizing the structure and functionality of tables, queries,
forms, and reports in Access, and is helpful for naive users who want to create more complex and customized
solutions.

Datasheet View

Datasheet View is similar to what you might see in a spreadsheet program. The data is in a table grid like Excel.
This allows you to interact with the information in a form similar to how you would work in Excel. You can add
or delete records (rows) and add or delete fields (columns) easily in this view. You can also use some of the
common keyboard shortcuts for copy and paste.

Having this view option can depend on which version of Access you are using. As of 2021, Datasheet View was
removed from forms in Access. So, if you are using a new version of the app, you will likely not have the
Datasheet View option.

Using the Form Tool
A list of form tools is available within the Form Design tab on the right side of the ribbon. To add existing fields
to a form, click the Add Existing Fields command (see Figure 14.37). The Field List pane will appear, and you can
select a field or fields to add to your form.

Figure 14.37 You can begin to add elements to your form such as fields using the Tools command group. (Used with permission
from Microsoft)
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An option set in Design View on the property sheet is called a form property. These options control how the
form looks, works, and interacts with the rest of the database. Use the tabs to find the specific property you
want to set, and use the help available to you in the bottom-left corner of the Access window to learn the
function of each property setting. In many cases, the default setting may be adequate for getting started.

You can use tab order to help control which section of the form the cursor moves to next. This feature
provides ease-of-use for gathering data in a user-friendly way. When adjusting tab order, always consider the
layout of the form: What is the first thing the user will do, what is next, and so on? Also consider omitting any
fields the user will simply tab through—for example, autonumber fields. These types of fields can be omitted
altogether for a better user interface experience.

Using the Split Form Tool
After building a table, you can create a split form. Select the table from the All Access Objects list and then go
to the Create tab. Under More Forms, select Split Form. In this example, Figure 14.38, you can collect a list of
your favorite jokes. The split form shows the datasheet (a running list of jokes) in the lower section, outlined in
yellow, while allowing access to the single-form information outlined at the top.

Figure 14.38 Split form view allows you to the information as it would look in the form as well as the tabular view showing each
record in the table. (Used with permission from Microsoft)

Using a split form may be helpful when you are scrolling through a datasheet to make changes, because it
enables you to highlight a row of data in the single-form view. As you have seen, a common theme in form
design is making the process easy and intuitive for the user.

Adding Controls to a Form
A form control is the part of a form that is used to enter, edit, or display data. Remember that controls can be
bound, unbound, or calculated. In Understanding and Using Databases, we covered how to use the Control
Wizard to walk you through adding controls to your form. Here, we will go into more detail about the different
types of controls you can add, and how to add them without the wizard.

As an example of adding controls, start by creating a Main Menu for a multiuser-friendly database, using the
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example of a carpeting business, as Figure 14.39 shows.

Figure 14.39 Controls are used to customize the form by inserting images, text boxes for titles, and other related elements. (Used
with permission from Microsoft)

When helping a customer, an agent of the business would begin by opening the Main Menu form. Notice that
a form control, Carpet Calculator, has been added to the Main Menu as the first control. To respond to a
customer’s call, the agent will most likely need a form to calculate a potential quote for a project. The form
control that was added is a button, one of many options available in the Controls section of Form Design.

Common Controls
Controls can be placed on forms to add to their functionality. This section walks you through the procedure for
adding several common controls.

The command control is used to start an action or a set of actions. For example, the button in Figure 14.39 is
designed to open the Carpet Calculator form. The Command Button Wizard shown in Figure 14.40 appears
automatically when you add a button to a form in Design View. When you select Form Operations within the
Categories field, followed by Open Form within the Actions list, the wizard records a macro or event procedure
and attaches it to the command button’s On Click property.

Figure 14.40 You can further customize the form by adding a command button to perform a specific task such as closing or printing
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the form. (Used with permission from Microsoft)

Text Boxes
Text boxes are great items to elevate the use and function of any form. They can be bound to a field or
unbound. You can use an unbound text box to display the results of a calculation or to accept input that you
don’t want to store directly in a table, such as the current date and time—information that is not connected to
a field in a table or query.

It is easiest to add an unbound text box in Design View. On the Design tab, in the Controls group, click Text
Box. Position the pointer where you want the text box to be placed on the form or report, and then click to
insert the text box (outlined in yellow in Figure 14.41). In this example, the expression =Now() was added to the
unbound text box within the property sheet (circled). (Note that Access also places a label to the left of the text
box. In this example, the label was deleted, as the current date and time do not require a label.)

Figure 14.41 Elements such as the date and time can be added to text boxes when inserted into the form. (Used with permission
from Microsoft)

Combo Boxes
A combo box is an object or control that you can also place on a form. It displays a list of values from which a
user can quickly select. The values displayed within a combo box can be populated by a table/query, value list,
or field list. Combo boxes are commonly used in forms to provide users with a list of choices to select from,
while also allowing them to enter a new value if none of the predefined options meet their needs.
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Combo boxes are helpful for numerous reasons. As an example, they can simplify data entry by providing
users with a list of predefined options to choose from, which can help reduce errors and ensure data
consistency. In addition, combo boxes can be set up to validate the data entered by users, such as by checking
if the input matches a specific format or if it exists in a related table. This helps ensure the data entered into
the database is accurate and complete. In consideration of your users in retail, combo boxes can increase
efficiency by allowing retail associates to quickly select from a list of options, rather than having to manually
enter the information every time they handle any of the inventory.

In the example shown in Figure 14.42, a New Customer form is designed with two combo boxes: one for State
and the other for City. These two combo boxes were designed differently. The State combo box was built from
a table of state names and abbreviations, while the City combo box was built from a query of city and state
names. The query is set to display only the conditions selected by the State combo box.

Figure 14.42 Drop-down menus can be helpful to reduce the amount of information the user needs to type manually into the form.
These menus can be formatted and built in different ways, as evidenced by the State combo box in (a) and the City combo box in (b).
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(Used with permission from Microsoft)

An additional option that can be added to any combo box is the ability to update the list provided in the combo
box. In the example, only a couple of states and cities are listed, so you may want to include a shortcut for
adding a new state or city to the table. Combo boxes maintain spelling integrity.

In this example (see Figure 14.43, frmState (circled) is a form designed to update the tblState table. This form
was then added to the List Items Edit Form criteria on the associated property. Users can select List Items Edit
Form option, located in the property sheet, which launches the frmState form to update the table.

Figure 14.43 A table in the database (a) can be used to populate the options in the combo box so that if edited, (b) the form is
automatically updated as well. (Used with permission from Microsoft)
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Changing the Appearance of a Form
This section discusses changes that make a form easier to use and more appealing overall, and that will allow
for personalization of the project, including company branding.

Before you start to manipulate the appearance of a form, consider creating a template for both primary
default views: Single Form View and Continuous Form View. It is important to have a starting point to build
from if you anticipate creating numerous forms for the project, all of which will require formatting changes. In
this section, you will learn how to add headers and footers, add a title, modify text, control colors, and, finally,
add logos and custom imagery. This will be the starting point for you to explore your creativity.

Adding and Modifying Headers and Footers
Adding Header and Footer sections to a form in Access takes just a few simple steps. Start by displaying the
form in Design View (see Figure 14.44). Right-click on the grid area on the design surface and select Form
Header/Footer from the shortcut menu.

Figure 14.44 You can include company information or logos to each page of the form by adding a header. (Used with permission
from Microsoft)

Adding a Title to the Form
A clear and descriptive title can help users quickly identify the purpose of the form and understand how it
relates to the overall database. This may be the very first thing they see when the form opens. A well-crafted
title can communicate important information about the form, such as the type of data it contains, the purpose
of the form, or the specific function it serves within the database. This can help users understand how the
form fits into the larger context of the database and improve their overall understanding of the system. In
addition, consistent use of titles can help maintain a cohesive and organized database structure, making it
easier for users to locate specific forms and navigate the database overall. In consideration that you’re a
WorldCorp employee, adding a title to a form can add a level of professionalism to the database and make it
look more polished and organized. This can improve the overall perception of the database.

Often, the original form design is built around the title. When you envision a WorldCorp user interacting with a
form you designed, consider the title placement, size, and font selections in correlation with the company
branding.

As shown in Figure 14.45, you can add a title from Design View, on the Form Design Tools tab in the Header/
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Footer command group. Select Title (circled) to add a text box to the Header section of the form (Figure 14.46).

Figure 14.45 Including the date and time in the header could be helpful especially when sorting or tracking information from
completed forms. (Used with permission from Microsoft)

Figure 14.46 The title of the form should be descriptive of the data you will collect in the form. (Used with permission from
Microsoft)

Adding and Formatting Text
In today’s modern world with information at our fingertips, marketing toolkits (MTs) are often available and
are expected to be used when available. Numerous company websites now have highly detailed information
on their branding. As an example, Tennessee Tech (https://openstax.org/r/78TNTech) is one of many institutes
that make branding information available to both employees (faculty and staff) and customers (students). This
enables their current workforce and stakeholders to post on social media, post flyers, or add branding
information to newsletters as a way of promoting the company culture. MTs provide users with the various
elements the company requires—all promotion, training, and public relation materials. From the color scheme
to the font to the logo placement, expectations in design are being elevated every year.

In the current example, make sure to select the text box that you want to format. If you want to apply the
same formatting to multiple text boxes, click and hold Control on the keyboard to select multiple text boxes
before you apply the desired formatting (see Figure 14.47).

968 14 • Advanced Database Use

Access for free at openstax.org

https://openstax.org/r/78TNTech


Figure 14.47 The tools to customize the header are similar to the text formatting tools in other Microsoft apps. (Used with
permission from Microsoft)

When you are working in Design View, remember to return to Form View to preview your results. You may
need to repeat this several times to achieve your desired formatting.

Adding Logos and Images
Logos and images are important elements to add to forms for several reasons. They can be used to reinforce
the WorldCorp branding and create a consistent visual identity across all aspects of our databases, including
forms. They can enhance the visual appeal of a form, leading to a more engaging and attractive experience for
the user. They can also be helpful in communicating information to users—for example, highlighting important
points, guiding users through a process, or providing visual cues for navigation. Consider the rapid rise of self-
ordering screens at your local fast-food restaurant. Images help a diverse group of users identify what they
would like to order from the menu.

In addition, logos and images can evoke emotional responses in users, creating a more positive overall
experience. For example, using images of happy customers can help create a more positive association with
the database and improve user satisfaction while helping a customer in a retail location. Adding logos and
images can improve the overall user experience and encourage users to use the database more frequently.

To insert a logo from Design View, select the text box that was created when inserting the title. Then, select
Logo (Figure 14.48). The Windows folder will open, allowing you to select a picture file to be inserted as a logo
(Figure 14.49).
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Figure 14.48 Insert your company logo in the header to customize the form. (Used with permission from Microsoft)

Figure 14.49 After you have added elements such as the company logo, you can preview what users will see using the Form View
from Form Design tab. (Used with permission from Microsoft)

Formatting a form can be an enjoyable and creative process. It is satisfying to invest the time needed to craft
the most visually pleasing form. Once you are satisfied with a design, consider creating a template of it that
you can copy and paste as a starting point for additional forms. That way, you can avoid duplicating the effort
that you have put into perfecting your form design.

14.4 Customizing Reports

Learning Objectives
By the end of this section, you will be able to:

• Create a customized report
• Modify what appears on a report
• Change the appearance of a report

Reports offer a way to view, format, and summarize the information in your Access database. For example, at
WorldCorp, you can create an invoice for all your sales, or a summary of total sales across different regions
and time periods depending on which corporate business unit on WorldCorp you are surveying. In the chapter
on Understanding and Using Databases, you learned about how to create and modify reports using the Report
Wizard. In this chapter, we will go deeper into creating and modifying reports.
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Building a Custom Report
The Report Wizard does provide a quick and efficient way to create reports. At times, however, you will need to
make a report from scratch. Understanding the section types enables you to use them to their fullest potential.

Often, queries are used to combine tables and define fields that will be included in a report at WorldCorp. As
with creating a form, queries become the primary building block for developing a desired report that meets
the current demands of the ever-changing WorldCorp objectives.

A report is divided into sections that can be seen in Design View. To create professional-looking reports, you
will need to understand how each section works. For example, the section in which you choose to place a
calculated control determines how Access calculates the results. What you want on the cover page of the
report may be very different than what you want at the top of the pages that follow.

In addition to the report header, page header, report footer, and page footer, which we covered in
Understanding and Using Databases, there are other sections in the report that you should know:

• Group Header: This section appears at the beginning of each group in the report and is used to display
summary information about each group.

• Detail: This section is where the actual data from the report is displayed. It appears for each record in the
report.

• Group Footer: This section appears at the end of each group and is used to display summary information
about the group.

Using these sections allows you to create a well-organized, easy-to-read report that contains all the necessary
information.

Modifying a Report
There are several tools and views that you can use to create, format, and customize reports. The different
views allow you to see and preview your report in different ways, each of which may be useful to you at times.
We reviewed these different views and some of these tools in Understanding and Using Databases, but here,
we will go into more depth.

Layout View
Layout View is a great way to see the print preview grid lines, with the ability to change the size and placement
of all labels, text boxes, and design elements. Right-clicking and selecting Layout View shows how much of the
report will fit on a page. In Layout View, each control on the report displays real data, making this a useful view
for setting the size of controls or performing tasks that affect the report’s appearance and usability, as Figure
14.50 shows.
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Figure 14.50 In the Layout View, you can make changes while viewing the form to see how the user will see the form with data
included. (Used with permission from Microsoft)

Design View
In Access, Design View is a view that allows you to create and customize the layout and structure of a report.
Design View is an important feature for creating professional-looking reports, as it allows you to customize the
design and appearance of the report to suit your needs.

When you open a report in Design View, you’ll see a grid that represents the layout of the report. The report is
divided into several sections, including the Report Header, Page Header, Group Header, Detail, Group Footer,
Page Footer, and Report Footer. Each section has its own set of properties that you can modify to change the
appearance and behavior of the section. You can also add various types of controls to the report, including text
boxes, labels, buttons, and images in this view. Grouping and sorting options to the report can help organize
and display the data in a meaningful way.

Design View also allows you to set properties for the entire report, such as its orientation, margins, and page
size. You can also add themes and styles to give the report a consistent and professional appearance. Overall,
this view allows you to create custom reports that suit your needs in inventory management and retail store
operations while at WorldCorp. By taking advantage of the many customization options available in Design
View, you can create reports that are both informative and visually appealing.

As you can see in Figure 14.51, the Design View includes all sections of the report.
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Figure 14.51 The gridlines in Design View are helpful to keep the form looking professional by lining up controls and sizing elements
appropriately for the fields. (Used with permission from Microsoft)

Grouping and Sorting in a Report
Tools that can group and sort your information will be of utmost importance when organizing your report.
Information is often easier to understand when it is divided into groups. For example, in the invoice for
Awesome Clothes Inc., the sections are used to group the details and relevant information. In addition, placing
a total (a sum of all Amounts) in the Report Footer section can replace a lot of manual interaction with a
calculator. The customer can quickly see the total of the grouped sections, showing the amount owed.

Grouping and sorting are important features in Access reports that allow you to organize data in a meaningful
way. Additional considerations why you might want to use grouping and sorting in your Access reports are
endless. Grouping and sorting can make it easier for users to read and understand the data in a report. By
grouping related data together and sorting it in a logical order, you can help users quickly identify patterns
and trends. It also allows you to summarize data by creating subtotals or totals for each group. Sorting can
help you identify outliers or anomalies in your data. For example, if you’re sorting a list of customers by
purchase amount, you might notice that one customer has made an unusually large purchase, which could
indicate a potential sales opportunity or a data entry error.

Grouping and sorting can help you make more informed decisions by presenting the data in a clear way. By
using these tools in different ways, you can analyze the data from multiple perspectives and identify
opportunities for improvement. By using these features, you can create reports that are more informative and
easier to understand, which can ultimately help you make better business decisions that affect our success at
WorldCorp.

Filtering Records
Another useful tool in Access is the filtering tool. This gives you the ability to filter a report prior to printing or
presenting the information. There are just a couple quick steps you can take every time to ensure the
information that is obtained in the report is correctly filtered to the desired data points.
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To start, open the report in Design View. Click on the Sorting and Grouping button in the Grouping & Totals
section of the Design tab on the ribbon. In the Sorting and Grouping dialog box, select the field that you want
to filter by. Simply click on the “...” button next to the Filter property. In the Filter dialog box, select the criteria
that you want to use for the filter. You can select from a variety of options, including Equals, Not Equals,
Contains, Does Not Contain, Between, and more.

Enter the value or values that you want to use for the filter. You can enter a single value, multiple values
separated by commas, or a range of values. Next, click the OK button to close the Filter dialog box and save
and close the report. Open the report in Print Preview or Report View to see the filtered results. Note that you
can also apply filters to a report while viewing the report in Print Preview or Report View. To do this, click on
the Filter button in the Sort & Filter section of the Home tab on the ribbon, and then select the criteria that you
want to use for the filter.

To use an actual example, let’s filter our customers living in Ohio. Simply right-click on states listed as OH, and
click Text Filters - Equals OH (see Figure 14.52).

Figure 14.52 A report of information gathered from data entered into the form can be sorted and filtered by text or by fields. (Used
with permission from Microsoft)

In Figure 14.53, Access applies the filter, and you can now print the report including only the data selected
from the filter.

Figure 14.53 The report will only display the information based on the filter; the remaining information will be hidden but is still
contained in the table. (Used with permission from Microsoft)

Adding Totals and Subtotals
Adding totals and subtotals to a report in Microsoft Access is useful for summarizing data and providing
meaningful insights to numerous activities at WorldCorp. A few reasons why you might want to add totals and
subtotals to your report could include summarizing data, grouping data, identifying outliers, and comparing
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datasets.

Totals and subtotals allow you to summarize data in a report by providing aggregate values such as sum,
average, count, minimum, maximum, and more. This can help users quickly understand the overall trends in
the data. Grouping data by a particular field or criteria, such as by department or product category is very
useful for subtotals by allowing users to analyze the data from different perspectives. Totals can be used to
identify outliers or anomalies in the data. For example, if the total sales for a particular product are much
higher than the other products, it may indicate that there is a potential opportunity for growth. In addition,
they can be used to compare data across different time periods, geographic locations, or other criteria. This
can help users identify trends and patterns in the data that may not be immediately apparent. Layout View be
used to add totals or averages to a report.

To add a total in a report, start by opening the report in Design View. Click on the field where you want to add
the total. Then, in the Properties window, scroll down to the Total property and select the type of total you
want to add. See Figure 14.54 for the available options. Finally, save the report and reopen it in Print Preview or
Report View to see the total.

Figure 14.54 Access provides some tools to help you analyze information, although not to the extent that you can do data analysis in
Excel. (Used with permission from Microsoft)

Adding Fields to a Report
To add fields to a report in Access, start by opening the report in Design View. Select the Add Existing Fields
button in the Controls section of the Design tab on the ribbon. In the Add Existing Fields dialog box, select the
table or query that contains the fields that you want to add to the report. Select the fields that you want to add
to the report by checking the boxes next to their names. Click the Add button to add the selected fields to the
report.

In addition, you can drag the fields to the desired location on the report once they are added. You can also
resize the fields by dragging the edges of the control box. Make sure to save the report. Once you are done
adding the fields to the report, you can customize their appearance and formatting by adjusting the properties
in the Properties window.

As an example, we will review how text boxes can be added to a report to improve its ability to communicate
information at WorldCorp. Start by opening your report in Layout View or Design View. Note: If your database
does not contain any tables, the Field List pane will be empty. When you find the field(s) you want to add,
double-click the field and then drag it from the Field List pane to the form or report, as Figure 14.55 shows.
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Figure 14.55 From the Report Layout Design tab you can add additional fields to the report from the Tools command group. (Used
with permission from Microsoft)

Adding Time and Date
One area that is very important on an invoice is the invoice date and due date. In addition to the original
purchase date, it can be helpful to calculate a due date or add a mailing date. In the following example, we will
see the procedure for adding three dates: origin date, due date, and mailing date. This custom build will clearly
explain to the customer the payment due date parameters.

Start in Layout View or Design View. The DateOut field, as shown in Figure 14.56 was included in the field list.
This information can be presented on the report and used later in calculating the additional information.

Figure 14.56 Choose the field you want added to the report and place in the report in the desired location. (Used with permission
from Microsoft)
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Formatting a text box prior to copying it is highly recommended to save time and keep attributes alike. In the
example shown in Figure 14.57, copy and paste the label and text box twice, pasting the second instance
directly below the first. Then, change the labels to represent the three dates the customer should see:
Purchase date, Invoice date, and Due Date (Figure 14.58). For appearance, the borders on each label were
changed to transparent.

Figure 14.57 If you are using a similar layout for multiple fields in the report, you can insert once and copy and paste for the
additional fields. (Used with permission from Microsoft)

Figure 14.58 Descriptive titles are needed for each field in the report. (Used with permission from Microsoft)

Next, open the property sheet and select the Invoice Date text box. Change the control source to =Date()—a
quick change that will provide the current date for the text box, as shown in Figure 14.59.

Figure 14.59 By changing the properties for the inserted field, you can add formulas to automatically populate certain aspects of the
form. (Used with permission from Microsoft)

Select the Due Date text box and open the property sheet. Change the control source to =[DateOut] + 30. The
control source is the field to which your text box is linked; it will display the data in that field and any updates
you make to the field. This sample expression makes a calculation: It takes the field DateOut and adds 30 days
to the field. The text box will display the expected due date of the invoice, as you can see in Figure 14.60. As
this is probably the most important date in the report for the customer, change the font to red and make it
boldface. This subtle change will help direct the customer’s eyes to the important due date field.
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Figure 14.60 Mathematical operators can be utilized in field properties to modify dates as needed. (Used with permission from
Microsoft)

Changing the Appearance of a Report
In Understanding and Using Databases, we briefly covered how to add images and custom text to your report.
Here, we will go into detail about further customizing the appearance of your report.

Adding and Formatting Text
Many companies require particular directions when they invoice their customers. Terms and conditions are
required and standardized through contracts. Placement, size, and accessibility are important, especially for
current or future customers. In the example of the customer invoice, suppose you want to include a direction
in the Page Footer section to instruct the customer on how to make a payment. In the following example, a
label is used in the Report Footer section as direction for making payment. It provides information on how to
direct the payment and where to send it. In designing this label, you will need to know how to set the size,
font, and color to meet company guidelines or standards.

To do this, open the report in Layout View and select the Label option from the Report Layout Design Controls
(see Figure 14.61). Draw the label in the Footer section and proceed to enter the payment directions.

Figure 14.61 The tools available to customize a report look very similar to those used to customize a form. (Used with permission
from Microsoft)

While still on the label, select the Label option Format and adjust the font, size, and color within the font
section. Within the label, font styles, sizes, and colors can be changed from the ribbon, as in all Microsoft Office
products (Figure 14.62).

Figure 14.62 Text contained on a form can be adjusted by size, font type, and others similar to changing fonts in Word. (Used with
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permission from Microsoft)

Once complete, review the report in Print Preview View. Make sure the message is displayed in the correct
position and with the correct formatting. You can repeat these steps for any other information that may be
standardized on the report (e.g., contract guidelines or customer service contact information).

Adding Page Numbers
Open the report in Design View or Layout View. On the Design tab, in the Header/Footer group, click Page
Numbers. When the Page Numbers dialog box appears, choose the format, position, and alignment that you
want (Figure 14.63). Note: If you do not want a number to appear on the first page of the report, be sure to
uncheck the option to clear the Show Number on the First page checkbox. When you are done, click OK, and
the page numbers will be added to the report. (To see how the page numbers will look when the report is run,
switch to Print Preview.)

Figure 14.63 (a) In the Header/Footer command group, page numbers can be added to multi-page reports. (b) Just as in Word, you
can determine the formatting and location of the page number on the report. (Used with permission from Microsoft)

Adding Logos and Images
In the example of the customer invoice, a company logo helps clearly represent the company’s ownership and
brand. Beyond simply using font styles and colors to distinguish your company, a company logo can make
reports look professional. Note: Before finalizing a report that may go out to a large audience, be sure to check
with your company’s guidelines on placement, size, and color guidelines for logos. Larger companies often
offer a marketing toolkit to help guide employees in the use of logos.

To better understand the use of logos, we will walk through steps for adding and modifying a static image on a
form, using our clothing company example.

First, choose the image that you want to use as the logo for the clothing company. Ideally, this image has been
given to you or made available. Company logos are usually saved as a JPEG or PNG file type. Open the report in
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Design View when you are ready to add the logo. Select the Image button in the Controls section of the Design
tab on the ribbon. This will add an image control to the report.

Resize the image control to the desired size by dragging the edges of the control box. Right-click on the image
control and select Properties from the context menu. In the Properties window, go to the Picture property and
click on the ellipsis button (...) to select the image file that is the saved logo.

In the Picture Size Mode property, choose the Clip option to ensure that the image is displayed at its original
size. Save the report once complete. You can also modify the appearance of the image by adjusting the
properties in the Properties window. For example, you can change the border style, color, and thickness, as
well as the background color of the control box. In this example, shown in Figure 14.64, the logo was placed in
the center of the invoice header section, replacing the company name.

Figure 14.64 Company logos are an important part of reports such as invoices sent customers and are easily added in the header.
(Used with permission from Microsoft)

Now it is time to print your report. Before you do, make sure you are happy with the final version. Remember
that although forms are designed for users, reports are for audiences and stakeholders. It’s important to
consider whether your message and data are clearly presented and whether the report meets all company
guidelines for publication.

SPOTLIGHT ON ETHICS

Privacy in Two Acts: FERPA and HIPPA

Personal information such as addresses, work history, and in some cases medical history, could be
contained in a variety of different databases and with a variety of different organizations or companies. Our
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personal information is regularly exchanged and sold to entities to solicit sales, send mailers, or for political
purposes just to name a few examples. More and more people are becoming concerned with the use and
privacy of their information.

Two areas of particular concern are medical data and academic/educational data. You might be familiar
with FERPA – The Family Educational Rights and Privacy Act of 1974. This piece of legislation was passed to
protect your academic records. The Act also gives protections to individuals for how their educational
records are used by government agencies such as the Department of Education. Your right to keep those
records private is part of the legislation. In addition, you have the right to request your records at any time.
The data essentially belongs to you. There are certain provisions that allow usage of the data for reporting
and auditing purposes. But when the data is used, personally identifiable information is generally not
disclosed.

In a similar manner, HIPPA, or the Health Insurance Portability and Accountability Act of 1995, protects your
medical information. Your specific medical information is kept private under most circumstances.
Information such as treatment plans or medication might be shared with insurance companies but that
information is protected through the insurance companies from outside entities under the same HIPPA
legislation.

In general, under both legislative acts, unless there is a justifiable compelling reason to disclose your
personal information, it is kept private. Both acts give options for you to disclose to certain entities. For
example, you can decide to allow your parents access to your educational records or your spouse/partner
have access to your medical records. Signed approval for such disclosure is needed to release the
information to someone other than yourself.

14.5 Using Macros

Learning Objectives
By the end of this section, you will be able to:

• Record a macro that automates a common task
• Record a macro that enhances database functions
• Demonstrate some understanding of macro code

A macro is a set of instructions that can automate repetitive tasks or perform complex operations with a single
click. Macros can be created using the Macro Builder, which provides a graphical interface for creating and
editing macros. Examples of how a macro can be used in Microsoft Access are many.

As an example, your database under construction that tracks inventory for retail stores that WorldCorp would
like to launch has numerous options to consider. Each time a new transaction is entered, you need to generate
an invoice for the customer that includes their name, the date of the sale, and a list of the items bought. To
automate this process, you can create a macro that performs the following tasks:

1. Open the Orders table and find the most recent order.
2. Get the customer’s name from the Customers table.
3. Get the date of the order.
4. Get a list of the items ordered from the Order Details table.
5. Create a new record in the Invoices table.
6. Populate the new record with the customer’s name, the date of the order, and the list of items ordered.
7. Save the new invoice record.

Once you have created this macro, you can run it whenever you need to generate a new receipt. Access will

14.5 • Using Macros 981



automatically perform all the necessary steps, saving you time and reducing the risk of errors. Macros provide
the ability to automate repetitive tasks, improve productivity, and reduce errors in database management.

Creating and Recording Macros
Macros can make tasks that you routinely perform in Access quicker through automation. Macros are built
using computer coding language to perform specific tasks such as running reports, printing forms, or copying
data from one table into another table.

To begin using macros, open the macro design builder, located under the Create tab. This will create a blank
macro builder, which can be saved and stored for later use in the All Access Objects area. The Macro Designer
on the right side (Figure 14.65) contains the Action Catalog, where all of your actions will be stored in folders.
You have Data Entry options, Data Import/Export, and so on, and on the left in the main area you have a blank
canvas to start building your macro.

Figure 14.65 Macros are computer code written within the program to tell the app an action or actions to perform. (Used with
permission from Microsoft)

Recording a Macro to Automate Common Tasks
Recording a macro to automate tasks in Access is a common way to save time and increase productivity. When
you record a macro in Access, you essentially create a set of instructions that Access can use to automatically
perform a sequence of tasks.

Let’s say you frequently need to create a report that shows the total sales for each region of the country in the
growing area of retail sales. You can use the Macro Recorder to automate this process. First, select the Create
tab in the ribbon and select Macro. In the Macro Builder, click the Record button to start recording the macro.
Perform the actions you want the macro to automate. For example, you could select the fields you want to
include in the report, specify the criteria for grouping the data by region, and apply formatting to the report.

When you have finished performing the actions, click the Stop Recording button in the Macro Builder. Give the
macro a descriptive name and save it. Now, whenever you need to create a report that shows the total sales
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for each retail store, you can simply run the macro you recorded (Figure 14.66). Access will automatically
perform all the steps you recorded, saving you time and reducing the risk of errors.

Figure 14.66 Recording a macro is an easy way to automate a task such as running a report or printing a form that you perform
regularly. (Used with permission from Microsoft)

A common use of macros is to add a button to a form. In the previous section, we discussed how a Main Menu
form can help improve user experience by creating a navigation map. Buttons can have macros embedded
that open and close certain forms; they can also control what record source is displayed.

For example, suppose you want to add your customer form to the Main Menu. The original goal is to add a
button that will open the customer form. However, if you want to add a button that will add a new customer,
you can create a macro that will open the customer form and move the record to the new source. The open
form is shown in Figure 14.67.

Figure 14.67 Macros can be added to forms through buttons and can be programmed to perform a wide variety of actions such as
adding a new field. (Used with permission from Microsoft)

You will see the form name with a drop-down arrow, which will show you the forms available in your database.
For each form, there is a View option, which will allow you to open the form in Form View, Design View, or Print
Preview View. You also can apply a filter name or a condition. In Figure 14.68, the macNewCustomer macro
that was created centered on finding particular records. You will notice this option is available to modify.
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Figure 14.68 The drop-down menus give you options such as adding or deleting records in the form. (Used with permission from
Microsoft)

Recording a Macro to Enhance Database Functions
By customizing your database with macros, you can create a system for accomplishing many similar
operations easily and efficiently. Two common applications for macros are displaying message boxes and
validating data:

• Displaying a message box: You can use the MsgBox action to display alerts, warnings, and other useful
information. The MsgBox action has four arguments: Message, Beep, Type, and Title.

• Data validation: Often used in Microsoft Excel, data validation is an extremely helpful step to take prior to
adding the data to the database. To ensure that only valid data is entered in a form, you can specify a
validation rule for the control in the form or set record and field validation rules in the underlying table
design. For more complex data validation, you can use a macro or an event procedure to specify the rule.

As another example, you can use the RunApplication macro to run a Microsoft Windows-based application,
such as Excel, Word, or PowerPoint, from within Microsoft 365. For example, you may want to paste Excel
spreadsheet data into your Access database. This can greatly enhance your database’s ability to work with
imported data.

Reviewing Completed Macros
One of the easiest ways to review a macro is to simply run the macro and see if the desired outcome occurs. At
any point, a macro can be edited to better serve the database developer’s goal for how it will function.

To review completed macros in Access that have been developed, you can start by opening the database that
contains the macros you want to review. Go to the Navigation Pane on the left side of the screen and select the
Macros option. This will display a list of all the macros in the database.

Double-click on the macro you want to review. This will open the macro in Design View. In this view, you can
see all the actions and conditions that make up the macro. You can review each action to ensure that it
performs the intended task and that it is configured correctly.

To run the macro and test its functionality, click the Run button in the Macros tab of the ribbon. This will
execute the macro and perform all the actions defined within it. If you encounter any issues or errors while
running the macro, you can use the Debug mode to review the code and identify the problem. To exit the
Design View of the macro, click the Close button in the top-right corner of the screen. By reviewing completed
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macros in Access, you can ensure that they function as intended. Additionally, you can use the insights gained
from reviewing completed macros to improve future developments with your overall programming skills.
These are big steps are mastering relationship databases.

Understanding Macro Code
Figure 14.69a shows how to add code to an event procedure. Although there is a steep learning curve for
understanding the syntax, its applications are unlimited. In this example, we want to create a message box
that will appear when a user opens the form. The code is written out just below the comments (shown in green
in Figure 14.69b) that were added. Whenever you add new code, either directly or by using a macro, be sure to
include a comment. If there is a problem or a future need for a change, comments can help clarify what the
code was designed to accomplish.

Figure 14.69 (a) Using the Code Builder tool you can write the computer code to perform specific actions in Access. (b) The Code
Builder tool adds in the specific requirements for the computer code to work such as “ “ and commands. (Used with permission from
Microsoft)

After opening the builder options menu, select Code Builder. This will open a new window, as shown, that will
allow the developer to type in the desired code directly. This code can be broken into four sections.

First, MsgBox has been identified as the action. Because it is placed in the event procedure On Open, a
message box will appear when it opens.

14.5 • Using Macros 985



Second, text for the message box—in this example, “Ask how they heard about us!”—is included to remind
associates to ask the customer this basic engaging question while taking a new customer order.

Finally, there is a request for which form to open after the message box appears. The following message box
shown in Figure 14.70 was created through the code.

Figure 14.70 Message boxes can be added to forms to give users specific instructions. (Used with permission from Microsoft)

Understanding Visual Basic
Visual Basic for Applications (VBA) is a programming language that is integrated into Access, allowing you to
create custom solutions for data management, reporting, and other tasks. VBA provides a powerful set of tools
for developers to create robust and scalable applications within Access.

Some examples of how VBA can help developers in Access include automating repetitive tasks. With VBA,
developers can create macros and scripts to automate repetitive tasks, such as importing data, running
reports, or updating records. This can save time and reduce errors by eliminating the need for manual data
entry.

Customizing user interfaces can be written in VBA and can be used to create custom forms and dialog boxes to
provide a user-friendly interface for working with data. Developers can add buttons, menus, and other
controls to simplify complex tasks and make the application more intuitive. VBA can also create custom
functions and algorithms for analyzing data within Access. Developers can create advanced data models and
calculations to help gain insight data. One of the keys to VBA is opening up the ability to integrate with other
applications. It can be used to integrate Access with other applications, such as Excel or Outlook. This allows
developers to create custom workflows and exchange data between applications.

VBA can be used to create custom reports within Access, including dynamic reports that update based on user
input or other data sources. In summary, VBA is a powerful tool that seems to offer endless abilities and
functionality in Access. It provides a wide range of features and capabilities for creating custom solutions to
meet the specific needs of users and organizations. With VBA, you can automate repetitive tasks, customize
user interfaces, enhance data analysis, integrate with other applications, and create custom reports, and that
is just scratching the surface of possibilities.

LINK TO LEARNING

Using VBA will take some practice as you are essentially writing computer code. VBA has a wide variety of
applications to assist you in working Access and also in Excel. Most users can record macros to meet most
of their automation needs in Access. However, if you have more advanced needs and are familiar with
computer coding, VBA can be quite powerful. The best way to show how VBA can expand the power and
agility of Access is by providing a demonstration. Please view this video tutorial on how to use VBA to create
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databases within Access (https://openstax.org/r/78VBADatabase) to learn more.

14.6 Data Analysis and Integration

Learning Objectives
By the end of this section, you will be able to:

• Integrate data from outside sources
• Export data from Access to other applications
• Build a form to serve as a dashboard that is updated automatically

Now that you are comfortable with building and maintaining databases, it is time to start talking about
integration. Suppose you have one database that controls all accounting functions and another that simply
focuses on operations. Integration allows you to share information between these two databases to provide
comprehensive information about the company.

The simplest way to bring data from one Access database into another is by copying and pasting; however, this
method does not support the updating of information, but for better control and flexibility, you may want to
use importing and linking instead. When you import data from one database into another, Access creates a
copy of the data in the destination database without altering the source. During the import operation, you can
choose the objects you want to copy, control how tables and queries are imported, and specify whether
relationships between tables should be imported. Relational databases have many layers and details baked
into the cake. Making sure the details are captured is important.

You may want to import data to create a table or tables that are similar to tables that already exist in another
database. You may want to copy the entire table or you may just need to import the table definitions so you
can avoid the need to manually design each table. When you import only the table definition, the fields and
field properties are copied to the destination database, but not the data in the table. The result is an empty
table, which you can populate with your data.

If your goal is to add records from one database to an existing table in another database, you should consider
importing the records to a new table and then creating an append query. You cannot append records to an
existing table during an import operation.

Integrating Data from Outside Sources
Data stored outside the current database is called external data. External data may be data that you store in
another Access database, or it may be data that you store in a multitude of other file formats. The first step in
bringing outside data from Excel or other applications is to prepare the external data. An administrator may
need to create an account and provide permissions to ensure that the right people have access to the data and
that the data does not end up in the wrong hands. (For example, employees’ confidential information must be
kept absolutely confidential.) In an external database, the administrator may also want to create specific
tables, views, queries, and so on to limit the results to only what is needed.

Access provides a powerful and effective means of presenting data, even data from external sources. When
you access external data, you can either import the data into an Access database or you can link to the data
from an Access database. Importing the data, though optimal, is not always possible. If you can’t import
external data, you should link to external files because Access maintains information about these linked files
that will optimize performance when manipulating the external files.

Importing Data
The first step is to decide what you want to import and how it will join with your existing data. Normally, data is
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stored in various formats, files, and locations, which makes it hard to get and use it. If you have data in a
spreadsheet, a SharePoint list, or some other format, you can import it into an Access database with just a few
steps, making it much more easily available in Access. On the External Data tab, there are a number of tools
for importing and linking to data in the Import & Link command group (Figure 14.71).

Figure 14.71 Data may often be stored in other programs but can generally be imported into or linked to an Access database. (Used
with permission from Microsoft)

Linking to external data is quite different from importing data. Linked data remains in its native format. By
establishing a link to the external data, you can build queries, forms, and reports that present the data. Once
you have created a link to external data, the link remains permanently established unless you explicitly remove
it. The linked table appears in the Navigation Pane just like any other Access table, but with a different icon. In
fact, if the data source permits multiuser access, the users of an application can modify the data, just as users
of applications written in the data source’s native database format are able to do. The main difference between
a linked table and a native table is that you cannot modify a linked table’s structure from within Access.

There are two circumstances in which you should import (rather than linking to) external data:

1. If you are migrating an existing system into Access
2. If you want to use external data to run a large volume of queries and reports, and you do not intend to

update the data.

In either case, you would choose the import option because it gives you the added performance that native
Access data provides.

Steps for Importing
Now you are ready to take the steps to import data from another source. Often, data analytics seems to grow
in Excel. More and more, we see far too much data being stored in Excel. Luckily, the following steps can help
move the data into Access for you.

Open the database into which you want to import objects. You will only be able to import tables and queries
from other Access databases; you can’t import forms, reports, macros, or modules. The location of the Import
Wizard will vary slightly depending on your version of Access. On the External Data tab, in the Import & Link
command group, click New Data Source (Figure 14.72). Follow the wizard directions to add the imported
records.
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Figure 14.72 Access can accommodate importing data from a variety of different sources and file types. (Used with permission from
Microsoft)

As an example, suppose that once a month your local distributor sends you an updated list of wines to sell at
your restaurant. The distributor emails you an Excel file that includes both the updated list of names of wines
and their updated prices. The wines listed will not change often, but the prices will reflect supply-and-demand
changes in the industry. Because the list is extensive, it will be helpful for you to know how to import the list
into Access and then how to make changes as needed.

You will need a table that contains both its own product ID and a corresponding Stock Number—the number
the distributor uses to identify each type of bottle. Figure 14.73 shows an example of the Excel sheet a wine
distributor might send.

Figure 14.73 Data is often contained in Excel spreadsheets that might contain formulas or links to other spreadsheets. (Used with
permission from Microsoft)

In this example, start by adding a new data source from the saved file on your computer. The Import Wizard
dialog box will appear, asking several questions to help you import the Excel data (Figure 14.74). Rather than
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just importing the Excel sheet, you can go ahead and link the sheet, knowing that the distributor will update
the Excel sheet continuously.

Figure 14.74 You can import data into the database you have open as a new table currently or you can instead link it to an existing
table. (Used with permission from Microsoft)

After the link is made, a permanent object is created in the All Access Objects list. The example shown in Figure
14.75 has the WineList table from Excel linked. It will automatically display any changes that have been made
to the Excel file. The Excel table that is now visible in Access is easy to work with and functions much like a
table.

Figure 14.75 The imported data file looks very similar in format to the Excel spreadsheet using the column titles. (Used with
permission from Microsoft)
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LINK TO LEARNING

One of the challenges of managing and analyzing data is understanding what to do when data contains
errors. Read this article discussing data cleaning and what to consider when cleaning data
(https://openstax.org/r/78DataCleaning) to learn more. It will help you understand the importance of
cleaning data as you plan your future data projects.

Exporting Data
To export data from Access, first select the table or other database object to export in the Navigation Pane.
Click the External Data tab in the ribbon, and then click the button in the Export button group for the file
format to which you want to export the object. This will open the Export Wizard for the type of export you want
to perform.

The specific steps shown in each wizard will vary slightly, depending on the file type to which you are
exporting. In most cases, you must select a name and file location for the exported object. You also often need
to set additional parameters for the export routine. You will be prompted to save your export routine, if
desired.

The Export Wizard enables you to export data from an Access database to a file format that can be read by
Excel. When you export data to Excel, Access creates a copy of the selected data and then stores the copied
data in a file that can be opened in Excel. If you copy data from Access to Excel frequently, you can save the
details of the export operation for future use and can even schedule the export operation to run automatically
at set intervals.

Typically, your department or work group will use both Access and Excel to work with data. You store the data
in Access databases, but you use Excel to analyze the data and to distribute the results of your analysis. As
another example, you may be a longtime user of Access, but your manager or another colleague prefers to
work with data in Excel.

Building a Dashboard with Navigation Forms
Dashboards provide a visual interface for users to interact with when using forms. The Dashboard provides a
listing of buttons that direct the user to specific forms or reports. The first thing you see on opening many
Access databases is a dashboard, a form populated with navigation forms that will be accessed through
clicking on the specific command button. Using these provides the means for the user to navigate the
database, opening forms, reports, and so on. The key for the user is a way to navigate. Traditionally, a
dashboard is a graphical interface that allows a quick view of visualized data, as shown in Figure 14.76. In
Access, however, we can build a dashboard from a form that will let us easily run queries and pull up reports.
This section will demonstrate how to upgrade a Main Menu form that has only buttons and labels into a full
dashboard of information for your company to use.
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Figure 14.76 A dashboard is a menu of buttons that allows users to access other forms and subforms that you have created. (Used
with permission from Microsoft)

Planning Your Dashboard
There are four general subtypes of dashboards:

1. Strategic dashboard: focused on long-term strategies and high-level metrics
2. Operational dashboard: shows shorter time frames and operational processes
3. Analytical dashboard: contains vast amounts of data created by analysts
4. Tactical dashboard: used by middle management to track performance

In the following example, imagine that you are a mid-level sales manager who wants to track a basic sales
summary. A tactical dashboard seems like the best fit for your situation. Business intelligence has evolved into
smart solutions that provide effective data management—from extracting, monitoring, analyzing, and deriving
actionable insights needed to stay competitive in the market, to powerful visualizations created with a
dashboard builder, which enable business users to interact with the specific bits and pieces of information they
may need at any time. In this simple example, you want to record and track total orders and number of
customers. Adding these elements to your Main Menu is a good place to start.

Building Your Dashboard
It is often helpful to first make a listing of the forms that will need to be regularly accessed by users. The forms
could vary by department but there might be a group of forms that are routinely used company-wide. At
WorldCorp, key performance indicators (KPIs) are critical to monitor for the success of their strategies. A
dashboard that contains navigation options, as well as KPIs, can help manage the business. Figure 14.77
shows an example of this.

Figure 14.77 Dashboards can include not only navigation buttons but also summary information for tracking purposes. (Used with
permission from Microsoft)

DSum and DCount expressions can add both a sales total and a customer count to your dashboard. These
have been added to text boxes that were unbound to the form. Each text box was then formatted to fit the
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theme of the form. Under form design, Insert Modern Form was selected. This is a simple yet powerful way to
add context to a sale. Additionally, your team can review the form and see the results as they are updated after
each launch of the form. Note that there is an option to Refresh All on the Home tab, which will update the text
box and charts.

REAL-WORLD APPLICATION

Relational Databases in the Cultural World

Many industries use relational databases. They are often hard at work in the background compiling data,
gathering customer information, optimizing inventory, or organizing content for decision making. Database
usage is more evident in industries such as banking, airlines and transportation, manufacturing, and retail.

In recent years, the usage of relational databases in unexpected industries has surged. One example is in
libraries and historical preservation. Libraries and museums have utilized new technologies to make their
collections of archives and artifacts available digitally for a much larger audience to enjoy, appreciate, and
use for their own research. Wilmington College, a four-year liberal arts college in Ohio that was founded by
the Religious Society of Friends (Quakers), has done just that. Through the generosity of a significant peace
activist and donor to the institution, the college has extensive collection of artifacts related to Hiroshima
and the impacts of nuclear weapons held at its Peace Resource Center (PRC).

The PRC archives is the most extensive collection of interdisciplinary materials related to the legacy
of nuclear war in the United States. Each year, the PRC BRMA receives between 400-450 visitors,
including researchers, students, and members of the public. The archives holds documents;
creative responses to the atomic bombings, such as poetry, plays, and artistic works; historic
poster collections; historic photos; slides; scrapbooks; photo albums; 16-mm films; reel-to-reel
audio; cassette tapes; and artifacts among others.

—the Barbara Reynolds Memorial Archivese

Through the use of digital archiving and cataloging in an extensive database, this collection is available
online to the broader public. The searchable, relational database is linked to several research libraries and
contains digital images of the archives and artifacts held in the college’s collection. Many other such
databases of items of historical significance exist across the world such as through the Smithsonian and the
United States National Archives. Historians and archivists have taken advantage of these technological tools
to make history more accessible without compromising the integrity of the artifacts.
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Chapter Review
Key Terms
action query query that specifies a particular action, such as creating a new table, deleting a row or rows

from a table, updating records, or creating new records
aggregate query instruction that carries out calculations on a group of records rather than on individual

records
append query query that adds records from one or more tables to the end of another table or tables
arithmetic operator used to calculate a value from two or more numbers or to change the sign of a number

from positive to negative, or vice versa
command control tool that is used to start an action or a set of actions
comparison operator used to compare values and return a result that is true, false, or null
control source area in the property sheet that controls which data is displayed in a particular field, as well as

any updates you make to the field
crosstab query instructions that calculate and restructure data for easier identification of trends or patterns
dashboard allows users to view account activity at a glance and quickly find records and reports
data validation process of ensuring that data is entered correctly into a form by specifying a validation rule

for the control in the form
delete query query that deletes a group of records from one or more tables
Detail section information that appears once for every row in the record source that is being referenced
external data data stored outside the current database
form control part of a form used to enter, edit, or display data; controls can be bound, unbound, or

calculated
form property option that is set in Design View on the property sheet; they control how the form looks,

works, and interacts with the rest of the database
Group Footer area where summary information appears at the end of each group of records
Group Header area that displays names at the beginning of each new group of records
logical operator used to combine two Boolean values and return a true, false, or null result; also known as

Boolean operators
macro tool that allows you to automate tasks and add functionality to your forms, reports, and controls
make-table query query that creates a new table from all or part of the data in one or more existing tables
many-to-many relationship relationship in which each record in one table can have many related records in

another table, and vice versa; this type of relationship, which really consists of two one-to-many
relationships, is made possible only by defining a table

message box used to display alerts, warnings, and other useful information
null criteria query used to find records that have a null value in a particular field
one-to-many relationship relationship in which each record in one table has one or more related records in

another table, but a record in the second table has only one matching record in the first table
one-to-one relationship relationship in which each record in one table has at most one related record in

another table
parameter query query that allows you to prompt users whenever a query runs
query criterion expression that Access compares with query field values to determine whether to include

the record that contains each value
range criteria query used to specify a range of values for a field
select query query that retrieves data from one or more tables and displays the result in a datasheet
simple criteria query that specifies an exact value or expression to filter results
SQL query query created by using a statement in SQL, a programming language designed to manage data

stored in relational databases
subform form that is inserted into another form (the main form)
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syntax set of rules by which the words and symbols in an expression are correctly combined
tab order helps control which section of the form the curser moves to next
update query query that makes global changes to a group of records in one or more tables
Visual Basic for Applications (VBA) event-driven programming language and environment from Microsoft

that provides a graphical user interface (GUI), which allows programmers to modify code by simply
dragging and dropping objects and defining their behavior and appearance

wildcard symbol used to represent an unknown character in a search string
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Summary
14.1 Advanced Queries in Microsoft Access

• Queries can handle multiple types of criteria to help isolate data.
• Learning how to build/record expressions through correct syntax can help control numerous operators in

a query. Using multiple criteria in a single query can help drill down when asking questions about data
records.

• Creating an aggregate within a query can help find totals and groupings within data.

14.2 Multiple Table Forms
• Adding data from two tables to a single specialized form can be an efficient way to reduce steps and

enhance user experience. Queries are the bedrock of building and designing relational forms.
• Using the Form/Subform Wizard in Access can help ensure the creation of proper relationships.

Understanding how subforms and relationships work opens the door to form design.

14.3 Customizing Forms
• Through the tools in Access, you can add and arrange fields, labels, buttons, and other objects, and set

their properties to control their behavior and appearance in the form. These tools allow you to create
more complex and customized forms.

• Controls are the parts of a form that are used to enter, edit, or display data Adding controls such as
command buttons or combo boxes are added to manage how form looks, works, and interacts with the
rest of the database.

• Elements such as headers and footers, titles, modifications to the text and colors, logos can be used to
customize the form to company specific standards.

14.4 Customizing Reports
• Use report tools to build a custom report in both Layout View and Design View.
• Use report tools to group and sort in a report, filter records, and add totals and subtotals to a report.
• Use report tools to change the appearance of a report by adding fields with time and date, formatting

text, adding page numbers to a report, and adding logos and images to a report.

14.5 Using Macros
• Macros can make tasks that you routinely perform in Access quicker through automation. Macros are built

using computer coding language to perform specific tasks such as running reports, printing forms, or
copying data from one table into another table

• By customizing your database with macros, you can create a system for accomplishing many similar
operations easily and efficiently. Two common applications for macros are displaying message boxes and
validating data.

• VBA is a programming language that is integrated into Access, allowing you to create custom solutions for
data management, reporting, and other tasks. Using the Code Builder tool, you can add specialized
macros to forms and reports.

14.6 Data Analysis and Integration
• Integrating data from outside sources may take some planning.
• Steps for importing and exporting data were reviewed.
• Building a dashboard with navigation forms helps drive business. Plan and build your dashboard around

forms are used most often in the organization.

Review Questions
1. You need to review a database and identify orders placed by a specific customer for more than $50. What
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type of criteria should you use for this Access query?
a. wildcards
b. simple criteria
c. logical operators
d. null criteria

2. What kind of action query would you use to make global changes to a group of records in a table that
needs updating?
a. Action query
b. Update query
c. Crosstab query
d. Delete query

3. ________ let you carry out calculations on record groups rather than performing individual operations.
a. Append queries
b. Update queries
c. Aggregate queries
d. Delete queries

4. What can help build and ensure a relationship between two tables?
a. Dropdown Wizard
b. Lookup Wizard
c. Table Wizard
d. Microsoft Wizard

5. What kind of form is inserted into another form (known as the primary form)?
a. query form
b. auto-form
c. subform
d. drop-down form

6. The most visually intuitive view to use for form modification is ________.
a. Design View
b. Print View
c. Layout View
d. Form View

7. Which feature helps the developer control which section of the form the curser moves to next?
a. Report Wizard
b. tab order
c. property sheet
d. Field list

8. Some customers may find that predefined options on a form do not meet their needs. Which control
provides customers with the option of entering a new value on a form?
a. Text Box
b. Command
c. Combo Box
d. Tab order
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9. Which section of a report do you use for information that might normally appear on a cover page, such as
a logo, title, or date?
a. Report Header
b. Page Header
c. Group Header
d. Page Footer

10. What is the primary purpose of grouping and sorting in Access reports?
a. to display the report title and general information clearly
b. to organize data into sections such as Report Header and Footer
c. to help users quickly identify patterns and trends in the data
d. to format the report with different font styles and colors

11. In Access, which view should you use to review a report and see how it will look when you run it?
a. Design View
b. Layout View
c. Form View
d. Print Preview

12. What is a macro in the context of Access?
a. a type of database table used to store user data
b. a graphical representation of a database schema
c. a set of instructions for automating tasks or performing operations
d. a programming language used for creating web applications

13. How does recording a macro in Access help enhance database functions?
a. It creates queries with multiple criteria.
b. It enables the building of queries that aggregate.
c. It optimizes the Form Wizard to allow users to build a custom form.
d. It creates a system to accomplish similar operations easily and efficiently.

14. How can Visual Basic for Applications (VBA) enhance the capabilities of Access for developers?
a. by providing advanced graphic design tools for creating visually appealing forms
b. by automatically generating complex SQL queries for data analysis
c. by offering integration with external databases and servers
d. by allowing developers to automate tasks, create custom interfaces, analyze data, integrate with other

applications, and generate custom reports

15. When you import data into Access from an external source, what happens to the source data?
a. Importing data always alters the source data.
b. Importing data is not as flexible as copying and pasting.
c. Importing data allows you to modify the structure of linked tables that contain the source data.
d. Importing data creates a copy of the data in the destination database without altering the source

data.

16. When you export data from Access to Excel, what does the Export Wizard do?
a. Exporting data from Access to Excel is a manual process that requires copying and pasting.
b. The Export Wizard in Access allows you to import data from Excel to Access databases.
c. Access creates a link between the data in Access and Excel when exporting data.
d. The Export Wizard allows you to save the export routine for future use and automate the export
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operation.

17. Which type of dashboard is focused on tracking short-term operational processes and metrics?
a. strategic dashboard
b. analytical dashboard
c. operational dashboard
d. tactical dashboard

Practice Exercises
18. Download this sample database from Durham University (https://openstax.org/r/78SmpleDatabase). Open

the database and create an aggregate query that sums the Cost field of the Asset Items table. What is the
total cost of the Asset Items?

19. Imagine that you are a human resources (HR) professional responsible for reducing tardiness in the
workplace. You have a database table listing all of the company’s employees, with corresponding details
about each employee. How would you create a form that will keep track of clocking-in after each change in
the HR Employee Handbook? The form should include the employees’ new clock-in times, date of test, and
any notes taken about the HR changes.

20. Build a simple Main Menu form and create a text box for the current date and time, along with a label that
reads “Main Menu.” Format the text box to Broadway font, centered, and in bright red. Try to center the
label and also to center the text box directly below the label.

21. Create a custom sales report, following these steps:

1. Open Access and create a new report.
2. Use Design View to add the following sections to your report: Report Header, Page Header, Group

Header, Detail, Group Footer, Page Footer, and Report Footer.
3. In the Page Header section, add the column headings for Product Name, Quantity Sold, and Total

Sales.
4. Group the report by Product Category in the Group Header section.
5. In the Detail section, display the product name, quantity sold, and total sales for each product.
6. Calculate the sum of total sales for each product category and display it in the Group Footer section.
7. Add page numbers to the Page Footer section.
8. In the Report Footer section, calculate and display the overall total sales for the entire report.

22. You’re responsible for creating an invoice report for WorldCorp. Customize the report, following these
steps:

1. Create a new report in Access.
2. Add a logo of WorldCorp to the Report Header section.
3. Format the logo to ensure it fits well and looks professional.
4. In the Page Header section, add the company name, address, and contact information.
5. Design the Detail section to show the invoice details, including item name, quantity, price, and

subtotal.
6. Add a calculated field to calculate the total amount for each item.
7. Display the due date of the invoice in the Page Footer section.
8. Format the report to use a consistent font style and size throughout.

23. You are working on a database that tracks inventory for a retail store chain. Whenever a new transaction is
entered, you need to generate an invoice for the customer that includes their name, the date of the sale,
and a list of the items bought. Create a new macro that has multiple steps and save it with a descriptive
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name. Then, run the macro to verify that it generates an invoice.

24. You are working on a database that tracks employee information for WorldCorp. You want to enhance the
user experience by using macros to display custom messages and validate data entry. Create a macro that
displays a message box when the user enters certain data. Then, run the macro to make sure it displays
everything correctly.

25. Go to the Contextures website (https://openstax.org/r/78Contextures) and scroll down to the Sample Data
Files options. Download some sample data to work with. First, create an Excel table, using the data you
have selected. Then, try to link the Excel table into Access. Make changes in the Excel file to see if the
changes are captured in Access.

26. Go to the Contextures website (https://openstax.org/r/78Contextures) and scroll down to the Sample Data
Files options. Download one of the sample sets of sales data to work with. Create a tactical sales
dashboard using Access. This dashboard should provide a quick overview of key sales metrics and allow
you to navigate to detailed reports.

Written Questions
27. You have an online business that pulls in customers from around the world. You want to find out which

countries are the sources of the largest number of orders. Which type of query should you create?

28. Explain why creating one-to-one relationships between tables in a database is not useful.

29. Imagine that you are setting up a database to support a company’s marketing function. The marketing
department wants to use a multiple-choice question to learn how new customers first heard about the
company. Explain the benefits of using a one-to-many relationship when creating a form to collect the
desired information.

30. You developed a well-designed form that works as intended. But users do not understand the purpose of
the form nor how it relates to your overall database. To resolve this issue, what feature should you add to
the form and what steps should you follow to add this feature?

31. Explain the key differences between Design View and Layout View in Access when working with reports.
How can these views help you customize the appearance and layout of your reports?

32. Explain how the Report Wizard and Design View contribute to creating customized reports in Access.
Compare the advantages and limitations of using the Report Wizard versus manually designing a report in
Design View.

33. Explain the steps in making sure that a report is useful and readable.

34. Describe the process of recording a macro in Access to automate tasks.

35. Explain the process for importing an Excel file into an Access database. Describe the steps you would take,
the decisions you would make during the import, and how you would ensure that the data remains up to
date in your database.

36. Apart from Excel, name two other file formats to which you can export data from Access using the Export
Wizard. Provide a brief explanation of when it might be appropriate to use each of these file formats.

Case Exercises
37. You are a data analyst at WorldCorp. Your supervisor has assigned you the task of creating a

comprehensive sales report for the past quarter. The report will provide insights into sales performance,
product categories, and regional sales distribution. You are required to use Access to design and
customize the report. Follow these steps to complete the task:
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Report setup: Use the Report Wizard to choose the appropriate data source (e.g., the Sales table) and
fields for the report. Include fields such as SalesDate, ProductCategory, ProductName, QuantitySold,
and TotalSales.
Customize the report layout: Add the company logo to the Report Header section. Format the logo for
an appropriate size and position. In the Page Header section, add the report title, current date, and
your name as the report creator.
Group, sort, and filter the report: Group the report by ProductCategory in the Group Header section.
Display the product category name and a brief description. In the Detail section, display product
details including product name, quantity sold, and total sales. Add a calculated field to calculate the
average price per unit for each product. Apply a filter to show data for sales within the past quarter
(e.g., between April 1 and June 30). Calculate and display the total sales for each product category in
the Group Footer section. Add a grand total at the end of the report to display the overall total sales
for the quarter.
Formatting and design: Format the text boxes with consistent font style, size, and color. Apply
alternating row colors to improve readability in the Detail section. Use appropriate borders and
spacing to enhance the visual appeal of the report. Add page numbers to the Page Footer section.
Review the entire report in Print Preview to ensure proper formatting and data accuracy. Save the
report with a meaningful name.

38. You have been tasked with enhancing the efficiency of WorldCorp’s database by implementing macros for
automating common tasks and enhancing database functions. Your goal is to create macros that
streamline inventory tracking and reporting processes.

Task 1: Automating Inventory Tracking

WorldCorp needs a way to automate the process of updating inventory quantities whenever new products
are received or sold. Create a macro that performs the following tasks:

1. Open the Inventory table and find the product for which the inventory needs to be updated.
2. Update the inventory quantity based on whether products are received or sold.
3. Save the changes to the Inventory table.

Task 2: Enhancing Inventory Reporting

To improve inventory reporting, WorldCorp wants a macro that generates a report showing low-stock
items. Create a macro that does the following:

1. Open the Inventory table and filter products with low stock quantities (e.g., less than 10 units).
2. Create a new report with the filtered data, including product name, current quantity, and reorder

information.
3. Save and display the generated report for review.

Task 3: Implementing Custom Message Boxes

WorldCorp would like to enhance the user experience by adding custom message boxes to the database.
Create a macro that does the following:

1. Displays a message box when a new product is added to the Products table, asking the user to
confirm the addition

2. Provides options to proceed with adding the product or cancel the operation

Task 4: Reviewing Completed Macros

After implementing the macros for automation and enhancement, review and test each macro’s
functionality. Open the macros you’ve created and ensure they perform the intended tasks accurately.
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Task 5: Reflecting on Visual Basic for Applications (VBA)

Write a short reflection on how VBA could further enhance the automation and functionality of the macros
you’ve created. Identify at least two scenarios where incorporating VBA code could provide additional
benefits to the macros.
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Figure 15.1 Using different programs to meet your business needs is a common practice. Many programs are designed to work

together. (credit: modification of “Team Having a Meeting” by Mikael Blomkvist/Pexels, CC0)

Chapter Outline
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15.4 Microsoft Excel and Microsoft PowerPoint Integration
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15.7 New Developments: The Role of Artificial Intelligence
15.8 Mastering Workplace Software Skills: A Project

Chapter Scenario
We looked at WorldCorp’s business from a wide variety of perspectives. We examined sales data, marketing
data, accounting information, and other relevant items that are essential to their business. Looking at so many
different types and sources of data is a commonplace practice for many companies. Nearly all organizations,
regardless of the type or industry, have different departments or areas that work together and share
information.

For example, at WorldCorp, the sales department might need information from accounting on the price point
and cost of items they are selling to customers. Upper management needs to understand how goals are being
met in each of the sales regions. And outside vendors might need to know projections for the next quarter to
evaluate the impact on their profits. This information can be shared in a wide variety of ways, such as a
narrative report or a spreadsheet—or maybe even both, combined in one file to be shared with several people.

In previous chapters, we briefly discussed the ways the programs can work together to meet the needs of the
organization. This chapter focuses specifically on how the programs can be integrated to combine information
in a professional and meaningful way for the users. The goal is to think broadly about using the programs
together to best get your ideas across to the intended audience. Remember, you need to keep in mind the
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needs of the audience as you prepare the information to be shared. This capstone chapter gives you the
opportunity to practice the skills you learned in previous chapters as well as integrate information from the
various software programs. Referring to the book’s table of contents can help you find supporting content in
this text should you need a refresher.

15.1 Microsoft 365: Collaboration and Integration

Learning Objectives
By the end of this section, you will be able to:

• Explain how Microsoft 365 supports collaboration
• Explain integration across Microsoft 365 apps
• Link and embed objects in Microsoft 365 apps
• Import a PDF using Microsoft 365 apps

WorldCorp is preparing for its annual meeting. Businesses often have a large, yearly meeting to summarize
the organization’s performance over the last year. Publicly traded companies (those that sell stock) are actually
required to hold this kind of meeting each year. Key stakeholders are invited to this meeting, and important
documents and performance metrics are shared in both formal presentations and documents. These key
stakeholders can include a wide variety of constituents, such as the owners of the company, important
customers, vendors, and upper management. This is WorldCorp’s chance to showcase its successes and
highlight goals for the next year. There is a good deal of preparation that goes into the meeting, including
determining the agenda, creating the presentations, and formatting the documents to be distributed. You not
only want the information conveyed to be accurate, but you also want to share the information in a way that is
engaging and easy to follow.

Collaboration in Microsoft 365
Microsoft 365 (more commonly known by its former longtime name, Microsoft Office) gives users the ability to
collaborate on almost any platform. You can access and often edit files on a wide variety of devices through
the downloaded apps. Organizations rely on collaborating to achieve their goals. This, of course, will vary by
industry and type of organization, but most would agree that working with others both within and outside of
the business occurs on a regular, if not daily, basis.

Today we often hear the phrase collaborative workspace. Collaborative workspaces are secure virtual
environments that allow users access to company files, programs, and apps from any location. These
workspaces allow employees to work remotely, and many companies today incorporate such workspaces into
their overall company strategy. By offering employees options to work remotely, companies can meet the
diverse needs of their employees and in some cases have seen an increase in productivity. For example, one
study found that 40 percent of employees indicate they work more hours when working remotely than when
in the office. Employees also indicated they felt less stress. The workspace does not have to be exclusively
virtual but does need to be organized in such a way to foster teamwork and productivity with access to the
needed information and tools to accomplish the company goals.

Programs such as the Microsoft suite facilitate incorporating collaborative workspaces into the company
structure. Through applications such as Microsoft Teams and Microsoft SharePoint, users can share files,
manage schedules, create team folders, meet virtually, and edit documents in real time. Using these features
of Microsoft allows employees located in different parts of the world to work together on a project, even if they
are never in the same physical location. Technological advances have changed how organizations function,
saving them money while aiding employee job satisfaction and work-life balance.
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REAL-WORLD APPLICATION

Remote and Hybrid Workplaces

Drift (https://openstax.org/r/78Drift), a technology firm in Boston, Massachusetts, was founded in 2015 as a
traditional, in-person workplace. As the company grew to include additional offices and employees,
collaborating virtually became a high priority. Like many companies, Drift was forced to move to a fully
remote workplace during the COVID-19 pandemic in 2020. After the initial transition to establish
expectations and common practices for collaboration and acquire the needed technology, the company
decided to remain a fully remote workplace, which has allowed employees to relocate to be closer to family
and make life choices, such as marriage or having children, a bit easier. This has also enhanced the diversity
within the company.

Drift’s Chief People Officer Dena Upton said the company took what is called a Digital First approach:

“It means that our primary work spaces are our homes. The bulk of individual work will happen there. When
the team does come together, we’ll do so in ‘Conversation Spaces,’ or our repurposed offices. Everywhere
we currently have a physical space—Boston, San Francisco, and Tampa—we’re creating collaboration
outposts for group work.”

This is just one example of a company that is realizing the benefits of a remote workplace, at both company
and employee levels. There are, of course, many others, and when employees are given the chance, they
choose remote work. According to a McKinsey & Company American Opportunity Survey, which tracks the
public’s views on economic issues, 87 percent of workers who are offered the chance to work remotely take
the offer.

Not every company, however, is on board with a fully remote workforce. In fact, some high-profile
companies such as Goldman Sachs and Netflix have called employees back into the physical office full time.
To track these trends, visit Hubble (https://openstax.org/r/78Hubble), which specializes in helping
companies set up hybrid and remote solutions. It maintains and updates a list it calls The Official List of
Every Company’s Back-to-Office Strategy.

Integration in Microsoft 365
When applications that serve different purposes work together in a seamless, functional way, this is called
integration. One key feature of Office that fosters integration across applications is the common user
interface. Each application has a similar format and structure. When you open Microsoft Word, for example,
you will notice many of the same functions and tabs that you will see in Microsoft Excel or Microsoft Outlook.
Additionally, the keyboard shortcuts are common among the Microsoft applications. As an example, Ctrl+C
(Command+C for Mac) is the keyboard shortcut for “copy,” and this shortcut works in all Office (and Google)
applications. This commonality between functions, tools, and tabs allows users to easily switch between
applications.

Microsoft SharePoint and Microsoft OneDrive are two other features of Office that help with integration of the
applications. Company files can be stored and shared where all employees can access the information. You can
also manage who can access and edit files in the shared folders. You can think of SharePoint and/or OneDrive
as the main repository of company files. Generally, SharePoint is accessed across the enterprise, while
OneDrive is usually accessed by individual users. These files can be accessed within individual applications,
such as Excel or Teams, or easily emailed as attachments. Files can also be accessed and often edited on a
wide variety of devices.

Microsoft has designed their applications to work together to serve the various informational needs of
individuals and business organizations. Users can see real-time edits to documents, collaborate on creating a
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presentation, or efficiently schedule a meeting using the calendar features. Files can be attached to meeting
invitations, files can be shared via Microsoft Teams, and Excel spreadsheets can be embedded in Word
documents. These are just a few examples of how the Microsoft applications are integrated with each other.

Linking and Embedding Objects
Information from any of the Microsoft programs can be integrated into another program in a few ways. With
integration, you are putting information from one file type into another file type. In previous Excel chapters,
you learned how to copy a table and paste that into Word or PowerPoint. Copying and pasting information
allows you to include the information in your Word or PowerPoint file, but as a static version of the object. This
means that if you changed the information in Excel, it would not be changed in the Word or PowerPoint file. To
update the table in your other file, you would need to copy and paste the table again. This simple process may
be acceptable in some cases, but it can be time consuming and repetitive. Other options for integrating
content from another source include linking and embedding objects.

Linking and embedding items in applications files are useful tools when adding information or objects from
one program to another. The information that you are linking or embedding into another program comes from
the source file. You bring information from the source file to move to another program. For example, you can
bring a table from an existing Excel file (the source file) into a PowerPoint slide (the destination).

Linking items means creating a direct, dynamic connection between the source file and the destination file.
When an object is linked, the information is stored in the original application (the source file) but just displayed
in the other application (the destination file). A link allows the user to work with the information in the source
file and have it update automatically in the destination file. For example, when data from an Excel spreadsheet
is linked to a Word document, the Excel data is stored in the Excel spreadsheet but displayed in the Word
document. This can be a useful function when information from one department is stored separately from
another department, such as in a separate SharePoint folder. You might not want someone outside of the
department to have access to all the files in the departmental folder, but they might need access to selected
information. Note that when linking files together, you need to be sure that all users have access to both files
at least to view the files. For example, if you link a Word document and an Excel file and would like a coworker
to be able to make changes to the linked data, they will need to have access to both the source file and the
destination file.

Embedding an object in another program is much like using the copy-and-paste functions, except that you do
not have to open the other file. Embedding will place a copy of the information from the source file into the
destination file, where it becomes part of the destination file. This creates a static copy, just like copying and
pasting does. It also means that if the information is changed in the source file, it will not be updated in the
destination file where it is embedded. Furthermore, once information is embedded into the destination file,
that information becomes part of the file size of the destination file. For example, embedding a video into a
Word document will increase the file size of the Word document, because it now contains a copy of the video.

To link or embed information from another file, go to the Insert tab and to the Text command group (see
Figure 15.2). Choose the Object function to open the drop-down menu. Because the ribbons are similar across
programs, you should be able to do this in Word, PowerPoint, and Excel.
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Figure 15.2 Other options in the Text command group include inserting a signature and the date/time. This is the Insert tab from
Word. (Used with permission from Microsoft)

Notice that there are two options in the Object menu: Object and Text from File. Using the Object function, you
can either link or embed another file into your current file.

When you first select the Object function, you will see two options (see Figure 15.3): you can create a different
file type from scratch (Create New), or you can get information from an existing file (Create from File).

Figure 15.3 You can use the Insert Object function to insert a wide variety of file types, including PDF files and images. Here, an
Adobe file is highlighted to select, but if you scroll through the list, you will see many other choices. (Used with permission from
Microsoft)

Linking to Objects
When you want to link to a file, you probably already have a file in mind. Select the Create from File in the
Object dialog window, then use the Browse button to search for the file where the information is saved. Tick
the box called Link to file (Figure 15.4).
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Figure 15.4 Click on the Browse button to search for the saved file you would like to integrate into the current file. (Used with
permission from Microsoft)

The Link to file option places a link to the file location in the current file. When you link a source file to the
current file, you establish a connection between the two files. You can then access the source file by double-
clicking on the link. Linking to a source file also ensures that any information that is changed in the source file
will also be changed in the current file. For example, let’s say you want to insert a dynamic link to an Excel
worksheet into a Word document. If any information is changed in that Excel file, that change will be reflected
when you click on the link in the Word document.

However, keep in mind that there is one drawback to linking a source file to another file: If you change the
location where that source file is saved, the link will no longer be valid. Continuing with our previous example,
let’s say that the Excel file that you linked to was saved on your desktop. Later, you move that Excel file to your
OneDrive. If you click on the link in the Word document, the link will no longer work. You would have to insert
the link again using the new location of the source file.

You can also insert links to other files directly from the Insert tab, from the Links command group (see Figure
15.5). When you choose this option, the file name, underlined and in blue font, will be used to show the
linkage. Choosing the Link option directly from the Insert tab will give you a listing of your most recently used
files. If the file that you wish to link is not in the list, you can browse for the file by choosing Insert Link from
the bottom of the drop-down menu.

Figure 15.5 Inserting a link to another file uses the same command group as inserting a link to a bookmark or a cross-reference.
(Used with permission from Microsoft)
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Embedding Objects
You can also use the same Object function, located in the Insert tab, to embed a file. Let’s return to the Insert
Object dialog window, as shown in Figure 15.3. Let’s choose “Microsoft Excel Chart” from the Object type list.
This will insert two Excel worksheets into our destination file: one worksheet containing the chart and the
other containing the data used to build that chart. (We learn more about inserting Excel charts into Word
documents in Inserting Microsoft Excel Charts into Microsoft Word Documents.) You would then add the data
for the chart as you would if you were working in Excel (Figure 15.6).

Figure 15.6 To navigate to the data you will use to build the chart, click on Sheet1 just as you would in Excel. (Used with permission
from Microsoft)

In the Insert Object dialog box, you can also choose the checkbox Display as icon (Figure 15.7). This will insert
an icon for the appropriate program that will allow the user to click on it to insert the object (as in Figure 15.8).
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Figure 15.7 Choosing Change Icon gives you the option to change the icon to something other than the default setting. (Used with
permission from Microsoft)

Figure 15.8 To access the object, simply click on the icon that has been inserted into the file. (Used with permission from Microsoft)

Remember, embedding is similar to copy and paste except that you do not have to actually open the source
file. When embedding information from another file, the application will insert a snapshot of the file where it
was last saved.

For example, if you last saved your Excel worksheet with your cursor on a cell in Sheet4, then essentially
Sheet4 is the selected worksheet. The data on Sheet4 will be embedded into the other file showing the image
of Sheet4. If you are on slide 5 in your PowerPoint presentation when you save the presentation, then slide 5
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will be displayed in the new file. You can double-click on the embedded object, and it will open the source file
type so that you can view the other slides and worksheets if they are present. If you embed an Excel chart, it
will open as Excel where you can make changes. However, these changes will not change the source file. It will
only change the information in the file you are working with currently. The source files will not change when
they are embedded.

Inserting Text from a File
You may recall from Figure 15.2 that there were two options available when inserting an Object from the Text
command group: Object, and Text from File. This option, which allows you to insert text from another file into
the current file, is often used as a shortcut to combine information contained in multiple Word documents. The
Text from File function is available only in Word. It is not an option when inserting objects in Excel or
PowerPoint. And although the source file can be of any type, it is generally easiest to use Word, PowerPoint, or
PDF files because these file types are more textual. If you try to insert text from an Excel file, you may find that
the information is not formatted properly.

Importing a PDF File
There are a few different ways to handle importing content from a PDF file into a Word document. You can
copy and paste the text from within the PDF, try to convert the PDF by opening it with Word, or insert the PDF
into your document as an object.

The copy-and-paste solution is the most straightforward, but this method copies only the text from the PDF. To
use this method, first open the PDF file in Adobe Acrobat (or another PDF viewer), press Ctrl+A to select all,
press Ctrl+C to copy, and then go to your Word document and press Ctrl+V to paste the selected text into
Word. You can also use the other copy-and-paste methods you learned earlier in this book. Double-check to
make sure all the text has copied correctly. If it didn’t, try to select smaller areas instead of the whole
document. Using the copy-and-paste option with PDFs often leaves you with inaccurate line breaks, odd
characters, and other errors to fix, which can be time consuming.

You can also try to open the PDF file using Word’s conversion tools. To do this, locate the PDF file and right-
click to activate your system’s contextual menu, then go to Open with . . . and select Word as the app. This will
effectively convert the PDF to a .docx file, while keeping the images and the text intact. Unfortunately, this
conversion process is not always successful.

As an example, let’s open a graphics-heavy file, such as a report with images on the first page. As shown in
Figure 15.9, Word warns that the file may not look the same after it has been converted to a .docx file. You can
see in Figure 15.10 that the conversion resulted in a number of changes to the text and images on the page.
Therefore, the Word conversion tool may be a better choice for simpler files that do not contain many images
or special formatting, such as section breaks or tables.

Figure 15.9 Opening a PDF file in Word is an option, but it has some limitations. (Used with permission from Microsoft)
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Figure 15.10 (a) The original PDF file had a lot of images. (b) When converted to a Word file, the images remained intact but shifted
on the page. There are also changes to the font style, size, line spacing, and colors.

Finally, you can also insert your source document into Word as a linked object, following the same steps you
used for Excel object insertion. Go to the Insert tab and select the Object drop-down command, then click
Object to open the Object dialog box. On the second tab, Create from File, browse to the PDF file’s folder
location and select the file. Then select the Link to File checkbox and choose OK. Now the item’s first page has
been inserted as an object in the Word document. This is a link to the PDF file, so if you double-click it, the PDF
file will open. To make this first page smaller, hover over one of the corners and, as the mouse pointer changes
from a symbol to arrows, use the mouse to reduce the size of the page.

LINK TO LEARNING

Microsoft continues to improve the features of their programs to facilitate real-time collaboration. This is an
increasingly important capability as more people are working remotely at least part of the time.
Additionally, collaborative features can foster team building and enhanced productivity in an organization,
whether the members are physically in the same location or not. In the future, more businesses may use
Microsoft’s technology to move to a fully or primarily remote business model. Watch this video about some
of the advanced features of the Microsoft suite (https://openstax.org/r/78MicroAdvFeat) to learn more.
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15.2 Microsoft Word: Integration with Microsoft Excel and Microsoft
Access

Learning Objectives
By the end of this section, you will be able to:

• Integrate Word documents into Excel worksheets
• Link Excel worksheets to Word documents
• Insert Excel charts into Word documents
• Embed Access data into Word documents

One key advantage of a suite like Microsoft 365 (Office) is that it enables you to insert information from other
file types into its applications. For example, suppose you want to connect a file with a more narrative structure
to explain your analysis in an Excel worksheet. You can use file integration to include notes that detail the
specific calculations or data sources in Excel. Conversely, in a company-wide report, it may be helpful to
include chart visuals to illustrate how sales have changed over the last quarter. These are just a few examples
of the value of integrating Word and Excel when conveying information to a broad audience.

Integrating Microsoft Word Documents into Microsoft Excel Worksheets
The previous section provided a general overview of linking and embedding in Microsoft. Now we look
specifically at the process for linking and embedding Word files into Excel worksheets. Keep in mind that Excel
is a spreadsheet program. It is not designed to handle large amounts of text. It is a good idea to spend a little
time thinking through the best approach before you try to integrate a lengthy Word document into an Excel
workbook.

Here is an example scenario: You have just finished summarizing information from three of WorldCorp’s top
sales agents for the past month. You have created a Monthly Report memo in Word and an Excel worksheet
that includes a PivotTable. Because the memo is rather short, you decide to incorporate it into your Excel
worksheet rather than sharing two separate files with your team. This makes the most sense because you
want others to be able to manipulate the PivotTable and analyze the information to best meet their needs.
Figure 15.11 shows the Excel file with the PivotTable and chart of the summarized data and Figure 15.12 shows
the memo created in Word.
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Figure 15.11 The summarized data is contained in an Excel file. (Used with permission from Microsoft)

Figure 15.12 The summary memo is in a Word file that can be incorporated into the Excel file by using the Insert Object function.
(Used with permission from Microsoft)

Using the Insert Object function in Excel, you can integrate the Word document into the file. First, place your
cursor where you would like to have the memo information placed in the Excel document. In this example, let’s
choose cell A10. The object will be inserted into the selected cell. Note that you will be able to move and resize
the object once you have placed it on the worksheet, but it is easier to manipulate the object if you insert it in
the general location where you would like it to be. Also note that resizing an object can compromise its
readability—another reason to be cautious about placing large amounts of text in Excel.
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As covered in Microsoft 365: Collaboration and Integration, go to the Insert tab and the Text command group,
and choose Object (Figure 15.13). From there, you have two options: Create New or Create from File. Select
Create from File (see Figure 15.14).

Figure 15.13 Excel considers inserting a file into an existing workbook as inserting an Object. (Used with permission from Microsoft)

Figure 15.14 Remember to choose Create from File when you have the information already saved in another file. (Used with
permission from Microsoft)

The Word file was previously created and saved as Monthly Report. Choose this file and click OK. If the file you
are trying to insert is open, you will get an error message indicating that the file is in use. (Only one person can
be working in a shared file at the same time. Once the person is finished and has closed the file, it will become
available for others to edit.) In that case, simply close the file and insert the object again. Notice that the Link
to File and Display as icon options are available here as well. The information from the Word document is now
in the Excel file (Figure 15.15). Because we did not choose Link to File, the Word memo is embedded in the
Excel worksheet and has become part of the Excel file. This means that if you make any changes in the Word
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document (the source file), they will not be reflected in the Excel file. Notice in the formula bar you see
“=EMBED(“Document”,”). Excel automatically adds this to indicate that an object has been embedded (or more
specifically is now a part of) into the Excel file. In this case, we embedded a Word document, so you see the
word “Document” in the formula. This will be inserted when you choose to embed an object or file. You should
not edit or change this formula.

Figure 15.15 The memo was inserted into cell A10. (Used with permission from Microsoft)

Note that although we selected cell A10 as the cell to insert the memo into, the memo takes up much more
space than this. The cell we select is simply where the top left corner of the object will be, but the object itself
may cover many other cells. This is why resizing is important (Figure 15.16).
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Figure 15.16 Resizing the object enables you to fit it into the space next to the chart, but this also makes the text a bit harder to read.
(Used with permission from Microsoft)

As an alternative to placing the actual text into the worksheet, you can choose to insert the information as an
icon. Adding the icon to the spreadsheet creates a link rather than embedding the text into the Excel file. The
user simply double-clicks on the icon to access the Word file. By choosing Display as icon, you can avoid some
of the drawbacks of inserting blocks of text into a worksheet and have a direct link to the source file. To do this,
select the Display as icon option. Remember that you can change the look of the icon that will be inserted by
choosing Change Icon (Figure 15.17).

When the icon is placed in the worksheet, it will contain the file name, “monthly report.docx” in this case.
However, because the file name has a space in it, the program will insert the Unicode for a space, which is
“%20”. (Note: Unicode was discussed in Document Preparation.) Notice that the icon displays the file name
with the “%20” where the space was located. This is a quirk of the program that cannot be avoided.

15.2 • Microsoft Word: Integration with Microsoft Excel and Microsoft Access 1017



Figure 15.17 (a) Make sure there is a check in the Display as icon box if you want to insert an icon rather than the actual text in the
Word file. (b) The icon appears much smaller than the embedded memo content. The Word icon makes it clear that the file is a Word
document. (Used with permission from Microsoft)

Finally, you can choose to link the Word document and the Excel spreadsheet using the Link to File option. This
provides a dynamic link to the file so that any changes made in the Word file will also be reflected in the Excel
file. To insert a link to the file, tick the checkbox, Link to File, and click OK. Generally speaking, providing a link
is the preferred option unless you are certain that the source file is not going to change. However, remember
that if the file path (where the source file is saved on your computer or in your cloud drive) changes, you will
need to insert the link again into your Excel worksheet.

Integrating Microsoft Excel Worksheets into Microsoft Word Documents
Now we look at integrating an Excel file into Word. This is quite common in organizations when preparing
summary reports that include data. Excel is used to summarize, analyze, and prepare visuals such as charts of
the data. Word is then used to provide some textual context and additional information. We follow steps
similar to those that have previously been discussed for integrating Excel worksheets into Word documents.

Let’s go back to the WorldCorp Monthly Report example. The management team would like to include
information from the sales department in their monthly report. The monthly report is created in Word and
ideally would include some text, the data tables, and any charts or graphs that help summarize the data. The
report is distributed to all members of the management team to keep them updated on the company’s
progress toward year-end goals. You want to include the data from the Excel worksheet in the document.

We start by embedding the summary table from the March sales data in the Excel file into the monthly report
file created in Word. First, open the Word document and determine where you would like to display the Excel
information. The information will be embedded at the cursor location in the Word file. Go to the Insert tab,
then the Text command group, then Object. Follow the same procedure we used previously. The Excel data will
insert as a clean table into your Word document (Figure 15.18). If your Excel file has multiple worksheets, you
will have to double-click on the table to see those other worksheets. You can also use this double-click
functionality to access the Excel data and edit it directly in Word (Figure 15.19). Remember, the Excel file must
not be open when using the Insert Object tool. Also remember that you are embedding this into the Word
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document. If any information in the source file (the Excel file) changes, it will not be updated in the Word file.

Figure 15.18 The table from the current worksheet in the Excel file will be embedded into the Word document. (Used with
permission from Microsoft)
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Figure 15.19 Double-clicking on the table will give you Excel functionality to make changes to the table. You can also see the other
tabs when you do this. (Used with permission from Microsoft)

At this point, the report is still a draft, so you anticipate changes to the data. You want to be sure that the
report reflects accurate information when it is distributed, so you would like to replace the embedded
information with a link. Linking to the Excel file means that information that is changed in the source Excel file
will also be updated in the Word file. Choose the Link to File option to create the connection between the two
files of different types. Visually, the result will look the same in the Word document, but any changes that are
made to the source will be automatically reflected in the table in the Word document. Double-clicking on the
table will open a new Excel window of the source file. Finally, you again have the option to include an icon
instead of the actual table.

Another available method for inserting Excel content into a Word document is to use the Insert tab to place an
Excel workbook into a Word file, allowing you to work in that interface as you normally would in Excel. To do
this, go to the Insert tab, then select the Table drop-down menu and choose Excel Spreadsheet, as shown in
Figure 15.20a. A blank Excel object will appear in Word, as shown in Figure 15.20b. (Note that this option is not
available to Mac users.) You can then paste the copied table onto this blank document or add new data and
create the table. This table will not be linked. This method gives you the same functionality for sizing columns,
sorting, and inserting formulas as you would have in Excel. The Excel worksheet is simply placed inside the
Word file. Keep in mind that when you choose this option, the Excel file you create inside the Word document
does not stand alone but becomes part of the Word file. Therefore, to make changes to the Excel spreadsheet,
you need to access the Word file. As a result, this option is not very practical if you need to create a large
dataset. You might need to make changes to the Excel file, and working in Excel as an object in a Word file can
be cumbersome. However, it can be useful as a quick and easy way of providing others with access to Excel
data without sending multiple files.
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Figure 15.20 (a) You can insert an Excel spreadsheet as an object in a Word file. This option is under the Insert Table drop-down,
rather than the Insert Object drop-down menu. (b) You will now have an Excel window within the Word document that you can use to
add data, make charts, and calculate formulas. (Used with permission from Microsoft)

Finally, you can always copy and paste Excel information into the Word file. To do this, go to the Paste drop-
down menu, accessible from the Home tab. This drop-down menu gives you six options, as seen in Figure
15.21.

Figure 15.21 When copying an Excel table to be inserted into a Word document, you have several options for pasting the table into
the document. (Used with permission from Microsoft)

You begin by selecting a table in the worksheet in Excel and copying it with Ctrl+C or by using the Copy tool
from the Home tab. Then head to Word to paste the table into the document file. The table shown lists the
different options for pasting the Excel information into the Word file Figure 15.22.
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Figure 15.22 There are six copy-and-paste methods you can use when importing from Excel. Each one will result in a different
appearance on the page. (Used with permission from Microsoft)

Let’s look at an example of each copy-and-paste option. Figure 15.23 shows an example Excel table, as it
appears in Excel. Notice the differences between the copy-and-paste options; you may have to adjust the Excel
table to get it to look the way it is supposed to.

Figure 15.23 Notice the formatting of the original Excel table. The cells are a certain width, and the text is aligned in a certain way in
each cell. You will see some differences once you copy and paste this data into Word. (Used with permission from Microsoft)

For example, using the Keep Source Formatting option (Figure 15.24) keeps the font and cell background
colors, but you will need to adjust some of the column widths to display the dollar values correctly. Note that
the option Link & Keep Source Formatting will appear the same, except that the data will be a link, not an
embedded object.
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Figure 15.24 Notice that the “Price” and “Marginal Profit” columns are not wide enough to fit the whole amount on one line, which
makes it hard to read. You will need to manually adjust the column widths. (Used with permission from Microsoft)

In Figure 15.25, you can see the result of the Use Destination Styles option. In this case, our “destination style”
is the style of the Word document we are pasting into, which of course does not contain any cell background
colors or special formatting. As a result, you will lose some of the formatting, such as the blue fill color. Note
that the option Link & Use Destination Styles will appear the same except that the data will be a link, not an
embedded object.

Figure 15.25 The Use Destination Styles option can be useful if you want the Excel data to match the rest of the Word document,
instead of maintaining its original formatting. (Used with permission from Microsoft)

The option to copy and paste the Excel data as a Picture will result in the cleanest appearance (see Figure
15.26). The inserted picture will appear exactly how the original Excel table appears; note that there are no
issues with the column widths or the cell background color. However, the picture is static and cannot be edited.

Figure 15.26 The option to copy and paste the Excel data as a picture results in a snapshot of the Excel table that can be resized and
modified like an image. (Used with permission from Microsoft)

Last, there is the Text Only copy-and-paste option. This option is exactly as it sounds: it pastes only the text of
the Excel table and does not include any formatting, cell borders, or background colors. The issue with this is
that much information in Excel is represented in cell format, so once the cell borders are gone, it becomes
difficult to parse the information. You can see in Figure 15.27 how difficult this is to read. This option is useful
only when you need to strip out all formatting and manipulate the text on its own.

Figure 15.27 The Text Only option typically results in unreadable text, as the columns are no longer aligned, and it is not clear how
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the information should be parsed. (Used with permission from Microsoft)

You also have the option to use the Paste Special tool and choose the Object Linking and Embedding (OLE)
option. Paste Special gives you some options in addition to the shortcuts shown as icons on the drop-down
menu. (Several of the options we already discussed are included in the list as well.) Go to the same Paste drop-
down command (in Figure 15.21), but this time choose Paste Special. This will open a new dialog box that will
give you additional choices, as seen in Figure 15.28. Select the first option, Microsoft Excel Worksheet Object. If
you have Paste selected (on the left side of the dialog box), the OLE Excel object will not be linked to the
original, meaning that it will be static; it will not update if the original file changes. If you have Paste link
selected, the object will look the same, but it will be updated if the original file changes. Both options will result
in a similar image; however, the Paste link option will simply result in a linked file. You can see the result in
Figure 15.29.

Figure 15.28 The Paste Special tool has additional options beyond the shortcuts in the Paste menu. (Used with permission from
Microsoft)

Figure 15.29 You can embed or link an Excel table to your Word document using the Paste Special tool, just like you can with the
Insert Object tool. (Used with permission from Microsoft)

Inserting Microsoft Excel Charts into Microsoft Word Documents
To integrate charts into Word documents, you simply follow the same procedure as outlined previously for
inserting objects. Here, we are looking at ways to directly integrate the two file types rather than simply
copying and pasting the information from one to the other. The concepts in this chapter are particularly useful
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when collaborating with others on workbooks or documents. Multiple users can make changes to either file, or
those with access to files will see those changes in real time.

There are a few options when integrating Excel charts into Word documents, all of which use the same
methods for inserting that you already learned in this section. You can include the chart as a picture, or you
can choose to embed or link the chart into the Word document. Finally, if you also want to include the Excel
data along with the chart, you can use the Insert Object tool. However, if you just want to include the chart and
not the spreadsheet data, linking or embedding will be the best option.

Think about the differences between linking and embedding when you determine which option is appropriate.
Let’s look at the same example of the sales data broken down by agent (refer to Figure 15.11). What do we do
if we only want to include the chart in a Word document, and not the PivotTable?

First, we copy the chart. Then we open our Word document—the Monthly Report—and determine where we
would like to include the chart in the file. In this example, let’s include the chart below the table of data we
integrated in the previous section. Be sure to have the cursor at the location where you want the chart to be
placed. Use the Paste Special function on the Home tab to either link or embed the chart into the Word file,
selecting “Microsoft Excel Chart Object,” similar to what we did in Figure 15.28. See Figure 15.30 to see the
different options that appear in this dialog box when you have a chart as your source file.

Figure 15.30 You have the option to Display as icon rather than including the actual chart. (Used with permission from Microsoft)

To embed the chart, choose Microsoft Excel Chart Object and click OK. If you would prefer to link the chart,
choose Microsoft Excel Chart Object and check the option Paste link. This will establish the link rather than
embedding the chart. The final chart should appear as it does in Excel and may need to be resized to fit on
your Word page (Figure 15.31).
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Figure 15.31 You will likely need to resize the chart when embedding it into the Word document. You can do this by simply grabbing
one of the corners of the chart and dragging it to where you would like it to be, as you would with an image. (Used with permission
from Microsoft)

If you linked the chart to your Word document, the chart should automatically update when you alter the
source data in the original Excel file. Let’s walk through an example of changing information in the Excel file to
see how this affects the chart. We will change Izabelle’s Sum of FOB$ from the current value of $46,847 to a
new value of $26,847 (Figure 15.32).

Figure 15.32 This is the PivotTable and chart as they appear in the Excel source file. Notice the chart reflects the decrease in Izabelle’s
FOB$. (Used with permission from Microsoft)
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When you open the Monthly Report Word file again, these values will be automatically updated in the chart.
You will be presented with a window asking if you would like to update the linked information. Choose Yes to
update the linked Excel chart. As an alternative, if you are already working in the Word file, you can right-click
on the chart and choose Update Link to automatically update the chart with the new Excel chart, as Figure
15.33 shows.

Figure 15.33 If you already have the Word file open, you can update the link by right-clicking on the chart and choosing Update Link.
Notice that the chart is now updated to reflect the decrease in Izabelle’s FOB$. (Used with permission from Microsoft)

Embed Microsoft Access Data into Microsoft Word Documents
The process for importing data from Access is similar to what we just did with Excel. You can use the classic
copy and paste, or you can choose Paste Special options. You can also add exported data from Access to Word.
Because Access files can be very lengthy databases, it may not always make sense to integrate them with
Word files. In some cases, however, you may want to integrate these files. For example, you may want to
integrate an Access database into a Word document to make it easier to print customer lists or product sales
in a full document. You also may want to use portions of a database to create mailing labels or product
summary cards for sales personnel.

15.3 Microsoft Word and Microsoft PowerPoint Integration

Learning Objectives
By the end of this section, you will be able to:

• Add Word documents to PowerPoint slides
• Integrate PowerPoint slides into Word documents
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At this point, you probably have noticed the similarities in integrating Microsoft 365 applications together. This
is a key feature of the Microsoft suite that makes it especially well-suited for both collaborative workspaces
and a traditional workplace in an office building. The ease of integrating Word and Excel, Excel and
PowerPoint, and PowerPoint and Word facilitate communication and teamwork at all levels in an organization.
Large corporations to small entrepreneurial ventures can find value in utilizing an integrative suite such as
Microsoft.

In this section, we focus on Word and PowerPoint. This integration can be particularly useful when preparing
materials for a presentation or meeting, for which there may be a need to have information at the ready. This
information may take the form of a handout or memo, created in Word, while also having a slideshow
presentation as a supplement to the meeting discussions. There are times when it can be useful to show the
slideshow material on the handout or add a link to a Word document to a PowerPoint. Let’s explore some
different options for integrating these two programs.

Add Microsoft Word Documents to Microsoft PowerPoint Slides
Many of the techniques you have learned in this and previous chapters on Word and PowerPoint can be
applied when integrating Word and PowerPoint. When integrating the two applications, just as with other
integrations, consider first whether linking or embedding is the best option. Use embedding if you can be
assured the source document will not change and that you will not need access to the source files. Choose
linking if you expect updates and want to be able to access the source document if needed.

Let’s revisit the example of sales data and the Monthly Report for March. Not only do you have the data in an
Excel workbook, but you have also created a memo to be distributed to key managers within WorldCorp. You
have now been asked to prepare a presentation of the material to be presented in the monthly sales meeting.
You need the information in the monthly report to include in the presentation. Rather than retyping the
information into PowerPoint, it is easier to either embed or link the Word document you already created.

To begin, create a new presentation for the monthly sales meeting. You could work from a template or open a
previous presentation rather than starting from scratch. (These topics were covered in the PowerPoint
chapters.) Determine where in the presentation (i.e., on which slide) you want the information from the Word
document to be placed. As with other applications, the information from the source file will be placed at the
cursor location. Navigate to the Insert tab, then to the Text command group, then to Object. The function
window is similar to that of other Microsoft programs, except that instead of having different tabs for Create
New and Create from File, there are option buttons to choose between, on the left side (Figure 15.34). Since we
already created the monthly report memo in Word, choose Create from File. You still have the options to link
and display as an icon.
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Figure 15.34 The handy Result section at the bottom of the window explains what will happen when you select each option. (Used
with permission from Microsoft)

Using the Browse button, find the Word file for the monthly report. If you wish to create a linkage between the
Word and PowerPoint files, be sure to check the Link box. When the Word document is linked, a picture of the
information will be inserted into the slide. Double-clicking on the picture will open Word, where you can edit
the document if needed. If you don’t choose the Link box, the information from the Word document will be
embedded into the slide rather than linked. (Be sure that the monthly report document is not open; if the file is
open, an error message will appear.) When you are done, click OK. The information from the report will now be
on the slide, as Figure 15.35 shows. If you need to make changes to the text, double-click on the object. This
will essentially open a Word environment on the slide itself where you can make the needed changes.
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Figure 15.35 The information is embedded or linked into the slide where the cursor was located. (Used with permission from
Microsoft)

Integrate Microsoft PowerPoint Slides into Microsoft Word Documents
Suppose you decide that you would like to provide access to the PowerPoint slides for those who cannot
attend the in-person monthly sales meeting. However, you do not want to send multiple files. Instead, you
want to integrate the presentation into the Monthly Report you already prepared.

First, you need to decide whether you want to integrate the entire presentation or just a few slides into the
Word file. If you want the user to see all the slides in the Word file without having to double-click on the
inserted object, it is better to use the cut-and-paste skills you learned about in an earlier chapter. You would
need to cut and paste each slide individually to see them all in the Word document. Through linking or
embedding, you can give the user access to some or all of the slides in the presentation, although they will not
appear on the screen as individual slides, as with copying and pasting. With linking and embedding, the user
will see an image of only one slide and will then need to double-click on that image to access the other slides
you have integrated. Determine if linking or embedding is appropriate for your needs based on whether you
expect updates to the source file. Then determine if you want the entire presentation or only selected slides to
be integrated. If you want to integrate the entire presentation, go to the Insert tab, then go to the Text
command group, then select the Object function to embed or link the PowerPoint file to your Word document.

If you want to include only a few of the slides, you will need to use Paste Special after copying the slides you
wish to use. To begin, select a slide in the presentation from the preview thumbnail in the PowerPoint file
(Figure 15.36). To select multiple slides, you will need to use Ctrl or Shift when you click on the additional slides.
(As usual, if you are on a Mac, you would use the Command key instead of the Ctrl key to select a slide.) If the
slides are not contiguous—that is, if you’d like to select slides 1, 3, and 5—use Ctrl to individually select each
one. To select a group of slides that are contiguous (e.g., slides 2 through 4), simply click on the first slide, hold
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Shift, and click on the last slide in the grouping you wish to select. For this example, let’s include slide 2 and
slide 4 only. We select slide 2 by clicking on the thumbnail, then hold Ctrl and click on slide 4 to select this slide
as well.

Figure 15.36 (a) Notice the border around slides 2 and 4 indicating that those are the selected slides. (b) Choose Copy from the
Home tab or by right-clicking anywhere on the thumbnails to bring up the shortcut window. (Used with permission from Microsoft)

To integrate the selected slides into Word, go to the Word document and place the cursor where you would
like the object inserted. Then choose Paste Special from the Paste drop-down menu (in the Clipboard
command group) on the Home tab (Figure 15.37). When prompted, choose Microsoft PowerPoint Presentation
Object and click OK.
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Figure 15.37 (a) After you copy the selected slides, go to the Word file and choose Paste Special. This will open up the Paste Special
dialog window that gives you a number of options on how you would like to insert the object. (b) You have the option to display the
slides as an icon rather than an image of the slide. You can also choose from a number of different file formats. (Used with
permission from Microsoft)

The slides will be embedded into the Word document (Figure 15.38). You do not have the option to link the
PowerPoint file in this case because you are not including the entire file, only a few selected slides. By double-
clicking on the slide image, the user will see the other embedded slides in the Word document. The slides will
open in a PowerPoint view screen so that you can scroll through to see the rest of the slides. (Note that
sometimes embedded PowerPoint slides look blurry when placed in a Word document. This is normal; they do
not always translate clearly.)
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Figure 15.38 Only the first slide in the selection will be displayed in the Word document. (Used with permission from Microsoft)

You can also access the other embedded slides by right-clicking on the image of the slide. You will then choose
Presentation Object and Show to see the other slides. This option shows the first embedded slide as full
screen, then to move to the next slide, use the Page down key on the keyboard. Or, you can right-click and
choose Next or See All Slides to look at all embedded slides. To get back to the Word document, hit ESC on
your keyboard. You can also right-click and choose End Show to get back to the Word document. Other options
available are Edit, Open, and Convert. With the Edit function, you can edit the slides in a PowerPoint
environment within the Word file. Choosing Open will open the object in PowerPoint. Finally, Convert enables
you to convert the object into another file type. You can also invite your readers to add comments to the
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PowerPoint by using the Add Comment tool in this menu (Figure 15.39). This can be a great way to encourage
collaboration and feedback on your PowerPoint file without having to send multiple files.

Figure 15.39 When you right-click on the integrated PowerPoint object, you can include a comment to the slideshow. (Used with
permission from Microsoft)

15.4 Microsoft Excel and Microsoft PowerPoint Integration

Learning Objectives
By the end of this section, you will be able to:

• Add PowerPoint slides to Excel worksheets
• Incorporate Excel worksheets into PowerPoint slides
• Integrate Excel charts into PowerPoint slides

WorldCorp shares information in a variety of ways and with multiple audiences. Integrating Excel and
PowerPoint data is simply another way of presenting information to others in a streamlined format, often
eliminating the need for sending multiple files. For example, you may need to share some key financial data
with an external stakeholder, but you only wish to share some of that data as well as provide some context for
it. A PowerPoint presentation that includes Excel charts and data tables can be a useful and visually interesting
way of sharing this type of information. Using many of the same approaches covered in earlier sections,
integrating Excel and PowerPoint is quite simple.

Add Microsoft PowerPoint Slides to Microsoft Excel Worksheets
The accounting department at WorldCorp has prepared a summary of recent transactions and saved that
information in an Excel file. They also created a short PowerPoint presentation to explain the data and analysis.
A formal meeting will not be held, but the department felt that including the presentation as part of the
spreadsheet would be helpful when distributing the information to other departments. The presentation and
Excel files have been created, but now we need to integrate the presentation into the Excel file so that it can be
distributed to others.

The workbook is arranged into three sheets, with the first sheet being a brief summary of the data (Figure
15.40). We will integrate the PowerPoint file on the summary sheet. The first step is to select a cell where the
slides will be integrated into Excel. We selected cell F1.
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Figure 15.40 It is helpful to include a statement indicating that the presentation is linked. This helps users understand what they are
looking at. (Used with permission from Microsoft)

As with other applications, you can either embed or link the file in Excel. Be aware that embedding the
slideshow file, which makes it a part of the Excel file, can increase the size of the file considerably, especially if
your presentation includes many graphics. You should have no problems sharing such a file via OneDrive, but
you may experience some challenges if you need to email the large file to others, as some email systems
restrict the size of files you can attach and send. Instead, you may want to choose linking, which simply
establishes the connection between the two files. Let’s link the PowerPoint to our Excel file and display it as an
icon rather than an image of the first slide in the slideshow.

We follow a similar path as in previous examples: Insert tab, then Text command group, then Object (Figure
15.41).

Figure 15.41 In Excel, the text command group is all the way on the right side of the ribbon. (Used with permission from Microsoft)

In the Insert Object dialog window that appears, select Create from File and find the PowerPoint file name (in
this case, AccountingReport.pptx). Be sure to select Link to File and Display as Icon, then click OK (Figure
15.42). The icon that was displayed in the Insert Object window will be inserted into cell F1. You can resize and
move the icon if desired. Also remember, you can change the icon to a different picture by clicking Change
Icon. You can access the PowerPoint presentation by either double-clicking on the icon or right-clicking and
choosing one of the options listed.
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Figure 15.42 (a) To embed the PowerPoint file, click the Link to file box. (b) The icon clearly indicates that the file is a PowerPoint file.
It uses the standard PowerPoint red color and shows the letter “P” so that users know what kind of file they are opening. (Used with
permission from Microsoft)

Remember the shortcut on the Insert tab for linking a file. If you choose this option, you will get a drop-down
list of the files you used most recently. You can also Browse to find the file you want to link by choosing Insert
Link from the bottom of the drop-down list. When you click on the file name, a link with the name of the file
will be inserted into the cell, as Figure 15.43 shows. You do not have an option to embed or display as an icon.
Instead, the file name (Accounting Report) will be displayed. When you click on the link, the PowerPoint file will
be opened in the PowerPoint application rather than within the Excel worksheet environment.
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Figure 15.43 (a) If the file you want to link is not in the Recent list, you can browse to find it. (b) Click on the link to access the
PowerPoint file. (Used with permission from Microsoft)

Incorporate Microsoft Excel Worksheets into Microsoft PowerPoint
Slides
Recall that you can use copy and paste to insert individual tables or charts into slides. Here we discuss going a
bit further than simply copying and pasting. We are integrating the entire Excel file or specific parts of the
Excel file into another application. We do this by either linking or embedding.

First, let us look at linking or embedding the entire Excel file into the PowerPoint file. To begin, open the
slideshow file; in this example, it is called AccountingReport.pptx. The accounting department would like the
recipients of the slideshow to also have access to the actual data file. This will enable the recipients to do their
own data analysis. Choose the location to include the embedded or linked object in the presentation. In this
example, let’s include an embedded object on the last slide and display it as an icon (see Figure 15.44). Click on
the slide where you would like to insert the Excel object and complete the usual steps for inserting an object.
The icon will then appear on the slide (Figure 15.45). It may be helpful to give the user some text indicating
whether the Excel file is linked or embedded.
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Figure 15.44 Note that we added a text box to the bottom of the last slide, explaining who to contact with questions and showing
exactly where the linked icon will be. (Used with permission from Microsoft)

Figure 15.45 You can move and resize the icon if desired. (Used with permission from Microsoft)

To access the Excel file, double-click on the icon and the file will open in Excel. You can also right-click on the
icon and choose Worksheet Object and then Open.

Just as in Excel, there is a shortcut on the Insert tab to link a file directly. The file will be linked with the file
name displayed as in the example covered earlier in the chapter. Choose the drop-down menu from Link on
the Insert tab to see a list of the most recent files. Remember, you can also browse for files, choosing the
option at the bottom of the drop-down menu. When the file is linked in your slideshow, the font color will be
light blue—a default setting in Office for indicating a linked file. It is possible that this color may not work well
with your slide design, as you can see in Figure 15.46. In that case, simply select the file name text and change
the font color and/or size to meet your needs. Refer to previous chapters to review the process for changing
font colors, styles, and size in PowerPoint.
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Figure 15.46 (a) The default for inserted file links is a light blue font with underlining. (b) You can change the font size and color to
make it more visible against the blue background. (Used with permission from Microsoft)

If you would like to link only some of the information contained in the Excel file, you will need to use the Paste
Special approach. You can also use the standard copy-and-paste approach, but this may alter the formatting or
will not be updated if you make changes to the table. Therefore, using Paste Special is a better approach as it
offers you more options for preserving formatting. One thing to note is that the columns/rows must be
adjacent to each other when making your selection; you cannot copy rows or columns that are noncontiguous
(not immediately adjacent to each other).

For this example, let’s link only the Volume Sold and Marginal Profit columns to our PowerPoint slide. First
select the two columns you want to link, then copy those columns using either the Copy icon on the Home tab
or right-click, then Copy (Figure 15.47). Determine where in the slideshow you would like the link to the Excel
information to appear (Figure 15.48). Then choose Paste Special from the Paste options in the Clipboard
command group. Choose Paste Link and click OK. The two columns are now linked in the PowerPoint file and
should appear neatly, with their formatting preserved, on your slide (Figure 15.49).
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Figure 15.47 You need to first manually select and copy the cells you wish to link or embed into the PowerPoint file. (Used with
permission from Microsoft)

Figure 15.48 Notice that the slide we want the link to appear in is selected in the lefthand thumbnail pane. (Used with permission
from Microsoft)
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Figure 15.49 You can resize and reposition the table if desired. (Used with permission from Microsoft)

Integrate Microsoft Excel Charts into Microsoft PowerPoint Slides
Integrating Excel charts into PowerPoint slides is similar to the process of selecting and integrating parts of a
table. You will use the Copy, then Paste Special approach to either link or embed charts into the PowerPoint
slideshow. Returning to our example slideshow, let’s embed the Marginal Profit donut chart in the PowerPoint
file. First go to the Excel file and select the chart you wish to integrate. Then copy the chart using one of the
two approaches for copying information: right-click, then copy; or select Copy from the Home tab. Determine
the placement of the chart in the PowerPoint slide. Then, from the Home tab, select Paste, then Paste Special.

Notice there are several options for integrating the chart into the slide, as Figure 15.50 shows. We choose to
embed the chart as a Microsoft Excel Chart Object to integrate the information. The other options, many of
which allow you to insert the chart as if it were an image (e.g., the JPEG and PNG file formats), will not embed
or link. They will simply place a copy of the Excel chart into the file (see Figure 15.51). Then click OK. The image
can then be resized like usual.
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Figure 15.50 The file path for the copied information is at the top of the Paste Special window. (Used with permission from Microsoft)

Figure 15.51 You will most likely need to resize and move the integrated chart. (Used with permission from Microsoft)
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Figure 15.52 Select the image and move or resize it to fit the design of the slide. (Used with permission from Microsoft)

15.5 Microsoft Excel and Microsoft Access Integration

Learning Objectives
By the end of this section, you will be able to:

• Create Access tables from Excel worksheets
• Create Excel worksheets from Access tables

Different Microsoft applications, such as Access and Word, have different requirements when it comes to
integrating information into other applications. Access is a program designed to manage and store data.
Unlike Excel, it is not designed to analyze data and perform complex calculations. However, you can integrate
Excel data into Access and vice versa. Some of these concepts were covered in the chapters on databases.
Revisit those chapters to refresh your memory on the functionality and purpose of Access as an application for
managing information.

Note that the terminology used for integrating Excel and Access is importing and exporting rather than linking
or embedding. You can import Excel data into Access and export Access information into Excel. Note also that
Access does not work on computers with macOS.

Creating Microsoft Access Tables from Microsoft Excel Worksheets
You may find that Access tables are created from existing information. The existing information can be from
other software programs, a customer database, or information from an accounting software program. When
you want to create an Access table from an Excel file, you need to import that Excel information into Access.

Let’s consider a possible scenario in which you might want to import an Excel file into Access. WorldCorp
would like to create a database of sales information that is currently in an Excel file. Each month, new
information from sales will be added to the database. Moving the sales data to Access will allow the sales team
greater functionality for sorting, filtering, grouping, and other customizations, which will enable them to
gauge progress toward the company’s annual goals. (Remember, Excel is best used as a data analysis program,
not as a database solution.) The Access database will be shared with the sales team through OneDrive at

15.5 • Microsoft Excel and Microsoft Access Integration 1043



WorldCorp. Currently, the Excel file contains two months of sales data. The information is organized by date,
product, product category, and item (Figure 15.53). Note that before you consider importing anything from
Excel into Access, you need to first clean up and organize your Excel file. Make sure the headers in your Excel
file are in the first row of the table. Before completing the import, you will get a preview of the data from Excel
so you can double-check that it is being imported correctly.

Figure 15.53 Note that the table is formatted with headers to make importing into Access easier. (Used with permission from
Microsoft)

Now that your Excel data is cleaned, open Access and create a blank database. Save it with an appropriate file
name, such as “Sales Data.” At this point, the database contains no data. We will import the data from the Excel
file into this blank database. Go to the External Data tab, then select New Data Source, then From File. From
there, choose Excel (Figure 15.54). Find the name for the Excel file that you are importing into Access (Figure
15.55).

Figure 15.54 You can import data from several different sources, including online sources. (Used with permission from Microsoft)
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Figure 15.55 Use Browse to find the file location for the Excel file. (Used with permission from Microsoft)

When importing information into Access, you have a couple of options. You can import the information into
the current database you have open as a new table, you can add the information to an existing table in a
database you have open, or finally, you can link the Excel information to the database, so that any changes
made in the linked Excel file will automatically be updated in the Access file. However, unlike integration with
other programs such as PowerPoint or Word when you could double-click on the image to access the actual
Excel file, you cannot edit the Excel file from Access.

For this example, we choose to import into a new table in the current database. When you click OK, you get a
preview of the data separated into columns, as seen in Figure 15.56. If it appears as it should, click Next. If your
table has headers, make sure the box is checked; Access will use these headers for the database columns.
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Figure 15.56 You can import data from other worksheets. Select the sheet you want to import from the selection window. (Used with
permission from Microsoft)

You can modify aspects of the fields (columns) you are importing by selecting Next, which enables you to
change the data type or the field name and also allows you to choose not to import a specific column. Once
you are satisfied with the field settings, click Next. Remember, you can always modify the field settings once
the database is created. You will be prompted to either name the table or use the default assigned by Access
(Figure 15.57).
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Figure 15.57 Choose an appropriate name for the database table. You can have multiple tables in one Access file. (Used with
permission from Microsoft)

The information is now imported into the database and ready to use, as Figure 15.58 shows.

Figure 15.58 The Excel data imported into Access looks fairly similar to the original table in Excel. (Used with permission from
Microsoft)
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LINK TO LEARNING

Sometimes when importing information from Excel into Access, you can encounter problems. These could
be a result of formatting within the Excel worksheet, because of complex calculations included in the data,
or other related issues. Other issues can arise when importing multiple sheets from a single Excel file. Read
this article on how to successfully import Excel data into Access (https://openstax.org/r/78ImprtExltoAcc) to
learn more about how to make sure your Excel file is ready to be imported into Access.

Create Microsoft Excel Worksheets from Microsoft Access Tables
You can also export information from an Access table into an Excel worksheet. This can be useful when you
would like to do further data analysis with the information stored in your database, or if you would like to
share some database information with an external stakeholder.

Let’s consider a scenario in which WorldCorp would like to send information from their central sales database
to some of the members of the sales team. The database has been filtered to include only two specific
locations—Virginia and West Virginia. This information will be shared with the regional sales team for their
quarterly meeting. The team members are more familiar with Excel than with Access, and WorldCorp
management would prefer to restrict access to the Access database to key personnel. So, they wish to send the
information from the table to the sales force in an Excel format. The data in the Access table has been filtered
by the criteria as shown in Figure 15.59. Refer to the chapters on databases for additional information on
sorting, filtering, and information in Access tables.

Figure 15.59 The data is filtered to show only certain rows. You can see the small funnel icon at the top of the Destination column
that indicates that this column is being filtered. (Used with permission from Microsoft)

Once the information from the database has been filtered, you can easily export it to Excel. Go to the External
Data tab and the Export command group. Choose the Excel icon from the group (Figure 15.60).
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Figure 15.60 Use the Browse button to determine the file location and name for the exported file. (Used with permission from
Microsoft)

You will need to tell Access where to export the file to and give it a file name. You can choose a new file or use
an existing Excel file. You can also change the file format if needed. Finally, you can choose to export the entire
table or just selected columns, whether to keep the formatting in the table, and whether to automatically open
the file in Excel when the export is finished. The formatting will be similar to what you see in Access but may
not be identical. You may need to adjust the column width and colors in Excel (Figure 15.61).

Figure 15.61 Notice that because the data was filtered in Access, only the filtered rows (records) were exported to Excel. (Used with
permission from Microsoft)

15.6 Integrating Data from Other Programs into Google Workspace

Learning Objectives
By the end of this section, you will be able to:

• Integrate data from Google Sheets into a Google Doc
• Integrate information from Microsoft programs into a Google program
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You may wish to integrate data from a spreadsheet or other program into a Google Doc for the reasons we
addressed earlier in this chapter. Linked data will update automatically, turning your Google Doc into a live
document with the latest information. Or you might want to copy and paste data from other programs into
Google Docs and match its style. You may also use Excel to make tables and graphs, and then import those
into Google Sheets. Using these tools can improve the quality of the infographics in your document as well as
help to convert your file into a more shareable, collaborative format.

Integrating Data from Google Sheets into a Google Doc
There are two ways to import Google Sheets tables into Google Docs. The first option is copy and paste, similar
to the process we used in Excel and Word. To do this, go to the table you want to copy in Sheets and select the
cells that are contained in it, as seen in Figure 15.62. Press Ctrl+C (Command+C on Mac) on the keyboard to
copy it or use another copy method. Then go to the Docs file, place the cursor where you want the table to be
pasted, and paste using Ctrl+V or another paste method. Immediately after pressing these keys, a Paste Table
dialog box will appear, as seen in Figure 15.63, asking you if you want to link the table or paste a static table.

Figure 15.62 Select the cells from the Google Sheets file to be integrated into the Google Doc. (Google Sheets is a trademark of
Google LLC.)

Figure 15.63 Linking will update the table in the Google Doc when changes are made in the Sheets file. (Google Sheets is a
trademark of Google LLC.)
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Linked tables or graphs, as discussed earlier, will update automatically in your Doc when the data in the source
sheet is updated. Remember, a static table will simply paste the content and will not update automatically. In
our example, we chose to have our table linked, so we left the Link to Spreadsheet on, and chose Paste. In
Figure 15.64, we can see the pasted table.

Figure 15.64 You may need to adjust column widths to give the table a professional appearance. (Google Sheets is a trademark of
Google LLC.)

Linking data from Sheets is not always straightforward. When you edit the original source document—the
Google Sheet—you need to make sure that the settings are correct in your Doc so that it will update properly.
Let’s assume that we will add rows to the client order list (our Google Sheet) as shown in Figure 15.65. This
means that the original Sheets table will grow three new rows; this will not immediately be updated in our
Google Doc.
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Figure 15.65 When you make changes to a linked table in a Google Doc, you need to take an extra step to make sure those changes
are reflected in the Doc file. (Google Sheets is a trademark of Google LLC.)

The table has increased in size; therefore, we need to make sure that our Google Doc knows how large the
table is supposed to be. To do this, go to the linked table in the Doc and hover over the Linked Table Options
icon in the upper right of the table, as shown in Figure 15.66. Choose Change Range.
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Figure 15.66 Use the Linked Table options to access the tools for the linked table. (Google Docs is a trademark of Google LLC.)

A dialog box will appear, and we see that the current range is A1 to G14, but we want it to be A1 to G23, as in
Figure 15.67. Type the new range, select OK, and the table will be updated.

Figure 15.67 If you add or remove cells from the Sheets table, you will need to update the cell references in Docs. (Google Docs is a
trademark of Google LLC.)

If you are just updating information in existing cells, and not adding or deleting columns or rows, you will need
to tell Google to update the table. For example, let’s say we made a mistake in row 2, and the quantity is
supposed to be nine instead of fourteen (Figure 15.65). Change the quantity in the Sheets file, then go to the
Doc file. Notice you now have a button at the top of the table that says Update, as Figure 15.68 shows. Select
Update, and the table will now be updated with the revised information (Figure 15.69).
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Figure 15.68 When you make changes that do not involve increasing or decreasing the size of the linked table, you will need to
update the Google Doc. (Google Docs is a trademark of Google LLC.)

Figure 15.69 Notice that the quantity of the first item changed from 14 to 9. (Google Docs is a trademark of Google LLC.)

To unlink the tables and graphs, simply select Unlink from the Linked Table options, and the table will become
static, as Figure 15.70 shows.
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Figure 15.70 If you unlink a table in a Google Doc, it becomes static and will not be updated if changes are made in the Sheets file.
(Google Docs is a trademark of Google LLC.)

Google Docs also enables you to insert a chart or graph that exists in a Google Sheet directly into your Google
Doc. A chart or graph that is linked in this way will automatically update when the contents of the Google
Sheet update. Using the skills learned in previous chapters, let’s create a summary chart of Quantity Sold per
product in your linked table. To incorporate this chart into the Google Doc, put your cursor at the point where
you want the chart to be placed in the document. Next, go to the Insert menu and hover over the Chart
command. This will open a drop-down menu; select From Sheets, as shown in Figure 15.71. This, in turn, will
open a dialog box that shows your recent Sheets files.

Figure 15.71 Although you can insert a chart directly into your Doc, as shown in the menu, sometimes it is more convenient to use
an existing chart from a Sheet. (Google Docs is a trademark of Google LLC.)

You can also use the Search tool to find a specific file. Select the one that has the information you want in your
chart—in our example, this file is called Sales Data (Figure 15.72). Click Select.
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Figure 15.72 From the window, choose the Sheets file where the charts or graphs are located. (Google Docs is a trademark of Google
LLC.)

The next screen gives you a preview of the graph (Figure 15.73). If you have more than one chart or graph
created in the Sheets file, as in this example, you will see all of them in the preview and can select the ones you
want to include.

When you have selected the charts or graphs to include, choose Import. To ensure that the chart stays
updated, tick the checkbox labeled Link to spreadsheet.
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Figure 15.73 Click on any or all of the charts that you wish to insert into the Doc. (Google Docs is a trademark of Google LLC.)

Again, if you want to update the chart to reflect changed values in the existing table, just click on the Update
button. But if the number of rows or columns has changed, so that the table is no longer the same size, you
will need to select the range for the linked table as we did previously. If there are no changes to the size of the
table, but only changes in values in existing cells, you can use the Update button. Figure 15.74 shows the result
of the integrated charts.

Figure 15.74 You may need to resize and move the charts and graphs to fit the needs of the document you are creating. (Google
Docs is a trademark of Google LLC.)

Integrating Data from Microsoft Programs into a Google Program
To add data from Microsoft 365 (Office) apps to your Google Workspace programs, simply upload the files to
Google Drive. Then you have the choice of keeping them as .docx (Word) or .xlsx (Excel) files or converting
them to .gdocx (Google Doc) or .gxlsx (Google Sheets), respectively. To convert Microsoft files to Google files,
you must open the document and manually choose to save it as a Google Doc or Sheet. When choosing this
option, you may have to adjust some of the formatting of your Doc or Sheets, but generally, this is a
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straightforward approach to bringing files from Microsoft programs into Google.

Data from Microsoft Excel
You can integrate data from Excel into any of the Google applications. First, let’s discuss how to bring Excel
information into a Google Doc. If your tables and graphs were created in Excel rather than in Sheets, you can
use one of the copy-and-paste methods used when placing Excel tables into a Word file. Select the table, copy
it using your preferred method, and then paste it into the Doc using either Paste or Paste Without Formatting
(Figure 15.75). Notice that much of your Excel formatting is lost when you use the copy-and-paste method.
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Figure 15.75 (a) The table in Excel is formatted with shading and borders. (b) When copying into Google Docs, you have only two
options. (Part a: Used with permission from Microsoft; Part b: Google Docs is a trademark of Google LLC.)
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Figure 15.76 The Paste option gives you the data in a table, but it is not formatted in the same way it was in Excel. (Google Docs is a
trademark of Google LLC.)
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Figure 15.77 The Paste Without Formatting option simply pastes the information as text, not in a tabular form. (Google Docs is a
trademark of Google LLC.)

To ensure that the Excel data gets inserted into your Google Doc in a manner that is closer to what you have in
Excel, you need to first upload the Excel file into your Google Drive and open it in Google Sheets.

First, upload the file into your Google Drive. Then, find the file in the Drive and right-click on it. Choose Open
with Google Sheets, as in Figure 15.78. This will open the file using the Google Sheets app, but remember, it
will not be saved as a Google Sheet until you manually choose to do so. After opening the file in Sheets, go to
the File window menu and then choose Save as Google Sheets, as shown in Figure 15.79.
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Figure 15.78 Opening your Excel file in Google Sheets preserves most of its formatting. (Google Drive is a trademark of Google LLC.)
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Figure 15.79 The file will be saved in your Drive as an Excel file unless you specifically save it as a Google Sheets file. (Google Sheets
is a trademark of Google LLC.)

Another option is to import the Excel information into a new Sheets file. This too will preserve much of your
formatting. However, if you have charts or graphs created in the Excel file that are not available in Google, the
charts or graphs will not import. Only the data will be imported. Then you can create a chart from within
Sheets. This is one limitation of Google: it does not have as many options for creating graphs and charts as you
will find in Microsoft. Most of the graph and chart formats available in Google are very basic, such as simple
line graphs and bar charts. You will not see some of the more advanced formats, such as the 3D options, as
you do in Microsoft.

Additionally, when you import an Excel file into a Sheets file, you might notice that any links you established
between that Excel file and another Excel file may not be preserved. If your Excel sheet contains formulas,
make sure these are accurate once imported. Importing works well, but the result may need some editing to
resolve compatibility issues. It is important to be aware of this limitation when importing Excel information
into Sheets.

Finally, once you have imported the data into a Sheets file, you can integrate that information into a Doc if
desired. This approach is likely to do a better job of retaining your formatting than the copy-and-paste
method.

To begin importing Excel into Sheets, create a new blank worksheet in Sheets. Then, while in Sheets, go to the
File window menu and choose Import (Figure 15.80). If the Excel sheet has already been uploaded to the Drive
as an .xlsx document, you can get the Excel file from the My Drive tab, as seen in Figure 15.81. If the file is not
in your Google Drive, choose the Upload tab to locate it. A new dialog box will appear, as shown in Figure
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15.82, asking what you want to do next: create a new spreadsheet, insert a new sheet, or replace the
spreadsheet. Select Replace Spreadsheet and then choose Import Data. This will move the entire contents of
the Excel spreadsheet into the new Google Sheet you just created (Figure 15.83).

Figure 15.80 Add the Excel file to your Google Drive to make importing easier. (Google Sheets is a trademark of Google LLC.)
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Figure 15.81 You will see your file in My Drive if the Excel file has already been uploaded into your Google Drive. (Google Drive is a
trademark of Google LLC.)

Figure 15.82 You can create a new spreadsheet in Sheets using imported Excel data. (Google Sheets is a trademark of Google LLC.)
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Figure 15.83 The data will be imported in Sheets with the same formatting as you had in the Excel file. (Google Sheets is a trademark
of Google LLC.)

Another option for bringing Microsoft files into Google is to change your settings in Google Drive. As a word of
caution, when you change your Google Workspace settings, you will change the settings for the entire Google
Drive and all files that are stored in the Drive.

First, go to the Settings icon at the top right of your Drive (Figure 15.84).

Figure 15.84 Access the settings in your Google Drive to edit how non-Google files are managed. (Google Drive is a trademark of
Google LLC.)

In the General tab, go to the option that says Convert Uploads and check the box Convert uploads to Google
Docs editor format. Tick on the checkbox as shown in Figure 15.85. Then click on Done. Again, be careful with
changing these settings, however, since this will change the process for your whole Google Drive, and not just
one file or folder.
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Figure 15.85 Choosing to convert all uploads to Google Docs editor format will change the setting for all files that are uploaded into
your Drive. (Google Drive is a trademark of Google LLC.)

Information from Microsoft Word
To import an entire Word document into Google Docs, follow the same steps that you used to import an Excel
document into Google Sheets: you can either upload the file into Google Drive, then Open it in Google Docs
(Figure 15.86); or, if the file is already in your Google Drive, right-click on the file and hover to Open with
Google Docs. Again, the file will not be a Google Doc file right away; it will remain a Word file unless you
deliberately choose to save it as a Google Doc. This is the same as the procedure for saving an Excel file as a
Google Sheet.
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Figure 15.86 For files that are in your Drive, you can choose to open them with Google Docs. But they will not be Docs files unless
you then save them as a Google Docs file. (Google Drive is a trademark of Google LLC.)

If you want to bring in certain portions of a Word document into Google Docs, you can use the copy-and-paste
method. For example, to bring just the title and this bulleted list from the report into a new Google Docs, you
would first select and copy the information from Word (Figure 15.87). In the new Google Doc, you can either
use Paste or Paste without formatting to insert the text. Figure 15.88 and Figure 15.89 show the difference
between using these paste options.
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Figure 15.87 First, copy the information from the Word document that you want to paste into a Google Doc. (Used with permission
from Microsoft)
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Figure 15.88 Even with the normal Paste tool, some of your formatting will be lost when you bring information from Word into Docs.
(Google Docs is a trademark of Google LLC.)
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Figure 15.89 When you use the Paste without formatting tool, the information will be pasted as plain text and will not preserve any
formatting, like font style or color. (Google Docs is a trademark of Google LLC.)

As with Sheets and Excel, there are some known compatibility issues between Docs and Word: The footer and
header may not be shown the same, some blank pages may be added in Docs that were not in the Word
version of the file, some fonts may not be recognized, the text may have alignment or indent issues, word-
wrapped pictures in Word may be out of place, and line spacing may be a little off. You will need to experiment
and use the programs consistently to get a better understanding of these compatibility issues and how they
might affect your document.

15.7 New Developments: The Role of Artificial Intelligence

Learning Objectives
By the end of this section, you will be able to:

• Understand the role of AI in applications
• Describe generative AI

Throughout the text, we looked at the basic and advanced capabilities of the Microsoft and Google
applications. We also discussed other key programs that you may encounter in your career. But these
programs are just the tip of the iceberg. These companies are constantly developing and improving their
products. In addition, with new advances in technology emerging nearly on a daily basis, these applications
will evolve. Specifically, advances in the use of artificial intelligence (AI) have found their way into many aspects
of our day-to-day lives. These technologies are evolving quickly, so it is worth keeping updated on them as you
move through your career. You can go to Microsoft or Google’s website to investigate the current state of AI
integration in their applications. Here we discuss just a few of the recent developments.
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Artificial Intelligence in Applications
A number of programs have AI embedded in their applications, a feature that is expected to increase as AI
technology advances. AI has also been integrated into search engines such as Bing and Microsoft Edge. Both
Microsoft and Google have introduced AI into their applications. Microsoft is incorporating AI into all of its
Microsoft 365 applications, including Outlook. This product, called Copilot, will provide enhanced abilities to
summarize documents, add animations to slides in PowerPoint, and create stories in Word. As of this writing,
Copilot is still in the developmental stage with a small group of test users. It is being marketed as a tool to
improve employee efficiency by automating time-consuming tasks such as composing or reading long emails
or summarizing datasets in Excel.

LINK TO LEARNING

Some analysts and others who use Excel also need the capabilities provided by the Python computer
programming language. Microsoft recently announced the addition of Python to Excel, giving users the
power of Python combined with Excel’s flexibility. With teams in mind, Microsoft designed Python in Excel
(https://openstax.org/r/78PythonExcel) to work with no setup required; as of this writing, Microsoft has
made it available to a select group of Microsoft users, with plans to expand to a larger group in the future.

In a comparable way, Google is testing incorporating AI into its Workspace applications. Google’s tool, called
Bard, is designed to do many of the same things as Microsoft’s Copilot. The program uses machine learning to
generate emails, draft documents, and summarize data trends, among many other functions. Keep in mind
that as AI continues to evolve, governments will seek to regulate its use and application.

For both Microsoft and Google, the goal is to use AI technology to enhance worker productivity. Adding
automation to routine, time-consuming tasks can free up employees to focus on more pressing and impactful
tasks that will contribute to their companies in a greater way. Although both Microsoft’s Copilot and Google’s
Bard are not widely available to all users at present, we can expect to see more AI in these programs with time.

Generative AI
Generative AI is a type of computer programming and machine learning technology that builds and
generates content itself. The computer is “trained” using complex programming that searches the internet for
relevant information. Then, based on the information found, the program can generate new content such as
text or audio.

For example, using a generative AI application, you can have a research essay constructed that will use
existing information to write the essay for you based on specific parameters, such as its length and topic. As
another example, parts of separate audio files can be combined into a new musical piece based on a certain
genre of music.

Recently, an innovative technology has emerged that is one of the most sophisticated generative AI programs
to date. This program, called ChatGPT, is designed to mimic conversational language. It is programmed to
respond to inquiries, ask clarifying questions, and even highlight its own mistakes. ChatGPT uses many
sources, including textbooks and websites, to train the program to use a natural tone when responding, in
contrast to the more rigid, less engaging, and often robotic responses typical of previous AI programs.

This program can be used to create original poems or music in a certain style. It can also be used to draft
research papers or articles on specific topics. You will start seeing the application of ChatGPT in customer
service applications. Even now, if you have a problem with an order you placed online, you can often access a
chat feature on the website to get help on the issue. It is likely that ChatGPT will be used in this context, as it is
more conversational, giving the impression that the user is conversing with a human, not a computer.
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LINK TO LEARNING

No doubt you have heard of ChatGPT outside of this text. Some of the coverage about this program can be
overwhelming to digest. Visit the OpenAI website (https://openstax.org/r/78OpenAI) to learn more. Here
you can create an account and enjoy a free trial of ChatGPT.

15.8 Mastering Workplace Software Skills: A Project

Learning Objectives
By the end of this section, you will be able to:

• Create an annual report and presentation using either Microsoft or Google programs
• Present the annual report summary

Throughout this text, you have seen the capabilities of various programs in Microsoft 365 (Office) and Google
Workspace. Along the way, you have learned new skills and refined existing knowledge. You are well on your
way to mastering the programs discussed in this book. Now, let’s put those skills to the test. In this final
section, you are tasked with developing an annual report for a subsidiary of WorldCorp, Lewis Enterprises, as
well as creating an accompanying presentation. While creating these files, you will need to make tables and
charts in a spreadsheet program. This comprehensive project will give you more practice of the major
concepts covered in the text. You can create the files in either Microsoft or Google. You could even challenge
yourself and create the files using both sets of programs. It is a good idea for you to be familiar with both
Microsoft and Google programs, as you are likely to encounter both of them during your career. Follow the
general outline that follows to create the annual report and presentation. Refer to the text for help along the
way, as needed.

The Company
The company you are working with is called Lewis Enterprises (LE). LE is a U.S. regional company that was
established fifteen years ago and has recently been bought by WorldCorp. LE specializes in computer software
and hardware for small independent pharmacies. The company serves the Midwest region and has a strong
customer base of independent pharmacies. They have had steady growth over the past several years. Each
year, management in the company provides a summary of the company’s performance over the last three
years and distributes it to all employees. This summary includes a document with accompanying discussion of
the results as well as a presentation. The presentation is generally given during the company’s annual meeting
that most employees attend. However, not all employees are able to attend the in-person meeting. The report
and presentation must be done in a way that is accessible for employees who receive the information in other
ways, including by video, electronically, and even as paper copies of the information.

The Assignment
What you are being asked to prepare is an internal annual report prepared for employees of the company,
rather than for distribution to the public. Generally, internal annual reports tend to be less formal than annual
reports prepared for stockholders and the public. The general purpose of an internal annual report is to help
managers and employees understand how well the organization performed over the previous year or set of
years, including successes, failures, and areas that need improvement. Internal annual reports are also critical
tools for providing information needed for decision-making and forecasting. Keep this purpose in mind, and
ensure that the report is prepared in a way that meets this purpose.

To prepare the annual report, you are given a file of sales data for 2020–2023 with forecasts for 2024 as well.
Following the tasks outlined in the following sections, prepare the files for the annual meeting. As you work
through the tasks, review the capabilities of the programs and practice ways to enhance the files with some of
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the tools available. For example, how might you incorporate WordArt or embed a video into the files? There
are many ways to create the materials for the annual report while conveying the key points and delivering a
professional, high-quality product.

Task 1: Preparing the Report
1. Create a shared folder that includes the data file and share with at least one other person.
2. Either use a template or create from scratch a shell of the annual report document with the following

elements/headings:
◦ Cover Page
◦ Table of Contents
◦ Introduction
◦ Historical Performance
◦ Year Overview
◦ Data Analysis
◦ Discussion of Results
◦ Conclusions

3. Be sure to include page numbers in your file and format headings appropriately so that you can add a
table of contents later.

4. Put the shell for the annual report in the shared folder.

Task 2: Formatting Data Files and Tables for the Report
1. Using the data in the downloadable Annual Report Sales Data worksheet (https://openstax.org/r/

78Ch15DataFile), summarize the sales data by year, by quarter, and by product.
2. Create charts, graphs, and tables that you feel are appropriate to visually convey the trends you notice.
3. Format the charts, graphs, and tables using a professional theme.

Task 3: Integrating Files for the Report
1. Integrate the charts, graphs, and tables you created into the appropriate section in the document file.
2. If necessary, format content for readability.
3. Include other data as appropriate to create the picture of trends in the data.
4. Be sure to add labels to your charts, graphs, and tables.

Task 4: Preparing the Presentation
1. Create the shell of the presentation using a template or from scratch using appropriate slide layouts and

titles. Be sure to include a title slide.
2. Choose a professional theme for the presentation.
3. Select images or objects to enhance the slides.

Task 5: Integrating Files for the Presentation
1. Integrate the information from the document (report) and spreadsheet file into the presentation file.
2. If necessary, format content for readability.

Task 6: Finalizing Files
1. Thoroughly proofread all files and make edits.
2. Add and format the table of contents.
3. Include speaker’s notes to the presentation file.
4. Prepare a handout of the key points to be distributed at the annual meeting.
5. Link the data file to the document file and presentation file.
6. Add finalized files to the shared folder and grant editing privileges to at least one collaborator.
7. Share the files with your instructor with the appropriate editing privileges.
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Chapter Review
Key Terms
collaborative workspace a virtual environment designed to enable programs and users of those programs

to work together
Generative AI technology that uses computer programming and machine learning to create content
integration occurs when software programs that serve different purposes are able to work together to

support the transfer of information from one program to another program
source file the file that contains the information that you want to put into another program
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Summary
15.1 Microsoft 365: Collaboration and Integration

• Collaborative workspaces allow users from various physical locations to work together efficiently.
• Office is designed to allow easy integration between applications.
• We discuss two types of integration—embedding and linking. Embedded information becomes a part of

the other file and is not updated if the source file is updated. Linked information is kept separate; a
connection between the two files is made, but it does not become part of the other file.

• Certain PDF files can be opened by Word by using the default conversion tool. Because the programs
generally have the same layout, there are common paths to take information from one program into
another program.

15.2 Microsoft Word: Integration with Microsoft Excel and Microsoft Access
• Integrating Word into Excel has some drawbacks as Excel is meant more for data rather than text.
• However, methods for importing Excel content into Word files include many copy-and-paste options, as

well as the ability to insert a linked object.
• The process for linking or embedding Excel charts into a Word file is similar to linking or embedding tables

of data. You can choose to display the information as an icon in the Word document rather than showing
an image of the linked or embedded information.

• You can import Access tables into Word, but this is typically not advised, as Access databases can be quite
lengthy.

15.3 Microsoft Word and Microsoft PowerPoint Integration
• The quickest way to link to a Word file in PowerPoint is to use the Link tool on the Insert tab.
• Linking a PowerPoint presentation to a summary report created in Word can enhance the overall message.

15.4 Microsoft Excel and Microsoft PowerPoint Integration
• PowerPoint files can be linked or embedded directly into Excel files.
• You can link or embed entire Excel files into a PowerPoint presentation or choose only certain selections.

Linking and embedding Excel information into PowerPoint files is similar to the process used to link and
embed Excel into Word.

• Integrating Excel tables and charts into PowerPoint presentations can enhance a presentation by showing
relevant data and visuals to explain trends.

15.5 Microsoft Excel and Microsoft Access Integration
• Access and Excel are commonly integrated. Many databases start with information from Excel.
• Information manipulated in an Access table is easily exported into Excel for additional analysis.

15.6 Integrating Data from Other Programs into Google Workspace
• Data from Google Sheets can be imported into a Google Doc using a few different methods.
• Microsoft files, such as Excel tables and charts, Excel worksheets, and Word documents, can be imported

into Google Sheets, which can then be imported into Google Docs by using the copy-and-paste method or
the Chart command in the Insert window menu. Converted files in both Sheets and Docs will not be
identical to the original Excel and Word documents.

15.7 New Developments: The Role of Artificial Intelligence
• Microsoft and Google have both incorporated AI into their applications. These application enhancements

are intended to increase employee productivity on more value-added tasks.
• ChatGPT is one type of generative AI that offers enhanced text generation that is more conversational in

style than previous versions of computer-generated text.
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Review Questions
1. Why are collaborative workspaces important?

a. They promote teamwork and increase productivity during in-office meetings.
b. They enable employees to work independently.
c. They enable organizations to meet the diverse needs of their employees through remote work

options.
d. They make it more efficient for organizations to gather the information and resources needed to

complete their work.

2. What is one way to convert a PDF file to a .docx file?
a. Open the PDF with Word.
b. Drag the file from your desktop to your Word document.
c. Insert it as a linked object into your Word document.
d. Copy and paste the text into your Word document.

3. Office’s common user interface fosters integration. What does this mean?
a. The common user interface enables collaborative workspaces.
b. The common user interface makes remote work possible.
c. The common user interface allows users to share files, edit documents, and have virtual meetings in

real time.
d. The common user interface has a similar format and structure in different applications.

4. Which function is similar to cut and paste?
a. linking
b. embedding
c. converting
d. integrating

5. What happens to the content of an Excel worksheet when it is integrated into a Word document?
a. When information in the Excel source file changes, if the file is integrated properly, the information

will also be updated in the Word file.
b. When information in the Excel source file changes, the information will not be updated in the Word

file.
c. The Excel data will insert into your Word document as a link.
d. The Excel data will insert into your Word document as textual content.

6. What steps should you use to integrate a Word document into an Excel file?
a. Select the Layout tab and use Page Setup.
b. Select the Review tab and use the Changes command.
c. Select the Insert Object function and put your cursor where the information should be placed in your

Excel document.
d. Select the Get Data function and click on the Query Options.

7. Where will an Excel table be inserted when embedding it into a Word document?
a. at the cursor location
b. at the top of the document
c. at the bottom of the document
d. as an icon in the heading

8. How do you embed Access data into Word documents?
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a. Choose Paste Special options or use classic copy and paste.
b. Use Update Link, and the table will be embedded if you click that option.
c. Choose References followed by Insert Table of Figures.
d. Use Insert followed by SmartArt, and the table will be embedded if you click that option.

9. How do you access all of the slides that have been integrated into a Word document?
a. from the Review tab
b. by double-clicking on the slide image in the document
c. by pressing Page down
d. by using Ctrl+Click

10. When adding Word documents to PowerPoint slides, what happens if you don’t choose the Link box?
a. The Word document will be embedded into the slide, rather than linked.
b. The Word document will be linked, but you will be unable to make any changes to it.
c. The Word document will be embedded, with a picture of the information inserted into the PowerPoint

slide.
d. The Word document will be linked, but you will have to retype some of the information to make it

display properly in PowerPoint.

11. __________ makes the PowerPoint file part of the Excel file and increases its file size.
a. linking
b. embedding
c. inserting as a picture
d. display as icon

12. What approach should you use to link only certain information from an Excel file into a PowerPoint slide?
a. Use the Insert tab, Choose Link approach.
b. Use the standard copy-and-paste approach.
c. Use the Paste Special approach.
d. Use the Display as icon approach.

13. What is the disadvantage of inserting an Excel chart into a PowerPoint slide as a JPEG or PNG image?
a. The image is simply a copy that cannot be moved around once it is inserted into a PowerPoint slide.
b. The image is simply a copy that cannot be integrated.
c. The image is simply a copy that cannot be duplicated to use on more than one slide.
d. The image is simply a copy that cannot be updated.

14. To easily export Access data to Excel, what should you do to the database information?
a. Format the information.
b. Convert the information to a JPEG file.
c. Filter the information.
d. Drop the information into a table in a Word document.

15. What is required to import an Excel file into an Access database?
a. header text with appropriate spaces
b. a blank database
c. a JPEG image that can be double-clicked to edit the Excel file from Access
d. a table from a Word document that can integrate the Excel information

16. What is one way to insert a chart from Google Sheets into Google Docs?
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a. You can go to the Insert window menu and use the mouse to choose Chart and then From Sheets.
b. You can drag the chart from Google Sheets to Google Docs, as long as they are in separate windows.
c. You can use the mouse to select the browser window where Google Sheets is located and then insert

the browser window on Google Docs.
d. You can use the Print Screen key on the keyboard to copy the chart and then press Ctrl+V at the

position where you want to place the chart in Google Docs.

17. Which option will preserve much of your formatting in an Excel sheet when bringing it into Sheets?
a. Import command
b. copy and paste
c. copy and paste without formatting
d. Preview

Practice Exercises
18. Your manager at WorldCorp has asked you to summarize information for various models of one of the

company’s products. You are given the following information:

Using this data and the skills learned in this and previous chapters, construct a short email/informal
memo to your manager. Include a link to the Excel chart that summarizes the information provided.

19. Create a table and chart in Excel showing your income and expenses over the last month. Use the skills
learned in previous chapters to format the table and to select the appropriate chart for the data. Now
create a Word document summarizing the key points evaluating your spending habits over the last
month, along with strategies for the next month if appropriate. Integrate the Excel table and chart into
the Word document.

20. Go to the Contextures website (https://openstax.org/r/78Contextures2) and scroll down to the Sample
Data Files options. Download one of the sample sets of data to work with. Open the file in Excel, and paste
it into Word using the various options covered in this section. Which paste option gives you the best
result?

21. Using the information on TV sales in the Excel worksheet that follows, create a short memo (in Word)
summarizing the data. Then create a brief PowerPoint presentation of two or three slides to supplement the
memo. Integrate the slideshow into your Word document.
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22. Using the Excel information that follows, embed the summary table from all three locations into a
PowerPoint slide.

23. Go to the Contextures website (https://openstax.org/r/78Contextures2) and scroll down to the Sample
Data Files options. Download one of the sample sets of data to work with. Open the file in Excel, and
create a chart of the data in Excel. Create a short PowerPoint presentation about the data. Integrate the
Excel information into the slides. Link the PowerPoint presentation into the Excel file.

24. Using the information in the downloadable Practice Exercise worksheet (https://openstax.org/r/
78Ch15DataFile), create an Excel table of the data. Import the data into Access. Filter the data by Home
Stereo Systems. Export the filtered table to Excel.

25. Go to the Microsoft 365 site (https://openstax.org/r/78OfficeTempl) to search for free templates. Search
for an Excel template that includes data and a chart. Save the template to your computer. Go to your
Google Drive and practice uploading the Excel file into the Drive. Now open the file in Google Sheets. Did
the template import into Sheets to look like it did in Excel? Explain what happened.

26. Go to the Microsoft 365 site (https://openstax.org/r/78OfficeTempl) to search for free templates. Search
for an Excel template that includes data and a chart. Open the template in Excel, and practice copying and
pasting using the various options discussed in this section. Which paste option was the best to maintain
the elements of the original template?

Written Questions
27. What are collaborative workspaces? What are some aspects of Microsoft 365 that foster collaboration?
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28. Describe the difference between linking and embedding. What are some advantages/disadvantages of
each?

29. Discuss the advantages and disadvantages of integrating Excel and Word information.

30. What is the main difference between a standard copy and paste and a linked paste of an Excel table?

31. What is the benefit of embedding a Word document in an Excel spreadsheet? Is it better to link or embed
an Excel chart in a Word document?

32. When integrating Word and PowerPoint, how do you determine whether linking or embedding is the best
option?

33. Why is it useful to integrate PowerPoint slides into a Word document?

34. For files that you will share with others electronically, what should you consider when deciding whether to
use embedding versus linking?

35. Why is it useful to integrate PowerPoint slides into Excel spreadsheets, and vice versa? What purpose does
this serve?

36. Why would a company want to integrate Excel and Access?

37. List at least three things that you must remember when integrating data from Google Sheets into a
Google Doc.

38. Describe the difference between copying and pasting information from Excel into Google Sheets, versus
opening an Excel as a Google Sheets file.

39. What are the names of Microsoft and Google’s AI tools, and how will these be used in Microsoft and
Google applications?

40. What is ChatGPT, and how can it be used in the workplace?
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